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Ru:Gramps	6.0	Вики	Руководство
Это	руководство	для	Gramps	версии	6.0.	Приглашаем	всех	принять	участие	в	написании	этого	руководства,	чтобы	сделать	его
более	удобочитаемым	и	полезным.

Обзор
Руководство	пользователя	поможет	Вам	освоиться	с	программой	Gramps.	Оно	раскрывает	все	аспекты	использования	Gramps:	общие
вопросы	по	работе	программы,	подробное	описание	всех	её	возможностей,	настройки,	работа	с	базой	данных,	создание	отчётов	и	т.д.

You	can	also	download	the	Complete	Russian	6.0	Offline	Manual	(16	MiB)	last	updated	27	Aug	2023.

Пред Содержание След
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Введение

Пред Содержание След

Gramps	—	это	программа,	созданная	для	проведения	генеалогических	исследований.	Хотя	Gramps	и	похож	на	другие	генеалогические
программы,	он	обладает	некоторыми	уникальными	и	мощными	возможностями,	которые	мы	обсудим	ниже.

Gramps	—	это	приложение	с	открытым	исходным	кодом,	а	это	значит,	что	вы	можете	свободно	копировать	и	распространять	его.	Gramps
разрабатывается	международной	командой	добровольцев,	которые	хотят	сделать	его	мощным	и	в	то	же	время	удобным.

Почему	Gramps?
Большинство	генеалогических	программ	позволяет	вводить	информацию	о	ваших	предках	и	потомках.	Семейные	связи	обычно
отображаются	в	виде	диаграмм,	графов	или	отчётов.	Некоторые	программы	позволяют	добавлять	изображения	или	видео.	Некоторые
даже	умеют	хранить	информацию	о	людях,	не	имеющих	никакого	отношения	к	основной	семье,	которую	вы	исследуете.	Кроме	того,
большинство	генеалогических	программ	умеют	обмениваться	информацией	с	другими	программами	и	печатать	разнообразные	отчёты.

Gramps	умеет	всё	это	и	немножко	больше.	Важно,	что	Gramps	позволяет	собрать	все	данные,	полученные	в	ходе	исследования,	в	одном
месте	—	в	вашем	компьютере.	Теперь	вы	можете	манипулировать	вашими	данными,	сопоставлять	и	анализировать	их,	а	не	возиться	с
кипами	бумаг.

Условные	обозначения
В	этом	руководстве	используются	некоторые	условные	обозначения.	Например:

Приложения

Команды,	вводимые	в	командную	строку

Имена	файлов

Заменяемый	текст

Надписи 	на	кнопках	и	других	элементах	графического	интерфейса

Переходы	в	меню	выглядят	так:	Меню	->	Подменю	->	Элемент	меню

Кнопки ,	на	которые	можно	нажать

CTRL + D 	Сочетания	клавиш,	которые	можно	нажать	на	клавиатуре.

То,	что	вы	вводите

Установленный	флаг
Снятый	-	флаг

Некоторые	заметки	и	подсказки	в	этом	руководстве	выделены	особо.

Пример	подсказки

Подсказки	и	дополнительная	информация	выглядят	именно	так.

Пример	заметки

А	заметки	выглядят	так.

Наконец,	предупреждения	о	том,	что	в	этом	месте	нужно	быть	особо	осторожным,	выглядят	так:

Пример	предупреждения

Предупреждения	выделены	особо.	Если	есть	шанс	создать	себе	проблему,	то	вы	будете
оповещены	об	этом	заранее.

Пред Содержание След
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Что	нового?

Пред Содержание След

Этот	раздел	содержит	обзор	изменений	в	Gramps	по	отношению	к	версии	5.0.	Подробнее	эти	изменения	описаны	далее	в	этом
руководстве.	Пользователям	Gramps	более	ранних	версий	рекомендуется	также	ознакомиться	с	этим	разделом	в	предыдущем
руководстве,	чтобы	убедиться	в	преимуществах	перехода	на	новую	версию	6.0.

Перед	обновлением

Предупреждение

Архивирование	(средствами	Управления	семейными	древесами)	не	обеспечивает	безопасность
Ваших	данных	во	время	обновления	программы	Gramps.	Существует	небольшая	вероятность,	что
при	обновлении	может	повредиться	семейное	древо,	также	как	могут	повредиться	и	архивы.	В
целях	безопасности	данных	рекомендуется	процедура	резервного	копирования,	описанная	ниже.

Перед	обновлением	убедитесь,	что	Ваши	данные	находятся	в	безопасности.	Лучший	способ	сделать	это:

1.	 Запустите	Gramps	версии	3.4	или	4.2	или	5.0
2.	 Откройте	Ваше	семейное	древо
3.	 Произведите	резервное	копирование	древа	в	формат	gramps	xml	или	в	формат	gramps	xml	package	(который	включает	в	себя

фотографии	и	другие	файлы,	связанные	с	Вашим	семейным	древом).	Резервное	копирование	производится	с	помощью	пункта	меню
Семейные	древа->Сделать	резервную	копию....

4.	 Закройте	текущее	древо	и	повторите	эти	шаги	для	каждого	имеющегося	семейного	древа.
5.	 Сохраните	полученные	файлы	в	надежном	месте

Более	подробную	информацию	смотрите	в	разделе	Резервное	копирование	семейного	древа.

После	резервирования	Ваших	данных	произведите	установку	Gramps	6.0.	Использование	установочного	пакета	Gramps	6.0	для	Вашей
операционной	системы	в	большинстве	случаев	позволяет	избежать	конфликтов	с	более	старой	версией.	Однако,	перед	установкой	Gramps
6.0	рекомендуется	удалить	Gramps	3.4	или	выбрать	для	Gramps	6.0	другое	место.	Для	установки	из	исходных	кодов	это	необходимое
условие.	Подробнее	об	установке	Gramps	6.0	смотрите	на	странице	загрузки	Gramps.

После	установки	Gramps	6.0	вы	сможете	продолжить	работать	с	Вашими	существующими	семейными	древами.	В	случае	возникновения
проблем	(например,	после	полного	обновления	системы),	импортируйте	Ваши	семейные	древа	из	резервных	копий	созданных	ранее.

Предупреждение

Открыв	семейное	древо	в	обновленной	версией	Gramps	или	в	обновленной	операционной
системе,	нельзя	пытаться	открывать	это	древо	старыми	версиями.	Как	всегда	в	таких	случаях,	для
обмена	Вашими	данными	необходимо	использовать	формат	gramps	xml.	Для	восстановления
поврежденных	баз	данных	существуют	специальные	инструменты,	но	они	в	основном
предназначены	для	продвинутых	пользователей.	Чтобы	избежать	потребности	в	таких	средствах,
следуйте	нашим	рекомендациям	по	обновлению	Gramps	или	операционной	системы.

Основные	видимые	изменения
К	видимым	изменения	можно	отнести:	внешний	вид,	данные.

Формат	данных

Формат	хранения	данных	не	изменился.

Семейное	древо	нельзя	открыть	в	Gramps	3.4/4.0/4.1/4.2	и	Gramps	6.0	без	обновления.

Откат	версии	может	быть	осуществлён	только	через	экспорт	в	формат	XML	и	последующем	импортом.

Файл	Gramps	XML,	созданный	в	Gramps	3.4/4.0/4.1	не	совпадает	с	таким	же,	созданным	в	Gramps	6.0.

Gramps	6.0	поддерживает	только	python3.

Подробно	об	изменениях	в	структуре	внутренней	базы	данных.

Основные	изменения

SQLite	теперь	стал	базой	данных	по	умолчанию	вместо	BSDDB.	Вы	по-прежнему	можете	выбрать	какую	базу	данных	использовать.
BSDDB	также	доступна	для	выбора.	Для	продвинутых	пользователей	доступны	PostgreSQL	и	MongoDB	через	сторонние
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дополнения.

Разработчики	верят,	что	SQLite	меньше	подвержена	повреждению	данных.

Возможность	переодического	создания	создания	резервных	копий.	Резервная	копия	при	выходе	из	программы	создается	по
умолчанию.
Параметры:	новый	параметр	для	сжатия	резервной	копии.

Интерфейс

Доступен	выбор	между	светлой	и	тёмной	темой	оформления.
Дополнительные	настройки	цветов	для	графиков.
Добавлен	фильтр	"в	<n>	км/мили/градусы".
Возможность	ввода	широты	и	долготы	через	запятую.
Улучшено	изменение	размера	боковой	панели,	положение	запоминается.
Редактор	фамилий	стал	более	понятным.
Порядок	кнопок	в	Видах	не	изменяется	при	перезапуске	Gramps.
Улучшено	отображение	прогресса	для	ресурсоёмких	операций.
Окна	запоминают	размер/положение.
В	Графики	добавлена	Двусторонняя	веерная	карта.
В	Географию	добавлена	поддержка	kml.

Места

Добавлена	возможность	поиска	альтернативных	названий	мест	при	выборе	местоположений.

Отчёты,	Инструменты,	Грамплеты

Новый	генеалогический	отчет
Редактор	формата	мест	и	параметры	для	многих	отчетов
Редактор	формата	даты	и	параметры	для	многих	отчетов
Параметр	для	обработки	живых	людей	в	отчетах
Инструмент	ReorderIDs	обновлён;	теперь	может	работать	с	пользовательскими	ID(идентификаторами)	(например	GetGov	IDs).
Веб	отчёт	дополнен	настройками	и	изменён	внешний	вид

вывод	на	различных	языках
вывод	даты
страница	статистики
включение	всех	(без	ссылок)	документов
родство	с	центральным	лицом	на	индивидуальных	страницах

Добавлен	выбор	размера	изображений	в	параметры	Граф	семейных	линий
Улучшены	отчёты	о	потомках
Добавлены	настройки	в	Полный	индивидуальный	отчёт

выбор	для	включения	заметок
данных	о	переписи
родство	с	центральным	лицом
включение	GrampsID,	меток,	атрибутов

Включение	всех	типов	мест	в	отчёт	о	местах
Выбор	отображения	линий	в	Графе	отношений,	Семейных	линиях,	Песочных	часах

Новый	иснтрумент:	Чистка	данных	-	удаление	лишних	пробелов.

Импорт/Экспорт

Gedcom	поддерживает	больше	нестандартных	'меток'	и	дополнительных	стандартных	меток
GEDCOM	5.6.0	поддерживает	пользовательские	события	при	экспорте
сжатие	при	экспорте	в	XML

Новые	дополнения

График	Quilt:	представление	древа	в	виде	графика.
Расширенный	менеджер	дополнений:	менеджер	дополнений	с	дополнительными	возможностями.
Граф	"Песочные	часы":	использование	LaTeX.
Импорт	и	слияние:	сравнивает	внешнюю	базу	данных	(Gramps	XML)	с	текущим	древом	и	предоставляет	возможность	слияния
изменений.
Проверка	связи	данных:	проверка	данных	на	связанность	с	лицами.

Внутренние	изменения
Изменения	для	поддержки	различных	баз	данных	(SQLite,	PostgreSQL,	MongoDB	и	др.)
Сообщения	о	повреждении	базы	данных	(обработка	несуществующих	объектов),	которые	раньше	скрывались	теперь	выводятся	как
ошибки.	Возможно	придётся	запустить	инструмент	проверки	базы	данных	для	исправления	этих	ошибок.
Предотвращение	закрытия	пользователем	программы	при	выполнении	длительных	операциях.

Зависимости

Поддерживается	только	python3.	(Python2	больше	не	поддерживается	с	января	2020	EOL)
Требуются	GTK+	3.10	и	PyGObject	3.12	или	старше.
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Дополнительная	информация

Локализация

Обновлены	переводы	для	языков:	ca,	cs,	da,	de,	en_GB,	eo,	fr,	fi,	hu,	is,	it,	lt,	nb,	nl,	pt_BR,	pt_PT,	ru,	sk,	sl,	uk,	vi

Планы

Информация	по	предыдущим	версиям	Gramps
Планы	на	следующую	версию.
Gramps	Enhancement	Proposals	(GEPS)	-	В	колонке	Released	указано	внесены	ли	доработкив	в	Gramps	6.0
Планы	на	6.0	-	Вики

Изменения

Информация	по	изменению	в	Gramps	6.0	на	баг-трэкере.

Дополнительная	информация	по	сборкам	Gramps:
Gramps	6.0.0
Gramps	6.0.1
Gramps	6.0.2

История

Страница	Предыдущий	выпуск	содержит	ссылки	основных	изменений	между	версиями.

Однако	страницы	Что	нового?	более	ранних	версий	могут	содержать	дополнительныую	информацию:

Version	5.0
Version	4.2
Version	4.1
Version	4.0
Version	3.4
Version	3.3
Version	3.2

Обзор	доработок	в	первые	был	добавлен	в	руководство	2010	года.	В	первые	3	года	существования	вики,	было	необходимо	обрабатывать
все	руководства.

Version	3.1	-	Полное	руководство
Version	3.0	-	Полное	руководство

Создание	документации	на	MediaWiki	было	начато	2006.	До	редакции	2.9	руководства,	документация	была	включена	в	программу
Gramps.	Руковдство	стало	доступно	для	загрузки	начиная	с	Gramps	3.0.

Gramps	2.2	(версия	руководства	2.9)

Пред Содержание След
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Начало

Пред Содержание След

В	этой	главе	мы	рассмотрим	основы	Gramps.	Сначала	мы	познакомимся	с	базовыми	понятиями,	затем	покажем	как	запустить	Gramps	и
как	получить	помощь,	когда	это	необходимо.

Обзор	Gramps
Gramps	это	бесплатный	продукт	с	открытым	исходным	кодом,	разработанный	как	гибкий	и	мощный	инструмент	для	генеалогических
исследований.	Он	может	быть	использован	как	захотите,	не	существует	одного	единственного	метода	работы	и	ввода	данных	с	ним.
Поэтому	перед	тем	как	погрузиться	в	инструкции	по	использованию,	желательно	получить	представление	о	том,	как	он	работает.

Gramps	разделяет	всю	генеалогическую	информацию	на	9	базовых	групп:

Люди
Семьи
События
Заметки
Документы
Цитаты
Источники
Места
Хранилища

Каждая	группа	состоит	из	отдельных	элементов.	Вы	можете	помещать	их	в	семейное	древо	один	за	другим	в	произвольном	порядке.
Например,	можно	сначала	занести	в	древо	сведения	о	Людях,	а	затем	связать	их	с	помощью	элементов	Семья.	Или	начать	с	Источников	и
создавать	Людей	только	если	это	гарантируется	Вашими	исследованиями.	Или	Вы	можете	смешивать	эти	стили	ввода	данных,	добавляя
Заметки	и	Источники,	затем	Семьи,	затем	опять	возвращаться	к	Заметкам	и	Источникам.	Одним	словом,	Вы	можете	проводить
генеалогические	исследования	как	пожелаете.

Если	у	Вас	появились	вопросы	в	Gramps	существует	сообщество	пользователей	и	разработчиков.	Также	доступны	ЧаВо	(список	часто
задаваемых	вопросов);	почтовые	списки	рассылки;	Баг-трекер	проекта	Gramps;	и	on-line	чат.

Связи

Элементы	этих	девяти	групп	можно	связывать	между	собой	множеством	способов.	Некоторые	связи	образуются	неявно.	Например,	при
добавлении	человека	в	семью	в	качестве	родителя	или	ребенка,	автоматически	создаются	специальные	связи,	называемые	Ссылки.	Вы
можете	увидеть	семьи,	с	которыми	связан	человек,	во	вкладке	Ссылки	на	главном	окне	лица.	Существует	много	других	способов	увидеть
связи	в	Gramps,	в	том	числе	Вид	Отношения.

Чтобы	избежать	дублирования	информации	Gramps	позволяет	повторно	использовать	элементы.	Для	этого	тоже	создаются	специальные
связи.	Например,	с	лицом	может	быть	связано	множество	заметок.	Если	в	заметке	упоминается	два	разных	человека,	то	имеет	смысл
сделать	эту	заметку	общей	для	двух	лиц.

Некоторые	связи	сами	по	себе	содержат	информацию.	Например,	вы	можете	связать	человека	с	событием	свадьбы	другой	пары,	потому
что	этот	человек	являлся	свидетелем	на	их	свадьбе.	В	этом	случае	муж	и	жена	будут	связаны	событием	свадьбы,	которое	будет	иметь
главную	роль,	а	свидетель	будет	выполнять	другую	роль,	роль	свидетеля.	Эта	информация	сохраняется	в	самой	ссылке	в	свойстве	роль.

Конфиденциальность

В	Gramps	существует	два	метода	для	защиты	конфиденциальных	данных.	Эти	методы	используются	при	обмене	данными	с	другими
людьми	путем	создания	отчетов,	экспорта	данных,	создания	веб-сайта.

Первый	метод	защищает	информацию	о	тех	людях,	которых	Gramps	считает	живыми.	Если	вы	специально	не	указали,	что	человек	мёртв
(добавлением	события	Смерть),	то	Gramps	сам	попытается	с	помощью	сложного	алгоритма	определить	жив	человек	или	нет.	При
использовании	этого	метода	данные	ныне	живущих	людей	будут	преобразованы.	Например,	человек	по	имени	"Петров,	Иван"	будет
присутствовать	в	отчетах	в	виде	"Петров,	[Живой]".

Второй	метод	защиты	конфиденциальных	данных	-	это	флажок	"Приватная	запись"	у	каждого	элемента.	Допустим,	у	Вас	в	заметках
находятся	конфиденциальные	данные.	Если	пометить	эти	заметки	как	приватные,	они	не	будут	показаны	в	отчётах	и	при	экспорте.	Так	же
помните,	что	некоторые	связи	сами	по	себе	могут	быть	помечены	как	приватные.	Это	полезно,	если	Вы	хотите	скрыть	от	посторонних
глаз	связь	человека	с	событием,	но	хотите	видеть	этого	человека	и	событие	в	отчетах,	при	экспорте	и	на	веб-сайте.

Fig.	2.1	Конфиденциальность	в
отчётах

Чтобы	эти	методы	защиты	конфиденциальных	данных	заработали,	Вам	нужно	специально	включить	их	использование	при	создании
отчётов	или	при	экспорте	данных.
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GEDCOM

Gramps	наследует	свою	внутреннюю	структуру	от	стандарта	GEDCOM.	Тем	не	менее,	там,	где	необходимо,	Gramps	расширяет
возможности	стандарта.	Если	планируете	использовать	Ваши	данные	в	другой	программе,	использующей	стандарт	GEDCOM,	вероятно,
захотите	ограничить	использование	специфичных	для	Gramps	расширений.	С	другой	стороны,	если	Вы	не	ограничены	другими
генеалогическими	программами,	можете	вводить	данные	любым	разумным	способом.

Вы	можете	узнать	больше	об	этой	проблеме	на	странице	Gramps	и	GEDCOM.

Запуск	Gramps
Лучший	способ	научиться	использовать	Gramps	-	работать	с	ним.	Давайте	начнём!

Способ	запуска	Gramps	зависит	от	Вашей	операционной	системы.

Gramps	можно	запустить	как	с	помощью	обычного	графического	интерфейса	пользователя	(GUI),	так	и	с	помощью	командной	строки
(CLI).	Из	командной	строки	Gramps	может	создавать	отчёты,	которые	недоступны	из	графического	интерфейса,	а	также	проводить
преобразования	и	т.д.	без	открытия	окна	Gramps,	и	даёт	возможность	просматривать	дополнительную	информацию,	которая	может
сигнализировать	о	проблемах.	Подробнее	смотрите	в	разделе	Командная	строка.

Linux

Официально	Gramps	поддерживает	только	платформу	Linux.	Разработчики	создают	и	тестируют	на	этой	платформе	исходный	код	и
решают	все	проблемы,	возникающие	в	процессе	развития	Gramps.

Если	Вы	используете	стандартный	менеджер	пакетов	(и	в	графическом	режиме,	и	в	режиме	командной	строки)	-	запуск	Gramps
выполняется	обычным	для	Вашего	дистрибутива	образом.	Например,	для	Ubuntu	18.04	можно	воспользоваться	иконкой	на	панели	запуска
или	запустить	Gramps	из	Dash.	Для	других	дистрибутивов	Gramps	обычно	находится	в	меню	Программы	(чаще	всего	в	раздел	Офис).

Запуск	Gramps	из	командной	строки	в	Linux	описан	здесь.

MS	Windows

Gramps	для	платформы	MS	Windows	поддерживается	сообществом.	Если	вы	установите	пакет	Windows	AIO	GrampsAIO32	или
GrampsAIO64,	то	значок	Gramps	появится	на	рабочем	столе	и	в	меню	'Пуск'	и	запустить	Gramps	можно	нажатием	на	этот	значок.

Запуск	Gramps	из	командной	строки	в	Windows	описан	здесь.

Существуют	и	другие	способы	установки	Gramps	для	Windows,	но	они	гораздо	сложнее	и	здесь	не	описаны.

Mac	OS	X

Gramps	для	платформы	Mac	OS	X	поддерживается	сообществом.	После	скачивания	образа	диска	Mac	OS	X	(.dmg)	достаточно	поместить
его	в	вашу	папку	с	приложениями	(или	в	любое	другое	место,	куда	вы	пожелаете)	и	Gramps	можно	будет	запустить	самым	обычным
образом	двойным	щелчком	кнопкой	мыши.

Запуск	Gramps	из	командной	строки	в	Mac	OS	X	описан	здесь.

Существуют	и	другие	способы	установки	Gramps	для	Mac	OS	X,	но	они	гораздо	сложнее	и	здесь	не	описаны.

Выбор	семейного	древа
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Рис.	2.2	Первый	запуск	Gramps,	семейное	древо	не	выбрано	(Gramps	6.0.0)

Если	после	запуска	Gramps	семейное	древо	еще	не	выбрано	-	начальное	окно	будет	малофункциональным.	Большинство	операций	ещё
недоступно.	Чтобы	загрузить	семейное	древо	(его	ещё	называют	базой	данных)	выберите	меню	Семейные	древа->Управление
семейными	древами,	чтобы	открыть	окно	Семейные	древа,	или	нажмите	иконку	 Семейные	древа 	на	панели	инструментов.	Gramps
запоминает	семейные	древа,	которые	Вы	недавно	загружали,	и	их	можно	снова	загрузить,	нажав	на	стрелку	рядом	с	кнопкой	
Семейные	древа 	и	выбрав	нужное	из	выпадающего	списка.

Для	получения	более	детальной	информации	по	окну	"Семейные	древа"	и	соответствующему	меню	-	смотрите	посвященную	этой	теме
главу:	Управление	семейными	древами.

Покажите,	как	начать	прямо	сейчас!
Мы	советуем	всем	сначала	прочитать/просмотреть	это	руководство	целиком,	чтобы	изучить	все	детали	Gramps.	Генеалогические
исследования	требуют	времени,	поэтому	не	поленитесь	ознакомиться	с	инструментами,	время	не	будет	потрачено	напрасно.

Тем	не	менее,	если	для	того,	чтобы	начать,	Вам	нужен	только	минимум	знаний	-	читайте	статьи:

Gramps	6.0	-	Ввод	и	редактирование	данных:	кратко
Введение	в	генеалогию	с	Gramps.

Помощь
В	Gramps	есть	меню	Справка,	к	которому	Вы	можете	обратиться	в	любой	момент.

Более	подробно	смотри	в	разделе	Справка.

Пред Содержание След
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Главное	окно

Пред Содержание След

Fig.	3.1	Example	of	a	Gramps	Main	Windows

Элементы	главного	окна	или	Обзор	интерфейса	Gramps.

Графический	интерфейс	пользователя	(GUI)	способ	представления	информации	на	экране	компьютера,	который	проще	понять	и
использовать,	потому	что	отображаются	значки,	меню,	также	доступна	мышь,	а	не	только	текст.

GUI	более	интуитивный,	чем	запоминание	команд	с	клавиатуры.	Трудно	найти	документацию	по	команде	незная	названия	функции.
Много	элементов	Gramps	не	подписано,	чтобы	уменьшить	отступы	и	увеличить	зону	отображения	генеалогической	информации.	Также
можно	отключить	в	настройках	отображение	текста	на	кнопках	(значках)	и	в	Навигаторе.

В	этом	разделе	представлены	названия	элементов	интерфеса	Gramps.	Зная	названия,	Вы	можете	более	эффективно	использовать	поиск
(как	Google)	страниц	в	руководстве,	где	упоминаются	эти	элементы.	Например,	для	поиска	страниц	связанных	с	фразой	"Navigator	Mode",
используйте	Google	запрос:

		"navigator	mode"	site:gramps-project.org/wiki

К	результату	поиска	будут	также	добавлены	изображения.	При	выборе	изображения	будет	открыта	страница	с	описанием	изображения	и
где	оно	используется	в	документации.	Эти	иллюстрированные	страницы	имеют	вводное	значение.

Если	элемент	интерфейса	не	встречается	на	изображениях	ниже,	смотрите	Gramps	снимки	экрана.	Эта	страница	содержит	Gramps	снимки
экрана	используемые	в	документации.	Нажмите	на	изображении	для	дополнительной	информации,	затем	прокрутите	до	раздела
"Использование	файла"	для	получения	списка	страниц	с	этим	изображением.	Также	на	странице	Значки	Gramps	содержатся	имена
значков	используемых	в	Gramps.

Когда	познакомитесь	с	элементами	интерфейса,	изучите	горячие	клавиши	для	быстрого	доступа	к	распространённым	функциям.

Главное	окно
При	открытии	существующего	или	создании	нового	семейного	древа	будет	показана	приборная	доска	со	скрытыми	боковой	и	нижней
панелями.	При	выборе	категории	Люди	в	навигаторе,	главное	окно	будет	обновлено	и	отобразит	"Список	людей"	(Рис.	3.2):	Главное	окно
Gramps	содержит	следующие	элементы:

Заголовок
Главное	меню
Панель	инструментов

Search	Bar	(Present	only	if	Sidebar	is	not	displayed.)(Not	shown	on	Dashboard)

Навигатор Область	отображения боковая	панел
(Not	shown	on	Dashboard)

Нижняя	панел	(Not	shown	on	Dashboard)

Индикатор	прогресса	и	статусная	строка
Fig.	3.2	Textual	representation	of	Gramps	interface
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Заголовок

Заголовок	окна	показывает	название	открытого	семейного	древа,	категорию	текущего	вида,	название	программы	и	кнопки	для
свертывания,	развертывания	и	закрытия	окна	Gramps.	Нажав	на	заголовок	можно	перемещать	окно	по	экрану.

Главное	меню

Главное	меню	расположено	в	верхней	части	окна	(сразу	под	заголовком)	и	предоставляет	доступ	ко	всем	функциям	Gramps.
Меню	являются	контекстными	-	состав	зависит	от	активной	категории.
При	щелчке	по	меню	откроется	вложенное	меню.	Элементы	меню	могут	быть	серыми	(недоступными),	если	их	нельзя	применить	к
текущему	объекту.

Ссылки	на	меню	в	руководстве	будут	выглядеть	так:	Меню	->	Подменю	->	Элемент	меню.

Видимость	элементов

Используйте	меню	 Вид ,	чтобы	скрыть	или	показать	элементы	Главного	окна.
Дополнительн	доступны	параметры	отображения	элементов	--	подписи	элементов,	прокрутка	и
кнопки	закрытия.

Выпадающее	меню

Fig.	3.3	Стрелка	вниз	 ∨ 	кнопка	выпадающего	меню

На	панелях	меню	расположена	Стрелка	вниз	 ∨ 	кнопка	без	подписи	выпадающее	меню,	где	доступны	дополнительные	возможности.

Всплывающее	меню

Fig.	3.4	Буфер	обмена	-	с	примером	всплывающего	меню	для
семьи

Большинство	невидимых	параметров	расположены	в	контекстных	всплывающих	меню.

Щелчок	правой	кнопкой	на	элементе	интерфейса	откроет	меню	с	часто	используемыми	функциями	для	этого	объекта.
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Fig.	3.5	Редактор	лица	-	с	примером	всплывающего	меню	для
заголовка

Щелчок	правой	кнопкой	на	элементе	интерфейса	распространенное	действие.	Однако,	щелчок	на	пустой	области	заголовка	редакторов	не
интуитивен,	но	содержит	дополнительные	возможности	и	параметры.

Панель	инструментов

Панель	инструментов	расположена	прямо	под	главным	меню.	Она	предоставляет	доступ	к	наиболее	часто	используемым	функциям
Gramps.
Состав	инструментов	зависит	от	выбранной	категории.

⚙	Параметры:	большинство	Видов	имеют	 Настройки... 		кнопку,	она	соответствует	меню	Вид	➡	Настроить	вид...	или
комбинации	клавиш	для	Настройки	активного	вида.	Будет	открыт	диалог	с	настройками	активного	Вида.
При	наведении	мыши	на	инструмент	покажет	подсказку	с	функциями	инструмента

Рис.	3.6	Подсказка	для	кнопки	Инструменты	на	панели
на	приборной	доске

Панель	можно	скрыть	или	отобразить	с	помощью	меню	Вид	->	Панель	инструментов.

Установка	сторонних	дополнений

добавляет	возможность	в	Gramps	показывать	подписи	на	панели	инструментов	для	каждой
кнопки.	Дополнение	Темы	расширяет	диалог	Настроек	вкладкой	Темы.

Один	из	параметров	на	вкладке	Темы	☑	 Текст	на	панелях .	При	его	выборе	появятся	подписи
на	панелях.
Этот	флажок	❏	не	выбран	по	умолчанию.

Рис.	3.7	Дополнительная	вкладка	Темы	в	диалоге	настроек
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Навигатор

Навигатор	расположен	в	левой	части	окна	и	позволяет	переключаться	между	категориями.	Подробнее	о	категориях	смотрите
Категории	навигатора.

Навигатор	можно	скрыть	или	отобразить	с	помощью	меню	Вид	->	Навигатор	или	комбинации	клавиш	 CTRL + M .

Смотрите	также:

Режимы	навигатора
Чтобы	скрыть	подписи	используйте	параметр	 Показывать	текст	на	кнопках	навигации 	на	вкладке	Правка	-
>Настройки...>Отображение.

Область	отображения

Область	отображения	-	это	область	в	центре	окна	Gramps.	Содержимое	области	отображения	зависит	от	выбранного	в	данный
момент	вида.	Подробно	виды	будут	рассмотрены	позднее.

Индикатор	прогресса	и	статусная	строка

Индикатор	прогресса	и	статусная	строка:	Располагаются	в	самой	нижней	части	окна	Gramps.
Индикатор	прогресса	расположен	в	левом	нижнем	углу	окна	Gramps.	Он	отображает	прогресс	выполнения	длительных	по
времени	операций,	таких	как	открытие	и	сохранение	больших	баз	данных,	импортирование	и	экспортирование	информации	в
другие	форматы,	создание	веб-сайтов	и	др.	Когда	Вы	не	совершаете	подобные	операции,	индикатор	прогресса	не
отображается.
Статусная	строка	расположена	справа	от	индикатора	прогресса.	Она	отображает	информацию	о	текущей	деятельности	Gramps
и	контекстную	информацию	о	выбранных	объектах.
В	статусной	строке	также	могут	отображаться	уведомления.	Кнопка	 Внимание 	(изображена	ниже)	будет	показана	на	3
минуты	слева	от	строки	статуса.	При	щелчке	по	ней	бутут	показаны	подробности	этого	уведомления.

Рис.	3.8	Уведомление	в	строке	статуса

Нижняя	и	боковая	панели

The	 Панель	грамплетов 	также	называемая	нижней	и	боковой	панелями.

Нижняя	панель:	Нижняя	панель	расположена	в	нижней	части	области	отображения.
Боковая	панель:	Боковая	панель	расположена	в	правой	части	области	отображения.

Боковая	и	нижняя	панели	могут	быть	индивидуально	включены	или	отключены	через	меню	Вид.	Если	боковая	панель	отключена	-	вместо
неё	отображается	 Панель	поиска .

Нижняя	и	боковая	панели	используются	грамплетами	и	фильтрами	для	отображения	соответствующей	информации.

Панели	грамплетов	-	меню
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Fig.	3.9	Расположение	меню	на	панели	грамплетов

Вы	можете	добавить	/	удалить	и	восстановить	Грамплеты	из	выпадающего	меню	 ∨ 	(кнопка	Стрелка	вниз)	справа	от	названий:

Меню	панели	грамплетов
Добавить	грамплет 	-	отображает	список	доступных	грамплетов	для	этой	панели
Удалить	грамплет 	-	отображает	список	добавленных	на	панель	грамплетов,	доступных	для	удаления.
Восстановить	грамплеты	по	умолчанию 	-	открывает	диалог	 Восстановить	параметры	по	умолчанию? ,	для
приведения	панели	к	начальному	виду.

Восстановить	параметры	по	умолчанию?

Рис.	3.10	Диалог	восстановления	грамплетов

Этот	диалог	позволяет	вернуть	панель	к	первоначальному	виду.	Это	действие	не	может	быть	отменено.	Для	подтверждения	действия
нажмите	 OK ,	а	для	отмены	 Отменить .	

Панель	поиска

Рис.	3.11	Категория	люди	-	отображение	панели	поиска	(боковая
панель	скрыта)

Если	боковая	панель	скрыта	в	Виде	со	списком,	то	отображается	 Панель	поиска .	Доступные	параметры	поиска	зависят	от	категории
Вида	в	котором	Вы	находитесь.	Панель	поиска	скрывается	при	открытии	боковой	панели.
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

Рис.	3.12	Категория	семья	-	отображение	боковой	панели	(панель
поиска	скрыта)

Панель	поиска 	доступна	для	следующих	Видов	и	Категорий:	Люди,	Семьи,	События,	Места,	Источники,	Цитаты,	Хранилища,	Альбом,
Заметки.	Панель	не	доступна	в:	Приборная	панель,	Отношения,	Графики,	География.

Введя	текст	в	 Панели	поиска 	и	нажав	кнопку	 Найти 	будут	отображены	строки	содержащие	этот	текст.

Панели	поиска	также	доступны	в	 Диалогах	выбора :

Выбор	семьи

Рис.	3.13	Выбор	семьи	-	с	панелью	поиска

Search	Bar

Режимы	навигатора
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Рис.	3.14	Выбор	режима	навигатора

Вы	можете	переключаться	между	режимами	с	помощью	выпадающего	списка:

Категории	(по	умолчанию)
Выпадающая
Расширяющаяся

Категории	(по	умолчанию)

рис.	3.15	Режим	категорий

Выбор	категорий	из	списка.

Выпадающая

Рис.	3.16	Режим	выпадающего	списка

Выбор	категорий	и	видов	из	выпадающих	списков.

Расширяющаяся
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Рис.	3.17	Режим	расширяющегося	списка

Выбор	видов	производится	из	раскрываемых	категорий.

Примечание

В	менеджере	дополнений,	режимы	навигации	имеют	тип	"боковой	панели".	Это	не	совсем
корректно,	потому	что	пункт	меню	Вид	->	Боковая	панель	управляет	правой	боковой	панелью,	а
не	левой	панелью	категорий.

Категории
Gramps	устанавливается	вместе	со	стандартными	категориями.	Эти	категории	описаны	в	главе	Категории	навигатора.

Дополнительные	виды

Вы	можете	добавлять	новые	виды	с	помощью	установки	дополнительных	модулей.	Виды	для
существующих	категорий	будут	добавлены	в	эти	существующие	категории.	Если	вид	уже
существует,	он	будет	обновлён,	а	если	же	вид	принадлежит	новой	категории	-	эта	категория	будет
добавлена	в	навигатор.

Выбор	категории	зависит	от	текущего	режима	навигатора.	Обычно	(для	большинства	режимов)	категория	выбирается	щелчком	по
соответствующей	иконке	в	навигаторе.

Также	для	перехода	к	следующей	или	предыдуещй	категории	вы	можете	использовать	комбинации	клавиш	 CTRL + N 	и	 CTRL + P .	Также
доступны	комбинации	клавиш	 CTRL + Alt + <цифра> 	для	первых	10	категорий	(такие	как	Хранилища/Альбом/Заметки	не	доступны.)	Если
Вы	скрыли	навигатор	-	это	будет	единственный	способ	переключиться	между	категориями	(до	тех	пор,	пока	Вы	его	не	включите).

Виды
Каждая	категория	может	содержать	различные	способы	представления	данных,	называемые	Видами.	Если	режимов	видов	несколько	-
между	ними	можно	переключаться.	Способ	переключения	видов	зависит	от	категории.

В	видах	с	таблицами	обычно	присутствует	иерархическое	(сгруппированное)	представление	и	просто	сортированный	список.	В
некоторых	графических	категориях	видов	(например,	Графики	и	География)имеется	множество	режимов.

Рис.	3.18	Навигатор	в	режиме	расширяющегося	списка

В	некоторых	режимах	на	панели	инструментов	присутствуют	кнопки	для	включения	видов.	Также	можно	переключить	вид	с	помощью
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меню	Вид	или	воспользоваться	комбинациями	клавиш	 CTRL + Alt + <число> ,	где	<число>	-	это	порядковый	номер	вида	в	категории.

Навигатор	по	умолчанию	находится	в	режиме	Категории.	При	использовании	режимов	выпадающего	или	расширяющегося	списка	будут
доступны	дополнительные	возможности.	

Фильтры

Рис.	3.19	Управление	фильтрами

Семейное	древо	обычно	хранит	информацию	о	большом	количестве	людей,	семей,	мест	и	других	объектах.	Поэтому	виды	могут
содержать	очень	длинные	списки	данных,	с	которыми	трудно	работать.	Gramps	предоставляет	два	способа	борьбы	с	этой	проблемой
позволяя	сузить	списки	объектов	до	приемлемого	размера.

Этими	метадами	являются	Поиск	и	Фильтрация.

Поиск	производит	поиск	по	текстовым	данным	в	таблице,	а	фильтр	показывает	людей,	чьи	данные	соответствуют	критериям	фильтра.

Поиск	-	простой	и	быстрый	способ	найти	текст	в	колонках,	показанных	на	экране.	Когда	боковая	панель	скрыта	-	отображается	 Панель
поиска .	Напечатайте	в	ней	текст	и	нажмите	кнопку	 Найти .	После	этого	в	таблице	будут	оставлены	только	те	строки,	которые	содержат
указанный	текст.

Другой	способ	-	включить	фильтр	на	боковой	панели.	Когда	боковая	панель	на	экране	-	 панель	поиска 	скрыта.	Фильтры	позволяют
Вам	интерактивно	создавать	набор	правил	фильтрации	и	применять	их	к	текущему	списку.	Фильтрация	основана	на	правилах	и	данных,	а
не	на	отображении	на	экране.	Фильтры	для	отображаемой	категории	можно	создать,	выбрав	пункт	меню	Правка	->	Редактор
фильтров....

Подробнее	о	работе	с	фильтрами	смотрите	в	соответствующем	разделе.

Поиск	или	Фильтры?

Поиск	ищет	только	текстовые	совпадения.	Если	дата	отображается	как	"Янв	1,	2000"	и	в	поле
поиска	ввести	"1/1/2000",	то	найдено	ничего	не	будет.	Однако,	фильтр	по	дате	со	значением
"1/1/2000"	сработает	правильно.

При	открытии	Gramps	все	фильтры	отключены.	Например,	вид	"Люди"	отобразит	всех	людей	из	семейного	древа.

Устранение	проблем
Если	интерфейс	Gramps	не	соответствует	описаниям	выше	в	руководстве,	возможно	имеются	небольшие	проблемы	установки	или
совместимости.

Возможно	такое	поведение	было	замечено	ранее	и	уже	найдено	решение.

Сначала	посмотрите	в	разделе	Устранение	проблем.	Если	не	удаётся	найти	решение	там,	напишите	о	проблеме	в	список	рассылки
Gramps.	Мы	стараемся	там	помогать	друг	другу.	

Пред Содержание След
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Категории

Пред Содержание След

Генеалогические	исследования	могут	содержать	большой	объём	информации.	Трудности	отображения	такой	информации	в	Gramps
решается	разделением	её	по	категориям,	которые	в	свою	очередь	отображают	информацию	с	помощью	видов.	Каждый	вид	отображает
часть	общей	информации	в	соответствии	с	категорией.	Это	станет	яснее,	после	знакомства	с	категориями.

Категории	навигатора
Навигатор	расположен	в	левой	части	окна	и	предназначен	для	быстрого	переключения	между	категориями.
Категории,	представленные	в	Навигаторе:

	Приборная	доска:	Показывает	различные	грамплеты	-	небольшие	программы,	которые	могут	помочь	Вам	в	генеалогических
исследованиях.

	Люди:	Показывает	список	людей	в	семейном	древе	без	их	связей	между	собой.	Имеет	два	представления:	плоское	и
древовидное.

	Отношения:	Показывает	отношения	между	выбранным	лицом	и	другими	людьми.	Включает	родителей,	супругов,	детей.

	Семьи:	Показывает	список	семей	в	семейном	древе.

	Графики:	Показывает	в	графическом	виде	семейное	древо	для	выбранного	лица.

	События:	Показывает	список	событий	в	семейном	древе.

	Места:	Показывает	список	мест	в	семейном	древе.

	География:	Отображает	данные	из	семейного	древа	на	карте.

	Источники:	Показывает	список	источников	семейного	древа.

	Цитаты:	Показывает	список	цитат	в	семейном	древе.

	Хранилища:	Показывает	список	хранилищ	информации	в	семейном	древе.

	Альбом:	Отображает	список	медиа-объектов	(фотографии,	аудио-,	видео-документы	и	пр.)	в	семейном	древе.

	Заметки:	Показывает	список	заметок	в	семейном	древе.

Данные	из	каждой	категории	могут	быть	показаны	в	нескольких	вариантах.	Каждый	такой	вариант	называется	"вид".	Например:

Категория
Вид	(1)
Вид	(2)

Для	каждой	категории	существует	несколько	вариантов	переключения	между	Видами:

1.	 Выбор	соответствующего	значка	на	панели	инструментов
2.	 Использовать	меню	Вид	>	...
3.	 Через	комбинации	клавиш.	Смотри	комбинации	для	Изменения	видов	по	цифре	0/1/2/../9

Эта	страница	содержит	краткое	описание	каждой	категории	и	видов	в	ней.

Приборная	доска
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Рис.	4.1	Приборная	доска

Эта	категория	предназначена	для	отображения	грамплетов.	Грамплеты	-	это	небольшие	программы	или	виджеты,	помогающие	вам	в
генеалогических	исследованиях.	Два	грамплета	включены	по	умолчанию	("Добро	пожаловать"	и	"Топ-10	фамилий").	Другие	грамплеты
можно	добавить,	щелкнув	правой	кнопкой	мыши	по	свободному	месту	окна	программы	и	выбрав	из	появившегося	списка.

Возраст	на	заданную	дату	-	просмотр	живых	людей	и	их	возраст	на	заданную	дату
Статистика	по	возрастам	-	просмотр	графиков	статистики	по	возрастам
Атрибуты	-	просмотр	атрибутов	выбранного	лица
Календарь	-	показывает	события,	произошедшие	в	указанный	день	и	месяц
Потомки	-	просмотр	потомков	выбранного	лица
Веерная	карта	-	просмотр	родословной	выбранного	лица	в	виде	круговой	диаграммы
Облако	имён	-	самые	популярные	имена	в	виде	"текстового	облака"
Быстрый	просмотр	-	показывает	статистику	по	поколениям	потомков	для	выбранного	лица
Рекорды	-	просмотр	рекордов	в	семейном	древе
Журнал	сессии	-	показывает	какие	сделаны	изменения,	и	какие	просмотрены	записи	в	вашем	древе	с	момента	последнего	запуска
Gramps
Статистика	-	показывает	статистику	по	семейному	древу
Облако	фамилий	-	самые	популярные	фамилии	в	виде	"текстового	облака"
Список	дел	-	блокнот	для	планирования	ваших	исследований
Топ-10	фамилий	-	10	самых	популярных	фамилий
Добро	пожаловать	-	окно	приветствия	Gramps
Что	дальше?	-	что	можно/нужно	сделать	дальше

Список	дополнительных	грамплетов,	которые	можно	легко	установить	и	использовать:

Headline	News	-	текущие	новости	с	сайта	Gramps
Birthdays	-	показывает	дни	рождений	ныне	живущих	лиц	из	семейного	древа	на	ближайший	год
Python	-	командная	строка	языка	Python
Note	-	просмотр	и	редактирование	главной	заметки	выбранного	лица

А	так	же	можно	ознакомиться	с	полным	списком	дополнительных	модулей.

Более	подробно	об	установке	и	использовании	грамплетов	смотрите	в	разделе	Грамплеты.

Люди
Категория	Люди	состоит	из	двух	видов:	"Дерево	фамилий"	и	"Список	лиц".	Вид	"Дерево	фамилий"	показывает	список	людей,
сохраненных	в	вашем	семейном	древе	(смотрите	Рис.	4.2).	Люди	группируются	по	фамилиям.	Слева	от	каждой	фамилии	расположен
значок	(обычно:	+),	по	нажатию	на	который	разворачивается	список	людей	с	выбранной	фамилией.	Повторное	нажатие	на	этот	значок
приводит	к	сворачиванию	списка	обратно.

Информация	о	каждой	персоне	в	списке	лиц	разбита	на	несколько	колонок.

Рис.	4.2	Дерево	фамилий
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Рис.	4.3	Список	лиц

Отношения

Рис.	4.4	Отношения

Категория	"Отношения"	показывает	всех	ближайших	родственников	выбранного	лица.	В	частности,	показаны	его	родители,	братья,
сестры,	супруги	и	дети.

Категория	"Отношения"	предназначена	для	быстрой	навигации.	Выбрать	другого	человека	можно	просто	щелкнув	по	его	имени	на
экране.	Каждое	имя	представляет	собой	ссылку,	похожую	на	ссылки	на	страницах	в	интернете.

Имя	выбранного	лица	выделяется	жирным	шрифтом.	Имена	других	людей	выделяются	жирным	курсивом	в	зависимости	от	того,
существуют	ли	у	них	определенные	отношения.	Для	родителей	или	супругов	выбранного	лица	имена	выделяются,	если	имеется
информация	об	их	родителях.	Для	братьев,	сестер	и	детей	выбранного	лица	имена	выделяются,	если	они	сами	имеют	детей.

Даты	отображаются	в	обычном	стиле,	либо	курсивом	в	случаях	замены	отсутствующих	событий	другими	событиями.	Например,	замена
отсутствующего	события	рождения	событием	крещения	или	замена	события	смерти	событием	похорон	и	т.д.

Категория	"Отношения"	содержит	следующие	разделы:

Выбранное	лицо:	В	верхней	части	экрана	отображаются	имя,	ID,	информация	о	рождении	и	смерти,	рассчитанный	возраст.	Если
доступна	фотография	-	она	отображается	правом	верхнем	углу.	Рядом	с	именем	расположен	символ	пола	и	кнопка	редактирования	

.	Нажатие	на	эту	кнопку	вызывает	форму	 Редактор	лица .

Родители:	Этот	раздел	содержит	семьи,	в	которых	выбранное	лицо	является	ребенком.	Для	людей,	у	которых	несколько	наборов
родителей,	будет	создано	несколько	разделов	Родители.

Используя	меню	Вид	->	Настроить	вид...	вы	можете	управлять	количеством	отображаемой	информации.	Это	меню	позволяет	скрывать
информацию	о	рождении	и	смерти,	и	информацию	о	братьях	и	сестрах.	Рядом	с	каждым	именем	есть	кнопка	редактирования	 ,	которая
позволяет	редактировать	все	детали	для	конкретного	лица.

С	помощью	кнопок	 Добавить 	или	 Добавить	в	семью 	вы	можете	добавить	новый	набор	родителей.	Кнопка	 Добавить 	создает
новую	семью	с	выбранным	лицом	в	качестве	ребенка.	Кнопка	 Добавить	в	семью 	позволяет	добавить	выбранное	лицо	ребенком	в
существующую	семью,	которую	можно	выбрать	из	списка.

Вы	можете	редактировать	семьи	родителей	с	помощью	кнопки	редактирования	 ,	расположенной	рядом	с	ID	семьи.	Если	вы	нажмете	на
кнопку	 - ,	следующую	за	кнопкой	редактирования,	выбранное	лицо	будет	удалено	из	списка	детей	этой	семьи,	но	отношения	между
родителями	не	изменятся.

Внимание

Если	не	проявить	достаточно	внимания,	можно	создать	несколько	семей	с	одинаковым	набором
родителей.	Необходимость	в	этом	возникает	редко,	поэтому	при	попытке	добавить	новую	семью
с	таким	же	набором	родителей,	как	в	существующей	семье,	Gramps	выдаст	предупреждение.	Если
вы	увидели	такое	предупреждение,	то	вероятней	всего	вам	нужно	отменить	создание	новой	и
выбрать	существующую	семью.

Семья:	Этот	раздел	похож	на	раздел	Родители,	только	выбранное	лицо	само	выступает	в	них	в	роли	родителя.	Поскольку	у	одного

Категории	-	Отношения 28

http://www.gramps-project.org/wiki/index.php/File:PersonView-PeopleListView-example-with-context-menu-60.png
http://www.gramps-project.org/wiki/index.php/File:Relationships-category-view-50.png
http://ru.wikipedia.org/wiki/%D0%93%D0%B8%D0%BF%D0%B5%D1%80%D1%81%D1%81%D1%8B%D0%BB%D0%BA%D0%B0
http://www.gramps-project.org/wiki/index.php/File:Gnome-important.png


лица	может	быть	несколько	семей	-	разделов	Семья	может	быть	тоже	несколько.	В	каждом	разделе	Семья	отображаются	супруги	и
их	дети.

Супруги

Мы	используем	термин	супруги	для	упрощения.	Тем	не	менее,	обратите	внимание,	что	супруги	в
действительности	могут	быть	сожителями,	партнерами	в	гражданском	браке	или	состоять	в
любых	других	подобных	отношениях	между	двумя	людьми.	Кроме	того,	супружеские	отношения
возможны	не	только	между	мужчиной	и	женщиной.

Вы	можете	создать	семью	с	помощью	кнопки	 Партнер 	на	панели	инструментов.	Добавится	новая	семья	с	выбранным	лицом	в	качестве
отца	или	матери.

Вы	можете	изменять	параметры	семьи	с	помощью	кнопки	редактирования	 ,	расположенной	рядом	с	ID	семьи.	Если	вы	нажмете	на
кнопку	 - ,	следующую	за	кнопкой	редактирования,	выбранное	лицо	будет	удалено	из	семьи.

Удаление	лица	из	семьи

Удаление	лица	из	семьи	не	приводит	к	удалению	самой	семьи.	Лицо	удаляется	только	с	позиции
отца	или	матери,	а	все	другие	отношения	в	семье	остаются	неизменными.

Примечание

Мы	используем	термины	отец	и	мать	для	упрощения.	Эти	термины	продолжают	использоваться
даже	при	отсутствии	в	семье	детей.	Так	же	эти	термины	используются	в	случае	однополых
отношений.

Вы	можете	изменить	порядок	родителей	и	семей	для	выбранного	лица,	нажав	кнопку	 Упорядочить .	Эта	кнопка	доступна,	только	если	у
выбранного	лица	более	одного	набора	родителей	или	более	одной	семьи.	После	нажатия	на	кнопку	появится	форма,	в	которой	вы	сможете
изменить	порядок	семей.

Рис.	4.5	Форма	"Упорядочить
отношения"

Настройка

Рис.	4.6	Форма	"Настроить	отношения"

Настроить	вид	"Отношения"	можно	с	помощью	формы	 Настроить	отношения 	из	меню	Вид	->	Настроить	вид...	или	нажав	кнопку
Настроить	вид... 	на	панели	инструментов.

Семьи
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Рис.	4.7	Семьи

Вид	категории	"Семьи"	из	показывает	список	семей,	сохраненных	в	вашем	семейном	древе	(см.	Рис.	4.7).	Этот	вид	позволяет	добавлять,
изменять	и	удалять	семьи.	При	стандартных	настройках	отображаются	следующие	колонки:	ID,	Отец,	Мать,	Отношение	и	Дата	брака.
Детей	этот	вид	не	отображает.

Удаление	семьи

В	отличие	от	категории	"Отношения",	нажатие	кнопки	 Удалить 	в	виде	"Семьи"	приводит	к
удалению	семьи	из	базы	данных.	Все	люди	останутся,	но	отношения	между	людьми	в	этой	семье
будут	удалены.

Графики
Эта	категория	содержит	несколько	видов	с	графическим	представлением	семейных	отношений	выбранного	лица.	В	стандартных
настройках	отображается	вид	"Родословная";	Вид	"Веерная	карта"	можно	выбрать	на	панели	инструментов.	Другие	виды	могут	быть
доступны	с	помощью	установки	дополнительных	модулей.

Родословная

Рис.	4.8	Родословная	1

Рис.	4.9	Родословная	-	настройки

Рис.	4.10	Родословная	2
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Рис.	4.11	Родословная	3

Рис.	4.12	Родословная	4

Вид	"Родословная"	отображает	до	пяти	поколений	родственников,	в	зависимости	от	размеров	экрана.	Каждый	человек	представлен	в	виде
прямоугольника,	содержащего	его	имя,	дату	рождения	(помечена	знаком	*),	дату	смерти	(помечена	знаком	+)	и	фотографию	(если
доступна).	Для	умерших	(либо	для	тех,	кого	Gramps	посчитал	умершими)	верхний	левый	угол	прямоугольника	перечеркнут	черной
полоской.	От	каждого	прямоугольника	отходят	две	ветви	-	верхняя	для	отца,	нижняя	для	матери.	Сплошные	линии	отражают	факты
кровного	родства,	а	пунктирные	-	усыновление,	опекунство,	детей	от	предыдущих	браков	и	т.д.

Слева	от	прямоугольника	выбранного	лица	расположена	стрелка.	Если	у	выбранного	лица	есть	дети,	нажатие	на	эту	стрелку	вызовет
список	его	детей.	Нажатие	на	имя	ребенка	в	этом	списке	приведет	к	тому,	что	статус	выбранного	лица	перейдет	к	нему.

Написание	имен	детей	в	списке	отличаются	для	продолжающихся	и	тупиковых	ветвей	родословной.

Имена	детей,	у	которых	у	самих	есть	дети,	выделены	в	списке	жирным	курсивом.	Для	тех,	у	кого	нет	детей	(тупиковая	ветвь),
используется	обычный	шрифт.	Если	у	выделенного	лица	только	один	ребенок,	список	не	вызывается	(потому	что	в	нем	нечего	выбирать)
и	статус	выбранного	лица	сразу	после	нажатия	на	стрелку	переходит	к	этому	ребенку.

В	правой	стороне	окна	расположены	две	стрелки.	При	нажатии	на	верхнюю	стрелку	статус	выбранного	лица	переходит	к	отцу.	При
нажатии	на	нижнюю	-	к	матери.

Рис.	4.13	Контекстное	меню

По	клику	правой	кнопкой	мыши	на	персональном	прямоугольнике	любого	человека	в	родословной	появляется	контекстное	меню.

Среди	других	полезных	элементов,	в	контекстном	меню	есть	подменю	со	списками	 Супругов ,	 Братьев/Сестер ,	 Детей 	и
Родителей 	этого	человека.

Если	данные	о	каких-либо	категориях	родственников	отсутствуют,	соответствующие	пункты	в	контекстном	меню	не	активны
(отрисованы	серым).	Также,	как	и	для	имен	в	списке	детей	выбранного	лица,	имена	родственников,	на	которых	ветвь	родословной
продолжается	или	прекращается,	отличаются	шрифтом.

Обучающее	видео

Вы	можете	посмотреть	видеоуроки	по	добавлению	и	редактированию	семей	(родителей,	детей,
братьев	и	сестер)	из	вида	"Родословная".
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Веерная	карта

Рис.	4.14	Веерная	карта

Вид	"Веерная	карта"	показывает	родословную	в	виде	круговой	диаграммы.	Нажатие	на	имя	человека	на	диаграмме	удваивает	занимаемый
им	сегмент.	Повторное	нажатие	возвращает	обычный	размер	сегмента.	По	клику	правой	кнопкой	мыши	появляется	контекстное	меню,
такое	же,	как	в	виде	"Родословная",	позволяющее	перемещаться	от	одного	человека	к	другому.

Этот	вид	дает	компактное	представление	родословной	и	позволяет	быстро	оценить,	какие	части	родословной	нуждаются	в	дальнейшем
исследовании.

Вы	можете	вращать	диаграмму,	нажав	над	свободной	областью	диаграммы	любой	кнопкой	мыши	и	перемещая	её.	Вы	можете	двигать
диаграмму	за	центральную	(белую)	область.

1.	 Диаграмма	может	представлять	собой	круг,	полукруг	или	четверть	круга.	В	двух	последних	случаях	диаграмма	прикреплена	к
боковой	или	нижней	части	окна

2.	 Дети	центрального	лица	показаны	в	виде	кольца	в	центре
3.	 Перетаскивание	имени	человека	в	центральный	круг	присваивает	ему	статус	выбранного
4.	 Цветовые	настройки

1.	 Цвет	сектора	связан	с	возрастом	человека
2.	 Цвет	сектора	зависит	от	того,	в	какой	период	времени	жил	человек
3.	 Белая,	классическая,	по	признаку	пола	и	настраиваемые	пользователем	цветовые	схемы

1.	 Фильтрация:	используйте	фильтры	на	боковой	панели,	чтобы	быстро	получить...	Например:	у	кого	известна	дата	рождения,	у	кого
есть	атрибут	голубые	глаза,	...	.	Те,	кто	прошел	через	фильтр,	будут	выделены	жирным	шрифтом,	остальные	станут	прозрачными

2.	 До	11	поколений	на	одной	диаграмме
3.	 Печать	из	панели	инструментов.	Вид,	который	вы	видите	на	экране	(после	поворотов,	увеличений	и	замены	цветов)	может	быть

распечатан	или	сохранен	в	формате	svg	(для	дальнейшего	редактирования	и	просмотра	через	браузер),	pdf	или	ps.
4.	 Шрифт	для	надписей	можно	выбрать	и	он	будут	автоматически	масштабироваться,	в	зависимости	от	размеров	сектора.	На	темном

фоне	шрифт	будет	белым,	и	наоборот.

Чтобы	во	всем	разобраться,	смотрите	видеоурок.

Веерная	карта	потомков
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Рис.	4.15	Веерная	карта	потомков

События

Рис.	4.16	События

Категория	"События"	отображает	список	всех	событий,	содержащихся	в	вашем	семейном	древе.	Одно	событие	может	относиться	к
нескольким	людям	и	нескольким	семьям.

Колонки,	доступные	для	отображения:	 Описание ,	 ID ,	 Тип ,	 Дата ,	 Место 	и	 Последнее	изменение .

При	стандартных	настройках	для	событий	отображаются	колонки	 Описание ,	 ID ,	 Тип ,	 Дата 	и	 Место .	Для	добавления,	удаления,
смены	порядка	может	использоваться	 Редактор	колонок ,	который	доступен	по	кнопке	 Настроить	вид... 	на	панели
инструментов.

Важность	описания	событий

Так	как	событие	может	относиться	к	нескольким	людям	и	семьям,	необходимо	присвоить	ему
уникальное	осмысленное	описание.	Впоследствии	это	поможет	найти	и	сопоставить	событие
участникам.

Список	событий	можно	сортировать	обычным	образом,	нажимая	на	заголовки	столбцов.	Нажатие	один	раз	выполнит	сортировку	по	этому
столбцу	в	порядке	возрастания.	Повторное	нажатие	выполнит	сортировку	в	порядке	убывания.

Места
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Рис.	4.17	Места

Категория	"Места"	отображает	список	географических	мест,	с	которыми	связаны	события	в	вашем	семейном	древе.	Это	могут	быть	места
рождения,	смерти	людей,	места	проведения	свадеб,	места	жительства,	работы,	учебы	или	любые	другие	ссылки	на	географические
расположение.	В	списке	мест	содержится:	 Название	места ,	 ID ,	 Улица ,	 Город ,	 Область ,	 Республика 	и	 Страна .

Список	мест	можно	сортировать	обычным	образом,	нажимая	на	заголовки	столбцов.	Нажатие	один	раз	выполнит	сортировку	по	этому
столбцу	в	порядке	возрастания.	Повторное	нажатие	выполнит	сортировку	в	порядке	убывания.

Если	место	достаточно	полно	описано,	вы	можете	попробовать	найти	его	в	картографической	службе.	Нажмите	на	кнопку	с	названием
картографической	службы	на	панели	инструментов.	В	зависимости	от	настроек,	кнопка	может	быть	подписана	 OpenStreetMap ,
Карты	Google 	и	т.п.	Картографический	сервис	может	быть	выбран	из	выпадающего	списка	под	черным	треугольником	справа	от
кнопки.

Откроется	ваш	веб-браузер	с	выбранной	картографической	службой.	Для	службы	"Карты	Google"	поиск	будет	произведен	по	широте	и
долготе	или	по	названию	места.	Различные	сервисы	используют	разные	требования	к	полноте	описания	места.

Эта	возможность	не	всегда	доступна	и	не	всегда	может	приводить	к	результатам,	которые	вы	ожидаете.

Места	и	Иерархия	мест

Рис.	4.18	Иерархия	мест

В	категории	"Места"	представлены	два	вида	-	"Места"	и	"Иерархия	мест".

Вид	"Иерархия	мест"	производит	группировку	мест	по	странам,	областям,	районам	и	т.д.

Этот	вид	появился	в	Gramps	3.6.0	(в	будущих	версиях	предполагается	сделать	более	продвинутую	группировку).

Вид	"Места"	отображает	все	места	в	виде	большого	списка.

География

Примечание

Категория	География	присутствует,	только	если	у	вас	установлена	библиотека	OsmGpsMap.
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Рис.	4.19	География

Эта	категория	предназначена	для	отображения	информации	на	карте.	Она	содержит	несколько	видов,	которые	с	помощью
картографических	сервисов	(OpenStreetMap,	Google	maps,	...)	отобразят	на	карте	людей	и	события.

На	карте	можно	увидеть:

все	места	из	вашего	семейного	древа
места	после	применения	фильтра
все	места,	связанные	с	выбранным	лицом
все	места,	связанные	с	выбранной	семьей
все	места,	связанные	с	событиями
места,	связанные	с	событиями	после	применения	фильтра

С	помощью	кнопок	на	панели	инструментов	доступны	виды:	"Семья",	"Лицо",	"События",	"Места".	Фильтрация	по	местам	и	событиям
производится	с	помощью	грамплета	"Фильтр"	на	боковой	панели.

Вид	"Семья"	показывает	все	места,	связанные	с	членами	выбранной	семьи.	Фильтрация	для	этого	вида	не	используется.

Вид	"Лицо"	показывает	все	места,	связанные	с	выбранным	человеком.	Фильтрация	для	этого	вида	не	используется.	В	контекстном	меню
доступна	дополнительная	функция	 Анимировать .	Если	у	человека	имеется	несколько	связанных	с	различными	местами	событий,	вы
можете	увидеть	виртуальный	жизненный	путь	человека	-	анимированное	перемещение	между	маркерами	на	карте.

Вид	"События"	показывает	все	места	из	вашего	семейного	древа,	связанные	с	событиями.	По	параметрам	событий	можно	произвести
фильтрацию.

Вид	"Места"	показывает	все	места	из	вашего	семейного	древа,	для	которых	известны	координаты	широты	и	долготы.	По	параметрам	мест
можно	произвести	фильтрацию.

Из	всех	видов	категории	"География"	есть	возможность	добавлять	новые	места	в	семейное	древо	и	делать	географическую	привязку
существующих	мест	по	широте	и	долготе.	Используйте	для	этого	пункты	 Добавить	место 	и	 Увязать	место 	в	контекстном	меню.
Кроме	того,	в	контекстном	меню	доступны	следующие	пункты:

Показать/скрыть	перекрестье 	-	управление	перекрестьем	в	центре	карты
Закрепить	масштаб	и	позицию/Снять	закрепление	масштаба	и	позиции 	-	отключение	автоматического
масштабирования	и	позиционирования.	Позволяет	запомнить	текущее	положение	и	масштаб	карты.
Центрировать	тут 	-	перемещение	центра	карты	в	положение	курсора	мыши
Поменять	сервис... 	-	смена	картографического	сервиса.	Более	подходящий	можно	выбрать	из	выпадающего	списка.

Источники

Рис.	4.20	Источники	(дерево	цитат)
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Рис.	4.21	Источники

В	категории	"Источники"	представлены	виды,	которые	отображают	список	всех	источников,	содержащихся	в	вашем	семейном	древе.

При	стандартных	настройках	открывается	вид	"Дерево	цитат".	Слева	от	каждого	источника	расположен	значок	(обычно:	+),	по	нажатию
на	который	разворачивается	список	цитат	для	этого	источника.	Повторное	нажатие	на	этот	значок	приводит	к	сворачиванию	списка
обратно.	Другой	вид	-	вид	"Источники"	отображает	только	список	источников.

Источниками	могут	быть	различные	документы	(свидетельства	о	рождении,	смерти,	браке	и	т.д.),	книги,	фильмы,	журналы,	личные
дневники,	-	всё,	что	может	подтвердить	генеалогическую	информацию.	Gramps	предоставляет	возможность	цитировать	источники	для
каждого	события	в	семейном	древе	(рождение,	смерть,	брак	и	т.д.).	В	списке	источников	содержится:	 Название ,	 ID ,	 Автор 	и
Информация	о	публикации .

Список	источников	можно	сортировать	обычным	образом,	нажимая	на	заголовки	столбцов.	Нажатие	один	раз	выполнит	сортировку	по
этому	столбцу	в	порядке	возрастания.	Повторное	нажатие	выполнит	сортировку	в	порядке	убывания.

Цитаты

Рис.	4.22	Цитаты

Вид	"Цитаты"	отображает	список	всех	цитат,	содержащихся	в	вашем	семейном	древе.

Цитата	показывает,	с	какой	частью	источника	связана	определенная	информация	в	вашем	семейном	древе.	Например,	источником
информации	является	книга,	а	цитатой	может	быть	отдельная	страница	в	этой	книге.	Gramps	предоставляет	возможность	цитировать
источники	для	каждого	события	в	семейном	древе	(рождение,	смерть,	брак	и	т.д.).	В	списке	цитат	содержится:	 Том/страница ,	 ID ,
Дата 	и	 Достоверность .

Список	цитат	можно	сортировать	обычным	образом,	нажимая	на	заголовки	столбцов.	Нажатие	один	раз	выполнит	сортировку	по	этому
столбцу	в	порядке	возрастания.	Повторное	нажатие	выполнит	сортировку	в	порядке	убывания.

Хранилища
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Рис.	4.23	Хранилища

Хранилища	служат	для	объединения	источников	по	критерию	мест,	где	они	хранятся.

Каждый	источник	может	иметь	ссылку	на	хранилище,	в	котором	он	находится	(например,	библиотека,	домашний	архив).	Вид
"Хранилища"	обладает	теми	же	функциями,	что	и	другие	виды.

Альбом

Рис.	4.24	Альбом

Вид	"Альбом"	отображает	список	всех	документов,	используемых	в	вашем	семейном	древе.

Документы	-	это	любые	файлы,	которые	могут	содержать	генеалогическую	информацию.	Любой	файл	может	быть	сохранен	как	документ
Gramps.

Чаще	всего	это	изображения,	аудио	и	видеоролики	и	т.д.	В	списке	документов	содержится:	 Название ,	 ID ,	 Тип ,	 Путь 	и	 Дата .

Для	добавления,	удаления,	смены	порядка	может	использоваться	 Редактор	колонок ,	который	доступен	по	кнопке	 Настроить
вид... 	на	панели	инструментов.

Список	документов	можно	сортировать	обычным	образом,	нажимая	на	заголовки	столбцов.	Нажатие	один	раз	выполнит	сортировку	по
этому	столбцу	в	порядке	возрастания.	Повторное	нажатие	выполнит	сортировку	в	порядке	убывания.

Заметки

Рис.	4.25	Заметки
Категории	-	Альбом 37

http://www.gramps-project.org/wiki/index.php/File:RepositoriesCategory-RepositoriesListView-example-52.png
http://www.gramps-project.org/wiki/index.php/File:MediaCategory-MediaListView-example-52.png
http://www.gramps-project.org/wiki/index.php/File:NotesCategory-NotesListView-example-52.png


Заметка	-	это	простой	текст,	содержащий	дополнительную	информацию	об	объекте.

Вид	"Заметки"	обладает	теми	же	функциями,	что	и	другие	виды.	Он	отображает	список	всех	заметок,	используемых	в	вашем	семейном
древе.	В	списке	заметок	содержится:	 Предпросмотр ,	 ID ,	 Тип .	Для	добавления,	удаления,	смены	порядка	может	использоваться
Редактор	колонок ,	который	доступен	по	кнопке	 Настроить	вид... 	на	панели	инструментов.

Вот	некоторые	типы	заметок:	Заметка	о	событии,	Заметка	о	человеке,	Заметка	об	источнике.

Двойной	щелчок	по	заметке	в	списке	вызовет	форму	для	редактирования.	Вы	можете	изменять	шрифт,	цвет	шрифта	и	фона.	Так	же
доступна	проверка	правописания.

Пред Содержание След
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Управление	семейными	древесами

Пред Содержание След

Теперь	перейдем	к	детальному	рассмотрению	вопросов	повседневного	использования	Gramps.	В	этой	главе	мы	дадим	подробный	обзор
того,	как	Вы	можете	управлять	Вашими	семейными	древесами	и	обмениваться	Вашей	информацией	с	другими	людьми,	занимающимися
генеалогией.

Создание	нового	семейного	древа

Рис.	5.1	Семейные	древеса

Новое	семейное	древо	можно	создать	с	помощью	меню	Семейные	древеса	->	Управление	семейными	древесами...	или	с	помощью
кнопки	 Семейные	древеса 	на	панели	инструментов.	Откроется	форма	 Семейные	древеса 	(рис.	5.1).

Нажмите	кнопку	 Создать 	и	Gramps	добавить	новое	семейное	древо	в	список.	Стандартное	имя	Семейное	древо	1	можно	поменять	с
помощью	кнопки	 Переименовать .

Теперь	чтобы	открыть	новое	пустое	семейное	древо	в	Gramps	нажмите	кнопку	 Загрузить	семейное	древо .

Открытие	семейного	древа
Открыть	семейное	древо	можно	либо	с	помощью	меню	Семейные	древеса	->	Управление	семейными	древесами...,	либо	с	помощью
кнопки	 Семейные	древеса 	на	панели	инструментов.	Откроется	форма	 Семейные	древеса 	со	списком	всех	древес,	известных
Gramps.	Значок	с	папкой	в	столбце	 Статус 	указывает	на	открытое	в	настоящий	момент	семейное	древо.	Выберите	необходимое	вам
древо	в	списке	и	нажмите	кнопку	 Загрузить	семейное	древо 	или	дважды	щелкните	по	названию	левой	кнопкой	мыши.

Чтобы	открыть	семейное	древо,	с	которым	вы	недавно	работали,	выберите	пункт	меню	Семейные	древеса	->	Открыть	недавнее	или
нажмите	на	стрелку	рядом	с	кнопкой	 Семейные	древеса 	на	панели	инструментов	и	выберите	необходимое	из	списка.

Режим	чтения

Если	вы	не	имеете	прав	на	запись	выбранного	древа,	то	оно	будет	открыто	в	режиме	чтения.	В
этом	режиме	доступен	только	просмотр	информации	без	возможности	внесения	изменений.
Заголовок	главного	окна	программы	в	этом	случае	дополняется	пометкой	(только	чтение).

Открытие	файлов	GEDCOM	или	XML
Gramps	умеет	открывать	семейные	древеса,	сохраненные	не	только	в	формате	базы	данных	Gramps.	Эта	возможность	доступна	из
командной	строки	и	распространяется	на	форматы	XML	и	GEDCOM.	Однако	необходимо	знать,	что	если	файлы	XML	или	GEDCOM
достаточно	велики,	то	вы	столкнетесь	с	проблемами	производительности	и,	в	случае	аварийного	завершения	программы,	ваша
информация	может	быть	повреждена.	Поэтому	лучше	создать	новое	семейное	древо	Gramps	и	импортировать	данные	из	файлов
XML/GEDCOM	в	него.

Открытие	файлов

При	открытие	файлов	XML	и	GEDCOM,	вся	информация	из	них	загружается	в	память	целиком	и	не	индексируется.	Формат	семейного	древа	Gramps	-	это	база	данных,	из	которой	данные	загружаются	в	память	по	требованию.	Таким	образом,	для	большого	семейного	древа	доступ	к	информации	может	быть	быстрее	и	эффективнее	без	использования	XML	или	GEDCOM.
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Редактирование	GEDCOM

Пожалуйста,	имейте	в	виду,	что	некоторая	информация	из	файла	GEDCOM	может	быть	потеряна
при	импорте	в	Gramps,	а	так	же	при	экспорте	обратно	в	GEDCOM.	Просто	открытие	и	просмотр
не	вносят	изменений	в	файл.	Однако,	если	были	сделаны	изменения,	и	эти	изменения	не	были
отменены	при	выходе	из	Gramps,	они	будут	сохранены	в	файл	GEDCOM	и	часть	данных,
возможно,	будет	потеряна.

Удаление	семейного	древа
Выберите	семейное	древо,	которое	нужно	удалить,	и	нажмите	кнопку	 Удалить .

Это	полностью	удалит	древо	и	всю	имеющуюся	в	нем	информацию	без	возможности	ее	восстановления.	Полезно	сохранять	резервные
копии	ваших	данных	путем	экспорта	в	формат	Gramps	XML	и	сохранения	этого	файла.

Переименование	семейного	древа
Вы	можете	переименовать	семейное	древо	(или	его	архив),	выбрав	его	в	списке	и	нажав	кнопку	 Переименовать .	Вам	останется	только
ввести	новое	название.

Резервное	копирование	семейного	древа
Самый	надежный	способ	создания	резервной	копии	семейного	древа	Gramps	-	сделать	его	экспорт	в	формате	Gramps	XML	(или
Gramps	XML-пакет,	чтобы	включить	в	экспорт	документы	из	Альбома)	с	отключенным	фильтром	секретности	и	другими
фильтрами,	и	скопировать	полученный	в	результате	экспорта	файл	в	безопасное	место,	лучше	всего	на	другой	физический	носитель
информации.

Форма	для	резервного	копирования

Рис.	5.2	Создание	резервной	копии

Просто	выберите	пункт	меню	Семейные	древеса	->	Сделать	резервную	копию....

Вы	можете	сделать	выбор	-	включать	в	резервную	копию	Альбом	или	нет.

Обратите	внимание,	что	это	обычный	экспорт	в	формат	Gramps	XML,	с	отключенными	фильтрами.	Вы	можете	в	любое	время
импортировать	его	обычным	способом.

Вы	можете	также	определить	шаблон	имен	файлов	резервных	копий,	установив	переменную	paths.quick-backup-filename	в	файле
~/.gramps/gramps40/gramps.ini	в	следующее	значение:

[paths]
quick-backup-filename='%(filename)s_%(year)d-%(month)02d-%(day)02d.%(extension)s'

В	шаблоне	можно	использовать	следующие	ключевые	слова:	year,	month,	day,	hour,	minutes,	seconds,	filename,	extension.

Вы	можете	использовать	архивы	для	создания	мгновенных	снимков	вашего	древа.	Такие	снимки	можно	использовать	как	обычные
резервные	копии,	если	Вы	хотите	попробовать	сделать	что-нибудь,	что	позднее	захотите	отменить.	Однако	этот	способ	не	заменяет
собой	резервное	копирование,	так	как	он	не	переживет	поломку	жесткого	диска	компьютера	и	большинство	серьезных	проблем	в
его	работе.

Для	опытных	пользователей:	каждое	семейное	древо	хранится	в	своем	собственном	подкаталоге	каталога	~/.gramps.	Резервные
копии	можно	делать	вручную,	сохраняя	эти	подкаталоги.

Архивирование	семейного	древа

Примечание

Архивирование	семейного	древа	доступно,	только	если	в	системе	установлена	библиотека	GNU
RCS	(Revision	Control	System).	Вы	можете	установить	её	независимо	от	Gramps.
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Вы	можете	легко	архивировать	и	делать	моментальные	снимки	семейных	древес	с	помощью	библиотеки	GNU	Revision	Control	System	или
RCS.	Для	этого	библиотека	должна	быть	установлена	на	вашем	компьютере.

Чтобы	сделать	архив:

Рис.	5.3	Пример	архивирования	семейного	древа

1.	 загрузите	семейное	древо.
2.	 нажмите	на	кнопку	 Семейные	древеса 	на	панели	инструментов	(дополнительно	можно	посмотреть	недавно	использовавшиеся

древеса)
3.	 выберите	в	списке	только	что	загруженное	вами	семейное	древо:	станет	доступна	кнопка	 Архивировать .
4.	 нажмите	на	кнопку	 Архивировать 	и	введите	описание	версии.

После	архивирования,	слева	от	названия	вашего	семейного	древа	в	списке	появится	значок	(обычно	'+'	или	треугольник).

Нажатие	на	этот	значок	развернет	список	архивов	семейного	древа.	(Повторное	нажатие	свернет	список	обратно).

Архивы	можно	удалять,	переименовывать	и	восстанавливать.

Восстановление	семейного	древа	из	архива

Рис.	5.4	Выбор	архива	для	восстановления

При	выборе	архива	становится	доступна	кнопка	 Извлечь .	Нажмите	на	нее,	чтобы	восстановить	архив.	Извлечённый	архив	появится	в
списке	под	именем	<название	исходного	семейного	древа:<название	архива>.	Теперь	это	независимое	семейное	древо.	Извлечение	-	это
способ	сохранения	архива,	потому	что	обычные	архивы	исчезают	при	удалении	исходного	семейного	древа	и	не	включаются	в	экспорт	в
Gramps	XML.

Просто	выберите	архив	и	нажмите	кнопку	 Извлечь .

Рис.	5.5	Извлечённый	архив

Gramps	восстановит	архив	в	новое	семейное	древо.	Название	этого	древа	будет	состоять	из	названия	исходного	древа	и	названия	архива
(Архивирование	семейного	древа).

Разблокирование	семейного	древа
При	открытии	семейного	древа	Gramps	блокирует	его	для	предотвращения	одновременной	работы	с	ним	нескольких	пользователей.
Можно	еще	раз	запустить	Gramps	и	открыть	в	нем	другое	семейное	древо,	но	уже	открытое	древо	будет	отображаться	со	значком	замка,
означающего,	что	древо	уже	открыто.	Закрытие	древа	в	первой	копии	Gramps	позволит	отрыть	его	во	второй.

Если	бы	вам	удалось	открыть	семейное	древо	одновременно	в	двух	копиях	Gramps,	то,	скорее	всего,	ваше	древо	было	бы	повреждено.
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В	редком	случае	аварийного	завершения	Gramps	семейное	древо	останется	в	заблокированном	состоянии.	Для	разблокирования	выберите
его	в	списке	и	нажмите	кнопку	 Разблокировать .	Делайте	так,	только	если	вы	уверены,	что	древо	не	открыто	в	другой	копии	Gramps.

Починка	семейного	древа

Рис.	5.6	Починка	семейного	древа

Если	семейное	древо	по	какой-либо	причине	повреждено	-	в	форме	 Семейные	древеса 	в	колонке	 Статус 	появится	красный	значок
ошибки.

Для	того,	чтобы	Gramps	попытался	устранить	повреждения,	выберите	поврежденное	древо	и	нажмите	кнопку	 Восстановить .

Gramps	попытается	восстановить	ваше	семейное	древо	из	файлов	резервных	копий,	которые	создаются	автоматически	во	время
завершения	работы	программы.

Сохранение	изменений	в	семейном	древе
Gramps	сохраняет	изменения	сразу	после	их	внесения.	Это	значит,	что	всякий	раз,	когда	Вы	нажимаете	в	Gramps	на	кнопку	 OK ,	Ваши
изменения	применяются	и	сохраняются	немедленно.	В	Gramps	нет	отдельной	команды	"Сохранить".

Вы	можете	отменить	внесенные	Вами	изменения,	выбрав	пункт	меню	Правка	->	Откатить.	При	этом,	если	несколько	раз	нажать	этот
пункт	-	отменится	последовательно	несколько	последних	изменений.	Также	несколько	изменений	сразу	можно	отменить	с	помощью
меню	Правка	->	История	Откатов....

Если	Вы	хотите	вернуть	Ваше	семейное	древо	к	исходному	состоянию,	в	котором	оно	было	сразу	после	его	последнего	открытия	в
Gramps,	выберите	пункт	меню	Семейные	древеса	->	Отказаться	от	изменений	и	выйти.	(Эта	команда	аналогична	завершению	работы
без	сохранения	изменений	в	других	программах.)

Если	Вы	хотите	сохранить	копию	Вашего	семейного	древа	под	другим	названием,	то	Вам	нужно	сделать	его	экспорт	и	затем
импортировать	назад	в	Gramps	в	новое	семейное	древо.	Лучше	всего	для	этого	использовать	формат	Gramps	XML.

Импорт	данных
Импорт	позволяет	переносить	в	Gramps	информацию	из	других	генеалогических	программ.	В	настоящее	время	Gramps	может
импортировать	данные	в	следующих	форматах:

Gramps	XML	(расширение	имен	файлов	.gramps)
Gramps	XML-пакет	(расширение	имен	файлов	.gpkg)
CSV	-	значения	через	запятую	(расширение	имен	файлов	.csv)
база	данных	GRAMPS	V2.x	(расширение	имен	файлов	.grdb)
GEDCOM	(расширение	имен	файлов	.ged)
GeneWeb	(расширение	имен	файлов	.gw)
Pro-Gen	(расширение	имен	файлов	.def)

Импортировать	или	открывать?

Помните	об	отличиях	импорта	данных	и	открытия	файлов.	Импорт	данных	означает	извлечение
их	из	источника	и	занесение	их	в	семейное	древо	Gramps.	Открытие	файла	подразумевает	работу
напрямую	с	этим	файлом.

Для	выполнения	импорта	информации	выберите	пункт	меню	Семейные	древеса	->	Импорт.	Откроется	форма	 Импорт	базы	данных ,	в
которой	нужно	выбрать	импортируемый	в	Gramps	файл.

Обратите	внимание,	что	импортировать	информацию	можно	только	в	уже	созданное	древо	Gramps,	поэтому	если	Вы	хотите	перенести	в
Gramps	все	данные	из	другой	программы	или	из	предыдущей	версии	Gramps	-	сначала	создайте	новое	пустое	семейное	древо	и	затем	уже
импортируйте	информацию	в	него.

Потеря	информации	при	импорте	из	некоторых	форматов

Важно	отметить,	что	не	существует	взаимно	однозначного	соответствия	между	всеми
особенностями	формата	Gramps	и	форматов	GEDCOM,	GeneWeb	или	Pro-Gen.	Поэтому,	при
импорте	из	этих	форматов	часть	данных	может	быть	потеряна.	Подробнее	о	данных,	которые	не
смогут	быть	импортированы	в	Gramps,	смотрите	ниже	в	этом	разделе.
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Порядок	 Событий 	при	импорте	из	других	программ

Порядок	событий	при	импорте	из	других	программ	может	быть	не	совсем	такой,	какой	вы
ожидали.	Gramps	предлагает	помощь	для	упорядочения	событий	согласно	вашим	пожеланиям.
Смотрите	инструмент	для	сортировки	событий.

Импорт	из	Gramps	V2.x

Gramps	V2.x	(.grdb):	До	Gramps	версии	3.0,	это	был	родной	для	Gramps	формат	-	модифицированная	версия	баз	данных	Berkeley	(BSDDB)
со	специальной	структурой	таблиц.	Это	был	двоичный	формат,	зависимый	от	архитектуры	компьютера.	Он	был	очень	эффективным,	но
не	работал	при	переносе	между	компьютерами	с	разной	архитектурой	(например	между	i386	и	alpha)

Импорт	из	формата	Gramps	V2.x	поддерживается	только	в	Gramps	версии	3.0.x.	При	этом	данные	импортируются	без	каких-либо	потерь.

Импорт	данных	из	формата	Gramps	V2.x	не	поддерживается	в	Gramps	6.0

Если	у	вас	есть	старое	древо	в	формате	Gramps	V2.x,	вам	необходимо	сначала	импортировать	его
в	Gramps	V3.0.x,	затем	экспортировать	в	формат	Gramps	XML	(или	Gramps	XML-пакет)	и	только
после	этого	импортировать	в	Gramps	6.0.

Импорт	из	Gramps	XML	и	Gramps	XML-пакет

Форматы	Gramps	XML	и	Gramps	XML-пакет	-	родные	форматы	для	Gramps.	Вы	можете	импортировать	из	этих	форматов	и
экспортировать	в	них	данные	без	риска	потерять	какую-либо	их	часть.

Gramps	XML	(.gramps):	Этот	формат	является	стандартным	форматом	Gramps	для	обмена	информацией	и	создания	резервных
копий,	а	так	же	был	форматом	базы	данных	старых	версий	Gramps	(до	2.x).	В	отличие	от	формата	Gramps	V2.x	grdb,	Gramps	XML
не	зависит	от	системной	архитектуры	и	доступен	для	обработки	в	текстовых	редакторах.	Семейное	древо	может	содержать	ссылки
на	документы,	которые	сами	хранятся	отдельно,	поэтому	при	использовании	Gramps	XML	невозможно	гарантировать	полную
переносимость	(для	полной	переносимости,	включая	документы,	необходимо	использовать	формат	Gramps	XML-пакет	(.gpkg)).
Файл	в	формате	Gramps	XML	создается	с	помощью	пункта	меню	Семейные	древеса	->	Экспорт...	и	последующего	выбора
соответствующего	формата.

Gramps	XML-пакет	(.gpkg):	Этот	формат	представляет	собой	сжатый	архив,	состоящий	из	файла	Gramps	XML	и	всех	документов
(фотографии,	аудиофайлы	и	т.д.)	на	которых	имеются	ссылки	в	семейном	древе,	поэтому	является	полностью	переносимым.	Файл	в
формате	Gramps	XML-пакет	создается	с	помощью	пункта	меню	Семейные	древеса	->	Экспорт...	и	последующего	выбора
соответствующего	формата.

При	импорте	информации	из	Gramps	XML	или	Gramps	XML-пакет	ход	выполнения	операции	будет	отображаться	в	строке	состояния	в
главном	окне	Gramps.	После	завершения	импорта	появится	окно	со	статистикой	импортированных	объектов.	Если	импортированные
данные	происходят	из	того	же	самого	семейного	древа,	в	которое	вы	импортируете	данные,	в	окне	со	статистикой	будет	сделано
предположение	об	объединении	некоторых	объектов.	Объединение	не	делается	автоматически.	Автоматическое	объединение	объектов
Gramps	можно	сделать	через	экспорт/импорт	в	формат	CSV.

Импорт	из	CSV

Формат	CSV	позволяет	импортировать	и	экспортировать	часть	данных	вашего	семейного	древа	в	простой	текстовый	файл,	в
котором	значения	отделяются	друг	от	друга	запятой.	Подробнее	смотрите	в	статье	Экспорт	и	импорт	CSV.

Импорт	из	GEDCOM

Рис.	5.7	Отчет	импорта

При	импорте	информации	из	GEDCOM	ход	выполнения	операции	будет	отображаться	в	строке	состояния	в	главном	окне	Gramps.	После
завершения	импорта	появится	окно,	показывающее,	какие	данные	не	были	импортированы.	В	отчете	(рис.	5.7)	детально	показаны	строки,
которые	были	игнорированы	или	их	не	удалось	распознать.	Содержимое	строк	(или	продолжений	строк)	также	показано.	В	некоторых
случаях	строка	в	отчете	может	не	совпадать	со	строкой	в	исходном	файле	GEDCOM,	так	как	они	проходят	некоторую	обработку.

Поскольку	Gramps	и	GEDCOM	используют	различные	'модели	данных'	-	неизбежно	некоторые	фрагменты	данных	импортировать	не
удастся.

Основные	исключения:
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Некоторые	структуры	атрибутов	GEDCOM	воспринимаются	как	 Атрибуты 	Gramps	и	поэтому	многие	элементы	GEDCOM	не
могут	быть	сохранены.
Игнорируются	элементы	DATA	из	SOURCE_RECORD	(определяют	ответственного	за	событие).
Игнорируются	все	цитаты	источников	для	заметок.
Многие	элементы	GEDCOM	не	имеют	точных	соответствий	в	модели	данных	Gramps,	поэтому	они	сохраняются	как	 Атрибуты 	и
Данные 	под	именами,	соответствующими	тегам	GEDCOM.	Это	особенно	относится	к	записям	header,	submitter	и	submission	и
тегам	REFN,	RFN,	RIN	и	AFN.

Рис.	5.8	Отчет	импорта:	Пример	заметки	с
информацией	об	импорте

Когда	в	пояснениях	к	элементу	данных	указано,	что	он	'игнорируется',	его	пропуск	фиксируется	в	отчете	в	конце	импорта	и	включается	в
заметку,	прикрепленную	к	соответствующему	объекту.

Когда	в	пояснениях	к	элементу	данных	указано,	что	он	'молча	игнорируется',	его	пропуск	нигде	не	фиксируется	и	в	заметку	не
включается.

Этот	раздел	описывает,	как	обрабатываются	элементы	данные	GEDCOM,	для	которых	нет	прямых	соответствий	в	Gramps.	Для	получения
дополнительной	информации	об	ограничениях	импорта	и	экспорта	GEDCOM	читайте	статью	Gramps	и	GEDCOM.

HEADer,	SUBMitter	и	SUBmissioN

В	Gramps	нет	точного	соответствия	этим	данным,	поэтому	вся	эта	информация	сохраняются	в	других	объектах.	В	зависимости	от
настроек	Gramps,	во	время	импорта	может	создаваться	объект	 Источник 	и	соответствующие	данные	будут	добавлены	в	него,	либо	в
прикрепленный	к	нему	объект	 Хранилище .

			HEADER:=
								n	HEAD																																										{1:1}
										+1	SOUR	<APPROVED_SYSTEM_ID>																		{1:1}		(элемент	'Данные'	в	'Источнике')
												+2	VERS	<VERSION_NUMBER>																				{0:1}		(элемент	'Данные'	в	'Источнике')
												+2	NAME	<NAME_OF_PRODUCT>																			{0:1}		(элемент	'Данные'	в	'Источнике')
												+2	CORP	<NAME_OF_BUSINESS>																		{0:1}		('Хранилище'	для	'Источника')
														+3	<<ADDRESS_STRUCTURE>>																		{0:1}		('Хранилище'	для	'Источника')
												+2	DATA	<NAME_OF_SOURCE_DATA>															{0:1}		(элемент	'Данные'	в	'Источнике')
														+3	DATE	<PUBLICATION_DATE>																{0:1}		(элемент	'Данные'	в	'Источнике')
														+3	COPR	<COPYRIGHT_SOURCE_DATA>											{0:1}		(элемент	'Данные'	в	'Источнике')
										+1	DEST	<RECEIVING_SYSTEM_NAME>															{0:1}		(элемент	'Данные'	в	'Источнике')
										+1	DATE	<TRANSMISSION_DATE>																			{0:1}		(элемент	'Данные'	в	'Источнике')
												+2	TIME	<TIME_VALUE>																								{0:1}		(элемент	'Данные'	в	'Источнике')
										+1	SUBM	@<XREF:SUBM>@																									{1:1}		(элемент	'Данные'	в	'Источнике')
																																																															(Также	используется	для	определения	SUBMITTER_RECORD)
																																																															(который	сохраняется	как	владелец	базы	данных)
										+1	SUBN	@<XREF:SUBN>@																									{0:1}		(игнорируется)
										+1	FILE	<FILE_NAME>																											{0:1}		(элемент	'Данные'	в	'Источнике')
										+1	COPR	<COPYRIGHT_GEDCOM_FILE>															{0:1}		(сохраняется	как	'Информация	об	издании'	в	'Источнике'	)
										+1	GEDC																																							{1:1}
												+2	VERS	<VERSION_NUMBER>																				{1:1}		(элемент	'Данные'	в	'Источнике')
												+2	FORM	<GEDCOM_FORM>																							{1:1}		(элемент	'Данные'	в	'Источнике')
										+1	CHAR	<CHARACTER_SET>																							{1:1}		(элемент	'Данные'	в	'Источнике')
												+2	VERS	<VERSION_NUMBER>																				{0:1}		(элемент	'Данные'	в	'Источнике')
										+1	LANG	<LANGUAGE_OF_TEXT>																				{0:1}		(элемент	'Данные'	в	'Источнике')
										+1	PLAC																																							{0:1}
												+2	FORM	<PLACE_HIERARCHY>																			{1:1}		(см.	ниже)
										+1	NOTE	<GEDCOM_CONTENT_DESCRIPTION>										{0:1}		('Заметка'	для	'Источника')
												+2	[CONT|CONC]	<GEDCOM_CONTENT_DESCRIPTION>	{0:M}
												

PLAC	FORM	используется	для	внутреннего	управления	интерпретацией	мест	(в	соответствии	со	спецификацией	GEDCOM).

Запись	SUBMISSION_RECORD	(должна	быть	единственной,	но	это	не	проверяется)	сохраняется	как	элемент	 Данные 	в	'Источнике'.

				SUBMISSION_RECORD:=
								n	@<XREF:SUBN>@	SUBN																												{1:1]
										+1	SUBM	@<XREF:SUBM>@																									{0:1}
										+1	FAMF	<NAME_OF_FAMILY_FILE>																	{0:1}
										+1	TEMP	<TEMPLE_CODE>																									{0:1}
										+1	ANCE	<GENERATIONS_OF_ANCESTORS>												{0:1}
										+1	DESC	<GENERATIONS_OF_DESCENDANTS>										{0:1}
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										+1	ORDI	<ORDINANCE_PROCESS_FLAG>														{0:1}
										+1	RIN	<AUTOMATED_RECORD_ID>																		{0:1}

Записи	SUBMITTER_RECORD	(может	быть	больше	одной)	сохраняются	как	 Хранилище 	для	'Источника',	за	исключением	выделенных
жирным	тегов.	Запись	SUBMITTER_RECORD,	которая	соответствует	элементу	SUBM	в	записи	HEADER	используется	для	установки
владельца	базы	данных.

			SUBMITTER_RECORD:=
								n	@<XREF:SUBM>@			SUBM																										{1:1}
										+1	NAME	<SUBMITTER_NAME>																						{1:1}
										+1	<<ADDRESS_STRUCTURE>>																						{0:1}
										+1	<<MULTIMEDIA_LINK>>																								{0:M}
										+1	LANG	<LANGUAGE_PREFERENCE>																	{0:3}
										+1	RFN	<SUBMITTER_REGISTERED_RFN>													{0:1}
										+1	RIN	<AUTOMATED_RECORD_ID>																		{0:1}
										+1	<<CHANGE_DATE>>																												{0:1}

MULTIMEDIA_LINK	игнорируется
LANG	игнорируется
RFN	и	RIN	игнорируются

INDIvidual

Запись	INDIVIDUAL_RECORD	сохраняется	в	Gramps	как	объект	 Лицо ,	за	исключением	выделенных	жирным	тегов.

			INDIVIDUAL_RECORD:	=
								n	@<XREF:INDI>@		INDI																											{1:1}
										+1	RESN	<RESTRICTION_NOTICE>																		{0:1}
										+1	<<PERSONAL_NAME_STRUCTURE>>																{0:M}
										+1	SEX	<SEX_VALUE>																												{0:1}
										+1	<<INDIVIDUAL_EVENT_STRUCTURE>>													{0:M}
										+1	<<INDIVIDUAL_ATTRIBUTE_STRUCTURE>>									{0:M}
										+1	<<LDS_INDIVIDUAL_ORDINANCE>>															{0:M}
										+1	<<CHILD_TO_FAMILY_LINK>>																			{0:M}
										+1	<<SPOUSE_TO_FAMILY_LINK>>																		{0:M}
										+1	SUBM	@<XREF:SUBM>@																									{0:M}
										+1	<<ASSOCIATION_STRUCTURE>>																		{0:M}
										+1	ALIA	@<XREF:INDI>@																									{0:M}
										+1	ANCI	@<XREF:SUBM>@																									{0:M}
										+1	DESI	@<XREF:SUBM>@																									{0:M}
										+1	<<SOURCE_CITATION>>																								{0:M}
										+1	<<MULTIMEDIA_LINK>>																								{0:M}
										+1	<<NOTE_STRUCTURE>>																									{0:M}
										+1	RFN	<PERMANENT_RECORD_FILE_NUMBER>									{0:1}
										+1	AFN	<ANCESTRAL_FILE_NUMBER>																{0:1}
										+1	REFN	<USER_REFERENCE_NUMBER>															{0:M}
												+2	TYPE	<USER_REFERENCE_TYPE>															{0:1}
										+1	RIN	<AUTOMATED_RECORD_ID>																		{0:1}
										+1	<<CHANGE_DATE>>																												{0:1}
			

SUBM,	ANCI	и	DESI	молча	игнорируются.
ALIA	("Ссылка	на	другую	запись,	описывающая,	возможно,	того	же	самого	человека")	сохраняется	как	элемент	 Связи 	под
именем	'Alias'.
REFN	и	REFN:TYPE	сохраняются	как	 Атрибуты 	 Лица ,	но	если	тегов	REFN	больше	одного,	станет	непонятно,	какой	TYPE	к
какому	REFN	относится.

Обработка	записи	INDIVIDUAL_ATTRIBUTE_STRUCTURE	существенно	сложнее.	Следующие	теги:

EDUC	(Успеваемость),
NMR	(Количество	браков),
OCCU	(Профессия),
PROP	(Имущество),
RELI	(Вероисповедание),
RESI	и
TITL	(Титул)

и	связанная	с	ними	информация	сохраняются	как	 События .	Описание	(указано	в	скобках	рядом	с	тегом)	сохраняется	в	поле	 Описание
События .	<EVENT_DESCRIPTOR>,	следующий	за	тегом	TYPE,	перезапишет	 Описание ,	если	<EVENT_DESCRIPTOR>	не	является
именем	атрибута.

Следующие	теги:

CAST	(Сословие),
DSCR	(Физическое	описание),
INDO	(Персональный	номер),
NATI	(Национальность),
NCHI	(Количество	детей)	и
SSN	(Номер	социального	страхования)

сохраняются	как	 Атрибуты 	и	большинство	полей,	за	исключением	описаний	(указано	в	скобках	рядом	с	тегом),	SOURCE_CITATION	и
NOTE_STRUCTURE	игнорируются.	(Игнорируемые	теги	выделены	жирным).

			INDIVIDUAL_ATTRIBUTE_STRUCTURE:	=
								n		CAST	<CASTE_NAME>																												{1:1}
										+1	<<EVENT_DETAIL>>																											{0:1}
													etc.
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			EVENT_DETAIL:	=
								n		TYPE	<EVENT_DESCRIPTOR>																						{0:1}
								n		DATE	<DATE_VALUE>																												{0:1}
								n		<<PLACE_STRUCTURE>>																										{0:1}
								n		<<ADDRESS_STRUCTURE>>																								{0:1}
								n		AGE	<AGE_AT_EVENT>																											{0:1}
								n		AGNC	<RESPONSIBLE_AGENCY>																				{0:1}
								n		CAUS	<CAUSE_OF_EVENT>																								{0:1}
								n		<<SOURCE_CITATION>>																										{0:M}
										+1	<<NOTE_STRUCTURE>>																									{0:M}
										+1	<<MULTIMEDIA_LINK>>																								{0:M}
								n		<<MULTIMEDIA_LINK>>																										{0:M}
								n		<<NOTE_STRUCTURE>>																											{0:M}
								
								

TYPE,	DATE,	PLACE_STRUCTURE,	ADDRESS_STRUCTURE,	AGE,	AGNC,	CAUS	и	MULTIMEDIA_LINK	игнорируются.

FAM_RECORD

Запись	FAM_RECORD	сохраняется	в	Gramps	как	объект	 Семья .

			FAM_RECORD:=
								n	@<XREF:FAM>@			FAM																												{1:1}
										+1	<<FAMILY_EVENT_STRUCTURE>>																	{0:M}
										+1	HUSB	@<XREF:INDI>@																									{0:1}
										+1	WIFE	@<XREF:INDI>@																									{0:1}
										+1	CHIL	@<XREF:INDI>@																									{0:M}
										+1	NCHI	<COUNT_OF_CHILDREN>																			{0:1}
										+1	SUBM	@<XREF:SUBM>@																									{0:M}
										+1	<<LDS_SPOUSE_SEALING>>																					{0:M}
										+1	<<SOURCE_CITATION>>																								{0:M}
										+1	<<MULTIMEDIA_LINK>>																								{0:M}
										+1	<<NOTE_STRUCTURE>>																									{0:M}
										+1	REFN	<USER_REFERENCE_NUMBER>															{0:M}
												+2	TYPE	<USER_REFERENCE_TYPE>															{0:1}
										+1	RIN	<AUTOMATED_RECORD_ID>																		{0:1}
										+1	<<CHANGE_DATE>>																												{0:1}

SUBM	молча	игнорируется.
REFN	и	REFN:TYPE	сохраняются	как	 Атрибуты 	 Семьи ,	но	если	тегов	REFN	больше	одного,	станет	непонятно	какой	TYPE	к
какому	REFN	относится.

SOURCE_RECORD

Запись	SOURCE_RECORD	сохраняется	в	Gramps	как	объект	 Источник ,	за	исключением	выделенных	жирным	тегов.

			SOURCE_RECORD:=
								n	@<XREF:SOUR>@	SOUR																												{1:1}
										+1	DATA																																							{0:1}
												+2	EVEN	<EVENTS_RECORDED>																			{0:M}
														+3	DATE	<DATE_PERIOD>																					{0:1}
														+3	PLAC	<SOURCE_JURISDICTION_PLACE>							{0:1}
												+2	AGNC	<RESPONSIBLE_AGENCY>																{0:1}
												+2	<<NOTE_STRUCTURE>>																							{0:M}
										+1	AUTH	<SOURCE_ORIGINATOR>																			{0:1}
												+2	[CONT|CONC]	<SOURCE_ORIGINATOR>										{0:M}
										+1	TITL	<SOURCE_DESCRIPTIVE_TITLE>												{0:1}
												+2	[CONT|CONC]	<SOURCE_DESCRIPTIVE_TITLE>			{0:M}
										+1	ABBR	<SOURCE_FILED_BY_ENTRY>															{0:1}
										+1	PUBL	<SOURCE_PUBLICATION_FACTS>												{0:1}
												+2	[CONT|CONC]	<SOURCE_PUBLICATION_FACTS>			{0:M}
										+1	TEXT	<TEXT_FROM_SOURCE>																				{0:1}
												+2	[CONT|CONC]	<TEXT_FROM_SOURCE>											{0:M}
										+1	<<SOURCE_REPOSITORY_CITATION>>													{0:1}
										+1	<<MULTIMEDIA_LINK>>																								{0:M}
										+1	<<NOTE_STRUCTURE>>																									{0:M}
										+1	REFN	<USER_REFERENCE_NUMBER>															{0:M}
												+2	TYPE	<USER_REFERENCE_TYPE>															{0:1}
										+1	RIN	<AUTOMATED_RECORD_ID>																		{0:1}
										+1	<<CHANGE_DATE>>																												{0:1}

DATA	и	его	подчиненные	теги	игнорируются

REPOSITORY_RECORD

Запись	REPOSITORY_RECORD	сохраняется	в	Gramps	как	объект	 Хранилище ,	за	исключением	выделенных	жирным	тегов.

			REPOSITORY_RECORD:	=
								n	@<XREF:REPO>@	REPO																												{1:1}
										+1	NAME	<NAME_OF_REPOSITORY>																		{0:1}
										+1	<<ADDRESS_STRUCTURE>>																						{0:1}
										+1	<<NOTE_STRUCTURE>>																									{0:M}
										+1	REFN	<USER_REFERENCE_NUMBER>															{0:M}
												+2	TYPE	<USER_REFERENCE_TYPE>															{0:1}
										+1	RIN	<AUTOMATED_RECORD_ID>																		{0:1}
										+1	<<CHANGE_DATE>>																												{0:1}

REFN,	REFN:TYPE	и	RIN	игнорируются
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MULTIMEDIA_RECORD

Запись	MULTIMEDIA_RECORD	сохраняется	в	Gramps	как	объект	 Документ ,	за	исключением	выделенных	жирным	тегов.

			MULTIMEDIA_RECORD:=
								n	@<XREF:OBJE>@	OBJE																												{1:1}
										+1	FORM	<MULTIMEDIA_FORMAT>																			{1:1}
										+1	TITL	<DESCRIPTIVE_TITLE>																			{0:1}
										+1	<<NOTE_STRUCTURE>>																									{0:M}
										+1	<<SOURCE_CITATION>>																								{0:M}
										+1	BLOB																																							{1:1}
												+2	CONT	<ENCODED_MULTIMEDIA_LINE>											{1:M}
										+1	OBJE	@<XREF:OBJE>@					/*	ссылка	на	следующий	объект	*/		{0:1}
										+1	REFN	<USER_REFERENCE_NUMBER>															{0:M}
												+2	TYPE	<USER_REFERENCE_TYPE>															{0:1}
										+1	RIN	<AUTOMATED_RECORD_ID>																		{0:1}

Ожидается,	что	будет	тег	'FILE',	указывающий	на	файл	с	документом.	Эти	возможности	взяты	из	спецификации	GEDCOM	5.6.0,	но
возможности	GEDCOM	5.6.0	по	поддержке	более	одного	<MUTIMEDIA_FILE_REFN>	с	подчиненными	тегами	FORM,	TYPE	и
TITL	не	реализованы.	(Следующий	файл	может	перезаписать	предыдущий	-	проверок	не	делается).
BLOB	игнорируется
REFN,	REFN:TYPE	и	RIN	игнорируются

NOTE_RECORD

Запись	NOTE_RECORD	сохраняется	в	Gramps	как	объект	 Заметка ,	за	исключением	выделенных	жирным	тегов.

			NOTE_RECORD:=
								n	@<XREF:NOTE>@	NOTE	<SUBMITTER_TEXT>											{1:1}
										+1	[	CONC	|	CONT]	<SUBMITTER_TEXT>												{0:M}
										+1	<<SOURCE_CITATION>>																								{0:M}
										+1	REFN	<USER_REFERENCE_NUMBER>															{0:M}
												+2	TYPE	<USER_REFERENCE_TYPE>															{0:1}
										+1	RIN	<AUTOMATED_RECORD_ID>																		{0:1}
										+1	<<CHANGE_DATE>>																												{0:1}

SOURCE_CITATION	игнорируется
REFN,	REFN:TYPE	и	RIN	игнорируются

Экспорт	данных

Информация	в	этой	статье	или	некоторых	её	разделах	устарела.
Пожалуйста	помогите	улучшить	Gramps	Wiki,	исправив	и	дополнив	эту	статью.

Рис.	5.9	Помощник	экспорта:	начало

Рис.	5.10	Помощник	экспорта:	выбор	формата

Экспорт	позволяет	вам	поделиться	любой	частью	вашего	семейного	древа	с	другими	исследователями,	равно	как	и	перенести	вашу
информацию	на	другой	компьютер.	В	настоящее	время,	Gramps	может	экспортировать	информацию	в	файлы	следующих	форматов:
Gramps	XML,	GEDCOM,	Gramps	XML-пакет,	Web	Family	Tree,	GeneWeb	и	CSV.
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Экспорт	сохраняет	копию

Когда	вы	экспортируете	информацию	из	Gramps,	вы	сохраняете	копию	открытого	семейного
древа.	Операция	экспорта	создает	новый	файл	с	копией	вашей	информации.	Обратите	внимание,
что	открытое	в	окне	Gramps	семейное	древо	НЕ	является	файлом,	создаваемым	во	время	экспорта.
Дальнейшее	редактирование	текущего	открытого	семейного	древа	не	внесет	изменения	в	файл	с
копией,	созданный	во	время	экспорта.

Для	экспорта	информации	выберите	пункт	меню	Семейные	древеса	->	Экспорт....	На	экране	появится	 Помощник	экспорта .	Его
страницы	проведут	Вас	по	этапам	экспорта:	выбор	формата	файла	(рис.	5.10),	выбор	пути	и	названия	нового	файла,	указание
специфичных	для	выбранного	формата	параметров.	После	закрытия	Вами	последней	страницы	Помощника	Экспорта	с	подтверждением
выбранных	Вами	параметров	экспорта,	операция	экспорта	будет	выполнена	в	соответствии	с	указанными	Вами	настройками.	Можно	в
любое	время	нажать	кнопку	 Назад 	для	пересмотра	ранее	указанных	параметров	экспорта,	чтобы	затем	повторить	экспорт	с	новыми
параметрами.

Фильтры	и	приватность

Gramps	позволяет	экспортировать	информацию	во	множество	распространенных	форматов	и	предоставляет	возможности	по	тонкой
настройке	параметров	экспорта.

Фильтры	людей	и	заметок:	Использование	фильтров	позволяет	ограничить	количество	экспортируемой	информации	в	соответствии
с	указанными	критериями	фильтрации.

Не	включать	записи	помеченные	как	личные:	Установите	этот	флажок,	чтобы	не	включать	личные	записи	в	файл	экспорта.

Ограничить	данные	о	ныне	живущих	людях:	Установите	этот	флажок,	чтобы	ограничить	количество	экспортируемой	информации,
касающейся	ныне	живущих	людей.	При	этом	вся	информация	об	их	рождении,	смерти,	адресах,	значимых	событиях	жизни	и	т.п.	не
будет	включена	в	файл	экспорта.	Включение	этого	параметра	активирует	дополнительные	настройки	ограничения	экспортируемой
информации	для	ныне	живущих	людей.	Например,	можно	экспортировать	слово	"Живой"	вместо	имени	человека;	можно	исключить
из	экспорта	заметки;	можно	исключить	источники	информации	для	ныне	живущих	людей.

Не	включать	записи	не	связанные	с	выбранным	лицом:	Позволяет	исключить	из	экспорта	записи,	не	связанные	с	выбранным	лицом.

Иногда	из	имеющейся	информации	не	очевидно,	жив	ли	человек	на	самом	деле.	Gramps	использует	сложный	алгоритм	для	определения
того,	является	ли	человек	ныне	живущим.	Помните,	Gramps	делает	лишь	наилучшие	возможные	предположения	и	не	может	всегда
угадывать	правильно.	Пожалуйста,	перепроверяйте	экспортируемую	информацию.

Экспорт	в	родные	для	Gramps	форматы

Фильтр	личных	записей

Важно	проверять	настройки	фильтров	при	экспорте.	Отключите	все	фильтры,	если	вы	делаете
резервную	копию.

Gramps	XML	(.gramps):	Этот	формат	является	стандартным	форматом	Gramps	для	обмена	информацией	и	создания	резервных	копий
(для	полной	переносимости,	включая	документы,	необходимо	использовать	формат	Gramps	XML-пакет	(.gpkg))	Экспорт	в	формат
Gramps	XML	создает	переносимый	файл.	XML	-	это	текстовый	файл	и	вы	можете	посмтреть	его	содержимое.	Гарантируется,	что
файлы	Gramps	XML,	созданные	в	предыдущих	версиях	Gramps,	можно	будет	открыть	в	последующих	(но	не	наоборот!).

Gramps	XML-пакет	(.gpkg):	Экспорт	в	этот	формат	создает	сжатый	файл,	содержащий	семейное	древо	в	формате	Gramps	XML	и
копии	всех	связанных	с	ним	документов.	Этот	формат	полезен	при	переносе	семейного	древа	на	другой	компьютер	или	для
передачи	его	другим	людям.

Если	Gramps	во	время	экспорта	не	может	найти	файл	с	документом,	то	Вы	увидите	сообщение	 Файл	не	найден .	Такое	же	сообщение
может	появиться	в	аналогичных	случаях	при	экспорте	в	формат	GEDCOM.

Экспорт	в	GEDCOM

Информация	в	этой	статье	или	некоторых	её	разделах	устарела.
Пожалуйста	помогите	улучшить	Gramps	Wiki,	исправив	и	дополнив	эту	статью.
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Рис.	5.11	Помощник	экспорта:	настройки	GEDCOM

Gramps	может	экспортировать	ваши	данные	в	распространенный	формат	GEDCOM.	Для	получения	дополнительной	информации	об
ограничениях	экспорта	GEDCOM	читайте	статью	Gramps	и	GEDCOM	(для	полного	экспорта	используйте	Gramps	XML).	Gramps
позволяет	производить	тонкую	настройку	параметров	экспорта	(рис.	5.11).

Фильтры	людей	и	заметок:	Использование	фильтров	позволяет	ограничить	количество	экспортируемой	информации	в	соответствии
с	указанными	критериями	фильтрации.

Не	включать	записи	помеченные	как	личные:	Установите	этот	флажок,	чтобы	не	включать	личные	записи	в	файл	экспорта.

Ограничить	данные	о	ныне	живущих	людях:	Установите	этот	флажок,	чтобы	ограничить	количество	экспортируемой	информации,
касающейся	ныне	живущих	людей.	При	этом	вся	информация	о	их	рождении,	смерти,	адресах,	значимых	событиях	жизни	и	т.п.	не
будет	включена	в	файл	экспорта.	Включение	этого	параметра	активирует	дополнительные	настройки	ограничения	экспортируемой
информации	для	ныне	живущих	людей.	Например,	можно	экспортировать	слово	"Живой"	вместо	имени	человека;	можно	исключить
из	экспорта	заметки;	можно	исключить	источники	информации	для	ныне	живущих	людей.

Не	включать	записи	не	связанные	с	выбранным	лицом:	Позволяет	исключить	из	экспорта	записи,	не	связанные	с	выбранным	лицом.

Экспорт	в	другие	форматы

Web	Family	Tree:	Экспорт	в	формат	Web	Family	Tree	создает	текстовый	файл	для	использования	в	программе	Web	Family	Tree.
Среди	параметров	экспорта	доступны	фильтр	и	возможность	ограничения	экспортируемой	информации	для	ныне	живущих	людей
пределами	их	семейного	круга.

GeneWeb:	Экспорт	в	формат	GeneWeb	создает	копию	вашей	информации	в	популярном	в	интернете	генеалогическом	формате.
Подробнее	о	GeneWeb	и	формате	смотрите	http://cristal.inria.fr/~ddr/GeneWeb/en/.

vCalendar	и	vCard:	Экспорт	в	vCalendar	или	vCard	сохраняет	информацию	в	форматах,	используемых	многими	программами-
календарями	и	адресными	книгами	(т.е.	ПИМ	-	Персональный	Информационный	Менеджер).

CSV:	Позволяет	импортировать	и	экспортировать	часть	данных	вашего	семейного	древа	в	простой	текстовый	файл,	в	котором
значения	отделяются	друг	от	друга	запятой.	Подробнее	смотрите	в	статье	Экспорт	и	импорт	CSV.	Также	смотрите	Экспорт	экрана.

Перенос	древа	из	Gramps	2.2	в	Gramps	6.0
Есть	два	способа	переноса	Вашей	информации	из	Gramps	версии	2.2	в	Gramps	версии	4:	прямой	импорт	базы	данных	версии	2.2	в	виде
файла	grdb	или	импорт	предварительно	выгруженной	базы	данных	из	Gramps	2.2	в	виде	файла	в	формате	XML.	Вследствие	сложности
внутреннего	устройства	хранения	информации	в	базах	данных	Gramps	версии	2.2,	экспорт	базы	данных	в	XML	формат	обычно	является
наиболее	удобным	и	беспроблемным	способом	переноса	информации	в	Gramps	версии	4.

Импорт	файла	базы	данных	в	формате	Gramps	2.2	(grdb):	В	базе	данных	Gramps	версии	2.2	информация	хранится	в	файле	с
расширением	grdb	и	в	одном	и	более	лог-файлах,	которые	хранятся	в	подкаталогах	в	.gramps/env.	Для	импорта	информации	из	базы
данных	в	формате	2.2	в	Gramps	4	создайте	новую	базу	данных	и	импортируйте	информацию	из	базы	данных	Gramps	2.2.	Важно
запустить	Gramps	4	от	имени	того	же	пользователя	системы,	под	которым	ранее	запускался	Gramps	2.2,	для	того,	чтобы	Gramps	4
имел	право	доступа	в	каталог	.gramps/env	с	лог-файлами,	необходимыми	для	поддержки	работы	базы	данных,	который
использовался	базой	данных	Gramps	2.2.	Если	запускать	Gramps	4	от	имени	другого	пользователя	или	на	другом	компьютере,	то
Вам	будет	необходимо	самостоятельно	обеспечить	выполнение	всех	необходимых	действий	по	обеспечению	доступности
.gramps/env	и	лог-файлов.	Если	во	время	импорта	базы	данных	формата	Gramps	2.2	появляется	сообщение	вида	"невозможно
открыть	/tmp/tmpDkI5pO",	то	это	значит,	что	Gramps	4	не	может	открыть	все	файлы,	которые	входят	в	состав	импортируемой	базы
данных.

Gramps	XML:	При	использовании	этого	способа	сначала	необходимо	сделать	экспорт	базы	данных	из	Gramps	2.2	в	формат	Gramps
XML.	Будет	создан	файл	с	расширением	.gramps,	содержащий	в	сжатом	виде	файл	базы	данных	в	формате	XML.	Этот	файл	не
имеет	зависящих	от	него	файлов	и	может	быть	перенесен	туда,	где	будет	установлен	Gramps	4.	После	завершения	экспорта
запустите	Gramps	4,	создайте	в	нем	пустую	базу	данных	и	импортируйте	в	нее	файл	.gramps.

Пред Содержание След
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Manage	Family	Trees:	CSV	Import	and	Export

Previous Index Next

This	section	relates	to	using	Gramps	with	the	Comma	Separated	Values	Spreadsheet(CSV)	format.

Gramps	CSV	import
Comma	Separated	Values	Spreadsheet(CSV)	export

You	can	also	Export	the	current	list	view	to	a	Spreadsheet(*.ODT)	or	CSV	file.

Gramps	Spreadsheet	Import/Export
This	format	allows	you	to	import/export	a	spreadsheet	of	data	all	at	once.	By	default,	the	spreadsheet	must	be	in	the	Comma	Separated	Value	(CSV)
format.	(Although	alternative	Delimiters	can	be	specified	for	the	CSV	Dialect	in	the	View	->	Configure	options	in	list	views.)	Most	spreadsheet
programs	can	read	and	write	this	format.	It	is	also	easy	to	write	by	hand.	This	is	the	only	Gramps	import	format	which	allows	for	merging	with
existing	data.

This	spreadsheet	format	does	not	allow	for	100%	export	of	Gramps	data.

It	only	exports	(and	imports)	a	subset	of	data,	namely:	people	(names,	gender,	birth,	baptism,	death,	and
burial	dates/places/sources);	marriages	(dates/places/sources);	relationships	(parents	and	children);	and
places	(title,	name,	type,	latitude,	longitude,	code,	enclosed	by,	and	enclosed	date).	Notes	are	not
exported,	but	new	notes	are	appended	onto	the	end	of	existing	notes.

Both	the	CSV	import	and	export	use	the	 Place	Format	setting	(in	the	Display	tab	of	Edit	-
>	Preferences)	for	places.

For	most	uses,	the	'Full'	setting	for	Place	Formats	should	be	used.	If	the	place	format	setting	doesn't
match	the	CSV	file	for	import,	you	may	get	the	same	place	created	more	than	once.

There	are	three	main	uses	for	this	format:

1.	 You	can	export	your	core	Gramps	data	into	a	spreadsheet	format,	edit	it	with	a	text	or	spreadsheet	program,	and	import	the	changes	and
additions	back	into	Gramps.	This	is	handy	for	sending	to	others	to	fill	in,	or	for	taking	on	the	road	when	you	don't	have	your	full	Gramps
application.

2.	 You	can	import	new	data	into	your	Gramps	database.	For	example,	if	you	have	a	set	of	new	people	to	add	to	your	database,	but	don't	want	to
hunt	and	peck	your	way	to	finding	where	they	go,	you	might	find	it	easier	to	type	them	into	a	spreadsheet,	and	then	quickly	bring	all	of	them
in	at	once.	This	is	handy	if	you	have	a	large	amount	of	data	that	you	are	cutting	and	pasting	from	another	application	or	the	web.	An	example
of	this	is	restoring	your	Gramps	database	by	loading	the	Narrative	Website	into	a	spreadsheet.

3.	 You	can	also	import	a	set	of	corrections	and	additions.	Say	that	you	have	printed	out	a	report,	and	you	are	going	through	it	marking
corrections.	If	you	make	each	correction	a	section	of	a	spreadsheet,	you	can	"script	the	edits"	and	then	execute	them	all	at	once.

Export

Fig.	6.1	Export	Assistant	-	Export	Options	-	wizard	dialog	(showing
defaults	for	"Comma	Separated	Values	Spreadsheet(CSV)")	with
Bottom	section	for	File	format	specific	options

To	export	your	family	tree:

1.	 Start	Gramps
2.	 Load	the	Family	Tree	to	be	exported
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3.	 Select	from	the	menu	Family	Trees	->	Export...
4.	 Select	 Next 	on	the	 Saving	your	data 	window.
5.	 Select	Comma	Separated	Values	Spreadsheet	(CSV)	on	the	 Choose	the	output	format 	window
6.	 On	the	 Export	options 	window:

1.	 In	the	top	section,	select	which	filters	to	apply	to	your	family	tree
2.	 From	the	checkboxes,	select	which	items	to	include	in	the	export	(people,	marriages,	children,	places)	and	whether	to	Translate	headers

into	the	language	currently	being	used.
7.	 On	the	 Select	Save	file 	window,	select	the	destination	filename	and	path
8.	 On	the	 Final	confirmation 	window,	verify	the	setting	and	click	the	 Apply 	button	to	begin	the	actual	export.

A	subset	of	fields	containing	your	genealogy	data	will	be	saved	to	a	.csv	file	in	the	format	described	below.	The	people	and	families	are	annotated	in
such	a	way	that	allows	the	data	to	be	edited	and	overwrite	the	outdated	information	as	they	are	Imported	back	in.	The	annotations	allow	updating
the	Tree	database	via	Import.

There	are	some	columns	that	will	be	blank,	specifically	note	and	source	columns.	These	are	listed	in	the	spreadsheet	so	that	you	can	make	notes	for
the	import,	but	notes	are	never	exported	with	this	tool.

Your	data	is	broken	up	into	four	sections	representing	places,	individuals,	marriages,	and	children.	The	exported	fields	and	column	names	are:

Places
Place,	Title,	Name,	Type,	Latitude,	Longitude,	Code,	Enclosed_by,	Date

Individuals
Person,	Lastname,	Firstname,	Callname,	Suffix,	Prefix,	Title,	Gender,	Birthdate,	Birthplace	(or	Birthplaceid),	Birthsource,	Baptismdate,
Baptismplace	(or	Baptismplaceid),	Baptismsource,	Deathdate,	Deathplace	(or	Deathplaceid),	Deathsource,	Burialdate,	Burialplace	(or
Burialplaceid),	Burialsource,	Note

Marriages
Marriage,	Husband,	Wife,	Date,	Place	(or	Placeid),	Source,	Note

Families
Family,	Child

The	first	column	in	each	area	is	the	Gramps	ID.	That	is	what	will	connect	your	edits	back	to	the	appropriate	data,	so	do	not	alter	those	IDs.	Load	this
file	into	your	favorite	spreadsheet	using	comma	separated,	double-quote	text	delimited,	and	Text	format	(any	encoding	for	now).	Then	you	can	add
or	correct	data,	and	save	it	back	out,	keeping	the	same	format.	You	can	then	import	the	data	back	on	top	of	your	old	data	and	it	will	be	corrected.

LibreOffice	allows	auto-formatting	to	be	turned	off	when	opening	the	CSV	file.

Auto-formatting	may	cause	LibreOffice	to	interpret	the	dates	incorrectly.	Change	the	type	of	the	column
to	'Text'	rather	than	'Standard'.	If	your	spreadsheet	program	doesn't	allow	formatting	the	fields	before
imported	the	data	into	columns,	it	will	be	necessary	to	change	the	dates	display	format	in	Gramps	before
exporting.	This	is	done	with	Edit	->	Preferences	->	Display	->	Date	Format

.

Excel	allows	formatting	columns	as	'text'	while	opening	the	CSV	file.

If	not	overridden,	Excel	may	interpret	the	dates	incorrectly.	Change	the	type	of	the	column	to	'Text'	rather
than	'General'.	Open	the	CSV	from	the	file	menu	(select	'Text	files'	as	the	type	in	the	file	open	dialog
box).	This	brings	up	the	'Text	Import	Wizard'	which	allows	selecting	'Delimited'	by	commas,	and
selecting	'Text'	for	all	the	columns.	(To	Select	all	columns,	click	the	first	column,	scroll	to	last	and	shift-
click	it.)

.

Excel	cannot	directly	save	proper	Unicode	CSV	files.

To	save	a	CSV	in	Unicode,	save	to	"Unicode	Text	(*.txt)",	then	open	the	file	in	Notepad++.	Using
Notepad++	'Search'	and	replace	menu,	change	all	the	tabs	('/t')	to	commas	(',').	Using	Notepad++
'Encoding'	menu	convert	to	"UTF-8-BOM"	and	save	the	file	to	CSV	('*.csv').

Import
To	import	your	CSV	data:

1.	 Use	the	file	from	above,	or	create	a	spreadsheet	(described	below)	with	genealogical	data
2.	 Start	Gramps
3.	 Create	a	new	Family	Tree
4.	 Select	from	the	menu	Family	Trees	->Import...
5.	 Select	the	Comma	Separated	Values	Spreadsheet	(CSV)	file	and	then	select	the	 Import 	button
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The	merge	part	of	this	code	will	only	add	or	update	information	to	your	database,	and	it	always	assume	that	the	spreadsheet	data	is	the	correct
version.

If	you	load	this	spreadsheet	into	LibreOffice,	make	sure	you	select	each	column	as	type	Text	rather	than	Standard.	Standard	will	reformat	your
dates	and	numbers.	Also,	if	you	use	Excel,	you	will	probably	want	to	select	all	cells	once	opened,	and	change	the	format	of	the	cells	to	Text.

The	spreadsheet	is	data	made	up	of	columns.	Each	column	should	have	at	the	top	of	it	the	name	of	what	type	of	data	is	in	the	column.	The	first
column	in	each	area	is	the	Gramps	ID	reference.	You	must	use	special	names	for	the	columns.	They	are:

Place

place	-	a	reference	to	this	place
title	-	title	of	place
name	-	name	of	place
type	-	type	of	place	(eg,	City,	County,	State,	etc.)
latitude	-	latitude	of	place
longitude	-	longitude	of	place
code	-	postal	code,	etc.
enclosed_by	-	the	reference	to	another	place	that	encloses	this	one
date	-	date	that	the	enclosed_by	place	was	in	effect

People

person	-		a	reference	to	be	used	for	families	(marriages,	and	children)	
grampsid	-	to	assign	a	Gramps	id	to	the	person
firstname/first_name/given_name/given	-	a	person's	first	name
surname/lastname/last_name	-	a	person's	last	name
callname/call_name/call	-	a	common	name	(nickname)	for	the	person
prefix	-	surname	prefix	(von,	de,	etc)
suffix	-	a	suffix	of	a	person's	name	(Jr.,	Sr.)
title	-	a	person's	title	(Dr.,	Mr.)
gender	-	male	or	female	(you	should	use	the	translation	for	your	language)
source	-	source	title	for	person
note	-	a	note	for	the	person's	record

birthdate	-	date	of	birth
birthplace	-	place	of	birth
birthplaceid/birthplace_id/birth_place_id	-	place	id	of	birth
birthsource	-	source	title	for	birth

baptismdate	-	date	of	baptism
baptismplace	-	place	of	baptism
baptismplaceid	-	place	id	of	baptism
baptismsource	-	source	title	of	baptism

deathdate	-	date	of	death
deathplace	-	place	of	death
deathplaceid	-	place	id	of	death
deathsource	-	source	title	for	death
deathcause	-	cause	of	death

burialdate	-	date	of	burial
burialplace	-	place	of	burial
burialplaceid	-	place	id	of	burial
burialsource	-	source	title	of	burial

occupationdate	-	date	of	occupation
occupationplace	-	place	of	occupation
occupationplace_id	-	place	id	of	occupation
occupationsource	-	source	title	of	occupation
occupationdescr	-	description	of	occupation

residencedate	-	date	of	residence
residenceplace	-	place	of	residence
residenceplace_id	-	place	id	of	residence
residencesource	-	source	title	of	residence

attributetype	-	type	of	attribute
attributevalue	-	value	of	attribute
attributesource	-	source	title	of	attribute

Marriage

marriage	-	if	you	want	to	reference	this	from	a	family,	you'll	need	a	matching	name	here
husband/father/parent1	-	the	reference	of	the	person	above	who	is	the	husband	
																									(for	female	parent1,	you'll	need	to	put	gender	in	the	person	area,	
																									or	edit	it	later	in	gramps)
wife/mother/parent2	-	the	reference	of	the	person	above	who	is	the	wife	
																									(for	male	parent2,	you'll	need	to	put	gender	in	the	person	area,	
																									or	edit	it	later	in	gramps)
date	-	the	date	of	the	marriage
place	-	the	place	of	the	marriage
placeid	-	the	place	id	of	the	marriage
source	-	source	title	of	the	marriage
note	-	a	note	about	the	marriage/wedding

Family

family	-	a	reference	to	tie	this	to	a	marriage	above	(required)
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child	-	the	reference	of	the	person	above	who	is	a	child
source	-	source	title	of	the	marriage
note	-	a	note	about	the	family
gender	-	male	or	female	(you	should	use	the	translation	for	your	language)	
									[You	can	put	gender	here,	or	in	person	above]

Details
Column	names	are	not	case-sensitive.	You	may	use	any	combination	of	the	columns,	in	any	order.	(Actually,	you	have	to	at	least	have	a	surname
and	a	given	name	when	defining	a	person,	you	have	to	have	a	marriage	and	child	columns	when	defining	children,	and	places	need	a	place
reference,	but	that	is	it.)	The	column	names	are	the	English	names	given	(for	now)	but	the	data	should	be	in	your	language	(including	the	words
"male"	and	"female").

Top-to-bottom	order	is	important	in	that	if	you	want	to	reference	something	in	one	area	to	another,	the	definition	MUST	come	first.	For	example,	if
you	want	to	define	families	of	people,	the	individuals	must	be	defined	before	the	families.	The	same	applies	to	places.	So	it	is	usually	best	to	put	the
Places	data	first,	people	next,	then	marriages	and	families.

Each	of	these	can	go	in	its	own	area	in	a	spreadsheet.	There	is	no	limit	to	the	number	of	areas	in	a	sheet,	and	each	area	can	have	any	number	of	rows.
Leave	a	blank	row	between	"areas".	Just	make	sure	that	areas	are	not	next	to	each	other;	they	must	be	above	and	below	one	another.

You	can	have	multiple	areas	of	each	kind	on	a	spreadsheet.	The	only	limitation	is	that	if	you	refer	to	a	person,	you	must	do	that	in	a	row	lower	than
where	that	person	is	described.	Likewise,	if	you	refer	to	a	marriage,	you	must	do	that	in	a	row	lower	than	where	the	marriage	is	described.
References	to	enclosed_by	places	must	already	exist	in	the	database,	or	be	defined	in	rows	above	in	the	spreadsheet.

If	you	use	the	'grampsid'	as	a	way	to	assign	specific	ids,	be	very	careful	when	importing	to	a	current	database.	Any	data	you	enter	will	overwrite	the
data	assigned	to	that	grampsid.	If	you	use	ids	in	the	place,	person,	marriage,	or	family	columns	that	are	surrounded	by	brackets	(for	example
'[I0001]'),	the	values	you	use	will	be	interpreted	as	grampsids	as	well.	If	you	are	adding	new	items,	you	are	encouraged	to	avoid	use	of	the	bracket
format	or	grampsid	columns,	so	as	to	avoid	accidentally	overwriting	your	data.	If	you	are	mixing	the	bracket	(or	grampsid)	methods	with	plain
references	(no	brackets),	put	the	plain	referenced	data	after	the	bracket	referenced	data.

If	you	are	entering	the	data	in	a	text	file,	and	if	you	wish	to	have	a	comma	inside	one	of	the	values,	like	"Clinton,	Co.,	MO"	then	you	need	place	the
entire	value	in	double-quotes	and	put	the	first	double-quote	right	after	the	preceding	comma.	For	example:

marriage,	parent1,	parent2,	place
m1,	p1,	p2,"Clinton,	Co.,	MO"
m2,	p3,	p4,"Havertown,	PA"

A	spreadsheet	program	will	do	this	automatically	for	you.

Here	is	an	example	spreadsheet	in	LibreOffice,	but	any	spreadsheet	program	should	work.

Fig.	6.2

,,,,,,,,,
,"Firstname","Surname","Callname","Gender","Prefix","Suffix","Title","Note","Grampsid"
,"Douglas","Test","Doug","male","Von","Sr.","Dr.","This	is	not	related","I0007"
,"Laura","Test",,"female",,,,,

Notice	that	the	data	need	not	begin	in	the	first	column,	nor	in	the	first	row.

And	here	is	the	resulting	data	in	Gramps:
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Fig.	6.3

Example	CSV	with	multiple	areas

Here	is	an	example	of	a	CSV	text	spreadsheet	with	multiple	areas:

Place,	Title,	Name,	Type
[P0001],	Michigan,	Michigan,	State
L1,	Canada,	Canada,	Country
L2,	USA,	USA,	Country

Firstname,	Surname,	Birthdate,	Birth	place	id
John,						Tester,		11/11/1965,	L1
Sally,					Tester,		01/26/1973,	L1

Person,	Firstname,	Surname,	Birthdate,				Birth	place	id
p1,					Tom,							Smith,			22	Jan	1970,	[P0001]
p2,					Mary,						Jones
p3,					Jonnie,				Smith
p5,					James,					Loucher
p6,					Penny,					Armbruster
[P0002],Tim,							Sparklet

Marriage,	Husband,	Wife
m1,							p1,						p2
m2,							p5,						p6

Family,	Child
m1,					p3
m1,					p6
m2,					[P0002]

If	you	cut	and	paste	that	into	a	file	(or	use	the	Addon:Import	Gramplet),	you	can	import	it	directly.

A	date	can	be	any	valid	Gramps	date,	including	dates	formats	like	"26	JAN	1973"	or	"26.1.1973".

If	you	make	your	references	be	Gramps	IDs	inside	square	brackets,	then	you	can	refer	to	people	already	in	the	database,	like	this:

Person,				Firstname,	Lastname
joe's	boy,	Harry,					Smith

Family,		Child
[F1524],	joe's	boy

Husband,	Wife
[I0123],	[I0562]

firstname,	surname
Timothy,	Jones

place,	enclosed_by
[P0001],	[P0002]

This	example	would	create	and	add	Harry	Smith	to	the	previously	existing	family	in	Gramps,	family	F1524.

Also,	this	example	would	marry	two	previously	existing	people,	I0123,	and	I0562.

This	also	creates	a	person	named	Timothy	Jones	who	is	not	related	to	anyone.
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Finally,	this	also	make	place	P0001	be	enclosed	by	place	P0002.

Example	CSV	from	Spreadsheet

Fig.	6.4

Using	Gramps	Example.gramps	for	this	example.	The	children	already	exist	in	the	Family	Tree.	So	you	can	enter	an	entire	generation	(8	names	with
marriage	dates)	into	LibreOffice	Calc.

Notice	that	you	can	use	numbers	or	strings	as	the	reference	names	between	areas.	In	the	person	area,	I	used	the	numbers	1	through	8.	That	made	it
easy	to	refer	to	them	in	the	second	area	of	marriages.	The	marriages	are	labeled	with	the	letters	A	through	D.

Also	note	that	in	the	spreadsheet	the	children	in	the	third	area	are	existing	people	in	Gramps	as	indicated	by	the	brackets	around	the	Gramps	IDs.

Saving	as	CSV	and	importing	into	Gramps	produces	the	far	right-hand	column	in	the	tree.

Fig.	6.5	Saving	as	CSV	and	importing	into	Gramps	produces	the	far	right-
hand	column	in	the	tree.(Highlighted	in	yellow)

Contents	of	CSV	file	gen4-test.csv

,,,
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,,,
"Person","Firstname","Lastname",
1,"Peter","Blank",
2,"Anna	Maria","Kiefer",
3,"Georg","Schmidt",
4,"Barbara","Goering",
5,"Johann","Kiefer",
6,"Fides","Federer",
7,"Sebastian","Schelli",
8,"Magdelena","Schlegel",
,,,
,,,
"Marriage","Husband","Wife","Date"
"A",1,2,"28	jan	1712"
"B",3,4,"4	may	1732"
"C",5,6,02/07/1930
"D",7,8,17/08/1927
,,,
"Family","Child",,
"A","[I0104]",,
"B","[I0105]",,
"C","[I0972]",,
"D","[I0973]",,

See	also

Discourse	forum	discussion:
CSV	template	for	Text	Import

Addon:Import	(text)	Gramplet	Third	party	addon	by	Doug	Blank	-	an	interactive	version	of	the	CSV	Import
Python	CSV	library	docs	-	dialects	and	formatting	parameters

Examples	of	customizing	the	CSV	import	code	to	support	additional	records:

Feature	request	13391:	[CSV]	Importing	complex	Excel	tables	into	Gramps	(such	as	witnesses	information)
PR	#139	:	Add	CSV	Import	support	for	AFN	and	REFN	attributes
PR	#810	:	Add	occupation	&	residence	events	+	attributes	in	the	CSV	persons	importer
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Probably	Alive
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The	living	status	of	the	people	in	a	Gramps	database	is	important	when	you	need	to	share	your	data	with	others,	but	want	to	protect	the	details	of
those	that	are	alive.	It	is	also	employed	in	some	reports.	For	these	reasons,	Gramps	has	some	tools	to	help	you	determine	if	someone	is	alive.

How	does	Gramps	determine	if	someone	is	alive?

Fig.	7.1	Menu:	"Edit	>	Preferences..."	-	"Limits"	-	tab	-	defaults

A	simple	way	to	tell	if	someone	is	alive	is	to	see	if	they	have	a	death	event,	or	a	death-related	event	(such	as	a	burial).	However,	it	is	probably	true
that	many	people	in	your	database	don't	have	such	events,	as	you	may	not	know	any	details	of	their	death.	If	you	know	someone	is	dead,	it	might	be
a	good	idea	to	create	a	death	event.	You	can	also	go	back	and	add	useful	details	(such	as	date	and	place	of	death)	once	that	is	known.	Adding	events
for	people	known	dead,	even	if	they	contain	no	exact	details,	is	somewhat	useful.	However,	Gramps	can	also	add	events	with	estimated	dates	(or
not)	for	you	(described	below).

Requiring	a	user	to	manually	add	a	death	event	to	a	person	(so	that	they	would	not	be	considered	alive)	would	be	very	tedious	---one	would	have	to
enter	details	on	many	people.	Recall	that	if	someone	is	considered	alive,	then	their	details	should	be	prevented	from	being	shared	when	exported.
Therefore,	Gramps	has	a	function	that	can	compute	whether	someone	is	probably	alive	based	on	their	event	dates,	or	their	relations	with	people	who
may	have	event	dates.	For	example,	if	a	person	doesn't	have	any	evidence	of	death	(such	as	a	death	or	burial	event),	then	Gramps	will	check	this
person's	parents,	children,	siblings,	continuously	until	some	evidence	is	found---or	it	runs	out	of	connections	to	check.	Using	information	on	typical
age	and	event	spans	(such	as	typical	age	differences	among	siblings,	typical	ages	of	mothers	at	time	of	birth,	etc.)	Gramps	can	make	guesses	as	to
whether	a	person	is	alive	or	dead.	As	you	can	imagine,	this	can	be	a	time-expensive	function	to	execute,	but	can	be	quite	useful.	The	values	for	the
typical	ages	at	birth,	between	generations,	etc.,	can	be	set	in	the	Menu	->	Edit	->	Preferences	->	Limits	>	Calculation	limits	tab.

The	probably	alive	function	can	check	to	see	if	a	person	was	alive	on	any	specific	date,	or	during	a	time	span.	This	is	used	in	the	Age	on	Date
Gramplet.	Normally,	the	system	will	estimate	birth	and	death	events,	and	see	if	a	date	falls	between	those	two.

However,	there	is	one	special	case:	if	you	are	looking	for	people	probably	alive	 today	and	they	have	a	death	event,	then	they	are	considered	dead	no
matter	what	(even	if	the	event	doesn't	have	a	date).	Therefore,	you	will	get	different	results	if	you	see	who	was	probably	alive	yesterday	(or	last
year)	as	compared	to	who	is	considered	alive	today.	The	reason	for	this	is	that	if	you	have	a	death	event,	you	know	that	a	person	died	in	the	past,
but	you	don't	know	when.	If	you	look	to	see	if	a	person	was	alive	in	the	past	(yesterday	and	prior)	then	you	can	not	say	for	certain	if	they	were	dead
then	without	knowing	a	death	date.

If	you	want	to	know	the	details	of	why	Gramps	has	determined	an	individual	is	alive	or	dead,	you	can	use	the	Calculate	Estimated	Dates	Tool	addon
to	get	an	explanation.	This	will	show	the	estimate	birth	and	death	dates,	and	the	relationship	to	someone	who	has	an	event	date	on	which	these	are
based.

Probably	Alive	Proxy
The	first	tool	is	the	"Probably	Alive"	proxy.	This	is	used	automatically	whenever	you	export	your	data	to	a	format	that	supports	the	ability	to	restrict
details	on	living	people.	The	proxy	wraps	the	database	in	a	layer	that	prevents	access	to	sensitive	details	of	living	people,	such	as	their	given	name,
and	their	events.

Probably	Alive	Filter
Today's	date	is	treated	specially	in	the	instances	of	events	with	no	dates,	and	checking	alive	status	in	the	past.	For	example,	if	a	person	has	a	death
event	with	no	date,	then	we	know	that	the	person	is	dead	as	of	today,	and	always	in	the	future.	However,	for	those	functions	for	which	you	can
check	to	see	if	a	person	was	alive	on	a	date	in	the	past,	we	cannot	say	if	they	were	alive	or	dead	on	that	date.	So,	if	you	have	a	death	event	with	no
date,	and	check	to	see	if	they	were	alive	just	yesterday,	Gramps	will	be	unable	to	determine	the	alive/dead	status.

See:

People	probably	alive	filter
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Calendar	Gramplet
See	Calendar	gramplet.

Editing	Dates
See	Editing	dates.
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Ввод	и	редактирование	данных:	кратко

Пред Содержание След

Этот	раздел	создан	для	того,	чтобы	дать	Вам	знания,	необходимые	для	начала	введения	генеалогической	информации	в	Gramps.	В	нем
разъясняется,	как	вводить	в	базу	данных	информацию	о	людях	и	как	указывать	их	родственные	связи.	Более	подробно	эти	вопросы
раскрываются	в	следующей	главе	Gramps	6.0	Вики	Руководство	-	Ввод	и	редактирование	данных:	подробно.

Введение
Сначала	давайте	назовем	типы	информации,	которые	можно	вводить	в	базу	данных	Gramps:

Персональные	данные	(имена,	адреса,	даты	рождения	и	смерти	и	т.п.)
Информация	об	отношениях	между	людьми	(свадьбы,	разводы,	гражданские	браки	и	т.п.)
Информация	о	родителях	и	детях
Источники,	документирующие	Ваше	генеалогическое	исследование

Комбинации	клавиш

Gramps	можно	управлять	не	только	с	помощью	пунктов	меню	и	его	кнопок,	но	и	с	помощью
большого	количества	комбинаций	клавиш.	Подробнее	см.	append-keybind	.

Теперь	давайте	кратко	рассмотрим	способы	ввода	и	изменения	этих	типов	информации	в	Gramps.

Добавление	или	редактирование	информации	о	человеке
Информацию	о	человеке	можно	добавлять	в	базу	данных	разными	способами.	Некоторые	из	них	мы	опишем	в	этом	разделе.	Самый
простой	способ	для	добавления	информации	о	людях	-	это	использование	вида	 Люди .	Находясь	в	нем	(side-nofilt-fig),	нажмите	кнопку
Добавить 	на	панели	инструментов.	Введите	любую	известную	Вам	информацию	о	человеке	в	диалоге	 Лицо 	(подробнее	см.	edit-pers-
fig).

Для	редактирования	уже	имеющейся	в	базе	данных	информации	о	человеке,	выберите	человека	в	виде	 Люди 	и	нажмите	кнопку
Редактировать	выделенное	лицо .

Другие	способы	добавления	и	редактирования	информации	о	людях	в	виде	Люди

Также	можно	использовать	пункты	меню	Правка	 Добавить... 	и	 Редактировать... .	Либо
можно	нажать	правую	кнопку	мыши	на	человеке	и	выбрать	пункт	контекстного	меню
Добавиить... 	или	 Редактировать... .

Также	можно	добавлять	информацию	о	людях	в	базу	данных	из	вида	 Отношения ,	диалог	 Редактировать	семьи ,	а	также	из	других
мест	в	программе.

Добавление	отношений	(связей)
Есть	два	основных	способа	добавления	отношений	между	людьми	-	с	использованием	вида	 Отношения 	и	с	использованием	диалога
Редактировать	выделенную	семью 	из	вида	 Семьи .	Вид	 Семьи 	обычно	используется	для	построения	всех	отношений	между
людьми	в	пределах	семьи.	Вид	 Отношения 	обычно	используется	для	построения	различных	отношений	одного	конкретного	человека.

Для	добавления	отношения	для	выделенного	человека	переключитесь	в	вид	 Отношения 	(family-fig)	и	выделенный	человек	будет	показан
как	"Активное	лицо".	Рядом	с	надписью	 Семья 	находится	кнопка	 Добавить 	(обычно	представлена	как	кнопка	со	знаком	 + ).
Нажатие	кнопки	 Добавить 	отобразит	диалог	 Редактирование	семьи 	с	"Активным	лицом",	указанным	в	качестве	отца	или	матери.

File:Edit-
RelationshipsView-40.png
Рис.	6.0	Редактирование
семьи

Вопрос:	Был	ли	уже	добавлен	в	базу	данных	человек,	для	которого	будет	создано	новое	отношение	с	"Активным	лицом"?	Если	да,	то
нажмите	на	кнопку	 Выбрать 	рядом	с	этим	человеком	и	выберите	из	списка	нужного	человека.	Если	нет,	то	нажмите	кнопку
Добавить 	для	добавления	нового	человека	в	базу	данных	и	указания	его	отношения	к	"Активному	лицу".
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Фильтр

GRAMPS	по	умолчанию	фильтрует	отображаемый	список	людей,	ограничивая	его	только	теми
людьми,	которые	теоретически	могли	бы	состоять	в	отношениях	с	"Активным	лицом".	GRAMPS
показывает	только	тех	людей,	даты	рождения	и	смерти	которых	лежат	в	интервале	срока	жизни
"Активного	лица".	Можно	добавить	в	этот	список	людей,	нажав	кнопку	 + .	Для	полного	отказа	от
использования	фильтра	поставьте	галочку	в	поле	Показать	всех.

To	search	a	person	on	dialog	selector

Поиск	людей	в	списке	можно	осуществлять	по	первой	букве,	набранной	на	клавиатуре.	(см
Поиск	записей)

См.	6.0	Выделение	человека

Для	редактирования	существующей	связи	между	людьми	в	виде	 Отношения ,	нажмите	на	кнопке	 Редактировать 	рядом	с
соответствующей	семьей	в	списке.	Если	в	списке	указано	более	одной	связи,	то	можно	выбрать	супруга	или	партнера,	нажав
соответствующую	кнопку	 Редактировать 	рядом	с	отношением.

Для	создания	нового	отношения	в	виде	 Семьи 	нажмите	на	кнопку	 Добавить	новую	семью 	на	панели	инструментов	для	открытия
диалога	 Редактирование	семьи .	Здесь	можно	добавить	в	семью	людей.

Добавление	родителей

Рис.	4.3	Выбор	семьи

В	виде	 Отношения 	можно	добавлять	родителей	для	активного	лица	(family-fig).	При	этом	необходимо	обращать	внимание	на	то,	чтобы
не	создавать	копии	существующих	семей.	Для	добавления	активного	лица	в	уже	созданную	семью	нужно	нажать	на	кнопку	 Выбрать .
Если	семья,	включая	родителей,	еще	не	была	создана,	то	нужно	нажать	на	кнопку	 Добавить .

При	нажатии	кнопки	 Выбрать 	будет	открыт	диалог	 Выбор	семьи ,	в	котором	можно	выбрать	ранее	созданную	семью,	после	чего
активное	лицо	будет	добавлено	в	нее	в	качестве	ребенка.

При	нажатии	кнопки	 Добавить 	будет	открыт	диалог	 Редактирование	семьи 	при	этом	активное	лицо	будет	добавлено	в	новую
семью	в	качестве	ребенка.	Родителей	в	семью	можно	добавить	либо	через	создание	новых	людей	в	базе	данных,	либо	выбрав	их	из	числа
уже	имеющихся	в	базе	людей.

Предупреждение

При	создании	семьи	и	указании	в	качестве	ее	родителей	людей,	которые	уже	указаны	в	качестве
родителей	в	другой	семье	в	базе	данных,	GRAMPS	выдаст	сообщение	с	предупреждением.	В
случае	игнорирования	предупреждения	будет	создан	дубликат	имеющейся	семьи.
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Рис.	4.4	Создание	дубликата	семьи

Также	можно	указывать	родителей	человека,	находясь	в	виде	 Семьи .	Если	семья	уже	создана	в	базе	данных,	то	нажмите	на	кнопку
Редактировать 	на	панели	инструментов	и	в	диалоге	 Редактирования	семьи 	добавьте	человека	в	качестве	ребенка.	Если	семья	еще
не	была	создана	в	базе	данных,	то	нажмите	на	кнопку	 Добавить 	для	вызова	диалога	создания	новой	семьи	и	указания	соответствующих
родителей	и	детей.

Добавление	детей

Рис.	4.5	Редактор	родства	ребёнка

Добавление	детей	в	связь	между	людьми	производится	аналогичным	образом.	В	виде	 Отношения 	или	 Семьи 	выберите	существующую
семью	или	создайте	новую.	Детей	можно	добавлять,	нажав	кнопку	 Создать	новое	лицо	и	добавить	ребёнком	в	семью 	или
Добавить	существующее	лицо	ребёнком	в	семью 	рядом	со	списком	детей.

Нажатие	кнопки	 Создать	новое	лицо	и	добавить	ребёнком	в	семью 	отобразит	диалог	 Новое	лицо 	для	добавления	в	базу
нового	человека.	Нажатие	кнопки	 Добавить	существующее	лицо	ребёнком	в	семью 	позволит	выбрать	из	списка	уже	имеющегося
в	базе	данных	человека.	По	умолчанию	ребенок	добавляется	в	семью	с	типом	отношения	"Рождение"	для	обоих	родителей.

Для	изменения	установленного	по	умолчанию	отношения	между	родителем	и	ребенком	"Рождение"	нужно	выделить	ребенка	и	нажать
кнопку	 Редактировать	родственное	лицо .	В	результате	будет	отображен	диалог	 Редактор	родства	ребёнка .

Для	изменения	порядка	детей	в	семье	используйте	клавиши-указатели	на	клавиатуре	или	функцию	drag	and	drop	в	 Редакторе	семьи .	

Добавление	фотографий	и	других	медиа-	объектов
Можно	добавлять	фотографии	и	другие	медиа-	объекты	к	записям	базы	данных	о	людях,	событиях,	источниках	и	местах.	Также	можно
добавлять	фотографии,	относящиеся	не	только	к	одному	человеку,	а	к	группе	лиц	или	событию	(например,	групповые	семейные
фотографии).

Для	добавления	изображения	для	конкретного	человека	нужно	переключиться	на	Вид	 Люди 	(mainwin-fig),	выбрать	нужного	человека	и
затем	нажать	на	кнопку	 Редактировать	выделенное	лицо 	на	панели	инструментов.	В	результате	будет	отображен	диалог	 Лицо
(edit-pers-fig).	Выберите	в	диалоге	вкладку	 Галерея 	и	нажмите	на	кнопку	 + 	для	вызова	диалога	 Выбрать	документ 	из	окна
Редактора	ссылки	на	документ.	Укажите	имя	файла	или	найдите	файл	с	нужным	изображением	и	укажите	название	добавляемого
изображения.

Для	добавления	изображений,	относящихся	к	связям	между	людьми	(например,	изображения	о	браке),	нужно	переключиться	на	Вид
Семья 	(family-fig)	и	дважды	щелкнуть	клавишей	мыши	на	кнопку	в	строке	с	информацией	о	семье.	В	результате	будет	отображен
диалог	 Семья .	Выберите	в	диалоге	вкладку	 Галерея 	и	нажмите	на	кнопку	 + 	для	добавления	изображения.

Для	добавления	изображений,	относящихся	к	источникам	или	местам,	нужно	переключиться	на	Вид	 Источники 	(sources-fig)	или
Места 	(places-fig).	Выберите	нужный	источник	или	место	и	затем	либо	дважды	щелкните	кнопкой	мыши	на	нем,	либо	нажмите	на
кнопку	 Редактировать	выделенное	(источник/место) 	в	панели	инструментов.	Выберите	вкладку	 Галерея 	и	нажмите	на	кнопку
+ 	для	добавления	изображения.

Наконец,	для	добавления	изображений,	не	относящихся	к	конкретному	человеку,	связям,	источникам	или	местам,	нужно	переключиться
на	Вид	 Альбом 	(media-fig).	Затем	нажмите	на	кнопку	 Добавить	новый	документ 	на	панели	инструментов	для	добавления
изображения.	Ранее	добавленные	изображения	также	будут	указаны	в	Виде	 Альбом .

Альтернативный	способ	добавления	изображений	в	галереи

Всегда	можно	добавлять	изображения	в	любые	галереи	с	помощью	перетаскивания.	Можно
перетаскивать	изображения	из	Вида	 Альбом ,	из	любой	галереи,	с	рабочего	стола,	из	менеджера
файлов	или	веб-браузера	и	помещать	их	в	нужную	галерею.

Во	всех	галереях	также	можно	использовать	кнопку	 Редактировать 	для	правки	информации	об	изображении	и	кнопку	 - 	для
удаления	ссылки	на	изображение	из	данной	галереи.
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Удаление	изображения	из	галереи

Удаление	медиа-	объекта	из	галереи	не	удаляет	его	из	базы	данных.	Для	полного	удаления
изображения	из	базы	данных	нужно	удалить	его	в	Виде	 Альбом ,	предварительно	выделив	его	и
затем	нажав	на	кнопку	 - 	на	панели	инструментов.

Редактирование	событий,	источников,	мест	и	хранилищ
Для	добавления	в	базу	данных	события,	источника,	места	или	хранилища	нужно	переключиться	на	соответствующий	Вид:	 События ,	(
events-fig),	 Источники 	(sources-fig),	 Места 	(places-fig)	или	 Хранилища 	(repository-fig).	Затем	нажать	на	кнопку	 Добавить 	на	панели
инструментов	для	добавления	соответствующего	объекта	и	ввести	информацию	в	соответствующий	диалог	 Редактора	событий 	(
Редактор	источников 	,	 Редактор	мест 	или	 Редактор	хранилищ 	).

Для	изменения	информации	о	событиях,	источниках,	местах	и	хранилищах,	уже	имеющихся	в	базе	данных,	нужно	переключиться	в
соответствующий	Вид,	выделить	нужный	объект	и	затем	нажать	на	кнопку	 Редактировать 	на	панели	инструментов.	Либо	можно
дважды	нажать	клавишей	мыши	на	выделенном	объекте	для	его	изменения.

Пред Содержание След

Ввод	и	редактирование	данных:	кратко	-	Редактирование	событий,	источников,	мест	и	хранилищ62

http://www.gramps-project.org/wiki/index.php/File:Gramps-notes.png
http://www.gramps-project.org/wiki/images/b/bc/EventsCategory-EventsListView-example-52.png
http://www.gramps-project.org/wiki/images/6/6c/Sources.png
http://www.gramps-project.org/wiki/images/d/d5/PlacesCategory-PlaceListView-example-52.png
http://www.gramps-project.org/wiki/images/f/f7/RepositoriesCategory-RepositoriesListView-example-52.png
http://www.gramps-project.org/wiki/index.php?title=Ru:Gramps_6.0_%25D0%2592%25D0%25B8%25D0%25BA%25D0%25B8_%25D0%25A0%25D1%2583%25D0%25BA%25D0%25BE%25D0%25B2%25D0%25BE%25D0%25B4%25D1%2581%25D1%2582%25D0%25B2%25D0%25BE_-_%25D0%25A3%25D0%25BF%25D1%2580%25D0%25B0%25D0%25B2%25D0%25BB%25D0%25B5%25D0%25BD%25D0%25B8%25D0%25B5_%25D0%25A1%25D0%25B5%25D0%25BC%25D0%25B5%25D0%25B9%25D0%25BD%25D1%258B%25D0%25BC%25D0%25B8_%25D0%25B4%25D0%25B5%25D1%2580%25D0%25B5%25D0%25B2%25D1%258C%25D1%258F%25D0%25BC%25D0%25B8&action=edit&redlink=1


Ввод	и	редактирование	данных:	подробно

Пред Содержание След

В	предыдущем	разделе	был	дан	краткий	обзор	порядка	ввода	и	редактирования	информации	в	Gramps.	В	этом	разделе	данный	обзор
будет	значительно	расширен.

Как	мы	видели	ранее,	в	Gramps	есть	несколько	Видов.	В	каждом	из	них	можно	вводить	и	редактировать	информацию.	На	самом	деле,
часто	можно	получить	доступ	к	одной	и	той	же	информации	из	различных	Видов.

В	Gramps	ввод	и	редактирование	информации	осуществляется	с	помощью	так	называемых	"диалогов".	Поскольку	мы	часто	используем
этот	термин,	необходимо	определить	то,	что	мы	под	ним	подразумеваем:

Диалог	-	это	всплывающее	окно,	которое	предоставляет	одну	или	несколько	форм	для	ввода	и	редактирования	информации
определенного	типа.	Примеры	диалогов	в	Gramps:	диалог	 Редактирование	лица ,	диалог	 Редактор	семьи 	и	многие	другие.

Диалоги	часто	содержат	ряд	вкладок,	с	помощью	которых	информация	объединяется	в	подкатегории.	Например,	диалог	"Редактирование
лица"	содержит	вкладки	для	таких	подкатегорий,	как	события,	атрибуты,	адреса,	заметки	и	др.

Кнопки	добавления,	удаления	и	редактирования

В	большинстве	случаев	Gramps	использует	знак	 + 	для	обозначения	кнопки	 Добавить ,	знак	 -
для	обозначения	кнопки	 Удалить 	и	изображение	ручки	на	листе	бумаги	для	обозначения	кнопки
Редактирование .	Мы	также	в	этом	руководстве	будем	использовать	эти	знаки.

Давайте	продолжим	изучение	ввода	и	редактирования	данных	различных	типов:

1.	 Часть	1:	Добавление	людей,	дат,	семей	и	отношений	в	Gramps
2.	 Часть	2:	Остальные	ключевые	объекты	Gramps:	события,	документы,	источники	и	цитаты,	места,	хранилища	и	заметки
3.	 Часть	3:	Как	работать	с	именами,	атрибутами	и	адресами.	Способы	объединения	информации.

Пред Содержание След
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Ввод	и	редактирование	данных:	подробно	-	часть	1

Пред Содержание След

В	предыдущем	разделе	был	дан	краткий	обзор	порядка	ввода	и	редактирования	информации	в	GRAMPS.	В	этом	разделе	данный	обзор
будет	значительно	расширен.

Как	мы	видели	ранее,	в	GRAMPS	есть	несколько	Видов.	В	каждом	из	них	можно	вводить	и	редактировать	информацию.	На	самом	деле,
часто	можно	получить	доступ	к	одной	и	той	же	информации	из	различных	Видов.

В	GRAMPS	ввод	и	редактирование	информации	осуществляется	с	помощью	так	называемых	"диалогов".	Поскольку	мы	часто	используем
этот	термин,	необходимо	определить	то,	что	мы	под	ним	подразумеваем:

Диалог	-	это	всплывающее	окно,	которое	предоставляет	одну	или	несколько	форм	для	ввода	и	редактирования	информации
определенного	типа.	Примеры	диалогов	в	GRAMPS:	 Редактор	лиц ,	 Редактор	семьи 	и	многие	другие.

Диалоги	часто	содержат	ряд	вкладок,	с	помощью	которых	информация	объединяется	в	подкатегории.	Например,	"Редактор	лиц"
содержит	вкладки	для	таких	подкатегорий,	как	события,	атрибуты,	адреса,	заметки	и	др.

Кнопки	добавления,	удаления	и	редактирования

В	большинстве	случаев	GRAMPS	использует	знак	 + 	для	обозначения	кнопки	 Добавить ,	знак
- 	для	обозначения	кнопки	 Удалить 	и	изображение	ручки	на	листе	бумаги	для	обозначения
кнопки	 Редактирование .	Мы	также	в	этом	руководстве	будем	использовать	эти	знаки.

Изменение	информации	о	людях
Информация	о	людях	вводится	и	изменяется	в	 Редакторе	лиц .	Этот	диалог	может	быть	вызван	из	различных	Видов	следующими
способами:

Из	видов	категории	Люди:

Дважды	щелкнуть	кнопкой	мыши	на	человеке,	информацию	о	котором	нужно	изменить
Выбрать	нужного	человека	в	списке	одиночным	нажатием	кнопки	мыши	и	затем	нажать	кнопку	 Редактировать
выделенное	лицо 	на	панели	инструментов.
Выбрать	нужного	человека	в	списке	и	затем	нажать	клавишу	Enter	на	клавиатуре.
Выбрать	пункт	"Редактировать..."	из	меню	"Правка"	GRAMPS
Выбрать	пункт	"Редактировать..."	из	контекстного	меню,	которое	вызывается	нажатием	правой	кнопки	мыши	на	строке	с
нужным	человеком.

Из	видов	категории	Отношения:	Для	изменения	информации	об	Активном	лице	нужно	нажать	кнопку	"Редактировать"	рядом	с	его
именем.

Из	видов	категории	Графики:	Дважды	щёлкнуть	левой	кнопкой	мыши	на	прямоугольнике	с	именем	человека,	информацию	о
котором	нужно	изменить.

Во	всех	вышеназванных	случаях	появится	диалог	 Редактора	лиц .

Диалог	редактора	лиц

Рис.	9.1.1	Диалог	создания	нового	лица
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Рис.	9.1.2	Диалог	 Редактора	лиц 	-	пример
отображения	данных	о	человеке

Редактор	лиц 	это	диалог,	где	Вы	вводите	информацию	о	новых	людях	или	редактируете	существующих	лиц.

Верхняя	часть	окна	диалога	состоит	из	двух	частей:	основная	информация	о	человеке	-	 Предпочитаемое	имя 	-	и	секция	 Общее 	с
кнопкой	установки	приватного	статуса	(для	пометки	данной	записи	о	человеке	как	приватной),	полем	для	выбора	пола	человека,	ID-
номером	для	данной	записи	и	с	полем	метки	для	обозначения	статуса	записи	(Завершено,	Задачи	и	т.д.),	изменение	которого	приведет	к
изменению	цвета	строки	в	Виде	"Люди".

В	контекстном	меню	(по	правой	кнопке	мыши)	на	пустом	месте	верней	части	окна,	около	поля	"Предпочитаемое	имя"	доступно	три
пункта:

Сделать	активным	лицом
Сделать	базовым	лицом
Быстрый	просмотр 	доступные	отчёты.

Ниже	расположены	несколько	вкладок,	содержащие	разнообразную	информацию	о	данном	человеке.	Щелчок	по	вкладке	откроет	её	для
просмотра	и	изменения	содержимого.

Нажатие	на	кнопке	 ОК 	в	нижней	части	окна	применит	все	сделанные	во	всех	вкладках	изменения	и	закроет	окно	диалога.	Нажатие	на
кнопке	 Отменить 	закроет	окно	без	применения	сделанных	изменений.

Рис.	9.1.3	"Сохранить	изменения?"	-	предупреждение

При	нажатии	кнопки	 Отменить ,	если	были	внесены	какие-либо	изменения	во	вкладках,	появится	окно	со	знаком	предупреждения	с
предложением	выбрать	одно	из	следующих	решений:

закрыть	диалог	без	сохранения	изменений
отказаться	от	отмены 	сохранения	внесённых	изменений
сохранить	внесённые	изменения.

также	можно	установить	флажок	Больше	не	спрашивать.	Или	отключить	предупреждение	 Не	показывать	предупреждение	при
отмене	с	изменёнными	данными 	в	настройках	Правка	>	Настройки...	>	Предупреждения.

Примечание

Нажатие	кнопки	 ОК 	немедленно	сохраняет	в	базе	данных	сделанные	изменения.	Отдельная
операция	по	сохранению	внесённых	изменений	не	требуется.

Предпочитаемое	имя
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Рис.	9.1.4	Редактор	лиц	-	секция	"Предпочитаемое	имя"
выделена	жёлтым

"Предпочитаемое	имя"	или	"имя	по	умолчанию"	-	это	то	имя,	которое	GRAMPS	будет	использовать	в	качестве	' имени'	человека.	В
настройках	GRAMPS	можно	указать	способ	отображения	имени	и	в	большинстве	случаев	GRAMPS	использует	предпочитаемое	имя.

Дополнительные	имена	отображаются	только	в	детальных	отчетах	(текстовых	и	при	создании	веб-сайта).	В	то	же	время,	операция	поиска
по	имени	выполняется	по	всем	имеющимся	для	данного	человека	именам	-	не	только	по	его	предпочитаемому	имени.

Секция	предпочитаемого	имени	содержит	информацию	об	имени	человека,	которая	обычно	указывается	при	его	добавлении	в	базу
данных.	Здесь	отображается	не	вся	возможная	информация	об	имени	человека,	а	лишь	наиболее	часто	используемые	поля.	Чтобы	ввести
еще	одну	фамилию,	нажмите	кнопку	 	 Добавить 	или	используйте	комбинацию	клавиш.	Для	отображения	всех	доступных	полей	для
ввода	информации	об	имени,	нужно	нажать	кнопку	 	 редактировать 	справа	от	секции	 Предпочитаемое	имя 	или	использовать
комбинацию	клавиш.	Будет	открыт	Редактор	имён.

В	 Редакторе	лиц 	доступны	для	изменения	следующие	поля	имени	человека:

Тип 	имени	(фамилия	при	рождении,	фамилия	в	браке,	неизвестно).	Также	можно	ввести	свой	тип,	например	"прозвище".	В
качестве	предпочитаемого	имени	рекомендуется	указывать	имя	человека,	указанное	в	его	документах,	а	все	другие	его	имена
хранить	во	вкладке	 Имена 	в	 Редакторе	лиц .
Имя 	-	имя	человека.
Суффикс 	-	необязательный	суффикс	имени	(например,	Мл.	или	III).
Фамилия 	-	часть	полного	имени	человека,	указывающая	на	семью,	к	которой	он	принадлежит.
Приставка 	-	необязательная	приставка	к	фамилии,	не	используемая	при	сортировке	по	фамилиям	(например,	Де-	или	Фон-).
Происхождение ,	происхождение	фамилии	указывает	на	способ	образования	фамилии.	Эта	информация	может	быть	полезна	в
генеалогических	исследованиях.
Титул 	-	титул,	используемый	для	обращения	к	человеку	(например,	Др.	или	Ув.).
Прозвище 	-	это	описательное	имя,	даваемое	человеку	вместо	или	в	дополнение	к	его	официальному	имени.	Если	прозвище
является	полноценным	именим,	то	лучше	использовать	тип	Также	известен	как	вместо	этого	поля.
Имя	в	быту 	-	официальная	часть	имени	человека,	которая	обычно,	в	быту	используется	для	обращения	к	нему.	То	есть	имя
человека	может	состоять	из	3	имен	(например,	Жан	Баптист	Жюль),	из	которых	только	одно	используется	(например,	Баптист).	В
Германии	и	некоторых	других	местностях	принято	выделять	бытовое	имя	человека	среди	других	его	имен,	см.	также	тут.	Поле	"Имя
в	быту"	также	можно	использовать	для	хранения	информации	о	прозвищах	человека	или	изменениях	в	его	имени	(например,
"Кристи"	для	"Кристина"),	но	предназначено	оно	не	для	этого:	имя	в	быту	-	корректное,	узаконенное	имя	человека.	Для	хранения
прозвищ	или	сокращений	имен	необходимо	создавать	альтернативные	имена	с	указанием	другого	типа	имени.

В	редакторе	имён	доступно	поле	 Прозвище	семьи 	-	это	неофициальное	имя,	даваемое	семье	для	отличения	её	носителей	от
однофамильцев	из	других	семей.	В	английском	языке	прозвище	семьи	часто	называется	также	"Farm	name"	и	зависит	от	места
проживания.

Поля	 Фамилия ,	 Происхождение 	и	 Тип 	обладают	функцией	"автодополнения":	по	мере	ввода	информации	под	ними	отображается
список,	содержащий	ранее	сохраненные	в	базе	данных	значения	для	данного	поля,	которые	частично	совпадают	с	введенной
информацией.	С	помощью	этой	функции	упрощается	ввод	информации	в	указанные	поля	за	счёт	того,	что	можно	выбрать	из	списка
подходящее	значение	без	необходимости	вводить	его	вручную.	Выбор	значения	в	списке	осуществляется	с	помощью	мыши	или	клавиш
со	стрелками	и	Enter.

Несколько	фамилий

Рис.	9.1.5	Секция	"Несколько	фамилий"	выделена	синим

При	редактировании	лиц	используйте	кнопку	 +	Добавить ,	чтобы	добавить	новую	строку	в	таблицу	секции	 Несколько	фамилий 	и
ввести	информацию	о	новой	фамилии.

Возможность	вводить	несколько	фамилий	может	быть	использована	для	составных	фамилий	или	добавления	отчества.	Например	для
скандинавского	имени	‘Сивер	Ериксен	Скотерд’,	где	полное	имя	состоит	из	имени	(Сивер),	ссылки	на	отца	(Ериксен	или	сын	Ерика)	и
фамилии	(Скотерд).	В	этом	случае	Вы	можете	добавить	'Ериксен'	с	происхождением	"Отчество"	и	добавить	фамилию	'Скотерд'	с
происхождением	"Расположение".

Если	Вы	не	добавили	информацию	в	эту	секцию,	при	следующем	запуске	Редактора	лиц	она	будет	скрыта.	Также	пустые	строки	не	будут
сохранены.

Основная	секция

Поле	 Пол 	позволяет	указать	пол	человека	:
мужской
женский
неизвестно	(по	умолчанию) 	.

Поле	 ID 	отображает	присвоенный	человеку	в	базе	данных	уникальный	номер	-	GRAMPS	ID,	который	помогает	различать	в	базе
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данных	людей	с	одинаковыми	именами.	В	поле	ID	можно	вручную	задавать	любое	уникальное	значение.	Если	этого	не	делать,	то
GRAMPS	автоматически	вставит	в	поле	ID	новое	значение.

Поле	 Метки: 	служит	для	отображения	прикреплённых	меток,	что	позволяет	увидеть	краткую	информации	о	состоянии
генеалогического	исследования	о	данном	человеке.

Кнопка	 Редактировать	список	меток 	откроет	диалог	выбора	меток,	в	котором	можно	выбрать	существующие	метки.

Кнопка	 Приватность 	позволяет	помечать	запись	о	данном	человеке	как	общедоступную	либо	приватную.

Предпочитаемое	изображение

Рис.	9.1.6	Область	"Изображение"	(выделена	красным)	в
диалоге	редактора	лиц

Редактор	лиц	также	содержит	в	правом	верхнем	углу	область	для	отображения	фотографии	данного	человека,	в	которой	отображается
первое	имеющееся	в	его	 Галерее 	изображение	(если,	конечно,	оно	в	ней	существует).

Информация	во	вкладках

Примечание

Если	имя	вкладки	выделено	жирным	шрифтом,	это	означает	наличие	данных	в	ней.

Вкладки	отражают	информацию	о	следующих	видах	персональной	информации:

События

Рис.	9.1.7	Вкладка	"События"	в	редакторе	лиц

Вкладка	 События 	позволяет	просматривать	и	редактировать	информацию	о	любых	событиях,	относящихся	к	человеку.	В	нижней	части
окна	вкладки	перечисляются	все	такие	события,	хранимые	в	базе	данных	и	содержит	следующие	столбцы:	Тип,	Описание,	Дата,	Место,
Главные	участники,	Конфиденциальность(значок	замка),	Роль,	ID,	Возраст.	Верхняя	часть	окна	вкладки	отображает	детальную
информацию	о	выбранном	в	нижней	части	окна	событии	(если	таковое	существует).	С	помощью	кнопок	 + 	,	 Редактировать 	и	 -
осуществляется	добавление,	изменение	и	удаление	записей	о	событиях	из	базы	данных.	Обратите	внимание,	что	кнопки
Редактировать 	и	 - 	доступны	только	тогда,	когда	в	списке	событий	выбрано	какое-либо	событие.	

Кнопка	 Участвует	в	существующем	событии 	открывает	диалог	 Выбор	события ,	который	позволяет	выбрать	существующее
событие	и	изменить	его	в	 Редакторе	ссылок	на	событие .

Когда	Вы	добавляете	новое	событие	или	редактируете	существующее,	открывается	 Редактор	ссылок	на	событие ,	как	с	ним	работать
описано	в	разделе	Редактирование	ссылок	на	события.	

Выбор	события

Рис.	9.1.8	Диалог	выбора	события

Диалог	 Выбор	события 	позволяет	сослаться	на	существующее	событие	и	открыть	его	в	 Редактире	ссылок	на	события .

Показаны	следующие	колонки:	Тип(сортировка	списка	по	умолчанию),	Главные	участники,	Дата,	Место,	Описание,	ID,	Последнее
изменение.

Чтобы	отфильтровать	список	используйте	кнопку	 Найти ,	для	уточнения	выберите	один	из	параметров	в	выпадающем	списке:

Тип	содержит	(по	умолчанию)
Тип	не	содержит
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Главные	участники	содержит
Главные	участники	не	содержит
Дата	содержит
Дата	не	содержит
Место	содержит
Место	не	содержит
Описание	содержит
Описание	не	содержит
ID	содержит
ID	не	содержит
Последние	изменения	содержит
Последние	изменения	не	содержит

Имена

Рис.	9.1.9	Вкладка	"Имена"	в	редакторе	лиц

Вкладка	 Имена 	позволяет	просматривать	и	редактировать	любые	возможные	дополнительные	имена	людей.	В	нижней	части	окна
перечислены	все	дополнительные	имена	для	человека,	сохраненные	в	базе	данных.	В	верхней	части	окна	отображается	детальная
информация	для	выбранного	дополнительного	имени.	С	помощью	кнопок	 + 	,	 Редактировать 	и	 - 	осуществляется	добавление,
изменение	и	удаление	дополнительных	имён	из	базы	данных.	Обратите	внимание,	что	кнопки	 Редактировать 	и	 - 	доступны
только	тогда,	когда	в	списке	дополнительных	имён	выбрано	какое-либо	имя.

Для	добавления	или	изменения	существующего	имени	используется	 Редактор	имён ,	подробнее	читайте	в	разделе.

Цитаты

Fig.	9.1.10	Вкладка	"Цитаты"	в	редакторе	лиц

Во	вкладке	 Цитаты 	можно	управлять	источниками	и	цитатами	о	собираемой	Выми	информации.

Это	должны	быть	основные	источники,	которые	не	относятся	к	конкретным	событиям,	но	тем	не	менее	несут	информацию	о
человеке.	Например,	если	тётя	Марта	в	своих	мемуарах	упоминает	её	правнука	Пола,	то	исследователь	может	предположить,	что
Пол	существует	и	указать	мемуары	Марты	как	источник	подтверждающий	предположения.

Подсказка

Источники	описывающие	события	лучше	указывать	в	соответствующем	событии	(на	вкладке
События ),	а	не	как	источник	для	человека.	На	вкладке	 Цитаты 	лучше	всего	указывать
источники	не	относящиеся	к	другим	данным.

В	центральной	части	расположен	список	ссылок	на	источники,	которые	относятся	к	этому	человеку.	Кнопки	 + 	,	 Редактировать
и	 - 	позволяют	добавить,	изменить	и	удалить	ссылку	на	источник.	Обратите	внимание,	что	кнопки	 Редактировать 	и	 -
активны	только,	когда	выбран	элемент	в	списке.

В	редакторе	можно	изменить	цитату	(только	для	этого	человека),	а	также	для	всех	объектов,	подробнее	смотрите	в	разделе
Редактирование	цитат.

Атрибуты

Рис.	9.1.11	Вкладка	"Атрибуты"	в	редакторе	лиц

Вкладка	 Атрибуты 	позволяет	просматривать	и	присваивать	атрибуты	людям.	Вам	предоставляется	полная	свобода	в	создании	и
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использовании	атрибутов.	Например,	атрибуты	могут	быть	созданы	для	описания	физических	характеристик	человека	или	его
индивидуальных	особенностей.

Обратите	внимание,	что	каждый	атрибут	в	списке	атрибутов	состоит	из	двух	частей:	собственно	Атрибут	и	его	Значение.	Эти	пары
Атрибут-Значение	помогут	организовать	и	систематизировать	Ваши	исследования.	Например,	если	Вы	создали	Атрибут	"Цвет
волос"	для	человека,	"Цвет	волос"	появится	в	списке	выбора	атрибутов	у	всех	остальных	людей.	Значение	атрибута	"Цвет	волос"
может	быть	"рыжий"	для	человека	А	и	"каштановый"	для	человека	Б.	Похожим	образом	Вы	можете	создать	Атрибут	"Щедрость"	и
использовать	Значение	"Неслыханная"	для	описания	щедрости	определенного	человека.

Нижная	часть	диалога	содержит	список	Атрибутов,	которым	присвоены	Значения	для	данного	человека.	Кнопки	 + ,
Редактировать 	и	 - 	позволяют	добавлять,	изменять	и	удалять	атрибуты	из	базы	данных.	Обратите	внимание,	кнопки
Редактировать 	и	 - 	доступны	только	если	Атрибут	выбран	в	списке.

Для	изменения	атрибута	используется	Редактор	Атрибутов.

GEDCOM

Некоторые	заранее	созданные	атрибуты	ссылаются	на	значения	из	стандарта	GEDCOM.
Подробнее	в	разделе

Адреса

Рис.	9.1.12	Вкладка	"Адреса"	в	редакторе	лиц

Вкладка	 Адреса 	позволяет	просматривать	и	записывать	различные	почтовые	адреса	людей.	Мы	рекомендуем	использовать
события	"проживание"	для	хранения	информации	о	месте	жительства.	Вкладка	адреса	оставлена,	в	основном,	для	совместимости	с
GEDCOM	стандартом,	где	смысл	хранения	адреса	-	написание	писем.

Нижняя	часть	окна	содержит	список	всех	адресов	хранящихся	в	базе	данных.	Верхняя	часть	отображает	детали	о	выбранном	адресе
(если	таковые	имеются).	Кнопки	 + 	,	 Редактировать 	и	 - 	позволяют	соответственно	добавлять,	изменять	и	удалять	записи
адресов	из	базы	данных.	Следует	отметить,	что	кнопки	 Редактировать 	и	 - 	будут	доступны	только	когда	выбран	хотя	бы	один
адрес	из	списка.

Для	изменения	адреса	используется	Редактор	Адресов.

Некоторые	отчёты	позволяют	ограничить	информацию	о	живых	людях.	В	частности,	могут	исключать	их	адреса.

Заметки

Рис.	9.1.13	Вкладка	"Заметки"	в	редакторе	лиц

Во	вкладке	 Заметки 	Вы	можете	делать	различные	записи	о	личностях,	которые	не	подходят	к	другим	категориям,	или	просто
текстовые	сообщения,	которые	Вы	хотите	добавить	к	семейному	древу.	Вы	можете	ссылаться	на	заметки	между	различными
записями	в	GRAMPS.	Панель	управления	содержит	обычный	набор	кнопок:	 Создать ,	 Добавить	существующую	заметку ,
Редактировать ,	 Удалить ,	а	также	кнопки	управления	сортировкой.

Для	редактирования	заметок	используется	Редактор	заметок.

Выбор	заметки

Рис.	9.1.14	Выбор	заметки

Выбор	заметок 	позволяет	создать	ссылку	на	существующую	заметку.

Показаны	следующие	колонки:	Предпросмотр	(сортировка	по	умолчанию),	ID,	Тип,	Метки,	Последние	изменение.

Используйте	кнопку	 Найти 	для	фильтрации	списка,	также	необходимо	выбрать	параметр	из	выпадающего	списка:
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

Предпросмотр	содержит	(по	умолчанию)
Предпросмотр	не	содержит
ID	содержит
ID	не	содержит
Тип	содержит
Тип	не	содержит
Метки	содержит
Метки	не	содержит
Последние	изменения	содержит
Последние	изменения	не	содержит

Галерея

Подсказка

Первое	изображение	из	 Галереи 	будет	также	отображаться	на	вкладке	 Подробности 	в	виде
"Люди".

Рис.	9.1.15	Вкладка	"Галерея"	в	редакторе	лиц

Вкладка	 Галерея 	позволяет	просматривать	и	добавлять	фотографии,	видео	и	другие	медиа-объекты	относящиеся	к	человеку.	В
центе	расположен	список	этих	объектов.	Для	изображений	будут	показаны	миниатюры,	а	для	других	объектов,	таких	как	аудио
записи,	видео	файлы	и	т.д.	будет	показана	иконка	соответствующая	этому	типу	файла.

Доступны	следующие	кнопки:

+ 	-	позволяет	добавить	новый	объект	с	помощью	Редактора	ссылок	медиа-объектов.
Выбрать 	-	открывает	диалог	 Выбора	медиа-объекта 	для	создания	ссылки	на	этот	документ.
Редактировать 	-	позволяет	изменить	выбранный	документ	в	Редакторе	ссылок	медиа-объектов.	Эта	кнопка	становится	доступна
после	выбора	объекта	в	списке.
- 	-	удаляет	выбранный	документ	из	галереи.	Эта	кнопка	становится	доступна	после	выбора	объекта	в	списке.

Для	изменения	основного	изображения,	выберите	нужное	изображение	и	перетащите	его	в	начало	списка.

После	выбора	документа	доступно	контекстное	меню	(правая	кнопка	мыши)	со	следующими	пунктами:

Посмотреть
Открыть	папку	с	этим	документом
Сделать	текущим	документом
Добавить
Добавить	из	существующих
Правка
Удалить

Примечание

Удаление	объекта	из	галереи	человека	не	удалит	его	из	базы	данных.	Будет	удалена	только	ссылка
на	объект	для	этого	человека.

Выбор	документа

Ввод	и	редактирование	данных:	подробно	-	часть	1	-	Изменение	информации	о	людях 70

http://www.gramps-project.org/wiki/index.php/File:Tango-Dialog-information.png
http://www.gramps-project.org/wiki/index.php/File:EditPerson-Gallery-tab-example-52.png
http://www.gramps-project.org/wiki/index.php/File:Gramps-notes.png
http://www.gramps-project.org/wiki/index.php/File:Gramps-notes.png


Рис.	9.1.16	Диалог	выбора	документа

Диалог	 Выбора	документа 	(медиа-объекта)	позволяет	создать	ссылки	на	существующие	документы,	после	выбора	изображения	оно
будет	открыто	в	 Редакторе	ссылок	на	медиа-объекты .

При	выборе	документа	в	списке	в	верхней	части	окна	будет	показана	миниатюра	(если	она	доступна).

Показаны	следующие	колонки:	Название	(сортировка	оп	умолчанию),	ID,	Тип,	Последнее	изменение.

Кнопка	 Найти 	позволяет	отфильтровать	список	по	заданному	параметру	из	выпадающего	меню:

Название	содержит	(по	умолчанию)
Название	не	содержит
ID	содержит
ID	не	содержит
Тип	содержит
Тип	не	содержит
Последние	изменение	содержит
Последние	изменение	не	содержит

Смотрите	также	Выбор	медиа-объекта	

Интернет

Рис.	9.1.17	Вкладка	"Интернет"	в	редакторе	лиц

На	вкладке	 Интернет 	отображаются	адреса	относящиеся	к	человеку.	Описание	интернет	адресов,	типы	(при	необходимости),
например:	http://gramps-project.org,	E-mail,	Страничка,	...

В	нижней	части	расположен	список	интернет	адресов	с	описаниями.	Сверху	расположены	кнопки	управления.	Кнопки	 +
Создать ,	 Редактировать 	открывают	 Редактор	интернет	адресов ,	кнопка	 - 	удаляет	выбранный	интернет	адрес.	Кнопка
"Перейти"	откроет	ссылку	в	Вашем	веб-браузере.

Кнопки	 Редактировать 	и	 -	Удалить 	становятся	доступными	при	выборе	адреса	в	списке.	

Редактор	интернет	адресов

Рис.	9.1.18	Редактор	интернет	адресов

Редактор	интернет	адресов 	позволяет	добавить	новый	адрес	или	изменить	существующий.

Тип: 	Тип	интернет	адреса:
Прочее	(по	умолчанию)
Статья	в	интернете
Страница	в	сети
Электронная	почта
FTP
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Открытая/приватная	запись 	переключение	конфиденциальности	записи.
Веб	адрес: 	Интернет	адрес	на	который	требуется	перейти,	например:	https://gramps-project.org

Перейти 	открывает	адрес	в	интернет	браузере	по	умолчанию
Описание: 	текстовое	описание	адреса.

Смотрите	также

Редактор	ссылок
Note	Link	Report

Связи

Рис.	9.1.19	Вкладка	"Связи"	в	редакторе	лиц

Вкладка	 Связи 	позволяет	просматривать	и	редактировать	информацию	о	связях	между	людьми.	Связи	могут	включать	Крёстных,
друзей	семьи,	коллег	по	работе	или	любые	другие	связи	которые	Вы	желаете	записать.	Если	ближайшее	отношение	'Крёстный',	тогда	это
будет	означать,	что	крёстным	отцом	человека	(редактируемого)	будет	человек	указанный	на	вкладке	"Связи".

В	стандарте	GEDCOM	о	Связях	говорится,	что	"отношение	или	связь	человека	-	это	лицо,	на	которое	указывают."	Вы	можете	добавить
взаимную	связь	на	вкладке	"Связи"	другого	человека.

В	примере	древа	example.gramps	Lewis	Garner's	указан	Крёстным	отцом	для	Anderson	Garner.	Используйте	события	для	указания	связей
(отношений)	содержащие	временные	рамками.	На	события	можно	ссылаться	и	указывать	роль	человека	в	событии.

Редактор	ссылки	на	лицо

Рис.	9.1.20	Редактор	ссылки	на	лицо

Нажмите	кнопку	 Выбор	лица,	которое	имеет	связь	с	редактируемым	лицом. ,	чтобы	открыть	диалог	 Выбора	человека .

Выбор	человека

Рис.	9.1.21	Диалог	выбора	человека
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СПД

Fig.	9.1.22	"LDS"	tab	from	"Edit	Person"	-	dialog	-	example

The	 LDS 	(Latter	Days	Saints)	tab	lets	you	view	and	edit	information	about	LDS	ordinances	of	the	person.	This	information	is	inherited	from
GEDCOM	specification.

These	are	LDS	Baptism,	Endowment,	and	Sealed	to	Parents	ordinances,	as	labeled	inside	the	tab.	Each	ordinance	is	described	by	its	date,	LDS
temple,	and	Place	where	it	happened.

An	additional	pop-up	menu,	"Parents,"	is	available	for	the	Sealed	to	Parents	ordinance.	Each	ordinance	can	be	further	described	through	the
selections	available	in	the	Status	pop-up	menu.	It	can	also	be	include	notes	and	references	to	sources	through	the	corresponding
Sources... 	and	 Note 	buttons.

See:	Family	Editor	dialog>Tab>LDS

Редактор	процедур	СПД

Fig.	9.1.23	"LDS	Ordinance	Editor"	-	dialog	-	default

Use	the	 Create	and	add	a	new	LDS	ordinance	or	 Edit	the	selected	LDS	ordinance 	buttons	to	bring	up	the	 LDS	Ordinance
Editor 	dialog	where	you	can	add	or	edit	existing	LDS	ordinances	of	the	person.

See	Ordinance	(Latter	Day	Saints)	on	Wikipedia,	the	free	encyclopedia

Ссылки

Рис.	9.1.24	Вкладка	"Ссылки"	в	редакторе	лиц
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Вкладка	 Ссылки

Редактирование	информации	об	отношениях
Информация	об	отношениях	вводится	и	редактируется	в	 Редакторе	семьи .

Этот	диалог	можно	вызвать	разными	способами:

Из	категории	Отношения:	нажмите	кнопку	 Редактировать 	на	семье	которую	хотите	редактировать.

Из	категории	Семьи:	выберите	семью	из	списка	и	нажмите	кнопку	 Редактировать 	на	панели	инструментов	или	используйте
двойной	щелчок	мыши	по	семье.

Из	категории	Графики:	наведите	указатель	мыши	на	линию	соединяющую	супругов,	щёлкните	правой	кнопкой	и	выберите
Редактировать 	в	контекстном	меню	или	используйте	двойной	щелчок	по	линии.

Любой	из	этих	способов	откроет	 Редактор	семьи :

Редактор	семьи

Рис.	9.1.25	Диалог	 Редактора	семьи

В	верхней	части	окна	показаны	имена	людей	редактируемого	отношения,	также	информация	об	их	рождении	и	смерти.

Отец/родитель1
Мать/родитель2

Отчёты	Быстрого	просмотра	доступны	из	контекстного	меню	(правая	кнопка	мыши)	на	пустой	области	в	верхней	части	окна.

В	секции	 Данные	об	отношении 	расположено	три	поля	и	вкладки	с	различной	информацией	об	отношении.	Щёлкните	по	любой
вкладке	для	просмотра	или	изменения	информации	в	ней.	В	нижней	части	расположены	кнопки	 OK 	и	 Отменить .	Нажатие	кнопки	 OK
в	любое	время,	сохранит	все	изменения,	сделанные	во	всех	вкладках	и	закроет	окно.	Нажатие	 Отменить закрое	окно	без	сохранения
изменений.	Если	были	внесены	изменения	на	любой	из	вкладок,	появится	окно	с	предупреждением	и	предложит	сохранить	изменения,
отменить	изменения	или	вернуться	в	редактор.

Секция	 Данные	об	отношении 	содержит	основное	описание	отношения.	В	поле	 ID 	указывается	номер	ID	под	которым	отношение
записано	в	базу	данных,	оставьте	это	поле	пустым,	чтобы	Gramps	добавил	его	сам.	Вы	можете	выбрать	из	выпадающего	списка	 Тип
семейных	отношений,	таких	как:	Гражданский	союз,	Супружество,	Прочее	(по	умолчанию),	Вне	брака	и	др.

Смотрите	также:

Как	добавить	данные	о	разводе?

Метки: 	отображает	метки	присвоенные	семье	при	исследовании.	Вы	можете	добавить	дополнительные	метки	с	помощью	кнопки
Редактировать	список	меток .
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Примечание

Кнопка	 OK 	немедленно	сохранит	изменения	в	базу	данных.	Gramps	не	имеет	отдельной	функции
сохранения.

Выбор	отца

Рис.	9.1.26	Выбор	отца

Диалог	 Выбора	отца 	позволяет	выбрать	отца	из	существующих	людей	в	базе	данных.	

Выбор	матери

Рис.	9.1.27	Выбор	матери

Диалог	 Выбора	матери 	позволяет	выбрать	мать	из	существующих	людей	в	базе	данных.	

Вкладки	редактора	семьи

Совет

Если	имя	вкладки	выделено	жирным,	это	означает	наличие	данных	в	ней.	Если	нет	-	она	пуста.

Вкладки	содержат	следующие	категории	информации	об	отношении:

Дети

Рис.	9.1.28	Вкладка	"Дети"	в	редакторе	семьи

Вкладка	 Дети 	позволяет	просматривать	и	редактировать	список	детей,	являющихся	частью	этих	отношений.	Кнопка	 + 	позволяет
добавить	нового	человека	в	базу	данных	и	сделать	его	ребёнком	этой	семьи.	Кнопка	 Выбрать 	позволяет	выбрать	существующего
человека	и	сделать	его	ребёнком	этой	семьи.	Кнопка	 Редактировать 	откроет	 Редактор	родства	ребёнка 	в	котором	можно

Ввод	и	редактирование	данных:	подробно	-	часть	1	-	Редактирование	информации	об	отношениях75

http://www.gramps-project.org/wiki/index.php/File:Gramps-notes.png
http://www.gramps-project.org/wiki/index.php/File:Gramps-notes.png
http://www.gramps-project.org/wiki/index.php/File:SelectFather-selector-example-50.png
http://www.gramps-project.org/wiki/index.php/File:Gramps-notes.png
http://www.gramps-project.org/wiki/index.php/File:SelectMother-selector-example-50.png
http://www.gramps-project.org/wiki/index.php/File:Tango-Dialog-information.png
http://www.gramps-project.org/wiki/index.php/File:FamilyEditor-dialog-Children-tab-example-50.png


This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

изменить	отношения	между	ребёнком	и	родителями.	Кнопка	 - 	удалит	выбранного	ребёнка	из	отношения.	Имейте	ввиду,	что
кнопки	 Редактировать 	и	 - 	доступны	только	после	выбора	ребёнка	в	списке.

Примечание

Удаление	ребёнка	из	списка	не	удалит	его	из	базы	данных.	Ребёнок	будет	удалён	только	из
отношения.

Совет

Используйте	стрелки	(вверх/вниз)	или	drag	and	drop,	чтобы	изменить	порядок	детей	в	семье.

Как	изменить	порядок	детей	в	семье? 	Используйте:

Эту	вкладку	Дети	в	редакторе	семьи,	чтобы	изменить	порядок	детей	в	семье.
Стороннее	дополнение	(инструмент)	Сортировка	детей	в	порядке	рождения.

Выбор	ребёнка

Рис.	9.1.29	Выбор	ребёнка

Диалог	 Выбора	ребёнка 	позволяет	выбрать	существующего	человека	и	после	его	выбора	открыть	в	 Редакторе	родства	ребёнка .

Показаны	следующие	колонки:	Имя	(сортировка	по	умолчанию),	ID,	Пол,	Дата	рождения,	Место	рождения,	Дата	смерти,	Место	смерти,
Супруги,	Последнее	изменение.	

Редактор	родства	ребёнка

Рис.	9.1.30	Редактор	родства	ребёнка

Редактор	родства	ребёнка 	позволяет	изменять	отношения	между	выбранным	ребёнком	и	родителями.

Доступны	следующие	поля:

Имя	ребёнка
Кнопка	 Редактировать 	-	откроет	ребёнка	в	редакторе	лиц.

Отношение	к	Отцу: 	Выбирается	из	выпадающего	списка	из	следующих	типов:
Воспитанник
Рождение(по	умолчанию)
Пасынок/падчерица
Нет
Спонсируемый
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Усыновление
Прочее

Отношение	к	Матери: 	Выбирается	из	выпадающего	списка	из	следующих	типов:
Воспитанник
Рождение(по	умолчанию)
Пасынок/падчерица
Нет
Спонсируемый
Усыновление
Прочее

Открытая/Приватная	запись 	переключение	конфиденциальности	для	отношения.

Ниже	доступны	следующие	вкладки.

Вкладка	цитаты

Вкладка	заметки

События

Вкладка	 События 	позволяет	просматривать	и	редактировать	список	событий	относящихся	к	семье.	Кнопки	 + 	,
Редактировать 	и	 - 	позволяют	добавить,	изменить	или	удалить	событие.	Учтите,	что	кнопки	 Редактировать 	и	 - 	доступны
только	после	выбора	события	из	списка.

Примечание

Удаление	события	из	списка	не	удалит	его	из	базы	данных.	Будет	удалено	только	ссылка	на	него	в
данном	отношении.

Цитаты

Вкладка	 Цитаты 	позволяет	просматривать	и	редактировать	список	ссылок	на	источники,	которые	подтверждают	отношение.	Это
могут	быть	документы	в	которых	упоминается	отношение,	но	не	в	официальном	виде.	Например,	в	мемуарах	тёти	Марты
упоминается	свадьба	её	правнука	Пола,	исследователь	может	предположить,	что	у	Пола	есть	жена	и	указать	мемуары,	как	источник
для	подтверждения.

Совет

Источники	в	которых	содержатся	данные	о	событиях	вступления	в	брак	или	разводе	лучше
указывать	в	этих	событиях,	на	вкладке	"События".

Кнопки	 + 	,	 Редактировать 	и	 - 	позволяют	добавить,	изменить	и	удалить	ссылку	на	источник	в	этом	отношении.	Учтите,	что
кнопки	 Редактировать 	и	 - 	становятся	доступными,	только	после	выбора	цитаты	в	списке.

Примечание

Удаление	элемента	из	списка	не	удалит	его	из	базы	данных.	Будет	удалена	только	ссылка	на
источник	из	данного	отношения.

Атрибуты

Вкладка	 Атрибуты 	позволяет	просматривать	и	редактировать	инфнормацию	об	отношении,	которая	может	быть	представлена	как
атрибут.	Кнопки	 + ,	 Редактировать 	и	 - 	позволяют	добавить,	изменить	или	удалить	атрибут.	Учтите,	что	кнопки
Редактировать 	и	 - 	доступны	только	после	выбора	атрибута	в	списке.

Заметки

Вкладка	 Заметки 	позволяет	просматривать	и	редактировать	заметки	связанные	с	отношением.	Они	могут	быть	любым
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комментарием,	который	не	подходит	для	представления	в	виде	"Параметр-Значение"	в	Атрибутах.	Чтобы	добавить	или	изменить
существующую	заметку,	просто	введите	нужный	текст.

Параметр	 Формат 	позволяет	управлять	тем	как	заметка	будет	отображаться	в	отчётах	и	на	веб-страницах.	Если	выбрать	Flowed,	то	будут
убраны	лишнии	пробелы,	табуляция	и	символы	конца	строки.	Пустые	строки	между	текстом	будут	обработаны	как	новые	параграфы.

Если	выбран	параметр	"Свёрстанный",	то	текст	в	отчётах	и	веб-страницах	будет	отображён	также,	как	введён	в	редакторе	 Заметок .

Галерея

Вкладка	 Галерея 	содержит	фотографии	и	другие	медиа	объекты	связанные	с	семьёй.	В	центре	расположен	список	этих	объектов	в
виде	миниатюр	изображений.	Другие	объекты,	например	аудио	и	видео	файлы	отображаются	соответствующей	иконкой	Gramps.
Кнопки	 + 	,	 Выбрать 	,	 Редактировать 	и	 - 	позволяют	добавить	новое	изображение	или	ссылку	на	него,	изменить
существующее	изображение,	а	также	удалить	ссылку	на	медиа	объект.	Имейте	ввиду,	что	кнопки	 Редактировать 	и	 -
становятся	доступными	только	после	выбора	объекта	в	списке.

СПД

The	 LDS 	(Latter	Days	Saints)	tab	displays	information	about	the	LDS	Sealed	to	Spouse	ordinance.	The	data	can	include	date,	LDS	temple,
and	Place.	The	status	of	the	ordinance	can	be	described	through	the	selections	available	in	the	Status	pop-up	menu	and	can	also	be	referenced
in	the	corresponding	Sources...	and	 Note 	buttons.

To	edit	source	data,	switch	to	the	Sources	View	and	select	the	desired	entry	in	the	list	of	sources.	Double-click	that	entry	or	click	the	 Edit 	icon
on	the	toolbar	to	invoke	the	following	 Source	Editor	dialog: 	The	main	part	of	the	window	displays	four	notebook	tabs	containing	different
categories	of	information.	Click	a	tab	to	view	or	edit	its	contents.	The	bottom	part	of	the	window	has	 OK 	and	 Cancel 	buttons.	Clicking	 OK
will	apply	all	the	changes	made	in	all	tabs	and	close	the	dialog	window.	Clicking	the	 Cancel 	button	will	close	the	window	without	applying	any
changes.

Note

Clicking	 OK 	will	immediately	save	changes	to	the	database	(write	on	disk).	All	changes	are	immediate.

Tip

If	a	tab	label	is	in	boldface	type,	this	means	it	contains	data.	If	not,	it	has	no	data.

See:	Edit	Person	dialog>Tab>LDS	

Редактирование	дат
Этот	раздел	содержит	информацию	о	вводе	и	изменении	дат.	Так	как	даты	очень	важны	в	генеалогических	исследованиях,	Gramps
позволяет	сохранять	и	использовать	любую	доступную	информацию	о	датах.

Информация	может	быть	введена	напрямую	в	поле	даты	или	при	помощи	диалога	 выбора	даты ,	который	можно	вызвать	по	кнопке
Открыть	редактор	дат 	рядом	с	полем	ввода	дат.

Смотрите	также:

Gramps	6.0	Вики	Руководство	-	Вероятно	живые
Меню	->	Правка	->	Настройки...	->	Даты	-	Для	изменения	значений	по	умолчанию:	максимальный	возраст,	количество	лет	между
поколениями	и	др.

Выбор	даты

Рис.	9.1.31	Диалог	 Выбора	дат 	(по	умолчанию)
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Хотя	доступны	правила	обработки	дат	введённых	вручную,	возможно	использование	диалога	 выбора	дат .	Этот	диалог	полезен	для
ввода	сложных	дат	или	для	уверенности,	что	информация	добавлена	в	формате	понятном	Gramps.

Календарь: 	выбор	альтернативного	типа	календаря.
Григорианский	(по	умолчанию)
Юлианский	(включая	Смешанные/Двойные	даты)
Еврейский
Французский	республиканский
Иранский
Исламский
Шведский

	 Двойная	дата 	Используется	совместно	с	полем	 Первый	день	года ,	если	календарь	поддерживает	двойную	дату.	(по
умолчанию	отключено)

Первый	день	года 	(пустое	поле	по	умолчанию)
Качество 	-	выбор	качества	даты.

Обычная	(по	умолчанию)
Оценено
Вычислено

Тип 	-	выбор	точности	даты	или	другого	типа	даты.
Обычная	(по	умолчанию)	-	интервал	ограниченный	днём,	месяцем	или	годом	(не	связанный	с	часовым	поясом)
До
После
Около
Отрезок
Интервал
Только	текст

Дата 	-	выбор	 Года ,	 Месяца 	и	 Дня .
Вторая	дата 	-	если	 тип 	даты	является	Отрезком	или	Интервалом,	становится	доступным	выбор	второй	даты.
Текстовый	комментарий 	текстовое	поле	позволяет	хранить	произвольный	текст	вместе	с	датой.

Важная	информация	о	датах

Если	имеется	описание	относящееся	к	дате,	лучше	написать	его	в	Заметке	или	описании
относящемуся	к	событию,	вместо	использования	поля	с	текстовых	комментарием	в	диалоге
выбора	даты .	Это	предпочтительнее	по	следующим	причинам:	Если	вы	введёте	дату
непосредственно	в	поле	даты	(без	использования	диалога	 выбора	даты ),	эти	данные	будут
преобразованы	Gramps.	Таким	образом,	любой	комментарий,	который	мог	быть	там	до	разбора,
будет	перезаписан.

Проверка	даты

Рис.	9.1.32	Диалог	выбора	даты	-	пример

Gramps	использует	проверку	дат.

Хотя	частичные	даты	неточно	определяют	день,	всё	же	имеют	некоторую	возможность	сравнения	дат.

Поле	ввода	даты	подсвечивается	красным	и	отображается	значок	(красный	крестик)	для	обозначения,	что	введённая	дата	не	соответствует
допустимым	форматам.

Примеры	дат,	которые	не	будут	распознаны	Gramps	"Рождественская	неделя	'61",	"Осень	1782",	или	"лето,	когда	мне	сделали	операцию".
В	этом	случае,	дата	будет	преобразована	и	сохранена	как	строка	с	типом	Только	текст.	Все	даты	этого	типа	не	имеют	возможности
сравнения.	Где	это	возможно,	лучше	избегать	записей	дат	с	типом	Только	текст.	Лучше,	ввести	дату	"Декабрь	1961"	и	добавить	описание
"Рождественская	неделя	'61."	Более	точно	можно	указать	используя	интервал	дат...	и	также	добавить	описание.	Описание	необходимо	для
связи	'Рождественской	недели'	с	указанным	промежутком	времени.	Это	может	значить,	что	строка	календаря	день	Рождества.	Но
Американский	и	Европейский	календари	начинаются	с	разных	дней	недели.	Или	это	может	значить	-	7	дней	до	Рождества	Christmas.	И	так
интервал	позволяет	исследования	и	сравнения,	а	описание	содержит	интерпретацию.

В	различных	Видах	(таких	как	 Люди ),	нераспознанные	даты	будут	выделены	жирным	шрифтом	(по	умолчанию).	Отображение	текста
(стиль)	нераспознанных	дат	может	быть	изменён	в	параметре	 Разметка	для	неверных	форматов	дат	на	вкладке	 Даты 	в
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Настройках.

Качество	даты

Обычное:	"обычная"	дата	является	точным	днём,	месяцем	или	годом.

Оценено:	дата	"оцененная"	на	основании	предположений,	ограничений	и	связанных	с	ней	известных	дат.	(Например,	возраст	между
поколениями,	максимальная	продолжительность	жизни	и	др.)

Вычислено:	дата	"вычисленная"	на	основании	известных	временных	промежутках	и	датах	без	указания	точной	даты.	(Например,
памятник	с	указанными	датой	смерти	и	возрастом.)

Кажется,	что	данные	переписи	можно	использовать	для	вычисления	дат,	но	это	не	совсем	так.	Перепись	обычно	определяет	возраст	и
имеет	дату	проведения	переписи,	но	эти	данные	обычно	оценочные	или	округлённые.

Тип	даты

Справа	от	 Качества 	расположено	выпадающее	меню	 Тип .

Даты	в	Gramps	классифицированы	в	соответствии	со	следующими	типами	точности	(масштабом)	интервалов	или	временных	рамок:

Обычный:	"обычная"	дата,	которая	включает	интервал	указывающий	на	день,	месяц	или	год.	Дата	может	быть	завершённой
(указывающей	на	24-часовой	интервал,	например,	июнь	6,	1990)	или	частичной	(без	указания	дня	для	интервала	в	1	месяц,
например,	Июль	1977	или	без	указания	дня	и	месяца	для	интервала	в	1	год).

До:	дата	с	типом	"до"	указывает	на	происходящее	перед	определённым	днём,	месяцем	или	годом.

После:	дата	с	типом	"после"	указывает	на	происходящее	после	определённого	дня,	месяца	или	года.

Около:	дата	с	типом	"около"	(приблизительно)	указывает	на	некоторый	интервал	до	или	после	определённого	дня,	месяца	или	года.

Отрезок:	описывает	период,	в	течение	которого	произошло	событие.	Событие	может	быть	повторяющимся	в	этом	интервале	или
однократным,	произошедшим	в	известных	границах	времени.

Например,	"между	Январём	1932	и	Мартом	1932."

Интервал:	описывает	период	в	рамках	которого	длится	событие	(обстоятельство).

Например,	"с	Мая	12,	2000	по	Февраль	2,	2002."

Формат	дат

Диалог	выбора	даты	помогает	выбрать	дату	и	сохранить	её	в	необходимом	формате	понятном	Gramps.	Это	может	быть	полезно,	если	Вы
не	знакомы	с	параметрами	или	требуется	использовать	другой	календарь	и	указать	начало	года.

Gramps	распознаёт	даты	введённые	в	различных	форматах.	Gramps	по	умолчанию	использует	цифровой	формат;	например,	ДД.ММ.ГГГГ
для	европейских	стран,	ММ/ДД/ГГГГ	для	США	и	т.д.	Чтобы	избежать	неоднозначности	лучше	всегда	использовать	формат	д	месяц	гггг
или	месяц	д	гггг.

Кроме	точных	дат,	Gramps	распознаёт	много	других	вариантов	записи:	до,	после,	около,	отрезка	и	интервала.	Также	понимает	указанное
качество:	оценено	или	вычислено.	И	на	конец,	поддерживает	частичные	даты	и	альтернативные	календари.	Ниже	приведены	правила
записи	даты	для	проведения	однозначного	разбора.

Правила	разбора

В	зависимости	от	локализации	Gramps	используется	необходимый	обработчик	дат	которые
доступны	для	французского,	немецкого,	русского,	финского,	датского,	испанского,	словацкого	и
шведского	языков	(список	обработчиков).	Если	обработчик	для	Вашего	языка	отсутствует,	то
будет	использован	английский.
Если	что-то	не	указано	в	локализованном	руководстве,	можно	попробовать	записать	дату
обычным	способом	привычным	для	Вашего	языка.	Если	не	удалось,	используйте	диалог	 выбора
даты .	Обработанная	при	выборе	в	диалоге	дата	покажет,	как	нужно	вводить	локализованные
качество	и	тип.

Обычные	даты	могут	быть	введены	в	виде	как	Вы	привыкли	их	записывать.	Добавление	слэша	после	года	с	последующим	значеним
создаст	юлианскую	двойную	дату.

Пример:	Май	24,	1961,	31	Дек	1858/9	или	Январь	1,	2004.

Частичные	даты	вводятся	просто	без	неизвестной	информации.

Пример:	Май	1961	и	2004.

Даты	с	отличным	от	обычного	 качеством 	необходимо	начинать	с	подходящего	ключевого	слова	Оценено	или	Вычислено.

Пример:	оцен.	1961	или	вычисл	2005.	(Имейте	ввиду,	что	 качество 	для	обычных	дат	указывать	не	нужно.)

Ввод	и	редактирование	данных:	подробно	-	часть	1	-	Редактирование	дат 80

http://www.gramps-project.org/wiki/index.php/File:Gramps-notes.png
http://www.gramps-project.org/wiki/index.php/Handler_List


Указать	 типы 	До,	После	или	Около	можно	просто	набрав	"до",	"после"	или	"около"	перед	датой.

Для	даты	с	 типом 	отрезка,	введите	"между	ДАТА	и	ДАТА",	а	для	 типа 	интервал,	введите	"с	ДАТА	по	ДАТА".

Пример:	с	2001	по	2003,	до	Июня	1975,	примерно	2000,	вычисл	между	Маем	1900	и	1	Января	1990.

Несколько	примеров:

Капитан	Джон	Смит	был	приписан	к	первому	полку	между	1888-5-13	и	1902-10-24	в	соответствии	со	служебными	записями	(слова
"между"	и	"и"	использованы	намеренно,	как	в	повседневной	жизни).
Дату	нужно	записать	в	следующем	виде	"с	…	по	…",	так	как	это	продолжительность	службы.

Полк	капитана	Джона	Смита	был	направлен	к	реке	Шельда	в	Валансьен	за	неделю	до	перемирия.
Это	можно	записать	как	событие	с	типом	"Воинская	служба"	с	датой	"между	Ноя	4	1918	и	11	Ноя	1918"	(Gramps	преобразует
даты	в	стандартный	формат,	несмотря	на	использования	двух	разных	форматов	записи)	на	реке	Шельда,	Валансьен,
департамент	Нор,	Франция...	потому,	что	точная	дата	"одномоментного"	события	не	указана	в	источнике.

Календари

Альтернативные	календари	-	это	календари	отличные	от	григорианского.	На	данный	момент	Gramps	поддерживаются	юлианский,
еврейский,	французский	республиканский,	иранский,	исламский	и	шведский	календари.	Для	выбора	календаря	(не	используемого	по
умолчанию),	добавьте	название	календаря	к	строке	даты,	например	"Январь	9,	1905	(юлианский)"	или	используйте	выпадающее	меню.

Шведский	календарь

Шведский	король,	Карл	XII,	решил,	что	Швеция	должна	использовать	григорианский	календарь.	Однако,	планировалось	постепенное
введение	начиная	с	1700-02-29	до	1744.	И	так	после	1700-02-28	наступал	1700-03-01.	Это	производилось	до	Северной	войны,	из-за
которой	1704	и	1708	были	високосными.	В	1711	году	Карл	XII	решил	окончательно	отказаться	от	реформы	календаря	и	вернуться	к
юлианскому	летоисчислению.	Для	этого	в	1712	году	в	феврале	были	добавлены	два	дня	и	таким	образом	в	Швеции	в	1712	году	появилась
необычная	дата	30	февраля.	Окончательно	Швеция	перешла	на	григорианский	календарь	в	1753	году	обычным	для	всех	стран	способом:
день,	следующий	за	17	февраля,	объявили	1	марта.	В	Gramps	Вы	можете	ввести	даты	для	шведского	календаря	с	1700-03-01	по	1712-02-30.
Все	остальные	даты	помечаются	неверными	и	должны	быть	откорректированы.

Двойные	даты

Двойные	даты	(также	известные	как	даты	по	"старому/новому	стилю")	например,	"Янв	23,	1735/6".	Распространённой	ошибкой	является
неопределённость	года,	это	имеет	историческое	значение.	Двойные	даты	представляют	собой	время,	смещения	Января	1	в	начало	года.
Так	Янв	23,	1735/6	явлется	уточнением,	чтобы	было	понятно	на,	что	ссылается	дата.

Английские	и	Американские	колонии	официально	не	принимали	"1	Января"	началом	нового	года	до	1752.	До	1752,	правительство
Англии	официально	принимало	25	Марта	как	начало	нового	года,	однако	большинство	англичан	1	Января.	Поэтому	многие	люди
записывали	даты	между	1	января	и	25	марта	25	в	двойном	формате.

Иногда,	двойные	даты	могут	появляться	в	виде	дроби,	например	на	надгробьях	(170	и	3/4,	что	означает	1703	и	1704):

Рис.	9.1.33	Надгробный	камень	с	двойной	датой	в
виде	дроби

Отметить	дату	как	двойную	можно,	добавив	слэш	между	годами.	Например:

1721/2
1719/20
1799/800

Такие	двойные	года	могут	отображаться	везде,	где	может	обычный	год.

Двойные	даты	представлены	в	юлианском	календаре,	и	его	месяцы	и	дни	будут	такими	же,	как	в	текстовом	виде.

Первый	день	года

Совместно	с	двойными	датами	(и	другими),	где	известно,	что	новый	год	отличался	от	1	января.	Для	отметки	данного	факта	в	Gramps,
добавьте	код	месяц/день	в	скобках,	после	календаря	(если	есть).	Например:

Янв	20,	1865	(Mar25)
Янв	20,	1750	(юлианский,Mar1)
Фев	23,	1710/1	(Mar25)

Для	обозначения	начала	года	отличающегося	от	1	января,	используйте	следующие	коды:

Jan1
Mar1
Mar25
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Sep1

Могут	быть	использованы	как	единственный	параметр	в	скобках	или	сразу	после	названия	календаря	(запятая	и	без	пробела).

Имейте	ввиду,	если	первый	день	года	отличается	от	1	января,	тогда	Январь	будет	после	Декабря	этого	года.	Даты	содержащие	коды
нового	года	будут	сортироваться	соответственно.

Пред Содержание След
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Ввод	и	редактирование	данных:	подробно	-	часть	2

Пред Содержание След

В	предыдущем	разделе	представлено	подробное	описание	процессов	ввода	и	изменения	данных	о	людях,	отношениях	и	датах.	Этот
раздел	описывает	работу	с	другими	объектами,	которые	Вы	встретите	в	Gramps.

Изменение	информации	о	событиях

Рис.	7.2.1	Категория	событий	-	пример	представления	событий	в
виде	списка

Добавление	события	к	человеку	позволяет	записать	найденную	информацию.

При	создании	события	в	категории	 События ,	открывается	диалог	 Новое	событие .

Для	добавления	или	изменения	данных	события,	переключитесь	на	категорию	 События 	и	выберите	необходимый	элемент	из	списка
событий.	Двойным	щелчком	или	кнопкой	 Редактировать 	на	панели	инструментов	откройте	диалог	создания/изменения	события.	

Редактор	событий

Рис.	7.2.2	Редактор	событий

События	создаются	и	изменяются	в	 Редакторе	событий .	Этот	редактор	можно	вызвать	из	 Редактора	лиц 	или	диалога
Семья/Отношения .

В	верхней	части	Вы	можете	просмотреть	и	изменить	основную	информацию	о	событии:

Тип	события 	может	быть	выбран	из	доступных	типов	событий	в	выпадающем	меню.	Например,	рождение	(по	умолчанию),
смерть	и	др.	Также	можно	ввести	свой	тип	события	в	это	поле.
Дата 	события	может	быть	точной	датой,	интервалом	(с	...	по,	между	...),	или	неточной	датой	(около	...).

Кнопка	 Редактора	даты 	откроет	диалог	 Выбора	даты .
В	поле	 Описание 	можно	указать	подробное	описание	события.

Установка	флажка	 Приватная/Свободная	запись ,	помечает	событие	как	частное	и	позволяет	не	включать	событие	в
отчёты.

Место 	может	быть	выбрано	из	списка	мест	по	кнопке	 Выбрать	существующее	место 	или	добавлено	новое	при	нажатии
кнопки	 Добавить	новое	место .	Также,	можно	перетащить	мышкой	запись	о	месте	в	это	поле.
ID 	уникальный	идентификатор	события.	Оставьте	это	поле	пустым,	Gramps	автоматически	заполнит	его	при	создании	нового
события.
Метки 	позволяет	выбрать	существующие	метки	по	кнопке	 Редактировать	список	меток .

Вкладки	редактора

В	центре	окна	расположены	вкладки,	содержащие	различные	категории	информации.	Щелкните	вкладку	для	просмотра	или	изменения	её
содержимого.

Вкладки	предоставляют	следующие	категории	информации	о	событии:
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Цитаты	источника

На	вкладке	 Цитаты	источника 	можно	просмотреть	или	изменить	источники,	относящиеся	к	событию.	В	центре	окна	расположен
список	со	всеми	такими	источниками,	сохраненными	в	базе	данных.	Кнопки	 + ,	 Редактировать ,	 - 	позволяют	добавить,
изменить,	и	удалить	ссылку	на	источник,	связанный	с	событием.	Обратите	внимание,	что	кнопки	 Редактировать 	и	 -
становятся	доступны,	только	когда	ссылка	на	источник	выбрана	в	списке.

Заметки

Вкладка	 Заметки 	предоставляет	место	для	записи	комментариев	или	заметок	о	событии.	Для	добавления	заметки	или	изменения
существующей,	просто	отредактируйте	текст	в	поле	ввода.

Галерея

Вкладка	 Галерея

Атрибуты

Вкладка	 Атрибуты

Ссылки

Вкладка	 Ссылки

В	нижней	части	окна	расположены	кнопки	 OK 	и	 Отменить .	Щелчок	по	 OK 	запишет	все	сделанные	изменения	во	всех	вкладках	и
закроет	окно	диалога.	Щелчок	по	 Отменить 	закроет	окно	диалога	без	сохранения.	Щелчок	по	 Справка 	откроет	справочную
информацию,	если	она	доступна.

Совет

Если	шрифт	заголовка	вкладки	жирный	-	это	означает,	что	она	содержит	данные.	Если	нет	-	то
вкладка	пуста.

Редактирование	ссылок	на	события
Ссылки	на	события	связывают	Событие	с	Лицом	и	позволяют	предоставлять	дополнительную	информацию	о	событии.	При	добавлении
события	на	вкладке	События	в	редакторе	лиц,	открывается	редактор	ссылок.

Редактор	ссылок	событий

Совет

Информация	в	этом	диалоге	относится	к	конкретной	ссылке	на	событие.	На	каждое	событие
можно	ссылаться	множество	раз.	И	все	эти	ссылки	будут	иметь	полную	общую	информацию	о
событии.	Этот	диалог	позволяет	предоставить	данные,	относящиеся	к	конкретной	ссылке,	такие
как	роль,	дополнительный	атрибут,	ссылку	на	документ.

Рис.	7.2.3	Редактор	ссылки	на	событие

Диалог	содержит	две	секции	 Информация	о	ссылке 	и	 Общая	информация .

Информация	о	ссылке 	содержит	информацию	связанную	с	данной	ссылкой	на	это	Событие:	 Общее ,	 Заметки ,	 Атрибуты .
Общая	информация 	содержит	вкладки:	 Общее ,	 Цитаты	источника ,	 Атрибуты	 ,	 Заметки ,	 Галерея ,	 Ссылки .
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Информация	о	ссылке

Вкладки	раздела

Общее

В	качестве	роли	Лица	в	данном	событии	используйте	Главный	для	главного	действующего	лица,	иначе	выберите	качественную	роль
(Например,	Свидетель,	Священник,	...).

Events	added	to	a	Person	via	the	Share	or	by	drag'n'drop	will	be	assigned	the	Unknown	Event	Role	by	default.	If	the	Person	holds	an	equal	Role,
set	their	Role	to	Primary	as	well.

If	none	of	the	pre-defined	Roles	are	appropriate,	add	a	custom	Role	by	typing	in	the	new	Role	name	rather	than	selecting	one	from	among	those	of
the	Role	Pull-Down	menu.	Any	added	custom	Roles	will	remain	available	in	that	expanded	menu...	unless	the	Tree	is	exported	&	re-imported	or	via
a	3rd	party	addon	Utility	like	Type	Cleanup.	

Заметки

Атрибуты

Общая	информация

Общая	информация	для	события	и	всех	ссылок	на	него.

Примечание

Все	изменения	в	разделе	с	общей	информацией	будут	отражены	в	самом	событии,	для	всех	его
участников.

Вкладки	раздела

В	разделе	Общая	информация	имеются	следующие	вкладки.	

Общее

Цитаты	источника

Атрибуты

Заметки

Галерея

Ссылки

Редактирование	информации	о	медиа-объектах
Для	редактирования	данных	о	медиа-объектах,	переключитесь	в	вид	Альбом	и	выберите	необходимую	запись	из	списка	источников.
Дважды	щелкните	по	этой	записи	или	щелкните	по	кнопке	 Редактировать 	в	панели	инструментов	для	вызова	диалога	 Редактор
свойств	медиа-объектов	(Альбом) :

Новый	документ
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Рис.	7.2.4	Диалог	создания	нового	документа

В	диалоге	отображается	миниатюра	и	сводная	информация	о	свойствах	объекта	(ID,	путь	к	файлу,	дата	и	тип	объекта).

1.	 Описательное	 Название 	для	этого	медиа-объекта.
2.	 ID 	уникальная	запись	для	идентификации	медиа-объекта,	оставьте	для	заполнения	системой.
3.	 Дата 	для	фотографии	может	быть	датой	съемки.
4.	 Путь 	медиа-объекта	на	компьютере.	Gramps	не	хранит	медиа-объекты	в	базе	данных,	только	пути!	Установите	Relative	Path	в

Настройках,	чтобе	не	исправлять	путь	к	базовому	каталогу,	где	хранятся	все	Ваши	медиа-объекты.	Утилита	Media	Manager	может
помочь	в	управлении	путями	коллекций	медиа-объектов.

5.	 Mime 	значение	-	тип	медиа-объекта.

В	центре	окна	находятся	четыре	вкладки,	содержащих	различные	категории	информации.	Щелкните	по	вкладке,	для	просмотра	или
изменения	ее	содержимого.	В	нижней	части	окна	расположены	кнопки	 OK 	и	 Отмена .	Щелчок	по	кнопке	 OK ,	сохраняет	изменения
сделанные	во	всех	вкладках	и	закрывает	окно	диалога.	Щелчок	по	кнопке	 Отмена ,	закроет	окно	без	сохранения.

Note

Щелчек	по	кнопке	 OK 	немедленно	сохраняет	изменения	в	базу	данных	(записывает	на	диск).

Совет

Если	шрифт	заголовка	вкладки	жирный,	то	это	означает,	что	она	содержит	данные.	если	нет,	то
вкладка	не	содержит	данных.

Общая	информация	об	объекте

В	верхней	части	окна	можно	просмотреть	или	изменить	Название	и	Дату	объекта.	Вы	можете	ввести	эту	информацию	непосредственно	в
соответствующие	поля.	Также,	для	заполнения	поля	Даты,	Вы	можете	вызвать	диалог	Редактор	дат,	щелкнув	по	LED	кнопке.

Note

Ссылка	на	каждый	медиа-объект	осуществляется	по	пути	к	нему	в	файловой	системе.
Отслеживание	файлов	возлагается	на	пользователя.	GRAMPS	только	ссылается	и	отображает
содержимое,	но	не	управляет	собственно	файлами.

Вкладки

Tip

If	a	tab	label	is	in	boldface	type,	this	means	it	contains	data.	If	not,	it	has	no	data.

Вкладки	содержат	следующие	категории	данных	о	медиа-объектах:

Цитаты

На	вкладке	 Цитаты 	можно	просмотреть	или	изменить	источники,	относящиеся	к	объекту.	В	центре	окна	расположен	список	со	всеми
такими	источниками,	сохраненными	в	базе	данных.	Кнопки	 +	,	Редактировать	,	and	- 	позволяют	добавить,	изменить,	и	удалить
ссылку	на	источник,	связанный	с	объектом.	Обратите	внимание,	что	кнопки	 Редактировать 	и	 - 	становятся	доступны,	только	когда
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

ссылка	на	источник	выбрана	в	списке.

Атрибуты

Вкладка	 Атрибуты	 позволяет	просматривать	и	изменять	специфическую	информацию	о	медиа-объекте,	которую	можно	выразить	как
Атрибуты.	Внизу	отображаются	все	такие	атрибуты,	сохраненные	в	базе	данных.	Кнопки	 + 	,	 Редактировать 	,	и	 - 	позволяют
добавить,	изменить	или	удалить	атрибут.	Обратите	внимание,	что	кнопки	 Редактировать 	и	 - 	становятся	доступны,	только	когда
атрибут	выбран	в	списке.

Заметки

Вкладка	 Комментарии 	предоставляет	место	для	записи	различной	информации	об	объекте,	которая	не	попадает	в	другие	категории.	Это
место	полезно	для	записи	данных,	не	подходящих	для	вариантов	доступных	в	Атрибутах.	Для	добавления	заметки	или	исправления
существующей,	просто	отредактируйте	текст	в	поле	ввода.

Ссылки

Вкладка	 Ссылки 	отражает	все	записи	в	базе	данных,	ссылающиеся	на	данный	медиа-объект.	Список	ссылок	может	быть	упорядочен	по
любой	колонке:	 Тип 	,	 ID 	или	 Имя .	Дважды	щелкните	по	ссылке,	чтобы	отредактировать	соответствующую	запись.

Note

Только	главные	объекты	могут	отображаться	на	вкладке	 Ссылки :	Лицо,	Семья,	Событие,
Источник	или	Место.	Второстепенные	объекты,	такие	как	Имена	и	Атрибуты,	хотя	и	могут
ссылаться	на	медиа-объекты,	отображаются	только	через	главные	объекты,	к	которым	они
принадлежат.

Редактирование	ссылок	на	медиа-объекты
When	Media	Object	references	connect	a	Media	Object	to	an	other	object	on	a	 Edit	Person's	Gallery 	tab,	the	 Share 	button	will	bring	up
the	Select	Media	Object	selector	and	once	you	select	a	Media	Object	the	 Media	Reference	Editor 	dialog	appears.

Выбор	документа

Fig.	7.2.5	Select	a	media	object	-	(File)	Selector	Dialog	-	example

The	 Select	a	media	object 	file	selector	allow	you	to	preview	and	select	a	media	file	you	want	to	attach,	and	at	the	same	time	you	may	edit
the	shown	 Title: 	(Defaults	to	the	filename	without	the	file	extension).

Convert	to	a	relative	path 	(checkbox	unchecked	by	default	until	checked	for	the	first	time	and	remembered	for	each
subsequent	image	selection.)

See	also:	Select	Media	Object	selector
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Media	Reference	Editor	dialog

Fig.	7.2.6	Media	Reference	Editor	-	dialog	-	collapsed	default	example

The	 Media	Reference	Editor 	dialog.

See	also	How	to	create	image	reference	regions

Fig.	7.2.7	Media	Reference	Editor	-	dialog	-	"Shared	Information"
section	expanded	example

You	may	also	expand	the	Shared	Information	section.
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Top	section

Top	section	tab	pages

General

Углы	области	:	x1,	x2,	y1,	y2.

Область 	позволяет	выбрать	определенную	координатами	часть	Медиа-Объекта.	Вы	можете	выбрать	область	на	картинке	курсором
мыши	или	устанавливая	нужные	значения	в	соответствующих	полях,	задать	левый	верхний	и	правый	нижний	угол	области	для	ссылки.
Точка	(0,0),	это	левый	верхний	и	(100,100)	-	правый	нижний	угол.

Открытая/закрытая

Кнопка	 Privacy 	помечает	запись	как	открытую	или	закрытую.	Установите	флаг	 Private ,	чтобы	пометить	данную	 запись ,	как
закрытую.

Цитаты

Атрибуты

Заметки

Shared	Information

Shared	Information	tab	pages

General

References

Source	Citations

Attributes

Notes

Редактирование	информации	о	местах
Для	редактирование	информации	о	местах	переключитесь	в	вид	Места	и	выберите	необходимую	запись	из	списка	мест.	Дважды	щелкните
эту	запись	или	щелкните	кнопку	 Редактировать 	в	панели	инструментов,	чтобы	открыть	следующий	 Редактор	мест 	диалог:

Редактор	местоположений
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Fig.	7.2.8	Place	editor	-	dialog

В	диалоге	доступны	следующие	поля:

1.	 Название	места :	полное	название	этого	места.
2.	 Широта :	положение	Места	над	экватором	в	виде	десятичной	дроби	или	в	градусах.	Например,	правильными	будут	значения:

12.0154,	50°52'21.92"N,	N50º52'21.92"	или	50:52:21.92.	Вы	можете	установить	эти	значения	через	вид	География,	найдя	в	нем	Место
или	через	сервис	карт	в	виде	Места.

3.	 Долгота :	положение	Места	относитально	нулевого	мередиана	(Гринвича)	в	виде	десятичной	дроби	или	в	градусах.	Например,
правильными	будут	значения:	-124.3647,	124°52'21.92"E,	E124º52'21.92"	или	124:52:21.92.	Вы	можете	установить	эти	значения	через
вид	География,	найдя	в	нем	Место	или	через	сервис	карт	в	виде	Места.

4.	 ID :уникальная	запись	для	идентификации	Места,	оставьте	для	заполнения	системой.

Вкладки	редактора

Совет

Если	шрифт	заголовка	вкладки	жирный,	то	это	означает,	что	она	содержит	данные.	если	нет,	то
вкладка	не	содержит	данных.

Вкладки	отображают	следующие	категории	информации	о	Местах:

Входит	в

Fig.	7.2.9	"Enclosed	By"	tab	from	"Place	Editor"	-	dialog	-	example

Places	in	Gramps	are	stored	in	a	hierarchy.	The	 Enclosed	By 	tab	allows	you	to	link	this	place	to	other	places,	higher	in	the	hierarchy,
which	enclose	it.	Each	link	consists	of	a	place	and	an	optional	date	range.	The	buttons	 + 	,	 Edit 	,	and	 - 	let	you	add,	modify,	and	remove
a	link.	Note	that	the	 Edit 	and	 - 	buttons	become	available	only	when	a	link	is	selected	from	the	list.	In	general,	a	country	will	be	a	top
level	place,	and	will	not	be	linked	to	any	other	place.

See	also:	Enclosed	By	Gramplet	

Select	Place	selector
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Fig.	7.2.10	Select	Place	-	Selector	Dialog	-	example

The	 Select	Place 	selector	dialog	allows	you	to	link	to	an	already	existing	place	and	once	selected	it	will	be	opened	in	the	 Place	Reference
Editor

You	may	use	the	 Find 	button	to	filter	the	list	based	on	one	of	the	options	from	the	drop	down	list:

Name	contains	(default)

Place	Reference	Editor

Fig.	7.2.11	Place	Reference	Editor	-	Dialog	-	example

Place	Reference	Editor

Вторая	часть	окна	содержит	семь	вкладок	с	различными	категориями	информации.	Щелкните	по	вкладке	для	просмотра	или	изменения	ее
содержимого.	В	нижней	части	окна	расположены	кнопки	 OK 	и	 Cancel 	.	Щелчок	по	кнопке	 OK 	,	сохраняет	изменения	сделанные	во
всех	вкладках	и	закрывает	окно	диалога.	Щелчок	по	кнопке	 Cancel ,	закроет	окно	без	сохранения.

Note

Щелчок	по	кнопке	 OK 	незамедлительно	сохранит	все	изменения	в	базе	данных.

Альтернативные	имена

Вкладка	 Альтернативные	имена 	позволяет	просмотреть	и	изменить	другие	названия,	под	которыми	это	Место	может	быть	известно.
Кнопки	 + 	,	 Редактировать 	,и	 - 	позволяют	добавить,	изменить,	и	удалить	название	места,	связанный	с	событием.	Обратите
внимание,	что	кнопки	 Редактировать 	и	 - 	становятся	доступны,	только	когда	название	выбрано	в	списке.
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Note

Seeing	a	question	?	mark	means	that	you	may	have	a	problem	in	the	naming	variants	of	that	place.	There
may	be	some	places	which	have	different	names	for	the	same	date	range	and	language.	Overlapping	date
ranges	are	valid.	The	place	displayer	will	use	the	first	matching	name.

Цитаты

Вкладка	 Цитаты 	позволяет	просмотреть	и	изменить	источники,	относящиеся	к	Месту.	В	центре	окна	расположен	список	ссылок	на
источники,	хранящиеся	в	базе	данных.	Кнопки	 + 	,	 Редактировать 	,	и	 - 	позволяют	добавить,	изменить,	и	удалить	ссылку	на
источник,	связанный	с	этим	местом.	Обратите	внимание,	что	кнопки	 Редактировать 	и	 - 	становятся	доступны,	только	когда	ссылка
на	источник	выбрана	в	списке.

Заметки

Вкладка	 Комментарии 	отображает	комментарии	и	заметки	относительно	Места.	Чтобы	добавить	или	изменить	заметку,	просто
отредактируйте	текст	в	поле	ввода	текста.

Галерея

Вкладка	 Галерея 	позволяет	сохранить	и	отобразить	фотографии	и	другие	медиа-объекты	связанные	с	данным	Местом.	В	центре	окна
находятся	список	всех	таких	объектов	и	миниатюры	файлов	изображений.	Другие	объекты,	такие	как	аудио-видео	файлы	и	т.п.
представлены	общим	значком	GRAMPS.	Кнопки	 + 	, Выбрать	 ,	 Редактировать 	,и	 - 	позволяют	добавить	изображение,	добавить
ссылку	на	существующее	изображение,	изменить	существующее	изображение,	и	удалить	ссылку	медиа-объекта	на	Место.	Обратите
внимание,	что	кнопки	 Редактировать 	и	 - 	становятся	доступны,	только	когда	медиа-объект	выбран	в	списке.

Интернет

Вкладка	 Интернет 	содержит	Интернет	адреса,	имеющие	отношение	к	данному	Месту.	Внизу	находится	список	таких	Интернет	адресов,
сохраненных	в	базе	данных.	Вверху	-	отображаются	данные	о	выбранном	в	списке	адресе.	Кнопки	 + 	,	 Редактировать 	,	и	 -
позволяют	добавить,	изменить,	и	удалить	Интернет	адрес.	Кнопка	 Перейти 	(в	виде	значка	с	зеленой	стрелкой	и	желтым	кружком)
открывает	в	Вашем	браузере	веб-страницу,	соответствующую	выбранному	Интернет	адресу.	Обратите	внимание,	что	кнопки
Редактировать ,	 - 	и	 Go 	становятся	доступны,	только	когда	медиа-объект	выбран	в	списке.

Ссылки

Вкладка	 Ссылки 	показывает	любые	записи	в	базе	данных	(события	и	т.п.	),	которые	ссылаются	на	это	Место.	Эта	информация	не	может
быть	изменена	из	диалога	 Редактора	Места .	Вместо	этого,	будет	открыта	соответствующая	запись	(к	примеру,	событие	рождения)	и
изменена	ссылка	на	ее	Место.

Place	Name	Editor	dialog

New	Feature	added	in	Gramps	4.2.0

New	Place	Name	editor.	See	What's	new?

Fig.	7.2.12	Place	Name	Editor	dialog	-	default

You	can	access	the	 Place	Name	Editor 	dialog	from	the	 Place	Editor 	dialogs	 Invoke	place	name	editor 	button.

The	 Place	Name	Editor 	dialog	allows	you	to	add/edit	the	following	information:

Name: 	the	name	of	the	place
Date: 	Date	range	in	which	the	place	is	valid

Invoke	the	date	editor 	button
Language: 	Language	in	which	the	name	is	written.	Valid	values	are	two	character	ISO	codes	for	example:	en,fr,	de,	nl.	See	Wikipedia	for
the	full	list	of	valid	ISO	639-1	codes.

Поддерживаемые	форматы	Широты/Долготы
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При	создании/изменении	Места,	возможны	следующие	форматы	Широты/Долготы:

Форматы	Широты	и	Долготы

D.D4
представление	в	градусах,	4	знака	после	запятой

Пример:	+12.0154	,	-124.3647

D.D8
представление	в	градусах,	8	знаков	после	запятой	(точность	как	ISO-DMS)

Пример:	+12.01543265	,	-124.36473268

DEG

представление	в	градусах,	минутах,	секундах

Пример:	50°52'21.92"N	,	124°52'21.92"E	°	-	знак	градуса	в	UTF-8	имеет	код	c2b00a
или	N50º52'21.92"	,	E124º52'21.92"	º	-	знак	градуса	в	UTF-8	имеет	код	c2b00a
Символом	для	секунд	может	быть	либо	одна	двойная	кавычка	",	либо	две	одинарных	'
Буквы	N/S/W/E	могут	находиться	как	до,	так	и	после	цифр.

DEG-
представление	в	градусах,	минутах,	секундах	с	двоеточием	:

Пример:	-50:52:21.92	,	124:52:21.92

ISO-D
ISO	6709	представление	в	градусах,	т.	е.

Пример:	±DD.DDDD±DDD.DDDD

ISO-DM
ISO	6709	представление	в	градусах,	минутах,

Пример:	±DDMM.MMM±DDDMM.MMM

ISO-DMS
ISO	6709	представление	в	градусах,	минутах,	секундах

Пример:	±DDMMSS.SS±DDDMMSS.SS

Редактирование	информации	об	источниках

From	either	of	the	 Sources 	category	views	you	can	select	or	create	a	new	source,	or	if	you	had	chosen	the	 	 + 	or	 	 Edit 	buttons,	then	the
New	Source 	editor	dialog	appears.

New	Source	dialog

Fig.	7.2.13	New	Source	-	editor	dialog	-	example

В	верхней	части	окна	вводится	общая	информация	об	источнике:	его	 Название 	,	 Автор 	,	 Аббревиатура 	и	 Информация	о
публикации .

1.	 Название :	Название	источника.
2.	 Authors :	Автор	источника.
3.	 ID :	уникальная	запись	для	идентификации	источника,	оставьте	для	заполнения	системой.
4.	 Аббревиатура :	Сокращенное	название	для	сортировки,	ведения	картотеки.
5.	 Информация	о	публикации :	Такая	информация	о	публикации,	как	город	и	год	публикации,	имя	издателя,	...

New	Source	tab	pages

На	вкладках	содержатся	следующие	категории	данных	об	источнике:

Заметки

Вкладка	 Комментарии 	служит	для	заметок	или	комментариев	об	источнике.	Для	добавления	заметки	или	исправления	существующей,
просто	отредактируйте	текст	в	поле	ввода.	Только	главные	объекты	могут	отображаться	на	вкладке	 Ссылки :	Лицо,	Семья,	Событие,
Место	или	Медиа-объект.	Второстепенные	объекты,	такие	как	Имена	и	Атрибуты,	отображаются	только	через	главные	объекты,	к
которым	они	принадлежат.
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This	article's	content	is	incomplete	or	a
placeholder	stub.
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Галерея

Вкладка	 Галерея 	позволяет	сохранить	и	отобразить	фотографии	и	другие	медиа-объекты	связанные	с	данным	Источником	(например
фото	свидетельства	о	браке).	В	центре	окна	находятся	список	всех	таких	объектов	и	миниатюры	файлов	изображений.	Другие	объекты,
такие	как	аудио-видео	файлы	и	т.п.	представлены	общим	значком	GRAMPS.	Кнопки	 + 	,	 Выбрать 	,	 Редактировать 	и	 - 	позволяют
добавить	изображение,	добавить	ссылку	на	существующее	изображение,	изменить	существующее	изображение,	и	удалить	ссылку	медиа-
объекта	на	Место.	Обратите	внимание,	что	кнопки	 Редактировать 	и	 - 	становятся	доступны,	только	когда	медиа-объект	выбран	в
списке.

Атрибуты

Вкладка	 Атрибуты 	отображает	пары	"Ключ/Значение"	,	которые	могут	ассоциироваться	с	источником.	Это	схоже	с	"Атрибутами",
используемыми	для	других	типов	записей	в	GRAMPS.	Разница	в	том,	что	Атрибуты	могут	иметь	комментарии	и	ссылки	на	источники,	а
пары	"Ключ/Значение"	-	нет.

В	центре	размещается	список	всех	записей	Данных.	Кнопки	 + 	и	 - 	позволяют	добавить	и	удалить	пару	Ключ/Значение.	Чтобы
изменить	ключ	или	значение,	сначала	выберите	нужную	запись.	Затем	щелкните	ячейку	либо	ключа,	либо	значения	и	введите	текст.	Для
окончания	редактирования,	щелкните	в	любом	месте	вне	ячейки.

Хранилища

Вкладка	 Хранилища 	отображает	ссылки	на	хранилища,	в	которых	содержатся	источники.	Список	можно	упорядочить	по	любому
столбцу:	 ID 	,	 Название ,	 Телефон 	и	 Тип .	Для	просмотра	и	редактирования	записи,	щелкните	по	ней	дважды.	Вы	также	можете
редактировать	ссылку.	Кнопки	на	вкладке	позволяют	добавить	новое,	сделать,	отредактировать	или	удалить	ссылку	на	имеющееся
хранилище.

Select	Repository	selector

Fig.	7.2.14	Select	Repository	-	Selector	Dialog	-	example

The	 Select	Repository 	selector	dialog	allows	you	to	link	to	an	already	existing	repositories	and	once	selected	it	will	be	opened	in	the
Repository	Reference	Editor

You	may	use	the	 Find 	button	to	filter	the	list	based	on	one	of	the	options	from	the	drop	down	list:

Title	contains	(default)

Ссылки

На	вкладке	 Ссылки 	перечислены	все	записи	в	базе	данных,	которые	ссылаются	на	этот	источник.	Список	можно	упорядочить	по
любому	столбцу:	 Тип 	,	 ID 	или	 Название .	Для	просмотра	и	редактирования	записи,	щелкните	по	ней	дважды.

Редактирование	ссылок	на	источники
Ссылка	на	источник	связывает	Источник	с	другим	объектом	и	позволяет	предоставлять	дополнительную	информацию	об	Источнике.	При
добавлении	ссылки	на	источник	к	событиям,	местам	и	т.д.,	открывается	следующий	диалог:

Citations	connect	a	Source	to	another	object	and	allow	you	to	provide	additional	information	about	the	source.	Citations	can	be	attached	to	a	large
number	of	objects,

People	and	various	information	about	people 	(such	as	their	name,	address	etc),
Relationships	(Families)	and	various	information	about	relationships,
Events	and	various	information	about	events,
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

Media	objects	and	attributes	of	media	objects,
Places	and	various	information	about	places,
Addresses	of	repositories.

For	each	object,	a	common	set	of	buttons	are	provided:

	 + 	(Create	and	add	a	new	citation	and	a	new	source).	This	brings	up	an	empty	Citation	dialog.
	 Add 	(Add	an	existing	citation	or	source).	This	brings	up	the	Source	or	Citation	selection	dialog	box.
	 Edit 	(Edit	the	selected	citation).	This	brings	up	the	Citation	dialog	pre-populated	with	the	Citation	and	source	information.
	 - 	(Remove	the	existing	citation).	This	removes	the	citation	from	the	object.	It	does	not	delete	the	citation	itself,	which	could	then	be

connected	to	another	object.

Note	that	the	 	 Edit 	and	 	 - 	buttons	become	available	only	when	a	citation	has	been	selected.

Select	Source	or	Citation	selector

Fig.	7.2.15	Select	Source	or	Citation	-	Selector	Dialog	-	example

When	 	 Add 	adding	an	existing	citation	or	source,	the	 Select	Source	or	Citation 	dialog	appears

This	allows	either	an	existing	source	or	an	existing	citation	(along	with	its	associated	source)	to	be	selected.	Click	on	the	disclosure	triangle
alongside	a	source	to	see	the	citations	associated	with	that	source.	For	example,	if	one	of	your	sources	were	a	book,	then	the	citations	would
normally	refer	to	a	page	(or	pages)	within	the	book.	If	you	already	have	a	citation	that	refer	to	the	particular	page	of	the	book,	then	you	could	select
that	citation	which	would	then	be	shared.	On	the	other	hand,	if	this	object	needs	to	refer	to	a	new	page,	then	you	would	select	the	source	and	in	the
subsequent	dialog	enter	the	new	page.

Use	the	search	field	to	 Find 	a	source	or	citation	based	on	one	of	the	following:

Source:	Title	or	Citation:	Volume/Page	contains(default)
Source:	Title	or	Citation:	Volume/Page	does	not	contain
ID	contains
ID	does	not	contain
Last	Change	contains
Last	Change	does	not	contain

New	Citation	dialog
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Fig.	7.2.16	New	Citation	-	editor	Dialog	-	example

Если	источника,	на	который	Вы	ссылаетесь,	еще	нет	в	базе	данных,	Вы	можете	ввести	его,	нажав	 Создать... 	и	заполнив	диалог
Редактор	Источника .

Citation	information

В	части	диалога	 Информация	о	ссылке 	отображаются	данные	связанные	с	конкретной	ссылкой	на	этот	Источник:	 Достоверность ,
Том/Страница ,	 Дата 	и	 Комментарии .	Вы	можете	выбрать	уровень	достоверности	из	выпадающего	меню	 Достоверность .
Остальные	данные	можно	ввести	в	поля	ввода	текста.

1.	 Дата :	Дата	связанная	с	этой	ссылкой	на	источник.	Обычно	используется	для	записи	даты	внесения	изменения	в	оригинальный
источник.	(Typically	used	to	store	the	log	date	(when	text	was	added	to	the	original	source).)

2.	 Том/Страница :	Конкретное	указание	места	информации,	на	которую	сделана	ссылка.	Для	печатных	работ	это	поле	может
включать	номер	тома	в	многотомных	изданиях	и	номер(а)	страниц.	Для	периодических,	оно	может	включать	том,	издание	и	номера
страниц.	Для	газеты	-	номер	полосы,	номер	страницы.	Для	неизданных	источников,	это	могут	быть	номера	листов,	страниц,	кадров
и	т.п.	Записи	переписей	в	добавление	к	номерам	страниц	могут	иметь	номера	строк,	жилищ,	семей.

3.	 Достоверность :	представляет	количественную	оценку	вероятности	информации	ее	поставщиком,	основанную	на
подтверждающих	доказательствах.	Это	не	исключает	необходимости	оценки	доказательств	получателем	информации.

1.	 Очень	низкая	=	Ненадежные	доказадельства	или	оценочные	данные.
2.	 Низкая	=	Надежность	доказательств	под	вопросом	(опросы,	переписи,	устная	родословная	или	вероятно	искаженные,

например	автобиография).
3.	 Высокая	=	Вторичные	доказательства,	данные	официально	записанные	некогда	после	события.
4.	 Очень	высокая	=	Прямые	и	первичные	доказательства	или	по	преобладанию	доказательств.

A	warning	icon	 	is	displayed	if	the	citation	is	shared.

Совет

Информация	в	этом	диалоге	характерна	для	конкретной	ссылки.	На	каждый	источник	можно
ссылаться	много	раз	и	все	эти	ссылки	будут	иметь	общую	информацию.	Этот	диалог	позволяет
предоставить	данные	характерные	для	конкретной	ссылки,	такую	как	существенные	цитаты,
комментарии,	достоверность,	номера	страниц	и	т.п.	для	более	полного	описания	ссылки.

Select	Source	selector

Fig.	7.2.17	Select	Source	-	Selector	Dialog	-	example

The	 Select	Source 	selector	dialog	allows	you	to	link	to	an	already	existing	source.

You	may	use	the	 Find 	button	to	filter	the	list	based	on	one	of	the	options	from	the	drop	down	list:

Title	contains	(default)
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Citation	information	section	tab	pages

The	tabs	provide	the	following	information	categories	of	citation	data:

Note

The	 Note 	tab	provides	a	place	to	record	notes	or	comments	about	the	citation.	The	central	part	of	the	window	lists	all	notes	for	this	citation,	and
gives	you	a	preview	of	the	beginning	of	the	note.	The	buttons	 	 + ,	 	 Add ,	 	 Edit ,	 	 - ,	 	 Up 	and	 	 Down 	let	you	add	a	new	note,
share	the	selected	note,	edit	the	selected	note,	remove	the	selected	note	and	move	the	selected	note	up	or	down	the	list	of	notes.	Note	that	the	
Add ,	 	 Edit ,	 	 - ,	 	 Up 	and	 	 Down 	buttons	become	available	only	when	a	media	object	is	selected	from	the	list.	Removing	a	note
only	removes	the	note	from	this	citation,	it	does	not	delete	the	note	itself.	Please	refer	to	details	on	editing	notes.

Gallery

The	 Gallery 	tab	lets	you	store	and	display	photos	and	other	media	objects	associated	with	a	given	citation	(for	example,	a	photo	of	a	page	of	a
book	or	a	page	of	a	census).	The	central	part	of	the	window	lists	all	such	objects	and	gives	you	a	thumbnail	preview	of	image	files.	Other	objects
such	as	audio	files,	movie	files,	etc.,	are	represented	by	a	generic	Gramps	icon.	The	buttons	 	 + ,	 	 Add ,	 	 Edit 	and	 	 - 	let	you	add	a
new	image,	add	a	reference	to	an	existing	image,	modify	an	existing	image,	and	remove	a	media	object's	link	to	the	citation.	Note	that	the	 Edit
and	 - 	buttons	become	available	only	when	a	media	object	is	selected	from	the	list.	Please	refer	to	details	on	editing	media	references.

Attributes

The	 Attributes 	tab	displays	"Key/Value"	pairs	that	may	be	associated	with	the	citation.	These	are	similar	to	the	"Attributes"	used	for	other
types	of	Gramps	records.	The	difference	between	these	Key/Value	pairs	and	Attributes	is	that	Attributes	may	have	source	citations	and	notes,	while
Key/Value	data	may	not.

The	central	part	of	the	window	lists	all	existing	Key/Value	pairs.	The	buttons	 	 + 	and	 	 - 	let	you	add	and	remove	pairs.	To	modify	the	text	of
Key	or	Value,	first	select	the	desired	entry.	Then	press	the	 	 Edit 	button	to	select	the	Key,	or	click	in	either	the	Key	or	Value	cell	of	that	entry
and	type	your	text.	When	you	are	done,	click	outside	the	cell	to	exit	editing	mode.

References

The	 References 	tab	lists	all	the	database	records	that	refer	to	this	source,	if	any.	The	list	can	be	ordered	by	any	of	its	column	headings:	 Type 	,
ID 	,	or	 Name .	Double-clicking	an	entry	allows	you	to	view	and	edit	the	record.

Редактирование	информации	о	хранилищах

Once	you	have	selected	a	source,	or	if	you	had	chosen	the	 	 + 	or	 	 Edit 	buttons,	then	the	 New	Repository 	dialog	appears.

New	Repository	dialog

Fig.	7.2.18	New	Repository	-	editor	dialog	-	example

The	following	fields	are	shown:

Name: 	of	the	repository	(where	sources	are	stored).
Type: 	of	repository	can	be	physical	or	virtual	structures	where	genealogical	and	family	history	sources	are	stored:

Album
Archive
Bookstore
Cemetery
Church
Collection
Library(default)
Safe
Unknown
Web	site

ID :	an	unique	record	to	identify	the	repository.	Leave	empty	to	be	generated	by	Gramps.
Record	is	public/private 	Lock	icon	toggle.
Tags:

Edit	the	tag	list
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New	Repository	tab	pages

The	tabs	represent	the	following	categories	of	repository	data:

Addresses

The	 Addresses 	tab	lets	you	view	and	record	the	various	addresses	of	the	repository.

The	bottom	part	of	the	window	lists	all	addresses	stored	in	the	database.	The	top	part	shows	the	details	of	the	currently	selected	address	in	the
list	(if	any).	The	buttons	 + 	,	 Edit 	,	and	 - 	allow	you	to	correspondingly	add,	modify,	and	remove	an	address	record	from	the	database.
Note	that	the	 Edit 	and	 - 	buttons	become	available	only	when	an	address	is	selected	from	the	list.

Internet

The	 Internet 	tab	displays	Internet	addresses	relevant	to	the	repository.	The	bottom	part	lists	all	such	Internet	addresses	and	accompanying
descriptions.	The	top	part	shows	the	details	of	the	currently	selected	addresses	in	the	list	(if	any).	The	buttons	 + 	,	 Edit 	,	and	 - 	let	you
add,	modify,	and	remove	an	Internet	address.	The	"Go"	button	(represented	by	an	icon	having	a	green	arrow	and	yellow	circle)	opens	your
web	browser	and	takes	you	directly	to	the	highlighted	page.	Note	that	the	 Edit 	,	and	 - buttons	become	available	only	when	an	address	is
selected	from	the	list.

Notes

The	 Notes 	tab	provides	a	place	to	record	notes	or	comments	about	the	repository.	To	add	a	note	or	modify	existing	notes	simply	edit	the
text	in	the	text	entry	field.

References

The	 References 	tab	indicates	any	database	records	that	refer	to	a	given	repository.	The	list	can	be	ordered	according	to	any	of	its	column
headings:	 Type 	,	 ID 	,	or	 Name 	.	Double-clicking	an	entry	allows	you	to	view	and	edit	the	corresponding	record.

Редактирование	заметок

Once	you	have	selected	a	source,	or	if	you	had	chosen	the	 	 + 	or	 	 Edit 	buttons,	then	the	 New	Note 	editor	dialog	appears.

See	also:

Notes	Category

New	Note	editor	dialog

Fig.	7.2.19	New	Note	-	editor	dialog	-	example

When	creating	a	new	note,	or	when	editing	an	existing	note,	the	 New	Note 	editor	dialog	appears.	There	are	two	tabs,	the	Note	tab,	and	the
References	tab.

Note	tab

The	 Note 	tab	is	the	place	for	adding	notes	to	People,	Sources,	etc.	The	tab	allows	you	to	re-sequence	notes	in	the	order	you	want	to	see	them.	As
on	the	other	tabs,	you	can	add	new	(note)	records,	share	existing	notes	with	another	object	and	remove	notes	from	this	object.

'Remove'	is	not	the	same	as	'Delete'

Removing	a	note	record	from	the	Note	tab	does	not	delete	the	note	data	from	the	family	tree.	It	remains
present	in	the	Note	category	view	afterwards	but	is	no	longer	linked	with	the	current	object.

Notes	that	are	not	linked	to	any	object	in	the	Tree	may	be	found	in	the	Notes	view	by	searching	for	a	zero
count	in	the	"Notes	with	a	reference	count	of	<count>"	Custom	filter	rule.
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The	Note	tab	has	the	following	elements

A	toolbar	to	apply	styles	to	your	notes.	You	can	select	and	apply	one	of	the	toolbuttons,	or	set	the	values	as	you	want	and	start	typing.

Italic	:	common	function	known	from	text	editors
Bold	:	common	function	known	from	text	editors
Underline	:	common	function	known	from	text	editors
Undo	:	Undoes	last	action.
Redo	:	Re-applies	last	action.
Font	selection	drop	down	list:	a	basic	font	selector	showing	all	fonts	installed	on	your	operating	system.
Font	size:	select	the	size	of	the	font	to	use	for	your	text.
Font	color:	select	the	color	of	your	font.
Background	color:	adds	a	background	color	to	the	text	you	enter.
Link:	Opens	the	 Link	Editor 	allowing	you	to	create	an	internal	link	to	an	item	in	Gramps,	such	as	a	Person,	Family,	Event,
Note,	etc.
Clear	Markup:	Highlight	the	text	to	remove	markup	you	have	placed	on	the	note.

Important

If	you	want	to	revert	to	a	previous	version	of	a	note	after	you	save	it,	there	is	an	Undo/Redo	feature	for
notes	(just	like	other	items).	Go	to	menu	->	Redo,	Undo,	or	Undo	History.

A	context	menu	on	the	textview.

The	most	important	entry	in	this	context	menu	is	the	spell	selection.	You	are	offered	a	selection	of	installed	languages	on	your	system
with	spell	checking	enabled.

The	text	view	where	you	can	write	your	note

Some	properties	of	your	note

Preformatted 	checkbox:	Notes	in	Gramps	are	considered	flowed	for	beautiful	presentation	in	the	reports.	In	this	setting,
newlines	and	white	spaces	will	be	automatically	ignored	so	as	to	form	complete	paragraphs,	which	are	defined	by	an	empty	line
between	two	textblocks.	When	 Preformatted 	is	checked,	Gramps	will	assume	the	whitespace	and	enters	you	used	in	the
notes	are	important.	Use	this	for	tables,	literal	transcripts,	...	.	Use	monospace	font	to	keep	preformatting.	Try	not	to	use
preformatted	if	you	do	not	need	it,	the	reports	you	create	will	be	more	beautiful.
Make	public/private 	Privacy	on	the	other	objects,	you	can	indicate	a	note	as	private	so	as	to	make	sure	you	can	remove
this	note	from	all	output	Gramps	creates	with	one	easy	click.
ID: 	a	unique	id	for	the	note.	If	left	blank	an	automatic	id	will	be	chosen	according	to	the	settings	in	the	preferences
Type: 	(General	default)	The	note	type.	You	can	add	your	own	value	by	typing	it
Tags: 	Select	a	Tag	for	the	note:	Complete,	Todo	etc...	You	can	add	your	own	Tags	by	typing	it

References	tab

The	 References 	tab	indicates	any	objects	that	refer	to	a	given	note.	The	list	can	be	ordered	according	to	any	of	its	column	headings:	 Type ,
ID ,	or	 Name .	Double-clicking	an	entry	allows	you	to	view	and	edit	the	corresponding	record.

HTML	links

If	you	add	links	to	webpages	with	the	full	address	in	a	note,	the	link	will	turn	blue	and	underlined	when
you	hover	your	mouse	over	the	text.	Clicking	the	link	opens	the	webpage	in	your	default	browser.

Редактор	ссылок
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

Fig.	7.2.20	Notes	Editor	-	Linking
text

When	the	Link	button	does	not	respond

A	block	of	Note	text	must	be	highlighted	for	the	Link	Editor	to	be	active.	There	is	no	visual	indicator
when	the	button	is	inactive.

Fig.	7.2.21	Link	Editor	-	dialog	-	example

The	 Link	Editor 	has	the	following	options:

Link	Type: 	allows	you	to	create	an	external	link	to	an	Internet	Address	(URL)	or	an	item	in	Gramps,	such	as	an	Event,	Family,	Media,
Note,	Person,	Place,	Repository,	Source,	or	Citation.

	 Select	Item 	button	:	opens	the	selector	dialog	for	existing	items	in	the	category	specified	in	the	Link	Type.
New 	button

Gramps	item:
Edit 	button	:	opens	the	editor	dialog	for	the	specified	Gramps	item

Internet	Address:

See	also:

Internet	Address	Editor
Note	Link	Report

Note	markup	and	preformat	in	reports

Markup	like	bold,	color,	underline,	...	can	be	added	to	notes.	A	note	can	be	preformatted	or	not.	It	depends	on	the	output	type	how	this	markup	will
appear.	Here	an	overview	is	given	of	what	you	can	expect.

Pdf	and	direct	print	(to	printer	or	to	file)	fully	support	the	markup	and	the	preformatted	setting
ascii	print	removes	all	markup	from	the	notes	for	obvious	reasons
LaTeX	output	interprets	the	markup	to	its	best	of	possibilities.	LaTeX	is	not	well	suited	as	a	typesetting	language	to	add	custom	style.	That
would	break	the	benefits	LaTex	offers.	Hence,	the	following	is	done:

bold,	underline	and	italic	is	supported
fontsize	is	mapped	to	the	size	indicators	of	LaTeX	in	a	fuzzy	manner
mono	fonts	are	shown	as	a	mono	spaced	font
color	and	font	is	not	supported
preformatted	is	handled	correctly

Narrative	Web.	Many	people	use	the	Narrative	Web	report	as	an	easy	way	to	work	with	their	data.	This	report	is	trying	to	respect	markup	in
the	notes.	This	is	an	interpreted	translation,	it	is	not	one-to-one.
ODF	output	does	not	support	markup	at	the	moment.
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RTF	output	does	not	support	markup	at	the	moment.
html	output	does	not	support	markup	at	the	moment.

Note	markup	and	preformat	in	reports

Use	markup	in	notes	only	in	those	cases	it	adds	to	the	information	stored.	Gramps	is	not	a	text	editor.

Пред Содержание След
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

Ввод	и	редактирование	данных:	подробно	-	часть	3

Пред Содержание След

В	предыдущих	разделах	был	проведён	подробный	обзор	ввода	и	редактирования	основных	объектов	Gramps.	В	этом	разделе	будет
продолжен	обзор	других	объектов,	которые	встречаются	в	Gramps.

Редактор	имён
Имена	редактируются	в	 Редакторе	имён доступного	из	 редактора	лиц .	

Name	Editor	dialog

Fig.	7.3.1	Name	Editor	-	Dialog	-	example

The	top	of	the	window	allows	entry	of	the	type	of	name	(e.g.,	Birth	Name,	Married	Name,	etc)	from	a	dropdown	list.	Next	are	elements	of	the
personal	name	most	commonly	grouped	as	Given	Name	elements.	Following	the	Given	Name	section	is	the	Family	Names	section.	At	the	bottom
are	elements	allowing	for	customization	of	name	sorting,	dates	for	names,	name	sources,	and	notes	for	names.	

Type

Type: 	(Birth	Namedefault)	The	Name	type	dropdown	list	allows	you	to	select	the	type	of	name	being	entered.	You	may	also	directly	type
in	your	Custom	type	into	this	field.
Record	is	public/private 	toggle	the	icon	in	the	top	right	corner	to	mark	this	name	record	as	private.	This	will	give	you	a	chance	to
omit	this	name	from	being	included	in	reports	if	you	choose	so	among	the	report	generation	options.

Given	Name(s)	Section

The	Given	Name(s)	Section	contains	all	parts	of	a	personal	name	you	can	store	with	Gramps:

Given: 	The	person's	given	names	should	all	be	entered	here.
Call	Name: 	The	person's	proper	legal	name	that	was	used	most	commonly	by	the	person	should	be	entered	here.	For	example,	someone
named	John	Raymond	Smith	who	uses	the	name	Raymond	should	have	Raymond	entered	here.	If	this	person	uses	Ray	commonly,	this	should
be	entered	as	a	nickname	since	Ray	is	not	the	proper	legal	name	(see	following).	In	Germany	and	some	other	places,	it	was	custom	to
underline	the	call	name	among	the	different	given	names	(see	also	here).
Title: 	The	person's	title,	such	as	Doctor	(or	Dr.)	can	be	entered	here.
Suffix: 	The	person's	name	suffix,	such	as	Junior	(Jr.)	or	III,	should	be	entered	here.
Nick	Name: 	The	person's	nickname	should	be	entered	here.	Nicknames	include	shortenings	of	proper	legal	names	such	as	Greg	for
Gregory	(cf.	Call	Name	above).

Family	Names	Section

The	Family	Names	Section	contains	the	person's	family	name	elements.	Gramps	allows	for	multiple	family	names	as	well	as	multiple	kinds	of
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family	names.

Toolbar	-	+	/	Edit	/	Remove	/	Move	up	in	list	/	Move	down	in	list

The	following	columns	are	shown:

Prefix 	A	prefix	for	the	family	name	that	is	not	used	in	sorting	(such	as	"de"	or	"van").
Surname 	for	the	main	portion	of	one's	family	name.
Connector 	often	used	in	matronymic	or	patronymic	naming	schemes,	such	as	dotter.
Origin 	indicating	the	type	of	family	name	this	is	and	its	derivation.
Primary 	Radiobox	indicating	if	the	family	name	is	the	primary	one.

The	following	field	is	shown:

Family	Nick	Name: 	for	families	commonly	referred	to	using	a	more	vernacular	nickname.

See	also:	Names	in	Gramps	-	wiki	article.	

Name	Editor	tab	pages

Tip

The	tab	labels	reflect	the	presence	of	corresponding	information:	if	the	tab	contains	any	data,	its	label
appears	boldface;	if	the	tab	has	no	data	then	its	label	appears	regular	(not	bold).

General

Options	allowing	you	to	adjust	specific	grouping,	sorting,	and	displaying	properties	of	this	name,	as	well	as	to	provide	the	date	corresponding	to	the
name:

The	 Group	as: 	field	provides	an	alternative	grouping	node	for	a	name	in	the	person	view,	overriding	the	default	grouping	based	on	the
family	name.	This	may	be	necessary	with	similar	family	names	that	need	to	be	grouped	--	for	example	Russian	names	Ivanov	and	Ivanova	are
considered	the	same,	but	the	difference	in	gender	is	reflected	in	different	spelling.	See	Grouping	Surnames.

	 Override 	Check	this	checkbox	to	enable	typing	into	this	field.	(checkbox	unchecked	by	default)

People	are	displayed	according	to	the	name	format	given	in	the	Preferences	(the	default).
Here	you	can	make	sure	this	person	is	displayed	according	to	a	custom	name	format	(extra	formats	can	be	set	in	the	Preferences).

The	 Sort	as 	and	 Display	as 	determine	how	the	name	appears	in	the	People	View	and	the	reports.	The	sort	allows	you	to	override	the
name	pattern	set	in	the	Gramps	preferences	in	the	sorting	of	the	name.	For	example,	you	suddenly	have	a	branch	of	Swedish	names	with
given	and	patronymic,	but	the	rest	of	your	database	sorts	names	on	Family	name,	Given.	You	can	indicate	here	to	sort	this	name	always	as
Patronymic,	Given.

Here	you	can	make	sure	this	person	is	sorted	according	to	a	custom	name	format	(extra	formats	can	be	set	in	the	Preferences).
The	display	allows	you	to	say	how	the	name	is	displayed.	You	might,	for	example,	want	to	sort	a	name	in	a	specific	manner,	but	still	have	the
display	of	the	name	which	can	be	set	in	your	preferences.
The	Person	Tree	view	groups	people	under	the	primary	surname.	You	can	override	this	by	setting	here	a	group	value.	You	will	be	asked	if
you	want	to	group	this	person	only	or	all	people	with	this	specific	primary	surname.

The	 Date 	can	provide	information	on	the	validity	of	this	name	--	use	date	spans	as	necessary.	The	edit	date	icon	opens	the	Date	Editor.	Eg.
for	a	Married	Name,	enter	the	date	that	the	name	is	first	used	or	the	marriage	date.

Source	Citations

The	 Source	Citations 	tab	displays	information	about	sources	and	citations	relevant	to	this	name	and	controls	allowing	its	modification.	The
central	part	displays	the	list	of	all	such	citations	and	sources	stored	in	the	database.	The	buttons	 + 	,	 Edit 	,	and	 - 	allow	you	to	correspondingly
add,	modify,	and	remove	a	citation	to	this	name.	Note	that	the	 Edit 	and	 - 	buttons	become	available	only	when	a	source	reference	is	selected
from	the	list.

More	info:	Citations	editor

Notes

The	 Note 	tab	displays	any	notes	concerning	the	name.	To	add	a	note	or	modify	existing	notes	simply	edit	the	text	in	the	text	entry	field.

More	info:	Note	Editor

Атрибуты
When	you	add	or	edit	an	Attributes	from	the	 Edit	Person 	dialogs	 Attributes 	tab	the	 Attribute	Editor 	dialog	will	be	shown.	

Attribute	Editor	dialog
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Note

Some	predefined	attributes	are	present	because	they	are	defined	in	the	GEDCOM	standard.

Fig.	7.3.2	Attribute	Editor	-	Dialog	-	default

The	top	of	the	window	shows	the	dialog	title	including	the	name	of	the	person	whose	attribute	is	being	edited.	The	central	part	of	the	window
displays	three	notebook	tabs	containing	different	categories	of	available	information.	You	can	bring	any	tab	to	the	top	for	viewing	or	editing	by
clicking	on	the	appropriate	tab	heading.	The	bottom	part	has	 OK 	and	 Cancel 	buttons.	Clicking	the	 OK 	button	at	any	time	will	apply	all	the
changes	made	in	all	tabs	and	close	the	dialog	window.	Clicking	the	 Cancel 	button	at	any	time	will	close	the	window	without	applying	any
changes.

The	top	section	allows	editing	of	the	most	general	information	about	the	attribute:

Attribute: 	(Identification	Numberdefault)	The	name	of	an	attribute	you	want	to	use.	For	example:	Height	(for	a	person),	Weather	on
this	Day	(for	an	event),	...	Use	this	to	store	snippets	of	information	you	collect	and	want	to	correctly	link	to	sources.	Attributes	can	be	used	for
people,	families,	events,	and	media.	The	information	can	be	typed	in	the	appropriate	text	entry	fields.	The	attribute	name	can	also	be	selected
from	available	choices	(if	any)	listed	in	the	 Attribute 	drop-down	menu.
Record	is	public/private 	Toggle	this	to	mark	this	attribute	record	as	private	or	public.	This	will	give	you	a	chance	to	omit	this
attribute	from	being	included	in	the	reports	if	you	choose	so	among	the	report	generation	options.
Value: 	Plain	text	description	entry	of	the	attribute.	Eg.	1.8m,	Sunny,	or	Blue	eyes.

Attribute	Editor	tab	pages

Tip

The	tab	labels	reflect	the	presence	of	corresponding	information:	if	the	tab	contains	any	data,	its	label
appears	boldface;	if	the	tab	has	no	data	then	its	label	appears	regular	(not	bold).

Source	Citations

The	 Source	Citations 	tab	displays	information	about	citations	and	sources	relevant	to	this	attribute	and	controls	allowing	its
modification.	The	central	part	displays	the	list	of	all	such	sources	and	citations	references	stored	in	the	database.	The	buttons	 + 	,	 Edit 	,
and	 - 	allow	you	to	correspondingly	add,	modify,	and	remove	a	source	reference	to	this	attribute.	Note	that	the	 Edit 	and	 - 	buttons
become	available	only	when	a	citation/source	reference	is	selected	from	the	list.

Notes

The	 Note 	tab	displays	any	notes	concerning	the	attribute.	To	add	a	note	or	modify	existing	notes	simply	edit	the	text	in	the	text	entry	field.

Адреса

Используйте	событие	Проживание	для	хранения	информации	об	адресе.

Смотрите	также	Почему	проживание,	а	не	адрес?

При	создании	или	изменении	адреса	в	 Редакторе	лиц 	во	вкладке	 Адреса 	будет	открыт	 Редактор	адресов .	

Address	Editor	dialog
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Fig.	7.3.3	Address	Editor	-	Dialog	-	default

The	 Address	Editor 	dialog	allows	you	to	record	a	current	address	by	recording	the	information	in	the	appropriate	text	entry	fields.

The	top	section	of	the	dialog	allows	editing	and	entry	of	information	about	the	address:

Date: 	Date	at	which	the	address	is	valid.
Invoke	date	editor 	button

Street: 	The	street	of	the	address.
Record	is	public/private 	button.	Toggle	this	button	to	mark	this	address	record	as	private	or	public.	This	will	give	you	a	chance	to
omit	this	address	from	being	included	in	reports	if	you	choose	so	among	the	report	generation	options.
Locality: 	The	locality	name	of	the	address.
State/County: 	The	state	or	county	of	the	address	in	case	a	mail	address	must	contain	this.
City: 	The	village	or	city	of	the	address.
Country: 	Country	of	the	address.
ZIP/Postal	code: 	Postal	code.
Phone: 	Phone	number	linked	to	the	address.

The	bottom	of	the	dialog	has	 Help ,	 Cancel 	and	 OK 	buttons.	Clicking	the	 OK 	button	at	any	time	will	apply	all	the	changes	made	in	all	tabs
and	close	the	dialog	window.	Clicking	the	 Cancel 	button	at	any	time	will	close	the	window	without	applying	any	changes.	

Address	Editor	tab	pages

Interface	Tip

There	is	a	visible	indicator	for	each	tab	in	editor	windows	to	alert	when	there	is	underlying	data	to
explore.	This	can	relieve	the	compulsion	to	visit	empty	tabs	for	simple	confirmation.

The	tab	label	font	styling	reflects	the	existence	of	corresponding	information:	if	the	tab	contains	any
data,	the	tab	label	will	be	in	boldface	and	be	preceded	by	an	icon;	if	the	tab	has	no	data,	then	the	label
appears	in	regular	(plain,	not	bold)	typeface	lacking	the	icon.

The	following	tabs	contain	different	categories	of	available	information.	You	can	bring	any	tab	to	the	top	for	viewing	or	editing	by	clicking	on	the
appropriate	tab	heading.

Source	Citations

The	 Source	Citations 	tab	displays	information	about	sources	relevant	to	this	address	and	controls	allowing	its	modification.	The	central
part	displays	the	list	of	all	such	sources	and	citations	references	stored	in	the	database.	The	buttons	 + 	,	 Edit 	,	and	 - 	allow	you	to
correspondingly	add,	modify,	and	remove	a	citation/source	reference	to	this	address.	Note	that	the	 Edit 	and	 - 	buttons	become	available
only	when	a	source	reference	is	selected	from	the	list.

Notes

The	 Notes 	tab	displays	any	notes	concerning	the	address.	To	add	a	note	or	modify	existing	notes	simply	edit	the	text	in	the	text	entry	field.

Merging	records
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

Fig.	7.3.4	Merge	the	Selected	Persons	-	Toolbar	icon	highlighted	-
example

Sometimes	several	records	in	your	family	tree	turn	out	to	be	describing	the	same	object:	same	person,	same	place,	or	same	citation/source.	It	could
happen	either	when	the	data	is	entered	twice	by	mistake,	or	when	new	information	reveals	that	the	two	entries	refer	to	the	same	person.	It	can	also
happen	after	importing	a	GEDCOM	obtained	from	a	relative,	whose	database	overlaps	with	your	existing	data.

Whenever	you	detect	duplicate	records,	merging	them	is	a	useful	way	of	correcting	the	situation.

To	make	a	merge,	exactly	two	records	have	to	be	selected 	in	the	appropriate	view
(People	View,	Sources	View,	or	Places	View).	This	is	accomplished	by	selecting	one
entry	and	then	selecting	another	person	while	holding	down	the	 Ctrl 	key.
You	will	see	the	 Cannot	merge	people 	warning	dialog	if	you	attempt	to	merge
anything	other	than	two(2)	records.

Merge	People

Merging	people	does	not	discard	any	information.

The	decisions	you	make	during	the	merge	only	affect	which	data	parts	will	become	primary	and	which
will	become	secondary	for	the	resulting	merged	record.

Fig.	7.3.5	Merge	People	-	"Context	Information"	sections	expanded	-
dialog	-	default	example

When	exactly	two	people	are	selected,	choose	Edit	->Merge...	to	invoke	the	 Merge	People 	dialog.

The	dialog	allows	you	to	decide	on	whether	or	not	the	selected	records	should	be	merged.	If	you	decide	that	the	records	should	not	be	merged,
despite	similar	names,	you	may	click	 Cancel 	button	to	close	the	dialog	without	making	any	changes.	Expanding	the	"Detailed	Selection"	and	the
"Context	Information"	fields	on	the	bottom	left	shows	more	information	about	the	people	to	be	merged.
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If	you	decide	to	proceed	with	merging,	select	the	appropriate	 Select 	radio	button	to	specify	the	record	to	be	used	as	the	source	of	primary	data,
then	click	 OK .	The	data	from	the	other	record	will	be	kept	as	alternate	data.

Specifically,	all	names	from	the	other	record	will	become	alternate	names	of	the	merged	record.	Similarly,	parents,	spouses,	and	children	of	the
other	record	will	become	alternate	parents,	spouses,	and	children	of	the	merged	record,	and	so	on.	

Fig.	7.3.6	Merge	People	-	"Detailed	Selection"	&	"Context
Information"	sections	expanded	-	dialog	-	example

Merge	Families

Fig.	7.3.7	Merge	Families	-	dialog	-	default	example

When	exactly	two	families	are	selected,	choose	Edit	->Merge...	to	invoke	 Merge	Families 	dialog.

The	dialog	allows	you	to	decide	on	whether	or	not	the	selected	records	should	be	merged.	If	you	decide	that	the	records	should	not	be	merged,
despite	being	similar,	you	may	click	 Cancel 	to	close	the	dialog	without	making	any	changes.

You	can	either	choose	one	of	the	two	families	to	be	the	source	of	the	primary	data	for	the	new	family,	or	by	expanding	the	 "Detailed	Selection"
field	you	can	individually	choose	which	father	is	the	source	of	the	primary	data,	which	mother	is	the	source	of	the	primary	data,	and	which	family
(selected	by	Gramps	ID)	is	the	source	of	the	other	primary	data.

If	you	decide	to	proceed	with	merging,	choose	the	appropriate	 Select 	radio	button(s)	to	specify	the	source(s)	of	the	primary	data	to	be	used	for
the	merged	family	record,	and	then	click	 OK .	The	children	from	both	marriages	are	merged	into	the	new	family.	The	two	fathers	are	merged	and
the	events	from	the	secondary	father	are	attached	to	the	primary	father.	The	names	from	the	secondary	father	become	alternate	names	for	the
primary	father.	The	same	occurs	with	the	two	mothers.	The	events	related	to	the	secondary	family	(e.g.	marriage	and	any	divorce)	are	transferred	to
the	primary	family.	The	secondary	family	and	the	person	record	for	the	secondary	father	and	mother	are	deleted	from	the	database.	
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Fig.	7.3.8	Merge	Families	-	"Detailed	Selection"	&	"Context
Information"	sections	expanded	-	dialog	-	example

Merge	Events

Fig.	7.3.9	Merge	Events	-	dialog	-	default	example

When	exactly	two	events	are	selected,	choose	Edit	->Merge...	to	invoke	 Merge	Events 	dialog.

The	dialog	allows	you	to	decide	on	whether	or	not	the	selected	records	should	be	merged.

If	you	decide	that	the	records	should	not	be	merged,	despite	similar	titles,	you	may	click	 Cancel 	to	close	the	dialog	without	making	any	changes.

If	you	decide	to	proceed	with	merging,	choose	the	appropriate	radio	button	to	specify:

Type
Date
Place
Description
Gramps	ID

to	be	used	for	the	merged	record,	then	click	 OK 	

Fig.	7.3.10	Merge	Events	-	"Detailed	Selection"	&	"Context
Information"	sections	expanded	-	dialog	-	example
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Merge	Places

Fig.	7.3.11	Merge	Places	-	dialog	-	default	example

When	exactly	two	places	are	selected,	choose	Edit	->Merge...	to	invoke	 Merge	Places 	dialog.

The	dialog	allows	you	to	decide	on	whether	or	not	the	selected	records	should	be	merged.

If	you	decide	that	the	records	should	not	be	merged,	despite	similar	titles,	you	may	click	 Cancel 	to	close	the	dialog	without	making	any	changes.

If	you	decide	to	proceed	with	merging,	choose	the	appropriate	radio	button	to	specify:

Title
Latitude
Longitude
Location
ID

to	be	used	for	the	merged	record,	then	click	 OK .	

Fig.	7.3.12	Merge	Places	-	"Detailed	Selection"	&	"Context
Information"	sections	expanded	-	dialog	-	example

Merge	Sources

Fig.	7.3.13	Merge	Sources	-	dialog	-	default	example

When	exactly	two	sources	are	selected,	choose	Edit	->Merge...	to	invoke	 Merge	Sources 	dialog.

The	dialog	allows	you	to	decide	on	whether	or	not	the	selected	records	should	be	merged.

If	you	decide	that	the	records	should	not	be	merged,	despite	similar	titles,	you	may	click	 Cancel 	to	close	the	dialog	without	making	any	changes.

If	you	decide	to	proceed	with	merging,	choose	the	appropriate	radio	button	to	specify:
Ввод	и	редактирование	данных:	подробно	-	часть	3	-	Merging	records 109

http://www.gramps-project.org/wiki/index.php/File:MergePlaces-dialog-example-default-50.png
http://www.gramps-project.org/wiki/index.php/File:MergePlaces-dialog-sections-expanded-example-50.png
http://www.gramps-project.org/wiki/index.php/File:MergeSources-dialog-example-default-50.png


Title
Author
Abbreviated	title
Publication	information
ID

to	be	used	for	the	merged	record,	then	click	 OK .	

Fig.	7.3.14	Merge	Sources	-	"Detailed	Selection"	&	"Context
Information"	sections	expanded	-	dialog	-	example

Merge	Citations

Fig.	7.3.15	Merge	Citations	-	dialog	-	default	example

When	exactly	two	citations	are	selected,	choose	Edit	->Merge...	to	invoke	 Merge	Citations 	dialog.

The	dialog	allows	you	to	decide	on	whether	or	not	the	selected	records	should	be	merged.

If	you	decide	that	the	records	should	not	be	merged,	despite	similar	titles,	you	may	click	 Cancel 	to	close	the	dialog	without	making	any	changes.

If	you	decide	to	proceed	with	merging,	choose	the	appropriate	radio	button	to	specify:

Volume/Page
Date
Confidence
Gramps	ID

to	be	used	for	the	merged	record,	then	click	 OK .

See	also	the	Merge	Citations...	Tool.	
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Fig.	7.3.16	Merge	Citations	-	"Detailed	Selection"	&	"Context
Information"	sections	expanded	-	dialog	-	example

Merge	Repositories

Fig.	7.3.17	Merge	Repositories	-	dialog	-	default	example

When	exactly	two	repositories	are	selected,	choose	Edit	->Merge...	to	invoke	 Merge	Repositories 	dialog.

The	dialog	allows	you	to	decide	on	whether	or	not	the	selected	records	should	be	merged.

If	you	decide	that	the	records	should	not	be	merged,	despite	similar	titles,	you	may	click	 Cancel 	to	close	the	dialog	without	making	any	changes.

If	you	decide	to	proceed	with	merging,	choose	the	appropriate	radio	button	to	specify:

Name
Type
Gramps	ID

to	be	used	for	the	merged	record,	then	click	 OK 	

Fig.	7.3.18	Merge	Repositories	-	"Detailed	Selection"	&	"Context
Information"	sections	expanded	-	dialog	-	example

Merge	Media	Objects
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Fig.	7.3.19	Merge	Media	Objects	-	dialog	-	default	example

When	exactly	two	Media	Objects	are	selected,	choose	Edit	->Merge...	to	invoke	 Merge	Media	Objects 	dialog.

The	dialog	allows	you	to	decide	on	whether	or	not	the	selected	records	should	be	merged.

If	you	decide	that	the	records	should	not	be	merged,	despite	similar	titles,	you	may	click	 Cancel 	to	close	the	dialog	without	making	any	changes.

If	you	decide	to	proceed	with	merging,	choose	the	appropriate	radio	button	to	specify:

Title
Path
Date
Gramps	ID

to	be	used	for	the	merged	record,	then	click	 OK 	

Fig.	7.3.20	Merge	Media	Objects	-	"Detailed	Selection"	&	"Context
Information"	sections	expanded	-	dialog	-	example

Merge	Notes

Fig.	7.3.21	Merge	Notes	-	dialog	-	default	example

When	exactly	two	notes	are	selected,	choose	Edit	->Merge...	to	invoke	 Merge	Notes 	dialog.

The	dialog	allows	you	to	decide	on	whether	or	not	the	selected	records	should	be	merged.

If	you	decide	that	the	records	should	not	be	merged,	despite	similar	titles,	you	may	click	 Cancel 	to	close	the	dialog	without	making	any	changes.

If	you	decide	to	proceed	with	merging,	choose	the	appropriate	radio	button	to	specify:

Text
Type
Format
Gramps	ID
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to	be	used	for	the	merged	record,	then	click	 OK 	

Fig.	7.3.22	Merge	Notes	-	"Detailed	Selection"	&	"Context
Information"	sections	expanded	-	dialog	-	example

Пред Содержание След
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Navigation

Previous Index Next

As	long	as	any	Family	Tree	database	is	open,	Gramps	is	focused	on	a	single	person	usually	referred	to	as	an	Active	Person.	This	allows	you	to	view
or	modify	the	data	concerning	this	person,	his	or	her	immediate	family,	etc.	Navigating	in	the	Family	Tree	database	(i.e.	moving	from	person	to
person)	is	in	fact	nothing	else	but	changing	the	Active	Person.

This	section	describes	many	alternative	ways	to	navigate	through	the	database	using	both	the	complex	and	the	convenient	interfaces	Gramps
provides.	All	these	ways	fundamentally	accomplish	the	same	result,	but	some	methods	of	navigating	will	be	more	convenient	than	others...
depending	on	what	you	are	doing	in	Gramps	at	the	moment.

Using	the	People	Category
The	most	intuitive	way	to	select	an	Active	Person	is	to	use	the	People	Category.	When	in	the	People	Category,	just	select	the	name	of	the	desired
person	from	the	list	by	clicking	that	list	entry.	The	person	you	have	selected	becomes	active.	The	statusbar	updates	to	reflect	the	change	of	the
active	person.

See	also

Editing	information	about	people

Using	the	Relationships	Category
When	in	the	Relationships	Category,	you	can	easily	navigate	between	the	members	of	the	displayed	family	as	follows:

Click	on	the	underlined	name	of	the	person	you	want	to	go	to	and	this	person	will	be	the	new	active	person	of	the	Relationships	Category.

The	name	of	the	currently	active	person	is	not	underlined.

In	addition	to	this,	Gramps	provides	an	extensive	set	of	keyboard	navigation	options.	The	detailed	reference	to	the	key	bindings	is	found	in	the
Appendix	B:	Keybindings	reference.

Using	the	Families	Category
When	in	the	Families	Category,	you	can	easily	navigate	between	the	displayed	families.

The	Families	can	be	used	to	visually	compare	a	series	of	families	for	possible	duplicates	and	missing	data.	Sorting	on	the	different	columns	allows
putting	similarly	named	Partners	in	close	proximity	allowing	Spouses	to	be	compared.	You	can	match	by	Given	name	or	Nickname	by	temporarily
changing	the	 Name	format: 	option	in	the	 Display	Options 	section	of	Edit	▶	Preferences...	dialogs	 Data 	tab.	As	an	example,	a	name
format	of	Given	Surname	Suffix	would	makes	the	column	sort	on	the	nickname	name.

Merging	two	families	will	not	only	combine	the	Family	secondary	objects,	but	also	simultaneously	merge	the	two	fathers	and	two	mothers.

The	Family	view's	Filter	Gramplet	allows	searching	for	Persons	in	different	family	roles.	So	you	might	look	for	Families	with	a	father	named
"John",	a	mother	named	"Mary"	and	a	child	named	"Thomas".

Using	the	 	Charts	Category
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Fig.	10.1	Timeline	Pedigree	View	-	Third	Party	Addon	for
Charts	Category	-	context	menu	example

Gramps	relies	heavily	on	form-based	layouts	of	linked	list	items.	These	imply	relationships	between	records	in	your	family	Tree.	The	Charts
Category	provides	an	alternative,	more	visual,	way	of	representing	those	relationships.	The	positions,	shapes,	and	colors	of	containers	along	with
their	connecting	lines	&	arrows	can	show	an	extra	depth	of	interrelation	with	different	factors.	Containers	can	be	simple	color	filled	boxes,	arcs,
ribbons,	or	many	other	shapes.

But	the	Charts	Category	also	provides	an	alternative	way	to	navigate	through	the	family	tree.	The	benefit	of	this	method	is	that	you	can	see	more
than	one	generation	of	the	family	tree.	So	you	can	jump	directly	from	a	great-grandson	to	a	great-grandfather	without	going	through	the
intermediate	generations.

Note	that	after	changing	the	Active	Person	in	the	Charts	Category,	the	Chart	View	is	re-adjusted	to	the	newly	selected	Active	Person	focus.	When
in	the	Charts	Category,	you	can	easily	navigate	between	the	members	of	the	displayed	family	tree	as	follows:

To	make	any	displayed	person	the	Active	Person	focus,	left-click	their	corresponding	container.	Right-clicking	the	container	will	invoke	a	context
menu	with	options	appropriate	to	contents.

The	context	menu	for	a	Person	container	may	contain	▶sub-menus	listing	all	spouses,	siblings,	children,	and	parents	of	the	corresponding	Person.
The	first	entry	in	the	context	menu	will	usually	be	the	name	of	the	Person	in	that	container.	(It	could	alternately	be	an	Edit	option.)	Selecting	the
Person	name	will	shift	focus	in	the	same	way	as	left-clicking	the	container.	You	can	also	change	the	Active	Person	focus	to	any	of	the	spouses,
siblings,	children,	or	parents	of	any	displayed	person.

Some	charts	views	have	an	obvious	navigational	correlation.	Moving	through	generations	intuitively	matches	moving	to	the	left,	right,	upwards	or
downwards	in	the	chart.	These	may	have	custom	directional	navigation	buttons	to	allow	navigation	by	clicking	rather	than	dragging.

As	an	example,	to	change	the	focus	of	the	Pedigree	View 	to	a	child	(if	any	exists)	of	the	current	Active	Person,	click	the	 ❮ 	(Left	Arrowhead)
button	to	the	left	of	the	Active	Person’s	chart	box.	If	there	is	only	one	child,	the	focus	changes	immediately.	If	the	Active	Person	has	more	than	one
child,	the	 ❮ 	(Left	Arrowhead)	button	expands	with	a	pop-up	menu	with	a	selectable	list	of	the	children.	(For	this	particular	 ❮ 	(Left	Arrowhead)
button,	the	pop-up	menu	list	of	Children	is	sorted	by	that	Parent‘s	Marriage	order,	sub-sorted	by	Birth	order.	These	orders	can	be	changed	globally
in	the	Relationships	category.)

Advantages	of	using	context	(right-click)	menus

Direct	access	to	spouse	and	siblings.	Complete	lists	of	all	member	of	all	categories,	not	only	the
preferred	members.

Like	containers,	buttons	may	have	alternate	features	accessed	by	right-clicking	and	choosing	from	a	contexual	pop-up	menu.

Other	buttons	are	less	obvious	aids	to	navigating	to	not	People	but	features	of	Gramps.	Using	the	Pedigree	View 	example	again,	rolling	over	the
lines	between	boxes	shows	a	hint	with	any	known	basic	details	about	the	relationship	and	double-clicking	those	lines	opens	the	editor	for	that
Family.	And	double-clicking	the	Active	Person	box	opens	the	editor	for	that	Person.	It	is	well	worth	reading	the	detailed	documentation	on	each
Chart	View	to	discover	these	hidden	shortcuts	to	favorite	features.

The	built-in	Views	of	the	Chart	Category	are	introduced	in	the	Categories	reference	section.	Some	are	described	in	greater	depth	in	articles	listed	at

Navigation	-	Using	the	People	Category 115

http://www.gramps-project.org/wiki/index.php/File:TimelinePedigreeView-Addon-Person-ContextMenu-example-52.png
http://www.gramps-project.org/wiki/index.php/File:Tango-Dialog-information.png


the	bottom	of	the	View’s	introductory	section.

The	collection	of	Views	in	the	Charts	Category	can	be	expanded	with	Third-Party	Addons	using	the	Plugin	Manager	feature	of	Gramps.	The
available	Third-Party	Addon	plugins	can	be	found	under	the	View	column	of	the	list	of	Addons	table.	The	maintenance	of	a	few	Third-Party	Addon
Views	has	been	adopted	by	the	Gramps	volunteer	team	over	the	years.	These	became	'built-in'	after	being	vetted	and	then	included	in	the	main
Gramps	distributions.	Articles	about	using	each	Addon	View	are	linked	to	the	label	Plugin/Documentation	column.	The	quality	of	documentation
varies	dramatically	for	these	articles.

Using	Gramplets

Fig.	10.2	Dashboard	Category	view	-	with	default	Gramplets	shown

On	the	Sidebar	and	bottombar,	you	can	add	Gramplets	to	expand	your	navigation	options	beyond	a	single	generation's	distance.	Some	examples	are:

Relatives
Descendants
Pedigree
Fan	Chart

These	examples	provide	the	ability	to	navigate	the	Active	Person	focus	with	using	the	perspective	of	familial	relationship...	to	nearby	relatives,
descendants	or	ancestors.	Future	Gramplets	might	allow	navigating	by	geographical	proximity,	DNA	matching	or	some	other	connection	we	haven't
yet	considered.

The	text	based	Gramplets	tend	to	have	names	hotlinked	for	navigation	while	the	graphical	ones	may	use	contextual	menus.	

Setting	the	Home	Person
One	(and	only	one)	person	in	the	Family	Tree	database	can	be	designated	as	the	Home	Person.	Once	the	Home	Person	is	designated,	returning	the
Active	Person	focus	to	that	person	becomes	a	matter	of	a	single	click,	regardless	of	which	Category	is	being	used	at	the	moment.

To	set	the	Home	Person,	first	navigate	to	that	person	using	any	method	you	like.	Then	choose	the	People	category	and	select	the	menu	Edit	->Set
Home	Person.	Once	this	is	done,	you	can	move	to	the	Home	Person	from	anywhere	in	the	database	by	simply	clicking	the	Toolbar	 Home 	icon.
You	can	also	choose	the	menu	Go	->Home	or	select	 Home 	item	from	any	context	menu	available	on	the	right	click	or	use	the	keyboard	shortcut
Alt + Home .

Settings#Setting	Home	Person
On	the	Edit	Person	dialog	you	can	select	 Make	Home	Person 	from	the	context	menu.

Setting	the	Active	Person
The	Active	Person	is	expected	to	be	the	contextual	focus	of	actions,	reports	and	edits.	They	are	the	selected	item	in	the	Person	view	or	at	top	of	the
Relationship	view.

The	Active	Person	focus	may	be	selected	directly	or	"navigated"	to	indirectly.	Methods	include:

clicking	on	a	person's	listing	in	the	Person	view
selecting	the	person	from	the	Bookmarks	menu
Using	history-based	Navigation	( Forward 	and	 Back 	toolbar	buttons	and	the	Go	menu)
hotlink	navigation
Context	menus
Notes	as	Navigational	Shortcuts

There	is	a	selection	highlight	as	a	visual	cue	of	the	Active	Person	in	the	People	View.	In	the	Relationship	View,	the	Active	Person	is	shown	in	a
separate	section	at	the	top.	All	other	persons	shown	below	have	an	immediate	(parent,	sibling,	spouse,	child)	relationship	with	the	Active	Person.
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Optionally,	the	Status	Bar	may	set	to	list	the	focus	Object	for	the	View	Category.	(The	Active	Person	is	the	focus	for	several	View	Categories.)

Hotlink	Navigation

Normally,	simply	clicking	on	the	hotlinked	name	of	a	Person	will	select	that	person	and	shift	this	Active	Person	contextual	focus.

Fig.	10.3	Relationships	Category	view

Each	Person's	name	in	the	Person	and	Relationship	category	views	is	a	hotlink.	Changing	the	Active	Person	focus	in	Person	view	appears	to	merely
change	which	record	is	highlighted.	But	this	also	causes	Gramplets	contents	to	be	updated	and	the	Relationship,	Charts	and	Geography	views	to	be
re-focused	on	the	new	Active	Person.

Selecting	a	different	hotlinked	name	in	the	Relationship	category	view	causes	a	less	subtle	change.	The	perspective	of	how	the	family	data	is
represented	changes	towards	that	focus.	Their	details	move	to	the	top	section	and	their	immediate	family	are	re-arranged	below.

Contextual	Menu	Navigation

However,	hotlinked	names	in	the	References	tab	and	Notes	(and	in	some	Gramplets)	will	merely	open	the	Person	Editor	window	without	navigating
the	Active	Person	focus	to	that	Person.	(These	links	behave	as	though	you	had	clicked	an	 Edit 	button	instead	of	a	hotlinked	name.)	This
facilitates	quickly	editing	Persons	around	the	Active	Person	without	the	disorientation	of	a	shifting	focus.

Fig.	10.4	Context	menu	on	the	Person	editor

The	Active	Person	focus	can	be	set	while	in	the	 Edit	Person	dialog 	by	using	the	context	menu	(right-clicking)	in	the	empty	space	of	the
header	area.	The	Make	Active	Person	option	in	that	context	menu	changes	the	Active	Person	focus	to	the	Person	being	edited.	

Using	history-based	Navigation

Fig.	10.5	Example	of	the	history	based	navigation	tools	("Go"	menu)

Gramps	also	features	a	powerful	set	of	history-based	navigation	tools.	These	tools	are	similar	to	those	commonly	used	in	web	browsers.
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They	include	Back	and	Forward	items	available	from	the	Go	menu,	context	menus	and	keybindings	(available	in	People,	Family,	and	Pedigree
Categories),	and	the	 	Back 	and	 	Forward 	toolbar	buttons.	They	also	include	the	list	of	the	recent	selections	available	under	the	Go
menu	that	allows	you	to	jump	directly	to	any	of	the	recent	selections.	Finally,	clicking	on	the	 	Back 	and	 	Forward 	toolbar	buttons	goes
to	previous	or	next	object	in	the	history.	

Gramps_6.0_Wiki_Manual_-_Navigation#Navigation_History

Bookmark	Navigation

The	 Home	button 	on	the	toolbar	is	a	special	case	bookmark.	It	shifts	the	Active	Person	focus	to	the	Person	currently	designated	as	the	 Home
Person.	This	is	so	frequently	useful	that	this	feature	has	the	keybinding	 Alt + Home .

Similar	to	setting	the	Home	Person,	you	can	bookmark	other	people	from	the	database	to	simplify	further	navigation.	To	bookmark	a	person,	first
navigate	to	that	person,	then	choose	the	menu	Bookmarks	->Add	Bookmark	or	use	the	keybinding	 Ctrl + D ,	if	no	person	is	selected	you	will	get
the	 Could	Not	Set	a	Bookmark 	warning.	To	move	to	that	person	elsewhere	in	the	database,	choose	the	menu	Bookmarks	->Person's	name
from	the	list	of	bookmarked	names	shown.	The	other	categories	have	their	own	list	of	Bookmarks.

Organize	Bookmarks	dialog

Fig.	10.6	"Organize	Bookmarks"	dialog	-	example

You	can	manage	your	bookmarks	by	choosing	the	menu	Bookmarks	->Organize	bookmarks...	or	keybinding	⇧	Shift + CTRL + D .	This	opens	the
Organize	Bookmarks 	dialog	with	the	list	of	bookmarks	and	the	controls	to	modify	this	list.

Use	the	 Up 	and	 Down 	buttons	to	change	the	list	sequence.	Use	the	 Remove 	button	to	remove	a	Bookmark.	The	 Help 	will	bring	you	to	this
page,	and	you	close	the	 Organize	Bookmarks 	window	with	the	 Close 	button.

The	list	of	Bookmarked	People	can	be	selected	through	the	People	Category,	as	explained	above,	but	is	also	shared	with	the	Relationships	and
Charts	Categories.

On	a	similar	basis,	separate	lists	of	Bookmarks	are	maintained	in	each	of	the	following	Categories:	Families,	Events,	Places,	Sources,	Citations,
Repositories,	Media,	and	Notes.

Notes	as	Navigational	Shortcuts

Fig.	10.7	Notes	Editor	-	Linking	text

There	are	separate	Bookmarks	lists	in	several	categories.	But	they	are	still	just	simple	lists.	Long	lists	of	bookmarks	quickly	become	unwieldy.

Persistent	Links	can	be	created	in	Notes.	Use	the	Link	Editor	in	Notes	to	organize	navigation	links	to	different	types	of	Gramps	records	following	to
your	own	organization	methods.	Once	a	Note	has	linked	text,	that	linked	record	can	be	used	like	a	Bookmark.	In	Note	Gramplets	where	editing	is
not	active,	clicking	on	the	Link	open	the	Object	Editor	for	that	link.	(It	requires	an	extra	modifier	in	the	Noted	Editor:	navigate	to	that	record	by
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holding	the	 CTRL 	key	and	clicking	on	the	Linked	Text.)	One	note	be	used	as	a	Linked	Index	to	other	Notes	with	different	sets	of	Links.

An	example	of	a	linked	note	might	include	an	obituary	where	all	the	Persons,	Places	or	even	the	Events	are	Linked.	This	makes	it	easier	to	navigate
to	the	indirectly	related	(or	even	unrelated)	pallbearers,	funeral	officiators,	or	attendees.

Another	note	might	be	the	transcribed	bibliography	for	the	published	original	research	of	another	genealogist.	As	you	collect	digital	copies	of	those
originally	cited	references,	the	linked	bibliography	can	be	used	as	a	Source	acquisition	checklist.	When	completely	Linked,	the	Bibliography	can	be
use	to	navigate	through	Sources	for	each	citation	while	searching	for	unsupported	conclusions,	inaccuracies	or	omissions.	

Finding	records

Finding	People

You	may	want	to	first	apply	search	filters	to	reduce	the	size	of	the	list.	The	 search	bar	can	be	used	for
single	term	searches	when	the	gramplets	sidebar	is	not	enabled.	For	more	complex	searches,	gain	access
to	the	multiple	term	filter	controls	by	enabling	the	gramplet	sidebar	(by	choosing	the	View	->	Sidebar
menu)	and	choosing	the	Filter	gramplet	tab.	Select	the	desired	filter	and	click	 Find .	For	details,	see
Filters.

Browse	to	a	record

To	find	a	record	in	one	of	the	category	list	views,	first	switch	to	the	appropriate	category	that	provides	the	list	of	the	desired	records:	People,
Sources,	Places,	or	Media.	Then	scroll	to	the	desired	record.	The	focus	of	the	active	record	for	the	category	is	changed	by	selecting	a	record.	Simply
scrolling	the	view	does	not	change	the	active	record	focus.

By	default,	the	list	will	be	sorted	on	the	first	column	of	the	tabular	data.	The	for	grouped	(People)	or	hierarchical	tree	(Places)	records,	the	first
column	is	required	to	be	the	"Name"	column.	In	the	People,	the	grouping	is	based	on	the	Preferred	Surname.	In	the	Places,	the	Grouping	is	based	on
the	order	of	Enclosing	Places.

The	order	and	display	(or	hiding)	of	columns	change	be	Configured.	A	dialog	appears	after	selecting	the	View	->	Configure...	menu	item;	or,
clicking	the	Configure	button	on	the	Toolbar;	or	using	the	configure	active	view	common	keybinding.

The	list	of	records	in	the	view	can	be	reduced	by	filtering	with	the	Search	Bar	or	the	Filter	gramplet.	

Find	a	Record

Fig.	10.8	Find	people	list	view	using	Interactive	search	type	ahead	-
example

Also	known	as	an	"interactive	type-ahead	search".

Select	a	line	in	the	list	to	gain	focus	and	then	start	typing	information	(contained	in	the	data	of	the	current	Sort	column)	of	a	person	or	the	title	of	a
Source,	Place,	or	Media	object	that	you	are	attempt	to	find,	respectively.	The	focus	will	shift	to	the	first	record	that	matches	the	text	in	the	search
mode	textbox.

Alternatively,	after	clicking	anywhere	in	the	main	view	area	to	gain	focus,	press	 CTRL + F 	(⌘	Cmd + F 	on	macOS)	keybinding	to	turn	on	the
search	mode	textbox.	This	keybinding	is	often	overlooked	since	simply	starting	to	type	is	also	enough	to	both	open	the	box	and	start	entering	the
search	term.

As	you	type,	the	first	matching	record	in	the	sort	column	of	the	list	will	scroll	to	the	center	of	the	list	and	be	selected.	As	you	type	more	characters,
the	match	will	be	refined.	As	long	as	the	search	mode	text	box	is	visible,	pressing	the	⬇ 	down	arrow	cursor	key	will	move	to	the	next	match	while
pressing	the	 ⬆ 	up	arrow	cursor	control	key	will	move	to	the	previous	match.	The	box	disappears	after	it	is	idle.	(When	there	have	been	no
keystrokes	for	between	5	and	15	seconds.)	Without	the	Find	box	active,	the	cursor	control	keys	revert	to	moving	the	records	selection	up	and	down
the	list.

Changing	the	sort	column	(by	clicking	on	the	header)	also	changes	the	column	being	matched.	Finding	in	a	different	sort	column	works	best	in	Flat
List	view	modes.
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People	or	Place	category	view	modes	with	hierarchical	grouped	are	a	bit	less	responsive	than	Flat	List	view	that	are	already	sorted	alphabetically.
The	Grouped	Person	is	the	most	complex	functionality.	By	default,	it	is	sorted	on	the	Grouping	name	then	sub-sorted	on	the	'Name'	column	in	the
'Display	As'	Name	format	from	the	Data	menu	of	Preferences.	That	will	be	the	Preferred/Primary	name	in	"Surname,	Given	Suffix"	format	and	the
"Surname"	includes	the	Prefix	and	Connectors.	However,	the	'Group	as',	'Sort	as',	and	'Display	as'	settings	can	be	used	to	override	the	order	using
the	'Name	Editor.'	

Jump	to	by	Gramps	ID

Fig.	10.9	Jump	to	by	Gramps	ID	-	dialog	-
example

If	you	know	the	ID	for	the	target	record	in	the	currently	active	category,	The	Jump	to	feature	can	be	the	most	efficient	way	to	navigate	to	that
target.

Pressing	the	 CTRL + J 	keybinding	will	show	the	 Jump	to	by	Gramps	ID 	dialog	allowing	you	enter	the	particular	Gramps	ID	in	the	current
View	to	which	you	want	to	make	active.

Jump	to	by	Gramps	ID 	only	searches	for	an	exact	text	match.	The	Gramps	ID	can	either	be	generated	automatically	when	the	ID	field	is	left
blank	when	adding	a	record	or	manually	entered	as	an	override.

It	is	similar	to	Find,	except	that	it	is	not	interactive	and	ONLY	works	on	the	Gramps	ID	field	rather	than	the	column	that	currently	selected	for
sorting.	And	 Jump	to	by	Gramps	ID 	can	change	the	focus	for	the	active	record	in	every	view	category	except	the	Geography	and	Dashboard
categories.

See	also

The	 CTRL + J 	“Jump	to”	Gramps	ID	feature	discussion
GEPS:	Selector	design	proposals

Navigation	History

A	history	of	the	recently	active	records	for	the	focus	the	active	category	is	tracked.	The	last	ten	are	made	accessible	through	the	Go	menu	and	its
keybindings.	Or	you	can	scroll	through	the	focus	history	with	the	 �� 	left	and	�� 	right	cursor	keys.

Using	the	Clipboard

Not	your	ordinary	Clipboard

Note,	that	the	Gramps	Clipboard	doesn't	work	anything	like	a	standard	computer	clipboard.	It	works	like
a	real	clipboard	in	that	you	drag	things	onto	it,	and	drag-copy	them	off.

Clipboard	contents	are	temporary

Clipboard 	storage	is	persistent	within	a	single	Gramps	session.	Closing	the	 Clipboard 	window
will	not	lose	the	stored	records.	However,	exiting	Gramps	will.

If	you	do	need	to	save	items	between	sessions	there	is	a	Third-party	Addon	Collections	Clipboard
Gramplet	that	does.
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Fig.	10.10	Clipboard	-	dialog	-	Showing	Context	menu	(right	click)
example

For	an	application	like	Gramps	the	 Clipboard 	is	very	important	as	it	will	help	reduce	repetitive	data	entry.

The	 Clipboard 	tool	provides	a	temporary	notepad	to	store	database	records	for	easy	reuse	during	a	single	Gramps	session	eg:	until	you	exit
Gramps.	In	short,	this	is	a	sort	of	the	copy-and-paste	functionality	extended	from	textual	objects	to	other	types	of	records	used	in	Gramps.	Clipboard
makes	extensive	use	of	the	drag	and	drop	technique

To	invoke	the	 Clipboard ,	either	choose	the	menu	Edit->Clipboard	or	click	the	Toolbar	 Clipboard 	button	or	use	the	Keyboard	shortcut
(accelerator	key)	 CTRL + B .

Clipboard 	supports	addresses,	attributes	(both	personal	and	family),	events	(both	personal	and	family),	names,	media	objects	references,
citations,	URLs,	and	of	course	textual	information	of	notes	and	comments.	To	store	any	type	of	these	records,	simply	drag	the	existing	record	on	to
the	 Clipboard 	Pad	from	the	corresponding	editor	dialog.	To	reuse	the	record,	drag	it	from	the	Clipboard	on	to	the	corresponding	place	in	the
editor,	e.g.	Address	tab,	Attribute	tab,	etc.

"Ref"	clipboard	objects	include	Shared	Information

Some	objects	show	a	link	icon	in	the	left	column	and	say	'ref'	in	the	label.	This	indicates	that	dragging
such	selection	will	produce	a	reference	to	a	shared	object,	not	link	the	object	itself.	All	the	shared
attributes	will	be	replicated.For	example,	the	media	object	file	will	not	be	duplicated.	Instead,	the
reference	will	be	made	to	an	existing	media	object,	which	will	result	in	the	local	gallery	entry.

Clipboard	context	menu

Selecting	a	record	using	the	context	menu	(right	click)	will	show	the	following	three	options	for	each	record	type:

See	the	[RECORD	TYPE]	details
Make	the	[RECORD	TYPE]	active
Create	Filter	from	the	[RECORD	TYPE]	selected

One	example
You	find	a	birth	certificate	of	a	person.	In	this	certificate	also	the	witnesses	are	mentioned.	And	the	birth	certificate	also	determines	a	source
where	the	information	was	stored.	The	best	way	is	to	open	the	clipboard	and	drag	the	source	you	want	to	work	with	there.	Then	use	drag	and
drop	to	use	it	in	new	items	you	use.

Now	you	can	finalize	the	information	on	the	person	editor	screen.	Drag	that	info	also	to	the	Clipboard.

Now	you	add	two	new	persons	for	the	witnesses	(assuming	you	do	not	have	them	already	in	your	database).	Simply	drag	and	drop	the	birth	info	to
the	witness	event	screen.	You	are	then	presented	with	the	screen	where	you	can	change	the	role	of	the	witness	to	witness	for	this	birth	event.	You
do	the	same	with	the	other	witness.

This	saves	you	a	lot	of	typing	and	possible	errors.
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Using	the	Addon	Manager

Addon	Manager	-	Requires	access	to	the	internet	to	retrieve	the	current	list	of	Addons

See:

Pull	Request	1312	for	introductory	notes	about	developing	the	new	Addon	Manager	feature
(New	in	Gramps	5.2)	
Discourse	thread	about	the	 Requires 	button

Fig.	10.11	Addon	Manager	dialog	showing	the	 Addons 	tab

You	can	access	the	 Addon	Manager 	from	the	menu	Edit	->	Addon	Manager...	or	select	the	 Addons	(Open	Addon	Manager) 	icon	on	the
toolbar	to	show	the	 Addon	Manager 's	 Addons 	tab	window	that	will	list	the	Third-party	addon	plugins	available	based	the	currently	selected
projects	on	the	 Projects 	tab.

Gramps	utilizes	builtin	and	addon	(aka	"add-on")	plugin	(aka	"plug-in")	modules	to	extend	the	capabilities	of	the	core	application.	One	of	the
primary	benefits	of	a	plugin	framework	is	that	it	allows	evolution	of	a	specific	feature	without	needing	to	update	the	entire	program.	Addons	should
not	be	mistaken	for	being	of	lesser	utility	to	basic	users	than	core	features	or	builtin	plugin.	Nor	does	"Third-Party"	mean	an	addon	is	of	lesser
quality.	However,	the	addons	published	to	the	Gramps-Project	GitHub	repository	have	been	vetted	and	will	not	covertly	change	your	Tree	data.

The	Addon	Manager	provides	a	way	to	explore	which	Addons	will	enhance	your	personal	workflows.	And	the	Plugin	Manager	(or	the	Plugin
Manager	Enhanced	addon)	builtin	plugins	provide	a	way	to	customize	Gramps	to	remove	the	clutter	of	features	that	you	do	not	use.

Addon	Manager

The	 Addon	Manager 	shows	the	following	three	tabs:

The	 Addons 	tab	shown	by	default	displays	the	list	of	available	Addons.
The	 Settings 	tab	where	options	can	be	changed
The	 Projects 	tab	where	external	or	local	addon	repository	links	can	be	added.

Addons
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Fig.	10.12	Addon	Manager	dialog	showing	default	filters	while	loading	the	lists	of
available	addons

The	 Addon	Manager 	dialog's	 Addons 	tab	will	show	a	list	of	available	Addons	after	loading	the	lists	from	the	Gramps	Project	Default	server
that	requires	access	to	the	internet;	the	list	can	be	reloaded	by	pressing	the	 Refresh 	button.	The	Addon	Manager	is	available	without	a	Family
Tree	loaded.	The	 Help 	button	will	show	this	section.

The	top	of	window	shows	a	 �	Search 	filter	field	where	you	can	type	any	part	of	the	addons	name	and	the	results	below	will	be
restricted/filtered	to	those	addons	that	match.

Below	the	search	field	you	have	five	addon	 Filters: 	(see:	Addon	list	legend)	and	a	 ⌫	Reset	addon	filters	to	default 	button	to
show	all	results	again:

Installation	status:
All	addons 	-	default
Not	installed
Installed
Updates

Project:	 All	projects 	-	default
Type:	 All	types 	-	default
Audience:	 Everyone 	-	default
Status:	 Stable 	-	default

To	install	the	addon	you	are	interested	in	use	the	various	search	filters	and	then	select	the	Addon	listing	entries	 Install 	button	and	once
installed	the	addons	version	number	will	be	shown	on	the	right	hand	side	of	the	entry	if	all	prerequisite	requirements	if	any	are	met.

You	can	change	the	first	filter	(Installation	status)	from	 All	addons 	to	 Updates 	to	manually	check	for	new	versions	of	your	installed	addons.
Or	you	can	have	Gramps	automatically	check	for	addons	by	using	the	setting	shown	on	the	Third-party	Addons:	Installing	Addons	in	Gramps.

The	Addon	manager	does	not	support	removal,	for	that	you	can	use	the	Plugin	Manager	to	hide	the	addon.

Addon	listing

Fig.	10.13	Addon	Manager	dialog	showing	the	 Addons 	tab	with	addons	installed

Each	addon	listing	shows	the	following	information:

Addon	name
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Second	line	shows	multiple	colored	boxes	with	details:
Left	side:	Project,	Type,	Audience,	Status,	Version
Right	side:	Installed	Version,	of	the	addon	only	shown	if	installed.

Description
Botton	line	may	show	multiple	buttons	depending	on	installation	status:

Left	side:	 Wiki 	button	that	provides	a	link	to	the	addons	support	page,	only	shown	if	available.
Right	side:	 Install 	button.

see:	Addon	list	legend

Settings

Fig.	10.14	Addon	Manager	dialog	showing	default	 Settings 	tab

The	Addon	Manager	dialog's	Settings	tab	has	the	following	two	sections:

General
Scheduled	update	checks

General

Allow	Gramps	to	install	required	python	modules :	Checkbox	un-selected	by	default

Scheduled	update	checks

The	following	setting	only	applies	to	the	 Available	Gramps	Updates	for	Addons 	window.

Check	for	addon	updates: 	Select	the	frequency	that	Gramps	checks	for	updates	to	Addons.
Never	-	never	checks	for	updates	when	you	start	Gramps	(Default)
Once	a	month	-	checks	for	updates	when	you	start	Gramps	once	a	month
Once	a	week	-	checks	for	updates	when	you	start	Gramps	once	a	week
Once	a	day	-	checks	for	updates	when	you	start	Gramps	once	a	day
Always	-	checks	for	updates	whenever	you	start	Gramps

What	to	check: 	so	when	you	check	for	updates,	it	checks	for:
Updated	addons	only	-	does	not	check	for	new	addons
New	addons	only	-	does	not	check	for	updated	addons	(Default)
New	and	updated	addons	-	checks	for	all	new	and	updated	addons

Do	not	ask	about	previously	notified	addons:
	Checked:	Means	that	new/updated	addons	are	only	asked	about	once;	afterwards	it	does	not	show	them	to	you	(Checkbox	selected

by	default)
	Unchecked:	Means	that	new/updated	addons	are	always	shown	to	you.

Check	for	updated	addons	now :	Button	assumes	you	have	an	Internet	connection	and	if	pressed	will	force	a	check	for	Addons	based
on	the	above	settings,	if	Addons	are	available	you	will	then	be	presented	the	 Available	Gramps	Updates	for	Addons 	window	where
you	choose	and	install	them	from.

Available	Gramps	Updates	for	Addons
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Fig.	10.15	Available	Gramps	Updates	for	Addons	dialog	after	checking	for	updated
addons	in	the	 Settings 	tab

The	 Available	Gramps	Updates	for	Addons 	window	you	will	show	a	list	broken	down	by	Type	that	you	can	view	by	selecting	the
Select	column	to	expand	out	each	of	the	top	level	 ▶ 	arrows	to	show	the	listings	under	those	Type	that	will	show	the	Name	and	Description	of	the
Addons.

You	can	then	select	the	check	box	of	those	Addons	you	want	to	install.
Alternatively	but	not	recommended	you	can	use	the	 Select	All 	button.
The	 Select	None 	will	un-select	all	choices.

Then	select	the	 Install	Selected	Addons 	button	to	download	those	Addons	from	the	Internet.
While	downloading	you	will	be	shown	the	 Progress	Information 	window.
Once	downloads	are	completed	from	the	 Done	downloading	and	installing	addons 	dialog	select	the	 Close 	button
From	the	 Preferences 	dialog	select	 Close 	button.
To	use	the	Addons	you	need	to	restart	Gramps,	menu	Family	Trees>Quit.

Progress	Information	window

Addon	Progress	Information	window	-
example

The	Addon	 Progress	Information 	window	is	shown	while	Downloading	and	installing	selected	addons...

If	required	you	may	 Cancel 	the	download.	

Done	downloading	and	installing	addons	dialog

"Done	downloading	and	installing	addons"	dialog	-	example

The	 Done	downloading	and	installing	addons 	dialog	is	shown	once	the	download	is	completed	and	reports	how	many	addons	have
been	installed,	along	with	a	reminder	that	if	you	have	installed	a	'View'	addon	you	will	need	to	restart	Gramps.	Select	the	 Close 	button	to
continue.	
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Projects

Fig.	10.16	Addon	Manager	dialog	showing	default	 Projects 	tab

Where	to	check	for	Addons	either	the	main	Gramps	Project	Default	server:

	Gramps:

https://raw.githubusercontent.com/gramps-project/addons/master/gramps60

Or	any	Gramps	compatible	Addon	servers	that	you	have	added,	the	Other	projects	section	shows	a	list	of	know	external	projects.

Near	the	bottom	left	of	the	Projects	tab	you	have	the	following	options

+ 	-	 Insert a project 	opens	the	 New	Project 	dialog	for	you	to	add	the	project	name	and	URL.
- 	-	 Remove the selected project 	deletes	the	selected	project	lines.	(The	Gramps	default	project	cannot	be	deleted,	but	it	can	be
unselected	so	nothing	is	checked	on	that	server.)
^ 	-	 Move project upwards in the list
v 	-	 Move project downwards in the list
⏎ 	-	 Revert to the project defaults 	opens	the	 Restore	project	defaults 	dialog	where	selecting	 Yes 	removes	all	other
projects.

New	Project	dialog

Fig.	10.17	New	Project	dialog	-	default

The	 New	Project 	dialog	allows	you	to	enter	the	 Project	name: 	and	 URL: 	of	the	external	projects	and	can	also	be	used	for	local	projects.	

Other	Projects

Fig.	10.18	Addon	Manager	dialog	showing	optional	projects	 Projects 	tab

List	of	known	external	other	projects	(copy	and	paste	the	Project	name	and	URL	as	required	to	the	 New	Project	dialog :

Project	name:	Isotammi	project	addons

URL
https://raw.githubusercontent.com/Taapeli/isotammi-addons/master/addons/gramps60

Navigation	-	Using	the	Addon	Manager 126

http://www.gramps-project.org/wiki/index.php/File:AddonManager-Projects-tab-default-60.png
http://www.gramps-project.org/wiki/index.php/File:NewProject-default-dialog-60.png
http://www.gramps-project.org/wiki/index.php/File:AddonManager-Projects-tab-populated-52.png


Summary:	Addon:Isotammi	project

Project	name:	Jean	Michault	tools	for	FamilySearch

URL
https://raw.githubusercontent.com/jmichault/gramps-kromprogramoj/gramps60

Summary:	https://github.com/jmichault/gramps-kromprogramoj	&	PersonFS	gramplet	(FamilySearch)	/	https://github.com/jmichault/gramps-
kromprogramoj/blob/gramps60/ReadMe.en.md

Project	name:	GlopGlop’s	collection	for	France

URL
https://raw.githubusercontent.com/grocanar/glopglop-addons/main/gramps60

Summary:	GedcomforGeneanet	&	ImportGenewebPlus

Project	name:	ztlxltl	experimental	FamilyTreeView	(FTV)	chart	view

URL
https://raw.githubusercontent.com/ztlxltl/FamilyTreeView/dist/gramps60

Summary:	https://github.com/ztlxltl/FamilyTreeView

There	is	a	Discourse	community	support	thread	where	other	"Project"	(or	curated	collections	of	Gramps	addons)	are	listed.

You	can	also	add	local	projects	see	example	screenshot.	

Restore	project	defaults

Fig.	10.19	Restore	projects	defaults	dialog

If	needed	you	can	verify	that	in	the	 Project's	tab	>	Where	to	check 	option	has	the	correct	URL.	To	locate	the	list	of	addons	for	your
current	language	and	version,	it	should	be	set	to:

https://raw.githubusercontent.com/gramps-project/addons/master/gramps60

if	not	select	the	 ⏎	(Revert	to	the	project	defaults) 	button	on	the	Projects	tab.

Using	Undo	History

Fig.	10.20	Menubar	-	Edit	Overview

A	work	session	has	an	Undo	history	to	reverse	transactions.

Three	related	menu	options:

Undo	-	Shows	the	last	change	made	that	can	be	reverted.
Redo	-	Shows	the	last	change	made	that	can	be	reverted.
Undo	History...	-	shows	the	 Undo	History 	dialog.

see	keybindings.
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Various	actions	will	reset	the	sessions	change	history	and	show	the	 Undo	history	warning :

Some	Tools	and	Import	are	batch	transactions	so	the	user	is	warned	before	the	undo	history	is	lost/cleared.
The	menu	option	Family	Trees	>	Abandon	Changes	and	Quit...	undoes	the	Undo	History.
Exiting	Gramps	and	restarting.

See	also:

Session	Log 	Gramplet	-	Keeps	track	of	activity	in	this	session.	It	lists	selected	and	edited	objects.
0001666	undo	history	can	be	invoked,	even	though	it	is	not	possible	to	undo	anything.
0008870:	Remove	"Abandon	Changes	and	Quit"
0012559:	Harmonize	History/logging	features
History:	2006	Gramps	version	2.1.2.	added	New	Undo	History	dialog.	You	can	view	all	the	changes	that	have	been	made,	and	can	select	the
point	to	which	you	would	like	to	undo	(or	redo)	-	Alex[1]

Undo	History	dialog

Fig.	10.21	"Undo	history"	dialog	-	example

Shows	a	list	of	changes	made	so	far	in	the	Undo	History	list	that	allows	you	to	 Undo 	/	 Redo 	/	 Clear 	a	single	transaction.

If	you	select	 Clear 	button	the	 Delete	confirmation 	dialog	is	shown	"Are	you	sure	you	want	to	clear	the	Undo	history?"

The	list	shows	the	"Original	time"	and	"Action"	made	in	each	transaction.

Undo	History	dialog	list	spans	all	objects	modifications.

The	UndoHistory	provides	a	list	view	with	all	the	editing	steps	available	for	undo/redo.	Selecting	a	line	in	the	list	will	revert/advance	to	the
appropriate	step	in	editing	history.

Main	Menus

Fig.	10.22	Menubar	-	Main
Menu	Overview	-	No	Family
Tree	Loaded

The	MenuBar	shows	the	available	Gramps	Menu	options.

Very	abbreviated	menus	will	be	available	before	a	Family	Tree	is	loaded.	They	allow	managing	Family	Trees;	quitting	Gramps;	editing	application-
wide	Preferences;	enabling	and	disabling	sections	of	the	Graphical	User	Interface	(GUI);	and	Help	options.
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"Import"	is	a	Family	Trees	menu	option	that	only	appears	when	a	Family	Tree	has
been	loaded

Gramps	needs	to	have	a	prepared	place	to	import	genealogical	data.	Create	and	load	a	new,	blank	Tree	to
in	order	to	import	data	exported	from	another	Genealogy	tool.	(Such	as	a	GEDCOM	file.)	Data	can	also
be	directly	imported	into	a	Tree	that	already	has	data.	But	make	a	backup	first!

Fig.	10.23	Menubar	-	Main	Menu	Overview	-	Family
Tree	Loaded

After	a	Family	Tree	is	loaded,	the	Family	Trees,	Reports,	Tools	and	Help	menus	will	always	have	consistent	options.	But	the	availability	of
options	of	the	other	menus	is	context	aware.	Options	in	the	Add,	Edit	and	View	menus	change	depending	on	the	active	Category	and	some	menu
items	appear	'dimmed'	when	the	selection	objects	in	the	view	do	not	permit	the	action.	

Fig.	10.24	Menubar	-	Main	Menu	Overview	-	Family	Tree	Loaded
showing	active	"Go",	"Bookmarks"	and	"Windows"	menu	entries	in
use

The	Go	and	Bookmarks	menus	are	specifically	built	of	navigation	links	within	each	view.

A	Windows	menu	appears	when	there	are	any	spawned	windows	or	dialogs	to	be	listed.	
If	available	keybindings	are	shown	in	the	menubar	menus	next	to	the	name	of	the	function.

You	can	also	select	each	of	main	menus	using	the	access	key	shortcuts	of	 Alt 	key,	plus	the	first	left	of	each	menu	option	eg:	Pressing	 Alt 	+
E 	keys	together	will	show	the	Edit	menu.

Family	Trees

Fig.	10.25	Menubar	-	"Family	Trees"	-
overview	example

Manage	Family	Trees...	-	open	the	Family	Tree	Manager	Window
Open	Recent	-	a	shortcut	to	opening	a	recently	worked	on	Family	Tree	(Toolbar:	▼	Connect	to	a	recent	database)
Close	-	backup	and	close	the	current	Tree

Import...	-	Bring	in	data	from	other	formats.
Make	a	Backup	before	importing!	There	are	import	Preferences	to	mark	imported	data	with	timestamped	Tag	and/or	Source	attributes.	These
options	significantly	slow	down	the	Import	process	but	are	helpful	for	the	ensuing	data	cleanup.
Export...	-	Exporting	data	allows	you	to	share	any	portion	of	your	Gramps	Family	Tree	with	other	researchers	as	well	as	to	enable	you	to
transfer	your	data	to	another	computer.

Export	View...	-	Menu	only	appears	on	most	Views,	if	the	displayed	data	can	be	exported.	Gramps	will	export	data	on	screen	according	your
choice:	CSV	or	Open	Document	spreadsheet	format.

Make	Backup...	-	Allows	you	to	make	a	Full	Gramps	XML	backup	of	your	currently	opened	Family	Tree.	Note	some	configuration	and
Media	items	are	omitted	from	XML	backups.
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Abandon	Changes	and	Quit.	-	If	you	want	to	return	your	Family	Tree	to	the	way	it	was	when	you	opened	at	the	start	of	that	session.	(This	is
just	like	quitting	without	saving	in	other	programs.)	You	will	be	shown	the	 Abort	changes? 	alert	dialog.
Quit...	-	Exits	your	Gramps	session	and	may	start	your	Autobackup	if	setup.

Add

Fig.	10.26	Menubar	-	"Add"	(a	new	object)
overview

Add	-	a	new	object
also	see	keybindings.

Person	-	adds	a	 Person	(prim.	obj.)

Family	-	adds	a	 Family	(prim.	obj.)	-	Brings	up	the	 Family	Editor	dialog

Event	-	adds	an	 Event	(prim.	obj.)

Place	-	adds	a	 Place	(prim.	obj.)
Source	-	adds	a	 Source	(prim.	obj.)
Citation	-	adds	a	 Citation	(prim.	obj.)
Repository	-	adds	a	 Repository	(prim.	obj.)
Media	-	adds	a	 Media	(prim.	obj.)
Note	-	adds	a	 Note	(prim.	obj.)

Edit

If	no	family	tree	is	loaded	only	the	Addon	Manager...	and	Preferences...	entries	are	shown.

Fig.	10.27	Menubar	-	Edit	Overview	-
default
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Fig.	10.28	Menubar	-	Edit	-	with	family	tree	loaded

Undo	-	The	last	edit	you	made.	See	Using	Undo	History
Redo	-	Revert	the	last	undo	you	did.	See	Using	Undo	History
Undo	History	-	Open	the	 Undo	History 	dialog

Additional	menu	options	dependent	on	Category	view	will	appear	here.

Tag	-	See	Tagging

Clipboard	-	The	Clipboard	tool	provides	a	temporary	notepad	to	store	database	records	for	easy	reuse.

Addon	Manager...	-	Third-party	addons	management
Preferences...	-	Shows	the	 Preferences 	dialog.	That	allows	you	to	change	most	settings	in	Gramps.
Additional	menu	options	dependent	on	Category	view	will	appear	here.

View

Fig.	10.29	Menubar	-	"View"	-
overview	example

Configure...	-	Allows	you	to	configure	the	active	view.	Provides	options	to	hide,	reveal	and	re-arrange	elements.	The	same	as	clicking	the	

Configure	the	active	view 	button	in	the	Toolbar.
Navigator	-	The	Navigator	is	a	sidebar	container	for	the	Navigator	Category	icons.	When	selected	(default),	the	sidebar	is	shown	on	the	left
of	the	active	View.	Deselecting	hides	the	Navigator	sidebar.	If	all	the	Category	icons	cannot	fit	in	the	available	vertical	space,	a	hidden
scrollbar	will	be	created	on	the	right	of	the	sidebar	and	be	revealed	when	rolled	(hovered)	over.
Text	labels	for	the	icons	can	be	hidden	via	an	option	in	the	Display	tab	of	Preferences.	Display	modes	can	be	selected	from	the	pop-up	menu
at	the	bottom	of	the	Navigator	sidebar.
Toolbar	-	show	(or	hide)	a	split	screen	container	for	(frequently	used)	action	icons	above	the	Category	View.	The	selection	of	action	icons
varies	to	suit	the	Category	view.	
A	Third	party	Addon	can	be	installed	to	supplement	the	Preferences	with	a	Theme	tab	providing	an	option	to	show	Text	labels	for	each
Toolbar	button.
Sidebar	-	Show	(or	hide)	a	split	screen	container	for	Gramplets	to	the	right	of	the	Category	View.
Bottombar	-	Show	(or	hide)	a	split	screen	container	for	Gramplets	at	the	bottom	of	the	window,	just	above	the	Status	Bar.
Full	Screen	-	Expand	window	to	use	all	available	screen	space	while	disabling	the	window	dragging	and	resizing	controls.	Deselecting
restores	to	previous	size	while	re-enabling	the	window	dragging	and	resizing	controls.
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Dependent	on	which	view	is	active,	other	option	menu	items	will	appear	here	that	can	modify	how	the	View	organizes	data.

Go

Fig.	10.30	Menubar	-	"Go"	Overview

Back	-	navigates	the	selection	of	the	current	View	backwards	to	the	previous	item	in	your	Navigation	history
Forward	-	navigates	the	selection	of	the	current	View	forward	to	the	next	item	in	your	Navigation	history

Home	-	navigates	the	Active	Person	focus	to	the	individual	set	as	the	Home	Person

Dynamic	list	of	the	most	recent	10	records	(People,	Families,	et	cetera)	selected,	the	List	is	dependent	on	the	Category	view	being	viewed.

You	can	use	the	third	party	 ‘Restart	where	you	were	last	working’ 	aka	Restore
History	addon

So	that	a	portion	of	the	Go	menu	can	be	made	to	persist	between	restarts	of	Gramps.

Bookmarks

Fig.	10.31	Menubar	-	Bookmarks	Overview

Add	Bookmark	-	Create	a	bookmark	from	the	currently	selected	item	eg:	Person,	Family	etc..
Organize	Bookmarks...	-	Opens	the	 Organize	Bookmarks 	dialog.

...	-	Dynamic	section	where	the	bookmarks	appear.

Reports

Fig.	10.32	Menubar	-	Reports
Overview

Books...	-	The	Books	Report	allows	you	to	create	a	custom	genealogy	book	containing	a	collection	of	Gramps	textual	and	graphical	reports	in
a	single	document	(i.e.	a	Book)
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Graphs...	-
Family	Lines	Graph...
Hourglass	Graph...
Relationship	Graph...

Graphical	Reports...	-
Ancestor	Tree...
Calendar...
Descendant	Tree...
Family	Descendant	Tree...
Fan	Chart...
Statistics	Charts...
Timeline	Chart...

Text	Reports...	-
Ahnentafel	Report...
Birthday	and	Anniversary	Report...
Complete	Individual	Report...
Database	Summary	Report...
Descendant	Report...
Detailed	Ancestral	Report...
Detailed	Descendant	Report...
End	of	Line	Report...
Family	Group	Report...
Kinship	Report...
Note	Link	Report...
Number	of	Ancestors	Report...
Places	Report...
Records	Report...
Tag	Report...

Web	Pages...	-
Narrated	Web	Site...
Web	Calendar...

Tools

Fig.	10.33	"Tools	>..."	Menubar	-
Tools	Overview

Analysis	and	Exploration	-
Compare	Individual	Events...
Interactive	Descendant	Browser...	-

Debug	-
Check	Localized	Date	Display	and	Parser...
Dump	Gender	Statistics...
Generate	Testcases	for	Persons	and	Families...
Populate	Sources	and	Citations...
Python	Evaluation	Window...	-	moved	to	Gramplets
Show	Uncollected	Objects...	-	moved	to	Gramplets

Family	Tree	Processing	-
Edit	Database	Owner	Information...
Extract	Event	Descriptions...
Extract	Information	from	Names...
Extract	Place	Data	from	Place	Title...
Find	Possible	Duplicate	People...
Fix	Capitalization	of	Family	Names...
Merge	Citations...
Rename	Event	Types...
Reorder	Gramps	IDs...
Sorts	events...

Family	Tree	Repair	-
Check	and	Repair	Database...
Rebuild	Gender	Statistics...
Rebuild	Reference	Maps...
Rebuild	Secondary	Indices...
Remove	Unused	Objects...

Utilities
Media	Manager...
Not	Related...
Relationship	Calculator...
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Verify	the	Data...

Windows

Fig.	10.34	Menubar	-	"Windows"	menu	-	overview	example

Windows	-	This	menu	provides	quick	access	to	opened	windows	you	are	working	on.

Help

Fig.	10.35	Menubar	-	"Help"	-
overview	example

User	Manual	-	Direct	link	to	the	online	Gramps	User	manual	you	are	viewing	right	now.	Yes,	you	need	an	internet	connection	to	consult	the
Gramps	User	Manual.
FAQ	-	A	link	to	the	Frequently	Asked	Questions	about	Gramps.
Key	Bindings	-	A	link	to	the	Keybindings	reference	for	Gramps.	Also	known	as	Keyboard	shortcuts.
Tip	of	the	Day	-	Displays	a	dialog	with	a	random	hint	about	using	the	Gramps	software.
Plugin	Manager	-	From	this	menu	you	can	manage	the	built	in	plugins	as	well	as	any	Third-Party	Addons	you	may	have	installed.

Gramps	Home	Page	-	This	item	opens	your	web	browser	and	connects	to	the	Gramps	project	web	site.
Gramps	Mailing	List	-	This	item	opens	your	web	browser	to	the	Gramps	mailing	list	page.	On	this	page,	you	can	browse	the	mailing	list
archives	and	join	the	gramps-users	mailing	list	so	you	can	share	your	experiences	with	other	Gramps	user's.
Report	a	Bug	-	Choose	this	item	to	file	a	bug	report	in	the	Gramps	bug	tracking	system.	(This	requires	you	to	have	a	registered	account	on
the	Gramps	bug	reporting	system)	(Remember,	Gramps	is	a	living	project.	We	want	to	know	about	any	problems	you	encounter	so	we	can
work	to	solve	them	for	you	and	everyone	elses	benefit.)
Extra	Reports/Tools	-	A	link	to	Installing	Third-Party	Addons	in	Gramps.

About	-	This	item	displays	a	dialog	with	general	information	about	the	Gramps	version	you	are	running.

Toolbar

Fig.	10.36	Tip	for	the	Tools	button	of	the	Dashboard	category
toolbar

The	Toolbar	is	a	horizontal	set	of	button	controls	located	right	below	the	menubar.	It	gives	you	access	to	the	most	frequently	used	functions	of
Gramps.

The	assortment	of	Toolbar	buttons	is	"contextual"	--	the	icons	shown	depends	on	which	Category	view	and	view	mode	is	active
Text	labels	are	shown	under	the	toolbar	buttons.
Hovering	over	a	toolbar	button	shows	a	tip	of	its	function.
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The	Toolbar	can	be	hidden	or	revealed	by	the	option	in	menu	View	->Toolbar.

Common	Toolbar	buttons

	Manage	databases

Fig.	10.37	Family	Trees
(Manage	databases)	-	icon	and
tooltip	on	toolbar

The	 	button	is	the	same	as	the	Family	Trees	▶	Manage	Family	Trees...	menu	option.	The	resulting	dialog	allow	switching	between	Trees
(genealogical	databases),

▼	Connect	to	a	recent	database

Fig.	10.38	"Connect	to	a	recent
database"	toolbar	button

This	▼	button	opens	Family	Trees	▶	Open	Recent...	drop-down	list	from	the	toolbar.

See:	▼	Connect	to	a	recent	database	section.	

	Go	to	the	previous	object	in	the	history

The	 	toolbar	button	is	an	alternative	to	the	Go	▶	Back	menu	option,	or	pressing	the	Back	keyboard	keybinding.	It	uses	the	history	based
Navigation	to	shift	the	active	object	focus	to	the	previously	selected	object	in	this	category.

	Go	to	the	next	object	in	the	history

The	 	toolbar	button	is	an	alternative	to	the	Go	▶	Forward	menu	option,	or	pressing	the	Forward	keyboard	keybinding.	It	uses	the	history	based
Navigation	to	restore	the	active	object	focus	shifted	with	the	Go	▶	Back	feature.

This	button	is	only	available	after	using	the	Go	▶	Back	feature.

	Go	to	the	home	person

The	 	toolbar	button	is	an	alternative	to	the	Go	▶	Home	menu	option,	or	pressing	the	Home	keyboard	keybinding.	It	shifts	the	Active	Person
focus	to	match	the	Home	Person.

This	button	is	only	functional	if	the	Home	Person	has	been	set.

	Add	a	new...
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The	 	toolbar	button	is	an	alternative	to	the	Edit	▶	Add..	menu	option,	or	pressing	the	Add	keyboard	keybinding.	It	opens	a	blank	Object	Editor
matching	the	object	category	of	the	current	view.

	Edit	the	selected...

The	 	button	is	an	alternative	to	the	Edit	▶	Edit...	menu	option,	or	pressing	the	Edit	keyboard	keybinding.	It	opens	an	Object	Editor	for	each
selected	object	in	the	category	view.

	Delete	the	selected...

The	 	toolbar	button	is	an	alternative	to	the	Edit	▶	Delete	menu	option,	or	pressing	the	Delete	keyboard	keybinding.	It	opens	a	Delete
confirmation	dialog.

The	item	that	is	about	to	be	deleted	is	identified.	If	multiple	items	were	selected,	a	dialog	appears	for	each.	A	checkbox	option	offers	to	"Use	this
answer	for	the	rest	of	the	items".

	Merge	the	selected...

This	toolbar	button	is	an	alternative	to	the	Edit	▶	Merge...	menu	option.	It	opens	the	Merge	dialog	for	that	particular	category	of	records.

Successful	use	of	the	Merge	button	is	only	possible	if	two	(and	only	2)	records	are	selected	in	the	view.

	Tag	the	selected	rows

This	toolbar	button	is	an	alternative	to	the	Edit	▶	Tag	submenu.

The	 	button	reveals	a	pop-up	menu	with	the	following	Tag	options:

New	tag...
Organize	tags...

Followed	by	a	list	of	currently	available	tags	that	can	be	applied	to	the	selected	objects	in	the	view.

Tags	are	used	for	color	coding	rows	in	list	views,	marker	swatches	on	some	charts,	and	persistent	markers	for	filtering	and	organization.

	Open	the	Clipboard	dialog

Fig.	10.39	Clipboard	-	dialog	-	showing	(right	click)	Context	menu

This	toolbar	button	is	an	alternative	to	the	Edit	▶	Clipboard	menu	option,	or	pressing	the	Clipboard	keyboard	keybinding.	It	opens	the	Clipboard
dialog	without	adding	the	selected	object	to	its	collection.	

	Configure	the	active	view

This	toolbar	button	is	an	alternative	to	choosing	the	View	▶	Configure...	menu	option,	or	pressing	the	Configure	active	view	keyboard	keybinding.

Most	Category	views	have	a	⚙	Configurable	Options.	Clicking	this	button	opens	the	dialog	with	the	controls	for	adjusting	those	options.

This	option	opens	a	dialog	with	choices	for	displaying	records	in	the	View.	(The	dialog	will	also	have	tabs	for	any	Gramplets	which	have
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configurable	options	that	are	active	in	the	view.)

	Open	the	reports	dialog

Fig.	10.40	Report	Selection	-	dialog

This	is	a	persistent	alternative	to	using	the	Reports	submenus.

By	presenting	the	available	Reports	in	a	floating	dialog,	room	is	available	for	describing	each	Report,	its	status	and	contributing	developer
information.	The	dialog	also	allows	exploration	of	Reports	to	be	more	structured.	

	Open	the	tools	dialog

Fig.	10.41	Tool	Selection	-	dialog

This	is	a	persistent	alternative	to	using	the	Tools	submenus.

By	presenting	the	available	Tools	in	a	floating	dialog,	room	is	available	for	describing	each	Tool,	its	status	and	contributing	developer	information.
The	dialog	also	allows	exploration	of	Tools	to	be	more	structured.

	Open	Addon	Manager

Fig.	10.42	Addon	Manager	dialog	example

Edit	->	Addon	Manager...	-	The	Addon	Manager	provides	a	way	to	explore	which	Addons	will	enhance	your	personal	workflows.
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	Open	Preferences

Fig.	10.43	Menu:	"Edit	->	Preferences..."	example

Edit	->	Preferences	-	Most	of	the	settings	affecting	the	entire	Gramps	program	are	configured	in	the	Preferences	dialog.
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Plugin	Manager
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The	 Plugin	Manager 	dialog	allows	you	to	control	how	Gramps	manages	plugins	and	Third-party	Addons.	Gramps	consists	of	a	core	plus	many
plugins.	When	Gramps	starts,	the	core	is	loaded	and	only	a	limited	number	of	plugins	are	loaded.	This	decreases	the	startup	time	and	memory
requirements	of	Gramps.	Subsequently,	many	plugins	are	automatically	loaded	by	Gramps	as	they	are	needed,	so	that	many	users	will	not	need	to	be
aware	of	the	existence	of	plugins,	or	their	delayed	loading.

The	 Plugin	Manager 	dialog	is	available	from	the	menu	Help	->Plugin	Manager.	Many	of	the	features	of	the	Plugin	Manager	are	intended	for
developers,	and	the	dialogues	described	below	are	those	seen	by	developers.	The	features	for	normal	users	are	noted	below	where	they	are	different.

Registration	and	loading
Plugins	are	either	held	locally	on	the	computer	and	are	known	about	by	Gramps,	when	they	are	said	to	be	 Registered,	or	they	are	held	on	a	remote
computer	and	Gramps	only	knows	their	name,	type	and	description,	when	they	are	said	to	be	Addons.

When	Gramps	starts,	information	is	automatically	read	about	the	local	plugins,	so	that	they	become	registered.	The	Addon	Manager	can	be	used	to
download	remote	Addons	so	that	they	too	become	registered.

Registered	(i.e.	local)	plugins	are	loaded	by	Gramps	in	the	following	situations:

1.	 they	are	automatically	loaded	at	startup.	Some	plugin	types	are	loaded	at	startup	(e.g.,	non	hidden	views),	some	plugins	can	have	a	flag	that
forces	load	on	startup,

2.	 they	are	automatically	loaded	by	virtue	of	the	user	clicking	on	a	view	or	requesting	a	report,
3.	 they	are	loaded	by	the	user	explicitly	requesting	load	in	the	plugin	manager,
4.	 remote	plugins	are	loaded	at	the	same	time	as	they	are	registered	by	using	 Install	Addons	with	the	menu	Edit	->	Addon	Manager....

Plugin	Manager	dialog
The	 Plugin	Manager 	dialog	allows	you	to	control	how	Gramps	manages	plugins	and	Third-party	Addons	there	are	two	tabs	for	the	dilaog:

Registered	Plugins 	and
Loaded	Plugins

You	may	also	replace	the	builtin	 Plugin	Manager 	dialog	with	the

Third-party	Plugin	Manager	Enhanced	Addon	that	provides	a	single	unified	view	that	combines	the
Registered	and	Loaded	views	with	all	the	available	Third-party	Addons/plugins

Registered	Plugins

Fig.	11.1	"Registered	Plugins"	tab	(developer	mode)

Here	you	see	a	list	of	all	plugins	that	Gramps	has	found.	These	are	the	plugins	which	are	part	of	Gramps,	as	well	as	the	plugins	found	in	the
gramps60/plugins	directory	within	the	Gramps	User	Directory.	The	type	of	plugin	is	shown	in	the	first	column.

You	can	show	or	hide	a	plugin	by	selecting	a	row	and	pressing	the	 Hide/Unhide 	button.	This	is	only	useful	for	the	User	Plugins.

By	selecting	a	row	and	double	clicking	or	pressing	the	 Info 	button	you	will	be	shown	the	 Detailed	Info 	dialog.

Use	the	 Close 	button	to	exit.	The	 Reload 	button	....	does?

In	developer	mode	two	additional	buttons	are	shown	they	are:

Edit 	-	Which	will	load	the	selected	rows	source	code	file	in	your	associated	text	editor.
Load 	-	Forces	a	reload	the	selected	plugin/addon.
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Loaded	Plugins

Fig.	11.2	"Loaded	Plugins"	tab	(developer	mode)

Here	you	see	a	list	of	all	plugins	that	have	been	attempted	to	be	loaded.	Normally,	all	views	(such	as	the	Relationship	View)	will	be	loaded,	and	all
gramplets/reports/tools	you	have	used	will	be	loaded	automatically.

If	there	was	an	error	during	the	loading	of	a	plugin,	then	the	Status	column	will	be	shown	in	this	tab.	Double	clicking	a	row	showing	a	failure	opens
the	 Detailed	Info 	dialog	showing	the	error	in	detail.	You	can	use	this	to	contact	the	plugin	author	or	the	Gramps	bug	list.

Later	if	you	decide	that	you	do	not	like	an	Addon,	you	can	mark	it	"hidden"	and	it	will	no	longer	show.

You	can	show	or	hide	a	plugin	by	selecting	a	row	and	pressing	the	 Hide/Unhide 	button.	This	is	only	useful	for	the	User	Plugins.

By	selecting	a	row	and	pressing	the	 Info 	button	you	will	be	shown	the	 Detailed	Info 	dialog.

Use	the	 Close 	button	to	exit.

In	developer	mode	two	additional	buttons	are	shown	they	are:

Edit 	-	Which	will	load	the	selected	rows	source	code	file	in	your	associated	text	editor.
Load 	-	Forces	a	reload	the	selected	plugin/addon.

Actions

Hide/Unhide

The	 Plugin	Manager 	dialog	can	be	used	to	hide	or	unhide	plugins.	Some	menus	will	not	display	hidden	addons,	so	that	the	addon	cannot	be
selected.	For	example,	if	a	Gramplet	is	hidden,	then	it	will	not	appear	in	the	Add	a	gramplet	context	menu	which	appear	when	right	clicking	the
background	of	the	Gramplets	main	tab.	However,	hiding	some	addons	(such	as	Relationships	or	Gramps	Views)	has	no	effect	and	may	not	even	be
allowed.

Detailed	Info	dialog

Fig.	11.3	"Detailed	Info"	dialog	-	example	with	context	menu

The	 Detailed	Info 	dialog	will	display	information	about	the	selected	plugin/Addon.	A	context	menu	is	available	to	copy	and	paste	information
as	required.	You	can	use	this	to	contact	the	plugin	author	or	report	an	issue	to	the	Gramps	bug	tracker
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Plugin	name:
Description:
Version:
Authors:
Email:
Filename:
Location:

Plugin	types
There	are	two	main	categories	of	plugins	in	Gramps:	User	Plugins	and	System	plugins.	User	Plugins	are	those	that	you	use	and	control	to	provide
different	functionality	for	you.	The	System	Plugins	are	used	by	Gramps.

There	are	many	plugins	that	come	with	Gramps.	However,	anyone	can	also	write	a	plugin	and	share	it.	These	third-party	plugins	are	called
"addons".	We	highly	encourage	users	and	developers	to	share	their	creations	with	other	Gramps	users.

See	also:

Addon_list_legend#Type
Addons	development

Addons_development#What_can_addons_extend.3F

User	Plugins

The	following	types	of	User	Plugins	are	present	in	Gramps:

1.	 doc	creators :	Backends	for	which	Gramps	can	write	reports	(pdf,	odf,	ascii	text,	...)
2.	 exporters :	export	formats	you	can	export	your	data	too	via	menu	Family	Trees	->	Export...
3.	 gramplets :	small	programs	you	can	embed	in	the	Dashboard	View,	or	detach	and	use	as	a	normal	window
4.	 gramps	views :	the	views	visible	in	the	main	window	of	Gramps
5.	 importers :	import	formats	from	which	Gramps	can	import	data	via	menu	Family	Trees	->	Import...
6.	 map	service :	targets	that	can	be	used	on	the	place	view	to	go	to	an	internet	map	service	(Go	toolbar	button)
7.	 quickreport :	know	as	Quick	Views	they	are	small	reports	that	are	available	in	the	context	menu	on	the	listviews,	or	via	the	Quick	View

gramplet
8.	 reports :	Textual	or	graphical	reports	Gramps	can	produce
9.	 tools :	Tools	you	can	start	via	the	menu	Tools

System	Plugins

The	following	types	of	System	Plugins	are	present	in	Gramps:

1.	 database :	Backends	that	allow	Gramps	to	support	alternate	database	types.
2.	 plugin	libs :	libraries	that	are	present	giving	extra	functionality.
3.	 relationships :	relationship	calculators	for	different	languages
4.	 rule :	rules	for	custom	filters
5.	 cite :	Citation	formatter
6.	 thumbnailer :	thumbnail	generation	for	previews	of	media

User	mode	or	Developer	mode
Gramps	detects	whether	it	is	being	run	in	User	mode	or	Developer	mode	by	the	'optimise'	 Python	option	flag:

python	-O	gramps.py

See	Debugging	Gramps.	
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Gramplets

Previous Index Next

This	page	details	the	functionality	of	the	Gramplets	that	come	with	Gramps.

For	more	Gramplets

that	you	can	extend	your	Gramps	functionality	with,	see	Third-party	Addons.
For	technical	details	about	creating	your	own	Gramplet,	please	see	Gramplets	for	Developers.

What	is	a	Gramplet?

Fig.	12.1	Dashboard	Category	view	(default	gramplets)

A	Gramplet	is	an	expansion	to	the	Gramps	program	that	ideally	works	seamlessly	as	if	it	was	a	core	feature.	They	actually	become	embedded	as
part	of	Gramps.	But	while	the	core	features	of	a	view	are	needed	almost	constantly,	the	bundled	Gramplets	extend	the	view	in	ways	that	are	only
needed	occasionally.	Gramplets	provide	a	supplemental	perspective	of	the	Tree	data	which	either:	changes	dynamically	during	the	navigation	of	the
Gramps	Tree,	or;	provides	interactivity	to	your	genealogical	data.

Gramplets	are	the	division	of	plug-ins	(also	called	widgets,	plugins,	addons,	auxiliary	components)	that	can	be	found	in	the	Dashboard	Category
...	or	the	Sidebars	and	Bottombars	in	other	Navigator	View	Categories.	They	provide	all	kinds	of	functionality	that	can	be	useful	for	the
researcher.

A	selection	of	builtin	plugins	are	bundled	and	pre-installed	with	Gramps.	The	Gramps	project	hosts	a	selection	of	addon	plugins	that	might	only	be
of	interest	to	certain	audiences.

There	are	also	third-parties,	such	as	The	Taapeli	Project	in	Finland,	who	hosts	their	own	selection	of	Isotammi	group	addon	plugins	developed	to
tune	Gramps	for	their	needs.	Members	of	the	Gramps	community	also	share	special	purpose	addons	privately	or	via	GitHub	repositories.	And,	of
course,	users	are	invited	to	develop	their	own	addons.

Performance	Drain

Gramplets	can	slow	down	Gramps	and	can	use	a	lot	of	memory.
Close	any	docked	Gramplets	that	will	not	be	of	immediate	use.	(It	is	not	necessary	to	uninstall	them	with
the	Plugin	Manager.)	Closed	Gramplets	can	be	re-added	to	a	Gramplet	Bar	or	the	Dashboard	as	needed.

Aren't	all	Plugins	also	Gramplets?

What	is	the	difference	between	Gramplets,	reports,	quick	views,	and	tools?

All	of	these	are	plugin	types.	But	Gramplets	are	subtype	of	plugins	with	more	emphasis	on	the	user	interface.	Gramplets	add	a	 capability	or	a
different	perspective	to	the	View.	They	can	be	used	to	improve	the	workflow	of	a	View.

The	other	plugins	tend	to	interrupt	the	normal	workflow	to	do	another	task.	They	also	tend	to	be	used	more	intermittently.	A	plugin	might	generate	a
static	(even	when	hot-linked)	snapshot	of	the	data,	be	a	way	of	doing	mass	change,	or	provide	an	alternative	import/export/output	system.
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

Some	common	Plugin	types	are:

Reports	-	provide	a	static	output	format	of	your	data,	typically	for	presentation
Quick	Views	-	provides	a	typically	short,	interactive	listing	derived	from	your	data
Tools	-	provide	a	method	of	processing	your	data
Gramplets	-	provide	a	dynamic	view	and	interface	to	your	data.

A	deeper	understanding	of	the	different	types	of	plugins	can	be	gained	by	sorting	the	Addon	List	by	Type	and	exploring	the	contrasting
Descriptions.

Some	of	the	more	static	types	of	plugins	can	be	extended	to	work	dynamically	as	a	Gramplet.

Several	plugins	have	evolved	into	multiple	types.	Some	plugins	are	shells	which	layer	extra	capabilities	around	other	plugins.	The	Quick	View
Gramplet	is	not	a	type	of	Quick	View	plugin.	Instead,	it	is	a	dockable	shell	that	shows	a	Quick	View	plugin	and	pushes	the	plugin	to	refresh	as	the
context	changes.

Tip:	Configure	the	Quick	View	Gramplet	

Use	the	Configure	button	to	change	which	Quick	View	plugin	will	be	displayed	from	the	any	of	the
various	Navigator	categories.

Starting	with	Gramplets

When	you	first	start	the	Dashboard	Category	you	will	see	two	default	Gramplets;	the	 Welcome	to	Gramps! 	Gramplet	and	the	 Top	Surnames
Gramplet .

The	Dashboard	and	Gramplet	Split	Bars	of	the	Navigator	Categories	may	have	common	and	specific	Gramplets.

Common	Gramplets	are	applicable	to	any	View	...	and	the	data	viewpoint	is	with	respect	to	the	Context	of	the	Active	Person	and/or	the	Home
Person.	They	can	be	docked	on	any	Navigator	Category	View	without	making	that	View	seem	ambiguous.
Specific	Gramplets	need	the	context	of	particular	Views	to	give	context	to	their	perspective	of	the	data.	The	list	in	the	Dashboard's	Add	a
Gramplet	submenu	and	the	 ∨ 	Gramplet	Bar	Menu	will	differ	according	active	Category	view	and	Gramplets	installed.

This	list	is	leftover	from	an	earlier	revision	of	the	wiki.	It	is	unclear	where	the	items	fit	in	this	discussion.

Back	references	Gramplets	-	provide	immediate	visibility	to	data	that	tends	be	viewed	occasionally	and	is	buried	in	the	interface...	like	the
references 	tab	on	object	Editor.
Filter	Gramplet	is	like	the	previous	filter	sidebar
Common	models	for	Notes,	Gallery,	Sources,	Citations,	Events
Children	Gramplet	on	Person	views	(also	charts	category	and	relationships	category),	families	view

General	Usage	and	Configuration
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Fig.	12.2	Dashboard	Welcome	Gramplet

The	container	controls	for	Gramplets	are	arranged	a	little	differently	in	the	Dashboard	category	View	as	opposed	to	the	Sidebar	and	Bottombar.
Being	aware	of	how	these	Gramplet	containers	differ	(and	are	similar)	will	let	you	focus	on	getting	the	high	speed	performance	instead	of
wondering	why	it	spun	out	of	control.

Originally	added	in	version	3,	Gramplets	in	Dashboard	category	View	are	arranged	in	a	configurable	number	of	columns.	The	Sidebar	and
Bottombar	split	panes	were	selected	from	among	later	innovations	proposed	in	GEPS	19.	They	were	built	on	the	Filter	Sidebar	of	the	3.3	version.
The	Filter	was	converted	to	a	Gramplet	and	pre-docked	in	the	Sidebar.

Fig.	12.3	Detached	Sidebar	Welcome	Gramplet

The	split	panes	provide	limited	screenspace	for	docking	Gramplets	in	the	other	Navigator	categories.	But,	unlike	the	many	columns	of	the
Dashboard	View,	each	new	split	pane	is	a	single	column,	filled	with	a	single	Gramplet.	(The	pane	still	supports	holding	multiple	Gramplets,	it	just
uses	Tabs	to	display	them	one	at	a	time.)

The	split	pane	approach	reduces	the	need	for	flipping	between	Category	Views...	and	that	lightens	the	demands	on	the	database.

Fig.	12.4	Detached	Gramplet	in	the	Dashboard	View
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However,	Gramplets	can	be	undocked	(detached,	torn	off)	to	float	free	from	any	of	the	three	containers.	When	detached,	an	additional	 Help
button	in	the	lower	left	will	open	the	Gramplet's	page	on	this	website.	Clicking	the	 X 	button	in	the	upper	right	corner	will	re-docks	a	detached
Gramplet.	Clicking	the	similar	 X 	button	of	a	docked	Gramplet	will	remove	it	from	the	pane.

The	Dashboard	Category	View

In	the	Dashboard,	you	can	drag	the	 	Properties	 	button	(top	left)	of	each	Gramplet	to	reposition	it	in	the	Dashboard	View	area.	You	can	click
the	 	Properties	 	button	to	detach	(or	‘undock’)	the	Gramplet	from	Dashboard	View	and	place	it	in	its	own	window.	The	window	will	stay
open	regardless	of	page	(relationships,	charts,	etc).	Closing	the	detached	view	will	put	it	back	onto	the	Dashboard	view.	If	you	quit	Gramps	with	a
open	Gramplet,	when	you	start	gramps	again,	it	will	open	automatically.

When	one	or	more	Gramplets	are	undocked	from	the	Dashboard	View,	they	remain	visible	as	you	change	to	a	different	View	(such	as	the	People	or
Charts	View).	In	this	way,	you	can	use	these	Gramplets	to	supplement	a	particular	View	with	additional	details	and	functionality	provided	by	the
Gramplet.

You	can	add	new	Gramplets	by	right-clicking	on	an	open	space	on	Dashboard	view.	Click	the	 X 	button	above	the	Gramplet	to	remove	it	from	the
Dashboard.

⚙	Configurable	Options

Fig.	12.5	View	menu

You	can	also	change	the	number	of	columns	by	changing	a	Gramplets	Layout	tab	setting	in	Configure	Dashboard	window.	To	open	the	window,

click	the	 Configure... 	button,	choose	View	➡	Configure...	from	the	View	menu,	or	press	the	Configure	active	view	keyboard
keybinding.

Fig.	12.6	Gramplet	Configuration	tabs

Each	Gramplet	docked	in	the	Dashboard	will	also	have	a	Configuration	tab	added.	(But	the	same	Gramplet	may	not	have	any	Configuration	options
or	tab	when	docked	in	the	Sidebar	or	Bottombar.)	The	Dashboard	provides	extra	options	for	each	Gramplet	to	allow	it	be	renamed,	set	to	a	fixed
vertical	size,	or	be	maximized	vertically	in	its	column.	The	Configuration	tab	for	Gramplets	in	docked	in	the	Dashboard	reflect	at	least	these
minimum	options.

Double-clicking	the	title	of	a	Gramplet	docked	in	the	Dashboard	Category	allows	you	to	change	the	display	title.

The	split-screen	Sidebar	&	Bottombar
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Fig.	12.7	Gramplet	split-screens	showing	Gramplet	Bar	Menu	with	the
unlabeled	Down	Arrowhead	 ∨ 	pull-down	menu	button

Each	of	these	split	screen	panes	is	a	container	of	stacked	Gramplet	tabs.	Like	Windows	with	a	tabbed	section,	each	can	show	only	a	single	tab	at	a
time.	But	tabs	can	be	added,	re-ordered,	undocked	or	disabled	in	a	similar	fashion	to	the	Dashboard.	However,	instead	of	a	Contextual	Menu,	each
split-pane	Gramplet	Bar	Menu	has	a	Down	Arrowhead	 ∨ 	pull-down	menu	button	to	show	the	same	pop-up	list	of	options.

To	add	a	Gramplet	to	the	stacked	tabs,	select	it	from	the	Gramplet	Bar	Menu	 ∨ 	Add	a	gramplet	submenu.

To	undock	a	tab,	grab	the	tab	title	and	drag	out	of	the	split-pane	onto	the	toolbar	or	menubar.	To	re-dock,	click	the	Close	button	or	the	'X'	button.

To	remove	the	Gramplet	from	the	stack	tabs,	select	it	from	the	Gramplet	Bar	Menu	 ∨ 	Remove	a	gramplet	submenu.	(Alternatively,	the	 ×
Close	button	will	be	accessible	if	the	'Show	close	button	in	gramplet	tabs'	checkbox	in	the	Display	tab	of	Preferences	is	selected.)

Curiously,	the	same	Gramplets	might	be	tabs	in	the	different	split-screen	section	of	a	View	but	be	configured	to	show	information	differently.	It	is
important	to	be	aware	that	each	Gramplet	(whether	stacked	as	a	Tab	or	floating	undocked)	bogs	down	performance	of	Gramps.	Use	fewer	Gramplets
to	make	Gramps	more	responsive.

The	lists	of	Gramplets	that	can	be	added	to	the	stack	of	tabs	in	a	split	pane	are	filtered	by	those	appropriate	to	that	category.

⚙	Configurable	Options

Fig.	12.8	View	menu

Want	Additional	Gramplets

To	add	more	Gramplets	follow	the	instructions	on	Third-Party	Addons.	Check	the	list	of	the	available
reports	here.

In	addition,	there	are	a	number	of	Third-party	Gramplets	that	you	can	easily	install	and	use.	These	include:

Headline	News	Gramplet	-	current,	breaking	news	from	Gramps
Data	Entry	Gramplet	-	edit	active	person's	name,	birth	date	and	place,	death	date	and	place,	and	add	people
Python	Gramplet	-	a	Python	shell
FAQ	Gramplet	-	frequently	asked	questions
Note	Gramplet	-	see	and	edit	active	person's	primary	Person	Note

and	many	others.	See	Third-party	Addons	for	more	details.

Summary	of	Gramplets
Summary	of	all	default	built-in	Gramplets	and	the	view	categories	in	which	each	gramplet	can	be	used.

Independently	for	each	Category	view	mode	container,	the	Gramplets	can	be	added	or	removed	using	the	following	controls:

In	the	Dashboard	Category,	via	the	right-click	context	menu.
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In	all	other	Categories,	via	the	drop-down	Gramplet	selection	menus	 ∨ 	(Down	Arrowhead	button)	on	either	the	Bottombar	or	Sidebar.

There	are	no	Menu	options	to	add	a	Gramplet.	This	is	because	it	would	be	ambiguous	whether	the	Gramplet	was	to	be	added	to	that	view	mode's
sidebar	or	bottombar.	

Gramplet	List

Click	a	Category	header	(twice)	to	sort	the	list	and	show	that	category's	menu	of	available	built-in	Gramplet	choices.	(The	actual	menu	will	also
include	installed	Third-party	addon	Gramplets.)

Gramplet
Dashboard People Relationships Families Charts Events Places Geography Sources Citations Repositories Media Notes

2-Way	Fan	Chart ✔ ✔ ✔ ✔

Age	Stats �� ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔

Age	on	Date �� ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔

Ancestors ✔ ✔ ✔ ✔

Attributes ❖ ✔ ❖ ✔ ❖ ✔ ❖ ❖ ❖

Calendar �� ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔

Children ❖ ✔ ❖ ✔ ✔

Citations ❖ ✔ ❖ ✔ ❖ ❖ ✔ ❖

Descendant	Fan ✔ ✔ ✔ ✔

Descendants ✔ ✔ ✔ ✔

Details ❖ ✔ ✔ ❖ ✔ ❖

Encloses ✔

Enclosed	By ✔

Events ❖ ✔ ❖ ✔ ✔

Events
Coordinates

❖ ✔ ❖ ✔ ✔

FAQ �� ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔

Fan	Chart ✔ ✔ ✔ ✔

Filter ♦ ♦ ♦ ♦ ♦ ♦ ♦ ♦ ♦ ♦ ♦ ♦
Gallery ❖ ✔ ❖ ✔ ❖ ❖ ✔ ❖ ❖

Given	Name
Cloud

�� ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔

Image	Metadata ✔

Media	Preview ✔

Notes ❖ ✔ ❖ ✔ ❖ ❖ ✔ ❖ ❖ ❖ ❖ ❖

Pedigree ✔ ✔ ✔ ✔

Quick	View ��	⚙ ♦	⚙ ♦	⚙ ♦	⚙ ♦	⚙ ♦	⚙ ♦	⚙ ♦	⚙ ♦	⚙ ♦	⚙ ♦	⚙ ♦	⚙ ♦	⚙
Records �� ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔

References ❖ ✔ ❖ ✔ ❖ ❖ ✔ ❖ ❖ ❖ ❖ ❖

Relatives ✔ ✔ ✔ ✔

Residence ✔ ✔ ✔ ✔

Session	Log �� ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔

SoundEx �� ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔

Statistics �� ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔

Surname	Cloud �� ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔

To	Do �� ❖ ❖ ❖ ❖ ❖ ❖ ❖ ❖ ❖ ❖ ❖

Top	Surnames �� ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔

Welcome	to
Gramps!

�� ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔

What's	Next? �� ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔

Python
Evaluation!

��	⚠ ⚠ ⚠ ⚠ ⚠ ⚠ ⚠ ⚠ ⚠ ⚠ ⚠ ⚠ ⚠

Uncollected
Objects!

��	⚠ ⚠ ⚠ ⚠ ⚠ ⚠ ⚠ ⚠ ⚠ ⚠ ⚠ ⚠ ⚠

Symbol Meaning
⚠ Dangerous.	Available	in	debug	mode	only
✔ listed	in	gramplet	menu	for	view
�� different	container	behavior

♦	⚙ category	specific	configuration	options

♦ category	specific	interface
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

❖ Content	based	on	active	record	or	category

For	more	detailed	information	on	using	the	installed	Gramplets,	see	Gramplets.	

Gramplets
This	following	sections	describe	each	Gramplet	and	its	basic	functionality.	

2-Way	Fan	Chart

Fig.	12.9	2-Way	Fan	Gramplet

Chart	consisting	of	both	ascendants	and	descendants.	The	2-Way	Fan	View	view	interactively	displays	the	active	person's	ancestors	and
descendants	in	a	pie	chart	format.	The	Descendant	Fan	provides	a	comprehensive	and	visually	appealing	way	to	explore	and	analyze	an	individual's
descendants	within	your	family	tree.

See	also:

Gramplets:
Fan	Chart	(ancestor)
2-way	Fan	Chart	(ancestor	and	descendant)
Descendant	Fan	Chart

Charts	category	view	modes:
Fan	Chart	(ancestor)
2-way	Fan	(ancestor	and	descendant)
Descendant	Fan

Reports	:	Graphical	reports:
Fan	Chart...	(ancestor)

Age	on	Date

Fig.	12.10	Age	On	Date	Gramplet	-	detached	example
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The	 Age	on	Date 	Gramplet	allows	you	to	enter	a	Calendar	date	in	the	 Date: 	entry	field.	If	you	select	the	 Run 	the	Gramplet	will	compute
the	ages	for	everyone	in	your	Family	Tree	living	on	that	Date	and	will	show	the	results	in	a	separate	Quick	View	report	dialog.	The	date	must	be
entered	in	a	calendar	format	that	Gramps	accepts	eg:	YYYY-MM-DD	.

No	configuration	options	are	available	for	this	gramplet.

Fig.	12.11	Age	On	Date	Gramplet	-	Quick	View	-	result	example

From	the	resulting	Quick	View	report	dialog	you	can	sort	by	the	Person,	Age	or	Status	columns.	Right	clicking	the	row	opens	a	context	menu	that
allows	you	to	Copy	all	rows	to	the	clipboard;	or	to	See	the	person	details	in	the	Person	Editor,	or	Make	the	person	active .

You	can	also	drag	a	date	to	from	Calendar	Gramplet	to	the	 Age	on	Date 	Gramplets	 Date: 	entry	field	to	enter	that	date.
See	also	the	Third-party	Addon	Date	Calculator	Gramplet	which	allows	you	to	do	date	math.

Age	Stats

Fig.	12.12	Age	Stats	Gramplet	-	detached	example

The	 Age	Stats 	Gramplet	shows	statistics	in	the	form	of	three	text	graphs	grouped	in	5	years	age	span	breakdowns	(use	the	vertical	scroll	bar	to
see	the	other	two	graphs):

Lifespan	Age	Distribution 	-	for	all	people	having	valid	birth	and	death	dates.
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Father	-	Child	Age	Diff	Distribution	-	shows	the	age	difference	between	child	and	father	where	both	individuals	have	valid	birth	dates.
Mother	-	Child	Age	Diff	Distribution	-	shows	the	age	difference	between	child	and	mother	where	both	individuals	have	valid	birth	dates.

Rolling	over	a	chart	row	will	display	a	hint	with	the	count	of	offspring	matching	the	row's	range.

Double-clicking	a	row	in	any	of	the	statistics	graphs	opens	a	Quick	Report	of	the	offspring	categorized	by	that	row.	You	can	sort	the	Quick	Report
by	the	Name,	Birth	Date	and	Name	Type	columns.

Right-clicking	the	Quick	View	report	row	displays	a	context	menu	for	copying	the	list,	opening	the	Person	Editor	or	activating	the	person.

⚙	Configurable	Options

Fig.	12.13	Age	Stats	Gramplet	-	from	Charts
Configuration	tab	defaults

Adjustable	graph	scaling	limits

Maximum	Age	1-150;	(110	default)
Maximum	Age	of	mother	at	birth:	1-150;	(40	default)
Maximum	Age	of	father	at	birth:	1-150;	(60	default)
Chart	Width:	1-150;	(60	default)

In	the	Dashboard	View,	the	Gramplet	may	be	detached	by	clicking	the	 Configure	active	view 	button.	

Ancestors

Fig.	12.14	Ancestors	Gramplet	-	detached	example

Gramplet	showing	active	person's	ancestors.	

Attributes
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Fig.	12.15	Attributes	Gramplet

The	Attributes	Gramplet	shows	all	of	the	attributes	for	the	current,	active	person.	Double	click	on	the	name	of	the	attribute,	and	you	will	run	a	Quick
View	that	shows	all	of	the	people	that	have	that	attribute,	and	the	values	for	it.	You	can	sort	the	Quick	View	by	the	attribute	value	by	clicking	on
the	column	name.	

Fig.	12.16	Attributes	Gramplet	-	Quick	View	example
result

In	the	Quick	View,	highlight	the	entry	to	change	the	active	person	(which	will	then	change	the	Attributes	Gramplet),	and	double-click	the	Quick
View	entry	to	bring	up	the	Edit	Person	dialog	window.	

Person	Attributes

See	Attributes	

Family	Attributes

See	Attributes	

Event	Attributes

See	Attributes	

Source	Attributes

See	Attributes	

Citation	Attributes

See	Attributes	

Media	Attributes

See	Attributes	

Calendar

Fig.	12.17	Calendar	Gramplet	-	detached	example

The	Calendar	Gramplet	shows	a	monthly	calendar.

Surrounding	the	 month 	label	at	the	top	left	corner,	the	 < 	 previous 	and	 > 	 next 	buttons	can	be	used	to	change	the	month.
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Surrounding	the	 year 	label	at	the	top	right	corner,	the	 < 	 previous 	and	 > 	 next 	buttons	can	be	used	to	change	the	year.

Double-click	a	day	to	run	the	 On	This	Day 	Quick	View.	The	Quick	View	window	shows	up	to	3	table	sections,	the	events	(if	any	exist)	of:	the
exact	date,	other	events	on	the	same	month/day	in	history,	and	events	in	that	year.

You	can	also	drag	a	day	from	the	Calendar	to	the	date	fields	(such	as	for	the	 Event	Editor	or	the	Age	on	Date	Gramplet)	to	enter	that	date.	Similarly,
a	calendar	day	may	also	be	dragged	to	the	Clipboard	where	it	will	be	stored	in	a	plain	text	format.

Localized	Day	of	the	week	headers

The	customary	first	day	of	the	week	can	be	shown	on	calendar	and	which	vary	culturally.	The	calendar
adapts	to	the	language	setting.	

The	feature	will	be	included	in	the	6.0	release	but	can	patched	manually.	See	the	Discourse	forum
discussion	on	the	Calendar	Gramplet

Children

Fig.	12.18	Children	Gramplet	-	detached	example

Gramplet	showing	the	active	persons	children.

How	do	I	change	the	order	of	children?	Use:

The	Family	Editor	Children	tab	to	change	the	order	of	children	in	the	family.
The	third	party	addon	Birth	Order	Tool	which	allows	bulk	updates	of	the	children	order.

Person	Children

See	Children

Also	shows	the	childs	spouse	if	present.	

Family	Children

See	Children	

Citations

Fig.	12.19	Citation	Gramplet	-	detached	example

Gramplet	showing	the	active	persons	citations.	

Person	Citations

See	Citations	

Family	Citations

See	Citations	

Event	Citations
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See	Citations	

Place	Citations

See	Citations	

Media	Citations

See	Citations	

Descendant	Fan	Chart

Fig.	12.20	Descendant	Fan	(chart)	Gramplet	-
detached	example

Gramplet	showing	active	person's	direct	descendants	as	a	fan	chart.

See	also:

Gramplets:
Fan	Chart	(ancestor)
2-way	Fan	Chart	(ancestor	and	descendant)
Descendant	Fan	Chart

Charts	category	view	modes:
Fan	Chart	(ancestor)
2-way	Fan	(ancestor	and	descendant)
Descendant	Fan

Reports	:	Graphical	reports:
Fan	Chart...	(ancestor)

Descendants

Fig.	12.21	Descendants	Gramplet	-	detached	example

The	Descendants	Gramplet	shows	the	direct	descendants	of	the	active	person.

The	order	of	the	spouses	and	children	is	that	given	in	the	Gramps	editor.	To	change	the	order	of	spouses,	click	on	Order	on	the	Relationship	view.
To	change	the	order	of	children,	drag	and	drop	them	in	the	correct	order	in	the	Family	edit	window.

This	Gramplet	is	based	on	the	Descendant	Report,	available	from	the	Textual	Reports.

The	Descendants	Gramplet	will	update	when	you	change	the	active	person,	or	change	family	trees.	It	does	not	update	automatically	for	edits	or
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

additions	because	this	report	is	time-consuming	to	run.

Minimizing	a	Gramplet	will	prevent	it	from	updating.

Moving	the	mouse	over	a	person	will	show	a	tooltip	summary	which	includes	the	death	date.	

Details

Fig.	12.22	Details	Gramplet	-	detached	example

Gramplet	showing	details	of	the	active	person.

Provides	a	brief	non	editable	summary	of	the	selected	person	for	example:

Name:	of	person
Also	Known	As:
Other	Name:
Father:
Mother:
Birth:
Death:
Burial:

Image:	If	available	the	primary	image	will	be	shown	to	the	right	of	the	details,	otherwise	a	cross	will	indicate	the	image	is	missing,	you	may
double	click	the	image	to	open	it	in	an	external	viewer.	To	change	the	primary	active	image	see:	Edit	Person	Editors	-	Gallery	tab

You	may	highlight	and	copy	the	individual	text	fields.

Missing	Media	Objects	'broken	link'	icon	of	a	box	with	a	red	'x'

Person	Details

See	Details	

Place	Details

See	Details	

Repository	Details

See	Details	

Encloses

Fig.	12.23	Encloses	Gramplet	-	detached	example

Gramplet	showing	the	hierarchical	locations	of	a	place	it	encloses	over	time.

See	also	Enclosed	By	tab
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Encloses	Place	Locations

See	Enclosed	By	

Enclosed	By

Fig.	12.24	Enclosed	By	Gramplet	-	detached	example

Gramplet	showing	the	locations	hierarchically	enclosed	by	a	place	over	time.

See	also	Enclosed	By	tab

Enclosed	By	Place	Locations

See	Encloses	

Events

Fig.	12.25	Events	Gramplet	-	detached	example

Primarily	designed	as	an	alternative	to	opening	a	Edit	Object	dialog	layout	tab	.

Double	click	a	row	to	edit	the	event.

See	Events

Family	Events

Gramplet	added	in	the	Person	category	will	show	the	events	for	the	active	Family.

Person	Events

Gramplet	added	in	the	Person	category	will	show	the	events	for	the	active	person.

Events	Coordinates

Primarily	designed	to	verify	that	the	key	data	exists	to	plot	the	Events	in	the	Geography	view.	Beyond	the	coordinates,	a	date	and	event	type	are
needed	for	some	of	the	animated	views.

Right-click	a	row	to	open	a	context	menu	to	edit	the	event	or	place.

Family	Events	Audit

Fig.	12.26	Events	Coordinates	Gramplet	-	detached	example

Gramplet	added	in	the	Family	category	will	show	the	Events	for	the	active	Family.	

Person	Events	Audit

Gramplet	added	in	the	Person	category	will	show	the	Events	for	the	active	person.	

Fan	Chart
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Fig.	12.27	Fan	Chart	Gramplet

The	Fan	Chart	Gramplet	shows	the	direct	ancestors	of	the	active	person	in	a	circular	format.	It	is	similar	to	the	Pedigree	View,	but	shown	around	the
center/active	person,	and	further	generations	spiralling	out.

Click	on	a	parent	in	the	chart	and	they	will	expand	or	contract	above	their	child.	Right-click	on	a	person	and	you	can:

select	that	person	to	be	the	active	person
edit	the	person	which	allows	through	Person	Editor	add	children	to	person's	families
select	from	among	the	person's	relatives	to	be	the	active	person
add	partners	(families)	to	person
copy	name,	birth	and	death	of	person	into	clipboard

Clicking	in	an	open	area	(non-person)	and	dragging	the	mouse	will	allow	you	to	rotate	the	chart	about	the	center.	You	may	also	left-click	and	drag
in	the	center	to	reposition	the	fan	chart.

A	black	edge	on	the	outer	radius	of	the	chart	indicates	more	parents	for	that	person.	A	black	circle	in	the	center	indicates	that	the	center	person	has
children.

The	Fan	Chart	Gramplet	will	update	when	you	change	the	active	person,	or	change	family	trees.

Minimizing	a	Gramplet	will	prevent	it	from	updating.

See	also:

Gramplets:
Fan	Chart	(ancestor)
2-way	Fan	Chart	(ancestor	and	descendant)
Descendant	Fan	Chart

Charts	category	view	modes:
Fan	Chart	(ancestor)
2-way	Fan	(ancestor	and	descendant)
Descendant	Fan

Reports	:	Graphical	reports:
Fan	Chart...	(ancestor)

FAQ
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Fig.	12.28	FAQ	Gramplet	-	detached	example

The	 FAQ	Gramplet 	(Frequently	Asked	Questions)	shows	a	list	of	common	questions,	and	links	to	their	answers	from	the	Gramps	Wiki	(requires
an	internet	connection).

This	gramplet	shows	a	manually	curated	list	of	Frequently	Asked	Questions	hyperlinked	to	answers	in	articles	of	the	Gramps	wiki.	The	list	is
collated	from	new	user	postings	to	the	Gramps	User	maillist	that	must	be	answered	repeatedly.

The	idea	is	to	make	the	answers	to	the	most	common	question	easier	to	find,	the	primary	objective	is	to	let	new	users	start	using	Gramps	more
quickly.

See	Also

Bug	Report	11742:	Dashboard	FAQ	links	are	obsolete	(resolved)
Bug	Report	11997:	how	to	add/update	FAQs

Filter

Gramplet	providing	a	filter	specific	to	the	Category:

People	Filter	Gramplet
Families	Filter	Gramplet
Charts	Filter	Gramplet 	-	Interface	is	the	same	as	the	 People	Filter	Gramplet
Events	Filter	Gramplet
Places	Filter	Gramplet
Geography	Filter	Gramplet 	-	Interface	is	the	same	as	the	 Places	Filter	Gramplet
Sources	Filter	Gramplet
Citations	Filter	Gramplet
Repositories	Filter	Gramplet
Media	Filter	Gramplet
Notes	Filter	Gramplet

See	Also

Gramps	Glossary	term:	Regular	Expressions	for	pattern	matching	in	searches
Filter	gramplets
Which	filters	(rules)	in	which	Category?
Isotammi	Filter+	gramplet	addon

People	Filter
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Fig.	12.29	People	-	Filter	Gramplet	-	detached	-	default

Equivalent	to	the	built-in	Custom	Filter	rules:

Name	:	People	with	a	name	matching	<text>
ID	:	People	with	Id	containing	<text>
Gender	:	Male	•	Female	•	People	with	unknown	gender
Birth	date	:	People	with	the	<birth	data>
Death	date	:	People	with	the	<death	data>
Event	:	People	with	the	personal	<event>
Note	:	People	having	notes	containing	<text>
Tag	:	People	with	the	<tag>
Custom	filter	:	People	matching	the	<filter>

Example

Some	simple	regular	expressions	to	filter	out	persons	with	surnames	spelled	slightly	different.

With	this	regular	expression	in	the	sidebar	filter	Name	entry:

eri[ck](s|ss)on

or

eri[ck]ss?on

or

eri[ck]s+on

You	get	all	four	versions	as	result:

Ericson
Ericsson
Erikson	
Eriksson

Use	of	regular	expressions 	only	works	on	some	fields

Families	Filter
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Fig.	12.30	Families	-	Filter	Gramplet	-	detached	-
default

Equivalent	to	the	built-in	Custom	Filter	rules:

ID	:	Families	with	Id	containing	<text>
Father	:Families	with	father	matching	the	<regex_name>
Mother	:	Families	with	mother	matching	the	<regex_name>
Child	:	Families	with	child	matching	the	<regex_name>
Relationship	:	Families	with	the	relationship	type
Family	Event	:	Families	with	the	<event>
Family	Note	:	Families	having	notes	containing	<text>
Tag	:	Families	with	the	<tag>
Custom	filter	:	Families	matching	the	<filter>

Charts	Filter

Fig.	12.31	Charts	-	Filter	Gramplet	-	detached	-	default
(Same	as	People	Filter)

The	diagrams	in	Charts	need	the	context	of	connecting	records	to	define	the	connections	between	blocks.	So	rather	than	only	displaying	only	the
matching	records	in	the	Charts	view	modes,	Filters	for	the	Charts	still	displays	all	the	records	but	dims	the	non-matching	ones.

Interface	is	the	same	as	the	 People	Filter	Gramplet 	

Events	Filter
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Fig.	12.32	Events	-	Filter	Gramplet	-	detached	-	default

Equivalent	to	the	built-in	Custom	Filter	rules:

ID	:	Events	with	Id	containing	<text>
Description	:	Events	matching	parameters
Type	:	Events	matching	parameters
Participants	:	Events	matching	parameters
Date	:	Events	matching	parameters
Place	:	Events	matching	parameters
Note	:	Events	having	notes	containing	<text>
Tag	:	Events	with	the	<tag>
Custom	filter	:	Events	matching	the	particular	<filter>

Places	Filter

Fig.	12.33	Places	-	Filter	Gramplet	-	detached	-	default

Equivalent	to	the	built-in	Custom	Filter	rules:

ID	:	Places	with	Id	containing	<text>
Name	:	Places	matching	parameters
Type	:	Places	matching	parameters
Code	:	Places	matching	parameters
Enclosed	By	:	Places	enclosed	by	another	place
Within	:	Places	within	an	area
Note	:	Places	having	notes	containing	<text>
Tag	:	Places	with	the	<tag>
Custom	filter	:	Places	matching	the	<filter>

Geography	Filter
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Fig.	12.34	Geography	-	Filter	Gramplet	-	detached	-
default	(Same	as	Places	Filter)

Interface	is	the	same	as	the	 Places	Filter	Gramplet

Sources	Filter

Fig.	12.35	Sources	-	Filter	Gramplet	-	detached	-
default

Equivalent	to	the	built-in	Custom	Filter	rules:

ID	:	Sources	with	Id	containing	<text>
Title	:	Sources	matching	parameters
Author	:	Sources	matching	parameters
Abbreviation	:	Sources	matching	parameters
Publication	:	Sources	matching	parameters
Note	:	Sources	having	notes	containing	<text>
Tag	:	Sources	matching	the	<tag>
Custom	filter	:	Sources	matching	the	<filter>

Citations	Filter
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Fig.	12.36	Citations	-	Filter	Gramplet	-	detached	-
default

Equivalent	to	the	built-in	Custom	Filter	rules:

Source:

ID	:	Sources	with	Id	containing	<text>
Title	:	Sources	matching	parameters
Author	:	Sources	matching	parameters
Abbreviation	:	Sources	matching	parameters
Publication	:	Sources	matching	parameters
Note	:	Citations	having	source	notes	containing	<text>

Citation:

ID	:	Citations	with	Id	containing	<text>
Volume/Page	:	Citations	matching	parameters
Date	:	Citations	matching	parameters
Min.	Conf.	:	Citations	matching	parameters
Note	:	Citations	having	notes	containing	<text>
Tag	:	Citations	with	the	<tag>
Custom	filter	:	Citations	matching	the	<filter>

Repositories	Filter

Fig.	12.37	Repositories	-	Filter	Gramplet	-	detached	-
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default

Equivalent	to	the	built-in	Custom	Filter	rules:

ID	:	Repositories	with	Id	containing	<text>
Name	:	Repositories	matching	parameters
Type	:	Repositories	matching	parameters
Address	:	Repositories	matching	parameters
URL	:	Repositories	matching	parameters
Note	:	Repositories	having	notes	containing	<text>
Tag	:	Repositories	with	the	<tag>
Custom	filter	:	Repositories	matching	<filter>

Media	Filter

Fig.	12.38	Media	-	Filter	Gramplet	-	detached	-	default

Equivalent	to	the	built-in	Custom	Filter	rules:

ID	:	Media	objects	with	Id	containing	<text>
Title	:	Media	objects	matching	parameters
Type	:	Media	objects	matching	parameters
Path	:	Media	objects	matching	parameters
Date	:	Media	objects	matching	parameters
Note	:	Media	objects	having	notes	containing	<text>
Tag	:	Media	objects	with	the	<tag>
Custom	filter	:	Media	objects	matching	the	<filter>

Notes	Filter

Fig.	12.39	Notes	-	Filter	Gramplet	-	detached	-	default

Equivalent	to	the	built-in	Custom	Filter	rules:

ID	:	Notes	with	Id	containing	<text>
Text	:	Notes	matching	parameters
Type	:	Notes	matching	parameters
Tag	:	Notes	with	the	<tag>
Custom	filter	:	Notes	matching	the	<filter>
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Gallery

Fig.	12.40	Gallery	Gramplet	-	detached	example

Gramplet	showing	media	objects.	The	first	image	is	the	primary	active	media	object	that	is	used	in	reports	and	the	 Edit	Person	dialog .

You	can	use	the	context	menu	to	right	click	and	Make	Active	Media	(Bug	reported	10359)

Double-click	on	the	picture	to	view	it	in	the	default	image	viewer	application.

See	also:

To	change	the	primary	media	object	for	reports	etc...	use	the	 Edit	Person	dialog s	Gallery	tab.

Person	Gallery

See	Gallery	

Family	Gallery

See	Gallery	

Event	Gallery

See	Gallery	

Place	Gallery

See	Gallery	

Source	Gallery

See	Gallery	

Citation	Gallery

See	Gallery	

Given	Name	Cloud

Fig.	12.41	Given	Name	Cloud	Gramplet	-	detached
example

Like	the	Surname	Cloud	Gramplet,	the	Given	Name	Cloud	Gramplet	shows	the	top	most	popular	given	names	in	your	family	tree.	The	size	of	the
name	indicates	how	popular	it	is.	Mouse	over	the	name	to	see	the	exact	count,	and	the	percent	of	people	in	the	family	tree	that	have	that	name.
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The	Gramplet	splits	up	given	names	into	words	(broken	up	by	spaces).	For	example	"Sarah	Elizabeth"	would	appear	under	both	"Sarah"	and
"Elizabeth".

Double-click	on	the	given	name	to	bring	up	a	Quick	View	of	all	of	the	matching	people.	

Image	Metadata

Fig.	12.42	Image	Metadata	Gramplet	-	example

The	Image	Metadata	Gramplet	offers	an	interface	to	look	at	Image	Exif	Metadata	from	your	images	(*.jpg,	*.png.	*.tiff,	*.exv,	*.nef,	*.psd,	*.pgf).	
See	also	the	third	party:

Addon:Edit	Image	Exif	Metadata

Prerequisites

Special	Note

Before	being	able	to	use	this	Gramplet/Addon,	you	will	need	to	download	and	install	gexiv2
or	install	gexiv2	from	your	local	Linux	repository.
MS-Windows	users,	this	is	depends	on	which	installer	you	used.
Ubuntu,	use	the	Universe	repository	to	find	gexiv2.
Also	see	GExiv2	for	Image	metadata

Once	you	have	installed	gexiv2,	see	above	for	directions	to	download	and	install	this	addon...

Pyexiv2	can	be	used	from	the	command	line	interface	(cli)	as	well,	and	from	within	a	python	script:

1.	 import	the	pyexiv2	library

from	pyexiv2	import	ImageMetadata,	ExifTag

2.	 specify	your	image

image	=	ImageMetadata("/home/user/image.jpg")

3.	 read	the	image

image.read()

Exif,	IPTC,	XMP	metadata	reference	tags	can	be	found	here.

Example:

image["Exif.Image.Artist"]	#	Artist
Smith	and	Johnson's	Photography	Studio

image["Exif.Image.DateTime"]	#	DateTime
1826	Apr	12	14:00:00

image["Exif.Image.DateTime"]	=	datetime.datetime.now()	#	Add	DateTime
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image.write()	#	write	the	Metadata

Usage	scenario

The	preferred	way	to	use	this	addon	is:

1.	 install	pyexiv2
2.	 Install	this	addon
3.	 Restart	Gramps
4.	 Click	Views	from	the	Menu	bar,	and	select	Media	Views
5.	 Open	the	Side	Bar
6.	 Slide	the	available	empty	right	view	to	about	half	the	screen.
7.	 Right	click	text	to	the	Side	Bar	tab,	and	select	Add	a	Gramplet
8.	 Select	Image	Metadata	Gramplet
9.	 Select	an	image	from	the	left	hand	MediaView

Media	Preview

Fig.	12.43	Media	Preview	Gramplet	-	detached
example

Gramplet	shows	a	preview	of	the	single	primary	media	object	if	it	exists.	
See	Media	Category

Notes

Fig.	12.44	Notes	Gramplet	-	detached	example

Gramplet	showing	the	active	persons	notes.

See	also:

Note	Gramplet	-	Third	party	Addon

Person	Notes

See	Notes	

Family	Notes

See	Notes	

Event	Notes
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See	Notes	

Place	Notes

See	Notes	

Source	Notes

See	Notes	

Citation	Notes

See	Notes	

Repository	Notes

See	Notes	

Media	Notes

See	Notes	

Pedigree

Fig.	12.45	Pedigree	Gramplet	-	detached	example

The	Pedigree	Gramplet	shows	a	compressed	view	of	the	active	person's	direct	ancestors.	It	defaults	to	going	back	100	generations.	The	names	can	be
clicked	to	change	the	active	person,	right-click	to	edit	the	person.	At	the	bottom	of	the	Gramplet	the	number	of	people	per	generation	is	listed.	Birth
and	death	dates	are	shown	next	to	each	person's	name.	Double-click	the	Generation	number	to	see	the	matching	individuals.

Using	the	content	of	the	Pedigree	in	another	program	requires	a	bit	of	effort	Open	a	contextual	pop-up	menu	by	right-clicking	anywhere	in	the
gramplet	except	a	hotlink.	Or,	you	can	begin	a	drag	selection	from	the	same	inert	areas.	Copy	the	highlighted	text	the	OS	clipboard	from	that	same
context	menu.	(The	keybinding	for	'Copy'	will	not	work.)	When	you	paste	the	text	into	another	text	editing	program,	you	may	need	change	the	font
to	a	non-proportional	font	to	preserve	the	indentation.	Some	online	services	collapse	leading	spaces	when	you	post	a	chunk	of	text.	Preserving	the
indentation	for	such	services	may	require	replacing	doubled	spaces	with	doubled	placeholder	characters...	like	periods/full	stops.

⚙	Configurable	Options

Maximum	generations:	1	to	100	limit;	(default:	100)
Show	Dates	checkbox;	(default:	deselected)
Line	Type	menu:	UTF,	ASCII;	(default:	UTF)

Python	Evaluation

Warning!	Diagnostic	Tool

Do	not	use	this	Debug	feature	on	your	working	Family	Tree.	Always	create	a	new	empty	Family	Tree	or
a	copy	of	your	existing	Family	Tree	for	testing.
This	option	is	only	available	when	Gramps	has	been	started	using	a	developer	mode	switch.	It	is	not
intended	for	general	use	and	has	limited	safeguards.
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Fig	12.46	Python	Evaluation	Gramplet	-
detached	example

The	 Python	Evaluation 	window	tool	is	intended	to	test	Python	scripts	with	Gramps	data.

Sample	code	for	listing	Gramps	internal	"constants":

import	os
import	sys
from	gramps.gen.const	import	*

#	Get	all	uppercase	variables	from	the	current	namespace
ENV	=	{
				name:	value	for	name,	value	in	locals().items()
				if	name.isupper()	and	not	name.startswith('_')	and	isinstance(value,	str)
}

#	Print	each	item	in	the	dictionary,	indicating	if	it's	a	hidden	directory
for	key,	value	in	ENV.items():
				try:
								if	os.path.isdir(value):
												if	sys.platform.startswith('win'):
																import	ctypes
																attrs	=	ctypes.windll.kernel32.GetFileAttributesW(value)
																hidden_status	=	"HIDDEN"	if	attrs	!=	-1	and	bool(attrs	&	2)	else	"NOT	HIDDEN"
												else:
																hidden_status	=	"HIDDEN"	if	os.path.basename(value).startswith('.')	else	"NOT	HIDDEN"
												print(f"({hidden_status})				{key}		:				{value}")
								else:
												print(f"{key}		:				{value}					(NOT	A	DIRECTORY)")
				except	Exception	as	e:
								print(f"{key}		:				{value}					(ERROR	:				{str(e)})")

See	Also

Python	Shell	addon	gramplet.	Where	possible,	use	the	Python	Shell	instead	of	Python	Eval.	It	has	extra	garbage	collection	functionality
Debug	submenu	in	the	Tools	menu	before	version	4.0.2
Gramps-devel	maillist:	Converting	tools	to	gramplets	-	Oct	2013
Discourse	--	Sample	scripts:

sample	script	to	Parse	selected	JSON	to	CSV
troubleshooting	Gramps	paths	and	environmental	variables

Quick	View

Fig.	12.47	Quick	View	Gramplet	-	detached
example

The	Quick	View	Gramplet	allows	the	selected	Quick	View	report	to	be	updated	dynamically	as	active	records	are	changed.	Instead	of	a	window
with	a	static	report,	the	gramplet	updates	as	different	active	records	are	selected	within	the	target	Category.	(When	this	Gramplet	was	introduced,	it
only	offered	choosing	Quick	View	Reports	from	the	People	category.	A	Configuration	pop-up	menu	to	select	View	categories	has	since	been
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added.)

You	can	run	any	of	the	builtin	Quick	Views	or	addon	QuickView	reports.	

Fig.	12.48	Quick	View	Gramplet	-	Configuration
tab	shown

You	can	change	the	options	by	clicking	the	Option	button	(top,	left	hand	button	of	the	Gramplet)	which	will	detach	the	Gramplet	and	bring	it	up	an
a	window.	Select	 Options 	on	the	top	row,	and	a	list	of	options	will	appear.	Press	 Save 	to	apply	the	changes	to	the	Quick	View.	You	may	then
close	the	window	to	reattach	the	Gramplet.

See	the	following	developer	information	if	you	are	interested	in	creating	your	own:

Making	your	own	Quick	Views.

Records

Fig	12.49	Records	Gramplet	-	detached	example

The	Records	Gramplet	shows	a	number	of	interesting	facts	about	the	records	(mostly	age	related)	from	your	database.	The	list	shows	the	top	three
for	each	element.

Person	Records:
Youngest	living	person
Oldest	living	person
Person	died	at	youngest	age
Person	died	at	oldest	age
Person	married	at	youngest	age
Person	married	at	oldest	age
Person	divorced	at	youngest	age
Person	divorced	at	oldest	age
Youngest	father
Youngest	mother
Oldest	father
Oldest	mother

Family	Records
Couple	with	most	children
Living	couple	married	most	recently
Living	couple	married	most	long	ago
Shortest	past	marriage
Longest	past	marriage

The	list	is	not	only	interesting	on	its	own,	it	is	also	a	good	sanity	check	of	the	data.	For	some	items	you	have	to	fill	in	some	additional	information.
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This	following	example	shows	that	there	was	a	marriage	event	(thus	calculation	of	the	offset)	but	none	of	the	persons	had	a	death	event.	Even	if	the
date	is	not	known,	just	enter	a	death	event	for	one	of	the	partners	and	the	list	will	be	corrected.

Living	couple	married	most	long	ago

1.	 van	Dosselaere,	Egidius	and	Rechters,	Petronella	(382	years,	1	month)
2.	 de	Richter,	Petrus	and	Asscericx,	Catharina	(379	years,	9	months)

An	identical	Records	Report	is	also	available.

References

Fig	12.50	References	Gramplet	-	detached	example

Gramplet	showing	the	active	persons	References.

Person	References

Person	References	:	Gramplet	showing	the	backlink	references	for	a	person

See	References	

Family	References

Family	References	:	Gramplet	showing	the	backlink	references	for	a	family

See	References	

Event	References

Event	References	:	Gramplet	showing	the	backlink	references	for	an	event

See	References	

Place	References

Place	References	:	Gramplet	showing	the	backlink	references	for	a	place

See	References	

Source	References

Source	References	:	Gramplet	showing	the	backlink	references	for	a	source

See	References	

Citation	References

Citation	References	:	Gramplet	showing	the	backlink	references	for	a	citation

See	References	

Repository	References

Repository	References	:	Gramplet	showing	the	backlink	references	for	a	repository

See	References	

Media	References
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Media	References	:	Gramplet	showing	the	backlink	references	for	a	media	object

See	References	

Note	References

Note	References	:	Gramplet	showing	the	backlink	references	for	a	note

See	References	

Relatives

Fig	12.51	Relatives	Gramplet	-	detached	example

This	Gramplet	shows	all	direct	relatives	of	the	active	person.	It's	intended	use	is	as	a	navigation	help,	an	alternative	way	to	move	through	your
family	tree	in	Gramps	.	If	you	detach	the	Gramplet,	and	place	it	next	to	Gramps,	it	will	allow	you	to	use	it	to	easily	change	the	content	of	the	current
"Person	view".

If	you	are	working	in	the	charts	category	Pedigree	view,	the	active	person	is	the	left-most	person.	By	clicking	a	name	in	the	relatives	Gramplet,	you
can	easily	change	the	active	person,	and	all	person	view	in	the	other	window	will	update.	As	the	relatives	Gramplet	shows	all	spouses,	all	children
and	all	parents,	this	offers	an	alternative	way	of	navigating	your	data.

The	names	in	this	Gramplet	also	allow	you	to	call	up	the	person	editor	directly,	by	right-clicking	on	any	of	the	names.

The	Relatives	Gramplet	can	be	added	to	the	following	categories:

People	Category
Relationships	Category
Charts	Category
Geography	Category	(selected	views	only)

Residence

Fig.	12.52	Person	-	Residence	Gramplet	-	detached	-	example

Gramplet	showing	residence	events	for	the	active	person

Person	Residence
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See	Residence	

Session	Log

Fig.	12.53	Session	Log	Gramplet	-	detached	example

The	session	log	keeps	track	of	activity	in	this	session.	It	lists	selected	and	edited	objects.

Click	a	name	once	to	make	this	person	the	active	person.	Double-click	on	a	name	or	family	brings	up	the	 edit 	page	for	that	object.	In	addition,	if
you	want	to	edit	a	person,	but	don't	want	to	change	the	active	person,	you	can	right-click	on	the	person's	name.

This	Gramplet	is	handy	because	you	can	very	quickly	change	the	active	person,	or	edit	the	object,	from	the	session	list.

Using	Undo	History]

SoundEx

Fig.	12.54	SoundEx	Gramplet	-	detached	example
showing	context	menu

The	 SoundEx	Gramplet 	generates	SoundEx	codes	for	the	names	of	people	in	the	Family	Tree.

From	the	 SoundEx	Gramplet 	window	you	can	either	choose	a	 Name: 	from	the	pop-up	menu	shown	by	selecting	the	down	 ▼ 	arrowhead,
(triangle)	or	you	can	type	a	name	into	the	text	field.

The	name	you	type	in	can	be	any	name...	even	a	name	not	present	in	your	Family	Tree.

The	 SoundEx	code: 	field	shows	the	result	automatically	eg:	The	SoundEx	code	for	Simpson	is	S512

You	can	right	click	on	the	 SoundEx	code: 	field	to	copy	the	result.

A	 Help 	button	is	available	which	brings	you	to	this	page.	With	the	 Close 	button	(or	using	the	keyboard	shortcut	 Alt + C )	you	dismiss	the
SoundEx	Gramplet 	window.	

Soundex	what	is	this?

Soundex	is	the	most	widely	known	of	all	phonetic	algorithms	which	allow	indexing	of	words	by	their	sound,	as	pronounced	in	English.	Soundex
support	is	included	with	searching	via	a	Soundex	match	of	People	with	the	<name>	Custom	Filter	rule,	a	Soundex	Gramplet,	and	as	a	quality	control
for	matching	in	the	Find	Possible	Duplicate	People	tool.
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The	Soundex	equivalent	is	a	coded	surname	(last	name)	index	based	on	the	way	a	surname	sounds	rather	than	the	way	it	is	spelled.	Surnames	that
sound	the	same,	but	are	spelled	differently,	like	SMITH	and	SMYTH,	have	the	same	code	and	are	filed	together.	The	Soundex	coding	system	was
developed	so	that	surnames	may	be	found	even	when	recorded	under	variant	spellings.

First	applied	to	the	1880	US	Census,	Soundex	is	a	"sound	index",	not	a	strictly	alphabetical	one.	The	key	feature	is	that	it	codes	surnames	(last
names)	based	on	the	way	a	name	sounds	rather	than	on	how	it	is	spelled.	The	Soundex	phonetic	coding	system	pre-dates	computers	and	was	to	help
researchers	find	a	surname	quickly	even	though	it	may	have	received	different	spellings.

Those	doing	census	lookups	must	use	the	same	method	to	encode	and	tabulate	surnames	as	the	census	workers	did	when	they	generated	the
database.

To	search	for	a	particular	surname,	you	must	first	work	out	its	encoding	equivalent.

Basic	Soundex	Coding	Rule:

Every	Soundex	code	consists	of	a	letter	and	three	numbers,	such	as	W-252.	The	letter	is	always	the	first	letter	of	the	surname.	The	numbers	are
assigned	to	the	remaining	letters	of	the	surname	according	to	the	Soundex	guide	shown	below.	Zeroes	are	added	at	the	end	if	necessary	to	produce	a
four-character	code.	Additional	letters	are	disregarded.	Examples:	Washington	is	coded	W-252	(W,	2	for	the	S,	5	for	the	N,	2	for	the	G,	remaining
letters	disregarded).	Lee	is	coded	L-000	(L,	000	added).

Number Represents	the	Letters
1 B,	F,	P,	V
2 C,	G,	J,	K,	Q,	S,	X,	Z
3 D,	T
4 L
5 M,	N
6 R

Disregard	the	letters	A,	E,	I,	O,	U,	H,	W,	and	Y.

Additional	Soundex	Coding	Rules:
Names	With	Double	Letters:	If	the	surname	has	any	double	letters,	they	should	be	treated	as	one	letter.	For	example:

Gutierrez	is	coded	G-362	(G,	3	for	the	T,	6	for	the	first	R,	second	R	ignored,	2	for	the	Z).
Names	with	Letters	Side-by-Side	that	have	the	Same	Soundex	Code	Number:	If	the	surname	has	different	letters	side-by-side	that	have
the	same	number	in	the	Soundex	coding	guide,	they	should	be	treated	as	one	letter.	Examples:

Pfister	is	coded	as	P-236	(P,	F	ignored,	2	for	the	S,	3	for	the	T,	6	for	the	R).
Jackson	is	coded	as	J-250	(J,	2	for	the	C,	K	ignored,	S	ignored,	5	for	the	N,	0	added).
Tymczak	is	coded	as	T-522	(T,	5	for	the	M,	2	for	the	C,	Z	ignored,	2	for	the	K).	Since	the	vowel	"A"	separates	the	Z	and	K,	the
K	is	coded.

Names	with	Prefixes:	If	a	surname	has	a	prefix,	such	as	Van,	Con,	De,	Di,	La,	or	Le,	code	both	with	and	without	the	prefix	because	the
surname	might	be	listed	under	either	code.	Note,	however,	that	Mc	and	Mac	are	not	considered	prefixes.For	example,	VanDeusen	might
be	coded	two	ways:V-532	(V,	5	for	N,	3	for	D,	2	for	S)	or	D-250	(D,	2	for	the	S,	5	for	the	N,	0	added).
Consonant	Separators:	If	a	vowel	(A,	E,	I,	O,	U)	separates	two	consonants	that	have	the	same	Soundex	code,	the	consonant	to	the	right
of	the	vowel	is	coded.	Example:Tymczak	is	coded	as	T-522	(T,	5	for	the	M,	2	for	the	C,	Z	ignored	(see	"Side-by-Side"	rule	above),	2
for	the	K).	Since	the	vowel	"A"	separates	the	Z	and	K,	the	K	is	coded.	If	"H"	or	"W"	separate	two	consonants	that	have	the	same
Soundex	code,	the	consonant	to	the	right	of	the	vowel	is	not	coded.	Example:	Ashcraft	is	coded	A-261	(A,	2	for	the	S,	C	ignored,	6	for
the	R,	1	for	the	F).	It	is	not	coded	A-226.

Please	visit	the	NARA	Soundex	Indexing	page	to	learn	more	about	Soundex	Indexing	System.	

Statistics
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Fig.	12.55	Statistics	Gramplet	-	detached
example

The	Statistics	Gramplet	runs	a	Statistics	report.	Double-click	the	phrases	to	bring	up	the	matching	items.

Following	information	is	provided	to	you	in	this	Gramplet:

Individuals
Number	of	individuals
Males
Females
Individuals	with	other	gender
Individuals	with	unknown	gender
Incomplete	names
Individuals	with	missing	birth	dates
Disconnected	individuals

Family	information
Number	of	families
Unique	surnames

Media	objects
Individuals	with	media	objects
Total	numbers	of	media	object	references
Number	of	unique	media	objects
Total	size	of	media	objects
Missing	Media	Objects

As	with	all	Gramplets	if	you	click	on	the	left	hand	side	 Tool 	button	you	detach	the	window	and	if	you	add	persons	to	your	family	tree,	you	will
see	the	amount	of	individuals	change	dynamically.

The	information	given	in	this	Gramplet	is	the	same	as	in	the	Database	Summary	Report	and	similar	to	the	result	from	the	 Database
Information 	dialog.	

Surname	Cloud

Fig.	12.56	Surname	Cloud	Gramplet	-	detached
example
Gramplets	-	Gramplets 174

http://www.gramps-project.org/wiki/index.php/File:Statistics-Gramplet-detached-52.png
http://www.gramps-project.org/wiki/index.php/File:SurnameCloud-Gramplet-detached-50.png


The	Surname	Cloud	Gramplet	shows	the	top	100	(by	default)	used	surnames.	The	name	font	size	is	proportional	to	the	amount	of	people	with	the
same	name.

Double-click	a	surname	to	run	the	 Same	Surnames	Quick	View .	This	will	open	the	 Quick	View 	window	where	you	can	find	all	people	with
a	matching	or	alternate	name.	Person,	birth	date	and	name	type	are	given.

If	you	mouse	over	the	name	you	see	the	percentage	of	occurrence	and	total	counts.	

Fig.	12.57	Surname	Cloud	Gramplet	-	Configuration
tab	shown

You	can	change	the	number	of	names	displayed	by	configuring	the	view	for	this	gramplet.	

To	Do

Fig.	12.58	To	Do	Gramplet	-	detached	example

The	To	Do	Gramplet 	displays	a	free	form	text	area	showing	the	contents	of	Note	objects	of	the	"To	Do"	type.	The	Type	of	To	Do	note	is	filtered	to
the	current	category.

You	can	use	this	area	to	put	some	notes,	remarks,	things	you	should	to	get	your	research	going.	There	are	several	other	To	Do	programs	(e.g.
Tomboy	e.a.)	but	these	Gramplets	are	useful	as	the	information	stays	within	the	Gramps	database.

To	Do	Gramplets	allow	you	to	create	notes	and	attach	them	to	Gramps	objects.	For	example,	you	can	add	a	Person	To	Do	Gramplet	to	the	sidebar	of
the	Person	View.	Notes	added	using	this	Gramplet	will	be	attached	to	the	currently	active	person.	There	is	a	To	Do	Gramplet	for	each	Gramps
primary	object	type.	
See	also	the	experimental	Third-party	Addon:

ToDo	Notes	Gramplet	available	for	the	Dashboard	that	lists	all	To	Do	notes	in	the	database,	together	with	the	object	to	which	they	are
attached.

Top	Surnames
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Fig.	12.59	Top	Surnames	Gramplet	-
detached	example

The	Top	Surnames	Gramplet	shows	the	top	10	(by	default)	used	surnames.

The	top	ten	is	presented	as	follows:

Surname
percentage
occurrences

The	list	gives	you	also	the	Total	unique	surnames	in	the	database	as	well	as	the	total	number	of	people	in	your	database.

Double-click	a	surname	to	run	the	 Same	Surnames	Quick	View .	This	opens	the	 Quick	View 	window,	which	gives	the	people	with	the
surname	you	double-clicked.

A	table	is	presented	which	shows	all	people	with	a	matching	name	or	alternate	name.	Person's	name,	ID,	birth	date	and	name	type	is	given.	

Uncollected	Objects

Warning!	Diagnostic	Tool

Do	not	use	this	Debug	feature	on	your	working	Family	Tree.	Always	create	a	new	empty	Family	Tree	or
a	copy	of	your	existing	Family	Tree	for	testing.
This	option	is	only	available	when	Gramps	has	been	started	using	a	developer	mode	switch.	It	is	not
intended	for	general	use	and	has	limited	safeguards.

Fig	12.60	Uncollected	Objects	Gramplet	-	detached	example

The	 Uncollected	Objects 	Gramplet	is	intended	to	list	the	low-level	Python	objects	that	are	left	around	in	memory	and	cannot	be	(easily)
automatically	deleted	when	they	are	no	longer	in	use.	Developers	use	it	to	try	to	identify	the	source	of	memory	'leaks',	which	cause	Gramps	to
continually	use	more	and	more	memory,	the	longer	it	is	used.

Because	the	tool	is	trying	to	display	objects	that	might	still	be	getting	deleted,	it	sometimes	has	some	trouble.	
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Welcome

Fig.	12.61	Welcome	Gramplet	-	detached	example

The	Welcome	to	Gramps!	Gramplet	gives	an	introductory	message	to	new	users,	and	some	basic	instructions.

The	welcome	message	describes	what	Gramps	is,	that	the	program	is	Open	Source	Software	and	how	you	start	a	 Family	Tree.	

What's	Next

Fig.	12.62	What's	Next?	Gramplet	-	detached	example

The	What's	Next?	Gramplet	displays	a	list	of	the	"most	urgent"	information	gaps	in	your	family	tree.	It	is	based	on	the	following	assumptions:

The	Home	Person	defines	the	focus
Searches	for	gaps.	The	search	begins	with	the	Home	Person's	descendants	and	works	up	the	tree
The	record	for	each	person	is	expected	to	contain:	the	given	name,	surname,	birth	(with	date	and	place),	and	death	(with	date	and	place)
You	want	to	know	parents,	their	marriage	(with	date	and	place),	and	-	if	divorced	-	divorce	date	and	place	of	each	family	with	married	parents
You	want	to	know	at	least	the	mother	of	each	family	with	unmarried	parents
The	closer	the	relationship	to	the	Home	Person,	the	more	"urgent"	the	information	gap	is.
The	closer	the	common	ancestor	is	from	the	main	person,	the	more	"urgent"	the	information	is	(e.g.	nephews	are	considered	more	"urgent"
than	uncles,	even	though	both	have	a	distance	of	3	generations,	because	for	nephews	the	common	ancestor	is	father/mother,	while	for	uncles,
the	common	ancestor	is	grandfather/grandmother)
Marriage	data	and	personal	data	of	the	spouse	is	slightly	less	"urgent"	than	personal	data	of	the	directly	related	person
Half-siblings	are	less	"urgent"	than	siblings

You	may	copy	the	text	from	inside	of	this	Gramplet	by	selecting	it	and	pasting	into	an	empty	document.	

Fig.	12.63	What's	Next?	Gramplet	-	Configuration	tab
shown

The	Gramplet	can	ignore	previously	verified	events	by	making	use	of	some	custom	Tags.	The	tags	are	selected	in	the	Gramplets	configuration.	For
example	you	can	tag	the	following	to	be	ignored:
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that	a	person	is	complete
that	a	family	is	complete
that	a	person	or	family	should	be	ignored	for	shortening	lists

Previous Index Next
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Reports

Previous Index Next

Fig.	13.1	Menubar	-	Reports
Overview

This	section	describes	all	the	different	reports	available	in	Gramps.

Gramps	comes	with	a	large	number	of	available	reports.	The	different	subsections	describe	the	various	possibilities	and	options:

Additional	Reports

Gramps	has	even	more	reports	available	to	install,	made	by	volunteers	just	like	you	they	are	called
Addons	and	you	check	the	growing	list	of	available	reports	here..	This	system	is	controlled	by	the	Plugin
Manager.

Introduction
Generating	Reports:	This	first	subsection	gives	you	some	general	remarks.

Reports

Fig.	13.2	"Reports"	toolbar	icon	for	"Open	the	reports	dialog"

The	reports	can	be	accessed	by	choosing	the	menu	Reports	->Report	Section	->Particular	Report	.

Alternatively,	you	can	browse	the	complete	selection	of	available	reports	along	with	their	brief	descriptions	in	a	 Report	Selection 	dialog

invoked	by	clicking	the	 	 Reports	(Open	the	reports	dialog) 	icon	on	the	toolbar	from	any	of	the	categories.	

Report	Selection	dialog

Fig.	13.3	Report	Selection	-	dialog	-	default	information
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Fig.	13.4	Report	Selection	-	dialog	-	example	showing	"Timeline
Chart"	information

The	 Report	Selection 	dialog	allows	you	to	browse	the	complete	selection	of	available	reports	along	with	their	brief	descriptions	when

invoked	by	clicking	the	 	 Reports	(Open	the	reports	dialog) 	icon	on	the	toolbar	from	any	of	the	categories.

Select	a	report	from	those	available	on	the	left.	Use	the	 ▶ 	arrows	to	expand	the	top	level	listings:

Graphs
Graphical	Reports
Text	Reports
Web	Pages

Then	select	the	report	you	are	interested	in	to	be	shown	on	the	right	hand	side	the	following:

Report	name
Report	description
Status:
Author:
Author's	email:

You	can	can	then	use	the	buttons	below	to	either	find	out	more	about	the	report	or	open	and	create	your	report.

Wiki 	opens	the	help	page	if	available	-	needs	an	internet	connection	—	⚡new	for	version	6.0.0
Close 	exits	this	dialog
Generate 	-	 Generate selected report 	-	opens	the	reports	configuration	page.

See	also:	Tool	Selection	dialog

Substitution	Values
Substitution	Values:	you	can	use	some	handy	values	in	your	reports.	(Selected	reports	only)

Books
The	Books	Report	allows	you	to	create	a	custom	genealogy	book	containing	a	collection	of	Gramps	textual	and	graphical	reports	in	a	single
document	(i.e.	a	Book)

Available	items	selections

Alphabetical	Index

Alphabetical	Index	-	This	item	produces	page(s)	with	an	alphabetical	index	of	people	noted	into	selected	textual	reports.

Custom	Text

Custom	Text	-	This	item	produces	a	page	with	three	paragraphs,	each	containing	custom	text:	Initial	Text,	Middle	Text	and	Final	Text.	The	text
input	fields	are	expandable	so	you	can	really	put	all	the	text	you	want	in	there.

Table	Of	Contents

Table	Of	Contents	-	A	Table	of	contents	(TOC)	is	generated	for	book	as	a	list	of	the	parts	of	a	book	or	document	organized	in	the	order	in	which	the
parts	appear.

Title	Page
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Title	Page	-	A	title	page	for	your	book.

Graphs
Graphs	reports	are	created	in	Graphviz	format	and	then	converted	into	graphical	output	running	it	through	the	Graphviz	dot	tool	behind	the	scene.

Family	Lines	Graph

The	Family	Lines	Graph	creates	an	easy-to-follow	graph.

Hourglass	Graph

The	Hourglass	Graph	generate	an	hourglass	graph.

Relationship	Graph

The	Relationship	Graph	creates	a	complex	relationship	graph.

Graphical	Reports
Graphical	reports	represent	information	in	forms	of	charts	and	graphs.

Ancestor	Tree

The	Ancestor	Tree	report	generates	the	chart	of	people	who	are	ancestors	of	the	Active	Person.

Calendar

The	Calendar	report	produces	a	calendar	with	birthdays	and	anniversaries	on	a	page	by	month.

Descendant	Tree

The	Descendant	Tree	report	generates	a	graph	of	people	who	are	descendants	of	the	Active	Person.

Descendants	Lines

Addon:DescendantsLines	-	Third	Party	Addon.

Family	Descendant	Tree

The	Family	Descendant	Tree	generates	a	graph	of	people	who	are	descendants	of	the	Active	Family.

Family	Tree

Addon:Family	Tree	-	Third	Party	Addon.

Fan	Chart

The	Fan	Chart	report	produces	a	chart	resembling	a	fan,	with	Active	Person	in	the	center,	parents	the	semicircle	next	to	it,	and	so	on,	for	a	total	of
five	generations.

See	also

Gramplets:
Fan	Chart	(ancestor)
2-way	Fan	Chart	(ancestor	and	descendant)
Descendant	Fan	Chart

Charts	category	view	modes:
Fan	Chart	(ancestor)
2-way	Fan	(ancestor	and	descendant)
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Descendant	Fan

Reports	:	Graphical	reports:
Fan	Chart...	(ancestor)

Pedigree	Chart

Addon:PedigreeChart	-	Third	Party	Addon.

Statistics	Charts

The	Statistics	Charts	report	can	collect	and	display	a	wealth	of	statistical	data	about	your	database.

Timeline	Chart

The	Timeline	Chart	report	outputs	the	list	of	people	with	their	lifetimes	represented	by	intervals	on	a	common	chronological	scale.

Text	Reports
Text	reports	output	information	as	formatted	text.

Ahnentafel	Report

The	Ahnentafel	Report	lists	the	Active	Person	and	his	or	her	ancestors	along	with	their	vital	data.	The	people	are	numbered	in	an	establish	standard
called	'Ahnentafel'.

Ancestorfill	Report

Addon:Ancestor	Fill	Report	-	Third	Party	Addon.

Birthday	and	Anniversary	Report

The	Birthday	and	Anniversary	Report	gives	the	same	information	as	a	calendar	but	in	text	format.

Complete	Individual	Report

The	Complete	Individual	Report	provides	individual	summaries	similar	to	that	of	the	Individual	Summary	Report.

Database	Differences	Report

Addon:Database	Differences	Report	-	Third	Party	Addon.

Database	Summary	Report

The	Database	Summary	Report	displays	the	overall	statistics	concerning	number	of	individuals	of	each	gender,	various	incomplete	entries	statistics,
as	well	as	family	and	media	statistics.

Descendant	Book

Addon:Descendant	and	Detailed	Descendant	Book	Reports	-	Third	Party	Addon.

Descendant	Report

The	Descendant	Report	presents	the	descendants	of	the	Active	Person	with	a	brief	description	in	intended	style.

Detailed	Ancestral	Report

The	Detailed	Ancestral	Report	covers	in	detail	the	ancestors	of	the	Active	Person,	including	a	range	of	vital	data	as	well	as	marriages.

Detailed	Descendant	Book

Addon:Descendant	and	Detailed	Descendant	Book	Reports	-	Third	Party	Addon.

Detailed	Descendant	Report

The	Detailed	Descendant	Report	covers	in	detail	the	descendants	of	the	Active	Person	by	generation,	following	the	genealogical	tradition	of	textual
descendant	reports	by	generation.	It	aims	to	provide	all	important	features	expected	to	be	found	in	these	classic	descendency	formats	and	has
received	influence	from	various	sources.

Detailed	Descendant	Report	with	all	Images

Addon:Detailed	Descendant	Report	With	All	Images	-	Third	Party	Addon.
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Double	Cousins

Addon:DoubleCousinReport	-	Third	Party	Addon.

End	of	Line	Report

The	End	of	Line	Report	provides	a	list	of	of	the	person's	last	known	ancestors	with	the	pedigree	line,	ordered	by	generations.

Family	Group	Report

The	Family	Group	Report	creates	a	family	group	report,	showing	information	on	a	set	of	parents	and	their	children.

Family	Sheet	Report

Addon:Family	Sheet	-	Third	Party	Addon.

Kinship	Report

Kinship	Report	provides	the	kinship	of	selected	person	according	to	level	search(	height,	down	generations)	set	by	the	user.

Last	Change	Report

Addon:LastChange	-	Third	Party	Addon.

Lines	of	Descendancy	Report

Addon:Lines	of	Descendency	Report	-	Third	Party	Addon.

Media	Report

Addon:MediaReport	-	Third	Party	Addon.

Note	Link	Report

The	Note	Link	Report	checks	the	status	of	internal	Gramps	links	in	notes.

Note	Report

Addon:Note_Report	-	Third	Party	Addon.

Number	of	Ancestors	Report

The	Number	of	Ancestors	Report	displays	the	number	of	ancestors	of	the	Active	Person.	The	form	is	-	generation	x	has	y	individuals	(z	%).

PersonEverything	Report

Addon:PersonEverything	Report	-	Third	Party	Addon.

Place	Report

The	Place	Report	produces	a	report	according	to	places	selected	by	the	user.	It	will	list	related	person	and	event	to	the	selected	place.

Records	Report

Records	Report	shows	a	number	of	interesting	records(mostly	age	related)	in	your	database,	like	oldest	living	person,	youngest	mother,etc.

Repositories	Report

Addon:Repositories	Report	-	Third	Party	Addon.

Repositories	Options	Report

Addon:Repositories	Options	Report	Third	Party	Addon.

Sandclock	Tree	Report

Addon:GenealogyTree	(Sandclock	tree	subsection)	Report	-	Third	Party	Addon.

Sources	and	Citations	Report

Addon:Sources	Citations	Report	-	Third	Party	Addon.

Tag	Report

The	Tag	Report	lists	primary	objects	-	persons,	families,	and	notes	-	who	match	the	selected	tag.
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TinyTafel	Report

Addon:TinyTafel	-	Third	Party	Addon.

ToDo	Report

Addon:ToDo	Report	-	Third	Party	Addon.

Web	Pages
Web	Pages	for	use	on	your	personal	website	or	to	give	away	as	a	standalone	report.

Narrated	Web	Site

The	article	about	the	Narrated	Web	Site	report	describes	the	report	with	extensive	options	for	generating	a	web	site	(i.e.,	a	set	of	linked	web
pages),	for	a	subset	of	selected	individuals.

Web	Calendar

The	Web	Calendar	is	a	Report	that	creates	webpages	showing	events	for	the	selected	individuals	as	a	set	of	monthly	calendars.

Dynamic	Web	Report

The	Dynamic	Web	Report	Addon	creates	interactive	web	pages	of	the	family	tree	database	with	options	allowing	a	wide	range	of	customization.	-
Third	Party	Addon.

This	addon	is	based	on	the	Narrative	Web	Report	native	Gramps	report.

This	section	is	a	placeholder.

Addons	don't	belong	in	this	part	of	the	manual.	
This	section	was	created	to	compensate	for	an	incorrect	address	used	by	the	 Help 	button	in	the	addon
and	has	been	corrected	as	of	the	0.0.82	version	released	3	Jan	2020.	The	new	version	links	to	the	actual
webpage	for	the	Dynamic	Web	Report

See	Also

Web	Solutions	for	Gramps

Quick	Views
Quick	Views	are	reports	that	are	available	in	the	context	menus	of	person,	family,	...	They	maybe	created	by	users,	even	with	limited	programming
knowledge.	

Previous Index Next
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Reports	-	part	1
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Generating	Reports
Reports	are	the	most	common	form	of	the	output	produced	by	genealogical	research.	The	majority	of	genealogical	software	puts	a	lot	of	emphasis
on	developing	nice	looking	reports.	Gramps	is	no	exception	in	this	regard,	offering	a	choice	of	a	variety	of	reports.	Gramps	can	generate	reports	in	a
multitude	of	open	formats,	both	text	based	and	graphical.	Gramps	can	also	produce	screen	based	reports	that	are	convenient	for	viewing	a	summary
of	your	database.	Finally,	Gramps	can	generate	a	web	site	suitable	for	immediate	posting	on	the	Internet.

All	reports	can	be	accessed	by	choosing	the	menu	Reports	->Report	Type->Particular	Report.	Alternatively,	you	can	browse	the	complete

selection	of	available	reports	along	with	their	brief	descriptions	in	a	 Report	Selection 	dialog	invoked	by	clicking	the	 Reports 	icon	on
the	toolbar.

Report	Settings

The	settings	chosen	when	generating	a	report	is	stored	in	the	users	profile,	in	.gramps/report_options.xml,	and	will	be	used	as	default	settings
when	generating	the	next	report.

If	there	is	a	need	to	revert	to	the	default	report	options	for	any	reason,	the	file	report_options.xml	can	be	deleted.

See:

Safe	mode

Report	Format	Style

All	of	the	reports	are	very	flexible.	If	you	wish	to	modify	or	extend	the	default	format	of	Gramps	reports,	you	can	design	and	choose	the	style	for
each	of	your	reports.	Gramps	provides	an	advanced	interface	for	customizing	practically	every	aspect	of	report-styles,	e.g.	for	fonts:	type	face,	size,
color	and	style;	for	paragraphs:	alignment,	background	color,	indentation,	spacing,	and	borders.

See:

Customize	report	output	formats

Back	to	Index	of	Reports.

Previous Index Next

Reports	-	part	1	-	Generating	Reports 185

http://www.gramps-project.org/wiki/index.php/File:Gramps-reports.png


Reports	-	part	2

Previous Index Next

Back	to	Index	of	Reports.

This	section	describes	the	substitution	values	that	can	be	used	in	the	different	reports	available	in	Gramps.

Substitution	Values
Many	of	the	graphical	reports	allow	you	to	customize	the	information	that	is	displayed	on	the	reports.	Variable	substitution	is	the	method	that	is
used	to	substitute	a	particular	symbol	(key)	for	specific	information	about	the	person	in	the	database.

For	example:

Substitution	Keys Will	show	as:	(the	person	is	alive)
Line	1 $n Line	1 Smith,	Edwin	Michael
Line	2 b.	$b{	at	$B} Line	2 b.	1961-05-24	at	San	Jose,	Santa	Clara	Co.,	CA
Line	3 d.	$d<	at	>$D Line	3 d.

In	the	next	section	a	list	of	all	available	variables	(The	Substitution	Keys)	follows.

If	you	wish	to	display	names,	date,	or	place	information	differently,	you	may	use	Format	Strings	to	accomplish	this.
There	are	also	Control	Variables	to	display	special	characters	(like	the	dollar	sign).
You	can	also	use	Grouping	to	optionally	display	information.	In	the	example	above	Line	2,	uses	grouping	to	display	'	at	' 	only	when	the
birth	place	is	known.
Along	with	Events	you	can	print	almost	anything.
Finally,	Separators,	to	make	your	life	complete.	In	the	example	above	Line	3,	uses	this	to	display	'	at	' 	only	when	both	the	birth	date	and
place	is	known.

The	Substitution	Keys

Personal	variables Marital	variables
$n Displays	the	person's	name $s Displays	the	name	of	the	person's	spouse
$i Displays	the	Gramps	ID	for	the	person. $j Displays	the	Gramps	ID	for	the	marriage.
$b Displays	the	person's	date	of	birth $m Displays	the	marriage	date	of	the	person	and	the	spouse.
$B Displays	the	person's	place	of	birth $M Displays	the	place	of	the	marriage	of	the	person	and	the	spouse.
$d Displays	the	person's	date	of	death $v Displays	the	divorce	date	of	the	person	and	the	spouse.
$D Displays	the	person's	place	of	death $V Displays	the	place	of	the	divorce	of	the	person	and	the	spouse.

$a
Displays	an	attribute	about	the	person.

see	Attributes	for	more $u
Displays	an	attribute	about	the	marriage.

see	Attributes	for	more

$e
Displays	event	information	about	the	person.

See	Events	for	more $t
Displays	an	event	information	about	the	marriage.

See	Events	for	more

All	of	the	Marital	variables	are	defined	by	the	person's	preferred	spouse	in	Gramps.	If	the	person	has	never	been	married,	then	these	variables	will
not	display	anything.

Other	Substitution	Keys

$T	Displays	Todays	date.

Default	displayed	formats

Variables Display	format
$n	$s Names	will	be	displayed	as	set	in	'Name	format:'	on	the	Display	tab	in	Gramps	preferences

$B	$D	$M	$V Places	will	display	the	Place	title	by	default
$b	$d	$m	$v	$T Dates	will	be	displayed	as	set	in	'Date	format:'	on	the	Display	tab	in	Gramps	preferences

$e	$t Events	will	display	the	description	by	default

Deprecated	variables

Some	of	the	old	variables	were	deprecated	because	Format	Strings	have	replaced	them.	So	here	is	a	list	of	those	variables	and	how	to	achieve	their
results:

Old	Variable How	to	display	it	now What	is	displayed
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$f $n Name	-	as	by	Gramps	name	display	under	Preferences
$n $n(g	f) Name	-	FirstName	LastName
$N $n(f,	g) Name	-	LastName,	FirstName	(note	the	explicit	comma)
$nC $n(g	F) Name	-	FirstName	LastName	in	UPPER	case
$NC $n(F,	g) Name	-	LastName	in	UPPER	case,	FirstName
$by $b(yyyy) Date	of	birth,	year	only
$dy $d(yyyy) Date	of	death,	year	only
$my $m(yyyy) Date	of	preferred	marriage,	year	only
$p $s Preferred	spouse's	name	as	by	Gramps	name	display	under	Preferences
$s $s(g	f) Preferred	spouse's	name	-	FirstName	LastName
$S $s(f,	g) Preferred	spouse's	name	-	LastName,	FirstName
$sC $s(g	F) Preferred	spouse's	name	-	FirstName	LastName	in	UPPER	case
$SC $s(F,	g) Preferred	spouse's	name	-	LastName	in	UPPER	case,	FirstName

Format	Strings

Format	strings	are	used	to	display	names	and	dates	differently	than	those	assigned	under	Gramps	Preferences.	Here	is	the	syntax	for	a	format	string:

$ key (format	string)
where:	 key 	is	one	of	the	following	characters:	'nsijbmBMdvDVauet'

A	format	string	is	any	text,	separators	or	format	codes	(defined	below)	to	display	information	about	the	person.

Formatting	names

For	names	($n	$s)	you	may	use	the	following	formatting	codes	to	display	the	name	differently.

t Title f Given	name
x Common	name.	Call	name	if	existing,	otherwise	first	first	name c Call	name
n Nick	name s Suffix
l Surname g Family	nickname

These	codes	can	be	upper-cased	to	uppercase	the	result.

For	example:

Formatting	code Displays

$n(L,	f)	($n(c)),	$n(L,	f){	($n(c))}
$s(f	l	s)

SMITH,	Edwin	Michael	(),	SMITH,	Edwin	Michael
Janice	Ann	Adams

If	you	want	to	print	a	character	'c'	within	the	format	string	(or	any	one	of	the	other
format	codes),

you	will	need	to	first	add	a	'\'	in	front	of	it.	See	Control	Variables	for	more.

The	curly	brackets	{	}	are	used	to	hide	information.

Here	it	is	used	around	'	($n(c))'	to	not	display	'	()'	if	the	person	does	not	have	a	call	name.	See
Grouping	for	more.

Formatting	Dates

For	all	of	the	date	variables	($b	$d	$m	$v)	you	may	use	the	following	formatting	codes:

yyyy The	year	as	a	four	digit	number yyy The	year,	with	a	minimum	of	three	digits
yy The	year,	from	00	to	99 y The	year,	from	0	to	99

mmmm

MMMM

The	full	name	of	the	month

The	full	name	IN	CAPS

mmm

MMM

The	abbreviated	name	of	the	month

The	abbreviated	name	IN	CAPS

mm The	month,	from	00	to	12 m The	month,	from	0	to	12
dd The	day,	from	00	to	31 d The	day,	from	0	to	31

o The	date	type	(modifier)

For	example:

Formatting	code displays
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$b(mmm-dd	yy)
$m(yyyy/mmm/d)
$b(mmm-dd	yy)

May-24	61
1995/May/27
Jun-04	85

For	date	types	(modifier)

Only	"Before",	"After",	and	"About"	are	supported	at	this	time.	all	others	will	not	display	anything.
And	for	date	span	and	date	ranges,	only	the	starting	(first)	date	is	displayed.

Formatting	Places

For	all	of	the	place	variables	($B	$D	$M	$V)	you	may	use	the	following	formatting	codes:

e Street l Locality
c City u County
s State p Postal	Code
n Country t Title
x Longitude y Latitude

These	codes	can	be	upper-cased	to	uppercase	the	result.

For	example:

Formatting	code displays

$B
$B(c,	s,	N)

St	Judes	Hospital
Carmel,	IN,	USA

Rules	for	format	strings

Anything	will	print	inside	a	format	string
You	need	to	use	Control	Variables	to	display	things	like	')'	and	format	codes
Separators	can	be	within	format	strings.
At	least	ONE	format	code	has	to	display	something	for	the	ENTIRE	format	string	to	display

For	examples:

Formatting	code displays

$n(f	l)
b.	$b	{at	$B
{d.	$d	$D

Edwin	Michael	Smith
b.	1961-05-24	at	San	Jose,	Santa	Clara	Co.,	CA

The	person	is	still	alive	(or	has	no	information	present)	so	the	line	was
removed.

Control	Variables

Control	variables	allow	you	to	print	characters	that	are	special	to	Substitution	values	within	a	display.

For	example	the	dollar	character	'$'	is	used	to	note	the	start	of	a	variable.	If	you	wish	to	print	a	dollar	character	you	would	use	a	control	character
like	'\$'

Control	Variables Result
\$ Displays	a	single	'$'
\\ Displays	a	single	'\'
\( Displays	a	single	'('
\) Displays	a	single	')'
\{ Displays	a	single	'{'
\} Displays	a	single	'}'
\< Displays	a	single	'<'
\> Displays	a	single	'>'

Basically	anything	that	comes	after	a	'\'	will	be	printed.

When	you	are	inside	a	format	string,

you	may	need	to	use	this	to	display	a	character	that	would	normally	be	a	format	code.

For	example:
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Formatting	code: displays

$b(m	hi	mom)
$b(m	hi	\mo\m)

5	hi	5o5
5	hi	mom

As	this	person	was	born	on	the	fifth
month.

Grouping

There	are	instances	where	you	do	not	want	certain	text	to	be	displayed.

Take	the	example:

Formatting	Code Only	date	is	known Only	place	is	known

died	on	$d	at	$D died	on	1975-06-26	at died	on	at	Reno,	Washoe	Co.,	NV

Neither	of	these	displayed	results	are	very	acceptable.

But	with	groups	(denoted	by	{}),	you	can	optionally	print	information	if	a	variable	within	contains	information.

Formatting	Code Only	date	is	known Only	place	is	known
died{	on	$d}{	at	$D} died	on	1975-06-26 died	at	Reno,	Washoe	Co.,	NV

Which	is	a	more	preferable	displayed	result	than	in	the	first	example.

Rules	for	groups

A	group	will	only	display	if	there	is	at	least	one	variable	that	displays	something.	So	if	a	group	only	has	text	and/or	variables	where	the	information
is	not	known,	the	entire	group	will	not	print.

Groups	can	also	be	nested.	If	this	happens	(like	below),	the	outer	group	will	only	display	if	there	is	at	least	one	variable	that	displays	something
within	the	outer	group	or	any	of	the	sub	groups.

Groups	can	also	be	used	to	remove	text.	If	you	wish	to	not	display	the	entire	line,	'-'	at	the	start	of	a	line	will	remove	the	entire	line	from	the
display	if	the	above	rule	is	true.

If	you	do	not	wish	to	have	the	display	code	above	(for	death	information)	displayed	(the	person	is	alive,	or	you	do	not	yet	know	the	information),
modify	the	code	to	look	like:

-{died{	on	$d}{	at	$D}

Examples

This	will	hide	'('	and	')'	if	the	divorce	information	is	not	known	(or	still	married).

m.	$m	$M	{-	($v(yyyy))

Only	display	some	spouse	information	if	married	or	remove	the	entire	line	if	never	married:

{$s	$m(yyyy)	{-	$v(\(yyyy\))}}

Attributes

Attributes	do	not	have	a	format	string.	Instead	the	attribute	name	is	placed	inside	[].	Here	is	the	syntax	for	an	attribute:

$ key [attribute	name]
where:	 key 	is	one	of	the	following	characters:	'au'

For	example:

Formatting	code displays

$a[Profession]
$a[Social	Security	Number]
$a[Total	\$	bequeathed]

Programmer
7A3-29-F1C6
3.00USD

Events

Events	have	the	same	starting	structure	as	attributes,	$e	or	$t	and	the	event	name	in	[]	but	events	have	an	extra	format	string	after	the	name	to
display	the	description,	date,	place,	id,	and	attributes	associated	with	it.	Each	of	these	items	can	be	displayed	with	a	,	a	'n',	'd',	'D',	'i',	and	'a'
respectively	in	the	format	string.	Here	is	the	syntax	for	an	event:

$ key [attribute	name](format	string)
where:	 key 	is	one	of	the	following	characters:	'et'

Event	format	strings
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The	Event	format	string	is	used	to	display	information	about	the	event.	Here	are	the	format	codes	to	display	parts	of	the	event:

Formatting	code displays Formatting	code displays
n Description i Event	ID
d Event	Date* D Event	Place*
a An	attributes	for	the	event**

*These	variables	can	themselves	have	format	strings.	Date	and	a	place	can	be	formatted	with	format	string	as	defined	in	Format	strings.

**Attribute	needs	to	have	the	attribute	name	in	[]	and	are	formatted	as	above.

For	example:

Formatting	code displays

$e[First	Communion](d(yyyy-mm-d))
$e[Bar	Mitzvah](n<	at	>	D)
$e[Birth](d(yyyy	mm/dd)	D)

2009-11-6
Jerry's	Bar	Mitzah	at	Opas	house
2007	05/23	Grandmothers	house

And:

Formatting	code displays

$b(yyyy-Mmm-dd)
$M is	the	same	as $e[Birth](d(yyyy-Mmm-dd))$t[Marriage](D)

Notes	for	attributes	and	events

Attribute	and	event	names	are	mandatory.	'$a'	or	'$a[]'	will	not	display	anything.

Attributes	and	event	names	may	have	special	characters	within	them.	Most	notably	']'	and	')'.	If	this	is	the	case,	you	will	need	to	use	Control
Variables

Separators

Separators	are	special	'text	only'	groups	inside	'<'	and	'>'	that	conditionally	display	a	separator	(like	',	'	or	'	-	')	between	two	groups,
variables,	format	codes	or	text.

Separators	are	displayed	conditionally	depending	on	these	rules:

A	variable	that	does	not	display	anything	will	remove	itself	and	a	separator	that	is	to	the	left	of	it	from	the	display	line	only.
If	there	is	not	a	separator	to	the	left,	the	same	variable	will	remove	itself	and	a	separator	that	is	to	the	right	of	it	from	the	displayed	line.
If	there	are	two	separators	together,	the	left	one	will	be	removed	from	the	display	line	and	the	right	is	kept.
Separators	at	the	start	or	end	of	the	display	line	(or	format	strings)	are	removed.

Take	this	example	formatting	code:

$s(f	l	s)<,	>$m(yyyy)<	@	>$M<	-	>$v(\(yyyy\))

Here	are	some	things	that	may	happen:

Possibility Outcome
If	none	of	the	variables	are	known None	of	the	separators	will	display
If	only	one	variable	is	known Only	that	variable	will	print.	No	separators	will	print.
If	only	the	spouse's	name	is	not	known The	first	separator	will	not	display

If	only	the	marriage	date	is	not	known
The	first	separator	does	not	display.	We	will	be	left	with:

Jane	Doe<	-	>{	…	}And	only	the	divorce	date	needs	to	be	known	to	print	the	second	separator.

If	only	the	divorce	date	is	not	known the	second	separator	will	not	display

Separators	can	be	inside	format	strings:

$n(<0>T<	>L<,	>f<	>s)

Unlike	groups,	separators	can	not	cross	over/out	of	format	strings.	So	the	separator	<0>	will	NEVER	display.	No	matter	what	is	on	the	left	hand	side
of	the	variable.

Here	is	a	useful	example:

{({b.	$b}<,	>{d.	$d})}

This	will:
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Only	print	the	outside	()	if	either	the	birth	or	death	date	displays

Only	displays	the	center	separator	if	both	dates	are	known.
So	here	are	some	thing	that	could	display

(b.	1970-4-8) (d.	2012-3-9) (b.	1970-4-8,	d.	2012-3-9) or	the	line	does	not	print	at	all.We	will	not	see	things	like:
() (,	) (b.) (b.,	) (d.)

(,	d.) (b.	1970-4-8,	) (b.	1970-4-8,	d.) (,	d.	2012-3-9) (b.,	d.	2012-3-9)

Back	to	Index	of	Reports.

Previous Index Next
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Fig.	13.3.1	Menu	entry	for
Reports

This	section	describes	the	Book	report	available	in	Gramps.

Books
The	Books	Report	allows	you	to	create	a	custom	genealogy	book	containing	a	collection	of	Gramps	textual	and	graphical	reports	in	a	single
document	(i.e.	a	Book)

The	only	report	available	under	this	report	is	the	Books	Report.

When	you	select	Reports-->Books...	from	the	menu,	the	main	 Manage	Books 	dialog	appears.	

Manage	Books	dialog

Fig.	13.3.2	Manage	Books	-	dialog

The	main	 Manage	Books 	dialog	has	three	sections	 Book	name: ,	 Available	items 	and	 Current	book

To	start	the	creation	of	your	custom	genealogy	book	click	the	 OK 	button	once	all	selections	of	the	reports	to	be	included	have	been	made,	and
possibly	configured	(or	reconfigured)	or	to	just	accept	the	defaults;	this	will	present	the	 Generate	Book 	dialog.

Book	name

The	 Book	name: 	(New	Bookdefault)	text	entry	field	shows	the	name	of	the	current	book.	Change	it	and	save	your	custom	book	(a	set	of
configured	selections)	for	future	use,	in	which	case	you	may	first	alter	the	field	to	contain	whatever	name	you	want.	If	you	load	a	saved-away	book
(see	below)	it	will	show	that	book's	name	--	which	may	then	be	changed	if	you	want	to	save	a	slightly-different	configuration.

Book	name	toolbar

The	top	horizontal	set	of	set	of	toolbar	icons	near	the	 Book	name: 	field	operate	on	the	whole	book	and	allow	the	following	functions:

The	 Clear	the	book 	icon	button	clears	all	previously	selected	 Available	items 	items	from	the	 Current	book 	section.
The	 Save	current	set	of	configured	selections 	icon	button	to	save	the	current	book	(under	the	name	previously	typed	in	the
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Book	name: 	text	entry	field)	for	future	use,	if	the	book	name	already	exists	you	will	be	asked	if	you	wanted	to	 Proceed 	to	save	over	it
or	you	can	 Cancel 	and	provide	another	name.	Saving	the	book	also	saves	the	configuration	for	each	of	the	 Available	items 	you
setup.

Fig.	13.3.3	"Open	previously	created	book"	icon	and	resulting
"Available	Books"	-	dialog

Select	the	 Open	previously	created	book 	icon	button	to	open	the	 Available	Books 	window	which	shows	all	your	previously-
saved	books.	In	that	box	either	double-click	on	a	particular	book	name	or	first	select	it	and	then	hit	 OK 	to	then	load	the	book.

Fig.	13.3.4	"Manage	previously	created	books"	icon	and
resulting	"Available	Books"	-	dialog

You	can	also	select	the	 Manage	previously	created	books 	icon	button	to	open	a	slightly	different	 Available	Books 	window
which	shows	your	list	of	available	books,	and	by	using	the	 Delete 	button	you	can	removed	the	selected	book.

Available	Books	window

1889	[Book	report]	Merge	buttons	and	windows	for	opening	and	managing	book
reports.

Available	Books	window	(1)
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Fig.	13.3.5	"Open	previously	created	book"	icon	and	resulting
"Available	Books"	-	dialog

Available	Books 	window

"Open	previously	created	book"	icon	and	resulting	"Available	Books"	-	dialog	

Available	Books	window	(2)

Fig.	13.3.6	"Manage	previously	created	books"	icon	and
resulting	"Available	Books"	-	dialog

Available	Books 	window	with	Delete	button	!

"Manage	previously	created	books"	icon	and	resulting	"Available	Books"	-	dialog	

Available	items

The	middle	section	 Available	items 	lists	the	book	items	available	for	inclusion	in	the	book.	

Available	items	selections

Almost	all	26	book	items	available	for	inclusion	in	the	book	are	textual	or	graphical	reports,	and	are	therefore	available	in	the	form	of	standalone
reports	(see	Index	of	Reports	for	their	individual	documentation).	The	exceptions	are	the	following	4	items	which	are	only	available	as	book	items,
in	a	book	report:

Alphabetical	Index
Custom	Text
Table	Of	Contents
Title	Page

The	other	22	book	items	do	not	have	the	 Paper	Options 	tab	that	is	available	only	to	the	standalone	reports.	Note	the	book	item	version	of	the
report	may	be	named	slightly	differently	to	the	standalone	version.

Ancestor	Chart	-	same	as	the	Ancestor	Tree	report.
Calendar
Descendant	Chart	-	same	as	the	Descendant	Tree	report.
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Alphabetical	Index

Fig.	13.3.7	Alphabetical	Index	-	item

The	 Alphabetical	Index 	book	item	produces	page(s)	with	an	alphabetical	index	of	people	noted	into	selected	textual	reports.

On	the	 Report	Options 	tab	you	may	choose	the	 Translation: 	language	from	the	drop	down	list.

This	book	item	is	only	available	in	a	book	report.	

Custom	Text

Fig.	13.3.8	Custom	Text	-	item

The	 Custom	Text 	book	item	produces	a	page	with	three	paragraphs,	each	containing	custom	text.

The	 Text 	tab	shows:

Initial	Text:
Middle	Text:
Final	Text:

The	text	input	fields	are	expandable	so	you	can	really	put	all	the	text	you	want	in	there.

The	lower	window	part	shows	some	 Document	Options :	here	you	can	choose	the	 Style .	You	can	choose	the	default	style	or	click	on	the
Style	Editor... 	button.	This	brings	up	a	 Style	Editor 	window	where	you	can	add	and	remove	Styles.	For	more	details	see	also	style
editor.	This	item	is	typically	meant	to	be	used	for	epigraphs,	dedications,	explanations,	notes,	and	so	forth.

This	book	item	is	only	available	in	a	book	report.	

Table	Of	Contents
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Fig.	13.3.9	Table	Of	Contents	-	item

A	 Table	Of	Contents 	(TOC)	is	generated	for	the	book	as	a	list	of	the	parts	of	a	book	or	document	organized	in	the	order	in	which	the	parts
appear.

On	the	 Report	Options 	tab	you	may	choose	the	 Translation: 	language	from	the	drop	down	list.

This	book	item	is	only	available	in	a	book	report.

For	Open	Document	Text	(ODT)	file	output

The	Table	Of	Contents	and	Index	are	inserted	into	the	document	but	are	not	generated	by	Gramps.	Using
the	LibreOffice	Writer	Word	Processor,	Right	click	in	the	created	document	in	then	click	on	 Update
Index	or	Table	of	Contents 	in	the	context	menu	to	generate	the	entries.

Title	Page

Fig.	13.3.10	Title	Page	-	item

If	you	selected	the	 Title	Page 	book	item	and	clicked	the	 Add 	button	to	put	this	item	in	your	book	and	you	click	 Preferences 	button
(Configure	currently	selected	item)	you	will	get	a	 Title	Page 	window.

On	the	 Report	Options 	tab	you	have	three	text	input	fields	available	where	you	can	change	the	example	text	provided.

Title: 	(Title	of	the	Book	default)
Subtitle: 	(Subtitle	of	the	Book	default)
Footer: 	(Copyright	2024	Alex	Roitman...	default)	(FYI	Alex	was	an	early	Gramps	project	contributor)

Image: 	allows	an	image	to	be	placed	optionally	between	the	subtitle	and	the	footer,	by	selecting	the
Select	an	existing	media	object 	button	which	will	show	the	 Select	Media	Object 	selector	dialog	where	you	can
select	the	existing	image	you	want.

Image	Size: 	You	can	also	change	the	default	(0.0)	size.

The	lower	window	part	shows	some	Document	Options:	here	you	can	choose	the	Style.	You	can	choose	the	default	style	or	click	on	the	 Style
Editor... 	button.	This	brings	up	a	 Style	Editor 	window	where	you	can	add	and	remove	Styles.	For	more	details	see	also	Style	Editor.

Because	you	can	configure	the	various	elements,	this	item	can	be	used	to	create	title	pages	for	the	whole	book,	its	chapter,	or	even	a	single	item.

This	book	item	is	only	available	in	a	book	report.	
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Current	book

The	bottom	section	 Current	book 	lists	the	currently	selected	items	in	the	order	they	will	appear	in	the	book.	

Current	book	toolbar

Fig.	13.3.11	Manage	Books	-	dialog

The	bottom	right	vertical	set	of	toolbar	icons	beside	the	 Current	book 	section	table	operate	on	the	sections	and	allow	the	following	functions:

Use	the	 +	Add	an	item	to	the	book 	icon	button	to	add	the	selected	item	from	the	top	 Available	items 	section	list	to	the
Current	book 	section	list	below.	Using	the	 Ctrl + A 	shortcut	or	double-clicking	the	(top	list's)	selected	item	will	also	add	it.
Use	the	 -	Remove	currently	selected	item	from	the	book	icon	button	to	remove	an	item	from	the	bottom	 Current	book
section	list.
Use	the	 Up	arrow	Move	current	selection	one	step	up	in	the	book	icon	button	to	change	the	order	of	the	selected	item	in
the	 Current	book .
Use	the	 Down	arrow	Move	current	selection	one	step	down	in	the	book	icon	button	to	change	the	order	of	the	selected
item	in	the	 Current	book .
With	the	 Configure	currently	selected	item 	icon	button	you	can	configure	the	options	of	the	selected	item	of	the	 Current
book 	--	but	you	must	select	the	item	first	otherwise	the	 No	selected	book	item 	warning	will	be	shown.	Double-clicking	an	item	will
also	start	a	configuration	dialog.	The	configuration	dialog	invoked	by	 Configure	currently	selected	item 	icon	button	are	item-
specific.	If	you	choose	not	to	configure	the	item,	some	defaults	will	be	used	for	all	needed	options.	The	common	option	for	almost	all	book
items	is	the	center	person:	the	person	on	whom	the	item	is	centered.	Thanks	to	this	option,	you	can	create	a	book	with	items	centered	on
different	people	(e.g.	your	mom's	and	dad's	ancestors	as	separate	chapters).	By	default,	the	center	person	is	set	to	the	 Active	Person .

No	selected	book	item	-	warning

Generate	Book	dialog

Fig.	13.3.12	Generate	Book	-	dialog
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You	will	see	the	 Generate	Book 	dialog	once	you	have	selected	the	 Manage	Books 	dialogs	 OK 	button	to	accept	the	defaults	and	start	the
creation	of	your	custom	genealogy	book.

There	are	two	sections	 Paper	Options 	and	 Document	Options :

Paper	Options

Paper	Options 	where	you	can	change	the	Size	and	Orientation	for	the	Paper	Format,	and	all	Margins.	A	Checkbox	is	available	to	use	metric
values	instead.

Document	Options

The	 Document	Options 	section	allows	you	to	change	the:

Output	Format: 	use	the	drop	down	menu	to	change	output	format:
PDF	document	(default)
PostScript
OpenDocument	Text
Print...

	 Open	with	default	viewer 	if	checked	allow	you	to	open	in	the	default	viewer	eg:	LibreOffice	Writer	Word	Processor.	(checkbox
unchecked	by	default)
Filename: 	enter	your	filename,	note	the	filename	extension	changes	depending	on	the	output	format.	eg:	For	PDF	documents	the	default
value	is	/yourhomedir/<Family	Tree	name>_book.pdf	and	OpenDocument	Text	the	default	value	is	/yourhomedir/<Family	Tree
name>_book.odt,	et	cetera.

See	also

Add	a	table	contents	or	an	index	to	a	Book	of	Reports
Creating	plugin	Reports	for	collation	compatibility	in	the	Books	feature.

Back	to	Index	of	Reports.

Previous Index Next
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Reports	-	part	4

Previous Index Next

Back	to	Index	of	Reports.

Fig.	13.4.1	Reports	>Graphical	Reports>...	Menu	overview

This	section	describes	the	different	 Graphical	Reports 	available	in	Gramps.

Graphical	Reports
Graphical	reports	represent	information	in	forms	of	charts	and	graphs.	Most	of	the	options	are	common	among	graphical	reports,	therefore	they	will
be	described	only	once,	at	the	end	of	this	section.	The	few	options	which	are	specific	to	a	given	report	will	be	described	directly	in	that	report's
entry.	See	also	substitution	values.

The	following	graphical	reports	are	available	in	Gramps:

Common	options

Common	options	for	text	reports	are	the	filename	of	the	output,	the	format	of	the	output,	selected	style,	page	size	and	orientation.	For	HTML
reports,	there	is	no	page	information.	Instead,	HTML	options	include	the	choice	of	the	HTML	template,	either	available	in	Gramps	or	a	custom
template	defined	by	you.	Optionally,	the	reports	can	be	immediately	opened	with	the	default	application.

Tip:	The	options	used	in	reports	are	persistent.

Each	report	remembers	the	options	previously	used.

The	options	which	are	specific	to	a	given	report	will	be	described	directly	in	that	report's	entry	and	on	Command	line	references.

For	each	report	there	is	a	screen	with	on	the	top	part	tabs	(like	Paper	Options...)	and	on	the	bottom	part	the	Document	Options.	The	number	of	tabs
varies	with	the	report.

Paper	Options

Fig.	13.4.2	Paper	Options	-	tab	for	Graphical	Reports

With	the	 Paper	Options 	tab	you	can	change:

Paper	format
Size 	Letter	(default)
Width 	(8.50	in.	default)
Height 	(11.00	in.	default)
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Orientation 	Portrait	(default)
Margins

Left (1.00	in.	default)
Right (1.00	in.	default)
Top (1.00	in.	default)
Bottom (1.00	in.	default)

	 Metric 	:	whether	to	use	metric	values	or	not	(in.	or	cm.).	(checkbox	unchecked	by	default)	(See	1703	Add	system	wide	preference	for
metric,	that	can	be	overridden	in	single	reports	until	you	restart	gramps	)

See	also	 Report	could	not	be	created 	dialog	which	may	occur	if	your	custom	page	size	is	too	large.	

Document	Options

Options	below	will	change	slightly	depending	on	the	output	format	selected.

Fig.	13.4.3	Document	Options	-	SVG	document	-	output	selected	-
example

Output	Format 	choose	the	output	format:
SVG	document	:	(Scalable	Vector	Graphics)	for	display	with	a	web	browser	or	editing	with	a	suitable	graphics	editor.
PostScript
OpenDocument	Text	(if	you	want	to	edit	the	report	with	Libreoffice/Openoffice)
PDF	document
Print...

	 Open	with	default	viewer :	you	can	indicate	to	open	the	made	document	your	default	viewer.	will	open	the	created	report	using
whatever	program	is	defined	on	your	system	for	handling	the	format	selected.(checkbox	unchecked	by	default)
Filename: 	default	value	is	/home/<username>/<Family	Tree	Name><Report	Name>.<output	format	extension> .	by	default	the
filename	is	the	same	as	the	report	type,	and	it	will	be	placed	in	your	home	directory.	(In	Windows	it	defaults	to	one	level	up	from	"My
documents".)
Style: 	(default	is	default).	With	the	 Style	Editor... 	button	you	can	add	Document	Styles.
SVG	Background	color: 	(transparent	background	default)

Select	a	person	for	the	report	selector

The	 Select	a	person	for	the	report 	selector	allows	you	to	select	an	already	existing	person	for	the	report	and	once	selected	they	will	be
placed	in	 Tree	Options 	as	the	Centre	Person.

Fig.	13.4.4	"Select	a	person	for	the	report"	-	selector	dialog	-	example

It	defaults	to	the	current	active	person.

You	may	check	the

Show	all 	box	to	show	the	entire	list	of	persons	in	the	tree	(checkbox	unchecked	by	default).

Scale	and	Resize	options

The	tree	is	first	made	on	a	canvas	that	can	fit	a	tree	of	any	size.	From	that	canvas	the	following	options	can	change	how	it	is	finally	displayed	on	a
page.	

Scale	tree	to	fit :

This	option	will	scale	up/down	the	size	of	the	report	on	the	canvas	to	fit	the	size	of	the	page	(set	in	Paper	Options)	that	you	wish	to	print	on.
Currently	you	can:

Do	not	scale	tree	(Default)
Scale	tree	to	fit	page	width	only
Scale	tree	to	fit	the	size	of	the	page	(both	width	and	height)
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For	the	last	option,	the	report	will	scale	to	the	lesser	scale	amount.

If	the	report	can	be	scaled	up	to	fit	the	width,	but	needs	to	be	scaled	down	further	to	fit	the	height,	it	will
be	scaled	down	leaving	lots	of	room	(empty	white	space)	width-wise.	Or	if	the	report	needs	to	be	scaled
down	just	a	little	for	height	and	scaled	down	more	for	width,	the	report	will	be	scaled	down	the	most
(width)	leaving	a	gap	(empty	white	space)	at	the	bottom.

Without	the	Check	box: Resize	Page	to	Fit	Tree	size. 	option	checked,	the	following	occurs	for	the	Scale	tree	to	fit	selections:

Do	not	scale	the	tree	may	give	you	a	report	that	spans	multiple	pages	horizontally	and/or	vertically
Scale	tree	to	fit	page	width	only	may	still	give	you	a	report	that	spans	multiple	pages	vertically.	No	pages	to	the	sides	of	others.	Only	one	on
top	of	another.
Scale	tree	to	fit	the	size	of	the	page	will	give	you	a	one	page	only	report.	The	report	will	print	on	a	page	the	size	set	in	Paper	Options.

Resize	Page	to	Fit	Tree	size

This	option	tells	how	big/small	to	resize	the	page	we	will	print	on.	With	this	option	unchecked,	the	page	size	that	is	set	in	Paper	Option.	With	this
option	checked	the	following	happens	based	upon	the	three	choices	in	 Scale	tree	to	fit: .

Overrides	options	in	the	'Paper	Option'	tab

This	option	will	create	irregular	page	sizes.

This	overrides/ignores	what	is	set	on	Paper	Options	and	print	on	a	page	the	same	dimensions	that	the	tree	uses	on	the	canvas.	So	taking	the	three
options	above,	in	scale	tree	to	fit,	this	is	what	will	happen	if	you	select	the	'Resize	Page	to	Fit	Tree	size'	option:

With	Do	not	scale	the	tree,	this	option	will	completely	ignore	what	is	set	in	Paper	Options	and	print	on	a	page	that	is	large	enough	to	display
the	entire	tree
With	Scale	tree	to	fit	page	width	only,	this	option	will	ignore	Paper	Height	that	is	set	in	Paper	Options	only.	The	tree	has	already	been	scaled
up/down	to	fit	the	page	width,	so	it	is	set.	Only	the	page	Height	is	set	upon	the	height	of	the	tree	we	are	printing.
With	Scale	tree	to	fit	the	size	of	the	page,	the	tree	has	already	been	scaled	to	the	size	of	the	page.	But	as	noted	above,	either	the	width	or
height	will	(more	than	likely)	have	a	gap	(empty	white	space)	in	it.	The	 Resize	Page	to	Fit	Tree	size 	will	narrow	down	this	gap	on
the	page	to	remove	that	gap.

inter-box	Y	scale	factor

Make	the	inter-box	Y	bigger	or	smaller

box	shadow	scale	factor

Make	the	box	shadow	bigger	or	smaller

Know	what	you	want	to	print	on

Scaling	a	tree	is	an	advanced	function.	The	 Document	Options 	→	 Style 	sets	the	size	of	text	that	you	can	print.	Scaling	down	is	not	very
desirable	as	the	text	becomes	more	difficult	to	read.	Scaling	up	is	better	but	may	have	the	some	issues.	So	here	are	some	pointers	to	make	nice
printed	documents.

First	thing	first.	What	paper	sizes	can	you	print	on?	Ask	around	and	see	what	page	sizes	you	can	print	on	easily.	Just	knowing	what	paper	sizes	you
can	print	on	helps	a	lot.	At	Kinkos	(in	the	U.S.A)	there	is	a	3	foot	wide	printer	with	paper	that	is	on	a	roll	(any	length).	So	we	could	use	'Scale	report
to	fit	page	width	only'	and	'One	page	report'	for	this.

It	is	also	noteworthy	to	first	make	your	report	using	 Scale	tree	to	fit s	Do	not	scale	the	report	option	and	 Resize	Page	to	Fit	Tree
size 	to	know	what	the	reports	full	dimensions	(width	and	height)	are.	This	will	help	you	know	how	to	better	put	this	report	on	the	pages	you	can
print	on.	Here	are	some	other	quick	things	to	take	into	account.

A	report	that	is	very	high	and	not	too	wide	may	print	better	with	only	the	Scale	report	to	fit	page	width	only	option.
With	the	reports	normal	width,	which	will	print	better?	Landscape	or	Portrait?
Since	every	boxes	width	is	set	by	the	widest	box,	can	you	use	the	Descendant	reports	→	Replace	option	to	abbreviate	or	remove	very	long
parts	that	are	not	needed?
The	size	of	the	title.	If	there	is	room,	you	may	want	to	make	the	title	larger.	And	if	it	is	too	large,	it	will	set	the	width	of	the	report.

Ancestor	Tree
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Fig.	13.4.5	Ancestor	Tree	-	Graphical	Reports	-	example	output
overview

The	 Ancestor	Tree 	report	generates	the	chart	of	people	who	are	ancestors	of	the	Active	Person.

From	the	menu	choose	Reports	->Graphical	Reports	->	Ancestor	Tree...	
See	also	common	options	

Tree	Options

Fig.	13.4.6	Ancestor	Tree	-	Graphical	Reports	-	Tree	Options	-	tab
default	options

Centre	Person: 	The	center	person	for	the	tree.	Defaults	to	the	Active	Person.
Select	a	different	person 	button.	-	Change	the	Centre	person.

	 Include	siblings	of	the	center	person 	Whether	to	only	display	the	centre	person	or	all	of	his/her	siblings	too	(checkbox
unchecked	by	default)
Generations 	(10	default)	The	number	of	generations	to	include	in	the	tree
Display	unknown	generations: 	The	number	of	generations	of	empty	boxes	that	will	be	displayed	(	when	the	tree	is	not	completely
full.)

No	generations	of	empty	boxes	for	unknown	ancestors	(default)
#	Generation(s)	of	empty	boxes	for	unknown	ancestors	(display	up	to	8	generations	of	empty	boxes)

	 Compress	tree 	Whether	to	remove	any	extra	blank	spaces	set	aside	for	people	that	are	unknown	(checkbox	checked	by	default)
	 Show	Index 	Display	index	of	each	person	(checkbox	unchecked	by	default)

Start	Index: 	(1	default)	The	start	index

Report	Options

Fig.	13.4.7	Ancestor	Tree	-	Graphical	Reports	-	Report	Options	-	tab
default	options

This	tab	gives	you	the	option	to	include	other	items	on	the	report.

Report	title: 	Choose	a	title	for	the	report.
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Do	not	print	a	title	(default)
Include	Report	Title

	 Include	a	border 	(checkbox	unchecked	by	default)
	 Include	page	numbers 	(checkbox	unchecked	by	default)

Scale	tree	to	fit: 	will	make	the	tree	larger	or	smaller	to	fit	the	page	as	desired.	The	options	are:
Do	not	Scale	the	tree	(default)
Scale	tree	to	fit	page	width	only
Scale	tree	to	fit	the	size	of	the	page

	 Resize	Page	to	Fit	Tree	Note:	Overrides	options	in	the	'Paper	Options'	tab	(checkbox	unchecked	by	default)
will	make	the	page	larger	or	smaller	to	fit	the	tree.

	 Include	blank	pages 	(checkbox	checked	by	default)

If	both	 Scale	tree	to	fit: 	and	 Resize	Page	to	Fit	Tree... 	are	selected,	the	options	happen	in	that	order;	scale	the	tree	first,	then
the	page.

The	two	options	 Scale	tree	to	fit: 	and	 Resize	Page	to	Fit	Tree... 	are	better	described	in	common	options	with	tips	for	making
nicer	reports.	

Report	Options	(2)

Fig.	13.4.8	Ancestor	Tree	-	Graphical	Reports	-	Report	Options	(2)	-
tab	default	options

Name	Format: 	Select	the	format	to	display	the	names.	Choose	from
Surname,	Given	Suffix	(default)
Given	Surname	Suffix
Given
Main	Surnames,	Given	Patronymic	Suffix
SURNAME,	Given	(Common)

Living	people: 	Select	to	include	or	not	living	persons	in	the	report.	Choose	from
Include,	and	all	data	(default)
Full	names,	but	data	removed
Given	names	replaced,	and	data	removed
Complete	names	replaced,	and	data	removed
Not	included

Years	from	death	to	consider	living: 	Select	the	number	of	years	since	death	to	consider	persons	for	the	report.	Allows	for	the
inclusion	or	exclusion	of	recently-dead	persons	in	the	report.	Default	value	is	0	years.

	 Include	data	marked	private 	(checkbox	checked	by	default)
Translation: 	The	translation	to	be	used	for	the	report.

Language	selector
Date	format: 	Select	the	format	to	display	dates.	Choose	from

YYYY-MM-DD	(ISO)(2018-04-08)	(default)
Numerical	(8/4/2018)
Month	Day,	Year	(April	8,	2018)
Mon	Day,	Year	(Apr	8,	2018)
Day	Month	Year	(8	April	2018)
Day	Mon	Year	(8	Apr	2018)

Display
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Fig.	13.4.9	Ancestor	Tree	-	Graphical	Reports	-	Display	-	tab	default
options

This	tab	allows	you	to	determine	the	 Father	Display	Format: 	to	be	used	for	the	report.	All	fathers,	grandfathers,	etc.	will	use	this	format.

The	 Mother	Display	Format: 	to	be	used	for	all	mothers,	grandmothers,	etc.	will	use	this	format.

The	{}	around	the	death	information	line	states	that	the	text	'd.	'	will	display	ONLY	when	there	is	death	information.	See	Substitution	Values	for
more	information,	including	how	to	include	places	and	attributes,	and	format	names	and	dates	and	places.

Center	person	uses	which	format: 	allows	you	to	specify	if	the	center	person	uses	the	father	display	format	or	the	mother	display	format
found	on	the	Display	tab.

Include	Marriage	box 	specifies	to	display	an	extra	box	between	a	father	and	mother	that	contains	marriage	information.	 The	Marriage
Display	Format: 	(see	Substitution	Values)	specifies	what	will	print	in	this	box.

Advanced

Fig.	13.4.10	Ancestor	Tree	-	Graphical	Reports	-	Advanced	-	tab
default	options

Replace	Display	Format:	'Replace	this'/'With	this': 	This	allows	you	to	put	in	pairs	of	strings	separated	by	'/'(foward
slash)	that	specify	text	you	want	to	replace	with	other	text.	For	example,	United	States	of	America/USA 	replaces	the	United	States	of
America	with	USA.	Each	column	width	is	defined	by	the	widest	box	in	the	report.	So	if	one	box	happens	to	be	a	lot	wider	than	the	rest,	a	lot
of	space	will	be	wasted.	The	replace	string	option	allows	you	to	remove,	or	abbreviate,	parts	of	the	string	that	is	not	needed,	or	that	can	be	cut
down,	so	the	amount	of	space	wasted	is	minimal.

	 Include	a	note 	You	may	check	the	Include	a	note	box	to	add	a	note	(checkbox	unchecked	by	default).
Note: 	specifies	text	the	note	will	contain.	Adding	the	substitution	value	“$T”	within	the	note	will	display	the	day	that	the	report	was	made.
Regular	date	formatting	(see	Substitution	Values)	applies.
Note	location: 	Specify	where	on	the	page	to	place	the	note.	Currently	a	note	will	be	attached	to	a	corner.	If	a	person	box	writes	over	it,
the	note	box	will	not	move.	Select	another	Note	location	option	to	position	the	note	if	this	happens.

Top	Left	(default)
Bottom	Left
Bottom	Right

These	following	two	options	are	better	described	in	Size	options	with	tips	for	making	nicer	reports.

inter-box	scale	factor: 	-	Make	the	inter-box	bigger	or	smaller	(default	is	1.00	in.).
box	shadow	scale	factor: 	-	Make	the	box	shadow	bigger	or	smaller	(default	is	1.00	in.).

Calendar

Fig.	13.4.11	Calendar	-	Graphical	Reports	-	example	output	overview
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This	report	produces	a	calendar	with	birthdays	and	anniversaries	on	a	page	by	month.

You	can	choose	the	Calendar	report	with	Reports	->Graphical	Reports	->	Calendar...

You	can	print	the	same	information	but	in	text	format	by	using	the	Birthday	and	Anniversary	Report.

See	Calendar	tools	holidays	for	an	explanation	of	how	to	add	or	change	the	holidays	appearing	on	the	output	of	this	calendar.	
See	also	common	options	

Report	Options

Fig.	13.4.12	Calendar	-	Graphical	Reports	-	Report	Options	-	tab
default	options

Filter: 	choose	between
Entire	Database	(Default)
Descendants	of	<active	person>
Descendant	families	of	<active	person>
Ancestors	of	<active	person>
People	with	common	ancestor	with	<active	person>

Center	Person: 	The	center	person	for	the	report	usually	the	active	person	unless	you	use	the	:
Select	a	different	person 	button	to	use	 Select	a	person	for	the	report 	selector	dialog.

Text	Area	1: 	(My	Calendar	default)	First	line	of	text	at	bottom	of	calendar.
Text	Area	2: 	(Produced	with	Gramps	default)	Second	line	of	text	at	bottom	of	calendar.
Text	Area	3: 	(http://gramps-project.org/	default)	Third	line	of	text	at	bottom	of	calendar.

Report	Options	(2)

Fig.	13.4.13	Calendar	-	Graphical	Reports	-	Report	Options	(2)	-	tab
default	options

Name	Format: 	Select	the	format	to	display	the	names.	Choose	from
Surname,	Given	Suffix	(default)
Given	Surname	Suffix
Given
Main	Surnames,	Given	Patronymic	Suffix
SURNAME,	Given	(Common)

	 Include	data	marked	private 	(checkbox	checked	by	default)
	 Include	only	living	people 	(checkbox	checked	by	default)

Translation: 	The	translation	to	be	used	for	the	report.	Shows	the	Language	selector

Content
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Fig.	13.4.14	Calendar	-	Graphical	Reports	-	Content	-	tab	default
options

Year	of	calendar: 	fill	in	the	year.	Defaults	to	current	Year.
Country	for	holidays: 	Select	the	country	to	see	associated	holidays.	Defaults	to	none.	See	example:	Calendar	tools	holidays
First	day	of	week: 	(Default:	Monday)	Select	the	first	day	of	the	week	for	the	report.
Birthday	surname: 	Select	married	women's	displayed	surname.

Wives	use	their	own	surname	(Default)
Wives	use	husband's	surname	(from	first	family	listed)
Wives	use	husband's	surname	(from	last	family	listed)

	 Include	birthdays 	:	include	or	not	birthdays	in	the	calendar	(checkbox	checked	by	default)
	 Include	anniversaries 	:	include	or	not	anniversaries	in	the	calendar	(checkbox	checked	by	default)
	 Include	death	dates 	:	include	or	not	death	anniversaries	in	the	calendar	(checkbox	unchecked	by	default)

Descendant	Tree

Fig.	13.4.15	Descendant	Tree	-	Graphical	Reports	-	example	output
overview

The	 Descendant	Tree 	report	generates	a	chart	of	people	who	are	descendants	of	the	Active	Person.	Alternatively	it	may	generate	a	chart	of
descendants	of	the	parents	of	the	Active	Person.

You	can	choose	the	 Descendant	Tree 	report	with	Reports	->Graphical	Reports	->	Descendant	Tree...	
See	also	common	options	

Tree	Options

Fig.	13.4.16	Descendant	Tree	-	Graphical	Reports	-	Tree	Options	-	tab
default	options

Report	for: 	The	main	person	for	the	report.	Defaults	to	the	Active	Person.
Select	a	different	person 	button.	-	Change	the	main	person.
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Generations 	(10	default	).	The	number	of	generations	to	include	in	the	tree	(including	the	main	person).	Note:	The	chart	will	include	one
more	generation	if	 [	]	Start	with	the	parent(s)	of	the	selected	first	is	selected.
Level	of	spouses 	specifies	how	deep	to	display	spouses.	(1	default	)

	 Start	with	the	parent(s)	of	the	selected	first	Will	show	the	parents,	brother	and	sisters	of	the	selected	person.
(checkbox	unchecked	by	default)

	 Compress	tree 	Whether	to	move	people	up,	where	possible,	resulting	in	a	smaller	tree	(checkbox	unchecked	by	default)
	 Bold	direct	descendants 	Whether	to	bold	those	people	that	are	direct	(not	step	or	half)	descendants.	(checkbox	checked	by

default)
	 Indent	Spouses 	Whether	to	indent	the	spouses	in	the	tree.	(checkbox	checked	by	default)

Report	Options

Fig.	13.4.17	Descendant	Tree	-	Graphical	Reports	-	Report	Options	-
tab	default	options

Report	Title: 	Choose	a	title	for	the	report.	Options	are:
Do	not	include	a	title	(default)
Descendant	Chart	for	[selected	person(s)]	(Note:	If	 [	]	Start	with	Parents	of	Selected 	is	ticked	on	the	 Tree	Options
tab,	both	parents	of	the	selected	person	are	shown.	Only	two	people	will	be	listed	in	the	title.	If	 [	]	Level	of	Spouses 	is	two	or
more,	descendants	of	"spouses	of	spouses"	are	included	on	the	chart,	but	are	not	listed	in	the	title.)

	 Include	a	border 	Whether	to	make	a	border	around	the	report.	(checkbox	unchecked	by	default)
	 Include	Page	Numbers 	Whether	to	include	page	numbers	on	each	page.	(checkbox	unchecked	by	default)

Scale	tree	to	fit: 	Whether	to	scale	the	tree	(make	the	tree	larger	or	smaller)	to	fit	a	specific	paper	size.	The	options	are:
Do	not	scale	the	tree	(Default)
Scale	tree	to	fit	page	width	only
Scale	tree	to	fit	the	size	of	the	page

	 Resize	Page	to	Fit	Tree	size	(Note:	Overrides	options	in	the	Paper	Option	tab)	(unchecked	by	default)
Resize	page	to	fit	tree	will	make	the	page	larger	or	smaller	to	fit	the	tree.	If	selected	with	the	 Scale	tree	to	fit ,	the	options	happen	in
that	order;	scale	the	tree	first,	then	the	page.	There	is	a	combined	effect	with	each	option:

1.	 With	"Do	not	scale	the	tree",	both	the	page	width	and	height	is	resized	to	fit	the	tree.
2.	 With	"Scale	tree	to	fit	page	width	only",	the	page	height	is	resized	to	fit	the	tree	height.
3.	 With	"Scale	tree	to	fit	the	size	of	the	page",	the	page	is	resized	to	remove	any	gap	in	both	height	and	width.

	 Include	Blank	Pages 	Whether	to	include	pages	that	are	blank.	(checkbox	unchecked	by	default)

The	 Scale	tree	to	fit: 	and	 [	]	Resize	Page	to	Fit	Tree	size	(Note:	Overrides	options	in	the	Paper	Option
tab) 	options	are	better	described	in	common	options	with	tips	for	making	nicer	reports.	

Report	Options	(2)

Fig.	13.4.18	Descendant	Tree	-	Graphical	Reports	-	Report	Options
(2)	-	tab	default	options

Name	format: 	Select	the	format	to	display	names.	Choose	from
Surname,	Given	Suffix(default)
Given	Surname	Suffix
Given
Main	Surnames,	Given	Patronymic	Suffix
SURNAME,	Given	(Common)

	 Include	data	marked	private 	Whether	to	include	private	date	(checkbox	checked	by	default)
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Living	People: 	How	to	handle	living	people.	Choose	from:
Include,	and	all	data	(default)
Full	names,	but	data	removed
Given	names	replaced,	and	data	removed
Complete	names	replaced,	and	data	removed
Not	included

Years	from	death	to	consider	living: 	Whether	to	restrict	data	on	recently-dead	people.	Select	the	number	of	years	since	death	to
consider	persons	for	the	report.	Allows	for	the	inclusion	or	exclusion	of	recently-dead	persons	in	the	report.	(Default	value	is	0	years.)
Translation: 	The	translation	to	be	used	for	the	report.
Date	format :	The	format	and	language	for	dates,	with	examples.	Choose	from:

YYYY-MM-DD	(ISO)(2018-04-08)	(default)
Numerical	(8/4/2018)
Month	Day,	Year	(April	8,	2018)
Mon	Day,	Year	(Apr	8,	2018)
Day	Month	Year	(8	April	2018)
Day	Mon	Year	(8	Apr	2018)

Display

Fig.	13.4.19	Descendant	Tree	-	Graphical	Reports	-	Display	-	tab
default	options

Descendant	Display	Format: 	sets	the	display	for	all	descendants	in	the	tree.	The	default	is:

$n
b.	$b
-{d.	$d}

which	displays	the	name,	birth	date	and	death	date	on	consecutive	lines	in	the	formats	set	on	the	Display	tab	in	Gramps	preferences.	The	{}	on	the
third	line	states	that	the	text	'd.	'	will	display	ONLY	when	$d	has	a	value,	i.e.	there	is	something	in	the	death	date	field	of	the	database	for	this
person.	See	Substitution	Values	for	more	information,	including	how	to	include	places	and	attributes,	and	select	different	formats	for	names	and
dates	and	places.

The	check	box	 Bold	direct	descendants 	causes	the	names	and	other	information	about	direct	descendants	to	be	in	the	bold	font	selected	in
the	style	editor.

Spousal	Display	Format: 	specifies	what	is	displayed	for	each	spouse.	The	default	is	the	same	as	for	descendants.	If	you	do	not	wish	to
have	a	separate	box	for	marriage	information,	it	can	be	displayed	in	the	spouse	box,	for	example	by	adding	a	line	with

m.	$m	

Which	displays	the	date	of	the	marriage.

Indent	spouses 	will	indent	the	spouse	and	marriage	boxes	from	the	descendant	boxes.	In	the	Family	Descendant	Chart,	it	does	not	affect	the
starting	family	or	the	parents	of	the	starting	family,	but	it	does	affect	any	other	spouses	of	those	three	couples.

	 Include	Marriage	box 	(checkbox	checked	by	default)	will	display	a	separate	box	on	the	tree	for	each	marriage.	The	display	format
is	set	in	 Marriage	Display	Format: 	.	The	default	is

m.	$m

which	displays	the	date	of	the	marriage.	If	this	box	is	not	ticked,	marriage	information	will	not	be	displayed	unless	you	specify	it	in	the	spousal
display	format	as	described	above.

Advanced

Reports	-	part	4	-	Graphical	Reports 208

http://www.gramps-project.org/wiki/index.php/File:DescendantTree-GraphicalReports-Display-tab-52.png


This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

Fig.	13.4.20	Descendant	Tree	-	Graphical	Reports	-	Advanced
-	tab	default	options

Replace	Display	Format:	'Replace	this'/'With	this': 	This	allows	you	to	put	in	pairs	of	strings	separated	by	'/'(foward
slash)	that	specify	text	you	want	to	replace	with	other	text.	For	example,	United	States	of	America/USA 	replaces	the	United	States	of
America	with	USA.	Each	column	width	is	defined	by	the	widest	box	in	the	report.	So	if	one	box	happens	to	be	a	lot	wider	than	the	rest,	a	lot
of	space	will	be	wasted.	The	replace	string	option	allows	you	to	remove,	or	abbreviate,	parts	of	the	string	that	is	not	needed,	or	that	can	be	cut
down,	so	the	amount	of	space	wasted	is	minimal.

	 Include	a	note 	You	may	check	the	Include	a	note	box	to	add	a	note	(checkbox	unchecked	by	default).
Note: 	specifies	text	the	note	will	contain.	Adding	the	substitution	value	“$T”	within	the	note	will	display	the	day	that	the	report	was	made.
Regular	date	formatting	(see	Substitution	Values)	applies.
Note	location: 	Specify	where	on	the	page	to	place	the	note.	Currently	a	note	will	be	attached	to	a	corner.	If	a	person	box	writes	over	it,
the	note	box	will	not	move.	Select	another	Note	location	option	to	position	the	note	if	this	happens.

Top	Left	(default)
Bottom	Left
Bottom	Right

These	following	two	options	are	better	described	in	Size	options	with	tips	for	making	nicer	reports.

inter-box	scale	factor: 	-	Make	the	inter-box	bigger	or	smaller	(default	is	1.00	in.).
box	shadow	scale	factor: 	-	Make	the	box	shadow	bigger	or	smaller	(default	is	1.00	in.).

Examples

Fig.	13.4.21	Descendant	Tree	Report,	Example	1.	Allan	Davies	had
three	spouses.
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Fig.	13.4.22	Descendant	Tree	Report,	Example	2.

The	example	below	is	based	on	the	same	family	as	the	first	example	and	shows	the	result	of	starting	with	"Child	2	Davies"	and	ticking	this	box.

Example	1	was	obtained	by	selecting	Allan	Davies	as	the	starting	person	and	then	running	the	report	without	this	box	ticked,	with	all	other	options
the	same	except	 Generations .	The	differences	between	the	two	examples	are:

The	format	of	the	first	generation	is	changed.	Because	the	parents	of	the	starting	person	must	be	adjacent,	spouses	in	the	first	generation	may
be	shown	out	of	order.
For	the	purpose	of	the	 Level	of	spouses 	setting,	both	parents	are	considered	direct	descendants,	rather	than	spouses.	(Although	the
mother	uses	the	 Spousal	display	format	 on	the	Display	tab.)

This	means	that	other	spouses	(if	any)	of	both	of	them	will	be	shown	to	the	number	of	levels	specified	by	 Level	of	spouses .	In	example	2,
Mike	Morris	is	shown	even	though	 Level	of	spouses 	is	set	to	1.

The	title	of	the	report	(if	selected	on	the	Include	tab)	is	changed	to	include	both	parents	of	the	starting	person.	Only	two	people	are	shown	in
the	title.	In	example	2,	Mike	Morris	is	not	listed	in	the	title	even	though	his	descendants	are	shown.

Generations 	The	number	of	generations	to	show	on	the	report	(including	the	starting	person).	If	 Start	with	the	parent(s)	of	the
selected	first 	is	selected,	the	chart	will	include	one	more	generation.	(Example	1	was	run	with	 Generations =3,	Example	2	with
Generations =2.)

Level	of	spouses 	specifies	how	deep	to	display	spouses.

For	the	example:

Abe	is	a	direct	descendant
Abe	has/had	married	Barbra	and	had	two	children
Abe	also	married	Bridget	and	had	one	child

Bridget	has/had	married	Carl.
Carl	and	Denise	had	a	child.

Given	the	above	example,	this	is	what	will	be	displayed	for	the	first	three	 Level	of	spouses 	options.

0	means	that	only	direct	descendants	will	be	shown.	Nothing	on	the	Secondary	tab	will	be	shown	(Spousal	information	or	Marriage
information).	For	the	example	above,	only	Abe	will	be	shown	with	three	children	directly	under	him
1	means	that	only	spouses	of	the	direct	descendants	will	be	shown.	For	the	example	above,	Abe	will	be	shown	with	two	pieces	of	marriage
information.	Under	the	first	will	be	two	children	and	one	child	under	the	second.
2	means	that	spouses	of	spouses	are	shown.	Same	as	1	but	Bridget	will	also	show	her	other	marriage.	If	they	had	any	children,	they	would	be
shown	too.
3	means	that	everyone	in	the	example	above	will	be	displayed.

Any	option	above	1	is	very	hard	to	read	on	the	report	without	the	 Indent	Spouses 	option	on	the	Display	tab.

And	last	but	not	least	is	the	 Compress	Tree 	option	which	tries	to	move	everyone	up	as	far	as	they	can	go	(compress)	and	still	have	a	readable
report.	If	 Start	with	the	parent(s)	of	the	selected	first	is	ticked,	 Compress	Tree 	does	not	have	any	affect	on	the	first
generation.	
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

Examples	1	or	2

....

Generations 	(10	default	).	The	number	of	generations	to	show	on	the	chart	(including	the	starting	person).	If	 Start	with	the	parent(s)
of	the	selected	first 	is	selected,	the	chart	will	include	one	more	generation.	(Example	1	was	run	with	 Generations =3,	Example	2	with
Generations =2.)

Level	of	spouses 	specifies	how	deep	to	display	spouses.

Start	with	the	parent(s)	of	the	selected	first	will	draw	a	descendancy	chart	from	the	parents	of	the	starting	person,	if	they	are	in
the	database.	The	Example	is	based	on	the	same	family	as	the	first	example	and	shows	the	result	of	starting	with	"Child	2	Davies"	and	ticking	this
box.

Example	1	was	obtained	by	selecting	Allan	Davies	as	the	starting	person	and	then	running	the	report	without	this	box	ticked,	with	all	other	options
the	same	except	 Generations .	The	differences	between	the	two	examples	are:

The	format	of	the	first	generation	is	changed.	Because	the	parents	of	the	starting	person	must	be	adjacent,	spouses	in	the	first	generation	may
be	shown	out	of	order.
For	the	purpose	of	the	 Level	of	spouses 	setting,	both	parents	are	considered	direct	descendants,	rather	than	spouses.	(Although	the
mother	uses	the	 Spousal	display	format	 on	the	Display	tab.)

This	means	that	other	spouses	(if	any)	of	both	of	them	will	be	shown	to	the	number	of	levels	specified	by	 Level	of	spouses .	In	example	2,
Mike	Morris	is	shown	even	though	 Level	of	spouses 	is	set	to	1.

The	title	of	the	report	(if	selected	on	the	Include	tab)	is	changed	to	include	both	parents	of	the	starting	person.	Only	two	people	are	shown	in
the	title.	In	example	2,	Mike	Morris	is	not	listed	in	the	title	even	though	his	descendants	are	shown.

For	the	example:

Abe	is	a	direct	descendant
Abe	has/had	married	Barbra	and	had	two	children
Abe	also	married	Bridget	and	had	one	child

Bridget	has/had	married	Carl.
Carl	and	Denise	had	a	child.

Given	the	above	example,	this	is	what	will	be	displayed	for	the	first	three	 Level	of	spouses 	options.

0	means	that	only	direct	descendants	will	be	shown.	Nothing	on	the	Secondary	tab	will	be	shown	(Spousal	information	or	Marriage
information).	For	the	example	above,	only	Abe	will	be	shown	with	three	children	directly	under	him
1	means	that	only	spouses	of	the	direct	descendants	will	be	shown.	For	the	example	above,	Abe	will	be	shown	with	two	pieces	of	marriage
information.	Under	the	first	will	be	two	children	and	one	child	under	the	second.
2	means	that	spouses	of	spouses	are	shown.	Same	as	1	but	Bridget	will	also	show	her	other	marriage.	If	they	had	any	children,	they	would	be
shown	too.
3	means	that	everyone	in	the	example	above	will	be	displayed.

Any	option	above	1	is	very	hard	to	read	on	the	report	without	the	 Indent	Spouses 	option	on	the	Display	tab.

And	last	but	not	least	is	the	 Compress	Tree 	option	which	tries	to	move	everyone	up	as	far	as	they	can	go	(compress)	and	still	have	a	readable
report.	If	 Start	with	the	parent(s)	of	the	selected	first	is	ticked,	 Compress	Tree 	does	not	have	any	affect	on	the	first
generation.	

Family	Descendant	Tree

Shared	options	with	the	Descendant	Tree	report

This	report	has	the	same	options	as	the	'Descendant	Tree'	report,	except	that	there	are	more	options	for
the	report	title	on	the	Include	tab.	Also,	some	of	the	options	have	a	different	effect.
Options	are	only	described	here	if	they	differ	between	the	two	reports.
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Fig.	13.4.23	Family	Descendant	Tree	-	Graphical	Reports	-	example
output	overview

The	 Family	Descendant	Tree 	report	generates	a	chart	of	people	who	are	descendants	of	the	Active	Family.

You	can	choose	the	Family	Descendant	Tree	report	with	Reports	->Graphical	Reports	->	Family	Descendant	Tree...	
See	also	common	options	

Tree	Options

Fig.	13.4.24	Family	Descendant	Tree	-	Graphical	Reports	-	Tree
Options	-	tab	default	options

Report	for: 	The	main	person	for	the	report.	Defaults	to	the	Active	Person.
Select	a	different	person 	button.	-	Change	the	main	person.

Generations 	(10	default	).	The	number	of	generations	to	include	in	the	tree	(including	the	main	person).	Note:	The	chart	will	include	one
more	generation	if	 [	]	Start	with	the	parent(s)	of	the	selected	first	is	selected.
Level	of	spouses 	specifies	how	deep	to	display	spouses.	(1	default	)

	 Start	with	the	parent(s)	of	the	selected	first	Will	show	the	parents,	brother	and	sisters	of	the	selected	person.
(checkbox	unchecked	by	default)

	 Compress	tree 	Whether	to	move	people	up,	where	possible,	resulting	in	a	smaller	tree	(checkbox	unchecked	by	default)
	 Bold	direct	descendants 	Whether	to	bold	those	people	that	are	direct	(not	step	or	half)	descendants.	(checkbox	checked	by

default)
	 Indent	Spouses 	Whether	to	indent	the	spouses	in	the	tree.	(checkbox	checked	by	default)

If	the	 [	]	Start	with	the	parent(s)	of	the	selected	first	is	checked,	the	report	shows	both	parents	of	the	starting	father	and
mother	(if	they	are	in	the	database),	and	all	descendants	of	both	sets	of	parents	for	the	selected	number	of	generations.	The	total	number	of
generations	in	the	chart	is	therefore	1	more	than	the	number	selected	in	the	generations	box.	(The	example	chart	above	was	made	with
generations=2.)

The	starting	father	and	mother	have	to	be	in	the	center	of	the	chart.

They	will	therefore	not	be	shown	in	birth	order	with	their	siblings	-	instead	they	will	be	shown	as	the	last	and	first	child	of	their	parents	respectively.
This	is	shown	in	the	Examples	chart,	where	the	children	in	both	families	have	been	named	Child	1,2,3	in	their	birth	order.	Furthermore,	if	the
starting	father	or	mother	have	other	spouses	they	will	be	shown	twice.	This	also	applies	to	the	parents	of	the	starting	father	or	mother.

If	this	box	is	not	ticked,	the	report	is	the	same	as	the	descendant	tree	report,	except	that	the	number	of	generations	is	increased	by	one,	the	format	of
the	first	generation	is	different,	and	you	get	extra	options	for	the	chart	title.	
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Report	Options

Fig.	13.4.25	Family	Descendant	Tree	-	Graphical	Reports	-	Report
Options	-	tab	default	options

Report	Title: 	Choose	a	title	for	the	report.	Options	are:
Do	not	include	a	title	(default)
Descendant	Chart	for	[selected	person(s)]	(Note:	If	 [	]	Start	with	Parents	of	Selected 	is	ticked	on	the	 Tree	Options
tab,	both	parents	of	the	selected	person	are	shown.	Only	two	people	will	be	listed	in	the	title.	If	 [	]	Level	of	Spouses 	is	two	or
more,	descendants	of	"spouses	of	spouses"	are	included	on	the	chart,	but	are	not	listed	in	the	title.)

	 Include	a	border 	Whether	to	make	a	border	around	the	report.	(checkbox	unchecked	by	default)
	 Include	Page	Numbers 	Whether	to	include	page	numbers	on	each	page.	(checkbox	unchecked	by	default)

Scale	tree	to	fit: 	Whether	to	scale	the	tree	(make	the	tree	larger	or	smaller)	to	fit	a	specific	paper	size.	The	options	are:
Do	not	scale	the	tree	(Default)
Scale	tree	to	fit	page	width	only
Scale	tree	to	fit	the	size	of	the	page

	 Resize	Page	to	Fit	Tree	size	(Note:	Overrides	options	in	the	Paper	Option	tab)	(unchecked	by	default)
Resize	page	to	fit	tree	will	make	the	page	larger	or	smaller	to	fit	the	tree.	If	selected	with	the	 Scale	tree	to	fit ,	the	options	happen	in
that	order;	scale	the	tree	first,	then	the	page.	There	is	a	combined	effect	with	each	option:

1.	 With	"Do	not	scale	the	tree",	both	the	page	width	and	height	is	resized	to	fit	the	tree.
2.	 With	"Scale	tree	to	fit	page	width	only",	the	page	height	is	resized	to	fit	the	tree	height.
3.	 With	"Scale	tree	to	fit	the	size	of	the	page",	the	page	is	resized	to	remove	any	gap	in	both	height	and	width.

	 Include	Blank	Pages 	Whether	to	include	pages	that	are	blank.	(checkbox	unchecked	by	default)

The	 Scale	tree	to	fit: 	and	 [	]	Resize	Page	to	Fit	Tree	size	(Note:	Overrides	options	in	the	Paper	Option
tab) 	options	are	better	described	in	common	options	with	tips	for	making	nicer	reports.	

Report	Options	(2)

Fig.	13.4.26	Family	Descendant	Tree	-	Graphical	Reports	-	Report
Options	(2)	-	tab	default	options

Name	format: 	Select	the	format	to	display	names.	Choose	from
Surname,	Given	Suffix(default)
Given	Surname	Suffix
Given
Main	Surnames,	Given	Patronymic	Suffix
SURNAME,	Given	(Common)

	 Include	data	marked	private 	Whether	to	include	private	date	(checkbox	checked	by	default)
Living	People: 	How	to	handle	living	people.	Choose	from:

Include,	and	all	data	(default)
Full	names,	but	data	removed
Given	names	replaced,	and	data	removed
Complete	names	replaced,	and	data	removed
Not	included

Years	from	death	to	consider	living: 	Whether	to	restrict	data	on	recently-dead	people.	Select	the	number	of	years	since	death	to
consider	persons	for	the	report.	Allows	for	the	inclusion	or	exclusion	of	recently-dead	persons	in	the	report.	(Default	value	is	0	years.)
Translation: 	The	translation	to	be	used	for	the	report.
Date	format :	The	format	and	language	for	dates,	with	examples.	Choose	from:

YYYY-MM-DD	(ISO)(2018-04-08)	(default)
Numerical	(8/4/2018)
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Month	Day,	Year	(April	8,	2018)
Mon	Day,	Year	(Apr	8,	2018)
Day	Month	Year	(8	April	2018)
Day	Mon	Year	(8	Apr	2018)

Display

Fig.	13.4.27	Family	Descendant	Tree	-	Graphical	Reports	-	Display	-
tab	default	options

Descendant	Display	Format 	sets	the	display	for	all	descendants	in	the	tree.	The	default	is:

$n
b.	$b
{d.	$d}

which	displays	the	name,	birth	date	and	death	date	on	consecutive	lines	in	the	formats	set	on	the	Display	tab	in	Gramps	preferences.	The	{}	on	the
third	line	states	that	the	text	'd.	'	will	display	ONLY	when	$d	has	a	value,	i.e.	there	is	something	in	the	death	date	field	of	the	database	for	this
person.	See	Substitution	Values	for	more	information,	including	how	to	include	places	and	attributes,	and	select	different	formats	for	names	and
dates	and	places.

Spousal	Display	format 	specifies	what	is	displayed	for	each	spouse.	The	default	is	the	same	as	for	descendants.	If	you	do	not	wish	to	have	a
separate	box	for	marriage	information,	it	can	be	displayed	in	the	spouse	box,	for	example	by	adding	a	line	with

m.	$m	

Which	displays	the	date	of	the	marriage.

Indent	spouses 	will	indent	the	spouse	and	marriage	boxes	from	the	descendant	boxes.	In	the	Family	Descendant	Chart,	it	does	not	affect	the
starting	family	or	the	parents	of	the	starting	family,	but	it	does	affect	any	other	spouses	of	those	three	couples.

Include	marriage	box 	will	display	a	separate	box	on	the	tree	for	each	marriage.	The	display	format	is	set	in	 Marriage	Display
format .	The	default	is

m.	$m

which	displays	the	date	of	the	marriage.	If	this	box	is	not	ticked,	marriage	information	will	not	be	displayed	unless	you	specify	it	in	the	spousal
display	format	as	described	above.

Advanced

Fig.	13.4.28	Family	Descendant	Tree	-	Graphical	Reports	-	Advanced
-	tab	default	options

Replace	Display	Format:	'Replace	this'/'With	this': 	This	allows	you	to	put	in	pairs	of	strings	separated	by	'/'(foward
slash)	that	specify	text	you	want	to	replace	with	other	text.	For	example,	United	States	of	America/USA 	replaces	the	United	States	of
America	with	USA.	Each	column	width	is	defined	by	the	widest	box	in	the	report.	So	if	one	box	happens	to	be	a	lot	wider	than	the	rest,	a	lot
of	space	will	be	wasted.	The	replace	string	option	allows	you	to	remove,	or	abbreviate,	parts	of	the	string	that	is	not	needed,	or	that	can	be	cut
down,	so	the	amount	of	space	wasted	is	minimal.

	 Include	a	note 	You	may	check	the	Include	a	note	box	to	add	a	note	(checkbox	unchecked	by	default).
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Note: 	specifies	text	the	note	will	contain.	Adding	the	substitution	value	“$T”	within	the	note	will	display	the	day	that	the	report	was	made.
Regular	date	formatting	(see	Substitution	Values)	applies.
Note	location: 	Specify	where	on	the	page	to	place	the	note.	Currently	a	note	will	be	attached	to	a	corner.	If	a	person	box	writes	over	it,
the	note	box	will	not	move.	Select	another	Note	location	option	to	position	the	note	if	this	happens.

Top	Left	(default)
Bottom	Left
Bottom	Right

These	following	two	options	are	better	described	in	Size	options	with	tips	for	making	nicer	reports.

inter-box	scale	factor: 	-	Make	the	inter-box	bigger	or	smaller	(default	is	1.00	in.).
box	shadow	scale	factor: 	-	Make	the	box	shadow	bigger	or	smaller	(default	is	1.00	in.).

Fan	Chart

Fig.	13.4.29	Fan	Chart	-	Graphical	Reports	-	example	output	overview

The	 Fan	Chart 	compactly	shows	paternal	and	maternal	ancestors.	The	report	produces	a	chart	representing	family	relationships	in	a	tree
structure	resembling	a	fan	(half	circle)	and	optionally	as	a	quarter	or	full	circle,	with	the	Active	person	in	the	inner	circle	(center),	parents	are	in	the
second	concentric	circle	divided	in	two	(each	side	is	one	parent),	the	third	circle	is	divided	in	four	representing	grandparents	and	so	on,	for	a
maximum	of	eleven	generations.

This	chart	is	also	know	as	a	Pedigree	fan	chart.

You	can	choose	the	Fan	Chart	report	with	Reports	->Graphical	Reports	->	Fan	Chart...	
See	also	common	options	

Report	Options

Fig.	13.4.30	Fan	Chart	-	Graphical	Reports	-	Report	Options	-	tab
default	options

Center	Person: 	The	center	person	for	the	report.	Defaults	to	the	Active	Person.
Select	a	different	person 	button.	-	Change	the	center	person.

Limitation

A	" Person	<____>	is	not	in	the	Database"	warning	dialog	will	be	shown	if	the	Center
Person	is	Private	or	Living	when	the	filtering	options	on	the	 Report	Options	(2) 	tab	settings	for
do	not	allow	Private	or	Living	Persons	are	used.

Generations: 	(5	default	)	The	number	of	generations	to	include	in	the	report.	(To	a	maximum	of	11	generations)
Type	of	graph: 	The	form	of	the	graph.

full	circle
Reports	-	part	4	-	Graphical	Reports 215

http://www.gramps-project.org/wiki/index.php/File:GraphicalReports-FanChart-example-landscape-50.png
http://www.gramps-project.org/wiki/index.php/File:FanChart-GraphicalReports-ReportOptions-tab-52.png
http://www.gramps-project.org/wiki/index.php/File:Gnome-important.png


half	circle	(Default)
overhang	(half	circle	with	overhang)
quarter	circle

Background	color: 	choose	from:
white
generation	dependent	(Default)

Orientation	of	radial	texts: 	choose	from:
upright	(Default)
roundabout

	 Draw	empty	boxes :	Draw	the	background	although	there	is	no	information	(checkbox	checked	by	default)
	 Use	one	font	style	for	all	generations	:	You	can	customize	font	and	color	for	each	generation	in	the	style	editor

(checkbox	checked	by	default)
	 Flip	names	that	are	on	the	bottom	half	of	the	fan	:	Flip	names	for	generations	2,3,	and	4	i.e.	those	found	in	circles

(checkbox	checked	by	default)
	 Exclude	the	title	of	the	chart 	:	to	make	more	room	for	the	chart	(checkbox	unchecked	by	default)

Report	Options	(2)

Fig.	13.4.31	Fan	Chart	-	Graphical	Reports	-	Report	Options	(2)	-	tab
default	options

	 Include	data	marked	private 	(checkbox	checked	by	default)
Living	people :	Select	to	include	or	not	living	persons	in	the	report.	Choose	from

Include,	and	all	data	(default)
Full	names,	but	data	removed
Given	names	replaced,	and	data	removed
Complete	names	replaced,	and	data	removed
Not	included

Years	from	death	to	consider	living :	Select	the	number	of	years	since	death	to	consider	persons	for	the	report.	Allows	for	the
inclusion	or	exclusion	of	recently-dead	persons	in	the	report.	Default	value	is	0	years.
Translation :	The	translation	to	be	used	for	the	report.

Language	selector

Statistics	Charts

The	 Statistics	Charts 	report	displays	statistical	data	about	your	Family	Tree	in	the	form	of	three	charts	for	Birth	Month,	Number	of	children
and	Gender	statistics.

You	can	choose	the	Statistics	Charts	report	with	Reports	->Graphical	Reports	->	Statistics	Charts...

Specific	options	include	filter,	sorting	methods,	and	additional	birth-	and	gender-based	limit	for	inclusion	into	statistics.	You	can	also	set	the
minimum	number	of	items	to	qualify	for	the	bar	chart,	so	that	the	charts	with	fewer	items	will	generate	a	pie	chart	instead.	The	 Charts	1 ,
Charts	2 	and	 Charts	3 tabs	allows	you	to	select	which	additional	information	to	include	on	each	individual	chart	in	your	report.

Statistics	Charts	-	Graphical	Reports	-	example	output	overview;	data	from	Example.gramps
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Fig.	13.4.32	Chart	1	(Birth	Month) 	
Fig.	13.4.33	Chart	2	(Number	of
children)	- 	Fig.	13.4.34	Chart	3	(Gender)

See	also	common	options	

Report	Options

Fig.	13.4.35	Statistics	Charts	-	Graphical	Reports	-	Report	Options	-
tab	default	options

Filter: 	choose	between
Entire	Database	(Default)
Descendants	of	active	person
Descendant	families	of	active	person
Ancestors	of	active	person
People	with	common	ancestor	with	active	person

Filter	Person: 	The	center	person	for	the	filter.	Defaults	to	the	Active	Person.
Select	a	different	person 	button.	-	Change	the	Center	person.

Sort	chart	items	by: 	Select	how	the	statistical	data	is	sorted:
Item	count	(default)
Item	name

	 Sort	in	reverse	order 	(checkbox	unchecked	by	default)
People	born	after: 	(1700	default)	Birth	year	from	which	to	include	people:	fill	in	a	year	to	start	from
People	born	before: 	(Current	year	default)	Birth	year	until	which	to	include	people:	fill	in	a	year

	 Include	people	without	known	birth	years 	(checkbox	unchecked	by	default)
Genders	included: 	Select	which	genders	are	included	into	statistics.

All	(Default)
Men
Women
Other

Max.	items	for	a	pie: 	(8	default)	With	fewer	items	pie	chart	and	legend	will	be	used	instead	of	a	bar	chart.
	 Include	counts	of	missing	information 	Whether	to	include	counts	of	the	number	of	people	who	lack	the	given	information.

(checkbox	unchecked	by	default)

Report	Options	(2)

Reports	-	part	4	-	Graphical	Reports 217

http://www.gramps-project.org/wiki/index.php/File:GraphicalReports-StatisticsCharts-Chart1-example-portrait-50.png
http://www.gramps-project.org/wiki/index.php/File:GraphicalReports-StatisticsCharts-Chart3-example-portrait-50.png
http://www.gramps-project.org/wiki/index.php/File:GraphicalReports-StatisticsCharts-Chart3-Gender-example-portrait-50.png
http://www.gramps-project.org/wiki/index.php/File:StatisticsCharts-GraphicalReports-ReportOptions-tab-52.png


Fig.	13.4.36	Statistics	Charts	-	Graphical	Reports	-	Report	Options	(2)
-	tab	default	options

Name	format: 	Select	the	format	to	display	the	names.	Choose	from
Surname,	Given	Suffix	(default)
Given	Surname	Suffix
Given
Main	Surnames,	Given	Patronymic	Suffix
SURNAME,	Given	(Common)

	 Include	data	marked	private 	(checkbox	checked	by	default)
Living	People: 	Select	to	include	or	not	living	persons	in	the	report.	Choose	from

Include,	and	all	data	(default)
Full	names,	but	data	removed
Given	names	replaced,	and	data	removed
Complete	names	replaced,	and	data	removed
Not	included

Years	from	death	to	consider	living: 	Select	the	number	of	years	since	death	to	consider	persons	for	the	report.	Allows	for	the
inclusion	or	exclusion	of	recently-dead	persons	in	the	report.	Default	value	is	0	years.
Translation: 	The	translation	to	be	used	for	the	report.

Language	selector

Charts	1

Fig.	13.4.37	Statistics	Charts	-	Graphical	Reports	-	Charts	1	-	tab
default	options

Displays	 Birth	Month 	statistics	by	default	and	you	can	include	any	of	the	following	the	indicated	data	on	a	chart:

	 Age 	(checkbox	unchecked	by	default)
	 Age	at	death 	(checkbox	unchecked	by	default)
	 Age	at	marriage 	(checkbox	unchecked	by	default)
	 Age	when	first	child	born 	(checkbox	unchecked	by	default)
	 Age	when	last	child	born 	(checkbox	unchecked	by	default)
	 Birth	month 	(checkbox	checked	by	default)

Charts	2
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Fig.	13.4.38	Statistics	Charts	-	Graphical	Reports	-	Charts	2	-	tab
default	options

Displays	 Number	of	children 	statistics	by	default	and	you	can	include	any	of	the	following	the	indicated	data	on	a	chart:

	 Birth	place 	(checkbox	unchecked	by	default)
	 Birth	year 	(checkbox	unchecked	by	default)
	 Death	month 	(checkbox	unchecked	by	default)
	 Death	place 	(checkbox	unchecked	by	default)
	 Death	year 	(checkbox	unchecked	by	default)
	 Event	type 	(checkbox	unchecked	by	default)

Charts	3

Fig.	13.4.39	Statistics	Charts	-	Graphical	Reports	-	Charts	3	-	tab
default	options

Displays	 Gender 	statistics	by	default	and	you	can	include	any	of	the	following	the	indicated	data	on	a	chart:

	 Forename 	(checkbox	unchecked	by	default)
	 Gender 	(checkbox	checked	by	default)
	 Marriage	place 	(checkbox	unchecked	by	default)
	 Number	of	children 	(checkbox	checked	by	default)
	 Number	of	relationships 	(checkbox	unchecked	by	default)
	 Surname 	(checkbox	unchecked	by	default)
	 Title 	(checkbox	unchecked	by	default)

Timeline	Chart
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Fig.	13.4.40	Timeline	Chart	-	Graphical	Reports	-	example	output
overview

The	 Timeline	Chart 	report	outputs	the	list	of	people	with	their	lifetimes	represented	by	intervals	on	a	common	chronological	scale.

You	can	choose	the	 Timeline	Chart 	report	with	Reports	->Graphical	Reports	->	Timeline	Chart...	
See	also	common	options	

Report	Options

Fig.	13.4.41	Timeline	Chart	-	Graphical	Reports	-	Report	Options	-
tab	default	options

Filter: 	choose	between
Entire	Database	(Default)
Descendants	of	active	person
Descendant	families	of	active	person
Ancestors	of	active	person
People	with	common	ancestor	with	active	person

Filter	Person: 	The	center	person	for	the	filter.	Defaults	to	the	Active	Person.
Select	a	different	person 	button.	-	Change	the	Center	person.

Sort	by: 	Sorting	method	to	use.
Birth	Date	(Default)
Name

Report	Options	(2)

Fig.	13.4.42	Timeline	Chart	-	Graphical	Reports	-	Report	Options	(2)
-	tab	default	options

Name	Format: 	Select	the	format	to	display	the	names.	Choose	from
Surname,	Given	Suffix	(default)
Given	Surname	Suffix
Given
Main	Surnames,	Given	Patronymic	Suffix
SURNAME,	Given	(Common)

	 Include	data	marked	private 	(checkbox	checked	by	default)
Living	people :	Select	to	include	or	not	living	persons	in	the	report.	Choose	from
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Include,	and	all	data	(default)
Full	names,	but	data	removed
Given	names	replaced,	and	data	removed
Complete	names	replaced,	and	data	removed
Not	included

Years	from	death	to	consider	living: 	Select	the	number	of	years	since	death	to	consider	persons	for	the	report.	Allows	for	the
inclusion	or	exclusion	of	recently-dead	persons	in	the	report.	Default	value	is	0	years.
Translation: 	The	translation	to	be	used	for	the	report.

Language	selector

Back	to	Index	of	Reports.	

Previous Index Next
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Reports	-	part	5

Previous Index Next

Back	to	Index	of	Reports.

Fig.	13.5.1	Reports	>Graphs>...	Menu	overview

This	section	describes	the	different	 Graphs 	(aka	Graph	Reports)	available	in	Gramps.

Graphs

Prerequisites	for	Graph	Reports

These	reports	are	created	using	the	GraphViz	program.	Therefore,	it	is	important	that	the	Graphviz
program	is	installed	on	your	computer.

Reports	and	custom	IDs

After	a	GEDCOM	import,	your	database	can	use	some	non-standard	IDs	(ie.	123I	or	456U	not	set	on
Edit	-->	Preferences	on	the	 ID	Formats 	tab).	If	generated	reports	do	not	properly	display	data,	then
try	Reorder	Gramps	IDs	tool	Tools-->Family	Tree	Processing-->Reorder	Gramps	IDs...

All	three	graph	reports:	Family	Lines,	Hourglass,	and	Relationship	Graphs	share	common	options:	 Graphviz	Layout ,	 Graphviz	Options ,
and	 Note .

Also	they	share	common	options	with	the	other	reports	common	options:	 Paper	Options 	and	 Document	Options .

Prerequisites	for	Graph	Reports

Requires	the	installation	of	the	GraphViz	program	and	Ghostscript	program	that	is	used	by	Graphviz	reports	to	help	create	PDF	files.

On	Linux,	use	your	package	manager.
On	Microsoft	Windows	use	the	Gramps	AIO	as	they	are	already	part	of	the	installer.
On	Apple	macOS	use	the	Gramps	.dmg	as	they	are	already	part	of	the	installer.

Common	Options

There	are	also	several	GraphViz	specific	options	related	to	pagination,	color,	and	details	of	the	graph.

This	plugin	uses	the	Graphviz	graph	visualization	and	Ghostscript	programs.	Graphviz	takes	the	generated	.gv	files	and	creates	the	final	files,	such
as	.gif,	.png,	,	.ps,	(Ghostscript	creates	.pdf),	etc.

Graphviz	Layout

Reports	-	part	5	-	Graphs 222

http://www.gramps-project.org/wiki/index.php/File:MenuOverview-Reports-Graphs-60.png
http://www.gramps-project.org/wiki/index.php/File:Tango-Dialog-information.png
http://www.gramps-project.org/wiki/index.php/Output_formats#Graphviz
http://www.gramps-project.org/wiki/index.php/File:Gnome-important.png
http://www.gramps-project.org/wiki/index.php/Output_formats#Graphviz
http://www.gramps-project.org/wiki/index.php/Output_formats#Graphviz
http://www.gramps-project.org/wiki/index.php/Output_formats#Graphviz


Fig.	13.5.2	Family	Lines	Graph	-	Graphs	-	Graphviz	Layout	-	tab
default	options

Font	family: 	Choose	the	font	family.	If	international	characters	don't	show,	use	FreeSans	font.	FreeSans	is	available	from	the	NonGNU
org.

Default
PostScript/	Helvetica
True	Type/	FreeSans

Font	size: 	(14	default)	The	font	size,	in	points.
Graph	Direction: 	Whether	the	graph	goes	from	top	to	bottom	or	left	to	right

Vertical	(top	to	bottom)	(Default)
Vertical	(bottom	to	top)
Horizontal	(left	to	right)
Horizontal	(right	to	left)

Number	of	Horizontal	Pages: 	(1	default)	Graphviz	can	create	very	large	graphs	by	spreading	the	graph	across	a	rectangular	array	of
pages.	This	controls	the	number	of	pages	in	the	array	horizontally.	Only	valid	for	dot	and	pdf	via	Ghostscript.
Number	of	Vertical	Pages: 	(1	default)	Graphviz	can	create	very	large	graphs	by	spreading	the	graph	across	a	rectangular	array	of
pages.	This	controls	the	number	of	pages	in	the	array	vertically.	Only	valid	for	dot	and	pdf	via	Ghostscript.
Paging	Direction: 	(Bottom,	left	default)	The	order	in	which	the	graph	pages	are	output.	This	option	only	applies	if	the	horizontal	pages
or	vertical	pages	are	greater	than	1.
Connecting	lines: 	-	How	the	lines	between	objects	will	be	drawn.	Choose	from:

Straight
Curved	(Default)
Orthogonal

Graphviz	Options

Fig.	13.5.3	Family	Lines	Graph	-	Graphs	-	Graphviz	Options	-	tab
default	options

Aspect	Ratio: 	Affects	greatly	how	the	graph	is	laid	out	on	the	page.	Specifically	node	spacing	and	scaling	of	the	graph(	see	Advice	1:).
Compress	to	minimal	minimal	size
Fill	the	given	area	(default)
Expand	uniformly

Advice	1:

If	the	graph	is	smaller	than	the	print	area:

Compress	to	minimal	minimal	size	will	not	change	the	node	spacing.
Fill	the	given	area	will	increase	the	node	spacing	to	fit	the	print	area	in	both	width	and	height.
Expand	uniformly	will	increase	the	node	spacing	uniformly	to	preserve	the	aspect	ratio.

If	the	graph	is	larger	than	the	print	area:

Compress	to	minimal	minimal	size	will	shrink	the	graph	to	achieve	tight	packing	at	the	expense	of	symmetry.
Fill	the	given	area	will	shrink	the	graph	to	fit	the	print	area	after	first	increasing	the	node	spacing.
Expand	uniformly	will	shrink	the	graph	uniformly	to	fit	the	print	area.
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DPI: 	(72	default)	dots-per-inch.	When	creating	PostScript	or	PDF,	use	72	DPI.	Typically	between	75	and	120	if	generating	.png	or	.gif	files,
but	300	or	600	if	generating	files	to	be	printed.	When	creating	images	such	as	.gif	or	.png	files	for	the	web,	try	numbers	such	as	100	or	300
DPI.
Node	Spacing: 	(0.20	default)	The	minimum	amount	of	free	space,	in	inches,	between	individual	nodes.	For	vertical	graphs,	this
corresponds	to	spacing	between	columns.	For	horizontal	graphs,	this	corresponds	to	spacing	between	rows.
Rank	Spacing: 	(0.20	default)	The	minimum	amount	of	free	space,	in	inches,	between	ranks.	For	vertical	graphs,	this	corresponds	to
spacing	between	rows.	For	horizontal	graphs,	this	corresponds	to	spacing	between	columns.

Note

Fig.	13.5.4	Family	Lines	Graph	-	Graphs	-	Note	-	tab	default	options

Note	to	add	to	the	graph: 	(Empty	by	default)	This	text	will	be	added	to	the	graph
Note	location: 	-	Whether	the	note	will	appear	on	top	or	bottom	of	the	page.

Top	(default)
Bottom

Note	size: 	(32	default)	The	size	of	note	text,	in	points.

Family	Lines	Graph

That	Family	Lines	Graph	does	not	display	all	of	the	people	in	the	Family	Tree.

Instead,	this	Graph	report	generates	smaller	family	trees,	with	many	options	to	try	and	restrict	the	number
of	people	included.

Fig.	13.5.5	Family	Lines	Graph	-	Graphs	-	example	output	overview

The	 Family	Lines	Graph 	works	by	starting	with	a	list	of	"people	of	interest".	This	initial	list	of	people	is	then	used	to	find	both	ancestors	and
descendants	to	generate	the	 Family	Lines	Graph 	using	the	GraphViz	generator.

A	typical	use	of	this	report	is	to	generate	simplified	graphs	to	be	printed	on	large	format	printing	plotters .

To	create	a	 Family	Lines	Graph 	from	the	menu	select	Reports	->Graphs	->	Family	Lines	Graph...	and	then	from	the	 People	of
Interest 	tab	click	on	the	 (add)	icon	and	select	at	least	one	person	from	the	 Select	Person 	selector	dialog	and	the	report	will	suggest	if
possible	a	second	related	person	via	the	 Select	Person	-	Also	include	<Person	Name> 	warning	dialog	select	 No 	or	 Yes 	depending
on	what	you	decide	and	then	select	 OK 	to	generate	the	report.	
See	also:

common	options	-	(GraphViz	specific	related	to	pagination,	color,	and	details	of	the	graph.)

Report	Options
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Fig.	13.5.6	Family	Lines	Graph	-	Graphs	-	Report	Options	-	tab
default	options

	 Follow	parents	to	determine	"family	lines" 	Parents	and	their	ancestors	will	be	considered	when	determining	"family
lines".	(checkbox	checked	by	default)

	 Follow	children	to	determine	"family	lines" 	Children	will	be	considered	when	determining	"family	lines".	(checkbox
checked	by	default)

	 Try	to	remove	extra	people	and	families	People	and	families	not	directly	related	to	people	of	interest	will	be	removed
when	determining	"family	lines".	(checkbox	checked	by	default)
Arrowhead	direction: 	Choose	the	direction	that	the	arrows	point:

Descendants	<-	Ancestors	(default)	-	arrows	point	to	the	Descendants.
Descendants	->	Ancestors	-	arrows	point	to	the	Ancestors.
Descendants	<->	Ancestors	-	arrows	point	to	both.
Descendants	-	Ancestors	-	None	(no	arrows	are	shown)

Graph	colouring: 	-	Males	will	be	shown	with	blue,	females	with	red,	unless	otherwise	set	above	for	filled.	If	the	sex	of	an	individual	is
unknown	it	will	be	shown	with	gray.

B&W	outline	-	Black	and	white	outline
Coloured	outline
Colour	fill	(default)

Rounded	corners: 	to	differentiate	between	women	and	men.
None	(default)
Female
Male
Both

Gramps	ID: 	Whether	(and	where)	to	include	Gramps	IDs
Do	not	include	(default)
Share	an	existing	line
On	a	line	of	its	own

Report	Options	(2)

Fig.	13.5.7	Family	Lines	Graph	-	Graphs	-	Report	Options	(2)	-	tab
default	options

Name	Format: 	-	Select	the	format	to	display	the	names.	This	choice	in	normally	taken	from	the	default	setting	in	Edit	>	Display	tab	for
Name	format: .	Or	to	override	that	setting	for	the	report	choose	from:

Default	-	(in	a	new	Family	Tree	this	is	normally	Surname,	Given	Suffix	)
Surname,	Given	Suffix
Given	Surname	Suffix
Given
Main	Surnames,	Given	Patronymic	Suffix
SURNAME,	Given	(Common)

	 Include	data	marked	private 	(checkbox	checked	by	default)	-	Whether	to	include	private	data.
Living	People: 	-	How	to	handle	(information	about)	living	people

Included,	and	all	data	(default)
Full	names,	but	data	removed
Given	names	replaced,	and	data	removed
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

Complete	names	replaced,	and	data	removed
Not	included

Years	from	death	to	consider	living: 	0(default)	-	Whether	to	restrict	data	on	recently	dead	people.
Translation: 	The	translation	to	be	used	for	the	report.	Language	selector	showing	all	languages	supported	by	Gramps.	Defaults	to	the
language	you	are	using	Gramps	in.
Date	format: 	The	format	and	language	for	dates,	with	examples

Default	-	Choose	this	option	to	use	the	default	set	in	Edit	>	Display	tab	for	 Date	format: 	option.
YYYY-MM-DD	(ISO)	(2024-11-15)	(default	for	report)
Numerical	(15/11/2024)
Month	Day,	Year	(March	14,	2018)
MON	DAY,	YEAR	(Mar	14,	2018)
Day	Month	Year	(14	March	2018)
DAY	MON	YEAR	(14	Mar	2018)

	 Use	subgraphs 	(checkbox	checked	by	default)	-	Subgraphs	can	help	Grapviz	position	spouses	together,	but	with	non-trival	graphs
will	result	in	longer	lines	and	larger	graphs.

People	of	Interest

Fig.	13.5.8	Family	Lines	Graph	-	Graphs	-	People	of	Interest	-	tab
default	options

The	graph	works	by	starting	with	a	list	of	"people	of	interest".	This	initial	list	of	people	is	then	used	to	find	both	ancestors	and	descendants.

People	of	interest: 	click	on	 	and	 	to	add/remove	people	of	interest.	When	in	doubt,	try	adding	your	grandparents	as	a	starting
point.

	 Limit	the	number	of	ancestors 	(checkbox	unchecked	by	default)	Whether	to	limit	the	number	of	ancestors.
50	default.	The	maximum	number	of	ancestors	to	include.	The	maximum	is	for	the	total	number	of	people,	not	generations	to	be
displayed	on	the	chart.

	 Limit	the	number	of	descendants 	(checkbox	unchecked	by	default)	Whether	to	limit	the	number	of	descendants.
50	default.	The	maximum	number	of	descendants	to	include.	The	maximum	is	for	the	total	number	of	people,	not	generations	to	be
displayed	on	the	chart.

Select	Person	-	Also	include	<Person	Name>	warning	dialog

Select	Person	-	Also	include	<Person	Name>	warning	dialog

Include
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Fig.	13.5.9	Family	Lines	Graph	-	Graphs	-	Include	-	tab	default
options

	 Include	dates :	date	of	birth,	date	of	death,	and	marriage	dates	will	be	included	in	the	graph	when	this	is	selected.	(checkbox
checked	by	default)

	 Limit	dates	to	years	only :	from	the	above	only	show	the	years.(checkbox	unchecked	by	default)
	 Include	places :	place	of	birth,	place	of	death,	and	place	of	marriage	will	be	included	in	the	graph	when	this	is	selected.(checkbox

checked	by	default)
	 Include	the	number	of	children :	marriage	text	will	include	the	total	number	of	children	when	this	is	selected.(checkbox

unchecked	by	default)
	 Include	thumbnail	images	of	people 	(checkbox	checked	by	default)

Thumbnail	location:
Above	the	name	(Default)
Beside	the	name

Thumbnail	size:
Normal	(default)
Large

Family	Colours

Fig.	13.5.10	Family	Lines	Graph	-	Graphs	-	Family	Colours	-	tab
default	options

Family	colors: 	Select	the	color	to	use	for	people	with	a	specific	surname.	Two	columns	are	available:	Surname	and	Color.	Click	on	
or	 	to	add	a	surname	from	the	 Select	surname 	window,	select	a	surname	and	press	 OK .	To	edit	the	surname	color	double-click	on	a
surname	and	from	the	 Select	color	for	[Surname	Selected] 	window	choose	from	the	shown	colors	and	then	select	 Select .

Individuals
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Fig.	13.5.11	Family	Lines	Graph	-	Graphs	-	Individuals	-	tab	default
options

You	can	select	a	color	for	each	of	the	following	from	the	 Pick	a	Color 	window	and	then	select	the	 Select 	button.

Males: 	the	colour	to	use	to	display	men.
Females: 	the	colour	to	use	to	display	women.
Other: 	the	colour	to	use	to	display	people	who	neither	men	nor	women.
Unknown: 	the	colour	to	used	when	gender	is	unknown	(and	for	people	whose	surname	doesn't	match	any	of	the	names	on	the	"Family
Colours"	tab.)
Families: 	the	colour	to	use	to	display	families.	(marriages).

Hourglass	Graph

Fig.	13.5.12	Hourglass	Graph	-	Graphs	-	example	output	overview

Generate	an	 Hourglass	Graph 	using	the	GraphViz	generator.	Go	to	Reports	->	Graph	->	Hourglass	Graph....

The	hourglass	graph	chart	shows	the	 Center	Person: s	ancestors	above	them	and	descendants	below	them.	The	hourglass	graph	does	not	show
siblings	of	the	ancestors	but	it	does	include	all	the	descendants	below	them	including	any	spouses.	
See	also:

common	options	-	(GraphViz	specific	related	to	pagination,	color,	and	details	of	the	graph.)

Report	Options
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Fig.	13.5.13	Hourglass	Graph	-	Graphs	-	Report	Options	-	tab	default
options

Center	Person: 	the	center	person	for	the	report,	defaults	to	the	current	active	person.
Select	a	different	person 	button.	-	Change	the	center	person.

Max	Descendant	Generations: 	default	10
Max	Ancestor	Generations: 	default	10
Arrowhead	direction: 	Choose	the	direction	that	the	arrows	point:

Centre	->	Others	(default)	-	arrows	point	to	the	Other.
Centre	<-	Others	-	arrows	point	to	the	Centre.
Centre	<->	Others	-	arrows	point	to	both.
Centre	-	Others	-	None	(no	arrows	are	shown)

Graph	colouring: 	-	Males	will	be	shown	with	blue,	females	with	red,	unless	otherwise	set	above	for	filled.	If	the	sex	of	an	individual	is
unknown	it	will	be	shown	with	gray.

B&W	outline	-	Black	and	white	outline
Coloured	outline
Colour	fill	(default)

	 Use	rounded	corners 	to	differentiate	between	women	and	men	(checkbox	unchecked	by	default)
Gramps	ID: 	whether	to	include	Gramps	IDs.

Do	not	include	(default)
include

Report	Options	(2)

Fig.	13.5.14	Hourglass	Graph	-	Graphs	-	Report	Options	(2)	-	tab
default	options

Name	format: 	-	Select	the	format	to	display	the	names.	This	choice	in	normally	taken	from	the	default	setting	in	Edit	>	Display	tab	for
Name	format: .	Or	to	override	that	setting	for	the	report	choose	from:

Default	-	(in	a	new	Family	Tree	this	is	normally	Surname,	Given	Suffix	)
Surname,	Given	Suffix
Given	Surname	Suffix
Given
Main	Surnames,	Given	Patronymic	Suffix
SURNAME,	Given	(Common)

	 Include	data	marked	private 	(checkbox	checked	by	default)	-	Whether	to	include	private	data.
Living	People: 	-	How	to	handle	(information	about)	living	people

Included,	and	all	data	(default)
Full	names,	but	data	removed
Given	names	replaced,	and	data	removed
Complete	names	replaced,	and	data	removed
Not	included

Years	from	death	to	consider	living: 	0(default)	-	Whether	to	restrict	data	on	recently	dead	people.
Translation: 	The	translation	to	be	used	for	the	report.	Language	selector	showing	all	languages	supported	by	Gramps.	Defaults	to	the
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language	you	are	using	Gramps	in.
Date	format: 	The	format	and	language	for	dates,	with	examples

Default	-	Choose	this	option	to	use	the	default	set	in	Edit	>	Display	tab	for	 Date	format: 	option.
YYYY-MM-DD(ISO)(2018-03-14)	(default	for	report)
Numerical(14/3/2018)
Month	Day,	Year(March	14,	2018)
MON	DAY,	YEAR(Mar	14,	2018)
Day	Month	Year(14	March	2018)
DAY	MON	YEAR(14	Mar	2018)

Graph	Style

Fig.	13.5.15	Hourglass	Graph	-	Graphs	-	Graph	Style	-	tab	default
options

You	can	select	a	color	for	each	of	the	following	from	the	 Pick	a	Color 	window	and	then	select	the	 Select 	button.

Males: 	the	colour	to	use	for	males.
Females: 	the	colour	to	use	for	females.
Other: 	the	colour	to	use	for	Others.
Unknown: 	the	colour	to	used	when	gender	is	unknown	(and	for	people	whose	surname	doesn't	match	any	of	the	names	on	the	"Family
Colours"	tab.)
Families: 	the	colour	to	use	for	families	(weddings).

Force	Ahnentafel	order 	-	Force	Sosa	/	Sosa-Stradonitz	/	Ahnentafel	layout	order	for	all	ancestors,	so	that	fathers	are	always	on	the	left
branch	and	mothers	are	on	the	right	branch.

Ahnentafel	number	visible 	-	Show	Sosa	/	Sosa-Stradonitz	/	Ahnentafel	number.

Show	symbols	for	events 	-	Show	genealogical	symbols	for	birth,	marriage	and	death	events.

Relationship	Graph

Fig.	13.5.16	Relationship	Graph	-	Graphs	-	example	output	overview

The	 Relationship	Graph 	creates	a	complex	relationship	graph	using	the	GraphViz	generator.

Via	the	menu:	Reports->	Graphs-	>Relationship	Graph....	You	will	be	presented	with	a	 Relationship	Graph 	window	where	you	can
change	all	the	settings.	
See	also:

common	options	-	(GraphViz	specific	related	to	pagination,	color,	and	details	of	the	graph.)
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Report	Options

Fig.	13.5.17	Relationship	Graph	-	Graphs	-	Report	Options	-	tab
default	options

Filter: 	-	Select	the	filter	to	be	applied	to	the	report.	Choose	from:
Entire	Database	(Default)	(Not	recommended!)
Descendants	of	active	person
Descendant	families	of	active	person
Ancestors	of	active	person
People	with	common	ancestor	with	active	person
Any	custom	made	filter	you	have	created	will	be	listed	below	the	other	choices.

Centre	Person: 	The	center	person	for	the	filter.	Defaults	to	the	Active	Person.	If	you	use	a	custom	filter,	no	Person	can	be	chosen.
Select	a	different	person 	button.	-	Change	the	Centre	person.

Arrowhead	direction :	Choose	the	direction	that	the	arrows	point:
Descendants	<-	Ancestors(default)	-	arrows	point	to	the	to	the	Descendants.
Descendants	->	Ancestors	-	arrows	point	to	the	to	the	Ancestors.
Descendants	<->	Ancestors	-	arrows	point	to	both.
Descendants	-	Ancestors	-	None	(no	arrows	are	shown)

Graph	colouring: 	-	Males	will	be	shown	with	blue,	females	with	red,	unless	otherwise	set	above	for	filled.	If	the	sex	of	an	individual	is
unknown	it	will	be	shown	with	gray.

B&W	outline	-	Black	and	white	outline
Coloured	outline
Colour	fill	(default)

	 Use	rounded	corners 	Use	rounded	corners	to	differentiate	between	women	and	men	(checkbox	unchecked	by	default)
	 Use	hexagons 	(checkbox	unchecked	by	default)

Gramps	ID: 	whether	to	include	Gramps	IDs.
Do	not	include	default
include

Report	Options	(2)

Fig.	13.5.18	Relationship	Graph	-	Graphs	-	Report	Options	(2)	-	tab
default	options

Name	Format: 	-	Select	the	format	to	display	the	names.	This	choice	in	normally	taken	from	the	default	setting	in	Edit	>	Display	tab	for
Name	format: .	Or	to	override	that	setting	for	the	report	choose	from:

Default	-	(in	a	new	Family	Tree	this	is	normally	Surname,	Given	Suffix	)
Surname,	Given	Suffix
Given	Surname	Suffix
Given
Main	Surnames,	Given	Patronymic	Suffix
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SURNAME,	Given	(Common)
	 Include	data	marked	private 	(checkbox	checked	by	default)	-	Whether	to	include	private	data.

Living	People: 	-	How	to	handle	(information	about)	living	people
Included,	and	all	data	(default)
Full	names,	but	data	removed
Given	names	replaced,	and	data	removed
Complete	names	replaced,	and	data	removed
Not	included

Years	from	death	to	consider	living: 	0	(default)	-	Whether	to	restrict	data	on	recently	dead	people.
Translation: 	The	translation	to	be	used	for	the	report.	Language	selector	showing	all	languages	supported	by	Gramps.	Defaults	to	the
language	you	are	using	Gramps	in.
Date	format: 	The	format	and	language	for	dates,	with	examples

Default	-	Choose	this	option	to	use	the	default	set	in	Edit	>	Display	tab	for	 Date	format: 	option.
YYYY-MM-DD(ISO)(2024-11-15)	(default	for	report)
Numerical(15/11/2014)
Month	Day,	Year(November	15,	2024)
MON	DAY,	YEAR(Nov	15,	2024)
Day	Month	Year(15	November	2024)
DAY	MON	YEAR(15	Nov	2024)

Include

Fig.	13.5.19	Relationship	Graph	-	Graphs	-	Include	-	tab	default
options

Dates	and/or	Places: 	-	Whether	to	include	dates	and/or	places
Do	not	include	any	dates	or	places 	(default)
Include	(birth,	marriage,	death)	dates,	but	no	places
Include	(birth,	marriage,	death)	dates,	and	place
Include	(birth,	marriage,	death)	dates,	and	place	if	no	dates
Include	(birth,	marriage,	death)	years,	but	no	places
Include	(birth,	marriage,	death)	years,	and	places
Include	(birth,	marriage,	death)	places,	but	no	dates
Include	(birth,	marriage,	death)	dates	and	places	on	same	line

	 Show	all	family	nodes 	Show	family	nodes	even	if	the	output	contains	only	one	member	of	the	family.	(checkbox	checked	by
default)

	 Include	URLs 	(checkbox	unchecked	by	default)
	 Include	relationship	to	center	person 	(checkbox	unchecked	by	default)
	 Include	thumbnail	images	of	people 	(checkbox	unchecked	by	default)

Thumbnail	location: 	Where	the	thumbnail	image	should	appear	relative	to	the	name
Above	the	name	(Default)
Beside	the	name

Include	occupation: 	Whether	to	include	the	last	occupation
Do	not	include	any	occupation	(default)
Include	description	of	most	recent	occupation
Include	date,	description	and	place	of	all	occupations

	 Include	relationship	debugging	numbers	also 	Whether	to	include	'Ga'	and	'Gb'	also,	to	debug	the	relationship	calculator
(checkbox	unchecked	by	default)

Graph	Style
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Fig.	13.5.20	Relationship	Graph	-	Graphs	-	Graph	Style	-	tab	default
options

You	can	select	a	color	for	each	of	the	following	from	the	 Pick	a	Color 	window	and	then	select	the	 Select 	button.

Males: 	the	colour	to	use	for	males.
Females: 	the	colour	to	use	for	females.
Other: 	the	colour	to	use	for	others.
Unknown: 	the	colour	to	used	when	gender	is	unknown	(and	for	people	whose	surname	doesn't	match	any	of	the	names	on	the	"Family
Colours"	tab.)
Families: 	the	colour	to	use	for	families	(weddings).

	 Indicate	non-birth	relationships	with	dotted	lines 	(checkbox	checked	by	default)	-	Shows	adopted	relationships.
	 Show	family	nodes 	(checkbox	checked	by	default)

Parent	grouping: 	Decides	the	location	of	the	parents	in	the	graph.
Normal	(default)
Parents	together
Parents	offset

Example	relationship	graph

Fig.	13.5.21	Relationship	Graph	-	Graphs	-	example	output	overview

Let	us	make	a	simple	example.	We	want	a	relationship	graph	with	the	Descendant	Families	of	a	certain	person.

1.	 First	check	that	this	person	is	the	active	person.	(You	change	this	later	but	this	is	handier)
2.	 Go	via	the	menu	Reports->Graphs->Relationship	Graph...
3.	 Papersize	:	A4	metric	landscape:	we	know	there	will	be	not	too	many	people	on	the	graph,	so	this	is	ok
4.	 Report	Options:	filter:	Descendant	Families	of...,	Color	fill,	Use	rounded	corners
5.	 Graph	Style	:	Show	Family	Nodes
6.	 Graphviz	Layout:	Font	size:	15	pts	FreeSans	Direction:	top	to	bottom
7.	 Graphviz	Options:	Fill	given	area	dpi	133
8.	 Note	:	we	add	title	on	the	top	size:	18	pts
9.	 Output	Format:	we	want	a	JPEG	file.

The	results	are	similar	to	the	image	shown	in	Fig.	13.5.21.	
See	also:

A	detailed	tutorial	How	to	make	a	relationship	chart

Back	to	Index	of	Reports.
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Reports	-	part	6

Previous Index Next

Back	to	Index	of	Reports.

Fig.	13.6.1	Reports	>Text	Reports>...	Menu	overview

This	sections	describes	the	different	 Text	Reports 	available	in	Gramps.

Text	Reports
Text	reports	represent	the	desired	information	as	formatted	text.	Most	of	the	options	are	common	among	text	reports,	therefore	they	will	be
described	here	under	Common	options.

Common	options

Common	options	for	text	reports	are	the	filename	of	the	output,	the	format	of	the	output,	selected	style,	page	size	and	orientation.	For	HTML
reports,	there	is	no	page	information.	Instead,	HTML	options	include	the	choice	of	the	HTML	template,	either	available	in	Gramps	or	a	custom
template	defined	by	you.	Optionally,	the	reports	can	be	immediately	opened	with	the	default	application.

Reports	remember	the	last	option	choices

The	options	used	in	reports	are	persistent:	i.e.,	each	report	remembers	the	options	previously	used.	
Report	Options	are	stored	in	the	report_options.xml	file	found	in	the	User	Directory.

The	options	which	are	specific	to	a	given	report	will	be	described	directly	in	that	report's	entry	and	on	Command	line	references.

For	each	report	there	is	a	screen	with	on	the	top	part	tabs	(like	Paper	Options...)	and	on	the	bottom	part	the	Document	Options.	The	number	of	tabs
varies	with	the	report.

Paper	Options
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Fig.	13.6.2	Paper	Options	-	tab	for	Text	Reports

With	the	 Paper	Options 	tab	you	can	change:

Paper	format
Size 	Letter(default)
Width 	(8.50	in.	default)
Height 	(11.00	in.	default)
Orientation 	Portrait(default)

Margins
Left (1.00	in.	default)
Right (1.00	in.	default)
Top (1.00	in.	default)
Bottom (1.00	in.	default)

	 Metric 	:	whether	to	use	metric	values	or	not	(in.	or	cm.).	(checkbox	unchecked	by	default)

Document	Options

Fig.	13.6.3	Document	Options	-	tab	defaults	for	Text	Reports	(Plain
Text	-	output	selected)

Options	below	will	change	slightly	depending	on	the	output	format	selected.

Output	Format: 	choose	the	output	format:
Print...
PDF	document
HTML
Open	Document	Text
PostScript
RTF	document
LaTex
Plain	Text

	 Open	with	default	viewer :	you	can	indicate	to	open	the	made	document	your	default	viewer.	(checkbox	unchecked	by	default)
Filename: 	default	value	is	/home/<username>/<Family	Tree	Name><Report	Name>.txt.
Style: 	(default	is	default).	With	the	 Style	Editor... 	button	you	can	add	Document	Styles.
Characters	per	line: 	(72	default)

Ahnentafel	Report
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Fig.	13.6.4	Ahnentafel	Report	-	Text	Reports	-	example	output
overview

The	 Ahnentafel	Report 	lists	the	Active	Person	and	his	or	her	ancestors	along	with	their	vital	data.

You	can	choose	the	 Ahnentafel	Report 	with	Reports	->Text	Reports	->	Ahnentafel	Report...

The	people	are	numbered	in	a	special	way	which	is	an	established	standard	Genealogical	Numbering	System	called	Ahnentafel.	This	report	has
some	Ahnentafel	specific	Style	options	in	the	Style	Editor	accessible	via	the	 Style	Editor... 	button.

The	Active	Person	is	given	number	1.	His	or	her	father	and	mother	have	numbers	2	and	3,	respectively.

This	rule	holds	for	every	person	while	going	back	in	generations:	father's	parents	are	numbered	4	and	5,	and	mother's	parents	are	numbered	6	and	7,
fathers	always	numbered	with	even	and	mothers	with	odd	numbers.

Therefore,	for	any	person	having	number	N	in	this	tree,	the	numbers	of	father	and	mother	are	2N	and	2N+1,	respectively.

			person	=	n
			father	=	2n
			mother	=	2n+1

Each	entry	will	consist	of	a	single	paragraph,	and	should	contain	the	following	contents:

Person	number.
Person's	name.
Birth	Information,	if	available.
Death	Information,	if	available.
Burial	Information,	if	available

See	also	common	options	

Report	Options

Fig.	13.6.5	Ahnentafel	Report	-	Text	Reports	-	Report	Options	-	tab
default	options

Center	Person: 	the	center	person	for	the	report,	defaults	to	the	current	active	person.
Select	a	different	person 	button	to	change	the	center	person	it	will	opens	the	 Select	Person 	selector	allowing	you	to
change	the	center	person,	by	selecting	the	 []	Show	all 	check	box.

Generations: 	(10	default)	The	number	of	generations	to	include	in	the	report.
Gramps	ID: 	whether	to	include	Gramps	IDs.

Do	not	include	(default)
Include

	 Page	break	between	generations 	Whether	to	start	a	new	page	after	each	generation.(checkbox	unchecked	by	default)
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	 Add	linebreak	after	each	name 	Indicates	if	a	line	break	should	follow	the	name.(checkbox	unchecked	by	default)

Report	Options	(2)

Fig.	13.6.6	Ahnentafel	Report	-	Text	Reports	-	Report	Options	(2)	-
tab	default	options

Name	Format: 	-	Select	the	format	to	display	the	names.	This	choice	in	normally	taken	from	the	default	setting	in	Edit	>	Display	tab	for
Name	format: .	Or	to	override	that	setting	for	the	report	choose	from:

Default	-	(in	a	new	Family	Tree	this	is	normally	Surname,	Given	Suffix	)
Surname,	Given	Suffix
Given	Surname	Suffix
Given
Main	Surnames,	Given	Patronymic	Suffix
SURNAME,	Given	(Common)

	 Include	data	marked	private 	(checkbox	checked	by	default)	-	Whether	to	include	private	data.
Living	People: 	-	How	to	handle	(information	about)	living	people

Included,	and	all	data	(default)
Full	names,	but	data	removed
Given	names	replaced,	and	data	removed
Complete	names	replaced,	and	data	removed
Not	included

Years	from	death	to	consider	living: 	0(default)	-	Whether	to	restrict	data	on	recently	dead	people.
Translation: 	The	translation	to	be	used	for	the	report.	Language	selector	showing	all	languages	supported	by	Gramps.	Defaults	to	the
language	you	are	using	Gramps	in.
Date	format: 	The	format	and	language	for	dates,	with	examples

Default	-	Choose	this	option	to	use	the	default	set	in	Edit	>	Display	tab	for	 Date	format: 	option.
YYYY-MM-DD(ISO)(2018-03-14)	(default	for	report)
Numerical(14/3/2018)
Month	Day,	Year(March	14,	2018)
MON	DAY,	YEAR(Mar	14,	2018)
Day	Month	Year(14	March	2018)
DAY	MON	YEAR(14	Mar	2018)

Birthday	and	Anniversary	Report

Fig.	13.6.7	Birthday	and	Anniversary	Report	-	Text	Reports	-
example	output	overview

This	report	produces	a	list	of	birthdays	and	anniversaries	on	a	page	by	month.	It	produces	the	same	information	as	a	Calendar	report	but	in	text
format	instead	of	a	calendar	table.

You	can	choose	the	Birthday	and	Anniversary	Report	with	Reports	➡	Text	Reports	▶	Birthday	and	Anniversary	Report...	
See	also	common	options	

Report	Options
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Fig.	13.6.8	Birthday	and	Anniversary	Report	-	Text	Reports	-	Report
Options	-	tab	default	options

Filter: 	-	Select	the	filter	to	be	applied	to	the	report.	Choose	from:
Entire	Database	(Default)
Descendants	of	Filter	Person
Descendant	families	of	Filter	Person
Ancestors	of	Filter	Person
People	with	common	ancestor	with	Filter	Person
or	select	from	the	Person	category's	Custom	Filters

Filter	Person :	The	center	person	for	the	report.	(Default	to	the	Active	Person)
Select	a	different	person 	button	to	change	the	filter	person	it	will	opens	the	 Select	Person 	selector	allowing	you	to
change	the	filter	person	from	the	Bookmarked	people.	Select	the	 []	Show	all 	check	box	to	choose	from	the	entire	Tree.

Title	Text: 	Birthday	an	Anniversary	Report	(default)	-	Title	of	report
Text	Area	1: 	My	Birthday	Report	(default)	-	First	line	of	text	at	bottom	of	report
Text	Area	2: 	Produced	with	Gramps	(default)	-	Second	line	of	text	at	bottom	of	report
Text	Area	3: 	http://gramps-project.org/	(default)	-	Third	line	of	text	at	bottom	of	report

Report	Options	(2)

Fig.	13.6.9	Birthday	and	Anniversary	Report	-	Text	Reports	-	Report
Options	(2)	-	tab	default	options

Name	Format: 	-	Select	the	format	to	display	the	names.	This	choice	in	normally	taken	from	the	default	setting	in	Edit	>	Display	tab	for
Name	format: .	Or	to	override	that	setting	for	the	report	choose	from:

Default	-	(in	a	new	Family	Tree	this	is	normally	Surname,	Given	Suffix	)
Surname,	Given	Suffix
Given	Surname	Suffix
Given
Main	Surnames,	Given	Patronymic	Suffix
SURNAME,	Given	(Common)

	 Include	data	marked	private 	(checkbox	checked	by	default)	-	Whether	to	include	private	data.
	 Include	only	living	people 	(checkbox	checked	by	default)	Include	only	living	people	in	the	report.

Translation: 	The	translation	to	be	used	for	the	report.	Language	selector	showing	all	languages	supported	by	Gramps.	Defaults	to	the
language	you	are	using	Gramps	in.

Content

Fig.	13.6.10	Birthday	and	Anniversary	Report	-	Text	Reports	-
Content	-	tab	default	options

Year	of	report: 	fill	in	the	year.	Defaults	to	current	Year.
Country	for	holidays: 	Select	the	country	to	see	associated	holidays.	None	are	shown	by	default.
Birthday	surname: 	Select	married	women's	displayed	surname.
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Wives	use	their	own	surname	(Default)
Wives	use	husband's	surname	(from	first	family	listed)
Wives	use	husband's	surname	(from	last	family	listed)

	 Include	birthdays: 	Whether	to	include	birthdays	in	the	calendar	(checkbox	checked	by	default)
	 Include	anniversaries: 	Whether	to	include	anniversaries	in	the	calendar	(checkbox	checked	by	default)
	 Include	relationships	to	center	person 	Whether	to	include	relationships	to	the	filter	person	(Note:	Slower	to	create	report)

(checkbox	unchecked	by	default)

Complete	Individual	Report

Fig.	13.6.11	Complete	Individual	Report	-	Text	Reports	-	example
output	overview

This	report	provides	individual	summaries.

You	can	choose	the	Complete	Individual	Report	with	Reports	->Text	Reports	->Complete	Individual	Report...

See	also	common	options	

Report	Options

Fig.	13.6.12	Complete	Individual	Report	-	Text	Reports	-	Report
Options	-	tab	default	options

The	advantage	of	this	report	is	the	specific	filter	option.	Depending	on	the	filter	choice	(Active	Person	only,	his	or	her	descendants,	his	or	her
ancestors,	or	entire	database),	the	report	may	contain	from	one	to	many	individual	summaries.	Another	option	for	this	report	is	the	inclusion	of
source	information	when	listing	events.

Filter :	choose	between
Entire	Database	(Default)
Descendants	of	Filter	Person
Descendant	families	of	Filter	Person
Ancestors	of	Filter	Person
People	with	common	ancestor	with	Filter	Person
or	select	from	the	Person	category's	Custom	Filters

Filter	Person :	The	center	person	for	the	report.	(Default	to	the	Active	Person)
Select	a	different	person 	button	to	change	the	filter	person	it	will	opens	the	 Select	Person 	selector	allowing	you	to
change	the	filter	person	from	the	Bookmarked	people.	Select	the	 []	Show	all 	check	box	to	choose	from	the	entire	Tree.

	 List	events	chronologically 	(checkbox	checked	by	default)
	 Page	break	before	end	notes 	(checkbox	unchecked	by	default)

Report	Options	(2)
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Fig.	13.6.13	Complete	Individual	Report	-	Text	Reports	-	Report
Options	(2)	-	tab	default	options

Name	Format :	Select	the	format	to	display	the	names.	Choose	from	Surname,	Given	Suffix(default)	/	Given	Surname	Suffix	/	Given	/
Main	Surnames,	Given	Patronymic	Suffix	/	SURNAME,	Given	(Common)

	 Include	data	marked	private 	(checkbox	checked	by	default)
Living	People: 	-	How	to	handle	(information	about)	living	people

Included,	and	all	data	(default)
Full	names,	but	data	removed
Given	names	replaced,	and	data	removed
Complete	names	replaced,	and	data	removed
Not	included

Years	from	death	to	consider	living: 	0(default)	-	Whether	to	restrict	data	on	recently	dead	people.
Translation: 	The	translation	to	be	used	for	the	report.	Language	selector	showing	all	languages	supported	by	Gramps.	Defaults	to	the
language	you	are	using	Gramps	in.
Date	format: 	The	format	and	language	for	dates,	with	examples

Default	-	Choose	this	option	to	use	the	default	set	in	Edit	>	Display	tab	for	 Date	format: 	option.
YYYY-MM-DD(ISO)(2018-03-14)	(default	for	report)
Numerical(14/3/2018)
Month	Day,	Year(March	14,	2018)
MON	DAY,	YEAR(Mar	14,	2018)
Day	Month	Year(14	March	2018)
DAY	MON	YEAR(14	Mar	2018)

Include

Fig.	13.6.14	Complete	Individual	Report	-	Text	Reports	-	Include	-	tab
default	options

	 Include	Notes 	(checkbox	checked	by	default)
	 Include	Source	Information 	(checkbox	checked	by	default)
	 Include	source	notes 	(checkbox	unchecked	by	default)
	 Include	Photo/Images	from	Gallery 	(checkbox	checked	by	default)

Include	(2)

Fig.	13.6.15	Complete	Individual	Report	-	Text	Reports	-	Include	(2)	-
tab	default	options

Gramps	ID: 	whether	to	include	Gramps	IDs.
Do	not	include	default
include

	 Include	Tags 	(checkbox	checked	by	default)
	 Include	Attributes 	(checkbox	checked	by	default)
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	 Include	Census	Events 	(checkbox	checked	by	default)
	 Include	relationships	to	center	person 	Whether	to	include	relationships	to	the	filter	person	(Note:	Slower	to	create	report)

(checkbox	unchecked	by	default)

Sections

Fig.	13.6.16	Complete	Individual	Report	-	Text	Reports	-	Sections	-
tab	default	options

Used	if	separate	section	is	required.

Event	groups:
	 Family 	(Checkbox	checked	by	default)
	 Religious 	(Checkbox	checked	by	default)
	 Vocational 	(Checkbox	checked	by	default)
	 Academic 	(Checkbox	checked	by	default)
	 Travel 	(Checkbox	checked	by	default)
	 Legal 	(Checkbox	checked	by	default)
	 Residence 	(Checkbox	checked	by	default)
	 Other 	(Checkbox	checked	by	default)
	 Custom 	(Checkbox	checked	by	default)

Database	Summary	Report

Fig.	13.6.17	Database	Summary	Report	-	Text	Reports	-	example
output	overview

This	report	displays	the	overall	statistics	concerning	number	of	individuals	of	each	gender,	various	incomplete	entries	statistics,	as	well	as	family
and	media	statistics.

You	can	choose	the	Database	Summary	Report	with	Reports	->Text	Reports	->Database	Summary	Report...

The	report	shows	a	break	down	of	the	following	information	for	the	open	Family	tree

The	numbers	in	the	different	categories	are	shown

Individuals:
Number	of	individuals:
Males:
Females:
Individuals	with	unknown	gender:
Incomplete	names:
Individuals	missing	birth	dates:
Disconnected	individuals:
Unique	surnames:
Individuals	with	media	objects:
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Family	information:
Number	of	families:

Media	Objects:
Number	of	unique	media	objects:
Total	size	of	media	objects:	in	MB(megabytes)

Missing	Media	Objects:	this	will	show	the	file	names	of	any	missing	media	object.

The	information	given	in	this	report	is	the	same	as	in	the	Statistics	Gramplet	and	similar	to	the	result	from	the	 Database	Information 	dialog.

See	also	common	options	

Report	Options

Fig.	13.6.18	Database	Summary	Report	-	Text	Reports	-	Report
Options	-	tab	default	options

	 Include	data	marked	private 	(checkbox	checked	by	default)
Living	People: 	-	How	to	handle	(information	about)	living	people

Included,	and	all	data	(default)
Full	names,	but	data	removed
Given	names	replaced,	and	data	removed
Complete	names	replaced,	and	data	removed
Not	included

Years	from	death	to	consider	living: 	0(default)	-	Whether	to	restrict	data	on	recently	dead	people.
Translation: 	The	translation	to	be	used	for	the	report.	Language	selector	showing	all	languages	supported	by	Gramps.	Defaults	to	the
language	you	are	using	Gramps	in.

Descendant	Report

Fig.	13.6.19	Descendant	Report	-	Text	Reports	-	example	output
overview

This	report	presents	the	descendants	of	the	Active	Person	with	a	brief	description	in	indented	style.

You	can	choose	the	Descendant	Report	with	Reports	->Text	Reports	->Descendant	Report...	
See	also	common	options	

Report	Options

Fig.	13.6.20	Descendant	Report	-	Text	Reports	-	Report	Options	-	tab
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default	options

The	only	specific	option	concerns	the	number	of	forward	generations	to	consider.

Center	Person: 	the	center	person	for	the	report,	defaults	to	the	current	active	person.
Select	a	different	person 	button	to	change	the	center	person	it	will	opens	the	 Select	Person 	selector	allowing	you	to
change	the	center	person,	by	selecting	the	 []	Show	all 	check	box.

Numbering	system: 	The	numbering	system	to	be	used.
Simple	numbering	(default)
d'Aboville	numbering
Henry	numbering
Modified	Henry	numbering
de	Villiers/Pama	numbering
Meurgey	de	Tupigny	numbering

Generations: 	(10	default)	The	number	of	generations	to	include	in	the	report.
	 Show	marriage	info 	Whether	to	show	marriage	information	in	the	report.	(checkbox	unchecked	by	default)
	 Show	divorce	info 	Whether	to	show	divorce	information	in	the	report.	(checkbox	unchecked	by	default)
	 Show	birth	and	death	info 	Whether	to	show	birth	and	death	information	in	the	report.	(checkbox	checked	by	default)
	 Show	duplicate	trees 	Whether	to	show	duplicate	Family	Trees	information	in	the	report.	(checkbox	checked	by	default)

Report	Options	(2)

Fig.	13.6.21	Descendant	Report	-	Text	Reports	-	Report	Options	(2)	-
tab	default	options

Name	Format: 	-	Select	the	format	to	display	the	names.	This	choice	in	normally	taken	from	the	default	setting	in	Edit	>	Data	tab's
Display	Options	section	for	 Name	format: .	Or	to	override	that	setting	for	the	report	choose	from:

Default	-	(in	a	new	Family	Tree	this	is	normally	Surname,	Given	Suffix	)
Surname,	Given	Suffix
Given	Surname	Suffix
Given
Main	Surnames,	Given	Patronymic	Suffix
SURNAME,	Given	(Common)

Place	format: 	-	Select	the	format	to	display	places.	This	choice	in	normally	taken	from	the	default	setting	in	Edit	>	Display	tab	for
Place	format: .	Or	to	override	that	setting	for	the	report	choose	from:

Default
Full

	 Include	data	marked	private 	(checkbox	checked	by	default)	-	Whether	to	include	private	data.
Living	People: 	-	How	to	handle	(information	about)	living	people

Included,	and	all	data	(default)
Full	names,	but	data	removed
Given	names	replaced,	and	data	removed
Complete	names	replaced,	and	data	removed
Not	included

Years	from	death	to	consider	living: 	0(default)	-	Whether	to	restrict	data	on	recently	dead	people.
Translation: 	The	translation	to	be	used	for	the	report.	Language	selector	showing	all	languages	supported	by	Gramps.	Defaults	to	the
language	you	are	using	Gramps	in.
Date	format: 	The	format	and	language	for	dates,	with	examples

Default	-	Choose	this	option	to	use	the	default	set	in	Edit	>	Display	tab	for	 Date	format: 	option.
YYYY-MM-DD(ISO)(2018-03-14)	(default	for	report)
Numerical(14/3/2018)
Month	Day,	Year(March	14,	2018)
MON	DAY,	YEAR(Mar	14,	2018)
Day	Month	Year(14	March	2018)
DAY	MON	YEAR(14	Mar	2018)

Detailed	Ancestral	Report
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Fig.	13.6.22	Detailed	Ancestral	Report	-	Text	Reports	-	example
output	overview

This	report	covers	in	detail	the	ancestors	of	the	active	person,	including	a	range	of	vital	data	as	well	as	marriages,	following	Sosa-
Stradonitz/Ahnentafel	numbering.	It	shares	many	of	its	properties	with	the	Detailed	Descendant	Report	(see	below).

You	can	choose	the	Detailed	Ancestral	Report	with	Reports	->Text	Reports	->Detailed	Ancestral	Report...	
See	also	common	options	

Report	Options

Fig.	13.6.23	Detailed	Ancestral	Report	-	Text	Reports	-	Report
Options	-	tab	default	options

The	report	is	structured	with	the	Ahnentafel	standard	numbering.

Center	Person: 	the	center	person	for	the	report,	defaults	to	the	current	active	person.
Select	a	different	person 	button	to	change	the	center	person	it	will	opens	the	 Select	Person 	selector	allowing	you	to
change	the	center	person,	by	selecting	the	 []	Show	all 	check	box.

Sosa-Stradonitz	number: 	(1	default)	The	Sosa-Stradonitz	number	of	the	central	person.
Generations: 	(10	default)	The	number	of	generations	to	include	in	the	report.
Gramps	ID: 	whether	to	include	Gramps	IDs.

Do	not	include	default
include

	 Page	break	between	generations :	Whether	to	start	a	new	page	after	each	generation.	(checkbox	unchecked	by	default)
	 Page	break	before	end	notes :	whether	to	start	a	new	page	before	end	notes	(checkbox	unchecked	by	default)

Report	Options	(2)

Fig.	13.6.24	Detailed	Ancestral	Report	-	Text	Reports	-	Report
Options	(2)	-	tab	default	options

Name	Format: 	-	Select	the	format	to	display	the	names.	This	choice	in	normally	taken	from	the	default	setting	in	Edit	>	Display	tab	for
Name	format: .	Or	to	override	that	setting	for	the	report	choose	from:

Default	-	(in	a	new	Family	Tree	this	is	normally	Surname,	Given	Suffix	)
Surname,	Given	Suffix
Given	Surname	Suffix
Given
Main	Surnames,	Given	Patronymic	Suffix
SURNAME,	Given	(Common)

	 Include	data	marked	private 	(checkbox	checked	by	default)	-	Whether	to	include	private	data.
Living	People: 	-	How	to	handle	(information	about)	living	people
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Included,	and	all	data	(default)
Full	names,	but	data	removed
Given	names	replaced,	and	data	removed
Complete	names	replaced,	and	data	removed
Not	included

Years	from	death	to	consider	living: 	0(default)	-	Whether	to	restrict	data	on	recently	dead	people.
Translation: 	The	translation	to	be	used	for	the	report.	Language	selector	showing	all	languages	supported	by	Gramps.	Defaults	to	the
language	you	are	using	Gramps	in.
Date	format: 	The	format	and	language	for	dates,	with	examples

Default	-	Choose	this	option	to	use	the	default	set	in	Edit	>	Display	tab	for	 Date	format: 	option.
YYYY-MM-DD(ISO)(2018-03-14)	(default	for	report)
Numerical(14/3/2018)
Month	Day,	Year(March	14,	2018)
MON	DAY,	YEAR(Mar	14,	2018)
Day	Month	Year(14	March	2018)
DAY	MON	YEAR(14	Mar	2018)

Content

Fig.	13.6.25	Detailed	Ancestral	Report	-	Text	Reports	-	Content	-	tab
default	options

	 Use	Complete	Sentences :	whether	to	use	complete	sentences	or	succinct	language.(checkbox	checked	by	default)
	 Use	full	dates	instead	of	only	the	year:	whether	to	use	full	dates	instead	of	year.(checkbox	checked	by	default)
	 Compute	death	age :	whether	to	compute	a	person's	age	at	death.(checkbox	checked	by	default)
	 Omit	duplicate	ancestors :	whether	to	omit	duplicate	ancestors.(checkbox	checked	by	default)
	 Use	callname	for	common	name :	whether	to	use	the	call	name	as	the	first	name.	(checkbox	unchecked	by	default)

Include

Fig.	13.6.26	Detailed	Ancestral	Report	-	Text	Reports	-	Include	-	tab
default	options

	 Include	children :	whether	to	list	children.(checkbox	checked	by	default)
	 Include	spouses	of	children :	whether	to	list	the	spouses	of	the	children.(checkbox	checked	by	default)
	 Include	events :	Whether	to	include	events.	(checkbox	unchecked	by	default)
	 Include	other	events :	Whether	to	include	other	events	people	participated	in.(checkbox	unchecked	by	default)
	 Include	descendant	reference	in	child	list :	whether	to	add	descendant	references	in	child	list.(checkbox	checked	by

default)
	 Include	Photo/Images	from	Gallery 	(checkbox	unchecked	by	default)

Include	(2)
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Fig.	13.6.27	Detailed	Ancestral	Report	-	Text	Reports	-	Include	(2)	-
tab	default	options

	 Include	notes 	(checkbox	checked	by	default)
	 Include	sources 	(checkbox	unchecked	by	default)
	 Include	source	notes 	(checkbox	unchecked	by	default)
	 Include	attributes 	(checkbox	unchecked	by	default)
	 Include	addresses 	(checkbox	unchecked	by	default)
	 Include	alternative	names 	(checkbox	unchecked	by	default)

Missing	information

Fig.	13.6.28	Detailed	Ancestral	Report	-	Text	Reports	-	Missing
Information	-	tab	default	options

Replace	missing	places	with	___ :	Whether	to	replace	missing	Places	with	blank	spaces.(checkbox	unchecked	by	default)
Replace	missing	dates	with	___ :	Whether	to	replace	missing	Dates	with	blank	spaces.(checkbox	unchecked	by	default)

Detailed	Descendant	Report

Fig.	13.6.29	Detailed	Descendant	Report	-	Text	Reports	-	example
output	overview

This	report	covers	in	detail	the	descendants	of	the	active	person	by	generation,	following	the	genealogical	tradition	of	textual	descendant	reports	by
generation.	It	aims	to	provide	all	important	features	expected	to	be	found	in	these	classic	descendency	formats	and	has	received	influence	from
various	sources.	The	Gramps	team	considers	as	one	of	its	objectives	the	viability	of	this	report's	adoption	by	professional	genealogical	institutions
worldwide.	As	a	consequence	this	is	a	highly	customizable	report.

The	report	includes	a	range	of	vital	information,	marriages	and	(optionally)	notes	and	spouses'	information.	Among	the	numerous	options	are	the
number	of	forward	generations	to	consider,	whether	to	compute	ages,	the	text-style	between	complete-sentenced	and	succinct,	and	whether	to
include	images.	The	report	utilizes	Henry-style	numbering	by	default,	and	offers	d'Aboville-style	numbering	and	Register-style	numbering	as
options.

You	can	choose	the	Detailed	Descendant	Report	with	Reports	->Text	Reports	->Detailed	Descendant	Report...	
See	also	common	options	

Report	Options
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Fig.	13.6.30	Detailed	Descendant	Report	-	Text	Reports	-	Report
Options	-	tab	default	options

Center	Person: 	the	center	person	for	the	report,	defaults	to	the	current	active	person.
Select	a	different	person 	button	to	change	the	center	person	it	will	opens	the	 Select	Person 	selector	allowing	you	to
change	the	center	person,	by	selecting	the	 []	Show	all 	check	box.

Numbering	system: 	the	numbering	system	to	be	used.
Henry	numbering	(default)
d'Aboville	numbering
Record	(Modified	Register)	numbering

Report	structure: 	How	people	are	organized	in	the	report
show	people	by	generations	(default)
show	people	by	lineage

Generations: 	(10	default)	The	number	of	generations	to	include	in	the	report.
Gramps	ID: 	whether	to	include	Gramps	IDs.

Do	not	include	default
include

Page	break	between	generations :	Whether	to	start	a	new	page	after	each	generation.	(checkbox	unchecked	by	default)
Page	break	before	end	notes :	whether	to	start	a	new	page	before	end	notes	(checkbox	unchecked	by	default)

Report	Options	(2)

Fig.	13.6.31	Detailed	Descendant	Report	-	Text	Reports	-	Report
Options	(2)	-	tab	default	options

Name	Format: 	-	Select	the	format	to	display	the	names.	This	choice	in	normally	taken	from	the	default	setting	in	Edit	>	Display	tab	for
Name	format: .	Or	to	override	that	setting	for	the	report	choose	from:

Default	-	(in	a	new	Family	Tree	this	is	normally	Surname,	Given	Suffix	)
Surname,	Given	Suffix
Given	Surname	Suffix
Given
Main	Surnames,	Given	Patronymic	Suffix
SURNAME,	Given	(Common)

	 Include	data	marked	private 	(checkbox	checked	by	default)	-	Whether	to	include	private	data.
Living	People: 	-	How	to	handle	(information	about)	living	people

Included,	and	all	data	(default)
Full	names,	but	data	removed
Given	names	replaced,	and	data	removed
Complete	names	replaced,	and	data	removed
Not	included

Years	from	death	to	consider	living: 	0(default)	-	Whether	to	restrict	data	on	recently	dead	people.
Translation: 	The	translation	to	be	used	for	the	report.	Language	selector	showing	all	languages	supported	by	Gramps.	Defaults	to	the
language	you	are	using	Gramps	in.
Date	format: 	The	format	and	language	for	dates,	with	examples

Default	-	Choose	this	option	to	use	the	default	set	in	Edit	>	Display	tab	for	 Date	format: 	option.
YYYY-MM-DD(ISO)(2018-03-14)	(default	for	report)
Numerical(14/3/2018)
Month	Day,	Year(March	14,	2018)
MON	DAY,	YEAR(Mar	14,	2018)
Day	Month	Year(14	March	2018)
DAY	MON	YEAR(14	Mar	2018)
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Content

Fig.	13.6.32	Detailed	Descendant	Report	-	Text	Reports	-	Content	-
tab	default	options

Use	complete	sentences :	whether	to	use	complete	sentences	or	succinct	language.(checkbox	checked	by	default)
Use	full	dates	instead	of	only	the	year:	whether	to	use	full	dates	instead	of	year.(checkbox	checked	by	default)
Compute	death	age :	whether	to	compute	a	person's	age	at	death.(checkbox	checked	by	default)
Use	callname	for	common	name :	whether	to	use	the	call	name	as	the	first	name.	(checkbox	unchecked	by	default)

Include

Fig.	13.6.33	Detailed	Descendant	Report	-	Text	Reports	-	Include	-	tab
default	options

Include	children :	whether	to	list	children.(checkbox	checked	by	default)
Include	spouses	of	children :	whether	to	list	spouses	of	children.(checkbox	unchecked	by	default)
	 Include	spouses 	(checkbox	unchecked	by	default)
	 Include	spouse	reference 	(checkbox	unchecked	by	default)
	 Include	events 	(checkbox	unchecked	by	default)
	 Include	descendant	reference	in	child	list :	whether	to	include	descendant	references	in	child	list.(checkbox	checked	by

default)
	 Include	Photo/Images	from	Gallery 	(checkbox	unchecked	by	default)

Include	(2)

Fig.	13.6.34	Detailed	Descendant	Report	-	Text	Reports	-	Include	(2)	-
tab	default	options

	 Include	notes 	(checkbox	checked	by	default)
	 Include	sources 	(checkbox	unchecked	by	default)
	 Include	sources	notes 	(checkbox	unchecked	by	default)
	 Include	attributes 	(checkbox	unchecked	by	default)
	 Include	addresses 	(checkbox	unchecked	by	default)
	 Include	alternative	names 	(checkbox	unchecked	by	default)
	 Include	sign	of	succession	('+')	in	child-list 	(checkbox	checked	by	default)
	 Include	path	to	start-person 	(checkbox	unchecked	by	default)
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Missing	Information

Fig.	13.6.35	Detailed	Descendant	Report	-	Text	Reports	-	Missing
Information	-	tab	default	options

Replace	missing	places	with	___ :	Whether	to	replace	missing	Places	with	blank	spaces.(checkbox	unchecked	by	default)
Replace	missing	dates	with	___ :	Whether	to	replace	missing	Dates	with	blank	spaces.(checkbox	unchecked	by	default)

End	of	Line	Report

Fig.	13.6.36	End	of	Line	Report	-	Text	Reports	-	example	output
overview

This	provides	a	list	of	a	person's	last	known	ancestors	with	the	pedigree	line,	ordered	by	generations.

You	can	choose	the	End	of	Line	Report	with	Reports	->Text	Reports	->End	of	Line	Report...	
See	also	common	options	

Report	Options

Fig.	13.6.37	End	of	Line	Report	-	Text	Reports	-	Report	Options	-	tab
default	options

Center	Person: 	the	center	person	for	the	report,	defaults	to	the	current	active	person.
Select	a	different	person 	button	to	change	the	center	person	it	will	opens	the	 Select	Person 	selector	allowing	you	to
change	the	center	person,	by	selecting	the	 []	Show	all 	check	box.

Name	Format: 	-	Select	the	format	to	display	the	names.	This	choice	in	normally	taken	from	the	default	setting	in	Edit	>	Display	tab	for
Name	format: .	Or	to	override	that	setting	for	the	report	choose	from:

Default	-	(in	a	new	Family	Tree	this	is	normally	Surname,	Given	Suffix	)
Surname,	Given	Suffix
Given	Surname	Suffix
Given
Main	Surnames,	Given	Patronymic	Suffix
SURNAME,	Given	(Common)

	 Include	data	marked	private 	(checkbox	checked	by	default)	-	Whether	to	include	private	data.
Living	People: 	-	How	to	handle	(information	about)	living	people

Included,	and	all	data	(default)
Full	names,	but	data	removed
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Given	names	replaced,	and	data	removed
Complete	names	replaced,	and	data	removed
Not	included

Years	from	death	to	consider	living: 	0(default)	-	Whether	to	restrict	data	on	recently	dead	people.
Translation: 	The	translation	to	be	used	for	the	report.	Language	selector	showing	all	languages	supported	by	Gramps.	Defaults	to	the
language	you	are	using	Gramps	in.
Date	format: 	The	format	and	language	for	dates,	with	examples

Default	-	Choose	this	option	to	use	the	default	set	in	Edit	>	Display	tab	for	 Date	format: 	option.
YYYY-MM-DD(ISO)(2018-03-14)	(default	for	report)
Numerical(14/3/2018)
Month	Day,	Year(March	14,	2018)
MON	DAY,	YEAR(Mar	14,	2018)
Day	Month	Year(14	March	2018)
DAY	MON	YEAR(14	Mar	2018)

Family	Group	Report

Fig.	13.6.38	Family	Group	Report	-	Text	Reports	-	example	output
overview

This	creates	a	family	group	report,	showing	information	on	a	set	of	parents	and	their	children.

You	can	choose	the	Family	Group	Report	with	Reports	->Text	Reports	->Family	Group	Report...	
See	also

common	options
Family	Sheet	addon	-	includes	output	of	sources.

Report	Options
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Fig.	13.6.39	Family	Group	Report	-	Text	Reports	-	Report	Options	-
tab	default	options

Filter: 	-	Select	the	filter	to	be	applied	to	the	report.	Choose	from:
Default	-	Defaults	to	the	Active	family	for	the	current	active	Person.
Every	family
Descendant	families	-	of	the	active	family
Ancestors	families	-	of	active	family

Center	Family: 	The	center	family	for	the	filter.	Defaults	to	the	Active	family	for	the	current	active	Person.
Select	a	different	family 	button	that	opens	the	 Select	Family 	selector	allowing	you	to	change	the	filter	family,	by
selecting	the	 []	Show	all 	check	box.

	 Recursive(down) :	Create	reports	for	all	descendants	of	this	family.(checkbox	unchecked	by	default)

Report	Options	(2)

Fig.	13.6.40	Family	Group	Report	-	Text	Reports	-	Report	Options	(2)
-	tab	default	options

Name	Format: 	-	Select	the	format	to	display	the	names.	This	choice	in	normally	taken	from	the	default	setting	in	Edit	>	Data	tab	in	the
Display	Options	section	for	 Name	format: .	Or	to	override	that	setting	for	the	report	choose	from:

Default	-	(in	a	new	Family	Tree	this	is	normally	Surname,	Given	Suffix	)
Surname,	Given	Suffix
Given	Surname	Suffix
Given
Main	Surnames,	Given	Patronymic	Suffix
SURNAME,	Given	(Common)

Place	format: 	Select	the	format	to	display	places
Default
Full

	 Include	data	marked	private 	(checkbox	checked	by	default)	-	Whether	to	include	private	data.
Living	People: 	-	How	to	handle	(information	about)	living	people

Included,	and	all	data	(default)
Full	names,	but	data	removed
Given	names	replaced,	and	data	removed
Complete	names	replaced,	and	data	removed
Not	included

Years	from	death	to	consider	living: 	0(default)	-	Whether	to	restrict	data	on	recently	dead	people.
Translation: 	The	translation	to	be	used	for	the	report.	Language	selector	showing	all	languages	supported	by	Gramps.	Defaults	to	the
language	you	are	using	Gramps	in.
Date	format: 	The	format	and	language	for	dates,	with	examples

Default	-	Choose	this	option	to	use	the	default	set	in	Edit	>	Display	tab	for	 Date	format: 	option.
YYYY-MM-DD(ISO)(2018-03-14)	(default	for	report)
Numerical(14/3/2018)
Month	Day,	Year(March	14,	2018)
MON	DAY,	YEAR(Mar	14,	2018)
Day	Month	Year(14	March	2018)
DAY	MON	YEAR(14	Mar	2018)

Include

Fig.	13.6.41	Family	Group	Report	-	Text	Reports	-	Include	-	tab
default	options

	 Parent	Marriage :	Whether	to	include	marriage	information	for	parent.	(checkbox	checked	by	default)
	 Parent	Events :	Whether	to	include	events	for	parents.	(checkbox	unchecked	by	default)
	 Parent	Addresses :	Whether	to	include	addresses	for	parents.	(checkbox	unchecked	by	default)
	 Parent	Notes :	Whether	to	include	notes	for	parents.	(checkbox	unchecked	by	default)
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	 Parent	Attributes :	Whether	to	include	attributes.	(checkbox	unchecked	by	default)
	 Alternate	Parent	Names :	Whether	to	include	alternate	name.	(checkbox	unchecked	by	default)

Include	(2)

Fig.	13.6.42	Family	Group	Report	-	Text	Reports	-	Include	(2)	-	tab
default	options

Gramps	ID: 	whether	to	include	Gramps	IDs.
Do	not	include	(default)
Include

	 Family	Notes :	Whether	to	include	notes	for	families.	(checkbox	unchecked	by	default)
	 Dates	of	Relatives :	Whether	to	include	dates	for	relatives.	(checkbox	unchecked	by	default)
	 Children	Marriages :	Whether	to	include	marriage	information	for	children.(checkbox	checked	by	default)
	 Generation	numbers(recursive	only) :	Whether	to	include	the	generation	on	each.(checkbox	unchecked	by	default)
	 Print	fields	for	missing :	Whether	to	include	fields	for	missing	information.	(checkbox	checked	by	default)

Kinship	Report

Fig.	13.6.43	Kinship	Report	-	Text	Reports	-	example	output	overview

This	provides	the	kinship	of	selected	person	according	to	level	search	(height,	down	generations)	set	by	user.

You	can	choose	the	Kinship	Report	with	Reports	->Text	Reports	->Kinship	Report...	
See	also:

common	options
Relationship	Calculator	Localization	-	create	meaningful	relation	descriptions	in	your	region.

Report	Options

Fig.	13.6.44	Kinship	Report	-	Text	Reports	-	Report	Options	-	tab
default	options
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Center	Person: 	the	center	person	for	the	report,	defaults	to	the	current	active	person.
Select	a	different	person 	button	to	change	the	center	person	it	will	opens	the	 Select	Person 	selector	allowing	you	to
change	the	center	person,	by	selecting	the	 []	Show	all 	check	box.

Max	Descendant	Generations: 	(2default)	The	maximum	number	of	descendant	generations.	If	needed	you	can	type	a	larger	number.
Max	Ancestor	Generations: 	(2default)	The	maximum	number	of	ancestor	generations.	If	needed	you	can	type	a	larger	number.

	 Include	spouses :	Whether	to	include	spouses.	(checkbox	checked	by	default)
	 Include	cousins :	Whether	to	include	cousins.	(checkbox	checked	by	default)
	 Include	aunts/uncles/nephews/nieces :	Whether	to	include	aunts/uncles/nephews/nieces.	(checkbox	checked	by	default)

Report	Options	(2)

Fig.	13.6.45	Kinship	Report	-	Text	Reports	-	Report	Options	(2)	-	tab
default	options

Name	Format: 	-	Select	the	format	to	display	the	names.	This	choice	in	normally	taken	from	the	default	setting	in	Edit	>	Display	tab	for
Name	format: .	Or	to	override	that	setting	for	the	report	choose	from:

Default	-	(in	a	new	Family	Tree	this	is	normally	Surname,	Given	Suffix	)
Surname,	Given	Suffix
Given	Surname	Suffix
Given
Main	Surnames,	Given	Patronymic	Suffix
SURNAME,	Given	(Common)

	 Include	data	marked	private 	(checkbox	checked	by	default)	-	Whether	to	include	private	data.
Living	People: 	-	How	to	handle	(information	about)	living	people

Included,	and	all	data	(default)
Full	names,	but	data	removed
Given	names	replaced,	and	data	removed
Complete	names	replaced,	and	data	removed
Not	included

Years	from	death	to	consider	living: 	0(default)	-	Whether	to	restrict	data	on	recently	dead	people.
Translation: 	The	translation	to	be	used	for	the	report.	Language	selector	showing	all	languages	supported	by	Gramps.	Defaults	to	the
language	you	are	using	Gramps	in.
Date	format: 	The	format	and	language	for	dates,	with	examples

Default	-	Choose	this	option	to	use	the	default	set	in	Edit	>	Display	tab	for	 Date	format: 	option.
YYYY-MM-DD(ISO)(2018-03-14)	(default	for	report)
Numerical(14/3/2018)
Month	Day,	Year(March	14,	2018)
MON	DAY,	YEAR(Mar	14,	2018)
Day	Month	Year(14	March	2018)
DAY	MON	YEAR(14	Mar	2018)

Note	Link	Report

Fig.	13.6.46	Note	Link	Report	-	Text	Reports	-	example	output
overview

The	 Note	Link	Report 	allows	you	to	check	Links	in	Notes	are	valid.

This	report	displays	and	checks	the	status	of	the	internal	link	consistency	in	Gramps	notes	created	with	the	Link	Editor	and	only	list	external	internet
addresses	created	using	the	Internet	Address	Editor	without	checking	them.
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You	can	choose	the	Note	Link	Report	with	Reports	->Text	Reports	->Note	Link	Report...

No	options	are	available	for	this	report.[1]

See	also:

common	options
Link	Editor
Internet	Address	Editor.

Number	of	Ancestors	Report

Fig.	13.6.47	Number	Of	Ancestors	Report	-	Text	Reports	-	example
output	overview

This	report	displays	the	number	of	ancestors	of	the	active	person.

You	can	choose	the	Number	of	Ancestors	Report	with	Reports	->Text	Reports	->Number	of	Ancestors	Report...

The	report	shows	the	following	details:

generation	1	has	1	individual	:	100%	:	this	is	the	person	you	started	with
generation	2	has	2	individuals	:	100%	:	both	parents	are	known
.....
generation	8	has	35	individuals	:	27.34	%	this	means	from	the	(2**7)	128	possible	ancestors	in	generation	8	-	27%	are	known.

Total	ancestors	in	generation	2	to	..	is	also	given	in	numbers	and	percentages.	
See	also	common	options	

Report	Options

Fig.	13.6.48	Number	of	Ancestors	Report	-	Text	Reports	-	Report
Options	-	tab	default	options

Center	Person: 	the	center	person	for	the	report,	defaults	to	the	current	active	person.
Select	a	different	person 	button	to	change	the	center	person	it	will	opens	the	 Select	Person 	selector	allowing	you	to
change	the	center	person,	by	selecting	the	 []	Show	all 	check	box.

Name	Format: 	-	Select	the	format	to	display	the	names.	This	choice	in	normally	taken	from	the	default	setting	in	Edit	>	Display	tab	for
Name	format: .	Or	to	override	that	setting	for	the	report	choose	from:

Default	-	(in	a	new	Family	Tree	this	is	normally	Surname,	Given	Suffix	)
Surname,	Given	Suffix
Given	Surname	Suffix
Given
Main	Surnames,	Given	Patronymic	Suffix
SURNAME,	Given	(Common)

	 Include	data	marked	private 	(checkbox	checked	by	default)	-	Whether	to	include	private	data.
Translation: 	The	translation	to	be	used	for	the	report.	Language	selector	showing	all	languages	supported	by	Gramps.	Defaults	to	the
language	you	are	using	Gramps	in.

Place	Report
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Fig.	13.6.49	Place	Report	-	Text	Reports	-	example	output	overview

Produces	a	report	according	to	places	selected	by	the	user.

It	will	list	related	person	and	event	to	the	selected	place.

You	can	choose	the	Place	Report	with	Reports	->Text	Reports	->Place	Report...

See	also	common	options	

Report	Options

Fig.	13.6.50	Place	Report	-	Text	Reports	-	Report	Options	-	tab
default	options

Select	using	filter: 	Select	places	using	a	custom	filter	you	created	earlier.
Select	places	individually: 	List	of	places	to	report	on.

+ 	button	-	Brings	up	the	 Select	Place 	selector	dialog	so	you	can	choose	a	place.
- 	button	-	Select	place	in	list	then	press	this	to	remove	place.

Center	on: 	-	If	report	is	event	or	person	centered.
Event	(default)
Person

Report	Options	(2)

Fig.	13.6.51	Place	Report	-	Text	Reports	-	Report	Options	(2)	-	tab
default	options

Name	format: 	-	Select	the	format	to	display	the	names.	This	choice	in	normally	taken	from	the	default	setting	in	Edit	>	Display	tab	for
Name	format: .	Or	to	override	that	setting	for	the	report	choose	from:

Default	-	(in	a	new	Family	Tree	this	is	normally	Surname,	Given	Suffix	)
Surname,	Given	Suffix
Given	Surname	Suffix
Given
Main	Surnames,	Given	Patronymic	Suffix
SURNAME,	Given	(Common)

Place	format: 	-	Select	the	format	to	display	places.	This	choice	in	normally	taken	from	the	default	setting	in	Edit	>	Display	tab	for
Place	format: .	Or	to	override	that	setting	for	the	report	choose	from:

Default
Full
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	 Include	data	marked	private 	(checkbox	checked	by	default)	-	Whether	to	include	private	data.
Living	People: 	-	How	to	handle	(information	about)	living	people

Included,	and	all	data	(default)
Full	names,	but	data	removed
Given	names	replaced,	and	data	removed
Complete	names	replaced,	and	data	removed
Not	included

Years	from	death	to	consider	living: 	0(default)	-	Whether	to	restrict	data	on	recently	dead	people.
Translation: 	The	translation	to	be	used	for	the	report.	Language	selector	showing	all	languages	supported	by	Gramps.	Defaults	to	the
language	you	are	using	Gramps	in.
Date	format: 	The	format	and	language	for	dates,	with	examples

Default	-	Choose	this	option	to	use	the	default	set	in	Edit	>	Display	tab	for	 Date	format: 	option.
YYYY-MM-DD(ISO)(2018-03-14)	(default	for	report)
Numerical(14/3/2018)
Month	Day,	Year(March	14,	2018)
MON	DAY,	YEAR(Mar	14,	2018)
Day	Month	Year(14	March	2018)
DAY	MON	YEAR(14	Mar	2018)

Records	Report

Fig.	13.6.52	Records	Report	-	Text	Reports	-
example	output	overview

The	Records	report	shows	a	number	of	interesting	records	(mostly	age	related)	in	your	database,	like	oldest	living	person,	youngest	mother,	etc.

You	can	choose	the	Records	Report	with	Reports	->Text	Reports	->Records	Report...

An	identical	Records	Gramplet	is	also	available.

See	also	common	options	

Report	Options

Fig.	13.6.53	Records	Report	-	Text	Reports	-	Report	Options	-	tab
default	options

Selection	of	the	records	to	print	is	possible,	and	a	reasonable	list	of	"positive	records"	is	preselected	(most	people	would	regard,	for	example,	a	long
marriage	as	a	positive	record,	while	an	early	divorce	would	rather	be	seen	as	a	negative	record).

Filter: 	-	Select	the	filter	to	be	applied	to	the	report.	Choose	from:
Entire	Database	(Default)
Descendants	of	active	person
Descendant	families	of	active	person
Ancestors	of	active	person
People	with	common	ancestor	with	active	person
Any	custom	made	filter	you	have	created	will	be	listed	below	the	other	choices.

Filter	Person: 	The	center	person	for	the	filter.	Defaults	to	the	Active	Person.
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Select	a	different	person 	button	to	change	the	filter	person	it	will	opens	the	 Select	Person 	selector	allowing	you	to
change	the	filter	person	from	the	Bookmarked	people.	Select	the	 []	Show	all 	check	box	to	choose	from	the	entire	Tree.

Number	of	ranks	to	display: 	3	(default)
Use	call	name:

Don't	use	call	name(default)
Replace	first	names	with	call	name	-	(See	Caveats)
underline	call	name	in	first	names	/	add	call	name	to	first	name

Footer	text: 	default	=	empty	field

Caveats

If	the	option	to	underline	the	call	name	is	selected,	the	report	uses	<u>...</u>	to	achieve	this.	This	only
works	with	CairoDoc	based	output	(direct	printing,	PDF	export)	and	HTML	output.

Report	Options	(2)

Fig.	13.6.54	Records	Report	-	Text	Reports	-	Report	Options	(2)	-	tab
default	options

Name	Format: 	-	Select	the	format	to	display	the	names.	This	choice	in	normally	taken	from	the	default	setting	in	Edit	>	Display	tab	for
Name	format: .	Or	to	override	that	setting	for	the	report	choose	from:

Default	-	(in	a	new	Family	Tree	this	is	normally	Surname,	Given	Suffix	)
Surname,	Given	Suffix
Given	Surname	Suffix
Given
Main	Surnames,	Given	Patronymic	Suffix
SURNAME,	Given	(Common)

	 Include	data	marked	private 	(checkbox	checked	by	default)	-	Whether	to	include	private	data.
Living	People: 	-	How	to	handle	(information	about)	living	people

Included,	and	all	data	(default)
Full	names,	but	data	removed
Given	names	replaced,	and	data	removed
Complete	names	replaced,	and	data	removed
Not	included

Years	from	death	to	consider	living: 	0(default)	-	Whether	to	restrict	data	on	recently	dead	people.
Translation: 	The	translation	to	be	used	for	the	report.	Language	selector	showing	all	languages	supported	by	Gramps.	Defaults	to	the
language	you	are	using	Gramps	in.

Person	1

Fig.	13.6.55	Records	Report	-	Text	Reports	-	Person	1	-	tab	default
options

	 Youngest	living	person 	(checkbox	checked	by	default)
	 Oldest	living	person 	(checkbox	checked	by	default)
	 Person	died	at	youngest	age 	(checkbox	unchecked	by	default)
	 Person	died	at	oldest	age 	(checkbox	checked	by	default)
	 Person	married	at	youngest	age 	(checkbox	checked	by	default)
	 Person	married	at	oldest	age 	(checkbox	checked	by	default)
	 Person	divorced	at	youngest	age 	(checkbox	unchecked	by	default)
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	 Person	divorced	at	oldest	age 	(checkbox	unchecked	by	default)

Person	2

Fig.	13.6.56	Records	Report	-	Text	Reports	-	Person	2	-	tab	default
options

	 Youngest	father 	(checkbox	checked	by	default)
	 Youngest	mother 	(checkbox	checked	by	default)
	 Oldest	father 	(checkbox	checked	by	default)
	 Oldest	mother 	(checkbox	checked	by	default)
	 Father	with	most	children 	(checkbox	unchecked	by	default)
	 Mother	with	most	children 	(checkbox	unchecked	by	default)
	 Father	with	most	grandchildren 	(checkbox	unchecked	by	default)
	 Mother	with	most	grandchildren 	(checkbox	unchecked	by	default)

Family

Fig.	13.6.57	Records	Report	-	Text	Reports	-	Family	-	tab	default
options

	 Couple	with	most	children 	(checkbox	checked	by	default)
	 Living	couple	married	most	recently 	(checkbox	checked	by	default)
	 Living	couple	married	most	long	ago 	(checkbox	checked	by	default)
	 Shortest	past	marriage 	(checkbox	unchecked	by	default)
	 Longest	past	marriage 	(checkbox	checked	by	default)
	 Couple	with	smallest	age	difference 	(checkbox	checked	by	default)
	 Couple	with	biggest	age	difference 	(checkbox	checked	by	default)

Tag	Report

Fig.	13.6.58	Tag	Report	-	Text	Reports	-	example
output	overview

This	lists	Tag	Usage	for	primary	objects	(person,	family,	notes)	who	match	the	selected	Tag.

You	can	choose	the	Tag	Report	with	Reports	->Text	Reports	->Tag	Report...

See	also	common	options	

Report	Options
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Fig.	13.6.59	Tag	Report	-	Text	Reports	-	Report	Options	-	tab	default
options

Tag :	Select	the	Tag	to	use	for	the	report.
Name	Format: 	-	Select	the	format	to	display	the	names.	This	choice	in	normally	taken	from	the	default	setting	in	Edit	>	Display	Options
tab	for	 Name	format: .	Or	to	override	that	setting	for	the	report	choose	from:

Default	-	(in	a	new	Family	Tree	this	is	normally	Surname,	Given	Suffix	)
Surname,	Given	Suffix
Given	Surname	Suffix
Given
Main	Surnames,	Given	Patronymic	Suffix
SURNAME,	Given	(Common)

Place	format: 	-	Select	the	format	to	display	places.	This	choice	in	normally	taken	from	the	default	setting	in	Edit	>	Display	Options	tab
for	 Place	format: .	Or	to	override	that	setting	for	the	report	choose	from:

Default
Full

	 Include	data	marked	private 	(checkbox	checked	by	default)	-	Whether	to	include	private	data.
Living	People: 	-	How	to	handle	(information	about)	living	people

Included,	and	all	data	(default)
Full	names,	but	data	removed
Given	names	replaced,	and	data	removed
Complete	names	replaced,	and	data	removed
Not	included

Years	from	death	to	consider	living: 	0(default)	-	Whether	to	restrict	data	on	recently	dead	people.
Translation: 	The	translation	to	be	used	for	the	report.	Language	selector	showing	all	languages	supported	by	Gramps.	Defaults	to	the
language	you	are	using	Gramps	in.
Date	format: 	The	format	and	language	for	dates,	with	examples

Default	-	Choose	this	option	to	use	the	default	set	in	Edit	>	Display	Options	tab	for	 Date	format: 	option.
YYYY-MM-DD(ISO)(2018-03-14)	(default	for	report)
Numerical(14/3/2018)
Month	Day,	Year(March	14,	2018)
MON	DAY,	YEAR(Mar	14,	2018)
Day	Month	Year(14	March	2018)
DAY	MON	YEAR(14	Mar	2018)

Back	to	Index	of	Reports.

Previous Index Next
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Reports	-	part	7

Previous Index Next

Back	to	Index	of	Reports.

Fig.	13.7.1	Reports	>Web	Pages>...	Menu	overview

This	section	describes	the	 Web	Pages 	reports,	Narrated	Web	Site	and	Web	Calendar	as	part	of	the	different	reports	available	in	Gramps.

Web	Pages

Narrated	Web	Site

For	this	report	to	work	requires	that	the	optional	prerequisite	PyICU	be	installed

See:

Prerequisites	for	Narrated	Web	Site

Do	you	really	want	to	use	the	entire	Family	Tree	database

Be	aware	that	if	you	select	the	Entire	Database	filter	option	for	your	Family	Tree	database	that	a	large
number	of	files	will	be	generated	(depending	on	the	size	of	your	Family	Tree	database).	It	is
recommended	to	start	with	a	smaller	filter	(for	example:	ancestors	of	a	certain	person)	to	simplify	the
output	while	you	learn	about	the	Narrated	Web	Site	Report.

Fig.	13.7.2	Narrated	Web	Site	-	Web	Pages	-	Individuals	(index)	page
-	default	HTML	output	-	example

The	 Narrated	Web	Site 	report	generates	a	web	site	(that	is,	a	set	of	linked	web	pages),	for	a	set	of	selected	individuals	and	provides	the	user
with	options	that	allow	a	wide	range	of	customization.	You	can	run	this	report	via	the	menu	Reports-->Web	Pages-->Narrated	Web	Site....

The	Narrated	Web	Site	report	creates	pages	that	closely	follow	the	World	Wide	Web	Consortium’s	Recommendations	for	XHTML	1.0	Strict	and
CSS	1.	These	recommendations	include	a	separation	of	content	from	presentation.	Due	to	this	practice,	the	style	and	appearance	of	the	new	web
pages	can	be	completely	controlled	from	one	CSS	stylesheet	without	altering	individual	pages.

Introduction	pages	can	be	added	to	provide	additional	information,	such	as	a	family	history.

Genealogy	records	can	generate	a	lot	of	files.	Many	web	servers	have	a	difficult	time	with	a	large	number	of	files	in	a	single	directory.	The	Narrated
Web	report	attempts	to	keep	the	number	of	files	per	directory	to	a	manageable	level.	To	do	this,	a	hierarchy	of	directories	is	created.	The	generated
file	names	are	not	intuitive,	but	are	unique	for	each	person.	Subsequent	runs	will	generate	identical	file	names,	making	it	easy	to	update	specific
files.
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Generating	Pages...

When	you	select	the	 OK 	button,	the	generation	of	the	web	pages	will	start.	So	first	check	all	options	on
the	each	of	the	Dialog	tabs

Dialog	tabs

The	 Narrated	Web	Site 	report	dialog	has	the	following	tabs	each	are	reviewed	below.

Report	Options
HTML	Options
Display
Page	Generation
Extra	pages
Images	Generation
Download
Advanced	Options
Include
Place	Map	Options
Other	inclusion	(CMS,	web	calendar,	PHP)
Translations
Calendar	Options

Report	Options

Fig.	13.7.3	Narrated	Web	Site	-	Web	Pages	-	Report	Options	-	tab
default	options

	 Store	web	pages	in	.tar.gz	archive 	(Checkbox	unchecked	by	default)	If	you	have	trouble	transferring	the	files	to	an	external
web	host,	you	can	create	a	single	gzip'd	tar	file	to	more	easily	upload	the	data.	The	large	number	of	files	and	directories	in	this	web	output
may	make	it	difficult	to	transfer	the	files	to	an	external	web	host.	Gramps	has	the	capability	of	saving	all	of	your	Narrative	Web	files	in	one
compressed	archive	using	the	gzip	and	tar	formats	(casually	known	as	a	‘tarball’).	This	single	file	can	quickly	be	transferred	to	your	server
and	uncompressed	on	the	website	host.	Unfortunately	not	all	web	servers	support	saving	web	files	in	this	way,	so	contact	your	hosting
provider	for	more	information.
Destination: 	(~/yourhomedirectory/<Family	Tree	Name>+NAVWEB 	default)	The	destination	directory	for	the	web	files.
Web	site	title: 	(My	Family	Tree	default)	The	title	of	the	web	site.	You	can	enter	a	custom	site	title	in	this	option.	Strongly	suggested
you	change	this	from	the	default
Filter: 	(Any	person	matching	this	filter	who	is	not	excluded	due	to	the	privacy	rules,	will	be	included	in	the	output.)	choose	between

Entire	Database	(Default)
Descendants	of	active	person
Descendant	families	of	active	person
Ancestors	of	active	person
People	with	common	ancestor	with	active	person

Filter	Person: 	The	center	person	for	the	report.	(defaults	to	Active	person)
	 Show	the	relationship	between	the	current	person	and	the	active	person	(Checkbox	unchecked	by

default)	-	For	each	person	page.
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Please	note	that	compliance	with	privacy	laws	and	individuals'	privacy	concerns	is	 your
responsibility	as	the	researcher.

The	Gramps	project	cannot	be	held	responsible	for	privacy	law	compliance	or	other	privacy	issues.
Privacy	of	personal	information	is	an	important	issue.

Gramps	provides	tools	and	settings	that	give	some	control	over	the	privacy	of	your	data...	but	these
controls	were	built	to	meet	the	regional	considerations	for	that	tool's	programmer.	You	are	responsible
for	verifying	compliance	before	publication.

Living	People 	How	to	handle	living	people.	You	can	control	the	display	of	sensitive	information	based	on	whether	or	not	an	individual
is	currently	alive.	However,	since	Gramps	is	a	research	tool,	it	is	likely	that	there	are	individuals	with	no	known	date	of	death	in	your
database.	To	deduce	if	an	individual	is	possibly	still	alive	Gramps	employs	an	algorithm	that	compares	death	dates,	birth	dates,
baptism/christening	dates,	death	dates	of	ancestors	and	birth	dates	of	ancestors.	The	algorithm	assumes	that	each	individual	is	possibly	still
alive	unless	the	cross-referenced	dates	make	the	individual’s	possibility	of	being	alive	unlikely.

Exclude	–	(Default)	Excludes	all	information	of	all	individuals	who	are	possibly	still	alive
Include	Last	Name	Only
Include	Full	Name	Only
Include	–	Include	all	information	of	all	individuals	even	if	they	are	possibly	still	alive

Years	from	death	to	consider	living:	(30	default)	This	option	is	inactive	if	the	"Living	People"	option	is	set	to	Include.

Privacy	requirements	can	extend	after	Death.	Laws	vary	regionally

Some	countries	have	laws	that	specify	a	certain	number	of	years	after	death	before	an	individual's
information	can	be	published.	Here	you	can	comply	with	such	laws	by	specifying	the	number	of	years
after	death	to	continue	to	apply	Privacy	redactions.

	 Include	data	marked	private :	Whether	to	include	private	objects.	If	your	intention	is	to	provide	a	complete	record	of	your
research,	checking	this	box	will	include	all	entries	marked	private	along	with	the	rest	of	your	database.	(checkbox	unchecked	by	default)

HTML	Options

Fig.	13.7.4	Narrated	Web	Site	-	Web	Pages	-	HTML	Options	-	tab
default	options

File	extension: 	The	extension	to	be	used	for	the	web	files.
.html	(Default)
.htm
.shtml
.php
.php3
.cgi

Copyright: 	-	When	creating	a	public	a	web	site	it	is	important	to	specify	the	copyright	conditions	under	which	you	are	publishing	your
data.	International	copyright	law	reserves	all	rights	of	your	data	to	your	discretion.	You	own	the	data	and	individuals	must	have	your
permission	if	they	wish	to	reuse	that	data.	In	genealogical	research	sharing	data	with	other	researchers	is	a	common	practice.

Standard	copyright	(default)
Creative	Commons	-	By	attribution-	A	range	of	six	Creative	Commons	licenses,	offering	various	use	restrictions	or	none	at	all.	Learn
more	about	the	Creative	Commons	at	https://creativecommons.org/
Creative	Commons	-	By	attribution,	No	derivations
Creative	Commons	-	By	attribution,	Share-alike
Creative	Commons	-	By	attribution,	Non-Commercial
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Creative	Commons	-	By	attribution,	Non-Commercial,	No	derivations
Creative	Commons	-	By	attribution,	Non-Commercial,	Share-alike
No	copyright	notice

Fig.	13.7.5	"HTML	Options"	tab	-
"StyleSheet"	eight	samples	(shown	top	down
order	of	list.)

StyleSheet: 	Gramps	provides	nine	built	in	style	sheets	for	you	to	choose	from	to	determine	the	appearance	or	your	web	pages.	Choose
between	these	stylesheets:

Basic-Ash	(a	'Basic'	color	scheme)	(	default)
Basic-Blue	(a	'Basic'	color	scheme)
Basic-Cypress	(a	'Basic'	color	scheme)
Basic-Lilac	(a	'Basic'	color	scheme)
Basic-Peach	(a	'Basic'	color	scheme)
Basic-Spruce	(a	'Basic'	color	scheme)
Mainz	-
Nebraska
No	style	sheet	(do	not	overwrite	existing	stylesheets)
Visually	Impaired

Regardless	of	the	style	you	choose,	the	style	sheet	can	be	found	in	css/narrative-screen.css.	You	may	edit	this	file	to	further	customize
the	appearance	of	your	web	pages.	
If	you	make	modifications	to	your	style	sheet	be	aware	that	regenerating	your	pages	with	the	same	output	destination	will	overwrite	your
custom	style	sheet.
The	option	of	not	including	a	stylesheet	(No	style	sheet)	it	for	users	who	have	already	created	a	custom	style	sheet	when	generating	a
previous	Narrated	Web	Site	report.	To	preserve	your	custom	style	sheet	through	subsequent	web	page	updates	select	 No	style	sheet .
If	you	want	your	own	stylesheet,	you	can	copy	one	of	the	existing	stylesheet	in	$HOME/.gramps/css/.	This	directory	doesn't	exist.	You	must
create	it	before	copying	your	future	stylesheet.	Change	its	name.	If	you	ask	for	a	new	report,	this	new	stylesheet	will	be	added	to	the	list	of
pre-existing	stylesheets.

Navigation	Menu	Layout: 	Choose	which	layout	for	the	Navigation	Menus.	(Only	available	for	selected	Stylesheets)
Horizontal	--	Default
Vertical	--	Left	Side
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Fade	--	Webkit	Browsers	Only
Drop-Down	--	Webkit	Browsers	Only

Citation	Referents	Layout: 	Determine	the	default	layout	for	the	Source	Page's	Citation	Referents	section
Normal	Outline	Style	(Default)
Drop-Down	--	Webkit	Browsers	Only

	 Include	ancestor's	tree :	Checking	this	box	will	include	an	ancestor	graph	on	each	individual’s	detail	page	if	they	have	defined
ancestors	in	your	database.	(checkbox	checked	by	default)	(	Note:	Narrated	Website	Ancestry	Tree	Design	Notes	discusses	creating	a	compact
Ancestry	trees	using	the	Buchheim/Walker	algorithm.)

You	can	change	the	number	of	generations	shown	from	the	 Display 	tabs	Graph	generations:	option.
	 Add	previous/next 	(checkbox	unchecked	by	default)	-	adds	links	to	the	navigation	bar.
	 This	is	a	secure	site	(HTTPS) 	(checkbox	unchecked	by	default)
	 Toggle	sections 	(checkbox	unchecked	by	default)	-	Check	if	you	want	to	open/close	a	section

Display

Fig.	13.7.6	Narrated	Web	Site	-	Web	Pages	-	Display	-	tab	default
options

Name	Format: 	Select	the	format	to	display	the	names.	Choose	from	Surname,	Given	Suffix	/	Given	Surname	Suffix	/	Given	/	Main
Surnames,	Given	Patronymic	Suffix	/	SURNAME,	Given	(Common)

	 Do	we	use	multiple	translations? 	(checkbox	unchecked	by	default)	-	Whether	to	display	the	narrative	web	in	multiple
languages.	See	the	 Translation 	tab	to	add	a	new	languages	to	the	default	one	defined	in	the	next	field.
Translation: 	-	The	translation	to	be	used	for	the	report.
Date	format: 	-	The	format	and	language	for	dates,	with	examples.
Gramps	ID: 	-	Option	determines	whether	to	hide	or	show	the	Gramps	ID	of	objects	in	your	web	page	output.

Do	not	include	(default)
Include

Tags: 	-	Whether	to	include	tags
Do	not	include	(default)
Include

	 Sort	all	children	in	birth	order(checkbox	unchecked	by	default)	-	Whether	to	display	children	in	birth	order	or	in	entry
order?

	 Do	we	display	coordinates	in	the	places	list? (checkbox	unchecked	by	default)	-	Whether	to	display	latitude/longitude
in	the	places	list?

	 Sort	places	references	either	by	date	or	by	name(checkbox	unchecked	by	default)	-	Sort	the	places	references	by	date
or	by	name.	Not	set	means	by	date.
Graph	generations 	:This	option	is	inactive	if	the	 Include	ancestor's	tree	option	on	the	HTML	Options	tab	is	not	checked.	The	default
number	of	generations	shown	in	the	ancestor	graphs	is	4	with	options	of	2,	3,	4	or	5.	The	individuals	represented	in	the	ancestor	graphs	are	the
same	individuals	whose	information	is	provided	elsewhere	in	your	web	pages.

	 Include	narrative	notes	just	after	name,	gender (checkbox	checked	by	default)	-	Unchecked	will	show	them	just	before
attributes.

Page	Generation
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Fig.	13.7.7	Narrated	Web	Site	-	Web	Pages	-	Page	Generation	-	tab
default	options

The	Page	Generation	tab	provides	options	for	creation	of	commonly	expected	supplemental	webpages	and	annotations	common	to	all	webpages
throughout	the	generated	website.

The	first	options	are	used	to	control	generation	of	three	supplemental	pages:	Home	(Home	webpage),	Introduction	(FAQ	or	About	Us	webpage)
and	Publisher	Contact	(Contact	Us	webpage).

Each	of	supplemental	pages	may	be	assigned	a	specific	Media	or	Note	item.	By	default,	no	content	(neither	media	nor	text	from	a	Note)	is	assigned
to	these	pages.

Content	for	these	pages	must	originate	as	Media	or	Notes	items	that	have	been	created	before	running	the	report.	Once	the	desired	items	have	been
added	to	your	Tree,	you	will	be	able	to	choose	them	from	a	list	of	Notes	or	Media	Objects.

Planning	for	sustainability

These	special-purpose	items	do	not	need	to	have	References	associated	with	any	other	record	in	the	Tree.
However,	you	might	find	it	helpful	to	add	a	Source	your	generated	Website	as	a	distinct	Source	(marked
as	Private)	to	your	Tree.	
This	private	Source	could	use	the	References	as	a	special-purpose	item	checklist...	with	an	added	Note	to
document	the	options	used	to	generate	the	Narrated	Website.
Add	another	note	documenting	any	idiosyncracies	encountered	when	publishing	the	site.
Such	internal	documentation	makes	reproducing	the	same	appearance	easier	when	generating	website
updates	in	the	future.

Home	page	note: 	Display	an	individual	Note	of	your	choice.
Home	page	image: 	Display	an	individual	Media	Object	of	your	choice.
Introduction	note: 	Display	an	individual	Note	of	your	choice.
Introduction	image: 	Display	an	individual	Media	Object	of	your	choice.
Publisher	contact	note: 	Display	an	individual	Note	of	your	choice.
Publisher	contact	image: 	Display	an	individual	Media	Object	of	your	choice.

Privacy	&	Spam	Exposure	Risk

Please	use	the	Publisher	contact	page	with	caution	if	you	will	be	publishing	your	web	pages	on	a	publicly
accessible	web	server.	Consider	using	a	single-use	(disposable)	eMailbox	or	secure	form	mail	system.

HTML	user	header: 	Display	an	individual	Note	of	your	choice.	This	annotation	text	will	appear	directly	below	the	site	title	on	every	web
page.
HTML	user	footer: 	Display	an	individual	Note	of	your	choice.	This	annotation	text	will	appear	within	the	footer,	above	the	copyright
statement	on	every	web	page.
PHP	user	session: 	A	note	to	use	for	starting	the	php	session.	This	option	will	be	available	only	if	the	.php	file	extension	is	selected.

Extra	Pages
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Fig.	13.7.8	Narrated	Web	Site	-	Web	Pages	-	Extra	Pages	-	tab	default
options

Extra	page	name: 	(blank)	-	Your	extra	page	name	like	it	is	shown	in	the	menubar.
Your	extra	page	path: 	(blank)	-	Your	extra	page	path	without	extension.

find	folder 	button

Images	Generation

Fig.	13.7.9	Narrated	Web	Site	-	Web	Pages	-	Image	Generation	-	tab
default	options

	 Include	images	and	media	objects 	This	option	determines	whether	to	include/exclude	a	gallery	of	media	objects	on	your
website.	(checkbox	checked	by	default)

	 Create	the	images	index 	This	option	allows	you	to	create	the	images	index.	(checkbox	unchecked	by	default)
	 Include	unused	images	and	media	objects 	This	option	determines	whether	to	include/exclude	a	gallery	of	unused	media

objects	on	your	website.	(checkbox	unchecked	by	default)
	 Create	and	only	use	thumbnail-	sized	images	:	This	option	allows	you	to	create	only	thumbnail	images	instead	of	full-

sized	images	on	the	Media	Page.	This	will	allow	you	to	have	a	much	smaller	total	upload	size	to	your	web	hosting	site.	(checkbox	unchecked
by	default)

	 Create	the	thumbnail	index 	:	This	option	allows	you	to	create	the	thumbnail	index	(checkbox	unchecked	by	default)
Max	width	of	initial	image: 	(800	default)	This	allows	you	to	set	the	maximum	width	of	the	image	(in	pixels)	shown	on	the	media
page.
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Considerations	for	choosing	image	width

The	width	options	need	further	expansion	but	discussions	on	the	MailLists	provide	some	added	insight.	

See	also:
(Gramps-devel)	NarrativeWeb	and	large	images	-	Mk	II

Some	idiosyncratic	browser	support	for	images	on	iPad	has	been	reported:
(Gramps-users)	Narrated	website	images	don't	appear	on	iPad	[SOLVED]	

If	the	image	contains	regions,	the	size	will	be	resized	to	max_width.	If	the	width	of	an	image	is	less	than
max_width,	no	resizing	will	occurs.

Fig.	13.7.10	Example	of	image	reference
regions	-	Media	tab	of	HTML	output	for
"Narrative	Web"	Report

Note	that	image	reference	regions	are	also	displayed	in	the	Narrative	Web	HTML	pages	created	with	Gramps.	There	are	no	special	options
necessary	for	this	feature,	other	than	the	existence	of	reference	regions	for	1	or	more	images.	Narrative	Web	displays	reference	regions	for	people
and	place	objects	only.	

Download

Fig.	13.7.11	Narrated	Web	Site	-	Web	Pages	-	Download	-	tab	default
options

	 Include	download	page :	Whether	to	include	a	database	download	option.	(checkbox	unchecked	by	default)
How	many	downloads: 	(2	default)	The	number	of	download	files	to	include	in	the	download	page
Download	Filename	#1: 	Select	the	file	to	be	used	for	downloading	of	database.
Description	for	download: 	(Family	Tree	#1	default)	Give	a	description	for	this	file.
Download	Filename	#2: 	Select	the	file	to	be	used	for	downloading	of	database.
Description	for	download: (Family	Tree	#2	default)	Give	a	description	for	this	file.
Download	Filename	#3: 	Select	the	file	to	be	used	for	downloading	of	database.
Description	for	download: (Family	Tree	#3	default)	Give	a	description	for	this	file.
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Advanced	Options

Fig.	13.7.12	Narrated	Web	Site	-	Web	Pages	-	Advanced	Options	-	tab
default	options

These	settings	address	the	amount	of	information	displayed	on	the	Surname	detail	and	Individual	index	web	pages.

Character	set	encoding: 	The	encoding	to	be	used	for	the	web	files.
Unicode	UTF-8	(recommended)	(Default)
ISO-8859-1	-	ISO/IEC	character	set	standard:	Part	1	(Latin	1:	Western	European)
ISO-8859-2
ISO-8859-3
ISO-8859-4
ISO-8859-5
ISO-8859-6
ISO-8859-7
ISO-8859-8
ISO-8859-9
ISO-8859-10
ISO-8859-13
ISO-8859-14
ISO-8859-15
koi8_r	-	Kod	Obmena	Informatsiey,	8	bit	("Code	for	Information	Exchange	-	8	bit")

	 Include	link	to	active	person	on	every	page :	(If	they	have	a	webpage)	(checkbox	unchecked	by	default)
	 Include	a	column	for	birth	dates	on	the	index	pages(checkbox	checked	by	default)
	 Include	a	column	for	death	dates	on	the	index	pages(checkbox	unchecked	by	default)
	 Include	a	column	for	partners	on	the	index	pages(checkbox	unchecked	by	default)
	 Include	a	column	for	parents	on	the	index	pages(checkbox	unchecked	by	default)
	 Include	half	and/	or	step-siblings	on	the	individual	pages(checkbox	unchecked	by	default)

Include

Fig.	13.7.13	Narrated	Web	Site	-	Web	Pages	-	Include	-	tab	default
options
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	 Include	family	pages (checkbox	unchecked	by	default)
	 Include	event	pages (checkbox	unchecked	by	default)
	 Include	places	pages (checkbox	unchecked	by	default)
	 Include	unused	place	pages (checkbox	unchecked	by	default)
	 Include	sources	pages (checkbox	unchecked	by	default)
	 Include	repository	pages (checkbox	unchecked	by	default)
	 Include	GENDEX	file	(/gendex.txt) .	This	option	creates	a	GENDEX	file	placed	at	the	top	of	the	website.	You	can	see	sites

which	support	this	format	and	read	more	about	it	at	the	GENDEX	Wikipedia	article.(checkbox	unchecked	by	default)
	 Include	address	book	pages (checkbox	unchecked	by	default)
	 Include	the	statistics	page (checkbox	unchecked	by	default)

Place	Map	Options

Fig.	13.7.14	Narrated	Web	Site	-	Web	Pages	-	Place	Map	Options	-
tab	default	options

Map	Service: 	Choose	your	choice	of	map	service	for	creating	the	Place	Map	Pages
OpenStreetMap	(default)
Stamen	Map
Google		:	For	this	option	to	work	requires	a	 Google	maps	API	key 	to	be	entered.	To	apply	for	one	goto	the	Google	maps	platform
(	https://cloud.google.com/maps-platform/	)	and	select	"Get	Started"	(top	right	corner)	and	follow	the	instructions	(may	involve	a	credit
card)	and	then	select	the	"Credentials"	option	on	the	"API	Manager"	menu	.	Then	click	on	the	"Create	Credentials"	button	on	the
"Credentials"	window.	Click	on	"API	Key	"on	the	next	pop-up	window.	Copy	the	generated	API	key	to	your	clipboard	and	paste	in	to
Gramps	"Google	maps	API	key:"	field.	I	strongly	suggest	that	after	generating	and	placing	your	report	online	that	you	go	back	to	the
google	maps	platform	and	Click	the	"Restrict	key"	button	on	the	API	key	created	window	and	add	your	domain	(this	will	stop	other
website	hijacking	your	api	key	and	making	you	pay!	These	new	Google	Maps	API	changes	came	into	affect	from	the	11th	of	June
2018.	see	the	pricing	table	https://cloud.google.com/maps-platform/pricing/sheet/	"You	also	get	a	recurring	$200	credit	on	your	billing
account	each	month	to	offset	your	usage	costs,	and	you	can	set	usage	limits	to	protect	against	unexpected	cost	increases"

	 Include	Place	map	on	Place	Pages :	Whether	to	include	a	place	map	on	the	Place	Pages,	where	Latitude/	Longitude	are
available.	(checkbox	unchecked	by	default)

	 Include	Family	Map	Pages	with	all	places	shown	on	the	map:	Whether	or	not	to	add	an	individual	page	map	showing
all	the	places	on	this	page.	This	will	allow	you	to	see	how	your	family	traveled	around	the	country.	(checkbox	unchecked	by	default)
Google/	FamilyMap	Option: 	Select	which	option	that	you	would	like	to	have	for	the	Google	Maps	Family	map	pages...

Family	Links	(default)
Drop
Markers

Google	maps	API	key: 	The	API	key	used	for	the	Google	maps.	This	key	is	mandatory	and	must	be	valid
How	to	get	the	API	key:	https://developers.google.com/maps/documentation/javascript/get-api-key

To	get	a	"Google	maps	API	key:"

visit	https://cloud.google.com/maps-platform/pricing/sheet/	as	a	cost	may	be	involved	as	well	as	the	use
of	a	credit	card

Stamen	Options:
Stamen	maps	API	key:
How	to	get	the	API	key:
openlayers	version	to	use:
Coordinates	format:

Other	inclusion	(CMS,	web	calendar,	PHP)
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Fig.	13.7.15	Narrated	Web	Site	-	Web	Pages	-	Other	inclusion	(CMS,
web	calendar,	PHP)	-	tab	default	options

	 Do	we	include	these	pages	in	a	CMS	web?	(Checkbox	unchecked	by	default)
URI: 	/NAVWEB	(default)	-	Where	do	you	place	your	website	?

	 Include	the	news	and	updates	page? 	(Checkbox	checked	by	default)	Whether	to	include	a	page	with	the	last	updates
Max	days	for	updates: 	1	(default)	-	You	want	to	see	the	last	updates	on	how	many	days?
Max	number	of	updates	per	object	to	show: 	1	(default)	-	How	many	updates	do	you	want	to	see	max?

See	also:

Howto:_Make_a_genealogy_website_with_Gramps#Integration_of_NarrativeWeb_in_a_CMS_or_MVS
Feature	request	5530	Integration	of	the	Narrative	Web	Site	into	a	CMS	or	MVC

Translations

Fig.	13.7.16	Narrated	Web	Site	-	Web	Pages	-	Translations	-	tab
default	options

On	the	Translation	tab	you	can	choose	which	languages	to	display	the	the	report	in.

To	use	this	section	enable	the	 [x]	Do	we	use	multiple	translations? 	language	option	on	the	 Display 	tab	and	you	can	also	choose
the	 Translation: 	language	to	display	the	narrative	web	report	in	if	different	from	the	default.

Second	language: 	Default	-	Default	language	Gramps	is	using.
Site	name	for	your	second	language:	This	site	title	-	Change	it	to	suit	the	language	for	this	translation	or	use	the	default	site
title	for	the	default	language	Gramps	is	using.
Third	language: 	Default	-	Default	language	Gramps	is	using.
Site	name	for	your	third	language:	This	site	title	-	Change	it	to	suit	the	language	for	this	translation	or	use	the	default	site
title	for	the	default	language	Gramps	is	using
Forth	language: 	Default	-	Default	language	Gramps	is	using.
Site	name	for	your	fourth	language:	This	site	title	-	Change	it	to	suit	the	language	for	this	translation	or	use	the	default	site
title	for	the	default	language	Gramps	is	using
Fifth	language: 	Default	-	Default	language	Gramps	is	using.
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

Site	name	for	your	fifth	language:	This	site	title	-	Change	it	to	suit	the	language	for	this	translation	or	use	the	default	site
title	for	the	default	language	Gramps	is	using
Sixth	language: 	Default	-	Default	language	Gramps	is	using.
Site	name	for	your	sixth	language:	This	site	title	-	Change	it	to	suit	the	language	for	this	translation	or	use	the	default	site
title	for	the	default	language	Gramps	is	using

See	also:

Multiple	languages	​​for	the	narrative	web	and	optional	other	additions	#1051	added	Nov	9,	2020

Calendar	Options

Fig.	13.7.17	Narrated	Web	Site	-	Web	Pages	-	Calendar	Options	-	tab
default	options

	 Do	we	include	the	web	calendar? 	(Checkbox	unchecked	by	default)
First	day	of	week: 	Sunday
Birthday	surname: 	Wives	use	their	own	surname

	 Create	on	day	event	pages	for	Year	At	A	Glance	calendar	(Checkbox	unchecked	by	default)
	 Include	birthdays 	(Checkbox	checked	by	default)
	 Include	anniversaries 	(Checkbox	checked	by	default)
	 Include	death	dates 	(Checkbox	unchecked	by	default)
	 Include	only	living	people 	(Checkbox	checked	by	default)

Show	data	only	after	year: 	1914

Multiple	languages	​​for	the	narrative	web	and	optional	other	additions	#1051	added	Nov	9,	2020	"The	web	calendar	doesn't	work	when
multiple	languages	is	in	use	and	we	link	people	to	the	narrative	web.	after	multiple	tries	without	succes,	I	integrate	webcal	in	the	narrative
web.	For	each	language,	I	use	the	related	holidays	calendar.	(#07151)"

Example	Web	Site	output

The	following	sections	show	the	default	appearance	of	web	pages	the	Narrative	Website	web	page	report.

Home

(optional	page)	

Introduction

(optional	page)	

Individuals
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Individuals	(index)	(default	page)	Filename:	individuals.html

Fig.	13.7.18	Narrated	Web	Site	-	Web	Pages	-	Individuals	(index)
page	-	default	HTML	output	-	example

Surnames

Surnames	(index)	(default	page)	Filename:	index.html

Surnames	count

Surnames	(count	index	-	sorted	by	"Number	of	People"	column)	(default	page)	Filename:	surnames_count.html	

Families

(optional	page)	

Events

(optional	page)	

Places

Places	(index)	(default	page)	Filename:	places.html	

Sources

Sources	(index)	(default	page)	Filename:	sources.html	

Repositories

(optional	page)	

Media

(default	page)	

Thumbnails

(default	page)	

Download

(optional	page)	

Address	Book

(optional	page)	

Contact

(optional	page)	

Updates

Updates	(default	page)	Filename:	updates.html	

HTML	Code	type	Notes
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In	this	subsection,	the	word	 tag	does	not	refer	to	Gramps	marker	tags

but	instead	refer	to	HTML	formatting	tags!

Gramps	Notes	set	to	the	HTML	Code	type	will	be	inserted	under	the	object	to	which	they	are	attached.	This	allows	special	HTML	chunks	to	be
included	in	the	report.

The	HTML	chunks	must	be	well-formed,	with	all	tags	properly	closed,	to	avoid	conflicts	with	the	rest	of	the	webpage	generated	by	the	report.	Only
insert	tags	in	a	HTML	Code-type	Note	that	would	normally	be	contained	within	the	body	of	a	HTML	document.

The	following	tags	will	always	be	ignored:	html,	meta,	doctype,	head,	meta,	title,	link,	script,	body

All	other	tags	will	be	available	:	i,	a,	p,	ol,	ul,	div,	h1-h7,	button,	svg,	table,	tr,	td,	…	

Prerequisites	for	Narrated	Web	Site

For	Gramps	6.0.x,	you	need	to	install	Pyicu	and	the	associated	packages.

See	also:

13407	Navweb	will	not	load	(	Name	localAlphabeticindex	is	not	defined	)	[If	optional	prerequiste	PyICU	not	installed	]

Possible	problems

If	the	report	shows	"Failed	Loading	Plugin"	name	'localAlphabeticIndex'	is	not	defined	:	do	you	have	the	prerequisite	pyicu
installed	?

Run	gramps	-v	from	the	command	line	to	see	if	any	additional	information	that	may	help	you	is	shown.
Other	errors:	Report	a	bug

Web	Calendar

The	Narrated	Web	Site	Report	does	not	hyperlink	back	into	the	Web	Calendar	Report.

Fig.	13.7.19	Web	Calendar	Report	-	Web	Pages	-	default	Calendar	for
December	2018	-	HTML	output

The	 Web	Calendar 	shows	events	for	the	selected	individuals	on	a	set	of	monthly	calendars.	You	can	run	this	report	via	the	menu	Reports	>
Web	Pages	>	Web	Calendar....

There	are	options	to	filter	the	individuals,	to	choose	which	years	to	include	(by	default,	only	the	current	year	is	included);	whether	to	include	only
living	people	and	whether	to	include	birthdays	or	anniversaries	or	both;	notes	can	be	included	on	monthly	pages	and	abbreviated	pages	can	be
included.

The	report	is	designed	to	work	with	the	Narrative	Web	Site	Report.	If	selected	there	is	a	'Home'	link	on	each	page	to	the	home	page	of	the	Narrative
Web	Site	Report.	There	is	also	an	option	to	include	links	from	the	individuals	on	the	calendar	to	the	same	individual	on	the	Narrated	Web	Site.

Working	with	the	Narrated	Web	Site	Report	requires	that	the	two	reports	have	been	constructed	in	a	compatible	way	by	the	user.	There	is	no
automated	check	that	the	two	are	compatible.	If	the	pages	are	not	compatible,	then	the	user	will	likely	get	a	'Page	not	found'	error.

Compatibility	depends	on:

1.	 Including	the	same	individuals	in	the	two	reports,
2.	 Storing	the	pages	in	compatible	directories.

In	order	to	include	the	same	individuals	in	the	two	reports,	the	same	filters	should	be	used,	and	similar	options	with	regard	to	including	living
individuals	(the	Web	Calendar	does	not	have	an	option	to	remove	'private'	information).
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By	default,	the	Narrated	Web	Site	Report	is	stored	in	the	directory	"~/<Family	Tree	Name>+NAVWEB",	and	by	default	the	Web	Calendar	is	stored	in
the	directory	"~/<Family	Tree	Name>+WEBCAL".	If	these	defaults	are	retained,	then	the	various	links	should	work	properly.	If	the	directories	have
been	changed,	then	the	'Home	link'	under	the	'Content	Options'	and	the	'Link	prefix'	under	the	'Advanced	Options'	will	need	to	be	changed
accordingly.

If	the	Web	Calendar	is	to	be	used	without	an	associated	Narrative	Web	Site,	then	uncheck	the	 Link	to	Narrated	Web	Report 	option	on	the
Advanced	Options 	tab	this	will	ensure	that	no	'Home'	link	is	generated.

Dialog	tabs

The	Web	Calendar	report	dialog	window	 Web	Calendar 	has	the	following	tabs	each	are	reviewed	below.

Report	Options
Report	Options	(2)
Content	Options
Advanced	Options
Jan	-	Jun	Notes
Jul	-	Dec	Notes

Report	Options

Fig.	13.7.20	Web	Calendar	-	Web	Pages	-	Report	Options	-	tab	default
options

Destination: 	~/yourhomedirectory/<Family	Tree	Name>+WEBCAL 	The	destination	directory	for	the	web	files.
find	folder 	button

Calendar	Title: 	(My	Family	Calendar	default)	The	title	of	the	calendar.
Filter: 	choose	between

Entire	Database	(Default)
Descendants	of	active	person
Descendant	families	of	active	person
Ancestors	of	active	person
People	with	common	ancestor	with	active	person

Filter	Person: 	The	center	person	for	the	filter.	(Default:	Active	person)
File	extension: 	The	extension	to	be	used	for	the	web	files.

.html	(Default)

.htm

.shtml

.php

.php3

.cgi
Copyright: 	The	copyright	to	be	used	for	the	web	files.

Standard	copyright	(Default)
Creative	Commons	-	By	attribution	-	A	range	of	six	Creative	Commons	licenses,	offering	various	use	restrictions	or	none	at	all.	Learn
more	about	the	Creative	Commons	at	https://creativecommons.org/
Creative	Commons	-	By	attribution,	No	derivations
Creative	Commons	-	By	attribution,	Share-alike
Creative	Commons	-	By	attribution,	Non-Commercial
Creative	Commons	-	By	attribution,	Non-Commercial,	No	derivations
Creative	Commons	-	By	attribution,	Non-Commercial,	Share-alike
No	copyright	notice

StyleSheet: 	The	stylesheet	to	be	used	for	the	web	pages.
Basic-Ash	(a	'Basic'	color	scheme)	(	default)
Basic-Blue	(a	'Basic'	color	scheme)
Basic-Cypress	(a	'Basic'	color	scheme)
Basic-Lilac	(a	'Basic'	color	scheme)
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Basic-Peach	(a	'Basic'	color	scheme)
Basic-Spruce	(a	'Basic'	color	scheme)
Mainz	-
Nebraska
No	style	sheet	(do	not	overwrite	existing	stylesheets)
Visually	Impaired

Report	Options	(2)

Fig.	13.7.21	Web	Calendar	-	Web	Pages	-	Report	Options	(2)	-	tab
default	options

Name	Format: 	-	Select	the	format	to	display	the	names.	This	choice	in	normally	taken	from	the	default	setting	in	Edit	>	Display	Options
tab	for	 Name	format: .	Or	to	override	that	setting	for	the	report	choose	from:

Surname,	Given	Suffix	(Default	in	a	new	Family	Tree	)
Given	Surname	Suffix
Given
Main	Surnames,	Given	Patronymic	Suffix
SURNAME,	Given	(Common)

	 Include	data	marked	private 	(checkbox	unchecked	by	default)
	 Include	only	living	people 	(checkbox	checked	by	default)	-	eliminates	ancestors	for	webcalendars	being	used	as	reminder

tools	instead	of	historical	tools.
Translation: 	The	translation	to	be	used	for	the	report.	Language	selector	showing	all	languages	supported	by	Gramps.	Defaults	to	the
language	you	are	using	Gramps	in.
Date	format: 	The	format	and	language	for	dates,	with	examples

Default	-	Choose	this	option	to	use	the	default	set	in	Edit	>	Display	Options	tab	for	 Date	format	*: 	option.
YYYY-MM-DD(ISO)(2018-03-14)	(default	for	report)
Numerical(14/3/2018)
Month	Day,	Year(March	14,	2018)
MON	DAY,	YEAR(Mar	14,	2018)
Day	Month	Year(14	March	2018)
DAY	MON	YEAR(14	Mar	2018)

Content	Options

Fig.	13.7.22	Web	Calendar	-	Web	Pages	-	Content	Options	-	tab
default	options
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	 Create	multiple	year	calendars 	(checkbox	unchecked	by	default)	Whether	to	create	Multiple	year	calendars	or	not.
Start	Year	for	the	Calendar(s): 	(Defaults	to	current	year)
End	Year	for	the	Calendars(s):	(Defaults	to	current	year)

Country	for	holidays: 	Select	the	country	to	see	associated	holidays.	(Defaults	to	blank)
First	day	of	week: 	Select	the	first	day	of	the	week	for	the	calendar.	(Default:	Sunday)
Birthday	surname: 	Select	married	women's	displayed	surname.

Wives	use	their	own	surname	(Default)
Wives	use	husband's	surname	(from	first	family	listed)
Wives	use	husband's	surname	(from	last	family	listed)

Advanced	Options

Fig.	13.7.23	Web	Calendar	-	Web	Pages	-	Advanced	Options	-	tab
default	options

Character	set	encoding: 	The	encoding	to	be	used	for	the	web	files
Unicode	UTF-8	(recommended)	(Default)
ISO-8859-1
ISO-8859-2
ISO-8859-3
ISO-8859-4
ISO-8859-5
ISO-8859-6
ISO-8859-7
ISO-8859-8
ISO-8859-9
ISO-8859-10
ISO-8859-13
ISO-8859-14
ISO-8859-15
koi8_r

	 Create	one	day	event	pages	for	Year	At	A	Glance	Calendar	(checkbox	unchecked	by	default)
	 Include	birthdays 	(checkbox	checked	by	default)
	 Include	anniversaries 	(checkbox	checked	by	default)
	 Include	death	dates 	(checkbox	unchecked	by	default)
	 Link	to	Narrated	Web	Report 	(checkbox	unchecked	by	default)

Show	data	only	after	year: 	(1914	default)	Show	data	only	after	this	year.	Default	is	current	year	-	'maximum	age	probably
alive'	which	is	defined	in	the	dates	preferences	tabs.
Link	prefix: 	../../Family	Tree	1_NAVWEB/	A	Prefix	on	the	links	to	take	you	to	Narrated	Web	Report.

Jan	-	Jun	Notes
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Fig.	13.7.24	Web	Calendar	-	Web	Pages	-	Jan-Jun	Notes	-	tab	default
options

Use	the	 Select	an	existing	note 	buttons	to	choose	the	note	from	the	 Select	Note 	selector	for	each	of	the	months	if	needed:

January	Note:
February	Note:
March	Note:
April	Note:
May	Note:
June	Note:

Jul	-	Dec	Notes

Fig.	13.7.25	Web	Calendar	-	Web	Pages	-	Jul-Dec	Notes	-	tab	default
options

Use	the	 Select	an	existing	note 	buttons	to	choose	the	note	from	the	 Select	Note 	selector	for	each	of	the	months	if	needed:

July	Note:
August	Note:
September	Note:
October	Note:
November	Note:
December	Note:

Example	Web	Site	output
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Fig.	13.7.26	Web	Calendar	Report	-	Web	Pages	-	default	Calendar	for
December	2018	-	HTML	output

See	Also

Web	Solutions	for	Gramps

Back	to	Index	of	Reports.

Previous Index Next
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Reports	-	part	8

Previous Index Next

Back	to	Index	of	Reports.

Fig.	13.8.1	Quick	View	context	menu	on	Edit	Person

This	section	describes	the	Quick	Views	as	part	of	the	different	reports	available	in	Gramps.

Quick	Views

Fig.	13.8.2	Quick	View	Report	-	People	view	-	Same	Surname	-
example	popup	window,	showing	right-click	context	menu

Quick	Views	are	report	windows	available	via	the	context	menu	of	the	most	of	the	category	views	and	some	of	the	edit	dialogs.

These	quick	views	are	generate	reports	based	on	the	first	selected	record	and	have	no	options	to	confuse	the	process.	However,	like	the	main	views,
the	user	defined	formats	selected	in	the	Display	tab	of	the	Preferences	will	carry	through	in	these	reports.

Quick	View	reports	are	static.	The	contents	of	these	floating	windows	will	not	update	as	the	object	focus	changes	nor	when	the	record	data	is
edited.	If	you	want	a	more	dynamic	version	of	the	Report,	a	QuickView	Gramplet	can	be	added	to	the	sidebar	or	bottombar.	The	report	will	be
regenerated	as	the	object	focus	shifts.	The	Configure	toolbar	tool	(or	View	menu	"Configure...	option)	will	have	a	Quick	View	tab	to	select	the
Object	type	and	report	being	displayed.

Clipboarding	Quick	View	data

Use	the	context	menu	(Right-click)	option	for	 Select	All 	to	highlight	QuickView	content	that	is	not	contained	in	a	formatted	table.	Then	use
the	context	menu	again	to	 Copy 	the	selected	content	to	the	OS	Clipboard.

For	Quick	Views	that	have	lists	of	records	in	tabular	format,	copy	QuickView	Table	row	data	to	the	OS	Clipboard	by	using	the	Context	menu
(Right-click)	option	within	a	table	row	to	choose	the	 Copy	all 	menu	option.	If	the	QuickView	has	multiple	tables,	they	must	be	copied
individually.

Accessing	Quick	Views
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Fig.	13.8.3	Quick	View	context	menu	on	the	People	Category	-
Person	(List)	View

The	Quick	Views	can	be	difficult	to	locate.	The	directly	accessible	interface	is	via	context	menus	rather	than	by	icons,	menu	items	or	being
explicitly	listed	in	dialogs.	And	the	indirect	access	is	even	more	transparent:	it	is	from	hotlinks	or	context	menus	in	gramplets	or	dialogs.

The	following	builtin	Quick	View	reports	are	available	via	context	menus	per	category:

	Dashboard	view	-	Not	available
Note	that	you	can	use	the	Quick	View	Gramplet

	People	view	and	 Edit	Person 	dialog
All	Events	:	Display	a	person's	events,	both	personal	and	family
Father	lineage	:	Display	father	lineage
Mother	lineage	:	Display	mother	lineage
Person	References	:	Display	references	for	an	<object	type>
Relation	to	Home	Person	:	All	person	related	to	Home	Person
Same	Given	Names	:	Display	people	with	the	same	given	name	as	a	person
Same	Surnames	:	Display	people	with	the	same	surname	as	a	person
Siblings	:	Display	a	person's	siblings

	Relationships	view	-	Not	available

	Families	view	and	 Edit	Family 	dialog
All	Family	Events	:	Display	the	family	and	family	members	events
Family	References:	Display	references	for	an	<object	type>

	Charts	view	-	Not	available

	Events	view
Event	References	:	Display	references	for	an	<object	type>
On	This	Day	:	Display	events	on	a	particular	day

	Places	view
Place	References	:	Display	references	for	an	<object	type>

	Geography	view	-	Not	available

	Sources	view
Source	References	:	Display	references	for	an	<object	type>

	Citations	view
Citation	References	:	Display	references	for	an	<object	type>

	Repositories	view
Repository	References	:	Display	references	for	an	<object	type>

	Media	view
Media	References	:	Display	references	for	an	<object	type>

	Notes	view
Link	References		:	Display	link	references	within	a	note
Note	References	:	Display	references	for	an	<object	type>

The	following	built-in	"Miscellaneous"	QuickView	reports	are	available	indirectly:	via	context	menus	in	gramplets	and	dialogs:

Age	on	Date	:	Display	people	probably	alive	and	their	ages	on	a	particular	date	of	an	event
Accessed	from	the	Calendar	gramplet.	Double-click	on	a	Calendar	day	opens	the	On	This	Day	Quick	View

Attribute	match	:	Display	people	with	an	Attribute	matching	an	identifier
Accessed	from	the	Attributes	gramplet

Filter	by	[custom	filter]	name	:
All
All	people
All	families
All	events
All	places
All	sources
All	repositories
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All	media
All	notes
Inverse	Person
Inverse	Family
Inverse	Event
Inverse	Place
Inverse	Source
Inverse	Repository
Inverse	Media
Inverse	Note
males
females
people	with	other	gender
people	with	unknown	gender
people	with	missing	birth	dates
people	with	media
media	by	size
incomplete	names
disconnected	people
unique	surnames
list	of	people

Accessed	from	the	Pedigree	gramplet	and	Age	Stats	gramplet

Built-in	QuickViews

All	Events

Example	"All	Events"	quick	view	report	from	the	People	view:

Sorted	events	of	Big	Louie	(Big	Louie)	Garner	von	Zieliński	Sr

Event	Type				 Event	Date		
	

Event	Place				

Birth	[E0001656] Jun	21,	1855 Great	Falls,	MT,	USA
Marriage	[E0002815] Apr	1,	1875 Paragould,	Greene,	AR,	USA

Death	[E0001657] Jun	28,	1911 Twin	Falls,	Twin	Falls,	ID,
USA

Burial	[E0001658] Jul	1,	1911 Twin	Falls,	Twin	Falls,	ID,
USA

All	Family	Events

Example	"All	Family	Events"	quick	view	report	from	the	Families	view:

Sorted	events	of	family
	Big	Louie	(Big	Louie)	Garner	von	Zieliński	Sr	-	Luella	Martel

Family	Members				 Event	Type		
	

Event	Date		
	

Event	Place				

Luella	Martel	[I0000045] Birth Jan	23,	1852 Eureka,	Humboldt,	CA,	USA

Big	Louie	(Big	Louie)	Garner	von	Zieliński	Sr	[I0000044] Birth Jun	21,	1855 Great	Falls,	MT,	USA,
2398756

Family Marriage Apr	1,	1875 Paragould,	Greene,	AR,	USA
Big	Louie	(Big	Louie)	Garner	von	Zieliński	Sr	[I0000044]
	 Death Jun	28,	1911 Twin	Falls,	Twin	Falls,	ID,	USA

Big	Louie	(Big	Louie)	Garner	von	Zieliński	Sr	[I0000044] Burial Jul	1,	1911 Twin	Falls,	Twin	Falls,	ID,	USA
Luella	Martel	[I0000045] Death Apr	28,	1921 Myrtle	Beach,	SC,	USA
Luella	Martel	[I0000045] Burial Apr	30,	1921 Myrtle	Beach,	SC,	USA

Personal	events	of	the	children

Family	Members				 Event	Type		
	

Event	Date		
	

Event	Place				

Jesse	Garner	[I0000623] Birth Jun	18,	1876 Paragould,	Greene,	AR
Raymond	Garner	[I0000624] Birth Sep	16,	1878 Paragould,	Greene,	AR
Jennie	Garner	[I0000625] Birth Sep	11,	1880 Paragould,	Greene,	AR
Walter	Garner	[I0000626] Birth Feb	17,	1882 Paragould,	Greene,	AR
Elizabeth	Garner	[I0000629] Birth 1883
Daniel	Garner	[I0000627] Birth Sep	30,	1883 Hood	River,	OR,	USA
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Bertha	Garner	[I0000628] Birth Mar	13,	1888 Hagerstown,	MD,	USA
Eugene	Garner	[I0000046] Birth Dec	1,	1895 Portsmouth,	OH
Raymond	Garner	[I0000624]
	 Birth Jul	12,	1911

Bertha	Garner	[I0000628] Burial Apr	1918 Sterling,	Whiteside,	IL,	USA
Jesse	Garner	[I0000623] Burial 1929 Sterling,	Whiteside,	IL,	USA
Daniel	Garner	[I0000627] Burial Mar	4,	1936 Sterling,	Whiteside,	IL,	USA
Walter	Garner	[I0000626] Burial Oct	1946 Sterling,	Whiteside,	IL,	USA
Jennie	Garner	[I0000625] Burial Jun	1964 Sterling,	Whiteside,	IL,	USA
Eugene	Garner	[I0000046] Burial Mar	3,	1984 Twin	Falls,	Twin	Falls,	ID,	USA

Bertha	Garner	[I0000628] Death Apr	5,	1918 Columbus,	Bartholomew,	IN,
USA

Raymond	Garner	[I0000624] Death May	2,	1921 Astoria,	OR,	USA
Jesse	Garner	[I0000623] Death Jan	21,	1929 Cedar	City,	UT,	USA
Daniel	Garner	[I0000627] Death Mar	2,	1936 Gary,	Lake,	IN,	USA
Walter	Garner	[I0000626] Death Oct	23,	1946 Battle	Creek,	MI,	USA

Jennie	Garner	[I0000625] Death Jun	20,	1964 Columbus,	Bartholomew,	IN,
USA

Eugene	Garner	[I0000046] Death Mar	1,	1984 Twin	Falls,	Twin	Falls,	ID,	USA

On	This	Day

Fig.	13.8.4	On	This	Day	QuickView

Right-click	on	a	selected	record	in	the	Event	view	to	select	from	the	context	menu	or,	Double-click	a	day	in	the	Calendar	Gramplet	to	run	the	 On
This	Day 	Quick	View.	The	Quick	View	window	shows	the	Events	of	the	selected	day:	Events	on	this	exact	date	and	Other	events	on	this
Month/day	in	history	as	well	as	Other	events	in	that	year.

The	information	is	presented	in	a	table	showing:

Date
Type
Place
Reference

The	text	in	the	QuickView	is	editable.	You	can	also	drag	a	reference	to	the	Clipboard.	

Father	lineage

Example	"Father	lineage"	quick	view	report	from	the	People	view:

Father	lineage	for	Big	Louie	(Big	Louie)	Garner	von	Zieliński	Sr

This	report	shows	the	father	lineage,	also	called	the	patrilineal	lineage	or	Y-line.	People	in	this	lineage	all	share	the	same	Y-chromosomes.

Name	Father				 Birth	Date				 Death	Date		
	

Remarks				

Big	Louie	(Big	Louie)	Garner	von	Zieliński	Sr
[I0000044] Jun	21,	1855 Jun	28,	1911

Robert	Garner	[I0000106] Apr	24,	1826/7
(Julian) Feb	3,	1916 No	birth	relation	with

child
Joseph	Garner	[I0000104] 1792
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Direct	line	male	descendants

Big	Louie	(Big	Louie)	Garner	von	Zieliński	Sr	(Jun	21,	1855	-	Jun	28,
1911)
		|-Eugene	Garner	(Dec	1,	1895	-	Mar	1,	1984)	
		|		|-Howard	Garner	(Jul	9,	1928	-	)	
		|		|		|-Barry	Garner	(Dec	14,	1948	-	)	
		|		|		|		|-Andrew	Garner	(Apr	11,	1999	-	)	
		|		|		|-Gerard	Garner	(Jul	31,	1955	-	)	
		|		|		|		|-Stephen	Garner	(Oct	5,	1983	-	)	
		|		|		|		|-Daniel	Garner	(Feb	11,	1985	-	)	
		|		|		|-David	Garner	(Dec	21,	1956	-	)	
		|		|		|-Thomas	Garner	(Dec	10,	1965	-	)	
		|		|-Eugene	Garner	(	-	)	
		|		|		|-Francis	Garner	(Jan	3,	1945	-	)	
		|		|		|-Richard	Garner	(Feb	28,	1947	-	)	
		|		|		|		|-Jason	Garner	(Oct	20,	1975	-	)	
		|		|		|-Michael	Garner	(Jun	12,	1948	-	)	
		|		|		|		|-Michael	Garner	(Jun	1,	1975	-	)	
		|		|		|-Peter	Garner	(Aug	5,	1954	-	)	
		|		|		|-Mark	Garner	(Oct	16,	1962	-	)	
		|		|		|-John	Garner	(Aug	15,	1961	-	)	
		|		|-John	Garner	(Oct	29,	1925	-	)	
		|-Jesse	Garner	(Jun	18,	1876	-	Jan	21,	1929)	
		|		|-Victor	Garner	(	-	)	
		|-Raymond	Garner	(Sep	16,	1878	-	May	2,	1921)	
		|-Walter	Garner	(Feb	17,	1882	-	Oct	23,	1946)	
		|-Daniel	Garner	(Sep	30,	1883	-	Mar	2,	1936)

Mother	lineage

Similar	to	Father	lineage	quick	view	report	from	the	People	view	as	described	above.

Siblings

Fig.	13.8.5	Quick	View	Report	for	Siblings

Siblings	of	current	person	with	Name,	Gender,	Birth	Date	and	relationship	type	(relative	to	the	current	person).	

Relation	to	Home	Person
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Fig.	13.8.6	Relationship	to	Home	Person	QuickView

Example	"Relation	to	Home	Person"	quick	view	report	from	the	People	view:	

Same	Given	Names

Same	Given	Names	quick	view	report	from	the	People	view	will	show	a	dialog	with	the	information	in	the	following	format:

								People	with	the	given	name	<Given	Name>

								There	are	<count>	people	with	a	matching	name,	or	alternate	name.

Person				 Birth	Date				 Name	type		
	

Webb,	Lewis	I.	[I0193] March	31,	1903 Birth	Name
Warner,	Lewis	[I1253] Birth	Name
Garner	von	Zieliński,	Lewis	Anderson	Sr	[I0044]
	 June	21,	1855 Birth	Name

Garner,	Lewis	[I1105] November	18,
1823 Birth	Name Jun	21,

1855

The	'Copy	All'	context	menu	will	include	the	table	data	without	headers	and	2	extra	columns	for	sorting	data:	
original	row	number	,	Name	(in	the	Preferences	format)	[<Gramps	ID>],	birth	date	(in	the	Preferences	format),	Name	type,	Julian	day	number
(continuous	count	of	days	since	January	1,	4713	BCE	in	the	proleptic	Julian	calendar)

1,	Webb,	Lewis	I.	[I0193],	March	31,	1903,	Birth	Name,	2416205
0,	Warner,	Lewis	[I1253],	,	Birth	Name,	0
2,	Garner	von	Zieliński,	Lewis	Anderson	Sr	[I0044],	June	21,	1855,	Birth	Name,	2398756
3,	Garner,	Lewis	[I1105],	November	18,	1823,	Birth	Name,	2387218

Same	Surnames

Fig.	13.8.7	Quick	View	Report	-	People	view	-	Same	Surname	-
example	popup	window,	showing	right-click	context	menu

Same	Surnames	quick	view	report	from	the	People	view	will	show	a	dialog	with	a	list	of	the	people	with	the	surname.	Uses	the	same	format	as	the
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Same	Given	Name	Person	category	QuickView.

See:	Top	Surnames	and	Surname	Cloud	Gramplets	

Category	References

Person	References

Person	References	built-in	Quick	View	:	Display	showing	the	backlink	references	for	the	active	person

Family	References

Family	References	built-in	Quick	View	:	Display	showing	the	backlink	references	for	a	family

Event	References

Event	References	built-in	Quick	View	:	Display	showing	the	backlink	references	for	an	event

Place	References

Place	References	built-in	Quick	View	:	Display	showing	the	backlink	references	for	a	place

Source	References

Source	References	built-in	Quick	View	:	Display	backlink	references	for	a	Source
Source	or	Citation	References	built-in	Quick	View	:	Display	backlink	references	for	a	Source	or	Citation

Citation	References

Citation	References	built-in	Quickreport	:	Display	backlink	references	for	a	Source	or	Citation

Repository	References

Fig	13.8.8	Repository	References	Quick	View

Repository	References	built-in	Quick	View	:	Display	the	repository	backlink	references	for	sources	related	to	the	active	repository

See	Repositories	Report	addon

Media	References

Media	References	built-in	Quick	View	:	Display	showing	the	backlink	references	for	a	media	object

Note	References

Note	References	built-in	Quick	View	:	Display	showing	the	backlink	references	for	a	note

Link	References

Link	Reference	quick	view	report	from	the	People	view	will	show	a	dialog	with	the	information	in	the	following	format:

								Link	References	for	this	note

Type				 Reference				 Link	check		
	

Family Garner,	Rita	Marie/Warner,	Allen	Carl	[F0001] Ok

Media Media,	1897_expeditionsmannschaft_rio_a	[O0010]		
	 Ok

Internet		
	 relative://relative.archive.tgz

Internet relative://relative.archive.zip

The	context	menu	will	vary,	based	upon	the	link	type	of	the	indicated	row.
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Link	that	reference	a	Gramps	object	record	will	offer	to	"See	the	<object	type>	details".	This	opens	the	Object	Editor.	Rows	with	Person	object
types	will	offer	an	option	to	Make	the	person	active..	Internet	object	types	have	no	context	menu	options.

The	'Copy	All'	context	menu	will	include	the	table	data	without	headers	and	an	extra	columns	for	sorting	data:	
original	row	number,	object	type,	reference	(link	target),	Link	check

0,	Family,	Garner,	Rita	Marie/Warner,	Allen	Carl	[F0001],	Ok
1,	Media,	1897_expeditionsmannschaft_rio_a	[O0010],	Ok
⋮
8,	Internet,	relative://relative.archive.tgz,	
9,	Internet,	relative://relative.archive.zip,	

Quick	View	Gramplet

Configurable	to	show	the	Quick	View	you	want	to	see.

Available	for	use	from	the	 Dashboard 	and	each	of	the	category	view	sidebars	and	bottombars.

See:

Quick	View	Gramplet

Quick	Views	Addons

Sort	the	Addons	list	table	on	the	Type	column	and	scroll	to	the	Quickview	grouping.

Available	addon	Quickviews	(in	the	People	category	view)	include:

All	Names	of	All	People
Biography
Number	of	ancestors	(by	generation)
Number	of	descendants	(totals	broken	down	by	generation	and	timeline	overlaps)	[recte:	not	the	Descendant	Count	gramplet]
Timeline	(events	of	immediate	family)

Making	your	own	Quick	Views

You	can	create	your	own	Quick	Views,	even	with	limited	programming/coding	knowledge.

Many	users	want	to	produce	a	view	quickly	for	their	specific	needs,	but	are	hindered	by	the	fact	they	do	not	want	to	learn	python	fully,	nor	the
intricacies	of	a	complicated	program	like	Gramps.

These	views	are	short	textual	reports	that	the	user	can	register	with	Gramps,	so	they	automatically	appear	in	the	context	menu's.

Accompanying	this,	the	simple	database	access	and	simple	document	interface's	have	been	constructed,	so	as	to	hide	as	much	complexity	as
possible.

See	the	Quick	Views	Coding	page	to	make	your	own.	

Back	to	Index	of	Reports.

Previous Index Next
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Tools

Previous Index Next

Fig.	14.1	"Tools	>..."	Menubar	-
Tools	Overview

This	chapter	describes	the	various	 Tools 	available	in	Gramps.

Gramps	 Tools 	allow	you	to	perform	various	types	of	analysis	of	your	genealogical	data.	Typically,	the	tools	do	not	produce	output	in	form	of
printouts	or	files.	Instead,	they	produce	screen	output	immediately	available	for	the	researcher.	However,	when	appropriate,	you	can	save	the	results
of	running	a	tool	into	a	file.

Tools

Fig.	14.2	Toolbar	Icon	for	"Open	the	tools	dialog"

The	tools	can	be	accessed	by	choosing	the	menu	Tools	->Tool	Section	->Particular	Tool	.

Alternatively,	you	can	browse	the	complete	selection	of	available	tools	along	with	their	brief	descriptions	in	a	 Tool	Selection 	dialog	invoked
by	clicking	the	 Open	the	tools	dialog 	icon	on	the	toolbar	from	any	of	the	categories.	

Additional	Tools

Gramps	allows	you	to	install	even	more	tools.	This	system	is	controlled	by	the	Plugin	Manager.	For
additional	tools	see	Addons.

Tool	Selection	dialog

Fig.	14.3	Tool	Selection	-	dialog	-	default	information	(and	"Debug"
tools	selection)
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Fig.	14.4	Tool	Selection	-	dialog	-	example	showing	"Check	and
Repair	Database"	information	(and	"Debug"	tools	selection)

The	 Tool	Selection 	dialog	allows	you	to	browse	the	complete	selection	of	available	tools	along	with	their	brief	descriptions	when	invoked	by

clicking	the	 	 Open	the	tools	dialog 	icon	on	the	toolbar	from	any	of	the	categories	and	use	the	 ▶ 	arrows	to	expand	the	listings.

Select	a	tool	from	those	available	on	the	left.	Use	the	 ▶ 	arrows	to	expand	the	top	level	listings:

Analysis	and	Exploration
Debug
Family	Tree	Processing
Family	Tree	Repair
Utilities

Then	select	the	tool	you	are	interested	in	to	be	shown	on	the	right	hand	side	the	following:

Tool	name
Tool	description
Status:
Author:
Author's	email:

You	can	can	then	use	the	buttons	below	to	either	find	out	more	about	the	tool	or	open	and	run	your	tool.

Wiki 	opens	the	help	page	if	available	-	needs	an	internet	connection	—	⚡new	for	version	6.0.0
Close 	exits	this	dialog
Run 	-	 Run selected tool 	-	opens	the	tools	configuration	page.

See	also:	Report	Selection	dialog

Analysis	and	Exploration

This	section	contains	tools	which	analyze	and	explore	the	database,	but	do	not	alter	it.	The	following	analysis	and	exploration	tools	are	currently
available	in	Gramps:

Compare	Individual	Events

Fig.	14.5	"Compare	Individual	Events"	-	"Event
comparison	filter	selection"	-	dialog

This	tool	collates	all	the	event	types	discovered	in	a	group	of	people.	Arguably,	it	could	be	considered	to	be	more	a	Report	than	a	Tool.	It	generates
a	summary	comparison	table	that	begins	with	the	Name	and	ID	of	each	person,	then	adds	columns	for	the	Event	types	and	dates.	If	there	are
multiples	of	the	same	event	type,	additional	rows	are	created.	The	collation	ignores	the	Roles	but	includes	custom	Event	types.

The	resulting	table	is	useful	for	comparing	of	suspected	duplicates	and	revealing	inconsistencies.	The	table	can	become	quite	wide	so	the	Save	As
(in	the	.ods	format)	will	allow	analysis	in	a	spreadsheet	application.
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You	can	use	this	tool	via	menu	Tools->Analysis	and	Exploration	>	Compare	Individual	Events...	which	will	open	the	 Event	comparison
filter	selection 	dialog

Event	comparison	filter	selection	dialog

The	people	for	this	comparison	can	be	chosen	from	previously	created	custom	filters	by	selecting	the	 Filter: 	drop	down	list,	which	defaults	to
the	Entire	Database.	Or	by	selecting	the	 Custom	Filter	Editor 	button,	to	create	custom	filters	in	the	 Person	Filters 	editor.	To	run	the
report	select	 Apply 	and	the	results	will	be	displayed	in	the	 Event	Comparison	Results 	dialog.

Event	Comparison	Results	dialog

From	the	 Event	Comparison	Results 	dialog	you	can	view	the	results	or	 Save	As 	the	resulting	table	as	a	spreadsheet	(ODS	format).	Select
Close 	to	exit	the	report.	

Fig.	14.6	"Compare	Individual	Events"	-	"Event	Comparison	Results"	-	dialog	-	expanded	example

The	spreadsheet	(ODS	format)	shows	the	following	output	fields:

Person,	ID,	Birth	Date,	Birth	Place,	Death	Date,	Death	Place,	LVG	Date,	LVG	Place,	Burial	Date,	Burial	Place,
Marriage	Date,	Marriage	Place

Family	Tree	Processing

This	section	contains	tools	which	may	modify	your	database.	The	tools	from	this	section	are	used	mostly	for	finding	and	correcting	errors	in	the
data.	The	following	Family	Tree	Processing	tools	are	currently	available	in	Gramps:

Edit	Database	Owner	Information
Extract	Event	Description
Extract	Information	from	Names
Extract	Place	Data	from	a	Place	Title	-	This	tool	was	moved	to	Third-party	addons
Find	Possible	Duplicate	People
Fix	Capitalization	of	Family	Names
Merge	citations
Rename	Event	Types
Reorder	Gramps	ID
Sort	Events

Family	Tree	Processing	tools	will	only	perform	modifications	upon	your	explicit	consent

Except	for	the	automatic	fixes	performed	by	 Check	and	repair	Database 	tool	in	the	Family	Tree
Repair	menu.

Edit	Database	Owner	Information
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Fig.	14.7	"Database	Owner	Editor"	-	dialog	-	default

The	 Edit	Database	Owner	Information 	tool	modifies	any	existing	Researcher	Information.

Select	the	menu	Tools->Family	Tree	Processing->Edit	Database	Owner	Information....	This	brings	up	the	 Database	Owner	Editor
window,	where	you	can	fill	in	the	needed	information	or	use	one	of	the	buttons	to	retrieve	existing	information.

Name:
Street:
Locality:
City:
State/County:
Country:
ZIP/Postal	Code:
Phone:
Email:

This	information	is	family	tree	specific	and	will	be	used	when	exporting	your	data	in	GEDCOM	format.

Two	button	choices	are	available:

Copy	from	DB	to	Preferences 	-	to	the	Researcher	section.
Copy	from	Preferences	to	DB 	-	from	the	Researcher	section.

—	⚡new	for	version	6.0	-	Use	regular	buttons	to	copy	owner	information	from/to	preferences	

Extract	Event	Description

The	name	format	in	the	Event's	Description	field	depends	on

the	defined	name	format	in	Edit->Preferences->Data>	Display	Options	(section)	-> Name	format:

Extracts	event	descriptions	from	the	event	data	by	using	a	model	:

{event	type}	of	{Surname},	{Given	name}

If	event	description	is	missing,	then	tool	will	use	this	event	description	field	model.

You	can	access	this	tool	via	the	menu	Tools->Family	Tree	Processing->Extract	Event	Description...

The	Undo	history	warning	will	be	shown	and	you	can	either	 Stop 	or	 Proceed	with	the	tool .

Once	you	 Proceed	with	the	tool 	this	tool	will	scan	and	modify	your	Family	Tree	and	if	not	present	show	you	the	 No	modifications
made 	alert	otherwise	if	present	you	with	the:

Modifications	made	result	window
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

Fig.	14.8	Extract	Event	Description's	-
"Modifications	Made"	-	window	-	example
result

Modifications	made 	result	window	listing	the	total	number	of	event	descriptions	that	have	been	added.	

Extract	Information	from	Names

This	tool	searches	the	entire	database	and	attempts	to	extract	titles	and	nicknames	that	may	be	embedded	in	a	person's	 Given	name 	field.	If	any
information	could	be	extracted,	the	candidates	for	fixing	will	be	presented	in	the	table.	You	may	then	decide	which	to	repair	as	suggested	and	which
not	to.

You	can	access	this	tool	via	the	menu	Tools->Family	Tree	Processing->Extract	Information	from	Names....

The	 Undo	history	warning 	dialog	will	be	shown	and	you	can	either	 Stop 	or	 Proceed	with	the	tool .

The	 Default	prefix	and	connector	settings 	dialog	will	be	shown	and	you	can	modify	each	of	the	options	as	required	and	once	you
have	finished	select	 OK 	to	start	the	tool.	

Once	the	tool	finishes	either	the	 No	modifications	made 	dialog	will	be	shown	as	No	titles,	nicknames	or	prefixes	were	found	or	the	 Name
and	title	extraction	tool 	window	will	be	shown	with	results	of	the	search.	

Default	prefix	and	connector	settings	dialog

Fig.	14.9	"Default	prefix	and	connector	settings"	-	dialog	for	the
"Extract	Information	from	Names"	Tool

The	 Default	prefix	and	connector	settings 	dialog	you	can	modify	each	of	the	options	as	required:

Prefixes	to	search	for: 	de,	van,	von,	di,	le,	du,	dela,	della,	des,	vande,	ten,	da,	af,	den,	das,	dello,	del,	en,
ein,	elet,	les,	lo,	los,	un,	um,	una,	uno,	der,	ter,	te,	die	(default)
Connectors	splitting	surnames: 	e,	y	(default)
Connectors	not	splitting	surnames: 	de,	van	(default)

No	modifications	made	dialog

No	titles,	nicknames	or	prefixes	were	found	in	the	selected	family	tree.

Select	 Close 	to	dismiss	the	dialog.
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

Name	and	title	extraction	tool	window

Fig.	14.10	"Name	and	title	extraction	tool"	-	dialog	results	window	for
the	"Extract	Information	from	Names"	Tool

The	top	section	shows	information	about	the	tool.

The	bottom	section	displays	the	results	list	in	a	table	with	the	following	columns:	Select,	ID,	Type,	Value,	Current	Name

You	can	un-Select	the	results	you	don't	want	and	then	 Accept	and	close 	to	apply	those	results	to	your	family	tree	or	 Cancel 	to	do
nothing.	The	 Help 	button	brings	you	to	this	tools	help	section.

Extract	Place	Data	from	a	Place	Title

This	tool	was	moved	to	Third-party	addons.

When	the	Place	Hierarchy	was	first	added	to	Gramps,	every	user	needed	a	tool	to	Addon:Extract	Place
Data	from	a	Place	Title.	Now	that	that	a	Hierarchy	of	Places	is	well	established,	the	tool	is	needed
infrequently.	So	installation	has	been	made	optional.

Find	Possible	Duplicate	People
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Fig.	14.11	Find	Possible	Duplicate	People
-	dialog	-	default

The	Find	Possible	Duplicate	People	tool	searches	the	entire	Tree	database,	looking	for	the	entries	that	may	represent	the	same	person.

You	can	access	this	tool	via	the	menu	Tool	->	Family	Tree	Processing	->	Find	Possible	Duplicate	People....

The	 Find	Possible	Duplicate	People 	dialog	will	be	shown	and	you	can	adjust	the	following	options:

Match	Threshold 	:	choose	between	Low	(default),	Medium	and	High	from	the	drop	down	menu.

How	is	the	quality	of	match	measured?

This	calculates	the	chances	(or	'odds')	of	matching	on	a	quality	scale	labeled	as	low,	medium	and	high.
For	each	piece	of	information	that	corresponds,	the	quality	of	the	match	is	considered	to	be	marginally
increased.	The	closer	the	particular	pieces	of	data	correlate,	the	larger	the	increase.	When	the	chance	is
greater	than	the	selected	Match	Threshold	then	a	match	will	reported.	The	thresholds	are	Low=0.25,
Medium=1.0	and	High=2.0.	So,	with	the	filtering	threshold	set	to	High,	fewer	matches	are	expected.

Options

	 Use	soundex	codes 	for	matching	possible	duplicate	people.	(checkbox	checked	by	default)

The	following	buttons	are	present:	 Help 	brings	you	to	this	page,	 Cancel 	to	stop	processing	and	an	 OK 	button	to	start	processing	the	data.

Select	 OK 	to	start	the	tool	and	the	data	will	be	processed	in	two	passes.

Pass	1:	Building	preliminary	lists
Pass	2:	Calculating	potential	matches.

A	progress	bar	will	be	shown	and	depending	the	speed	of	your	computer	and	the	amount	of	people	in	the	database	this	can	take	some	time.

Potential	Merges

Fig.	14.12	"Potential	Merges"	result	dialog	window	for	"Find	Possible
Duplicate	People"	-	dialog	-	example

Once	the	report	finishes	a	 Potential	Merges 	result	list	window	is	presented	with	the	following	columns	shown:

Rating	:	this	gives	you	an	idea	of	the	resemblance	between	the	two	people.	The	higher	the	ranking,	the	higher	the	chance	that	the	people	are
duplicates.
First	Person
Second	Person

You	can	either	double-click	on	the	selected	row	or	select	the	 Compare 	button	to	check	the	details.
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Three	buttons	are	present:	 Help 	brings	you	to	this	page,	a	 Close 	to	close	the	window	which	returns	you	to	the	 Find	Possible	Duplicate
People 	window	and	a	 Compare 	button	to	which	brings	up	the	 Merge	People 	window	which	was	explained	in	detail	in	the	 Merge
People 	dialog.	Here	you	can	select	with	the	radio	buttons	one	of	the	persons	and	eventually	use	the	 OK 	button	to	merge	the	data	if	you	find	the
two	persons	are	duplicates.

Selecting	the	 Cancel 	button	brings	you	back	to	the	 Potential	Merges 	result	list	window.	

Fix	Capitalization	of	Family	Names

This	tool	searches	the	entire	database	and	attempts	to	fix	the	capitalization	of	family	names.

The	aim	is	to	have	conventional	capitalization:	capital	first	letter	and	lower	case	for	the	rest	of	the	family	name.	If	deviations	from	this	rule	are
detected,	the	candidates	for	fixing	will	be	presented	in	the	table.

You	may	then	decide	which	to	repair	as	suggested	and	which	not	to.

You	can	use	this	tool	via	menu	Tools->Family	Tree	Processing->Fix	Capitalization	of	Family	Names....

Undo	history

Proceeding	with	this	tool	will	erase	the	undo	history	for	this	session.	In	particular,	you	will	not	be	able	to
revert	the	changes	made	by	this	tool	or	any	changes	made	prior	to	it.	It	is	recommended	that	you	please
stop	here	and	backup	your	database;	so	that	you	can	revert	the	process	of	running	this	tool.

The	Undo	history	warning	will	be	shown	and	you	can	either	 Stop 	or	 Proceed	with	the	tool .

Fig.	14.13	"Capitalization	changes"	-	dialog	-	results	example
for	"Fix	Capitalization	of	Family	Names"	tool

If	there	where	changes	to	the	capitalization	of	any	names	you	will	be	presented	with	the	 Capitalization	changes 	results	window.	The
window	shows	a	list	of	the	family	names	that	Gramps	can	convert	to	(according	to	Gramps)	correct	capitalization	(please	check	that	it	is	correct	for
you.).	In	the	 Capitalization	changes 	results	window	list	the	following	columns	are	available:

	 Select 	-	Check	or	uncheck	these	on	a	"by	name"	basis	if	you	choose	not	to	accept	the	recommendation	(checkbox	checked	by	default)
Original	Name 	-	The	name	as	currently	recorded.
Capitalization	Change 	-	The	name	with	change	if	applied.

Select	the	names	you	want	to	be	changed,	then	select	the	 Accept	changes	and	close 	button.	Or	use	the	 Cancel 	button	to	abort	changes.	

You	can	also	install	the	"Addon:Fix	Capitalization	of	Given	Names"	tool	Addon	that	once	installed	works	almost	identically	to	this	tool	but	works
for	"Given	Names"	

Merge	citations

The	 Merge	Citations 	tool

works	by	combining	notes,	media	objects	and	data-items	of	matching	citations.
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You	can	select	this	via	menu	Tools	>	Family	Tree	Processing	>	Merge	Citations...	.

Undo	history

Proceeding	with	this	tool	will	erase	the	undo	history	for	this	session.	In	particular,	you	will	not	be	able	to
revert	the	changes	made	by	this	tool	or	any	changes	made	prior	to	it.	It	is	recommended	that	you	please
stop	here	and	backup	your	database;	so	that	you	can	revert	the	process	of	running	this	tool.

The	Undo	history	warning	will	be	shown	and	you	can	either	 Stop 	or	 Proceed	with	the	tool .	

Fig.	14.14	"Merge	Citations"	-	dialog	-	default

Then	the	 Merge	Citations 	dialog	(Title	of	dialog	shows:Notes,	media	objects	and	data-items	of	matching	citations	will	be	combined.)will	be
shown

The	following	options	are	available:

Match	Threshold 	drop	down	list:
Match	on	Page/Volume,	Date	and	Confidence
Ignore	Date	(default)
Ignore	Confidence
Ignore	Date	and	Confidence

Options
	 Don't	merge	if	citation	has	notes 	(checkbox	unchecked	by	default)

Fig.	14.15	"Number	of	merges	done"	result
dialog	for	"Merge	Citations"	-	dialog	-	Tool	-
example

Select	 OK 	to	run	the	tool	and	once	complete	it	will	report	back	the	total	with	the	 Number	of	merges	done 	result	dialog.	
See	also	the	Merge	Citations	option	available	from	the	Citations	Category	list	view	

Rename	Event	Types

This	tool	will	rename	all	events	of	one	type	to	a	different	type.

You	can	access	this	tool	via	the	menu	Tools->Family	Tree	Processing->Rename	Event	Types....

The	Undo	history	warning	will	be	shown	and	you	can	either	 Stop 	or	 Proceed	with	the	tool .

Undo	history

Proceeding	with	this	tool	will	erase	the	undo	history	for	this	session.	In	particular,	you	will	not	be	able	to
revert	the	changes	made	by	this	tool	or	any	changes	made	prior	to	it.	If	you	think	you	may	want	to	revert
running	this	tool,	please	stop	here	and	backup	your	database.
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Fig.	14.16	"Change	Event	Types"	-	dialog	-	example	for
"Rename	Event	Types"	Tool

The	 Change	Event	Types 	dialog	is	presented.

Original	event	type :	fill	in	the	text	field	or	use	the	drop	down	menu	and	select	an	original	event	type
New	event	type :	fill	in	the	text	field	(you	can	create	a	complete	new	type	here)	or	use	the	drop	down	menu	and	select	a	new	type

The	example	shows	a	renaming	of	the	Birth	event	to	a	Baptism	event.

Custom	types

While	the	custom	types	do	not	show	in	the	drop	down	list,	you	can	over	type	or	paste	into	either	of	the
selection	boxes	and	convert	from	one	to	another.

Fig.	14.17	"Change	types"	-	result	dialog	-	example	for
"Rename	Event	Types"	Tool

Finally	use	the	 Cancel 	to	exit	or	select	 OK 	to	run	the	tool	and	once	complete	it	will	report	back	the	total	events	modified	with	the	 Change
types 	result	dialog.	

Renaming	events

Once	completed,	this	cannot	be	undone	by	the	regular	 Undo 	function.

See	also:

Editing	information	about	events

Reorder	Gramps	ID
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This	tool	can	be	used	to	Reorder	your	Gramps	IDs.	Several	options	are	available.

Custom	IDs'

If	you	customized	your	IDs',	all	those	can	be	replaced	by	this	tool.	So	take	care	before	you	use	this	tool!

Fig.	14.18	Reorder	IDs

You	can	use	this	tool	via	menu	Tools->Family	Tree	Processing->Reorder	Gramps	IDs....

The	'Object'	column	lists	the	type	of	ID.	Immediately	to	the	left	of	this	column	are	checkboxes	that	allow	the	enabling	of	changes	to	individual
object	types.	When	checked,	the	type	can	be	reordered.	The	'Object'	label	is	actually	a	button	that	can	be	used	to	toggle	all	of	the	check	boxes	at
once.

The	'Actual'	column	shows	an	example	of	the	current	ID.	The	'Quantity'	column	show	the	number	of	objects.

The	'Format'	column	can	be	used	to	change	the	ID	format	for	each	object	type.	Note	that	the	format	consists	of	a	prefix,	the	'%04d'	and	suffix.	There
MUST	be	at	least	a	prefix	or	a	suffix,	both	are	allowed.	It	is	recommended	to	keep	these	relatively	short.	The	'%04d'	defines	the	length	of	the
numeric	portion	of	the	ID,	the	'4'	can	be	changed,	anything	from	'3'	(allowing	numbers	from	000-999)	to	'9'	(000000000-999999999)	is	allowed.
Changes	made	here	are	the	same	as	made	in	the	menu	Edit->Preferences...	and	then	select	the	ID	Formats	tab.	The	'Format'	label	is	actually	a
button	that	can	be	used	to	reset	all	the	formats	to	the	last	used	value.

The	'Change'	column	contains	checkboxes	for	each	object	type.	If	this	is	checked,	the	IDs	for	that	object	will	be	replaced	with	new	IDs	of	the
'Format'	style,	unless	'Keep'	is	also	checked.	If	there	is	no	check,	the	ID	formats	are	NOT	updated,	but	the	number	field	within	the	format	is
renumbered.	The	'Change'	label	is	actually	a	button	that	can	be	used	to	toggle	all	of	the	check	boxes	at	once.

The	'Start'	field	indicates	the	starting	number	used	during	the	renumber	operation.	The	'Start'	label	is	actually	a	button	that	can	be	used	to	toggle
between	start	at	0,	and	start	after	last	current	number.

The	'Step'	field	indicates	the	interval	between	numbers	during	the	renumber,	'1'	is	a	simple	increment,	'2'	will	increment	by	2	etc.	The	'Step'	label	is
actually	a	button	that	can	be	used	to	toggle	between	'1',	'2',	'5',	and	'10'.

The	'Keep'	column	contains	checkboxes	for	each	object	type.	If	this	and	'Change'	is	checked,	the	ID	formats	for	that	object	will	be	retained,	and	the
number	field	within	the	format	is	renumbered.	The	'Keep'	label	is	actually	a	button	that	can	be	used	to	toggle	all	of	the	check	boxes	at	once.

The	Undo	history	warning	will	be	shown	and	you	can	either	 Stop 	or	 Proceed	with	the	tool .

Undo	history

Proceeding	with	this	tool	will	erase	the	undo	history	for	this	session.	In	particular,	you	will	not	be	able	to
revert	the	changes	made	by	this	tool	or	any	changes	made	prior	to	it.	If	you	think	you	may	want	to	revert
running	this	tool,	please	stop	here	and	backup	your	database.

When	you	click	'OK',	the	tool	will	show	a	progress	bar.

In	different	stages	the	following	IDs'	are	reordered:	Reordering	People	IDs',	Reordering	Family	IDs',	Reordering	Event	IDs',	Reordering	Media
Object	IDs',	Reordering	Source	IDs',	Reordering	Citation	IDs',	Reordering	Place	IDs',	Reordering	Repository	IDs'	and	finally	Reordering	Note	IDs'.

In	a	next	step	unused	IDs'	are	searched	for	and	assigned.

During	this	process	the	tool	will	examine	each	ID	to	see	if	it	looks	like	it	has	been	'customized',	if	it	doesn't	look	like	the	previous	ID	format	or	the
default	ID	format.	This	might	be	the	case	if	the	user	had	entered	his	own	text	in	the	ID	field	for	the	object	when	editing	it.	It	might	also	occur	if	the
third	party	GetGOV	Addon	or	GeoName	Addon	has	been	used,	as	that	tool	stores	the	GOV	ID	in	the	ID	field.	If	a	'customized'	ID	is	found,	it	will
ask	the	user	if	he	really	wants	to	replace	the	ID.	The	dialog	also	allows	the	user	to	use	the	same	answer	for	other	customized	IDs	found.

Sort	Events

Events	appearing	on	the	Event	tab	on	a	Person	or	Family	Editor	are	not	sorted	in	any	particular	order	other	than	the	order	that	the	events	were
added.	The	reason	for	not	enforcing	any	particular	ordering,	particularly	ordering	by	date,	is	to	allow	for	the	situation	where	an	event	was	known	to
have	happened	but	the	exact	chronology	is	not.	Importing	or	merging	data	from	an	external	source	can	lead	to	extra	events	being	added	to,	but	out	of
sequence	with,	the	existing	set	of	events	of	a	person	or	family.
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Events	can	be	manually	re-ordered	by	drag	&	drop	or	by	use	of	the	re-order	buttons	on	the	 Events 	tab.	Either	way,	an	event	can	be	moved	up	or
down	in	the	list	of	events	and	Gramps	will	remember	the	new	order	when	the	changes	are	saved.	The	new	ordering	will	be	used	wherever	events
are	shown	elsewhere	in	Gramps,	such	as	on	a	report.

The	order	of	all	events	on	a	tab	can	also	be	changed	by	clicking	a	column	title.	For	example,	clicking	the	'Date'	column	header	will	sort	all	the
events	in	date	order.	However	this	way	of	sorting	events	is	temporary	and	changes	to	the	event	order	are	not	preserved	when	the	window	is	closed.

The	drag	and	drop	approach	to	sorting	events	is	fine	for	moving	a	small	number	of	events	but	is	not	practical	for	large	scale	changes.	The	Sort
Events	tool	has	been	designed	specifically	for	this	purpose,	re-sorting	all	events	in	the	database	or	just	those	associated	with	a	targeted	selection	of
people	chosen	by	using	a	filter.

You	can	use	this	tool	via	menu	Tools->Family	Tree	Processing->Sort	events....

The	Undo	history	warning	will	be	shown	and	you	can	either	 Stop 	or	 Proceed	with	the	tool .

Undo	history

Proceeding	with	this	tool	will	erase	the	undo	history	for	this	session.	In	particular,	you	will	not	be	able	to
revert	the	changes	made	by	this	tool	or	any	changes	made	prior	to	it.	If	you	think	you	may	want	to	revert
running	this	tool,	please	stop	here	and	backup	your	database.

Fig.	14.19	"Sort	Events"	-	dialog	-	showing	"Tool	Options"	tab	for
"Sort	Events"	Tool

The	first	option	on	the	 Sort	Events 	dialog	window	is	used	to	define	the	range	of	people	who's	events	are	to	be	sorted.	The	first	choice	in	the
list	is	to	apply	the	sorting	to	all	people	in	the	database.	Alternative	choices	are	to	apply	sorting	to	ancestors	and	descendants	of	a	chosen	person	or	to
a	range	of	people	selected	by	a	custom	built	person	filter.	After	choosing	who	the	sort	should	apply	to,	the	next	thing	to	consider	is	how	the	events
should	be	sorted.	The	first	option	is	to	sort	by	date.	This	is	probably	the	most	likely	choice,	but	other	event	attributes	can	be	chosen	too.	The	final
choices	are	whether	to	make	the	events	sorted	ascending	or	descending	and	whether	to	apply	the	sort	to	family	events	that	the	selected	people
belong	to	as	well.

Sorting	events

Once	completed,	this	cannot	be	undone	by	the	regular	 Undo 	function.

Family	Tree	Repair

The	following	Family	Tree	Repair	tools	are	available:

Check	and	Repair	Database
Rebuild	Gender	Statistics
Rebuild	Reference	Maps
Rebuild	Secondary	Indexes
Remove	Unused	Objects

Check	and	Repair	Database

Warning:	The	 Check	and	repair	Database	tool	performs	automatic	fixes.

Once	completed,	this	cannot	be	undone	by	the	regular	 Undo	History 	function.

The	 Check	and	repair	Database 	tool	checks	the	selected	database/Family	Tree	for	integrity	problems,	fixing	the	problems	it	can.
Specifically,	the	tool	is	checking	for:
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Broken	family	links.	These	are	the	cases	when	a	person's	record	refers	to	a	family	while	the	family's	record	does	not	refer	to	that	person,	and
vice	versa.

Missing	media	objects.	The	missing	media	object	is	the	object	whose	file	is	referenced	in	the	database	but	does	not	exist.	This	can	happen
when	the	file	is	accidentally	deleted,	renamed,	or	moved	to	another	location.

Empty	families.	These	are	the	family	entries	which	have	no	reference	to	any	person	as	their	member.

Parent	relationship.	This	checks	all	families	to	ensure	that	father	and	mother	are	not	mixed	up.	The	check	is	also	made	that	parents	have
different	gender.	If	they	have	common	gender	then	their	relationship	is	renamed	to	"Partners".

You	can	use	this	tool	via	menu	Tools->Family	Tree	Repair->Check	and	Repair	Database....

Undo	history

Proceeding	with	this	tool	will	erase	the	undo	history	for	this	session.	In	particular,	you	will	not	be	able	to
revert	the	changes	made	by	this	tool	or	any	changes	made	prior	to	it.	It	is	recommended	that	you	please
stop	here	and	backup	your	database;	so	that	you	can	revert	the	process	of	running	this	tool.

The	Undo	history	warning	will	be	shown	and	you	can	either	 Stop 	or	 Proceed	with	the	tool .

Integrity	Check	Results	dialog

Fig.	14.20	"Integrity	Check	Results"	-	example	result
dialog	-	for	the	"Check	and	Repair	Database"	tool

Any	issues	found	are	automatically	fixed	and	the	 Integrity	Check	Results 	dialog	will	be	shown	with	a	summary	actions	taken.	

No	errors	were	found	dialog

Otherwise	you	will	see	the	 No	errors	were	found 	dialog	stating	that	The	database	has	passed	internal	checks .	

Gramps	had	a	problem	the	last	time	it	was	run	-	dialog

Fig.	14.21	Gramps	had	a	problem	the	last	time	it	was	run	-	dialog

After	Gramps	crashes	on	restart,	Gramps	will	offer	to	run	Check	&	Repair	tool.	(Introduced	in	Gramps	5.1.x)

Rebuild	Gender	Statistics

Fig.	14.22	"Gender	statistics	rebuilt"	-	result	dialog	for	"Rebuild
Gender	Statistics"	tool

Rebuilds	gender	statistics	for	name	gender	guessing	based	on	the	accumulated	statistics	of	genders	for	given	names	within	the	tree.	If	a	gender	is
common	to	more	than	half	the	in	the	Tree	with	a	particular	first	word	in	their	Given	name,	then	Gramps	will	guess	that	Gender	for	that	name	will	be
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the	same.

The	statistics	can	also	be	cleared	(if	the	Tools	➡	Debug	menu	has	been	enabled)	with	the	Dump	Gender	Statistics	Tool.

You	can	use	this	tool	via	menu	Tools	➡	Family	Tree	Repair	▶	Rebuild	Gender	Statistics....

Once	completed	the	 Gender	statistics	rebuilt 	result	dialog	will	be	shown.

Rebuild	Gender	Statistics	needed	after	converting	database

Issue	11314	notes	that	gender	statistics	are	swapped	after	database	conversion	to	SQLite.	If	your	gender
guessing	is	suggesting	the	opposite	gender	for	particular	given	names,	use	the	Rebuilt	Gender	Statistics
tool	to	fix	the	guessing.

See	Gender	entry.

Rebuild	Reference	Maps

Fig.	14.23	"Reference	maps	rebuilt"	-	result
dialog	for	"Rebuild	Reference	Maps"	tool

This	tool	rebuilds	reference	map	tables.	This	drives	the	list	of	References	items	in	editors.

You	can	use	this	tool	via	menu	Tools	➡	Family	Tree	Repair	▶	Rebuild	Reference	Maps....

Once	completed	the	 Reference	maps	rebuilt 	result	dialog	will	be	shown.

See	also

This	rebuild	is	also	performed	as	part	of	the	Tools	➡	Family	Tree	Repair	▶	Check	and	repair	database...

Rebuild	Secondary	Indexes

Fig.	14.24	"Secondary	indexes	rebuilt"	-	result
dialog	for	"Rebuild	Secondary	Indexes"	tool

This	tool	rebuilds	secondary	indices.

You	can	use	this	tool	via	menu	Tools	➡	Family	Tree	Repair	▶	Rebuild	Secondary	Indexes....

Once	completed	the	 Secondary	indexes	rebuilt 	result	dialog	will	be	shown.

The	Rebuild	Secondary	indexes...	re-constructs	the	secondary	tables	in	the	Tree	db.	These	tables	include	things	like	gender	statistics	(Given	Name
versus	gender)	to	allow	guessing	the	gender	of	names	as	they	are	entered,	surnames	(for	faster	lookup	of	possible	surname	and	to	make	the	person
tree	view	work),	the	various	IDs	for	objects	(to	facilitate	lookup	by	ID),	place	enclosure	tables,	to	make	the	place	tree	view	work,	and	a	few	others.

In	theory,	these	tables	are	kept	constantly	up-to-date	when	anything	changes.	So	rebuilding	the	Reference	Maps	and	Secondary	Indices	should	not
be	necessary.	But,	especially	early	on	in	the	Gramps	history,	bugs	sometimes	interfered	with	updates	completing	correctly.	So	the	tools	remain
available...	‘just	in	case’.

See	also

This	rebuild	is	also	performed	as	part	of	the	Tools	➡	Family	Tree	Repair	▶	Check	and	repair	database...

Remove	Unused	Objects

Tools	-	Tools 301

http://www.gramps-project.org/wiki/index.php/File:Gnome-important.png
https://gramps-project.org/bugs/view.php?id=11314
http://www.gramps-project.org/wiki/index.php/File:ReferenceMapsRebuilt-dialog-50.png
http://www.gramps-project.org/wiki/index.php/File:SecondaryIndexesRebuilt-dialog-50.png


This	tool	will	search	your	database	for	pieces	of	information	which	are	not	connected	to	anything	else,	and	then	allow	you	to	edit	and	attach	the
information	or	remove	them.

You	can	use	this	tool	via	menu	Tools->Family	Tree	Repair->Remove	Unused	Objects....

Fig.	14.25	"Unused	Objects"	-	dialog	example	results	for
"Remove	Unused	Objects"	tool

The	 Unused	Objects 	dialog	is	presented.

You	can	choose	from	the	search	option	you	want	to	use	from	the	top	section	of	the	 Unused	Objects 	dialog:

	 Search	for	events 	(checkbox	checked	by	default)
	 Search	for	sources 	(checkbox	checked	by	default)
	 Search	for	citations 	(checkbox	checked	by	default)
	 Search	for	places 	(checkbox	checked	by	default)
	 Search	for	media 	(checkbox	checked	by	default)
	 Search	for	repositories 	(checkbox	checked	by	default)
	 Search	for	notes 	(checkbox	checked	by	default)

Select	the	 Find 	button	to	run	the	tool,	and	once	completed	the	results	if	any	will	show	in	the	bottom	section	of	the	 Unused	Objects 	dialog
with	the	following	columns	shown:

Mark 	Select	the	row	if	you	want	to	delete	the	object	(unchecked	by	default)
	-	Icon	representing	the	type	of	object.
ID 	-	Gramps	internal	name	for	the	object.
Name 	-	of	the	object.

To	examine	the	object	you	must	double-click	on	the	row	and	it	will	show	the	appropriate	editor	for	the	object	allowing	you	to	edit	if	required.

Mark 	the	objects	you	want	to	delete	either	using	the	individual	checkboxes	or	using	the	associated	buttons:

Mark	all
Unmark	all
Invert	marks

Once	your	deletion	choices	have	been	made	select	the	 Delete 	button	to	delete	the	objects.

When	finished	you	may	then	use	the	 Close 	button	to	exit	the	tool.	

Utilities

This	section	contains	tools	allowing	you	to	perform	a	simple	operation	on	a	portion	of	data.	The	results	can	be	saved	in	your	database,	but	they	will
not	modify	your	existing	data.	The	following	utilities	are	currently	available	in	Gramps:

Clean	input	data
Find	database	loop
Media	Manager
Not	Related
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Relationship	Calculator
Verify	the	Data

Clean	input	data

Remove	leading	and	trailing	spaces

Fig.	14.26	Clean	input	data

Tool	to	clean	leading	and	trailing	spaces	from	imported	or	old	data.		The	tool	searches	for	place	names	with	leading	or/and	trailing	spaces.	It	also
looks	in	the	first	name	and	surname.

Leading	and	trailing	spaces	are	automatically	removed	during	name	data	being	committed	to	the	tree.

The	tool	can	be	triggered	from	the	menu	Tools	>	Utilities	>	Clean	input	data...	or	Tools	selector	dialog

See	also:

Avoid	invalid	characters	and	leading	or	trailing	spaces	in	the	entry	field	-	(added	in	Gramps	5.0.2	with	PR811)
New	tool	to	suppress	leading	and	trailing	spaces.	-	(added	in	Gramps	5.1.0)
Feature	request	4566	:	Please	remove	trailing	spaces	on	items	on	input	(2016)
Feature	request	4619	:	Trailing	blanks	are	removed	from	queries	in	the	preset	filters	(2011)

Find	database	loop

Fig.	14.27	Find	possible	loop

The	 Find	database	loop 	utility	allows	you	to	verify	if	you	have	ancestral	loops	in	the	database.

Select	this	via	the	menu	Tools->Utilities->Find	database	loop...	you	will	get	a	 Find	database	loop 	window.	The	window	has	five	tabs;
Gramps_ID , Parent ,	 Gramps_ID ,	 Child ,	 Family	ID .

1.	 First	Gramps_ID	is	a	reference	to	the	Parent.
2.	 Parent	(Ancestor	on	the	image)	is	the	person	we	are	looking	for	a	loop.
3.	 Second	Gramps_ID	is	a	reference	to	the	Child.
4.	 Child	(Descendant)	is	the	origin	of	the	loop.
5.	 Family_ID	is	a	reference	to	the	associated	family
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This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

Fig.	14.28	Find	possible	loop	in	a	complex	example

In	the	following	complex	example,	we	have	multiple	ancestral	loops	:

If	we	look	at	the	second	line,	we	have	:

1.	 First	Gramps_ID	:	I0002
2.	 Parent	is	:	Father,	Child2
3.	 Second	Gramps_ID	:	I0001
4.	 Child	is	:	Father,	Father
5.	 Family_ID	is	:	F0000

To	understand	what	happens	:

1.	 we	start	at	[I0002]	Father,	Child2.
2.	 We	continue	with	his	son	[I0003]	Father,	Child3.
3.	 We	continue	with	his	son	:	[I0000]	Child,	Child.
4.	 We	continue	with	his	son	:	[I0001]	Father,	Father.
5.	 We	continue	with	his	son	:	[I0002]	Father,	Child2	==>	HERE,	we	have	a	ancestral	loop.

To	read	more	about	ancestral	loops	see:

Finding	Ancestral	Loops	:	Modern	Software	Experience
Ancestral	Loops	:	Louis	Kessler's	Behold	Blog

Media	Manager

Fig.	14.29	Introduction	-	page	for	"Gramps	Media	Manager"	-	Tool
wizard
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The	 Gramps	Media	Manager 	is	a	group	of	four	separate	tools	accessed	via	a	wizard	like	dialog	that	you	can	access	via	the	menu	Tools-
>Utilities->Media	Manager...	which	will	show	the	first	Introduction	dialog	page	with	the	following	information	on	the	tools	abilities.

Introduction

This	tool	allows	batch	operations	on	media	objects	stored	in	Gramps.	An	important	distinction	must	be
made	between	a	Gramps	media	object	and	its	file.

The	Gramps	media	object	is	a	collection	of	data	about	the	media	object	file:	its	filename	and/or	path,	its
description,	its	ID,	notes,	source	references,	etc.	These	data	do	not	include	the	file	itself.

The	files	containing	image,	sound,	video,	etc.	exist	separately	on	your	hard	drive.	These	files	are	not
managed	by	Gramps	and	are	not	included	in	the	Gramps	database.	The	Gramps	database	only	stores	the
path	and	file	names.

This	tool	allows	you	to	only	modify	the	records	within	your	Gramps	database.	If	you	want	to	move	or
rename	the	files	then	you	need	to	do	it	on	your	own,	outside	of	Gramps.	Then	you	can	adjust	the	paths
using	this	tool	so	that	the	media	objects	store	the	correct	file	locations.

From	the	Introduction	page	selecting	the	 Next 	button	(or	using	the	keyboard	shortcut	 Alt + N )	you	will	be	shown	the	Selection	page	window.

Fig.	14.30	Selection	-	page	for	"Gramps	Media	Manager"	-	Tool
wizard	-	default

From	the	Selection	page	window	select	from	one	the	four	options	the	actions	you	want	to	take	and	then	select	the	 Next 	button:

Replace	substrings	in	the	path 	(default)
Convert	paths	from	relative	to	absolute
Convert	paths	from	absolute	to	relative
Add	images	not	included	in	database

Replace	substrings	in	the	path
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Fig.	14.31	Replace	substring	settings	-	page	for	"Gramps	Media
Manager"	-	Tool	wizard	-	default

This	tool	allows	replacing	specified	substring	in	the	path	of	media	objects	with	another	substring.	This	can	be	useful	when	you	move	your	media
files	from	one	directory	to	another.

Selecting	this	radio	button	will	bring	up	a	 Replace	substring	settings 	window	where	you	can	type	in	any	string	in	the	 Replace 	text
field	and	the	 With 	text	field.	At	any	time	you	can	click	on	the	 Cancel 	button	or	the	 Back 	button.	Clicking	the	 Forward 	button	will	bring
up	the	 Final	confirmation 	window.

Convert	paths	from	relative	to	absolute

Fig.	14.32	'Convert	paths	from	relative	to	absolute':"Final
Confirmation"	page	for	"Gramps	Media	Manager"	-	Tool	wizard	-
example

This	tool	allows	converting	relative	media	paths	to	the	absolute	ones.	It	does	this	by	prepending	the	 Base	media	path: 	as	given	in	the	 Family
Tree 	tab	of	Edit->Preferences	in	the	 Family	Tree's	Media	path 	section,	or	if	that	is	not	set,	it	prepends	the	default	User's	Directory.

Absolute	and	relative	paths,	From	Wikipedia.
Absolute,	relative,	UNC,	and	URL	paths	ArcMap	help.

Convert	paths	from	absolute	to	relative
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Fig.	14.33	'Convert	paths	from	absolute	to	relative':"Final
Confirmation"	page	for	"Gramps	Media	Manager"	-	Tool	wizard	-
example

This	tool	allows	converting	absolute	media	paths	to	a	relative	path.	The	relative	path	is	relative	to	the	given	base	path	in	the	setting	 Base	media
path: 	as	given	in	the	 Family	Tree 	tab	of	Edit->Preferences	in	the	 Family	Tree's	Media	path 	section,	or	if	that	is	not	set,	the	user's
directory	is	used.	A	relative	path	connects	the	file	location	to	the	base	media	path	that	can	be	changed	according	to	your	needs.

Absolute	and	relative	paths,	From	Wikipedia.
Absolute,	relative,	UNC,	and	URL	paths	ArcMap	help.

Add	images	not	included	in	database

Fig.	14.34	'Add	images	not	included	in	database':"Final	Confirmation"
page	for	"Gramps	Media	Manager"	-	Tool	wizard	-	example

Check	directories	for	images	not	included	in	database,	this	tool	adds	images	in	directories	that	are	referenced	by	existing	images	in	the	database.
You	will	have	to	import	one	media	item	from	each	sub	directory	manually.	Media	Manager	does	not	include	sub-directories	automatically.	All	the
directory	paths	shown	in	the	tool	will	be	searched	through.	

Not	Related
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Fig.	14.35.	"Not	related	to	'...'"	-	dialog	-	showing	results	for	"Not
Related"	Tool

This	tool	will	list	people	who	are	not	connected	to	the	selected	active	person.	Connections	may	include	linked	in	a	chain	of	references	or	linkages
created	with	the	link	editor	in	Notes.

You	can	use	this	tool	via	menu	Tools->Utilities->Not	Related....

You	will	get	a	 Not	related	to	'...' 	results	dialog	which	shows	a	list	of	all	the	people	that	are	NOT	related	to	the	selected	person.

This	list	gives	you:

Name
ID
Parents
Tags

From	the	Name	column	you	can	use	the	 ▶	right	arrow 	button	and	 ↓	down	arrow 	buttons	to	collapse	or	expand	the	grouped	Name	list.
Double	clicking	on	a	person	will	bring	up	the	 person	edit 	dialog	or	 family	edit 	dialog.

If	you	select	a	person,	you	can	use	the	 Tag 	text	field	(you	can	fill	in	whatever	custom	tag	name	you	want	to	use)	or	use	the	drop	down	list	to
choose	an	existing	tag	eg	TODO,	NotRelated.	Use	the	 Apply 	to	add	the	selected	tag	to	the	person(s).	This	tag	will	then	show	up	in	the	Tags
column.	

Relationship	Calculator

Fig.	14.36	"Relationship	to	'...'	"	-	dialog	-	showing	results	for
"Relationship	Calculator"	Tool

You	can	use	this	tool	via	menu	Tools	➡	Utilities	▶	Relationship	Calculator....

Selecting	the	Relationship	Calculator	tool	will	open	a	list	filtered	to	all	people	connected,	but	not	necessarily	related,	to	the	Active	Person.	To
calculate	relationship	to	different	person,	close	the	window,	make	that	person	Active	and	select	the	tool	from	the	menu	again.

Select	the	individual	from	the	filtered	list	to	report	if	a	relationship	exists.	The	exact	relationship	will	be	shown	in	the	lower	panel...	along	with	the
common	ancestors	in	that	relationship.	Only	blood	relationships	will	display	(except	for	husband-wife	and	step	relationships).	Note	that	"in-law"
relationships	are	not	displayed.

The	filtered	list	will	grouped	and	alphabetically	sorted	by	surname.	(Regardless	of	whether	the	View	menu	setting	of	the	Person	category	has	been
set	to	Grouped.)	The	list	columns	cannot	be	re-sorted.

The	degree	of	separation	(generation	distance)	that	will	be	recognized	is	controlled	by	the	 Max	generations	for	relationships 	value	in
the	Limits	tab	under	the	Edit	➡	Preferences...	menu.	Moved	from	the	5.1	General	tab	—	⚡new	for	version	5.2	(The	default	of	15	generations	will
report	a	12th	great-grandparent	relationship	but	not	the	13th	great-grandparents.	The	active	person	is	counted	as	one	of	the	generations.	So,	self
generation	plus	parent	plus	grandparents	are	the	other	3	generations.)
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Essentially,	any	two	people	are	directly	related	by	blood	if	they	have	an	ancestor	in	common.	One	of	these	individuals	may	actually	be	an	ancestor
of	the	other	-	such	as	a	great	grandparent.	Even	in	the	cases	of	aunts	and	uncles,	you	still	can	calculate	the	relationship	by	searching	for	the	common
ancestor.	In	this	case,	the	father	or	mother	of	the	aunt	or	uncle	will	be	a	grandparent	to	the	nephew	or	niece.

The	most	basic	blood	relationship	through	common	ancestors	is	that	of	siblings	(brothers	and	sisters)	who	are	only	one	generation	down	from	the
common	ancestor.	Another	special	relationship	is	that	of	one	of	those	siblings	to	the	descendants	of	the	other	siblings.	If	the	Active	Person	is	a
grandchild	of	the	common	ancestor,	the	sibling	would	be	an	aunt	or	uncle.	Beyond	that	generation	of	descendants,	there	are	two	equivalent	ways	of
describing	the	relationship.	The	daughter	of	great	grandparents	might	be	called	either	a	grandaunt	or	a	great	aunt.	(The	Relationship	Calculator	uses
the	'grand'	variant.)	That	person	is	a	great	grandaunt	to	the	second	great	grandchildren,	who	are	four	generations	distant	from	the	common	ancestor.
(She	may	also	be	called	a	second	great	aunt.)	The	reverse	relationship	of	an	aunt	or	uncle	is	a	nephew	or	niece.

Cousins	(also	called	"first"	cousins)	are	two	generations	down	from	the	common	ancestor	through	different	siblings.	"Second"	cousins	are	thus,
three	generations	down	from	the	common	ancestor	-	and	so	on.

After	that,	everyone	is	considered	a	"cousin",	but	to	indicate	that	they	are	not	in	the	same	generation	we	use	the	word	"removed"	to	indicate	the
number	of	generations	different	between	the	two.	For	example,	my	father's	"first"	cousin	is	also	my	"first"	cousin	but	"once	removed"	(one
generation	difference	between	us).	My	fathers	"first"	cousin	is	my	own	child's	"first	cousin	twice	removed"	-	two	generations	different.

If	multiple	blood	relationships	exist	due	to	pedigree	Collapse,	all	will	be	reported.

A	full	text	list	of	all	blood	relations	and	their	spouses	can	be	viewed	using	a	Kinship	Report.

See	also:

The	Relationship	to	home	person	Display	Preferences	option	for	the	Status	bar
Relation	to	Home	Person	quick	view.
The	Deep	Connections	gramplet:	If	this	third	party	addon	is	installed,	it	will	list	the	intervening	generations	through	the	sibling	offspring	of	a
common	ancestor.	(But	it	does	not	list	the	common	ancestor	or	if	both	person	a	connected	through	the	same	spouse.)	The	Gramplet	also
details	the	indirect	relationships.
Relationship	Calculator	Localization	-	create	meaningful	relation	descriptions	in	your	region.

Verify	the	Data

Verify	the	Data	tool	enhanced—	⚡new	for	version	5.2

Tool	performance	improved,	results	reorganized	into	a	Tree	rather	than	a	flat	list,	additional	tests.
8	New	rules	(marked	below)	to	find	additional	irregularities.

Fig.	14.37	"Verify	the	Data..."	-	"Data	Verify	tool"	dialog	-
"General"	tab	-	defaults

This	utility	allows	you	to	verify	the	database	based	on	the	set	of	criteria	specified	by	you.

For	example,	you	may	want	to	make	sure	that	nobody	in	your	database	had	children	at	the	age	of	98.	Based	on	common	sense,	such	a	record	would
indicate	an	error.	However,	it	is	not	a	consistency	error	in	the	database.	Besides,	someone	might	have	a	child	at	the	age	of	98	(although	this	rarely
happens).	The	Verify	tool	will	display	everything	that	violates	your	criteria	so	that	you	can	check	whether	the	record	is	erroneous	or	not.	The
ultimate	decision	is	yours.

Select	this	via	the	menu	Tools->Utilities->Verify	the	Data...	you	will	get	a	 Data	Verify	Tool 	window.	The	window	has	four	tabs;
General ,	 Women ,	 Men ,	 Families .	Those	tabs	show	a	list	with	criteria	and	a	input	field	where	you	can	alter	the	criteria	value.	In	the	lists
below	I	show	some	workable	values.

Verify	the	Data	tab	pages
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Select	the	criteria	you	want	to	run	the	tool	with	from	the	following	tabs.	If	you	are	OK	with	the	criteria	click	the	 Run 	button	(or	hit	the	 Alt + R
keybinding)	and	you	will	be	presented	with	a	 Data	Verification	Results 	window.

General

Maximum	age :	90
Minimum	age	to	marry :	17
Maximum	age	to	marry :	50
Maximum	number	of	spouses	for	a	person :	3
Maximum	number	of	consecutive	years	of	widowhood	before	next	marriage:	30
Maximum	age	for	an	unmarried	person :	99

The	first	check	box:	 Estimate	missing	or	inexact	dates 	causes	the	tool	to	accept	a	baptism	date	if	a	birth	date	is	not	known,	and	to
accept	a	burial	date	if	a	death	date	is	not	known.	It	also	causes	the	tool	to	accept	"inexact"	dates	(i.e.,	any	"legal"	Gramps	date	which	is	not	a	fully-
specified	one	(with	an	explicit	day	and	month	and	year)).

The	second	check	box:	 Identify	invalid	dates 	will	check	if	the	dates	are	invalid.

Women

Minimum	age	to	bear	a	child :	17
Maximum	age	to	bear	a	child :	48
Maximum	number	of	children :	12

Men

Minimum	age	to	father	a	child :	18
Maximum	age	to	father	a	child :	65
Maximum	number	of	children :	15

Families

Maximum	husband-wife	age	difference :	30
Maximum	number	of	years	between	children :	8
Maximum	span	of	years	for	all	children:	25

Data	Verification	Results	window

Fig.	14.38	Data	Verification	Results	window.

After	you	run	the	tool	you	will	be	presented	with	the	 Data	Verification	Results 	window.

Depending	on	your	criteria	and	your	data,	a	list	will	be	shown.	The	possibilities	of	findings	are	listed	below.	(But	others	may	be	added.)	Each	match
will	be	grouped	with	similar	findings.

Baptism	before	birth
Baptism	too	late	according	to	family	tradition

This	rule	determines	the	median	of	days	between	birth	and	baptism	over	all	children	of	a	family.	It	then	compares	the	days	between	the	birth
and	the	baptism	of	the	person	in	question	with	also	allowing	some	grace	period	of	deviation.	Currently,	that	grace	period	is	hard-coded	with
120	days.

Birth	equals	death
Birth	equals	marriage
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Burial	before	baptism
Burial	before	birth
Burial	before	death
Burial	too	late

A	Burial	is	considered	“too	late”	when	its	more	than	14	days	after	the	date	of	death.	Should	this	be	a	parameter	or	might	this	confuse	the
user?

Children	are	not	in	chronological	order

Birth	dates	(if	no	date	exists	and	estimation	is	on,	Baptism	dates	are	used)	are	checked	for	each	child	of	a	family.	Verifies	that	dates	ascend
through	the	list	of	children.	Children	without	any	of	those	dates	are	ignored

Dead	father
Dead	mother
Death	before	baptism
Death	before	birth
Death	equals	marriage
Disconnected	individual

ones	with	no	parent	or	spouse	or	child	or	sibling

Early	marriage

(	General	tab,	default	=	17	)

Families	are	not	in	chronological	order

This	Rule	uses	the	marriage	date	and	evaluates	that	the	families	are	ordered	in	a	chronological	order	for	a	person.	If	no	marriage	date	is
available	a	divorce	date	or	even	the	birth	date	of	the	oldes	child	of	each	family	is	used.	The	birth	date	as	last	possible	fallback	is	used	to
account	for	non-married	families	with	illegitimate	children.

Family	events	not	ordered	in	chronological	order
Family	has	events	with	role	Unknown
Female	husband
Husband	and	wife	with	the	same	surname
Invalid	birth	date

(	General	tab,	default	=	True	)

Invalid	death	date

(	General	tab,	default	=	True	)

Large	age	difference	between	spouses

(	Families	tab,	default	=	30	)

Large	age	differences	between	children

(	Families	tab,	default	=	8	)

Large	year	span	for	all	children

(	Families	tab,	default	=	25	)

Late	marriage

(	General	tab,	default	=	50	)

Male	wife
Marriage	after	death
Marriage	before	birth
Marriage	date	but	not	married
Married	often

(	General	tab,	default	=	3	)

Multiple	parents
Old	age	at	death
Old	age	but	no	death

(	General	tab,	default	=	90	)

Old	and	unmarried

(	General	tab,	default	=	50	)

Old	father

(	Men	tab,	default	=	65	)

Old	mother
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(	Women	tab,	default	=	48	)

Person	events	not	in	chronological	order
Person	has	events	with	role	Unknown
Same	sex	marriage
Too	many	children

(	Men	tab,	default	=	15;	Women	tab,	default	=	12	)

Unborn	father
Unborn	mother
Unknown	gender
Young	father

(	Men	tab,	default	=	18	)

Young	mother

(	Women	tab,	default	=	17	)

On	the	bottom	of	the	window	four	buttons	are	available	to	make	a	selection	easier.	Those	are	 Mark	all ,	 Unmark	all ,	 Invert	marks ,	and
Hide	marked .

Double-clicking	on	a	row	will	give	you	a	possibility	to	view	and	or	edit	the	data.

With	the	 Close 	button	(or	select	the	keyboard	shortcut	 Alt + C )	you	close	the	 Results 	window.	

Examples

Two	examples	from	using	real	data	with	this	tool:

The	warning	showed	'female	husband':	checking	the	data	I	found	a	family	with	father	:	Anna	Roelants.	Luckily	in	the	 Description
I	read:	The	marriage	of	Adam	Roelants	and	Cornelia	Crabbe.	It	was	clearly	a	typo:	Anna	i.s.o.	Adam.	Without	this	Tool	it	would	be
very	hard	to	find.

The	warning	showed	'late	marriage':	checking	the	data:	male	person	°1738	female	person	°1756	:	marriage	X	1804	[Gregorian
Calendar]	:	Everything	seemed	to	be	OK:	so	they	(re)married	at	the	age	of	66	and	48	years!	The	warning	showed	up	because	the
General	criteria	was	set	to	60.

See	Also

Development	discussion	on	Gramps	community	support	Discourse	forum:

Interest	in	enhancing	verify.py

Difference	between	 Verify	the	Data 	tool	and	the	Check	and	Repair	Database	tool

The	Check	and	Repair	Database	tool	detects	inconsistencies	in	the	database	structure.	The	 Verify	the
Data 	tool,	however,	is	detecting	the	records	that	do	not	satisfy	your	particular	criteria.

Debug

Warning	do	not	use	the	Debug	tools	on	your	working	Family	Tree

Always	create	a	new	empty	Family	Tree	or	a	copy	of	your	existing	Family	Tree	for	testing.
The	tools	available	in	this	advanced	menu	are	used	for	testing	only.

Fig.	14.39	"Tools	>Debug>..."	Menubar	-	Tools	-	Debug	menu
Overview

When	the	command	line:	Python	option	-O	optimise	flag	is	not	turned	on,	an	additional	Debug	entry	appears	in	the	Tools	menu	and	the	following
tools	are	available:

Check	Localized	Date	Displayer	and	Parser
Dump	Gender	Statistics
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Generate	Testcases	for	Persons	and	Families
Populate	Sources	and	Citations

Also	See:

Command	Line:	Python	options
Uncollected	Objects	Gramplet
Python	Evaluation	Gramplet

Check	Localized	Date	Displayer	and	Parser

Fig.	14.40	"Start	date	test?"	dialog	-	for	"Check	Localized	Date
Displayer	and	Parser"	-	Tool

This	test	tool	will	create	many	people	showing	all	different	date	variants	as	birth.	The	death	date	is	created	by	parsing	the	result	of	the	date
displayer	for	the	birth	date.	This	way	you	can	ensure	that	dates	printed	can	be	parsed	back	in	correctly.

You	will	be	shown	the	 Start	date	test? 	dialog	to	select	either	 Cancel 	to	exit	or	 Run	test 	to	start	the	tool.	

Dump	Gender	Statistics

Fig.	14.41	"Gender	Statistics	tool"	dialog	results	example	-	for
"Dump	Gender	Statistics"	-	Tool

The	"Gender	Statistics	tool"	dialog	will	show	the	results	in	list	about	the	statistics	for	the	gender	guessing	based	on	the	persons	first	name.

See	Gender	entry.	

Generate	Testcases	for	Persons	and	Families
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Fig.	14.42	"Generate	testcases"	dialog	-	for
"Generate	Testcases	for	Persons	and	Families"	-
Tool	-	default

The	testcase	generator	will	generate	some	persons	and	families	that	have	broken	links	in	the	database	or	data	that	is	in	conflict	to	a	relation.

The	 Undo	history	warning 	dialog	will	be	shown	and	you	can	either	 Stop 	or	 Proceed	with	the	tool .

You	can	generate	testcases	that	cause	the	following:

	 Generate	low	level	database	errors	Correction	needs	database	reload
	 Generate	database	errors
	 Generate	dummy	data
	 Generate	long	names
	 Add	special	characters
	 Add	serial	number
	 Add	line	break

Number	of	people	to	generate	(Number	is	approximate	because	families	are	generated)	2000(default)

Select	 Cancel 	to	exit	or	 OK 	to	start	the	tool.

Help 	will	bring	you	here.

Command	line	usage	see:	Plugins_Command_Line#Generate_Testcases_for_Persons_and_Families

Populate	Sources	and	Citations

Fig.	14.43	"Populate	sources	and	citations
tool"	dialog	-	default

This	tool	generates	sources	and	citations	for	each	source	in	order	to	populate	the	database	for	testing	with	significant	numbers	of	sources	and
citations.

Enter	the	required	number	and	then	select	 OK 	to	run	the	tool:

Number	of	sources: 	2	(default)
Number	of	citations: 	2	(default)
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Once	the	tool	is	complete	you	will	be	shown	the	 Data	generated 	alert	dialog.

Previous Index Next

Tools	-	Tools 315



Настройки

Пред Содержание След

Настройки
Большинство	настроек	Gramps	можно	изменить	в	форме	 Настройки .	Чтобы	вызвать	ее	выберите	пункт	меню	Правка	->Настройки....

Вкладки	в	верхней	части	формы	отображают	доступные	категории	настроек.

Рис.	13.1	Вкладки	в	форме	Настройки

Общие

Рис.	13.2	Общие	настройки

Эта	категория	содержит	настройки,	относящиеся	к	общей	работе	программы.

Добавлять	источник	при	импорте:	Эта	опция	влияет	на	импорт	данных.	Если	она	установлена,	каждый	импортируемый	элемент
будет	содержать	ссылку	на	файл-источник.

Внимание

Добавление	ссылки	на	источник	может	значительно	замедлить	импорт	данных.

Включить	проверку	правописания:	Эта	опция	управляет	возможностью	проверки	правописания	в	заметках.	Для	проверки
правописания	должен	быть	установлен	пакет	gtkspell.
Показывать	совет	дня:	Эта	опция	разрешает	или	запрещает	показывать	 Совет	дня 	во	время	запуска	Gramps.
Запоминать	последнюю	открытую	вкладку:	Эта	опция	разрешает	или	запрещает	показывать	последний	открытый	Вид.	Если	она
установлена	-	Gramps	после	запуска	будет	показывать	Вид,	с	которым	вы	работали	перед	закрытием	программы.
Максимальное	число	поколений	для	определения	родства:	Вы	можете	задать	максимальное	количество	поколений	для	определения
родства.	Значение	по	умолчанию	15.
Базовый	каталог	документов:	Здесь	вы	можете	задать	базовый	каталог	для	документов.	Нажатие	на	кнопку	 	откроет	форму
Выбрать	каталог	документов ,	где	вы	сможете	задать	требуемый	каталог.

Семейное	древо
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Рис.	13.3	Меню:	Правка>Настройки...	-	вкладка	"Семейное
древо"

Эта	вкладка	содержит	настройки	относящиеся	к	базе	данных	с	семейным	древом	и	управлению	резервным	копированием.

База	данных :
BSDDB	-	Legacy	Database	backend.
SQLite	(по	умолчанию)	-	DB-API	Database	Backend.
...	Если	установлены	другие	базы	данных,	то	они	тоже	появятся	в	списке,	например:	PostgreSQL.

Хост :	Адрес	сервера	или	IP	другого	компьютера	с	расположение	базы	данных.
Порт :	Номер	порта	для	доступа	к	базе	данных	сервера.
Путь	к	базе	данных	с	семейным	древом :	По	умолчанию	база	данных	хранится	в	ваша	домашняя
директория/.gramps/grampsdb.	Оставьте	эту	настройку	как	есть,	если	нет	абсолютной	уверенности	в	желании	изменить	этот	путь.
Путь	определяется	в	соответствии	Каталогом	пользователя	в	операционной	системе.

Автоматически	загружать	последнее	семейное	древо :	Этот	параметр	управляет	загрузкой	базы	данных,	с	которой	Вы
работали	в	последний	раз,	при	запуске	программы.
Каталог	для	резервного	копирования :	Каталог	в	который	будут	сохраняться	файлы	Gramps	при	выполнении	резервного
копирования.

Делать	резервную	копию	при	выходе :	При	выходе	из	программы	будет	создаваться	резервная	копия	в	указанном	выше
каталоге.
Автоматическое	резервное	копирование :

Никогда	(по	умолчанию)
Каждые	15	минут
Каждые	30	минут
Каждый	час

Смотрите	также:

Дополнение	PostgreSQL	-	для	включения	поддержки	PostgreSQL	баз	данных.

Отображение

Рис.	13.4	Настройки	отображения

Эта	категория	содержит	настройки,	которые	влияют	на	отображение	данных	и	имён.

Формат	имён:	Эта	настройка	управляет	отображением	имен.	В	Gramps	есть	две	группы	форматов	отображения	имён:
предопределенные	форматы	и	форматы,	заданные	пользователем.	Доступны	следующие	предопределенные	форматы:	Фамилия,
Имя	Суффикс;	Имя	Фамилия	Суффикс;	Имя	и	т.д.	При	нажатии	на	кнопку	 Редактировать... 	появляется	 Редактор
отображения	имён ,	в	котором	показан	список	доступных	форматов	и	примеры.	Если	вам	не	подходит	ни	один	из	существующих
форматов	-	создайте	новый.	Кнопка	 Добавить 	добавляет	новый	формат	в	список.	Нажав	на	эту	кнопку	вы	получите	новый	формат
Имя	Списокфо,	Суффикс	и	пример	отображения	имени:	Edwin	Jose	Smith	Weston	Wilson,	Sr.	После	добавления	нового	формата	в
список	становятся	доступны	кнопки	 Удалить 	и	 Изменить 	для	изменения	списка	форматов.
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Примечание

Кроме	общих	настроек	отображения	имен	Gramps	позволяет	выбрать	формат	отображения
индивидуально	для	каждого	имени	с	помощью	 Редактора	отображения	имён .

Рис.	13.5	Редактор	отображения	имен

Примечание

Пользовательские	форматы	отображения	имен	хранятся	в	базе	данных,	поэтому	до	загрузки
какой-либо	базы	информация	о	пользовательских	форматах	недоступна.

Формат	даты:	Эта	опция	управляет	отображением	дат.	Предлагается	несколько	различных	форматов	(например	YYYY-MM-DD
(ISO)),	которые	могут	зависеть	от	вашей	локали.

Календарь	в	отчетах:	Эта	настройка	управляет	отоображением	календаря	в	отчетах,	инструментах,	грамплетах,	видах.	Доступно
несколько	различных	календарей	(см.	Редактирование	дат).	Две	даты	в	двух	различных	календарях	будут	неправильно	отображать
периоды	(выбрав	Григорианский	календарь,	как	календарь	по	умолчанию,	пользователи	будут	иметь	более	понятное	представление
периодов.)

Угадывание	фамилий:	Эта	настройка	влияет	на	предлагаемую	фамилию	ребенка	при	добавлении	его	в	базу	данных.	Если	выбрано
Нет ,	фамилия	предлагаться	не	будет.	Если	выбрать	 Фамилию	отца ,	будет	предлагаться	фамилия	отца.	Если	выбрать
Комбинацию	фамилий	матери	и	отца ,	будет	предлагаться	фамилия,	состоящая	из	фамилий	отца	и	матери.	И,	наконец,	если
выбрать	 Исландский	стиль ,	будет	предлагаться	имя	отца	с	добавлением	суффикса	"ссон"	(т.е.	для	сына	Эдвина	будет
предложена	фамилия	Эдвинссон).

Совет

Эта	настройка	влияет	только	на	предлагаемую	фамилию	в	 Редакторе	лица ,	которую	Gramps
пытается	угадать.	Вы	можете	изменять	эту	фамилию	так,	как	считаете	нужным.	Установите	эту
настройку	в	значение,	которое	вы	чаще	всего	будете	использовать	и	это	сэкономит	вам	немного
времени	на	набор	текста.

Статусная	строка:	Эта	настройка	влияет	на	содержимое	статусной	строки.	Это	может	быть	имя	и	идентификатор	активного	лица,
либо	его	родственное	отношение	к	базовому	лицу.

Показывать	текст	на	кнопках	боковой	панели:	Эта	опция	влияет	на	отображение	текста	на	кнопках	боковой	панели.	Опция
применится	только	после	перезапуска	программы.

Текст
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Рис.	13.6	Текстовые	настройки

Эта	категория	содержит	настройки,	относящиеся	к	тому,	как	будут	отоображаться	отсутствующие	имена	или	приватные	записи.

Фамилия	отсутствует:	В	этом	поле	вы	можете	задать	как	будет	отображаться	отсутствующая	фамилия.	Значение	по	умолчанию
[Отсутствующая	Фамилия].	Вы	можете	поменять	его	на	[--]	или	любое	другое	на	ваше	усмотрение.
Имя	отсутствует:	В	этом	поле	вы	можете	задать	как	будет	отображаться	отсутствующее	имя.	Значение	по	умолчанию
[Отсутствующее	Имя].	Вы	можете	поменять	его	любое	другое	на	ваше	усмотрение.
Отсутствующая	запись
Приватная	фамилия
Приватное	имя
Приватная	запись

Форматы	ID

Рис.	13.7	Настройки	форматов	ID

Эта	категория	содержит	настройки,	влияющие	на	автоматическое	создание	идентификаторов	в	Gramps.

Лицо:	Задает	шаблон	для	идентификаторов	лиц.	Зачение	по	умолчанию:	I%04d.
Семья:	Задает	шаблон	для	идентификаторов	семей.	Зачение	по	умолчанию:	F%04d.
Место:	Задает	шаблон	для	идентификаторов	мест.	Зачение	по	умолчанию:	P%04d.
Источник:	Задает	шаблон	для	идентификаторов	источников.	Зачение	по	умолчанию:	S%04d.
Цитата:	Задает	шаблон	для	идентификаторов	цитат.	Зачение	по	умолчанию:	C%04d.
Документ:	Задает	шаблон	для	идентификаторов	документов.	Зачение	по	умолчанию:	O%04d.
Событие:	Задает	шаблон	для	идентификаторов	событий.	Зачение	по	умолчанию:	E%04d.
Хранилище:	Задает	шаблон	для	идентификаторов	хранилищ.	Зачение	по	умолчанию:	R%04d.
Заметка:	Задает	шаблон	для	идентификаторов	заметок.	Зачение	по	умолчанию:	N%04d.

Префиксы	идентификаторов

Префиксы	идентификаторов	используют	соглашения	по	форматированию	переменных	для	C,
Python	и	других	языков	программирования.	Например	%04d	раскрывается	в	целое	число,
дополненное	ведущими	нулями	до	4	цифр.	Если	вы	хотите	идентификаторы	вида	1,	2,	3	и	т.д.,
просто	поменяйте	шаблон	на	%d.

Даты
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Информация	в	этой	статье	или	некоторых	её	разделах	устарела.
Пожалуйста	помогите	улучшить	Gramps	Wiki,	исправив	и	дополнив	эту	статью.

Рис.	13.8	Настройки	дат

Исследователь

Рис.	13.9	Настройки	исследователя

Заполните	соответствующие	поля	вашими	персональными	данными.	Эта	информация	будет	использоваться	только	для	того,	чтобы
правильно	сформировать	файл	GEDCOM.	Для	создания	корректного	файла	GEDCOM	требуется	информация	о	создателе.	Можете
оставить	эти	поля	пустыми,	но	тогда	при	экспорте	у	вас	будут	создаваться	некорректные	файлы	GEDCOM.

Доступны	следующие	поля:

Имя:
Адрес:
Местность:
Город:
Область/Район/Уезд:
Государство/Страна:
Индекс/Почтовый	код:
Телефон:
Электронная	почта:

Информация	из	этих	полей	используется	как	значения	по	умолчанию	для	параметров	семейного	древа,	которые	можно	изменить	с
помощью	инструмента	Редактирование	информации	о	владельце	базы	данных.

Предупреждения

Рис.	13.10	Настройки	предупреждений

Эта	категория	управляет	отображением	окон	с	предупреждениями,	позволяя	повторно	включать	те,	которые	ранее	были	отключены.

Не	показывать	предупреждение	при	добавлении	родителей	к	ребенку.
Не	показывать	предупреждение	при	отмене	измененных	данных.
Не	показывать	предупреждение	об	отсутствии	информации	об	исследователе	при	экспорте	в	GEDCOM.
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Показывать	статус	модулей	при	ошибках	загрузки.

Цвета

Рис.	13.11	Вкладка	с	настройкой	цветов

Эта	вкладка	позволяет	выбрать	цвета	объектов	в	видах	с	графическим	отображением.

Вы	можете	выбрать

Цветовая	схема: 	Светлые	цвета(по	умолчанию)	or	Тёмные	цвета
Восстановить	цвета	по	умолчанию 	-	устанавливает	стандартные	цвета	для	текущей	схемы.

Цвета	для	мужчин
Цвета	для	женщин
Цвета	для	лиц	неизвестного	пола
Цвета	для	семей
Другие	цвета

Диалог	выбора	цвета

Рис.	13.12	Выбор	цвета

Выберите	цвет	из	палитры	или	используйте	 Другой ,	кнопка	 + 	позволяет	создать	свой	цвет,	как	по	'Hex	коду',	так	и	с	помощью
ползунков	или	мышм.	

Другие	настройки
Кроме	формы	 Настройки ,	в	Gramps	есть	и	другие	возможности	настраивать	программу.	По	разным	причинам	для	улучшения
доступности	их	вынесли	из	общей	формы.

Редактор	колонок
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Рис.	13.13	Редактор	колонок

Колонки	в	списках	можно	добавлять,	удалять	или	менять	их	порядок	с	помощью	 Редактора	колонок .	В	списке	будут	отображаться
только	отмеченые	колонки.	Чтобы	поменять	их	порядок,	переместите	колонку	на	новое	место	внутри	редактора	с	помощью	мыши.
Нажатие	на	кнопку	 Применить 	немедленно	отразит	изменения.	Чтобы	вызвать	 Редактор	колонок ,	выберите	в	меню	пункт	Вид-
>Настроить	вид...	или	нажмите	на	кнопку	 Настроить	вид... 	на	панели	инструментов.

Редактор	колонок

Редактор	колонок 	доступен	и	одинаково	воздействует	на	все	виды	со	списками.	А	именно,	он
доступен	для	вида	Люди,	Семьи	(список	детей),	Источники,	Цитаты,	Места,	Альбом,	Хранилища
и	Заметки.

Установка	базового	лица

Чтобы	установить	базовое	лицо,	перейдите	в	вид	Люди,	сделайте	активным	в	списке	лиц	нужного	человека	и	затем	выберите	пункт	меню
Правка	->Установить	базовое	лицо.

Рис.	13.14	Меню	Установить	базовое	лицо

Базовое	лицо	это	человек,	который	становится	активным	в	следующих	случаях:

при	открытии	семейного	древа
при	нажатии	на	кнопку	 Домой 	на	панели	инструментов
выбран	пункт	меню	Домой	или	через	меню	Переход,	или	через	контекстное	меню
используется	быстрая	комбинация	клавиш	 ALT + Home

Кнопка	 Домой 	на	панели	инструментов	доступна	для	видов	Люди,	Отношения	и	Родословная.

Установка	базового	лица
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Настройка	панелей

Показывать	или	нет	панель	инструментов,	боковую	панель,	панель	фильтра	(не	доступна	в	видах	Родословная	и	Отношения),
расположенные	на	главном	окне,	настраиваются	через	меню	Вид.

При	выборе	меню	 Вид 	появится	список	флажков,	которыми	можно	помечать	отображаемые	панели:

Навигатор
Панель	инструментов
Боковая	панель
Нижняя	панель
Полноэкранный	режим	 F11

Дополнительно,	в	зависимости	от	текущего	Вида,	будут	доступны	другие	настройки.

Люди:
Список	лиц
Дерево	фамилий

Родословная
Родословная
Граф
Линейка	времени
Веерная	карта

Места
Вид	"Места"
Вид	"Иерархия	мест"

Места
Семья
Лицо
События
Места

Источники
Источники
Дерево	цитат

Для	некоторых	видов	так	же	доступен	редактор	колонок.

Экспортировать	вид...

Fig.	13.15	Экспорт	в	формат	ODS

Для	большинства	видов	отображаемые	на	экране	данные	можно	экспортировать	с	помощью	пункта	меню	Семейные	древеса	-
>Экспортировать	вид....

Gramps	экспортирует	данные	с	экрана	в	выбранный	формат:	CSV	или	табрица	Open	Document	(ODS).

Для	примера	показан	экспорт	в	формат	ODS.

Это	такая	же	мощная	функция	(без	ограничений),	как	и	отчеты.

Модули

Начиная	с	версии	3.2	виды	-	это	модули	для	Gramps.

Gramps	стал	более	гибким.

Смотрите	Управление	модулями	и	Дополнения.
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Рис.	13.16	Управление	модулями

Рис.	13.17	Возможность	скрыть	модули

Редактор	стилей

При	выборе	отчета	для	формирования	в	верхней	части	появившейся	формы	вы	увидите	раздел	с	настройками,	специфичными	для	разных
типов	отчетов,	а	в	нижней	части	-	раздел	 Параметры	документа .	В	выпадающем	списке	вы	можете	выбрать	стиль	отчета.	Вы	так	же
можете	создать	свой	собственный	стиль,	нажав	на	кнопку	 Редактор	стилей... .

Если	вы	нажмете	кнопку	создания	нового	стиля,	появится	окно	с	полем	 Название	стиля .	Вы	можете	присвоить	своему	стилю	разумное
название.

С	левой	стороны	вы	увидите	раздел	 Абзац .	Этот	раздел	специфичный	для	каждого	отчета	и	содержит	список	абзацев.

В	примере	показаны	абзацы	для	отчета	 Таблица	предков :	AHN-Entry,	AHN-Generation	и	AHN-Title.

С	правой	стороны	имеются	три	вкладки:

Описание:	Содержит	описание	абзаца.
Параметры	шрифта:	Здесь	вы	можете	указать	 Стиль	шрифта 	Римский	или	Швейцарский,	 Размер 	в	пунктах,	 Цвет 	и	другие
Параметры 	шрифта	(Жирный,	Курсив,	Подчеркнутый).
Параметры	абзаца:	Здесь	указывается	 Выравнивание ,	 Цвет	фона ,	 Интервал ,	 Отступ 	и	 Поля 	вашего	стиля.

После	всех	изменений	вы	можете	сохранить	ваш	новый	стиль,	нажав	кнопку	 OK 	или	отменить	изменения,	нажав	 Отмена .

Рис.	13.18	Подсвечена	место
Редактора	стилей	в	секции
Параметров	документа
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Рис.	13.19	Описание	стиля

Рис.	13.20	Параметры	шрифта

Рис.	13.21	Параметры	абзаца

Файл	gramps.ini

Предупреждение

Содержимое	этого	раздела	выходит	за	рамки	интересов	обычного	пользователя	Gramps.	Если	вы
изменяете	настройки	на	низком	уровне,	вы	можете	повредить	Gramps.	Будте	осторожны.	ВАС
ПРЕДУПРЕДИЛИ!

Настройки	-	Файл	gramps.ini 325

http://www.gramps-project.org/wiki/index.php/File:Style-editor-dialog-description-options-tab-example-42.png
http://www.gramps-project.org/wiki/index.php/File:Style-editor-dialog-font-options-tab-example-42.png
http://www.gramps-project.org/wiki/index.php/File:Style-editor-dialog-paragraph-options-tab-example-42.png
http://www.gramps-project.org/wiki/index.php/File:Gnome-important.png


Рис.	13.22	Файл	gramps.ini

Для	управления	пользовательскими	настройками	Gramps	6.0	использует	ключи	INI,	которые	хранятся	в	файле	gramps.ini	в	папке	.gramps.

Список	ключей	разбит	на	подразделы:

behavior:	в	нем	используются	ключи	:	betawarn,	enable-autobackup,	use-tips...
export:	директории	экспорта	и	импорта
interface:	множество	ключей,	влияющие	на	различные	Виды:	например	event-height:	450,	event-ref-height:	585,	event-ref-width:	728,
event-width:	712...
paths:	ключи,	относящиеся	к	последним	импортированным	файлам	и	каталогам
preferences:	ключи,	относящиеся	к	настройкам:	форматы	идентификаторов,	todo-color...
researcher:	вся	информация	об	исследователе.

Редактор	форматов	имен

Информация	в	этой	статье	или	некоторых	её	разделах	устарела.
Пожалуйста	помогите	улучшить	Gramps	Wiki,	исправив	и	дополнив	эту	статью.

C	помощью	этого	редактора	редактируются	и	создаются	новые	форматы	имен.

Название	формата:	Названием	может	быть	любая	строка,	оно	используется	только	для	того,	чтобы	отличить	формат	от	других	в
списке.
Определение	формата:	Здесь	определяется	формат,	используя	специальные	символы	форматирования.	Перед	и	после	этих	символов
можно	вставлять	любые	другие	символы	и	строки.	Например	"(%t)	%L,	%f"	отформатируется	как	"(Dr.)	SMITH,	Edwin".

Символы	форматирования:

align="center"
Символ Имя СИМВОЛ ИМЯ
%f Given	Name %F GIVEN	NAME
%l Surname %L SURNAME
%t Title %T TITLE
%p Prefix %P- PREFIX
%s- Suffix %S SUFFIX
%c Call	name %C CALL	NAME
%y Patronymic %Y PATRONYMIC

Пример:	Показан	динамический	пример,	как	имя	будет	отображено	в	соответствии	с	текущим	 Определение	формата .
Подробности	определения	формата:	Показана	небольшая	памятка	с	описанием	символов	форматирования.

Пред Содержание След
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Фильтры

Пред Содержание След

Этот	документ	содержит	список	всех	правил	для	фильтров	в	Gramps.	Каждое	из	этих	правил	может	использоваться	для	создания	своих
фильтров,	смотрите	Custom	filter.	Правила	разбиты	по	категориям.

Фильтры	и	Поиск
Есть	два	механизма	искать	данные	в	Gramps:	Поиск	и	Фильтр.	Поля	для	поиска	находятся	на	верхней	панели	над	списком	элементов
активного	Вида	(Люди,	Семьи	и	т.д.).	Фильтры	могут	быть	использованы	совместно	с	поиском	или	отдельно	через	боковую/нижнюю
панель.	Верхняя	панель	поиска	появляется	только	если	закрыты	все	боковые	панели.	Вы	можете	открывать/закрывать	панели	через	меню
->	Вид.

Поиск	и	Фильтр	работают	совершенно	по	разному	и	важно	понять	эти	различия:

Поиск	-	функция	поиска	просматривает	базу	данных	в	том	виде,	в	каком	данные	отображаеются	на	экране.	Например,	если	в	ваших
настройках	указано	отображать	имена	в	виде	"Фамилия,	Имя"	и	вы	ищете	"Петров,	Иван",	то	найдутся	все	соответствующие	строки.
Если	вы	меняете	способ	отображения	имен	в	настройках,	вам	придется	изменить	и	критерий	поиска	(рапример	"Иван	Петров").
Поиск	используется	чаще	всего,	как	наиболее	простой	и	доступный,	но	он	имееет	ряд	ограничений	(смотрите	далее).

Фильтр	-	фильтры	используют	более	сложную	систему.	Они	не	ограничены	тем,	что	отображается	на	экране	и	просматривают
фактические	данные	в	базе.	Фильтр	по	имени	будет	пытаться	найти	соответствие	во	всех	полях	имени	(имя,	фамилия,	отчество	и
т.д.)	всех	имен	лица	(предпочитаемых	и	альтернативных),	но	только	по	одному	полю	-	вы	не	можете	искать	и	имя,	и	фамилию	в
одном	запросе.	Вы	можете	искать	фамилию,	но	не	фамилию	и	имя	одновременно.	Например,	если	значение	фильтра	по	имени	будет
"Иван",	найдутся	не	только	лица	с	именем	Иван,	но	и	с	фамилией	Иванов.	Но	вы	не	сможете	отфильтровать	записи	по	комбинации
имени	и	фамилии.

Создавать	и	управлять	фильтрами	можно	через	меню	Правка	->	Редактор	фильтров	или	через	специальную	боковую/нижнюю	панель.
Панель	Фильтр	предоставляет	несколько	быстрых	фильтров,	которые	похожи	на	Поиск	из	верхней	панели,	но	имеют	описанные	здесь
отличия.

Некоторые	из	отличий:

Фильтры	ищут	ещё	и	в	альтернативных	именах;	Поиск	-	только	в	предпочитаемых	(которые	отображаются).	Поэтому	на	фильтр
"Петров"	вы	можете	получить	лицо	казалось	бы	не	соответствующее	поиску.	Но	если	открыть	поднобности	этого	лица,	то	вы
увидите,	что	у	него	есть	альтернативное	имя	"Петров".
Фильтры	используют	регулярные	выражения.	Вы	можете	искать	все	имена,	начинающиеся	на	"П"	и	кончающиеся	на	"ов":	"П.*ов".
Вы	не	сможете	сделать	то	же	самое	в	панели	Поиск.
Поиск	ищет	только	то,	что	отображается.	Если	имя	или	текст	слишком	большие	для	отображения,	вы	не	сможете	их	найти.	Это
необходимо	иметь	в	виду	при	поиске	по	заметкам.	Заметки	и	другие	длинные	текстовые	поля	лучше	всего	искать	с	помощью
фильтров.
Все	фильтры	не	зависят	от	регистра;	"Петров"	то	же	самое,	что	и	"петров",	"ПЕТРОВ"	или	"ПеТров".

Подробнее	о	создании	фильтров	смотрите	на	странице	Example	filters.

Далее	будут	детально	описаны	возможности	фильтров.

Регулярные	выражения
Регулярные	выражения	это	быстрый	и	мощный	способ	описать	текст,	который	соответствует	шаблону.	Регулярные	выражения
используются	в	фильтрах	Gramps.	У	вас	должна	быть	включена	опция	 [	] Использовать	регулярные	выражения .

Например,	если	вы	ищете	фамилию,	которая	начинается	на	"П"	и	заканчивается	на	"ов",	для	описания	шаблона	вы	должны	использовать
регулярное	выражение.	Оно	должно	быть	^П.*ов:

^П	означает,	что	текст	должен	начинаться	с	П
.	означает	любой	символ	(буква,	цифра	или	еще	что-нибудь)
*	означает	ноль	или	больше	повторений	предыдущего	(в	нашем	случае,	любого	символа)
ов	задает	оставшиеся	символы	в	порядке	о,	в.

Регулярные	выражения	универсальны	и	имеют	много	опций.	Мы	используем	систему	регулярных	выражений	Python,	которая
описывается	ниже.	Вы	можете	использовать	любые	дополнительные	ресурсы	о	регулярных	выражениях	Python.

пробельные	символы	-	термин	"пробельные	символы"	используется	для	описания	одного	или	больше	непечатаемых	символов.	Например,
пробельные	символы	включают	в	сябя	табуляции,	пробелы	и	переводы	строк.

Некоторые	символы	в	регулярных	выражениях	имеют	специальное	значение.	К	ним	относятся:

.	^	$	*	+	?	{	}	[	]	\	|	(	)

Использование	специальных	символов:

'.'	соответствует	любому	символу	(буква,	цифра	или	еще	что-нибудь)
'^'	соответствует	началу	текста
'$'	соответствует	окончанию	текста
'*'	соответствует	нулю	или	более	повторений	предыдущего	элемента
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'+'	соответствует	одному	или	более	повторений	предыдущего	элемента
'?'	соответствует	нулю	или	одному	предыдущему	элементу	(делает	элемент	не	обязательным)
'{'	-	определяет	набор	соответствий
'}'	-	заканчивает	набор	соответствий
'['	-	начало	набора
']'	-	окончание	набора
'\'	-	следующий	символ	задает	специальную	последовательность
'|'	-	или
'('	-	начало	группы
')'	-	окончание	группы

Некоторые	специальные	последовательности,	начинающиеся	с	'\'	представляют	собой	полезные	наборы	символов,	такие	как	цифры,
буквы	или	любые	печатаемые	символы.	Далее	приводится	перечень	доступных	наборов.

\d	определяет	любые	десятичные	цифры;	эквивалентно	классу	[0-9].
\D	определяет	любые	символы,	кроме	десятичный	цифр;	эквивалентно	классу	[^0-9].
\s	определяет	любой	пробельный	символ;	эквивалентно	классу	[	\t\n\r\f\v].
\S	определяет	любой	не	пробельный	символ;	эквивалентно	классу	[^	\t\n\r\f\v].
\w	определяет	любой	цифро-буквенный	символ;	эквивалентно	классу	[a-zA-Z0-9_].
\W	определяет	любой	не	цифро-буквенный	символ;	эквивалентно	классу[^a-zA-Z0-9_].

Есть	более	сложные	квалификаторы	повторений	-	{m,n},	где	m	и	n	-	десятичные	числа.	Этот	квалификатор	означает	не	менее	m	и	не	более
n	повторений.

Группы	и	наборы

Группы	обозначаются	символами	'('	и	')'.	Эти	скобки	имеют	такое	же	значение,	как	и	в	математических	выражениях;	они	группируют
выражения	внутри	них	и	вы	можете	применять	к	содержимому	групп	квалификаторы	повторений,	такие	как	*,	+,	?,	или	{m,n}.	Например
(ab)*	будет	определять	ноль	или	более	повторений	ab.

Наборы	обозначаются	символами	'['	and	']'.

Можно	представить	группу,	как	список	альтернатив,	разделенных	символом	'|',	где	каждый	элемент	состоит	из	нуля,	одного	или
нескольких	символов,	а	набор	как	список	альтернатив,	где	каждый	элемент	состоит	из	одного	символа.

Примеры

^B.*ship$	-	определяет	любую	строку,	которая	начинается	на	'B',	далее	любые	символы	и	заканчивается	на	'ship'.
подходит:	Blankenship,	Blueship,	Beeship
не	подходит:	Blankenships

^B.*ship	-	определяет	все	строки,	которые	начинаются	на	'B',	далее	любые	символы,	далее	'ship'	(делее	может	быть	еще	что-нибудь).
подходит:	Blankenship,	Blankenships,	Blueship,	Blueshipman,	Beeship,	Beeshipness
не	подходит:	Blankenschips

Обычные	варианты	фамилий

пример	1:

Erikson	Eriksson	Ericson	Ericsson	Erickson	Ericksson	Erichson	Erichsson

определяется	выражением

		Eri(ch|ck|k|c)(ss|s)on

объяснение:

Eri	=	Eri

(ch|ck|k|c)	=	группа	ch,	ck,	k	или	c.	Более	длинные	помещаются	вперед.

(ss|s)	=	группа	ss	или	s.	Более	длинные	помещаются	вперед.

on	=	on

пример	2:

Bainbricke	Bainbridge	Bainbrig	Bainbrigg	Bambridge	Banbrig	Banbrige	Baynbrige

определяется	выражением

		Ba(in|yn|m|n)bri(dge|cke|g(g|e|))

объяснение:
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Ba	=	Ba

(in|yn|m|n)	=	группа	in,	yn,	m	или	n.	Более	длинные	помещаются	вперед.

bri	=	bri

(dge|cke|g(g|e|))	=	группа	dge,	cke	или	(g	вместе	с	g,	g	вместе	с	e	или	просто	g)

пример	3:

nairaud	nairault	naireaud	nayrault	nesrau	nesrault	nesreau	nesreaud	noirau	noiraud	noirauld	noirault	noiraut	noiraux	noireau	noireaud	noireault
noireaut	noirraux	noirreau	noirreaud	nouarault	noyraud	noyrault

определяется	выражением

	n(es|oua|oai|o[iya]|a[iy])r(r|)(on|((e|)au(x|t|d|lt|)))

объяснение:

n	=	n

(es|oua|oai|набор1|набор2)	=	группа	es,	oua,	oai,	набор1	или	набор2

набор1	-	o[iya]	=	набор	o	И	i,	y	или	a.	Другими	словами	oi,	oy	или	oa

набор2	-	a[iy]	=	набор	a	AND	i	or	y.	Другими	словами	ai	или	ay

r	=	r

(r|)	=	группа	r	или	ничего	(on|(подгруппа1)	=	группа	on	или	подгруппа1.

подгруппа1	это	группа	(подгруппа2	au	подгруппа3)

подгруппа2	это	(e|)	=	группа	e	или	ничего

au	=	au

подгруппа3	это	(x|t|d|lt)	=	группа	x,	t,	d	или	lt

Проверка	регулярных	выражений

Тестеры	регулярных	выражение	могут	быть	найдены	в	интернете	с	помощью	Google.	http://gskinner.com/RegExr/	-	простой	и	удобный

Редактор	фильтров
В	большинстве	случаев	вы	сможете	осуществлять	выбор	лиц,	событий,	мест	и	т.д.	просто	используя	боковую	панель	Фильтр	в	Видах
Люди,	События,	Места	и	т.д.	Обратите	внимание,	что	опция	'Использовать	регулярные	выражения'	работает	только	с	некоторыми
полями	(не	со	всеми).

Если	панель	Фильтр	не	удовлетворяет	ваших	потребностей,	придется	создавать	свои	фильтры.

Перенос	правил

Чтобы	избежать	неожиданных	эффектов	от	обновления	Gramps	(например	с	версии	3.2.x	на
версию	6.0.x),	при	необходимости	вы	можете	вручную	скопировать	файл	custom_filter.xml	из
Gramps	User	Directory	в	gramps_номер_версии.
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Рис.	14.1	Создание	фильтра

Рис.	14.2	Создание	фильтра

Редактор	фильтров	позволяет	создавать	фильтры,	которые	можно	использовать	при	создании	отчетов,	экспорте,	инструментах.	Это
действительно	мощное	средство	для	генеалогического	анализа.

После	запуска	редактора	фильтров	появляется	форма	 Фильтры	людей	(семей,	событий	и	т.д.) 	со	списком	фильтров,	которые	вы
создали	ранее.	Нажмите	кнопку	 + 	чтобы	создать	новый	фильтр.	После	создания	вы	можете	редактировать,	тестировать	или	удалить
выбранные	фильтры	используя	кнопки	 Редактировать... 	,	 Тестировать... 	и	 - 	соответственно.	Все	фильтры,	отображаемые	в
списке,	автоматически	сохранятся	в	вашей	базе	данных	и	будут	доступны	в	последующих	сессиях	Gramps.

Изменения	в	фильтрах

Изменения	в	фильтрах	вступят	в	силу	только	после	закрытия	окна	Фильтры	кнопкой	 Закрыть

Нажатие	на	кнопку	 + 	вызывает	форму	 Определить	фильтр 	(Рис.11.1)

В	поле	 Имя 	введите	название	вашего	фильтра.

В	поле	 Комментарий 	введите	описание,	которое	поможет	отличать	ваш	фильтр	от	других.	Добавьте	в	 Список	правил 	привила,
используя	кнопку	 + .	Если	у	фильтра	больше	одного	правила,	выберите	из	списка	 Параметры 	одну	из	операций	объединения	правил.
Эти	операции	позволяют	вам	выбрать	для	срабатывания	фильтра	будут	ли	выполняться	все	правила,	будет	выполтяться	хотя	бы	одно
правило	или	должно	выполняться	ровно	одно	правило.	Если	в	вашем	фильтре	только	одно	правило,	эти	операции	не	применяются.

Поставьте	галочу	 Возвращать	значения,	не	удовлетворяющие	правилам	фильтра ,	чтобы	инвертировать	правила.	Например,
после	инвертирования	правила	"имеет	общего	предка	с	лицом	I1"	будут	выбраны	все,	у	кого	нет	общих	предков	с	указанным	лицом.

Нажатие	на	кнопку	 + 	вызывает	форму	 Добавить	правило 	(Рис.11.2):

Фильтры	-	Редактор	фильтров 330

http://www.gramps-project.org/wiki/index.php/File:Define-filter-dialog-custom-filters-example-41.png
http://www.gramps-project.org/wiki/index.php/File:FilterSidebar-DefineFilterEditor-40.png
http://www.gramps-project.org/wiki/index.php/File:Gramps-notes.png


Рис.	14.3	Добавить	правило

В	левой	части	формы	отображаются	доступные	правила	для	фильтров,	разбитые	на	котегории	в	виде	дерева.	Чтобы	получить	детальное
описание	привила	нажмите	кнопку	 Справка .	Стрелки	вправо/влево	позволяют	развернут/свернуть	соответствующую	категорию.
Выберите	правило	из	списка	нажатием	на	его	название.	В	правой	части	окна	отобразится	название,	описание	и	список	значений
выбранного	правила.	После	выбора	правила	и	заполнения	его	значений	нажатие	на	кнопку	 OK 	добавит	правило	в	список	правил
редактируемого	фильтра.	Нажатие	на	кнопку	 Отменить 	просто	вернет	вас	к	редактированию	фильтра.

Совет

Ранее	созданный	фильтр	может	быть	использован	как	правило	для	другого	фильтра.	Это	дает	вам
бесконечную	гибкость	в	выборе	критериев	фильтрации,	которые	впоследствии	могут	быть
использованы	в	большинстве	отчетов,	при	экспорте	и	для	некоторых	инструментов	(таких	как
сравнение	отдельных	событий).

Фильтры	и	Виды
В	зависимости	от	используемого	Вида,	вам	доступны	различные	наборы	фильтров.

Грамплеты
фильтры	не	доступны

Люди,	Отношения,	Семьи
Фильтры	предков,	Фильтры	потомков,	Семейные	фильтры,	Общие	фильтры,	Фильтры	событий	и	Фильтры	отношений.

События,	Источники,	Цитаты,	Альбом,	Хранилища	и	Заметки
только	Общие	фильтры.	Фильтры,	специфичные	для	конкретного	Вида:	в	Виде	Альбом	можно	только	сортировать	и	искать
мадиа-объекты.

Места
Общие	фильтры	и	Фильтры	позиционирования.

Общие	фильтры

Люди,	Отношения	и	Семьи

Эта	категория	включает	следующие	правила:

Лица	в	списке	закладок
Выбирает	людей	из	списка	закладок.

Базовое	лицо
Выбирает	базовое	лицо.

Несвязанные	лица
Выбирает	людей,	не	имеющих	семейных	связей	ни	с	одним	лицом	из	базы	данных.

Все
Выбирает	всех	людей	из	базы	данных.

Женщины
Вибирает	всех	женщин.

Мужчины
Выбирает	всех	мужчин.

Лица,	у	которых	<число>	заметок
Выбирает	людей	с	определенным	количеством	заметок:	Значения:	Число	заметок	--	Число	должно	быть	больше
чем/меньше/равно	значению.

Лица	с	заметками,	содержащими	<регулярное	выражение>
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Выбирает	людей,	у	которых	текст	заметки	удовлетворяет	регулярному	выражению.	Значения:	Регулярное	выражение.

Лаца	с	заметками,	содержащими	<подстроку>
Выбирает	людей,	у	которых	текст	заметки	содержит	подстроку.	Значения:	Подстрока

Лица	с	флагом	"личная	запись"
Выбирает	людей,	помеченых	флагом	"личная	запись".

Лица,	соответствующие	<фильтру>
Выбирает	людей,	удовлетворяющих	фильтру	с	указанным	названием.	Значения:	Название	фильтра.	Название	фильтра	должно
быть	выбрано	через	меню.

Лица,	которые	вероятно	живы
Выбирает	людей	без	информации	о	смерти	с	не	слишком	большим	возрастом.	Значения:	На	указанную	дату

Лица	с	<id>,	удовлетворяющему	регулярному	выражению
Выбирает	лиц,	чей	идентификатор	в	Gramps	удовлетворяет	регулярному	выражению.	Значения:	Регулярное	выражение.

Лица	с	<числом>	событий	СПД
Выбирает	людей	с	определенным	количеством	собыдий	церкви	СПД.	Значения:	Число	событий	--	Число	должно	быть	больше
чем/меньше/равно	значению.

Лица	с	<числом>	адресов
Выбирает	людей	с	определенным	количеством	адресов.	Значения:	Число	адресов	--	Число	должно	быть	больше
чем/меньше/равно	значению.

Лица	с	<числом>	связей
Выбирает	людей	с	определенным	количеством	связей.	Значения:	Число	связей	--	Число	должно	быть	больше
чем/меньше/равно	значению.

Лица	с	<числом>	документов
Выбитает	людей	с	определенным	количеством	документов	в	галерее.	Значения:	Число	документов	--	Число	должно	быть
больше	чем/меньше/равно	значению.

Лица	с	<числом>	источников
Выбирает	людей	с	определенным	количеством	источников.	Значения:	Число	источников	--	Число	должно	быть	больше
чем/меньше/равно	значению.

Лица	с	<меткой>
Выбирает	людей	с	определенной	меткой.	Значение:	Название	метки.

Лица	с	законченными	записями
Выбирает	людей,	чьи	записи	помечены	как	законченные.

Лица	с	неполными	именами
Выбирает	людей	с	отсутствующими	именем	или	фамилией.

Лица	с	записями,	содержащими	<подстроку>
Выбирает	людей,	данные	которых	содержат	подстроку.	Значения:	Подстрока	--	Учитывать	регистр	--	Использовать
регулярные	выражения

Лица	с	<именем>
Выбирает	людей	с	указанным	именем.	Значения:	Имя	--	Фамилия	--	Суффикс	--	Титул	--	Префикс	--	Отчество	--	Имя	в	быту

Лица	с	<источником>
Выбирает	людей,	ссылающихся	на	данный	источник.	Значения:	Идентификатор	источника.

Лица	с	семейным	<атрибутом>
Выбитает	людей	с	определенным	значением	семейного	атрибута.	Значения:	Название	атрибута	--	Значение	атрибута.

Лица	с	личным	<атрибутом>
Выбирает	людей	с	определенным	значением	личного	атрибута.	Значения:	Название	атрибута	--	Значение	атрибута.

Лица	с	неизвестным	полом
Выбирает	людей,	пол	которых	неизвестен.

Лица	без	даты	рождения
Выбирает	людей,	дата	рождения	который	неизвестна.

Лица	с	<id>
Выбирает	людей	с	определенным	идентификатором	Gramps.	Правило	сработает	только	при	совпадении	идентификатора.	Вы
можете	либо	ввести	идентификатор	в	поле	ввода,	либо	выбрать,	нажав	на	кропку	 Выбор... .	В	этом	случае	идентификатор
появится	в	поле	ввода	после	завершения	выбора.

Лица,	измененные	после	<дата	время>
Выбитает	людей,	чьи	данные	были	изменены	после	определенной	даты	или,	если	задана	вторая	дата,	между	двумя	датами:
Значения:	изменения	после:	--	но	перед:.

Лица	с	событиями,	соответствующими	<фильтру>
Выбирает	людей,	у	которых	происходили	события,	соответствующие	фильтру	событий.	Значения:	Название	фильтра	событий.
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Фильтры	Лиц
Имеет	адрес

Выбирает	людей,	у	которых	есть	адрес.

Имеет	связь
Выбирает	людей,	у	которых	имеется	связью.

Имеет	законченую	запись
Выбирает	людей,	чьи	записи	помечены	как	законченные.	В	настоящее	время	законченность	персональной	информации
помечается	вручную	в	форме	 Редактор	Лица .

Имеет	имя
Выбирает	людей,	чье	имя	соответствует	определенному	значению	полностью	или	частично.	Например,	Маша	Иванова	будет
выбрано	правилом	по	значению	"иван"	для	фамилии.	Отдельные	значению	можно	задать	для	имени,	фамилии,	суффикса	и
титула.	Правило	сработает	только	если	все	не	пустые	значению	подойдут	имени	лица.	Чтобы	использовать	только	одно
значение	оставьте	остальные	пустыми.

Базовое	лицо
Выбирается	если	человек	является	базовым	лицом.

Женщина
Выбирает	женщин.

Мужчина
Выбирает	мужчин.

Лица,	которые	вероятно	живы
Выбирает	людей	без	информации	о	смерти	с	не	слишком	большим	возрастом,	судя	по	известной	дате	рождения	и	текущей
дате.

Лица	с	неполными	именами
Выбирает	людей	с	отсутствующими	именем	или	фамилией.

Лица	без	даты	рождения
Выбирает	людей,	дата	рождения	который	неизвестна.

Фильтры	событий
Эта	категория	содержит	правила,	которые	вибирают	людей	на	основании	их	событий:

Имеет	событие	рождения
Это	правило	выбирает	людей,	у	которых	событие	рождения	подходит	по	дате,	месту	или	описанию.	Правило	сработает,	если
событие	рождения	подходит	частично.	Правило	не	чувствительно	к	регистру	символов.	Например,	все,	кто	родился	в	России
подойдут	по	значению	"рос"	для	места.	Правило	сработает	только	если	все	не	пустые	значения	подойдут	событию	рождению
лица.	Чтобы	использовать	только	одно	значение	оставьте	остальные	пустыми.

Имеет	событие	смерти
Это	правило	выбирает	людей,	у	которых	событие	смерти	подходит	по	дате,	месту	или	описанию.	Правило	сработает,	если
событие	смерти	подходит	частично.	Правило	не	чувствительно	к	регистру	символов.	Например,	все,	кто	умер	в	России
подойдут	по	значению	"рос"	для	места.	Правило	сработает	только	если	все	не	пустые	значения	подойдут	событию	смерти
лица.	Чтобы	использовать	только	одно	значение	оставьте	остальные	пустыми.

Имеет	личное	событие
Это	правило	выбирает	людей,	которые	имеют	личное	событие,	подходящее	по	типу	события,	дате,	месту	и	описанию.
Правило	сработает,	если	личное	событие	подходит	частично.	Правило	не	чувствительно	к	регистру	символов.	Например,	все,
кто	учился	в	России	подойдут	по	значению	"рос"	для	места.	Правило	сработает	только	если	все	не	пустые	значения	подойдут
событию	лица.	Чтобы	использовать	только	одно	значение	оставьте	остальные	пустыми.

Имеет	семейное	событие
Это	правило	выбирает	людей,	которые	имеют	семейное	событие,	подходящее	по	типу	события,	дате,	месту	и	описанию.
Правило	сработает,	если	семейное	событие	подходит	частично.	Правило	не	чувствительно	к	регистру	символов.	Например,
все,	кто	женился	в	России	подойдут	по	значению	"рос"	для	места.	Правило	сработает	только	если	все	не	пустые	значения
подойдут	событию	лица.	Чтобы	использовать	только	одно	значение	оставьте	остальные	пустыми.

Свидетель
Это	правило	выбирает	людей,	кто	присутствовал	во	время	события	как	свидетель.	Если	задается	тип	событий:	личные	или
семейные,	будут	выбраны	только	события	такого	типа.

Лица	с	незаконченными	событиями
Это	правило	выбирает	людей	с	отсутствующей	датой	или	местом	в	личных	событиях.

Семьи	с	незаконченными	событиями
Это	правило	выбирает	людей	с	отсутсвующей	датой	или	местом	в	семейных	событиях	в	любой	из	их	семей.

Семейные	фильтры
Эта	категория	включает	правила,	которые	выбирают	людей	на	оснавании	их	семейных	отношений:
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Лица	с	детьми
Это	правило	выбирает	людей	с	детьми.

Лица	с	несколькими	браками
Это	правило	выбирает	людей,	у	которых	больше	одного	супруга.

Лица,	не	вступавшие	в	брак
Это	правило	выбирает	людей	без	супругов.

Лица,	которые	были	усыновлены
Это	правило	выбирает	усыновленных	людей.

Имеют	отношения
Это	правило	выбирает	людей	с	определенными	отношениями.	Отношения	должны	соответствовать	значению,	выбираемому
через	меню.	Дополнительно	имеется	возможность	задать	число	отношений	и	число	детей.	Правило	сработает	только	если	все
не	пустые	значения	подойдут	к	отношениям	лица.	Чтобы	использовать	только	одно	значение	оставьте	остальные	пустыми.

Является	супругом	для	заданных	фильтром
Это	правило	выбирает	людей,	женатых	на	тех,	кто	подходит	под	заданный	фильтр.	Название	фильтра	выбирается	через	меню.

Является	ребенком	для	заданных	фильтром
Это	правило	выбирает	людей,	чьи	отец	или	мать	подходят	под	заданный	фильтр.	Название	фильтра	выбирается	через	меню.

Является	родителем	для	заданных	фильтром
Это	правило	выбирает	людей,	чей	ребенок	подходит	под	заданный	фильтр.	Название	фильтра	выбирается	через	меню.

Является	братом	или	сестрой	для	заданных	фильтром
Это	правило	выбирает	людей,	чей	брат	или	сестра	подходят	под	заданный	фильтр.	Название	фильтра	выбирается	через	меню.

Фильтры	предков
Эта	категория	включает	правила,	которые	выбирают	людей	на	основании	того,	что	они	являются	предками	других	людей:

Предки
Это	правило	выбирает	предков	заданного	лица.	Опция	"Включить	первоначальное	лицо"	определяет	считать	ли	заданное	лицо
своим	предком	(используется	для	построения	отчетов).	Вы	можете	либо	ввести	идентификатор	в	поле	ввода,	либо	выбрать
лицо,	нажав	на	кнопку	 Выбор... .	В	этом	случае	идентификатор	появится	в	поле	ввода	после	завершения	выбора.

Предки	лица,	отстоящие	от	него	по	крайней	мере	на	N	поколений
Это	правило	выбирает	людей,	которые	являются	предками	заданного	лица	и	отстоят	от	него	не	менее	чем	на	N	поколений.
Например,	это	правило	со	значением	2	выберет	дедов,	бабок,	прадедов,	прабабок	и	т.д.,	но	пропустит	родителей	заданного
лица.

Предки	лица,	отстоящие	от	него	не	более	чем	на	N	поколений
Это	правило	выбирает	людей,	которые	являются	предками	заданного	лица	и	отстоят	от	него	не	более	чем	на	N	поколений.
Например,	это	правило	со	значением	2	выберет	родителей,	дедов	и	бабок,	но	пропустит	прадедов,	прабабок	и	т.д.	заданного
лица.

Имеет	общих	предков
Это	правило	выбирает	людей,	имеющих	общих	предков	с	заданным	лицом.

Имеет	общих	предков	для	заданных	фильтром
Это	правило	выбирает	людей,	имеющих	общих	предков	с	теми,	кто	подходит	под	заданный	фильтр.	Название	фильтра
выбирается	через	меню.

Предки	для	заданных	фильтром
Это	правило	выбирает	людей,	которые	являются	предками	тех,	кто	подходит	под	заданный	фильтр.	Название	фильтра
выбирается	через	меню.

Фильтры	потомков
Эта	категория	включает	правила,	которые	выбирают	людей	на	основании	того,	что	они	являются	потомками	других	людей:

Потомки
Это	правило	выбирает	потомков	заданного	лица.	Опция	"Включить	первоначальное	лицо"	определяет	считать	ли	заданное
лицо	своим	потомком	(используется	для	построения	отчетов).	Вы	можете	либо	ввести	идентификатор	в	поле	ввода,	либо
выбрать	лицо,	нажав	на	кнопку	 Выбор... .	В	этом	случае	идентификатор	появится	в	поле	ввода	после	завершения	выбора.

Потомки	лица,	отстоящие	от	него	по	крайней	мере	на	N	поколений
Это	правило	выбирает	людей,	которые	являются	потомками	заданного	лица	и	отстоят	от	него	не	менее	чем	на	N	поколений.
Например,	это	правило	со	значением	2	выберет	внуков,	внучек,	правнуков,	правнучек	и	т.д.,	но	пропустит	детей	заданного
лица.

Потомки	лица,	отстоящие	от	него	не	более	чем	на	N	поколений
Это	правило	выбирает	людей,	которые	являются	потомками	заданного	лица	и	отстоят	от	него	не	более	чем	на	N	поколений.
Например,	это	правило	со	значением	2	выберет	детей,	внуков	и	внучек,	но	пропустит	правнуков,	правнучек	и	т.д.	заданного
лица.

Потомки	для	заданных	фильтром
Это	правило	выбирает	людей,	которые	являются	потомками	тех,	кто	подходит	под	заданный	фильтр.	Название	фильтра
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выбирается	через	меню.

Члены	семей	потомков
Это	правило	выбирает	не	только	людей,	которые	являются	потомками	заданного	лица,	но	и	супругов	этих	потомков.

Фильтры	отношений
Эта	категория	включает	правила,	которые	выбирают	людей	на	основании	их	взаимных	отношений:

Родственная	связь
Это	правило	выбирает	всех	предков	обоих	людей	вглубину	к	их	общим	предкам	(если	такие	существуют).	Т.е.	проивздится
построение	родственной	связи	между	двумя	людьми	через	их	общих	предков.	Вы	можете	либо	ввести	идентификаторы	обоих
лиц	в	поле	ввода,	либо	выбрать	лица,	нажав	на	кнопку	 Выбор... .	В	этом	случае	идентификатор	появится	в	поле	ввода	после
завершения	выбора.

Различные	фильтры
Эта	категория	включает	правила,	не	подходящие	ни	к	одной	из	вышеперечисленных	категорий:

Имеет	личный	атрибут
Выбитает	людей	с	определенным	значением	личного	атрибута.	Название	атрибута	выбирается	из	меню.	Значение	задается	в
поле	ввода.

Имеет	семейный	атрибут
Выбитает	людей	с	определенным	значением	семейного	атрибута.	Название	атрибута	выбирается	из	меню.	Значение	задается	в
поле	ввода.

Имеет	события	СПД
Это	правило	выбирает	людей	или	семьи	с	событиями	СПД.

Метки

Информация	в	этой	статье	или	некоторых	её	разделах	устарела.
Пожалуйста	помогите	улучшить	Gramps	Wiki,	исправив	и	дополнив	эту	статью.

Перейтите	к	пункту	меню	Правка	->Метка.

Рис.	14.4	Выбор	меток	из	меню

Или	нажмине	на	панели	инструментов	кнопку	 Метка .

Рис.	14.5	Выбор	меток	из
панели	инструментов

Идея
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Рис.	14.6	Организовать	метки

Для	тех,	кто	использует	почтовые	программы	gmail	или	thanderbird,	метки	не	в	новинку.	Вместо	классического	распределения	писем	по
папкам,	как	в	программе	Outlook	(для	ОС	Windows)	или	Evolution	(для	ОС	Linux),	письма	организуются	с	помощью	присваивания	им
меток.	Т.е.	вместо	распределения	"один	ко	многим"	(письмо	вожет	находится	только	в	одной	единственной	папке,	а	папка	может
содержать	множество	писем),	в	программах	gmail	и	thanderbird	распределение	"многие	ко	многим"	(письму	может	быть	присвоено
множество	меток	и	каждая	метка	может	быть	присвоена	множеству	писем).

Так	же	и	с	большим	семейным	древом.	Если	вам	понадобится	разделить	древо	на	части,	эти	части	могут	пересекаться.	Например	часть
древа	по	отцовской	линии	и	часть	древа	по	материнской	линии.	Или	часть	вашей	семьи,	которая	эмигрировала	в	Австралию.

Идея	в	том,	чтобы	присваивать	метки	для	каждой	такой	части	древа:	Отцовский,	Материнский,	Австралия.

Отличия	от	маркеров

Рис.	14.7	Выбор	меток	в	редакторе	лица

Маркеры	похожи	на	папки	для	писем.	Персона	может	получить	только	один	маркер.	Метки	же	ведут	себя	как	многозначные	маркеры.

Метки	и	Фильтры

Метки	и	фильтры	создают	подмножество	древа,	но	по	разному	используются	на	практике.

Рис.	14.8	Фильтрация	по	меткам	в	панели
фильрации

Нет	ничего	сложного	определить	фильтр	для	части	древа	по	отцовской	линии.	Для	этого	в	Gramps	уже	существуют	специальные
логические	правила.	С	другой	стороны	создание	фильтра	для	лиц,	эмигрировавших	в	Израиль	гораздо	сложнее,	а	создание	фильтра	для
знаменитых	людей	в	вашем	древе	вообще	невозможно,	потому	что	нет	таких	логических	правил.	В	этом	случае	помогут	метки.

Преимущество	фильтров	в	том,	что	они	динамические.	После	добавления	потомка	вашего	отца,	этот	потомок	автоматически	появится	в
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фильтре	части	древа	по	отцовской	линии.

В	отчилие	от	фильтров,	метки	статичны.	При	добавлении	знаменитой	персоны	в	древо,	вы	должны	явно	присвоить	ему	метку
Знаменитый.

Кажется,	что	метки	можно	использовать	только	по	отношению	к	персонам.	Однако	и	для	других	объектов	можно	придумать
применение	меток:

Заметки:	например	"Заметка	не	закончена"	или	"Заметка	о	Германии".
Документы:	например	"Фото	от	дяди	Леши".

Выбор	меток

Fig.	14.9	Tag	selection	in	the	Person	Editor

When	you	use	 Edit	the	tag	list 	button	from	any	of	the	Editor	dialogs	like	 Person	Edit 	the	 Tag	selection 	dialog	list	is	shown
that	lets	you	remove	or	assign	existing	custom	tags.	The	tags	are	shown	in	alphabetical	order.	

Работа	с	метками

Здесь	приведены	некоторые	приемы	работы	с	метками.

Фильтрация

Наиболее	очевидное	применение	меток	-	использовать	их	для	фильтрации.

Присваивание	меток	выбранным	объектам

Рис.	14.10	Присваивание	новой	метки	нескольким
объектам

Из-за	статичного	характера	меток	имеется	полезная	возможность	присваивать	метки	нескольким	выбранным	объектам.	Например,	можно
выбрать	нескольких	лиц	в	списке	Люди	и	присвоить	им	новую	или	уже	существующую	метку.

Колонка	"Метки"

Рис.	14.11	Колонка	"Метки"	и	цветные	строки

В	списке	объектов,	которым	можно	присваивать	метки,	имеется	колонка	 Метки .	Эта	колонка	содержит	разделенный	запятыми	перечень
меток	для	каждого	объекта.

Пред Содержание След
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ЧаВо

Пред Содержание След

Этот	документ	содержит	перечень	вопросов,	которые	чаще	всего	задают	в	списках	рассылки	и	на	форумах.	Перечень	не	окончательный,
если	вы	хотите	добавить	вопрос/ответ	в	него,	пожалуйста	пошлите	письмо	на	список	рассылки	[email	protected].

Так	же	можете	взглянуть	на	следующие	категории	документации:

Как	мне	сделать...
Учебные	пособия	по	Gramps

Общий	раздел

Что	такое	Gramps?

Gramps	(акроним	от	англ.	Genealogical	Research	and	Analysis	Management	Program	System)	-	Программная	Система	для	Генеалогических
Исследований	и	Анализа.	Другими	словами,	это	персональная	генеалогическая	программа,	которая	позволяет	хранить,	изменять	и	изучать
генеалогическую	информацию,	используя	всю	мощь	вашего	компьютера.	Смотрите	так	же	статью	О	Gramps.

Где	взять	и	сколько	это	стоит?

Gramps	можно	установить	на	свой	компьютер	совершенно	бесплатно.	Gramps	-	проект	с	открытым	исходным	кодом	под	лицензией	GNU
GPL.	Это	означает,	что	вы	можете	получить	полный	доступ	к	исходным	кодам	Gramps	и	свободно	распространять	как	саму	программу,
так	и	её	исходные	коды.

Существует	ли	Gramps	на	других	языках?

Да,	версия	Gramps	6.0	переведена	на	28	языков,	смотри	Gramps	на	других	языках.

Как	делать	резервные	копии?

Используйте	последнюю	версию	Gramps!	Начиная	с	версии	2.2.5	появилась	автоматическая	функция	резервного	копирования.

Крайне	важно	создавать	резервные	копии	ваших	данных	и	хранить	их	в	надежном	месте.	У	Gramps	есть	специальный	формат	файлов,
компактный,	понятный	для	человека,	имеет	расширение	.gramps.	Смотрите	раздел	Резервное	копирование	Семейного	дерева.

Вы	можете	время	от	времени	копировать	этот	файл	в	безопасное	место	(например	на	usb	флешку).	Обратите	внимание,	.gramps	-	сжатый
файл.	Нажатие	на	этот	файл	приводит	к	запуску	Gramps.	Чтобы	увидеть	XML,	откройте	этот	файл	с	помощью	архиватора	(например
gunzip)	и	распакуйте	XML	файл.	Подробнее	об	этом.

Gramps	делает	быстрые	скрытые	копии,	что	позволяет	востанавливаться	в	случае	возникновения	ошибки.	Если	установлено
соответствующее	программное	обеспечение	(GNU	RCS),	вы	можете	использовать	систему	архивов.

Другой	метод	-	резервное	копирование	скрытой	директории	/.gramps.	Эта	директория	расположена	в	вашем	домашнем	каталоге,	если	у
вас	Linux.	Резервное	копирование	этой	директории	защитит	ваши	базы	данных	и	архивы.

Не	храните	резервные	копии	в	формате	GEDCOM .	Не	вся	информация	Gramps	может	быть	сохранена	в	GEDCOM.	Поэтому	операция
экспорта/импорта	Gramps	-->	GEDCOM	-->	Gramps	приведет	к	потере	части	ваших	данных.	Для	резервных	копий	используйте	формат
.gramps!

Не	храните	резервные	копии	в	формате	GRDB.	GRDB	это	база	данных,	которая	может	быть	машинозависимой	(может	не	читаться	на
некоторых	PC).	Для	GRDB	файла	невозможно	восстановить	даже	небольшие	повреждения.	Для	резервных	копий	используйте	формат
.gramps!

Gramps	поддерживает	шрифты	Unicode?

Конкретнее,	поддерживает	не	только	латинские	шрифты?	Да.	Изнутри	Gramps	работает	с	Unicode	(UTF-8),	поэтому	любые	записи	могут
сожержать	любые	символы.	Это	поддерживается	во	всех	отчетах.	Для	PDF/PS	вам	необходимо	использовать	(в	Linux)	gnome-print	или
LibreOffice.

Установка

Что	необходимо,	чтобы	установить	Gramps	на	Linux,	Solaris	или	FreeBSD?

Gramps	написан	с	использованием	библиотеки	GTK.	Так	же	необходимо	наличие	в	системе	установленной	библиотеки	pygtk.	Gramps
работает	под	GNOME,	KDE	или	любой	другой	средой	рабочего	стола.	Если	установлена	библиотека	привязки	GNOME	для	Python,	у
Gramps	будут	дополнительные	функции.	Рекомендуется	устанавливать	GTK	версии	2.8	или	выше.

Gramps	работает	на	Windows?

Да,	многие	люди	используют	Windows.	Самый	простой	путь	-	скачать	комплект	GrampsAIO	для	Windows,	который	представляет	из	себя
набор	всего	необходимого	для	Gramps	программного	обеспечения	"всё	в	одном"	и	может	быть	легко	установлен	на	ваш	компьютер.
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Мы	сделаем	всё	от	нас	зависящее,	чтобы	разобраться	в	возможных	проблемах	с	Windows.	Обращайтесь.

Смотрите	так	же	сборник	советов	по	Gramps	на	компьютере	с	Windows.

Есть	так	же	Linux	Genealogy	CD,	с	которого	можно	загрузиться	напрямую	(если	у	вас	есть	CD/DVD-ROM).	После	этого	вы	сможете
запускать	Linux	и	Gramps	без	CD,	даже	если	на	вашем	комьютере	только	Windows.

Gramps	работает	на	Mac?

Да,	платформа	Mac	для	Gramps	поддерживается	сообществом.

Обращайтесь	сюда.

Какие	минимальные	требования	для	запуска	Gramps?

Мы	рекомендуем	разрешение	экрана	не	ниже	800x600.	Для	Gramps	6.0	требования	к	объему	памяти	уменьшились	и	Gramps	может
достаточно	эффективно	работать	на	256MB,	обрабатывая	довольно	много	персон.	Системы	с	512MB	могут	обрабатывать	до	200000
персон.	Для	базы	данных	требуется	несколько	больше	дискового	пространства	,	чем	памяти.	Обычно	база	данных	занимает	несколько
мегабайт.	Для	120000	персон	требуется	уже	около	530MB.	Фотографии	хранятся	на	диске	отдельно,	поэтому	диск	необходим	большой.

Как	обновить	Gramps?

Операционные	системы	GNU/Linux	обычно	обновляются	автоматически.	Если	это	не	так	-	обратитесь	с	вопросом	к	тем,	кто	использует
ваш	любимый	дистрибутив	GNU/Linux.

Gramps	для	Windows	необходимо	обновлять	вручную.

Информация	в	этой	статье	или	некоторых	её	разделах	устарела.
Пожалуйста	помогите	улучшить	Gramps	Wiki,	исправив	и	дополнив	эту	статью.

TODO

Требуется	обновить	это	содержимое.

(не	законченный	ответ)

Настройки

Могу	я	поменять	формат	даты	в	отчетах	на	'день	месяц	год'?

Да,	поменяйте	формат	даты	в	настройках	Gramps	("Правка->Настройки->Отображение")	на	необходимый	вам	(например	ГГГГ-ММ-ДД
или	День	Месяц	Год)	и	сделайте	отчет.	При	этом	будут	использоваться	ваши	настройки.

Совместимость

Программа	Gramps	совместима	с	другими	генеалогическими	программами?

Gramps	поддерживает	совместимость	с	GEDCOM	-	спецификацией	для	обмена	генеалогической	информацией.	Gramps	может	читать	и
писать	файлы	в	формате	GEDCOM.

Важно	понимать,	что	спецификация	GEDCOM	слабо	проработана	-	практически	каждая	генеалогическая	программа	дополняет	ее	своими
"улучшениями".	Как	только	мы	узнаем	об	новом	улучшении	-	сразу	же	добавляем	в	функции	экспорта/импорта	Gramps.	Однако,
выявление	таких	улучшений	невозможно	без	помощи	пользователей.	Пожалуйста	сообщайте	нам	о	любых	улучшениях	GEDCOM,
которые	не	поддерживаются	в	Gramps	и	мы	сделаем	всё	возмножное,	чтобы	добавить	их!

Для	обсуждения	этого	существует	специальный	раздел	Gramps	and	GEDCOM.

Может	Gramps	читать	файлы,	созданные	в	других	генеалогических	программах?

Ответ	смотри	выше.

Может	Gramps	записывать	файлы,	которые	можно	прочитать	в	других	генеалонических	программах?

Ответ	смотри	выше.

Какие	стандарты	поддерживает	Gramps?

Самое	прекрасное	в	стандартах,	что	никогда	не	бывает	недостатка	в	них.	Gramps	прошел	тестирование	на	совместимость	со	следующими
"улучшениями"	GEDCOM:	GEDCOM5.5,	Brother's	Keeper,	Family	Origins,	Family	Tree	Maker,	Ftree,	GeneWeb,	Legacy,	Personal	Ancestral
File,	Pro-Gen,	Reunion,	and	Visual	Genealogie.

Как	в	Gramps	импортировать	данные	из	другой	генеалогической	программы?
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Самый	лучший	способ	-	создать	новое	семейное	древо	и	выбрать	пункт	"Импорт..."	в	меню	"Семейные	древеса".	Здесь	вы	пожете	выбрать
файл	GEDCOM,	созданный	в	другой	программе,	и	импортировать	его.

Могу	я	установить	Gramps	на	Linux	Web	Server	и	пользоваться	им	через	браузер?

Это	позволит	получить	доступ	к	моему	древу,	чтобы	добавить	в	него	информацию,	из	любой	точки	мира.

Gramps	может	создавать	веб-сайты,	но	он	не	может	предоставить	веб-интерфейс	для	их	редактирования.	Если	это	необходимо,	то	вам
лучше	подойдут	программы	GeneWeb	или	PhpGedView.	Можно	так	же	попробовать	экспериментальную	программу	gramps-connect.	Тем
не	менее,	вы	можете	задать	себе	следующие	вопросы:

1.	 Действительно	ли	я	хочу,	чтобы	мои	родственники	или	другие	люди	изменяли	мою	генеалогическую	базу	данных?
2.	 Можно	ли	полностью	доверять,	без	проверки,	любым	данным,	которые	могут	ввести	люди?
3.	 Эти	люди	имеют	такой	же	опыт	в	генеалогии,	как	и	я?

Возможно	лучше	будет	предоставить	другим	веб-форму	для	ввода	данных,	которые	будут	храниться	до	вашего	рассмотрения.	Вы	сможете
сами	решать,	должна	ли	эта	информация	быть	помещена	в	вашу	базу	данных.

Вы	так	же	можете	рассмотреть	вариант	неработоспособности	вашего	сайта,	если	вы	не	заплатите	за	веб-хостинг.

Отчеты

Gramps	может	напечатать	моё	семейное	древо?

Да.	Разные	люди	имеют	различное	представление	о	том,	что	такое	семейное	древо.	Некотороые	думают	что	это	схема,	начинающаяся	от
далекого	предка	и	перечисляющая	всех	его	потомков	с	их	семьями.	Другие	считают,	что	это	схема,	идущая	от	лица	назад	во	времени,
перечисляя	всех	его	предков	и	их	семьи.	Кто-то	думает,	что	это	таблица,	текстовый	отчет	и	т.д.

Gramps	умеет	делать	всё	перечисленное	и	много	других	схем	и	отчетов.	Более	того,	архитектура	плагинов	позволяет	пользователям,	т.е.
вам,	создавать	свои	собственные	дополнения	к	Gramps.	Например	новые	отчеты,	схемы,	исследовательские	инструменты.

В	каких	форматах	Gramps	может	создавать	отчеты?

Текстовые	отчеты	доступны	в	форматах	HTML,	PDF,	ODT,	LaTeX	или	RTF.	Графические	отчеты	(схемы	и	диаграммы)	доступны	в
форматах	PostScript,	PDF,	SVG,	ODS	и	GraphViz.

Как	поменять	язык	в	отчетах?

По	умолчанию	отчеты	создаются	на	языке	вашей	операционной	системы.	Вы	можете	изменить	язык,	установив	дополнительные
языковые	пакеты.	Подробнее	смотри	Howto:Change	the	language	of	reports.

Gramps	совместим	с	интернет?

Gramps	может	сохранять	веб-адреса	и	открывать	их	в	вашем	браузере.	Он	может	импортировать	данные,	которые	вы	загружаете	из
интернет.	Он	может	зкспортировать	данные,	которые	вы	можете	отправить	через	интернет.	Gramps	знаком	со	стандартными,	широко
распространенными	в	интернете	форматами	файлов	(например	картинки	в	JPEG,	PNG	и	GIF,	музыку	в	MP3,	OGG	и	WAV,	видео	в
QuickTime,	MPEG	и	AVI,	и	т.д.).	Кроме	этого	мало	что	генеалогическая	программа	может	делать	с	интернет.

Могу	я	создать	свои	отчеты/фильтры/что-нибудь	еще?

Да.	Есть	много	уровней	настройки.	Один	из	них	-	создание	или	изменение	шаблонов	отчетов.	Это	дает	вам	возможность	настраивать
шрифты,	цвета	и	форматирование.	Вы	так	же	можете	указать,	какое	содержимое	должно	быть	использовано	для	конкретного	отчета,	с
помощью	элементов	управления	на	форме	создания	отчета.	В	дополнение	к	этому	вы	можете	создавать	свои	фильтры	-	это	позволяет
выбирать	лиц	по	заданному	вами	критерию.	Вы	можете	комбинировать	эти	фильтры,	чтобы	создавать	другие,	более	сложные.	Наконец,	у
вас	есть	возможность	создавать	свои	плагины.	Это	могут	быть	новые	отчеты,	исследовательские	инструменты,	функции	экспорта/импорта
и	т.д.	Это	предполагает	некоторые	знания	в	программировании	на	Python.

Почему	в	отчетах	в	формате	PDF/PS	не	латинские	символы	отображаются	как	мусор?

Это	ограничения,	встроенные	в	шрифты	для	PS	и	PDF	форматов.	Чтобы	напечатать	не	латинский	текст,	используйте	Печать...	в	меню
выбора	формата	в	форме	создания	отчета.	Будет	использован	драйвер	gnome-print,	который	кроме	обычной	печати	поддерживает	еще	и
создание	PS	и	PDF.	(Внимание:	может	потребоваться	отдельная	установка	gnome-print,	потому	что	обычно	он	не	требуется	для	Gramps).

Если	у	вас	только	латинский	текст,	то	PDF-файл,	полученный	при	выборе	формата	PDF	будет	меньше	созданного	через	gnome-print,
потому	что	в	файл	не	будут	встроены	шрифты.

Хочу	внести	вклад	в	разработку	Gramps	и	создать	свой	отчет.	Как	это	сделать?

Самый	простой	путь	внести	вклад	в	разработку	отчетов,	фильтров,	инструментов	-	скопировать	существующий	в	Gramps	отчет,	фильт,
инструмент.	Если	вы	можете	создать	то,	что	хотите,	редактируя	существующий	код	-	замечательно.	Если	ваша	идея	не	вписывается	в
логику	существующих	инструментов	-	придется	создавать	ваш	собственный	плагин	с	нуля.	В	этом	вам	помогут	на	Developers	Portal	или
на	Developers	mailing	list:	[email	protected].

Чтобы	проверить	вашу	работу,	вы	должны	скопировать	ваш	плагин	в	директорию	$HOME/.gramps/plugins	и	он	будет	обнаружен	и
импортирован	во	время	запуска	Gramps.	Правильно	написанный	плагин	сам	себя	регистрирует	в	Gramps,	создает	пункт	меню	и	т.д.

Если	вы	довольны	вашим	плагином	и	хотите	пожертвовать	его	в	проект	Gramps	-	вам	всегда	рады,	обращайтесь	на	[email	protected].
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База	дынных	-	форматы	файлов	Gramps

Какой	максимальный	размер	базы	данных	(в	байтах)	может	обрабатывать	Gramps?

Gramps	не	имеет	жесткого	лимита	по	размеру	базы	данных.	Начиная	с	версии	2.0.0	Gramps	больше	не	загружает	всю	базу	данных	в
память,	что	позволяет	ему	работать	со	значительно	большим	размером	базы	данных,	чем	раньше.	Но	практике	есть	ограничения.	Главный
ограничивающий	фактор	-	доступная	память	в	системе	и	размер	кэша,	который	используется	для	доступа	к	базам	данных	BSDDB.	С
обычным	на	текущий	момент	объемом	памяти	Gramps	не	испытывает	проблем	с	базами	данных,	содержащих	десятки	тысяч	лиц.

Какое	количество	лиц	может	содержать	база	данных	Grampse?

Смотри	ответ	выше.	Еще	раз,	это	зависит	от	объема	памяти	на	вашем	компьютере,	смотри	Gramps	Performance.

У	меня	огромная	база	данных.	Есть	возможность	не	загружать	все	данные	из	моей	базы	в	память?

Начиная	с	версии	2.0.0	Gramps	больше	не	загружает	всю	базу	данных	в	память,	что	позволяет	ему	работать	со	значительно	большим
размером	базы	данных,	чем	раньше.	Название	формата	файлов	.grdb,	что	означает	"база	данных	Gramps".

Можно	разместить	базу	данных	Gramps	на	сетевом	диске?

Да,	можно.

Что	означает	"переносимый"?

База	данных	Gramps	3	(и	любой	файл	.grdb)	очень	сильно	зависят	от	программ,	в	которых	они	созданы.	Например,	вы	не	можете	просто
перенесте	данные	Gramps	в	этом	формате	на	другую	операционную	систему	(или	даже	на	другую	версию	той	же	самой	операционной
системы)	и	гарантировано	прочитать	эти	данные.	Данные	не	"переносимы".	Поэтому	вы	не	можете	использовать	этот	формат	для
резервного	копирования,	но	можете	для	этой	цели	экспортировать	их	в	пререностимый	формат.	Есть	два	переносимых	формата:
GEDCOM	и	Gramps	XML	(.gramps	или	.gpkg),	но	рекомендуется	Gramps	XML,	потому	что	только	он	сохраняет	действительно	все	ваши
данные.

Почему	формат	базы	данных(GRDB)	не	"переносим"?

Главная	проблема	с	переносимостью	в	Gramps	это	транзакции.	Начиная	с	версии	2.2	мы	добавили	поддержку	атомарных	транзакций	для
защиты	данных.	Благодаря	атомарным	транзакциям	множественные	изменения	фиксируются	как	единое	целое.	Либо	делаются	все
изменения,	либо	не	делается	ни	одного.	Вы	никогда	не	окажитесь	в	ситуации	с	частичным	набором	изменений.	Побочный	эффект	от
испльзования	транзакций	-	ускорение	доступа	(чтение	и	запись)	к	базе	даных.

Проблема	с	транзакциями	в	Gramps	(по	крайней	мере	при	использовании	BSDDB)	в	том,	что	невоозможно	хранить	все	данные	в	одном
файле.	Файлы	журналов	используются	для	слежения	за	транзакцими.	Эти	файлы	хранятся	в	директории	окружения	базы	данных.	Для
каждого	файла	нужна	отдельная	директория,	иначе	эти	файлы	могут	мешать	друг	другу.

С	версии	2.2	мы	храним	файлы	журналов	в	директории	~/.gramps/<путь>,	отдельной	директории	для	каждой	базы	данных.	Проблема	в
том,	что	вашему	GRDB	файлу	требуется	файл	журнала,	который	хранится	в	другой	директории.

Копируя	файл	GRDB	вы	копируете	только	часть	базы	данных.

Ошибки	и	предложения

Что	мне	делать	если	я	нашел	ошибку?

Самое	лучшее	-	самостоятельно	исправить	ошибку	и	послать	патч	на	 [email	protected]	:-)

Если	это	невозможно	-	вы	должны	создать	отчет	об	ошибке

Хороший	отчет	об	ошибке	состоит	из:

1.	 Версия	Gramps,	в	которой	вы	обнаружили	ошибку	(доступно	через	меню	Справка	->	О	программе).
2.	 Язык	Gramps	(можно	узнать	запустив	в	терминале	echo	$LANG)
3.	 Симптомы,	доказывающие,	что	это	действительно	ошибка.
4.	 Любые	отладочные	сообщения,	сообщения	об	ошибках,	предупреждения	и	т.д.,	всё,	что	выводится	на	терминал	или	в	специальных

отладочных	окнах.

Большинство	ошибок	может	быть	быстро	исправлено	при	наличи	достаточной	информации.	Пожалуйста,	заполните	ваш	отчет	до	конца.
Потом	у	нас	будет	возможность	связаться	с	вами,	чтобы	получить	больше	информации.

Предложения

Gramps	должен	быть...

Совершенно	очевидно,	что	Gramps	должен	стать	(клиент-серверным/использующим	интернет-
технологии/PHP/блог/Javascript/C++/distributed/KDE/Motif/Tcl/Win32/C#/и	т.п.)	приложением.	Когда	это	произойдет?

Самый	надежный	пособ	приблизить	это	событие	-	сделать	это	самостоятельно.	Gramps	-	свободное	программное	обеспечение	с	открытым
исходным	кодом,	поэтому	ничто	не	мешает	вам	взять	весь	исходный	код	и	продолжить	разработку	в	собственном	направлении.	В	этом
случае	вам	понадобится	выбрать	для	вашего	проекта	новое	имя,	чтобы	избежать	путаницы	с	продолжающим	развитие	Gramps.	Если	вы
расчитываете	на	советы,	консультации,	и	т.д.,	мы	будем	рады	сотрудничать	с	вашим	новым	проектом,	чтобы	обеспечить	совместимость
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или	импорт/экспорт	с	вашим	новым	форматом.

Если	же	вы	хотите,	чтобы	проект	Gramps	принял	вашу	стратегию,	вам	необходимо	убедить	разработчиктв	Gramps,	что	ваша	стратегия
хороша	и	превосходит	нынешнюю.

Наполнение	и	редактирование	моей	базы	данных

В	чем	разница	между	местом	проживания	и	адресом?

Место	проживания	это	место,	в	котором	кто-либо	жил	какой-то	период	времени.	Адрес	-	это	название	места	проживания	в	виде,	понятном
для	почтовой	системы.	Поэтому	любое	место	проживания	может	иметь	адрес,	если	это	необходимо.	Смотрите	так	же:	Почему	место
проживания	это	не	Адрес?

Как	поменять	порядок	детей?

Порядок	детей	можно	поменять	в	Редакторе	Семьи	с	помощью	перетаскивания	мышью	или	используя	кнопок	 	 Вверх 	и	 Вниз .

Как	поменять	порядок	супругов?

Порядок	супругов	можно	поменять	в	Отношениях	нажав	кнопку	 Упорядочить 	на	панели	инструментов.

Пред Содержание След
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Горячие	клавиши

Пред Содержание След

Этот	документ	содержит	список	горячих	клавиш	(клавишных	комбинаций	быстрого	вызова),	которые	вы	можете	использовать	в	Gramps
вместо	компьютерной	мыши.

Некоторые	комбинации	требуют	от	пользователя	нажать	кнопку	или	несколько	кнопок	одну	за	другой.	Другие	-	нажать	и	ужерживать
несколько	кнопок	одновременно.	Горячие	клавиши	могут	зависеть	от	раскладки	клавиатуры	(локализация).

Списки

Общие	назначения	клавиш

Следующие	комбинации	клавиш	доступны	во	всех	видах.

Комбинация Функция
CTRL + O Управление	семейными	древесами
CTRL + I Импорт
CTRL + E Экспорт
CTRL + N Переключиться	к	следующему	виду
CTRL + P Переключиться	к	предыдущему	виду
CTRL + M Переключение	панели	навигации
CTRL + 1 / CTRL + 2 /.. Переключиться	к	виду	под	номером	1/2/...
CTRL + B Открыть	буфер	обмена
CTRL + D Добавить	закладку	на	выделенный	элемент
⇧	Shift + CTRL + D Открыть	редактор	закладок
CTRL + H Открыть	историю	откатов
CTRL + J Перейти	к	элементу	с	инентификатором...
ALT + Влево 	(Левая	стрелка) Перейти	к	предыдущему	элементу	в	истории	переходов
ALT + Вправо 	(Правая	стрелка) Перейти	к	следующему	элементу	в	истории	переходов
ALT + Home Перейти	к	Базовому	Лицу
⇧	Shift + CTRL + C Настройка	текущего	вида
⇧	Shift + CTRL + R Переключение	правой	боковой	панели
⇧	Shift + CTRL + B Переключение	левой	боковой	панели
CTRL + Z Откатить
⇧	Shift + CTRL + Z Вернуть
CTRL + Q Выйти	из	Gramps

Комбинации	клавиш	для	списков

Следующие	комбинации	клавиш	доступны	во	всех	видах-списках:	Люди,	Семьи,	События,	Источники,	Цитаты,	Места,	Альбом,
Хранилища	и	Заметки.

Комбинация Функция
↵	Enter Редактировать	выделенный	элемент
CTRL + Insert Добавить	новый	элемент	в	базу	данных
CTRL + Delete Удалить	выделенный	элемент

Комбинации	клавиш	для	вида	Люди

Комбинация Функция
↵	Enter Развернуть	или	скрыть	записи	с	выбранной	фамилией

Редакторы

Комбинации	клавиш	для	вкладок	редакторов

Эти	комбинации	клавиш	работают	во	вкладках	редакторов	(не	на	названиях	вкладок!,	нажмите	на	кнопку	 Тab 	чтобы	переместить	фокус
на	сожержимое	вкладки).

Комбинация Функция
↵	Enter Действие	как	у	кнопки	 ,	если	такая	существует
Insert Действие	как	у	кнопки	 ,	если	такая	существует
Delete Действие	как	у	кнопки	 ,	если	такая	существует
Ctrl + O Действие	как	у	кнопки	 Share ,	если	такая	существует
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ALT + ← 	(Стрелка	влево) Переключиться	на	вкладку	слева
ALT + → 	(Стрелка	вправо) Переключиться	на	вкладку	справа
Кнопка	мыши Функция

Правая	кнопка Вызвать	контекстное	меню
Двойное	нажатие Действие	как	у	кнопки	 	 Edit ,	если	такая	существует
Средняя	кнопка Действие,	не	такое	как	у	кнопки	 	 Edit .	Например:	Во	вкладке	Дети	редактора	Семьи	вызывает	редактор	ребенка

Комбинации	клавиш	для	редакторов

Эти	комбинации	клавиш	работают	в	редакторах	для	смены	фокуса	или	для	переключения	состояния	кнопок	(Accessibility).

Комбинация Функция
Ctrl + P Изменить	статус	приватности	(открытая	или	приватная	запись).
Ctrl + D Запустить	диалог	выбора	даты	(если	существует).
Ctrl + A Нажать	на	кнопку	 	 Add 	(если	есть	такая).
Ctrl + E Нажать	на	кнопку	 	 Edit 	(если	есть	такая).
Ctrl + S Нажать	на	кнопку	 Select 	(если	есть	такая).
Ctrl + F Нажать	на	кнопку	 Father 	(если	есть	такая).
Ctrl + M Нажать	на	кнопку	 Mother 	(если	есть	такая).

Полезные	комбинации	клавиш

Комбинация Функция
F11 Переключиться	в	полноэкранный	режим
F1 Показать	руководство	пользователя

Пред Содержание След
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Командная	строка

Пред Содержание След

В	этом	документе	описаны	возможности	командной	строки,	доступные	при	запуске	Gramps	через	терминал.

Доступные	команды
В	этом	разделе	представлен	перечень	всех	команд,	доступных	через	командную	строку	Gramps.	Если	вас	интересует	большее,	чем	просто
список,	смотри	следующие	разделы:	Применение	and	Примеры.	Список	так	же	доступен	на	этой	странице.

Команды	списка

Вывести	список	всех	известных	семейных	древес:

Кратко

-l,	print	a	list	of	known	family	trees

Рис.	C.1	Пример	вывода	для	python	gramps.py	-l

Подробно

-L,	print	a	detailed	list	of	known	family	trees

Рис.	C.2	Пример	вывода	для	python	gramps.py	-L

Обратите	внимание,	что	даты	выводятся	согласно	текущей	локали.	Вы	можете	поменять	это	на	системном	уровне.	Например,	для
операционных	систем	на	основе	POSIX	это	будет	выглядеть	так:

LC_TIME=en_AU.UTF-8	gramps	-L

Команда	версии

-v	or	--version	prints	version	of	Gramps	and	dependencies,
					information	about	environment	settings	and	python	and	system	paths
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Рис.	C.3	Пример	вывода	для
python	gramps.py	-v

Команда	форматов

Формат	любого	файла,	предназначенного	для	открытия,	импорта	или	экспорта	должен	быть	описан	в	опции

-f	format

.	Ниже	приведен	список	допустимых	значений	аргумента	format.

Полная	поддержка

Эти	форматы	содержат	все	ваши	данные,	представленные	в	фамильном	древе.

gramps	-	формат	Gramps	XML:	Этот	формат	доступен	для	импорта	и	экспорта.	Если	не	указать	явно,	этот	формат	автоматически
выберется	по	расширению	файла	".gramps"
gpkg	-	упакованный	формат	Gramps	XML:	Этот	формат	доступен	для	импорта	и	экспорта.	Если	не	указать	явно,	этот	формат
автоматически	выберется	по	расширению	файла	".gpkg".	Он	состоит	из	zip-архива	ваших	даных	в	формате	XML	и	включает	в	себя
все	медиа-файлы
grdb	-	база	данных	Gramps	версии	до	3.x:	Этот	формат	доступен	для	импорта	для	поддержки	старого	формата	файлов	Gramps.	Всё
содержимое	файла	grdb	будет	импортировано.	Если	не	указать	явно,	этот	формат	автоматически	выберется	по	расширению	файла
".grdb"
burn	-	формат	записи	GNOME	iso:	только	экспорт,	доступен	только	на	GNOME	если	используется	протокол	записи	дисков

Частичная	поддержка

Эти	форматы	сорержат	большинство,	но	не	все	данные,	которые	вы	можете	создать	в	Gramps

ged	-	фрмат	GEDCOM:	Этот	формат	доступен	для	экспорта	и	импорта.	Если	не	указать	явно,	этот	формат	автоматически	выберется
по	расширению	файла	".ged"
gw	-	файл	GeneWeb:	Этот	формат	доступен	для	экспорта	и	импорта.	Если	не	указать	явно,	этот	формат	автоматически	выберется	по
расширению	файла	".gw"

Другие	форматы

Эти	форматы	содержат	отдельные	подмножества	ваших	данных

csv	-	значения	через	запятую:	Этот	формат	доступен	для	импорта	и	экспорта.	Но	будте	осторожны,	файл	для	импорта	должен	быть
такого	же	вида,	как	и	файл	созданный	функцией	экспорта.	При	экспорте	в	файл	попадает	только	часть	ваших	данных.
vcf	-	формат	VCard:	импорт	и	экспорт
vcs	-	формат	VCalandar:	экспорт
def	-	старый	формат	Pro-Gen:	импорт
wft	-	Web	Family	Tree:	этот	формат	доступен	только	для	экспорта.	Если	не	указать	явно,	этот	формат	автоматически	выберется	по
расширению	файла	".wft"

Команды	открытия

Вы	можете	открыть	фамильное	древо	или	импортировать	файл	в	пустое	фамильное	древо.

Чтобы	Gramps	выполнил	это,	просто	укажите	фамильное	древо	или	файл,	которые	вы	хотите	открыть:

python	gramps.py	'Моё	древо'
python	gramps.py	JohnDoe.ged

Первая	строка	отрывает	фамильное	древо,	вторая	импортирует	файл	gedcom	в	пустое	фамильное	древо.

Кроме	того,	вы	можете	указать	Gramps	имя	фамильного	древа	для	открытия	с	помощью	команды:

так	:

-O	famtree

или	так

--open=famtree	

-O,	Открывает	фамильное	древо.	То	же	самое	будет	если	просто	набрать	имя	древа	(или	путь	к	базе	данных)

Примеры:

python	gramps.py	'Family	Tree	1'
python	gramps.py	/home/cristina/.gramps/grampsdb/47320f3d
python	gramps.py	-O	'Family	Tree	1'
python	gramps.py	-O	/home/cristina/.gramps/grampsdb/47320f3d
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Совет

Если	не	указать	никаких	команд,	только	имя,	Gramps	проигнорирует	остальные	аргументы
командрой	строки.	Применяйте	команду	-O	для	открытия,	команду	-i	для	импорта,	если	хотите
использовать	еще	и	другие	команды	в	командной	строке

Совет

Только	фамильные	древеса	можно	открыть	напрямую.	Для	других	форматов	необходимо
использовать	опцию	импорта,	которая	создаст	пустую	базу	данных	и	импортирует	данные	в	нее.

Совет

Открыть	можно	только	одно	фамильное	древо.	Если	вам	необходимо	объединить	данные	из
нескольких	источников,	используйте	команду	импорта.

Команды	импорта

Файлы	для	импорта	помещаются	в	команду

-i	filename

или

--import=filename

.	Формат	может	быть	определен	командой

-f	format

или

--format=format

Эта	команда	должна	следовать	непосредственно	за	filename.	Если	формат	не	определен,	Gramps	пытается	предположить	формат	исходя	из
имени	файла.

Пример:

		python	gramps.py	-i	'Family	Tree	1'	-i	'Family	Tree	2'
		python	gramps.py	-i	test.grdb	-i	data.gramps

Совет

В	одной	командной	строке	может	быть	импортировано	более	одного	файла.	Если	вы
импортируете	несколько	файлов,	то	данные	из	следующего	файла	добавляются	в	базу	данных,
полученную	на	момент	окончания	импорта	предыдущих.

Если	вы	импортируете	больше	одного	файла,	каждому	файлу	должна	предшествовать	команда

-i

.	Файлы	импортируются	в	порядке	следования,	т.е.

	-i	file1	-i	file2	

и

	-i	file2	-i	file1	

скорей	всего	создадут	разные	инеднификаторы	(IDs)	в	конечной	базе	данных.

Команды	экспорта

Файлы	для	экспорта	помещаются	в	команду

-e	filename
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или

--export=filename

Формат	может	быть	определен	командой

-f

Эта	команда	должна	следовать	непосредственно	за	filename.	Если	формат	не	определен,	Gramps	пытается	предположить	формат	исходя	из
имени	файла.	Для	формата	iso	в	качестве	filename	должна	быть	указана	директория,	куда	будет	записана	база	данных	Gramps.	Для
форматов	gramps-xml,	gpkg,	gedcom,	wft,	geneweb	и	gramps-pkg	в	качестве	filename	должно	быть	указано	имя	файла,	куда	будет
производится	экспорт.

-e,	экспорт	фамильного	древа	в	требуемый	формат.	Нет	возможности	экспортировать	одно	фамильное	древо	в	другое.

Пример:

	python	gramps.py	-i	'Family	Tree	1'	-i	test.grdb	-f	grdb	-e	mergedDB.gramps

Обратите	внимание,	что	командная	строка	выше	не	изменит	'Family	Tree	1',	так	так	импорт	будет	производиться	во	временную	базу
данных,	тогда	как:

	python	gramps.py	-O	'Family	Tree	1'	-i	test.grdb	-f	grdb	-e	mergedDB.gramps

импортирует	test.grdb	в	Family	Tree	1,	а	затем	результат	экспортируется	в	файл!

Совет

В	одной	командной	строке	можно	экспортировать	более	одного	файла.	Если	вы	экспортируете
несколько	файлов,	то	Gramps	попытается	записать	каждый	файл,	использую	данные	из	доступной
на	текущий	момент	базы	данных.

Если	экспортируется	несколько	файлов,	каждому	должна	предшествовать	команда

-e

Файлы	будут	записываться	один	за	другим	в	порядке	следования	в	командной	строке.

Команды	действий

Действие,	выполняемое	над	импортированными	данными,	должно	определяться	в	команде

-a	action

или

--action=action

Действие	выполняется	после	успешного	завершении	всех	операций	импорта.

Следующие	действия	ведут	себя	подобным	образом:

report:	Позволяет	создать	отчет	из	командной	строки.

tool:	Позволяет	запустить	инструмент	из	командной	строки.

Отчеты	и	инструменты	обычно	имеют	множество	параметров,	которые	должны	следовать	за	командой	действия.	Параметры	отчетов	и
инструментов	указываются	в	виде	строки	в	команде

-p	option_string

или

--options=option_string

Следующие	действия	были	доступны	в	старых	версиях	Gramps	и	изменены	начиная	с	версии	Gramps	3.3:

summary:	Это	действие	делает	то	же,	что	и	Отчеты	->Текстовые	отчеты	->Обзор	базы	данных.	В	Gramps	3.3	оно	было	перенесено
(переименовано)	в	-a	report	-p	name=summary.

check:	Это	действие	делает	то	же,	что	и	Инструменты	->Починка	семейного	древа	->Проверить	и	исправить	базу	данных.	В
Gramps	3.3	оно	было	перенесено	(переименовано)	в	-a	tool	-p	name=check.

параметры	действия	report

С	помощью	действия	report	можно	создавать	большинство	отчетов	из	командной	строки.

Например:
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gramps	-O	"Family	Tree	1"	-a	report	-p	"name=family_group,style=default,off=html,of=test.html"

Вы	можете	задать	стили	css	с	помощью	параметра	css:

gramps	-O	"Family	Tree	1"	-a	report	-p	"name=family_group,style=default,off=html,of=test.html,css=Web_Nebraska.css"

или	вообще	не	использовать	стили	css:

gramps	-O	"Family	Tree	1"	-a	report	-p	"name=family_group,style=default,off=html,of=test.html,css="

Строка	параметров	отчета

Строка	с	параметрами	отчета	должна	удовлетворять	следующим	условиям:	Она	не	должна
содержать	пробелов	(так	устроен	интерфейс	командной	строки).	Если	некоторым	параметнам
требуются	пробелы	-	сорока	с	параметрами	должна	быть	заключена	в	кавычки.	Строка
параметров	должна	состоять	из	списка	пар	параметр	-	значение.	Внутри	пары	имя	параметра	и	его
значение	должны	разделяться	знаком	равенства.	Соседние	пары	должны	разделяться	запятой.

У	каждого	отчета	свой	набор	параметров.	Есть	так	же	параметры	общие	для	всех	типов	отчетов.

name=report_name:	Этот	обязательный	параметр	определяет	тип	создаваемого	отчета.	Если	тип	отчета	не	соответствует	ни	одному
из	доступных,	будет	выведено	сообщение	об	ошибке	вместе	со	списком	типов	доступных	отчетов.
of	:	имя	создаваемого	файла
off:	формат	создаваемого	файла.	Доступны	следующие	форматы:	eg,	pdf,	html,	doc,	...
style:	для	текстовых	отчетов	задает	стилевую	таблицу.	По	умолчанию	значение	'default'.
show=all:	Выводит	список	имен	всех	параметров	для	данного	типа	отчетов.
show=option_name:	Выводит	описание	параметра	option_name,	а	так	же	его	допустимые	значения.

Таким	образом,	чтобы	изучить	возможности	отчета,	выполните:

gramps	-O	"Family	Tree	1"	-a	report	-p	"name=family_group,show=all"

Совет

Если	параметр	отсутствует,	будет	использоваться	последнее	значение	этого	параметра	для
данного	типа	отчетов.	Если	отчет	создается	впервые,	будет	использоваться	значение	этого
параметра	из	другого	ранее	созданного	отчета,	когда	это	допустимо.	В	противном	случае	будет
использоваться	значение	параметра	по	умолчанию.

Если	в	одной	команде	выполняется	несколько	действий,	каджому	должна	предшествовать	команда

-a

Действия	выполняются	одно	за	другим	в	порядке	следования.

Списки

Некоторые	отчеты	имеют	параметры,	которые	должны	представляться	в	отчете	в	виде
нискольких	строк.	Например	некоторые	отчеты	позволяют	задать	формат	выводимой
информации,	имя	на	одной	строки	и	дату	рождения	на	другой.	Такие	многострочные	параметры
называются	в	Gramps	"списками".

Такие	списки	в	командной	строке	всегда	должны	начинаться	с	левой	квадратной	скобки

[

и	всегда	заканчиваться	правой	квадратной	скобкой

]

но	так	как	обычно	квадратные	скобки	являются	спецсимволами	для	командного	интерпретатора	(в	котором	вы	набираете	команду),	вы
должны	экранировать	их	для	того,	чтобы	командный	интерпретатор	их	игнорировал.

Подробности	зависят	от	типа	командного	интерпретатора.	В	linux/UNIX	обычно	вы	доолжны	поставить	перед	квадратной	скобкой
обратный	слэш

\

или	заключить	квадратную	скобку	в	кавычки,	одинарные	или	двойные.

Граф	"Песочные	часы"	позволяет	указать	комментарий	сверху	отчета.	Такой	комментарий	-	пример	параметра	списк.	Пример:
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gramps	-O	"Family	Tree	1"	-a	report	-p	name=hourglass_graph,note='[line	one,line	two]'

в	котором	показано,	что	строки	внутри	такого	списка	разделены	запятыми	и	пробелы	вместе	с	квадратными	скобками	заключены	в
кавычки.

Если	вам	необходимы	запятые	внутри	параметри	типа	список,	вы	можете	указать	Gramps,	что	эти	запятые	не	разделяют	строки.	Вы
должны	заключить	такие	строки	с	запятыми	в	кавычки	(одинарные	или	двойные).

Но	если	вы	уже	используете	кавычки	в	своем	параметре	(чтобы	заключить	в	них	квадратные	скобки),	вы	должны	использовать	другой	тип
кавычек,	чтобы	заключить	в	него	строки	с	запятыми.	Пример:

gramps	-O	"Family	Tree	1"	-a	report	-p	name=hourglass_graph,note="['line	one,	also	line	one','line	two,	also	line	two']"

В	список	можно	включать	любые	символы,	но	подробности	выходят	за	рамки	данного	описания.

Нужно	иметь	подробное	описание	для	вашего	командного	интерпретатора,	чтобы	знать,	как	включать	в	команду	спецсимволы	для	этого
интерпретатора	или	для	Gramps	(такие,	как	запятые	в	примере	выше).	Если	всегда	заключать	в	кавычки	строки	в	команде	дважды,	один
раз	для	интерпретатора	и	один	раз	для	Gramps,	не	нужно	будет	обращать	внимания	на	эти	экранирования.

параметры	действия	tool

Вы	можете	запустить	большинство	инструментов	из	командной	строки	используя	действие	'tool'.	Чтобы	увидеть	какие	именно,	наберите:

gramps	-O	"Family	Tree	1"	-a	tool	-p	show=all

Чтобы	увидеть	параметры	конкретного	инструмента,	например	"verify",	наберите:

gramps	-O	"Family	Tree	1"	-a	tool	-p	name=verify,show=all

Чтобы	запустить	инструмент,	например	"verify",	наберите:

gramps	-O	"Family	Tree	1"	-a	tool	-p	name=verify

параметры	действия	book	(начиная	версии	6.0)

Вы	можете	открыть	отчет	"Книга"	из	командной	строки	с	помощью	действия	'book'.	Чтобы	увидеть	какие	-	наберите:

gramps	-O	"Family	Tree	1"	-a	book

Чтобы	увидеть	доступные	параметры	для	книги,	например	с	названием	"mybook":

gramps	-O	"Family	Tree	1"	-a	book	-p	name=mybook,show=all

Чтобы	открыть	книгу,	например	с	названием	"mybook":

gramps	-O	"Family	Tree	1"	-a	book	-p	name=mybook

Команда	разблокирования	базы

-u,	вы	можете	дополнить	команду	-O	командой	-u	чтобы	принудительно	разблокировать	базу	данных.	Это	позволить	снять	блокировку
семейного	древа	(базы	данных),	оставшуюся	после	сбоя,	из	командной	строки.

Пример	(разблокировать	базу	данных	"Family	Tree	1"):

gramps	-O	"Family	Tree	1"	-a	report	-u	>	/dev/null

Обратите	внимание,	что	невозможно	открыть	семейное	древо,	которое	требует	исправления	базы	данных,	из	командной	строки.

Команда	конфигурирования	(config)

Команда	имеет	3	формы:	(следующие	примеры,	исключая	3.2,	используют	behavior.database-path	в	качестве	тестовой	конфигурационной
переменной.)

1)	Увидеть	все	конфигурационные	переменные:

-s	or	--show

Рис.	C.4	Пример	вывода	для	python	gramps.py	-s

2)	Посмотреть	значение	переменной:
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--config=behavior.database-path
или
-c	behavior.database-path

3)	Записать	переменную:

--config=behavior.database-path:'/media/mydb'
или
-c	behavior.database-path:'/media/mydb'

3.1)	Записать	в	переменную	значение	по	умолчанию:

--config=behavior.database-path:DEFAULT
или
-c	behavior.database-path:DEFAULT

3.2)	Записать	несколько	переменных:

--config=behavior.use-tips:False	--config=behavior.autoload:True
или
-c	behavior.use-tips:False	-c	behavior.autoload:True

После	записи	конфигурационной	переменной	(переменных)	Gramps	стартует,	используя	новые	значения.

Использование
Если	первый	аргумент	в	командной	строке	не	начинается	с	дефиса	(т.е.	не	команда),	Gramps	попытается	открыть	файл	с	именем,
указанным	в	первом	аргументе	и	запустить	интерактивную	сессию,	игнорируя	оставшуюся	часть	командной	строки.

Если	задана	команда

-O

,	Gramps	попытается	открыть	соответствующий	файл,	затем	выполнить	остальные	команды	в	командной	строке.

Заметка

За	один	запуск	Gramps	можно	открыть	только	один	файл.	Если	вам	нужно	получить	данные	из
нескольких	источников,	используйте	команду	импорта:

-i

Независимо	от	наличия	команды

-O

,	в	одной	командной	строке	можно	выполнить	несколько	импортов,	экспортов	и	действий,	используя	команды

-i

,

-e

и

-a

Порядок	команд

-i

,

-e

или

-a

друг	относительно	друга	не	важен.	Порядок	выполнения	всегда	одинаков:	сначала	все	импорты	(если	есть),	затем	все	экспорты	(если
есть)	и	затем	все	действия	(если	есть).

Заметка

Но	открытие	всегда	должно	быть	первым!

При	отсутствии	команд

-O
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или

-i

Gramps	покажет	свое	главное	окно	и	запустит	обычную	интерактивную	сессию	с	пустой	базой	данный,	потому	что	данные	для	обработки
нет.	(Если	конечно	вы	не	используете	опцию	всегда	стартовать	с	последней	загруженной	базой	данных).	При	отсутствии	команд

-e

или

-a

Gramps	покажет	свое	главное	окно	и	запустит	обычную	интерактивную	сессию	с	базой	данных,	полученной	после	открытия	и
выполнения	всех	импортов	(если	такие	есть).	Эта	база	данных	располагается	в	директории	~/.gramps/import/,	файле	import_db.grdb.

Все	ошибки,	возникающие	во	время	импорта,	экспорта	или	действий	будут	выведены	в	поток	stdout	(если	исключения	обработаны
Gramps)	или	в	stderr	(если	не	обработаны).	Используйте	обычные	перенаправления	stdout	и	stderr,	чтобы	записать	сообщения	об	ошибках	в
файл.

Примеры
Чтобы	импортировать	четыре	базы	данных	(форматы	которы	определяются	их	именами)	и	после	проверить	полученную	базу
данных	на	ошибки,	наберите:

gramps	-i	file1.ged	-i	file2.gpkg	-i	~/db3.gramps	-i	file4.wft	-a	check

Чтобы	явно	задать	форматы	в	предыдущем	примере,	добавьте	после	имен	файлов	команды	-f:

gramps	-i	file1.ged	-f	gedcom	-i	file2.gpkg	-f	gramps-pkg	-i	~/db3.gramps	-f	gramps-xml	-i	file4.wft	-f	wft	-a	check

Чтобы	сохранить	базу	данных,	полученную	после	всех	импортов,	используйте	команду	-e	(добавьте	команду	-f,	если	Gramps	не
сможет	предположить	формат	исходя	из	имени	файла):

gramps	-i	file1.ged	-i	file2.gpkg	-e	~/new-package	-f	gramps-pkg

Чтобы	сохранить	возможные	сообщения	об	ошибках	в	предыдущих	примерах	в	файлы	outfile	and	errfile,	запустите:

gramps	-i	file1.ged	-i	file2.dpkg	-e	~/new-package	-f	gramps-pkg	>outfile	2>errfile	

Чтобы	импортировать	три	базы	данных	и	запустить	интерактивную	сессию	Gramps	с	результатом:

gramps	-i	file1.ged	-i	file2.gpkg	-i	~/db3.gramps	

Чтобы	открыть	базу	данных	и	создать	по	ней	отчет	с	временной	диаграммой	в	PDF-файл	с	именем	my_timeline.pdf

gramps	-O	'Family	Tree	1'	-a	report	-p	name=timeline,off=pdf,of=my_timeline.pdf	

Список	параметров	отчета

Используй	строку	name=timeline,show=all,	чтобы	выяснить	все	доступные	параметры	отчета.
Чтобы	посмотреть	описание	на	конкретный	параметр,	используйте	строку
show=option_name.Чтобы	узнать	все	доступные	типы	отчетов,	используйте	строку	name=show.

Чтобы	преобразовать	на	лету	grdb	в	.gramps	xml:

gramps	-O	'Family	Tree	1'	-e	output.gramps	-f	gramps-xml

Чтобы	создать	веб-сайт	на	другой	языке	(на	немецком):

LANGUAGE=de_DE;	LANG=de_DE.UTF-8	gramps	-O	'Family	Tree	1'	-a	report	-p	name=navwebpage,target=/../de	

Ну	и	наконец,	чтобы	запустить	обычную	интерактивную	сессию	Gramps:

gramps

Переменные	окружения
Gramps	использует	следующие	переменные	окружения	(но	вы	не	должни	их	менять,	если	не	уверены	в	последствиях):

GRAMPSHOME	-	если	установлена,	перекрывает	настройки	пути	по	умолчанию	к	профилю,	что	позволяет	использовать,
например,	сетевые	диски	для	сохранения	данных	и	всех	настроек.	Для	технически	продвинутых	пользователей,	которые	запускают
несколько	версий	Gramps,	установка	разных	значений	переменной	$GRAMPSHOME	позволяет	избежать	взаимного	влияния	этих
версий.
LANG	-	используется	Gramps	для	определения	загружаемого	файла	языковой	поддержки.

Пред Содержание След
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Папка	Gramps

Пред Содержание След

В	этом	разделе	описано,	где	Gramps	создает	каталог	с	Вашими	данными	в	различных	операционных	системах.

Примечание

Местоположение	каталога	Gramps	с	Вашими	данными	зависит	от	операционной	системы,
которую	Вы	используете...
Везде	ниже	<~username>	должно	быть	заменено	на	имя	пользователя,	под	которым	Вы	зашли	на
компьютер.

POSIX	-	системы
По	умолчанию	путь	к	пользовательскому	каталогу	Gramps	в	POSIX	окружении:

/home/<~username>/.gramps

Такое	расположение	справедливо	для	BSD,	Linux,	Solaris,	Unix	и	OS-X,	если	собирать	из	исходных	кодов.

Mac	OS	X

На	платформе	Mac	файлы,	которые	начинаются	с	"."	не	видны	в	Finder.	Чтобы	сделать	доступ	к	каталогу	Gramps	проще,	откройте	окно
терминала	Finder-Applications-Utilities-Terminal	и	наберите	там

ln	-s	.gramps	gramps_user_directory

что	позволит	Finder	показать	содержимое.	Или	нажмите	Go	->	'Go	to	Folder...'	в	Finder	и	наберите

~/.gramps

в	окне	диалога	Go	to	Folder.

По	умолчанию	для	Mac	OS	X:Application	package	пакет	расположен	в

/Users/<username>/Library/Application	Support/gramps

MS	Windows

По	умолчанию	каталог	с	программой	и	пользовательскими	данными	не	отображаются	в	Проводнике.	Для	доступа	к	каталогу	пользователя
Gramps	следуйте	совету	Microsoft:

Показать	скрытые	файлы	-	Справка	Windows

По	умолчанию	путь	установки	Gramps	в	Windows	7	и	выше

C:\Program	Files\GrampsAIO64-5.X.X

или

C:\Program	Files	(x86)\GrampsAIO32-5.X.X

Расположение	пользовательских	данных	в	Windows	7	и	выше

C:\Users\<~username>\AppData\Roaming\gramps

Пред Содержание След
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Error	and	Warning	Reference

Previous Index Next

This	section	explains	what	to	do	when	something	unexpected	happens.

When	something	goes	wrong
Sometimes	something	goes	wrong,	either	because	you	have	asked	to	do	something	that	Gramps	doesn't	know	how	to	do,	or	because	something	has
happened	that	the	developers	of	Gramps	did	not	anticipate,	or	because	there	is	a	mistake	in	the	coding	of	Gramps.

Not	all	errors	and	warnings	are	obvious

Sometimes	all	the	errors	do	not	appear	on	the	screen.	If	something	unexpected	happens,	you	may	need	to
dig	a	little	deeper	to	see	all	the	error	messages	in	the	Gramps.log	file.

Alerts
An	alert	is	a	dialog	that	appears	when	Gramps	needs	to	give	you	an	important	message	about	an	error	condition	or	warn	you	about	potentially
hazardous	situations	or	consequences.

Most	alerts	are	self	explanatory,	and	the	same	type	of	alerts	that	you	might	get	with	any	application.	These	are	not	discussed	further	here.

However,	some	alerts	require	more	complicated	actions,	so	they	are	described	below.	

Abort	changes?

Fig.	E.1	"Abort	changes?"	dialog

The	 Abort	changes? 	dialog	is	shown	when	you	select	menu	Family	Trees	->Abandon	Changes	and	Quit.	you	can	use	the	 Cancel 	button
to	continue	your	editing	session	or	 Abort	changes 	button	to	return	the	family	tree	to	the	state	it	was	before	you	started	the	editing	session.

Are	you	sure	you	want	to	upgrade	this	Family	Tree?

Fig.	E.2	"Are	you	sure	you	want	to	upgrade	this	Family	Tree?"	dialog
-	Db	Upgrade	Required	-	example
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Fig.	E.3	"Are	you	sure	you	want	to	upgrade	this
Family	Tree?"	dialog	-	BSDDB	conversion	-	example

Fig.	E.4	"Are	you	sure	you	want	to	upgrade	this	Family	Tree?"	dialog
-	BSDDB	Upgrade	Required	Error	-	example

Fig.	E.5	"Are	you	sure	you	want	to	downgrade	this	Family	Tree?"
dialog	-	BSDDB	Downgrade	Required	Error	-	example

Fig.	E.6	"Are	you	sure	you	want	to	upgrade	this	Family	Tree?"	dialog
-	Python	Upgrade	Required	Error	-	example

These	dialogs	appear	for	the	listed	reasons:

"Db	Upgrade	Required"	-	If	you	try	to	open	a	Db(Sqlite3)	Family	Tree	created	with	a	previous	older	version	of	Gramps	with	a	newer	version
of	Gramps.
"BSDDB	Upgrade	Required	Error"	-	superseded	BSDDB	database	Family	must	be	converted	to	a	current	Database	engine	(typically	SQLite)
for	Gramps.
"BSDDB	Upgrade	Required	Error"	-	If	you	try	to	open	a	BSDDB	Family	Tree	created	with	a	previous	older	version	of	Gramps	with	a	newer
version	of	Gramps.
"BSDDB	Downgrade	Required	Error"	-	If	you	try	to	open	a	BSDDB	Family	Tree	created	with	a	previous	older	version	of	BSDDB	with	a
newer	version	of	BSDDB.
"Python	Upgrade	Required	Error"	-	If	you	try	to	open	a	BSDDB	Family	Tree	created	with	a	previous	older	version	of	Gramps	using	Python	2
with	a	newer	version	of	Gramps	that	uses	Python	3.

For	each	of	these	reasons	you	may	follow	the	same	general	advice;	if	you	still	have	the	older	version	of	Gramps	available,	then	you	should:
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Cancel 	this	dialog,	and	exit	Gramps
Open	the	Family	Tree	with	the	previous	version	of	Gramps	(Reinstall	the	old	version	of	Gramps),
Export	your	family	tree	in	Gramps	XML	(family	tree)	export	format	or	Gramps	XML	Package	(family	tree	and	media)	format,
Exit	the	old	version	of	Gramps	and	Start	the	new	version	of	Gramps,
Open	the	Family	Tree	in	the	new	version	of	Gramps	and	click	the	
I	have	made	a	backup,	please	upgrade	my	Family	Tree 	button	in	this	dialog

Error	parsing	arguments

Fig.	E.7Error	parsing	arguments	-	dialog	-	Database	is
locked	example

The	Family	Tree	database	is	locked	while	in	use	by	another	user	or	because	Gramps	exited	abnormally	during	previous	use.

See	Unlocking	a	Family	Tree	

Database	is	locked.	cannot	open	it!

The	Family	Tree	database	is	locked	while	in	use	by	another	user	or	because	Gramps	exited	abnormally	during	previous	use.

See	Unlocking	a	Family	Tree	

Cannot	open	database

Fig.	E.8	Dialogue	showing	DB	Environment	Error

Fig.	E.9	Dialogue	showing	DB	Version	Error

As	explained	in	the	dialogue,	the	Family	Tree	was	probably	created	with	an	old	version	of	the	Berkeley	database	program.	This	is	not	quite	the	same
thing	as	an	old	version	of	the	Gramps	program,	because	the	version	of	the	Gramps	program	and	the	version	of	the	Berkeley	database	are
independent.	However,	the	effect	is	somewhat	the	same.	As	suggested	in	the	dialogue,	if	you	have	the	old	version	of	Gramps	and	its	support
software,	then	you	should:

cancel	this	dialogue,
open	the	Family	Tree	with	the	previous	version	of	Gramps,
export	your	family	tree	in	Gramps	XML	database	export	format	or	Gramps	package	export	format	(see	Export	into	Gramps	formats),
start	the	new	version	of	Gramps,
open	the	'Manage	Family	Tree'	dialogue,
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click	on	 new 	and	create	a	new	Family	Tree,
load	the	new	Family	Tree
Import	the	Gramps	XML	or	Gramps	package.

Alternatively,	it	may	be	possible	to	use	the	recovery	tools.	See	'obtain	the	bsddb	recovery	tools'	under	Recover	corrupted	family	tree	

Low	level	database	corruption	detected

Fig.	E.10	"Low	level	database	corruption	detected"	dialog	-	example

This	dialogue	appears	when	a	problem	is	detected	with	the	underlying	database	that	supports	Family	Trees.

close	the	dialogue,
click	on	the	Family	Tree	Manager,
select	the	Family	Tree	you	were	trying	to	open,
the	 Repair 	button	should	be	available;	click	on	it,
once	the	Family	Tree	has	been	repaired	it	should	be	possible	to	open	it	in	the	normal	way.

If	this	does	not	work,	try	'obtain	the	bsddb	recovery	tools'	under	Recover	corrupted	family	tree	

Error	detected	in	database

Fig.	E.11	Dialogue	showing	Run	Database	Repair

Carry	out	suggested	action.	

Warnings
If	Gramps	detects	a	minor	error,	or	wishes	to	notify	you	about	an	occurrence	within	the	program,	then	Gramps	may	display	a	 �	Warning 	button
on	the	status	bar,	as	shown	below.	This	button	is	only	displayed	for	180	seconds,	so	if	you	see	it	you	should	immediately	click	on	it	if	you	want	to
see	the	messages.

Warning	button
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Fig.	E.12	Gramps	Main	Window	showing	Warning	button	on	the	Status
bar

The	 Warning 	button	(light	bulb	icon)	

Gramps	Warnings	dialog

Fig.	E.13	Gramps	Main	Window	showing	Warning	message	and	context	menu

If	you	click	the	 �	Warning 	button,	then	a	 Gramps	Warnings 	dialog	box	appears	showing	the	last	20	messages	received.

You	may	use	the	context	menu	to	copy	the	details	to	a	text	file.

See	More	details	about	the	Logging	system	

Some	of	the	warnings	that	may	appear	are	described	below:

Locale	warnings

Sometimes	there	is	a	problem	with	the	language	you	have	chosen.

If	you	have	installed	Gramps	using	your	platform's	standard	installation	method	(Package	manager/AIO	installer/Application	package)	and	are
using	your	platform's	built-in	mechanism	(System	Setting/Control	Panel/System	Preferences)	to	choose	the	language/sort	order/formats	you	are
running	in,	then	these	errors	should	not	occur,	and	may	mean	there	is	a	problem	in	Gramps.

However,	if	you	have	set	the	language/sort	order/formats	manually	by	setting	the	'environment'	see	 languages,	particularly	if	you	are	running
Gramps	from	the	command	line,	then	there	may	be	a	problem	with	what	you	have	typed	in.	The	message	(only	part	of	which	is	shown	below)
should	help	you	to	understand	where	the	error	is.

"Date	parser	for	'%s'	not	available,	using	default"
"Date	displayer	for	'%s'	not	available,	using	default"
"Family	relationship	translator	not	available	for	language	'%s'.	Using	'english'	instead."
'Unable	to	determine	your	Locale,	using	English'
"Localization	library	libintl	not	on	%PATH%,	localization	will	be	incomplete"
"No	translations	for	%s	were	found,	setting	localization	to	U.S.	English"
"Unable	to	create	collator:	%s"
"No	language	provided,	using	US	English"
"No	usable	languages	found	in	list,	using	US	English"
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"None	of	the	requested	languages	(%s)	were	available,	using	%s	instead"

Module	not	loaded	warnings

The	Gramps	application	contains	many	different	'modules'.	Some	of	these	modules	are	required	for	Gramps	to	run	at	all;	some	are	'strongly
recommend',	and	some	are	optional.

If	you	have	installed	Gramps	using	your	platform's	standard	installation	method	(Package	manager/AIO	installer/Application	package)	then	the
builder	of	that	package	will	have	decided	which	modules	are	present.	He	must	include	all	the	required	modules,	because	otherwise	Gramps	will	not
run,	but	he	can	choose	which	of	the	recommended	and	optional	packages	he	includes.	Consult	the	documentation	for	your	package	to	determine
which	modules	are	included.

If	you	try	to	do	something	that	needs	a	module	that	is	not	included,	then	you	will	get	a	warning	like	the	ones	below	(only	the	first	part	of	the
message	is	included).	What	you	can	do	about	it	depends	on	your	platform:

Linux	You	should	be	able	to	install	the	package	using	your	distribution's	standard	Package	Manager	or	the	GUI	interface	to	the	Package	Manager.
However,	in	some	cases	you	will	need	to	build	the	module	from	source.

MS	Windows	and	macOS	The	MS	Windows	AIO	installer	and	the	macOS	Application	bundle	come	with	certain	modules	built	in.	It	is	not	possible
for	the	normal	user	to	add	further	modules.	Therefore,	if	you	find	a	module	that	you	particularly	feel	should	be	included	you	should	post	on	the
Gramps	Forum	(probably	the	Development	section)	explaining	why	you	feel	its	omission	is	a	mistake.

"WARNING:	PIL	module	not	loaded.	"
"ICU	not	loaded	because	%s.	Localization	will	be	impaired.	"
"OsmGpsMap	module	not	loaded.	"
"GExiv2	module	not	loaded.	"
"Webkit	module	not	loaded.	"
"PIL	(Python	Imaging	Library)	not	loaded.	"
"GtkSpell	not	loaded.	"

Show	plugin	status	dialog	on	plugin	load	error

Allows	showing	dialog	following	the	Plugin	Registration	process	as	Gramps	starts.	The	dialog	reports	plugins	that	cause	an	error	during
registration.	This	allows	users	to	find	and	resolve	plugin	problems.

The	dialog	can	be	suppressed	from	 Show	plugin	status	dialog	on	plugin	load	error. 	option	in	the	 Warnings 	tab	of	the	Edit	->
Preferences	dialog.

The	error	conditions	that	would	trigger	the	plugin	error	status	dialog	are	primarily	handled	in	the	`load_plugin`	function	of	the	`PluginManager`
class.	Here	are	the	main	error	conditions:

1.	Plugin	Registration	File	Errors:

Missing	or	invalid	gramps_target_version	(gen/plug/_manager)
Incorrect	plugin	version	format	(gen/plug/_manager)
Missing	required	attributes	for	the	specific	plugin	type	(gen/plug/_manager)

2.	Module	Import	Errors:

The	plugin's	main	Python	file	cannot	be	imported	(gen/plug/_manager)

3.	Plugin	Initialization	Errors:

Exceptions	raised	during	the	plugin's	initialization	process	(gen/plug/_manager.py)

4.	Version	Incompatibility:

The	plugin's	gramps_target_version	does	not	match	the	running	Gramps	version	(gen/plug/_manager)

5.	Duplicate	Plugin	IDs:

Multiple	plugins	with	the	same	ID	are	detected	(gen/plug/_manager)

6.	Invalid	Plugin	Type:

PTYPE	specified	is	not	recognized	(gen/plug/_manager	and	gui/viewmanager)

Configuration	warnings

Sometimes	it	is	worth	just	deleting	the	old	configuration	files.
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"Importing	old	key	file	'keys.ini'..."	(The	.gramps/keys.ini	file	was	deprecated	in	Gramps	3.2,	now	.gramps/gramps60/gramps.ini	)
"Done	importing	old	key	file	'keys.ini'"
"Can't	find	filter	%s	in	the	defined	custom	filters"
"Number	of	arguments	does	not	match	number	of	"	+
"Value	'%(val)s'	not	found	for	option	'%(opt)s'"
"Unable	to	open	recent	file	%s	because	%s",
"WARNING:	ignoring	old	key	'%s'"
"WARNING:	ignoring	key	with	wrong	type	"
"Failed	to	parse	doc	options"
"Skipped	a	line	in	the	addon	listing:	"
"Failed	to	load	gramplets	from	%s	because	%s"

Other	warnings

Cannot	save	person

Fig.	E.14	Cannot	save	person	(Warning	window)

Attempting	to	save	a	person	without	any	data	from	the	Person	editor	displays	this	warning	popup.	You	need	at	least	one	letter	for	the	first	name.

Cannot	save	person
No	data	exist	for	this	person.	Please	enter	data	or	cancel	the	edit.
Close

Cannot	merge	<object>

Fig.	E.15	Cannot	merge	person	(Warning	dialog)	-	example

Attempting	to	merge	anything	other	than	two(2)	of	one	type	of	record	displays	this	warning	popup	dialog.

For	example:

Cannot	merge	people
Exactly	two	people	must	be	selected	to	perform	a	merge.	A	second	person	can	be	selected	by	holding	down	the	control	key	while	clicking	on	the
desired	person.

Close
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Duplicate	Family	warning	dialog

Duplicate	Family 	Warning

If	you	create	a	new	family	and	select	parents	that	are	already	in	an	existing	family,	Gramps	will	issue	the
Duplicate	Family 	warning	message.	If	you	proceed	by	saving	the	new	family,	you	will	have	a
duplicate	family.

Fig.	E.16	Duplicate	Family	-	warning	dialog

Suppress	warning	when	adding	parents	to	a	child

Can	be	enabled	from	 Suppress	warning	when	adding	parents	to	a	child. 	option	in	the	Preferences	>	Warnings	dialog.

Adding	parents	to	a	person	dialog

Fig.	E.17	"Adding	parents	to	a	person"
warning	dialog

Suppress	warning	when	cancelling	with	changed	data

Can	be	disabled	from	 Suppress	warning	when	cancelling	with	changed	data. 	option	in	the	Preferences	>	Warnings	dialog.

Used	by	the	Edit	Person	dialog.
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Save	Changes?	dialog

Fig.	E.18	"Save	Changes?"	-	alert	dialog

Suppress	warning	about	missing	researcher	when	exporting	to	GEDCOM

File:Xxx.png
Fig.	E.19	xxx

Can	be	disabled	from	 Suppress	warning	about	missing	researcher	when	exporting	to	GEDCOM.	option	in	the	Preferences	>
Warnings	dialog.

Delete	confirmation	dialog

Fig.	E.20	Delete	confirmation	dialog	for	the	"Undo
History"	dialog

Are	you	sure	you	want	to	clear	the	Undo	history?	Select	 Clear 	to	confirm	or	 Cancel 	to	exit.	

Undo	history	warning

Fig.	E.21	Tool	"Undo	history	warning"	dialog	-
default

The	 Undo	history	warning 	dialog	will	be	shown	and	you	can	either	 Stop 	or	 Proceed	with	the	tool/import .	It	is	recommended
that	you	stop	and	backup	your	database;	so	that	you	can	revert	the	process	of	running	the	tool	(or	import)	if	required.	

Error	and	Warning	Reference	-	Low	level	database	corruption	detected 362

http://www.gramps-project.org/wiki/index.php/File:SaveChanges-alert-dialog-50.png
http://www.gramps-project.org/wiki/index.php?title=Special:Upload&wpDestFile=Xxx.png
http://www.gramps-project.org/wiki/index.php/File:Gramps-notes.png
http://www.gramps-project.org/wiki/index.php/File:Delete-confirmation-dialog-Undo-History-60.png
http://www.gramps-project.org/wiki/index.php/File:UndoHistoryWarning-Tool-dialog-52.png


This	article's	content	is	incomplete	or	a
placeholder	stub.
Please	update	or	expand	this	section.

Fig.	E.22	Import	"Undo	history	warning"	dialog	-
default

Undo	history	warning

Proceeding	with	this	 process 	will	erase	the	undo	history	for	this	session.	In	particular,	you	will	not	be
able	to	revert	the	changes	made	by	this	tool	or	any	changes	made	prior	to	it.

If	you	think	you	may	want	to	revert	running	this	process,	please	stop	here	and	backup	your	database.

No	selected	book	item

No	selected	book	item	-	warning

You	will	see	 No	selected	book	item 	warning	dialog	when	the	Books	Report	when	you	have	not	selected	the	item	first	in	the	Current	book
section	of	the	Manage	Books	dialog.	

Person	<____>	is	not	in	the	Database

File:Xxx-52.png
Person	<____>	is	not	in	the
Database}}	warning	dialog

Person	____	is	not	in	the	Database	warning	dialog	will	be	shown	if	the	Center	Person	is	Private	or	Living	when	the	filtering	options
on	the	Report	Options	(2)	tab	settings	for	do	not	allow	Private	or	Living	Persons	are	used.

Autobackup...

"Autobackup..."	notification	on	exit	warning	dialog

The	 Autobackup... 	Please	wait	for	backup	to	complete.	notification	on	exit	dialog	is	shown	when	exiting	Gramps	to	indicate	an	Automatic
Backup	is	in	progress.

See	also:

Edit	➡	Preferences...	 Family	Tree 	tab's	Backup	Management	section	for	the	 [	]Backup	on	exit 	and	 Autobackup: 	options.

Error	and	Warning	Reference	-	Low	level	database	corruption	detected 363

http://www.gramps-project.org/wiki/index.php/File:UndoHistoryWarning-Import-dialog-52.png
http://www.gramps-project.org/wiki/index.php/File:Gnome-important.png
http://www.gramps-project.org/wiki/index.php/File:No-selected-book-item-warning-52.png
http://www.gramps-project.org/wiki/index.php?title=Special:Upload&wpDestFile=Xxx-52.png
http://www.gramps-project.org/wiki/index.php/File:Gramps-notes.png
http://www.gramps-project.org/wiki/index.php/File:Autobackup.notification.on.exit-52.png


Backup:	Add	a	popup	to	show	the	gramps	state	#1416

Could	Not	Set	a	Bookmark

"Could	Not	Set	a	Bookmark"	warning	dialog

A	bookmark	could	not	be	set	because	nothing	was	selected.	

Opening	the	'<xxxxxxx>'	database

File:Opening-the-xxxxxxx-
database-warning-60.png
"Opening	the	'<xxxxxxx>'
database"	warning	dialog

You	may	see	the	"Opening	the	'<xxxxxxx>'	database"	warning	dialog	when	attempting	to	convert	the	Database	Type	from	BSDDB	to	SQLite	.

An	attempt	to	convert	the	database	failed.	Perhaps	it	needs	updating.	

Errors
More	serious	problems	cause	an	 Error	Report 	dialog	to	be	shown	which	will	describe	the	actions	you	should	take.

Error	Report

Fig.	E.23	Error	Report	Assistant	-	dialog	-	collapsed	"Error
Detail"	-	default

The	 Error	Report 	dialog	appears	whenever	something	has	happened	in	the	Gramps	application	that	the	programmers	did	not	expect.

Have	a	read	of	the	How	to	create	a	good	bug	report	article.	If	you	believe	you	know	how	the	Gramps	developers	might	reproduce	the	bug	or	not,
then	select	the	 Report 	button	to	start	the	 Error	Reporting	Assistant 	dialog,	and	you	can	then	follow	the	instructions.	

Fig.	E.24	Error	Report	Assistant	-	dialog	-	expanded	"Error
Detail"	-	default
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Error	Reporting	Assistant	dialog

Allows	you	an	opportunity	to	compile	a	report	about	an	error	and	then	submit	it	manually	to	the	Gramps	bug	reporting	system	(This	requires	you	to
have	a	registered	account	on	the	Gramps	bug	reporting	system	and	then	login	into	your	bug	tracker	account.)

Using	the	bug	tracker

The	Error	Reporting	Assistant	is	also	known	as	the	Bug	Reporting	Assistant.	

Report	a	bug	page

Fig.	E.25	Report	a	bug	(page)	-	Error	Reporting	Assistant

This	is	the	Bug	Reporting	Assistant.	It	helps	to	make	a	bug	report	to	the	Gramps	developers	that	will	be	as	detailed	as	possible.

The	assistant	asks	a	few	questions	and	gathers	some	information	about	the	error	that	just	occurred	and	the	operating	environment.

At	the	end	of	the	assistant	process,	you	will	be	asked	to	file	a	bug	report	through	the	Gramps	bug	tracking	system.

The	assistant	will	copy	the	bug	report	to	the	Operating	System	clipboard.	This	allows	you	to	paste	it	into	the	form	on	the	Gramps	bug	tracking	and
review	exactly	what	information	you	want	to	include.	

Error	Details	page

Fig.	E.26	Error	Details	(page)	-	Error	Reporting	Assistant	(Showing
example	error)

If	you	can	see	that	there	is	any	personal	information	included	in	the	error	please	remove	it.

This	is	the	detailed	Gramps	error	information,	don't	worry	if	you	do	not	understand	it.	You	will	have	the	opportunity	to	add	further	detail	about	the
error	in	the	following	pages	of	the	assistant.	

System	Information	page
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Fig.	E.27	System	Information	(page)	-	Error	Report	Assistant

This	is	the	information	about	your	system	that	will	help	the	developers	to	fix	the	bug.	

Further	Information	page

Fig.	E.28	Further	Information	(page)	-	Error	Reporting	Assistant

Please	provide	as	much	information	as	you	can	about	what	you	were	doing	when	the	error	occurred.

This	is	your	opportunity	to	describe	what	you	were	doing	when	the	error	occurred.	

Bug	Report	Summary	page
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Fig.	E.29	Bug	Report	Summary	(page)	-	Error	Reporting	Assistant

This	is	the	completed	bug	report.	The	next	page	of	the	assistant	will	help	you	to	file	a	bug	on	the	Gramps	bug	tracking	system	website.	

Send	Bug	Report	page

Fig.	E.30	Send	Bug	Report	(page)	-	Error	Reporting	Assistant

Use	the	two	buttons	below	to	first	copy	the	bug	report	to	the	clipboard	and	then	open	a	webbrowser	to	file	a	bug	report	at	https://gramps-
project.org/bugs/login_select_proj_page.php?ref=bug_report_page.php

Send	Bug	Report 	-	This	is	the	final	step.	Use	the	buttons	on	this	page	to	start	a	web	browser	and	file	a	bug	report	on	the	Gramps	bug
tracking	system	(This	assumes	you	already	have	an	user	account	on	the	bug	tracker,	if	not	signup	for	one	first	and	then	login	into	your	bug
tracker	account.)

File	bug	report 	-	Use	this	button	to	start	a	web	browser	and	file	a	bug	report	on	the	Gramps	bug	tracking	system.
Copy	to	clipboard 	-	Use	this	button	to	copy	the	bug	report	onto	the	clipboard.	Then	go	to	the	bug	tracking	website	by	using	the
button	below,	paste	the	report	and	click	submit	report

Complete	page
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Fig.	E.31	Complete	(page)	-	Error	Reporting	Assistant

Gramps	is	an	Open	Source	project.	Its	success	depends	on	its	users.	User	feedback	is	important.	Thank	you	for	taking	the	time	to	submit	a	bug
report.	

Other	Errors

Report	could	not	be	created

File:Xxxx.png
Fig.	E.32	Report	could	not
be	created	dialog

The	 Report	could	not	be	created 	dialog	can	occur	for	various	reasons,	eg:	one	reason	is	that	the	custom	paper	size	you	have	chosen	for
the	report	is	too	large	for	PDF	format	that	is	being	used.

PDF	size	limits

Each	Adobe	PDF	Version	format	specification	has	a	maximum	page	size	limit,	for:

PDF	Version	1.4	(Acrobat	5.0)	and	PDF	Version	1.5	(Acrobat	6.0)	the	maximum	PDF	page	size	is
200"	x	200"	inches	(508cm	x	508cm)
PDF	Version	1.6	(Acrobat	7.0)	and	newer	the	theoretical	PDF	page	size	is	15,000,000"	x
15,000,000"	inches	(38,100,000cm	x	38,100,000cm)	but	in	reality	most	programs	do	not	properly
support	any	sizes	above	200"	x	200"	inches	(508cm	x	508cm).

See	PDF	From	Wikipedia.

Seeing	all	the	error	messages
Sometimes,	not	all	the	information	needed	to	understand	what	has	gone	wrong	will	appear	on	the	screen.	For	example,	if	you	start	Gramps	with	an
invalid	language	setting	(and	some	missing	components)	then	the	message	that	appears	in	the	 Warnings 	dialog	is:

Fig.	E.33	Dialogue	showing	limited	warnings

However,	the	full	set	of	warning	messages	is:

(process:10929):	Gtk-WARNING	**:	Locale	not	supported	by	C	library.
	Using	the	fallback	'C'	locale.
2013-03-13	18:49:04.376:	WARNING:	__init__.py:	line	69:	Date	parser	for	'xx_XX.UTF-8'	not	available,	using	default
2013-03-13	18:49:04.547:	WARNING:	__init__.py:	line	85:	Date	displayer	for	'xx_XX.UTF-8'	not	available,	using	default
2013-03-13	18:49:05.949:	WARNING:	spell.py:	line	74:	Spelling	checker	is	not	installed
2013-03-13	18:49:16.023:	WARNING:	gramplet.gpr.py:	line	400:	WARNING:	GExiv2	module	not	loaded.		Image	metadata	functionality	will	not	be	available.

Sometimes	Gramps	just	doesn't	start	and	nothing	appears	on	the	screen,	or	Gramps	suddenly	quits	so	you	don't	see	anything	on	the	screen.	In	all
these	cases	you	may	need	to	do	something	special	to	see	all	the	errors.
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Linux

You	can	start	Gramps	from	the	Command	Line,	as	described	in	the	note	here.	You	will	then	see	all	the	diagnostic	information	on	the	terminal.

MS	Windows

You	can	start	Gramps	from	the	Command	Line,	as	described	in	the	note	here.	You	will	then	see	all	the	diagnostic	information	on	the	terminal.

macOS

Starting	Gramps	through	the	CLI	on	macOS	is	covered	 here.

Console	application

You	can	also	look	at	log	messages	from	Gramps	using	Apples	 Console	application .	The	Console	application	is	located	in	your	Mac's
Utilities	folder,	which	is	found	in	the	Applications	folder.	(A	shortcut	on	recent	versions	of	macOS	is	to	press	Command	and	the	space	bar	to	start	a
Spotlight	search.	In	the	resulting	pop	up	window,	enter	the	first	few	characters	of	the	word	"Console"	and	then	select	the	Console	application.)

For	example,	one	of	the	early	alpha	releases	of	Gramps	just	would	not	start	and	displayed	nothing	on	the	screen.	However	by	opening	the	Console
application,	and	typing	Gramps	in	the	filter	at	the	top	right	hand	corner	some	diagnostic	information	appeared.	(Actually	we	typed	"gramps["
because	there	were	some	other	messages	that	were	not	relevant,	but	it	wouldn't	matter	if	they	were	included	as	well).

Fig.	E.34	Console	output

By	shift	clicking	to	select	all	the	relevant	messages	and	copying	them	we	get:

01/03/2013	00:08:02	[0x0-0x88088].org.gramps-project.gramps[1867]	2939:	ERROR:	importer.py:	line	51:	Could	not	find	any	typelib	for	Gtk	
01/03/2013	00:08:05	[0x0-0x88088].org.gramps-project.gramps[1867]	Gtk	typelib	not	installed.	Install	Gnome		Introspection,	and	pygobject	version	3.3.2	or	later.	
01/03/2013	00:08:05	[0x0-0x88088].org.gramps-project.gramps[1867]	Gramps	will	terminate	now.	

In	this	particular	case,	this	was	enough	to	help	the	developer	discover	the	problem.

Previous Index Next
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Информация	о	Gramps

Пред Содержание След

Fig	E.1	Окно	"О	Gramps"

О	Gramps

Основной	автор

Программу	Gramps	создал	Дональд	Н.	Эллингэм	([email	protected]).

Участники

Здесь	не	совсем	полный	список	тех,	кто	принимал	участие	в	создании	Gramps	(в	алфавитном	порядке	по	имени):

Alexander	Bogdashevsky
Alexander	Roitman
Alexandre	Duret-Lutz
Alexandre	Prokoudine
Anton	Huber
Arkadiusz	Lipiec
Arpad	Horvath
Arturas	Sleinius
Baruch	Even
Benny	Malengier
Bernd	Felsche
Bernd	Schandl
Billy	C.	Earney
Brian	Matherly
Bruce	J.	DeGrasse
Daniel	Durand
David	R.	Hampton
Donald	A.	Peterson
Douglas	S.	Blank
Eero	Tamminen
Egyeki	Gergely
Frederick	Noronha
Frode	Jemtland
Gary	Burton
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Gary	Shao
Greg	Kuperberg
Guillaume	Pratte
Ivan	Komaritsyn
James	Treacy
Jason	Salaz
Jeffrey	C.	Ollie
Jens	Arvidsson
Jérôme	Rapinat
Jesper	Zedlitz
Jim	Smart
Jiri	Pejchal
John	Doorty
Julio	Sanchez
Kees	Bakker
Larry	Allingham
Lars	Kr.	Lundin
Laurent	Protois
Leonid	Mamtchenkov
Lorenzo	Cappelletti
Lubo	Vasko
Luiz	Gonzaga	dos	Santos	Filho
Marcos	Bedinelli
Mark	Knoop
Martin	Hawlisch
Martin	Senftleben
Matt	Brubeck
Matthieu	Pupat
Michel	Guitel
Mirko	Leonhäuser
Nathan	Bullock
Nick	Hall
Paul	Franklin
Pier	Luigi	Cinquantini
Radek	Malcic
Radu	Bogdan	Mare
Richard	Bos
Richard	Taylor
Sam	Manzi
Samuel	Tardieu
Sebastian	Voecking
Serge	Noiraud
Soren	Roug
Stefan	Bjork
Stéphane	Charette
Steve	Hall
Steve	Swales
Tim	Allen
Tim	Waugh
Tino	Meinen
Trevor	Rhodes
Wayne	Bergeron
Xing	Wang
Yaakov	Selkowitz

Если	Вы	знаете	кого-то	ещё,	кто	должен	быть	представлен	в	этом	списке,	сообщите	об	этом	нам.

Появилось	замечание	или	идея?
Сообщите	об	ошибке	или	сделайте	предложение	по	программе	или	этому	руководству,	используя	пункт	меню	Справка	>	Отправить
отчёт	об	ошибке	в	Gramps	или	следуйте	инструкциям	на	этой	странице.

Лицензия
Эта	программа	распространяется	под	лицензией	GNU	General	Public	license,	опубликованной	фондом	Free	Software	Foundation.	Версия
лицензии	2	или	любая	из	более	поздних	на	Ваш	выбор.	Текст	этой	лицензии	можно	найти	по	ссылке	или	в	файле	COPYING,	который
распространяется	вместе	с	исходными	кодами	программы.
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Gramps	Glossary
This	glossary	gives	an	overview	of	terms	that	appear	in	Gramps,	with	a	short	description,	and	a	link	to	relevant	articles.	(Since	knowing	a	feature's
name	is	necessary	for	finding	the	corresponding	glossary	term,	also	refer	to	the	Visual	Guide	to	the	Gramps	Interface.)

For	a	glossary	of	genealogical	terms,	see	Genealogy	Glossary	and	Latin	words	and	expressions.

	A		B		C		D		E		F		G		H		I		J		K		L		M		N		O		P		Q		R		S		T		U		V		W		X		Y		Z

A

Active	Person
(core	concept)	-	The	person	designated	(or	'selected')	as	the	momentary	center	of	focus	in	the	open	Gramps	database.	The	perspective	of	this
person	defines	the	context	for	actions	and	for	displaying	all	the	surrounding	information.	Changing	this	focus	is	done	by	navigating	the
Active	Person	selection	to	another	person.
The	Active	Person's	relationship	to	the	Home	Person	defines	the	scope	of	the	perspective.
N.B.:	There	is	always	an	Active	Person	selection,	even	when	the	primary	object	(aka	record)	selected	in	the	current	view	is	not	a	'Person'
object.

addon
(aka	add-on)
an	optional	third-party	expansion	to	Gramps	that	leverages	Gramps	plugin	customization	framework	to	add	and	register	a	specific	feature.
The	Addon	Manager	allows	installing	and	updating	from	curated	collections	of	Addons.	(These	curated	collections	are	called	"Projects"	in	the
Addon	Manager.)
Addons	may	not	conform	to	the	same	design	or	code	quality	standards	of	builtin	plugin	modules.	Use	with	caution!
Optional	parts	bundled	with	the	core	project	are	called	by	the	more	generic	name:	builtin	plugins.	After	installation	and	being	registered,	both
the	"builtin"	and	"addon"	plugins	may	be	disabled	or	re-enabled	with	the	Plugin	Manager.

address
(sec.	obj.)	-	The	Gramps	concept	of	an	Address	is	a	particular	location	with	an	associated	time	frame.	Think	of	it	as	a	mailing	address.	It	is
intended	to	represent	where	a	person	lived	and	when	the	person	lived	there.	The	Address	consists:

Date
Street	Address
Locality
City
County
State/Province
Postal/Zip	code
Country
Phone

Not	to	be	confused	with	a	Place	which	has	a	fixed	position	(its	location).	Use	this	with	care.	For	genealogical	research	you	can	also	use	the
residence	event	coupled	with	a	Place.	For	mailing	(email,	postal),	add	an	address	to	a	Person	or	Repository.

administrative	division
a	unit	of	a	layered	system	subdividing	a	geopolitical	(geographic	or	political)	region.	Such	divisions	are	recorded	as	Place	Types	in	Gramps.
Meanwhile	the	structure	of	a	Place	Tree	is	built	by	layering	via	the	'Enclosed	by'	tab	in	the	Place	Editor.	The	subdivisions	are	sometimes
categorized	as	an	entity,	locality,	area,	or	region.	The	terms	of	subnational	entity,	constituent	unit,	or	country	subdivision	tend	to	imply
divisions	that	are	more	related	to	political	representation	than	administrative.	
See	wikipedia's	Administrative	division	for	a	conceptional	definition	or	List	of	administrative	divisions	by	country	for	specific	countries.

Aide
(event	role)	A	term	to	refer	to	the	role	of	an	assistant.

anglicisation
process	of	making	something	English.	If	an	immigrant	(or	their	descendant)	adopts	a	naturalized	variation	of	their	birth	name,	that	preferred
alias	can	be	added	with	an	Also	Known	As	name	type	in	the	Names	tab.	All	aliases	can	be	categorized	by	type	and	surname	variants	may	be
grouped	with	the	in	the	Name	Editor.

Association
(sec.	obj.)	-	The	roles	in	Associations	are	to	explicitly	define	the	how	one	person	relates	to	another.
Association	roles	are	used	when	the	relationship	falls	outside	the	implicit	roles	of	a	family	relationship	or	the	explicit	roles	in	shared	events.
These	custom	roles	convey	relationships	that	might	not	readily	apparent...	such	as	a	penpal	or	the	eponymous	person	honored	by	a	namesake.
Association	roles	may	also	be	used	as	placeholder	when	the	actual	genetic	connection	has	not	yet	been	discovered.
Association	roles	are	created	and	edited	with	the	Person	Reference	Editor,	which	includes	no	pre-defined	roles.	This	feature	starts	with	a
blank	list	of	custom	types)	and	the	default	"Godfather"	role	is	only	shown	as	a	hint.

attribute
(sec.	obj.)	-	Attributes	are	for	something	permanent,	or	at	least	somewhat	permanent:	eye	color,	blood	type,	etc.	Usually	you	would	have	not
more	than	one	of	each	attribute	type	for	a	Person/Family/etc.	Attributes	are	managed	from	an	Attributes	tab	in	each	primary	Object	Editor.
There	are	no	builtin	Attributes,	only	custom	types.

B

Books	Report

A	Reports	menu	feature	of	Gramps	that	allows	the	design	or	generation	of	a	repeatable	custom	genealogy	Book.	A	Book	consists	of	an	ordered
collation	of	Gramps	textual	and	graphical	reports	in	a	single	document.	The	individual	report	configuration	options	are	also	stored	with	the	Book	but
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the	Book's	document	pagesize	and	print	destination	configuration	options	override.

Bride
(event	role)	A	term	to	refer	to	the	woman	a	marriage	ceremony	who	will	have	the	role	of	wife	in	the	marriage.	See	also:	mother.

BSDDB
(database	backend	engine)	The	Berkeley	Software	Distribution	database	(also	known	as	BSDDB)	was	the	first	default	database	engine	used
by	the	2.0	through	the	5.0	versions	of	Gramps.	Originally,	Gramps	XML	was	used	directly	rather	than	as	a	Backup	and	data	exchange	format.
The	default	db	engine	changed	to	SQLite	in	the	5.1	version	via	the	DB-API	Database	Backend.	(Manual	updates	to	the	BSDDB	engine	for
the	5.1.3	version	may	be	advisable.)

C

Category
(core	concept)	Gramps	divides	and	organizes	the	information	about	each	Primary	Object	into	a	series	of	different	descriptive	schemas	called
Categories,	each	with	their	own	View.	Each	Category	is	a	smaller,	more	digestible	portion	of	the	total	information	that	comprises	a
Genealogical	Tree.	The	View	categories	are:	 	Dashboard,	 	People,	 	Relationships,	 	Families,	 	Charts,	 	Events,	 	Places,	
	Geography,	 	Sources,	 	Citations,	 	Repositories,	 	Media,	 	Notes

Celebrant
(event	role)	A	term	describing	a	role	of	the	person	who	performs	a	rite,	especially	referring	to	a	priest	at	the	Eucharist.

Citation
( 	prim.	obj.)	-	Contains	the	information	that	enables	you	or	others	to	locate	your	source	document.	An	isolated	Citation	can	be	created
without	first	creating	separate	Source	object.	But,	should	the	same	source	be	referenced	repeatedly	in	a	Tree,	a	separate	Source	simplifies	the
Citation	and	eliminates	redundant	information	that	must	be	harmonized.

Clergy
(event	role)	A	term	applied	to	a	religious	person	regardless	of	religion.	For	example,	a	monk	or	priest.	See	also:	celebrant.
Religious	terminology	is	often	subject	to	dispute,	see	the	Merriam-Webster	for	an	independent	definition.

Clipboard
(graphical	user	interface	terminology)	-	The	Gramps	Clipboard	is	a	shortcut	system	for	sharing	a	secondary	object,	navigation,	and	custom
filter	creation.	
Usage:	The	Clipboard	can	be	opened	from	a	icon	on	the	Toolbar,	the	Clipboard	choice	in	the	Edit	menu	or	a	keybinding.	A	floating	clipboard
dialog	that	has	become	buried	can	be	brought	to	the	top	of	the	stack	by	selecting	Clipboard...	from	the	Windows	menu.
The	Clipboard	can	greatly	improve	data	entry	efficiency,	see	the	"How	to	use	the	Gramps	Clipboard"	article	for	more	information.

Context	menu
(graphical	user	interface	terminology)	-	a	contextual	pop-up	menu	(aka	"context	menu")	is	a	menu	that	appears	when	right-clicking	(or
pressing	the	Menu	keyboard	key)	when	the	menu	options	directly	relate	to	the	item	indicated	by	the	mouse	pointer.	Thus,	the	indicated	item
provided	the	"context."

custom	Types
This	indicates	a	user-defined	classification,	as	opposed	to	classifications	that	came	pre-defined	in	Gramps.	(i.e.:	'Birth'	and	'Marriage'	are	2	of
the	pre-defined	'types'	of	Events.)
When	none	of	the	pre-defined	Types	are	suitable,	add	a	new	custom	Type	by	typewriting	directly	into	the	selector	combo	box.	If	the	value
doesn't	precisely	match	any	of	the	existing	menu	items,	a	new	custom	Type	will	be	created	when	the	 OK 	button	is	clicked.	
Any	added	custom	Type	will	remain	available	in	that	expanded	menu...	unless	the	Tree	is	exported	and	re-imported	or	removed	via	a	Third
party	addon	Utility	like	Type	Cleanup.
custom	Types	can	be	defined	for:	Event	Attributes,	Family	Attributes,	media	Attributes,	Person	Attributes,	Event	Roles,	Event	types,	Family	Relationship	Information	types,
Child	Reference	Types,	Name	Origin	Types,	Names	Types,	Note	Types,	Place	Types,	Repository	Types,	Source	Attributes,	Repository	Media	Types,	Internet	Address	(URL)
Types.

D

date
(sec.	obj.)	-	Dates	in	Gramps	are	much	more	complex	than	just	a	month,	day,	and	year.	Dates	are	always	in	a	particular	calendar,	can	span	a
time	frame	with	the	Date	Type,	the	Date	Quality	can	be	exact	(or	an	approximation	variant),	and	have	support	for	many	other	subtleties
specific	to	genealogy	data.	The	approximation	can	be	fine-tuned	with	the	Limits	preferences.
The	date	parsing	rules	are	applied	whenever	data	is	entered	into	a	date	text	field	or	a	date	selection	dialog.

DNA

1.	 acronym:	deoxyribonucleic	acid
2.	 a	nucleic	acid	that	carries	genetic	information.	Genetic	testing	compares	for	matching	sequence	lengths	(measured	in	centimorgans,	aka	cMs)

at	various	loci	on	specific	chromosomes	to	determine	common	ancestry.

Dock
(graphical	user	interface	terminology)	-	a	dock	is	one	of	the	multitude	of	containers	offering	controlled	access	and	context	to	Gramplets.
Gramplets	can	be	added	to,	removed	from,	or	undocked	from	a	container	to	float	free	of	the	main	window.
The	Dashboard	was	the	original	container	and	can	be	configured	with	multiple	columns	and	stacks	of	Gramplets.	The	sidebar	and	bottombar
splitbars	are	Category-specific	containers.	The	splitbars	only	show	a	single	gramplet	at	a	time	but	with	tabs	to	quickly	switch	between	them.
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Each	view	mode	has	its	own	set	of	splitbars.	So	the	basic	configuration	of	Gramps	has	the	Dashboard	plus	24	Category	view	modes...	or	49
separate	gramplet	containers.

DTD
acronym:	Document	Type	Definition.	A	document	that	defines	the	tagging	structure	which	identifies	the	individual	components	of	an	SGML
or	XML	document.
See	the	reference	documentation	for	the	versions	of	Gramps	RELAX	NG	(REgular	LAnguage	for	XML	Next	Generation)(.rng)	schema
XML	and	DTD

E

Event
( 	prim.	obj.)	-	Contains	the	information	related	to	an	happening.	Adding	an	Event	record	provides	the	context	of	an	interaction	of	the	roles
of	People/Families,	dates	&	places	in	activities.
An	Event	is	a	defining	moment	in	a	person's	life.	See	events	for	the	use	in	genealogy,	for	predefined	events	in	Gramps	and	suggested	naming
for	common	events.

event	role
The	role	a	Person	plays	in	an	Event.	The	focal	Person(s)	holds	a	Primary	role	in	personal	Events	and	the	Family	holds	a	Family	role	in
Family	events.	In	Gramps,	an	Event	can	be	linked	to	as	many	participants	as	desired.	Each	Person	may	participate	in	different	roles	but	more
than	one	Person	might	play	the	same	role.	The	Event	Role	captures	this	and	can	be	changed	in	the	Event	Reference	Editor.	Some	common
Roles	are	pre-defined	but	the	user	can	add	other	custom	Roles	by	just	typing	in	the	appropriate	new	label	into	the	selector	combo	box.
Pre-defined	Types	of	Event	Role:	Aide,	Bride,	Celebrant,	Clergy,	Family,	Godparent,	Groom,	Informant,	Primary,	Witness,	Unknown,	custom

event	type
The	general	denominator	to	which	an	event	belongs,	e.g.,	a	christian,	civil,	tibetan,	...	marriage,	are	all	denoted	by	the	event	type	marriage.
See	events	in	Gramps	for	an	overview.

F

Fallback	events
Certain	event	types	are	definitive	bookends	marking	the	beginning	or	end	of	a	life	(Birth/Death)	or	relationship	(Marriage/Divorce).	Those
bookend	events	are	key	factors	in	any	kind	of	timeline	analysis.
If	the	definitive	event	types	are	missing,	Gramps	will	look	for	similar	event	types	to	calculate	a	'fallback'	approximation.	When	dates	are
shown	in	italics,	it	indicates	that	the	preferred	bookend	event	was	not	found	and	one	of	the	pre-defined	Fallback	events	had	to	be	used.
Markers	for	some	fallback	events	can	be	customized	using	the	Genealogical	Symbols	tab	of	Preferences.

Family

1.	
Family	( 	prim.	obj.)	-	Contains	the	information	specific	to	relationships	between	people.	The	information	may	be	edited	directly	using	the
Edit	Family 	dialog.
This	traditionally	contains	one	or	two	parents	and	zero	or	more	children.	A	family	unit	is	created	in	Gramps	by	adding	Parents	to	an
individual,	by	adding	a	partner/spouse	to	an	individual,	or	by	adding	a	family	first	then	adding	the	people.	(A	family	can	even	consist	of	just
the	offspring.)
The	Family	relationship	is	a	core	concept	in	Gramps.	It	depicts	the	basic	relations	between	people.	Commonly	this	will	contain	a	father,	a
mother	and	some	children,	however,	it	can	also	contain	only	parts	of	this	(e.g.,	two	brothers,	a	mother	and	child).	People	can	be	part	of	several
families	(adoption,	remarried,	...)

2.	 Family	(event	role)	An	event	can	be	coupled	to	a	family,	denoting	that	the	both	partners	were	equally	involved	in	the	event.	Typically,	the
Marriage	event	will	be	coupled	to	a	family	with	event	role	family.	Family	is	the	default	role	when	adding	a	new	Event	in	the	Edit	Family
dialog.

File	Chooser
Picking	external	files	or	folders	for	import,	export,	reports	and	media	is	done	using	a	File	Chooser	dialog	from	GTK	(formerly	known	as
"GIMP	ToolKit"	and	"GTK+")	rather	than	those	of	the	native	Operating	System.	While	generally	familiar,	the	GTK	File	Chooser	has
customizable	features,	context	menus,	options	and	keybindings	that	are	documented	in	the	Settings	section	of	the	manual.

File	formats
File	formats	repackage	the	Tree	database	information	for	archiving,	data	exchange	with	other	software	or	display.

Import	formats:	GRAMPS	v2.x	database	(obsolete)	.grdb,	Comma	Separated	Values	.csv,	GEDCOM	(Genealogical	Data
Communication)	.ged,	GeneWeb	.gw,	Pro-Gen	.def,	vCard	(virtual	contact	card)	.vcf,	JSON	(JavaScript	Object	Notation)	.json,
SQLite	.sql
Export	formats:	Gramps	native	XML	format	(compressed	&	uncompressed	variants)	.gramps,	Gramps	Package	(Gramps	XML	plus
media)	.gpkg,	GEDCOM	(Genealogical	Data	Communication)	.ged,	GeneWeb	.gw,	Web	Family	Tree	(a	GEDCOM	variant)	.ged,
vCalendar	.ics,	vCard	(virtual	contact	card)	.vcf
Output	formats	including:	Comma	Separated	Values	.csv,	Data-Driven	Documents	(D3)	.d3,	Graphviz	graph	description	language
.dot,	Hypertext	Markup	Language	.html	.htm,	LaTeX	.tex,	Open	Document	Text	.odt,	Portable	Document	Format	.pdf,	Plain	Text
.txt,	PostScript	.ps,	Print	(hardcopy),	Rich	Text	Format	.rtf,	Scalable	Vector	Graphics	.svg,	vCard	(virtual	contact	card)	.vcf,
Extensible	Markup	Language	.xml

Filter
A	filter	(aka	query)	in	a	database	finds	(or	hides	by	'filtering	out')	records,	displaying	only	those	records	that	match	certain	criteria.	(The
criteria	are	comparison	or	query	rules	describing	some	attribute	of	a	record.)	Layers	of	criteria	can	be	applied	but	each	layer	requires
additional	processing	and	slows	performance	of	the	interface.	
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The	basic	Search	is	a	single	criteria	filter.	The	search	value	is	compares	only	one	attribute	of	a	record	that	has	been	selected	from	a	pop-up
menu.	
The	Filter	Gramplets	will	compare	several	predefined	common	attributes	simultaneously	with	simplified	access	to	changing	the	search
value.	The	default	is	for	exact	matching	but	Regular	Expressions	(RegEx)	can	be	used	for	pattern	matching.	A	Custom	Filter	may	be	also
layered	in.	
A	Custom	Filter	adds	richly	complex	Rules-based	comparison	with	layers	of	intersection	options	for	those	rules.	Custom	Filters	allow
repeatable	filters	to	be	created	with	pre-defined	rules	and	values	to	be	matched.	Beyond	interactively	hiding	(or	revealing)	records	in	views,
Custom	Filters	are	used	to	set	limits	for	exporting,	setting	scopes	for	reports,	and	targeting	tool	actions.
In	addition	to	the	builtin	rules	for	filtering,	Addon:Rule	expansions	are	available	for	Custom	Filters.

G

GEDCOM

1.	 acronym:	Genealogy	Data	Communication
2.	 a	format	for	importing	and	exporting	genealogical	data.	The	open	specification	for	the	GEDCOM	format	was	developed	by	The	Church	of

Jesus	Christ	of	Latter-day	Saints	(LDS	Church)	as	an	aid	to	genealogical	research.	The	long	standing	standard	release	was	version	5.5	in	1996
with	a	5.5.1	draft	update	presented	for	comment	in	1999.	(Belatedly,	the	'draft'	label	was	officially	removed	in	the	annotated	2019	release.
After	20	years	as	the	de	facto	standard	format,	it	remained	unimproved	excepting	for	2	tags	and	the	copyright.)

As	an	Open	Standard,	there	are	extensive	and	constantly	changing	incompatibilities	between	implementations	and	data	loss	when
transferring	GEDCOM	formatted	data	between	competing	software	tools	is	common.	Gramps	has	implemented	a	variety	of	GEDCOM
support	features.
GEDCOM	X	proposed	in	2012	and	5.5.5	proposed	in	2019	are	improvements	that	have	not	gained	the	approval	of	the	copyright	holder.
As	of	June	2021,	these	proposals	have	been	superseded	by	the	GEDCOM	7.0.1	version.

Godparent
(event	role)	A	term	to	refer	to	the	person	who	presents	a	child	at	a	christening	or	baptism	and	promises	to	take	responsibility	for	guiding	the
child	emotionally,	practically,	and	spiritually.	This	person	will	be	referred	to	as	godfather	or	godmother	after	the	christening	or	baptism.	See
also:	Add	a	godfather-godmother.

Gramplet
a	Gramplet	is	a	plug-in	(aka	widget	or	applet)	that	can	be	docked	in	the	 	Dashboard	category	view.	Later	sidebar	or	bottombar	were	added
to	the	remaining	views	to	extend	adding	and	undocking	a	Gramplet	functionality	of	those	view.	
Gramplets	dynamically	update	as	the	different	records	are	selected	in	the	main	display	area	of	a	view.	Gramplets	typically	create	an	alternate
interface	to	your	Family	Tree	data.	Collections	of	builtin	and	"3rd	party	addon"	gramplets	are	available	for	installation	and	download	with	the
Plug-in	Manager.	The	Plug-in	Manager	also	regulates	a	wide	variety	of	other	builtin	and	addons	which	can	expand	functionality	unrelated	to
the	interface.
See	the	Gramplets	development	for	independent	information.

Gramps	for	Desktops
Gramps	is	an	open-source	genealogy	application,	a	free	software	project	and	community.	
The	GRAMPS	in	all	capital	letters	and	the	"Genealogical	Research	and	Analysis	Management	Programming	System"	backronym	were	both
invented	around	2001	by	Don	Allingham's	father.	This	backronym	was	phased	out	around	March	2010	in	favor	of	Gramps	as	the	official
name	of	the	software.	All	upper-case	acronym-based	names	have	become	unfashionable	for	software.

Gramps	Web	for	Servers
Gramps	Web	is	collaborative	interface	(frontend)	and	backend	for	running	the	Gramps	genealogy	database	engine	on	servers.	It	is	one	of	the
Web	Solutions	for	Gramps.
It	is	a	multi-user	system	genealogical	web	application	with	different	levels	of	options	for	Visitors,	Members,	Contributors,	Editors,	and
Owners.	Trees	in	[Gramps	Web	on	a	server]	can	be	synchronized	with	the	more	mature	and	feature	laden	Gramps	for	Desktops.	Single	Tree
or	multiple	Tree	sites	can	be	self-managed	on	a	hosted	service	from	an	ISP,	leased	from	a	managed	hosting	ISP,	or	leased	from	an	application-
specific	fully	managed	CMS	provider,	or	installed	locally	for	access	from	a	local	area	network.

Graphical	User	Interface	(GUI)
a	visual	way	of	indicating	interactive	features	of	a	computer	operating	system	or	application/program.
The	Gramps	for	Desktops	GUI	is	introduced	in	Visual	Guide	to	Gramps	Interface.	It	uses	a	"windows,	icons,	menus,	pointer"	(WIMP)	based
approach	with	post-WIMP	elements	like	hyperlinked	redirection	and	custom	interface	objects.	The	desktop	interface	is	built	with	Gtk	(the
Gimp	Toolkit),	a	free	and	open-source	cross-platform	widget	toolkit	for	creating	graphical	user	interfaces.
The	appearance	and	interaction	may	vary	by	conventions	dictated	by	the	Operating	System	(OS),	installation	option	(such	as	language
localization	support	or	addon/plug-in),	theme	(at	the	OS	or	internal	levels),	and/or	user	preferences	customization.
The	specific	interface	elements	are	identified	by	customary	name,	general	appearance	&	behavior	in	the	Visual	Guide	to	Gramps	Interface.
Expansion	interface	elements	are	described	in	the	user	documentation	for	each	specific	addon.
The	Gramps	Web	GUI	(or	frontend)	is	a	platform-agnostic	web	browser	interface	built	with	the	Lit	lightweight	JavaScript	library	for
building	fast,	interoperable	web	components.	Although	the	hosting	side	requires	a	webmaster	with	significant	skills,	genealogical
collaborators	can	use	web	browser	on	almost	any	device.

Groom
(event	role)	A	term	to	refer	to	the	man	at	a	marriage	who	will	be	referred	to	as	husband	after	the	marriage.	See	also:	Add	a	spouse.

GUI
An	acronym.	see	Graphical	User	Interface.

H

Home	Person
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(core	concept)	-	The	persistently	designated	Home	Person	is	the	foundational	Person	(the	Proband,	Progenitor,	or	Progenitrix)	in	the	Tree
(the	currently	open	Gramps	database).	This	Person	is	the	central	target	of	genealogical	research	and	family	references	extend	from	this	center.
Ideally,	every	person,	event	and	source	in	the	Tree	will	(however	directly	or	indirectly)	relate	back	to	the	Home	Person.
By	default,	the	database	reports	describe	everything	else	in	contextual	relation	to	this	person.	The	Status	Bar,	the	Quick	View	called	"Relation
to	Home	Person",	and	the	Third	party	addon	Gramplet	called	"Deep	Connections"	all	describe	different	aspects	of	the	relationship	of	the
Active	Person	to	the	Home	Person.
You	(or	your	client)	are	customarily	designated	(set)	as	the	Home	Person.	And	this	Home	designation	serves	as	a	persistent	point	of	reference
for	the	rest	of	the	Tree	in	Reports	generally	and	for	the	Active	Person	in	detail.	But	a	different	Home	Person	might	be	temporarily	set	when
generating	reports	or	when	researching	a	complex	biography	or	obituary.	
Fascinating	tidbits	often	lure	Gramps	researchers	into	wandering	off-course.	When	the	Active	Person	has	become	lost,	the	bearings	can	be
instantly	regained	by	navigating	the	Active	Person	selection	back	to	the	Home	Person.
Navigate	to	Home	Person	-	keyboard	shortcut	 Alt + Home 	or	press	the	toolbar	 Home 	button.	
The	custom	filter	rule	for	finding	the	Home	Person	is	in	a	People	category	filter	under	the	General	filters	and	was	named	'Default	person'
until	the	5.1	version.

I

Informant
(event	role)	A	term	to	refer	to	the	Role	of	Person	who	reports	an	Event.

J

JSON
acronym:	JavaScript	Object	Notation.	JSON	is	a	lightweight,	text-based	data	format	designed	to	be	easy	for	humans	to	read	while	still
structured	enough	for	machines	to	parse	efficiently.	It	organizes	data	in	key-value	pairs,	allowing	information	to	be	grouped	together	in	a	clear
and	straightforward	way.

K

Keybinding
Keyboard	shortcuts	(aka	hotkeys)	key	(or	combination	of	keys)	that	can	be	used	to	navigate	a	Graphical	User	Interface	(aka	GUI)	as	an
alternative	to	using	the	mouse.	A	single	keystroke	(or	combination	of	keys	on	a	keyboard)	executes	a	command.
see	Gramps	GUI	keybindings

L

M

matronym
(origin	Name	attrib.)	-	personal	name	based	on	the	name	of	one's	mother

Media
( 	prim.	obj.)	-	Contains	the	information	related	to	a	media	object.	Media	objects	include	images,	videos,	audio	recordings,	documents,
webpages	or	any	other	type	of	related	files.
When	new	Media	objects	are	edited	from	the	Gallery	tabs	of	Object	Editors	or	from	the	Media	category	view,	the	New	Media	editor	allows
the	metadata	to	be	modified.

Merge
To	combine	the	objects	in	two	selected	rows	in	a	category	view	into	a	single	object.	This	reduces	duplicates	while	consolidating	references
and	secondary	objects.	The	merge	process	involves	selecting	two	rows	(a	target	row	to	be	kept	and	a	row	to	be	deleted)	then	choosing	Merge
from	the	Toolbar	or	Edit	menu.	Choices	are	offered	about	which	secondary	objects	take	precedence	when	there	are	conflicts,	but	no	data
(except	one	of	the	descriptions	in	an	Event	merge)	is	lost	by	default.	All	secondary	objects	from	both	selected	rows	are	conveyed	to	the
surviving	merged	row.	Only	two	objects	may	be	merged	at	a	time	unless	using	addon	tools	designed	for	multiple	object	merges	or	batches	of
merges.

Mode
see	View	mode

N

Name	Origin
An	optional	attribute	(characteristic)	identifying	how	a	name	was	derived	for	a	Person.	Pre-defined	items	of	the	origin	selection	menu
include:	inherited,	patrilineal,	matrilineal,	given,	taken,	patronymic,	matronymic,	feudal,	pseudonym,	occupation.	The	Name	Origin	of
Multiple	surnames	and	Alternative	names	can	be	added	from	the	Edit	Person	dialog.
Available	as	a	standard	attribute	of	Names	in	Gramps.

Navigator
(graphical	user	interface	terminology)	-	the	Navigator	is	a	Gramps-specific	name	for	a	left	sidebar	layout	of	category	view	icons,	allowing
movement	between	(aka	'navigating')	the	different	View	categories.	There	are	multiple	layout	modes	and	a	text	label	preferences	option	for
the	sidebar.	This	sidebar	may	be	hidden	or	revealed	from	the	menu	View	->Navigator	or	by	using	the	keybinding.	Navigator	layout	modes
are	'Sidebar'	type	plugins	that	can	be	added,	removed,	hidden	or	revealed	using	the	Plugin	Manager.
Gramps	divides	and	organizes	the	information	about	each	Primary	Object	into	a	series	of	Categories,	each	with	their	own	View.	Each	of	the
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Category	Views	displays	a	smaller,	more	digestible	portion	of	the	total	information	that	comprises	a	Genealogical	Tree.	The	View	categories
are:	 	Dashboard,	 	People,	 	Relationships,	 	Families,	 	Charts,	 	Events,	 	Places,	 	Geography,	 	Sources,	 	Citations,	
	Repositories,	 	Media,	 	Notes

Note
( 	prim.	obj.)	-	Contains	the	information	representing	a	textual	brief	record	of	facts	and	how	it	references	other	objects	in	the	Tree.	Notes	can
be	added	to	any	object	at	any	any	level	of	the	Tree	and	are	often	used	to	detail	the	context	of	that	record	in	the	Tree.
Records	in	the	Note	Category	contain	free-form	text	with	basic	formatting	and	linking	features.	Notes	can	be	categorized	by	Tag	and	Type	in
addition	to	the	object	to	which	it	is	attached.	That	information	is	created	and	modified	using	the	Notes	Editor.

O

Object
The	most	basic	framework	unit	of	genealogical	data	as	structured	in	the	Gramps	data	model.
The	most	complex	structures	are	the	Primary	Object	of	a	category.	Each	has	an	Object	Editor	that	organizes	entering	data	in	that	structure	but
also	allows	attaching	or	creating	secondary	objects.

Object	Editor	(aka	Edit	Object	dialogs)
(core	concept)	The	object	editor	dialogs	show	the	basic	info	of	the	Primary	Object	in	the	structured	form	of	the	header	area	where	it	can	be
directly	edited.	And	the	bottom	tabbed	section	allows	the	editing	of	interrelationships	with	secondary	objects	and	provides	access	to	the
Object	Editors	for	those	secondary	objects.
Click	the	following	links	for	instructions	of	how	to	open	and	use	each	type	of	Edit	Object	dialog.
The	available	categories	of	object	editor	dialogs	are:	 	 Edit	Person ,	 	 Edit	Family ,	 	 Edit	Event ,	 	 Edit	Place ,	
	 Edit	Source ,	 	 Edit	Citation ,	 	 Edit	Repository ,	 	 Edit	Media ,	 	 Edit	Note
The	available	categories	of	object	reference	editor	dialogs	for	shared	objects	are:	 Person	Reference	Editor 	(see	Associations),	 Child
Reference	Editor ,	 Event	Reference	Editor ,	 Place	Reference	Editor ,	 Repository	Reference	Editor ,	 Media
Reference	Editor

Officiator
(event	role)	A	term	to	refer	to	the	role	of	a	person	authorized	to	conduct	an	official	duty	or	function.	(Such	as	performing	a	marriage	or	funeral
ceremony	or	conferring	a	vocational	degree.)	Jurisdiction	may	be	derived	from	a	from	holding	a	position	of	civil	or	religious	authority.	Use
'OFFICIATOR'	rather	than	'Officiant'	for	GEDCOM7	Roles	compatibility.

P

patronym
(origin	Name	attrib.)	-	personal	name	based	on	the	name	of	one's	father.

Person
( 	prim.	obj.)	-	Contains	the	information	specific	to	an	individual	person	in	the	People	category.	The	information	may	be	edited	directly
using	the	Edit	Person	dialog.

Place
( 	prim.	obj.)	-	The	Gramps	concept	of	a	Place	is	a	particular	location	independent	of	time.	Over	time,	the	same	Place	may	have	different
address	information	due	to	changing	borders	and	political	situation.	For	example,	Leningrad	and	St.	Petersburg	represent	the	same	place,	but
with	different	names.	Places	in	Gramps	are	stored	in	a	hierarchy	and	are	direct	accessed	via	the	Places	category	view.	A	Place	consists	of:

Descriptive	Title
Name
Type	(administrative	divisions	such	as	country,	state,	county	...)
Longitude/Latitude
Code	(such	as	a	country	code	or	postal	code)
A	list	of	alternative	names	for	the	place
A	list	of	regions	which	enclose	the	place

plugin
(aka	plug-in)

a	type	of	expansion	framework	that	allows	Gramps	customization	by	providing	interface	hooks	to	recognize	and	use	external	code.
customized	module	of	code	built	to	provide	a	specific	feature	or	functionality	that	is	not	part	of	the	core	program.

The	various	types	of	Gramps	plugin	code	modules	can	be	enabled	or	disabled	via	a	plugin	manager.	Plugin	types	include:	Citation	formatter,
Database,	Doc	creator,	Exporter,	Gramplet,	Gramps	View	(Category	or	mode),	Importer,	Map	Service,	Plugin	lib,	Quickreport/Quickview,
Relationships,	Report,	Rule,	Sidebar,	Thumbnailer	Tool.
Plugins	can	be	builtin	(included	with	the	normal	distribution	of	Gramps)	or	an	addon	(installed	via	the	Third	party	addons	management	in
Preferences).

POSIX
Portable	Operating	System	Interface:	a	family	of	OS	standards	specified	by	the	IEEE	Computer	Society	for	maintaining	compatibility	with
variants	of	Unix	(such	as	Linux)	and	other	operating	systems.	Although	the	MacOS	is	"POSIX-certified",	the	term	is	used	in	this	manual	to
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generically	refer	to	just	the	"Mostly	POSIX-compliant"	Linux	and	BSD	distributions	with	verified	Gramps	downloads	and	which	use	the
POSIX-style	environment.

Preferences
The	Preferences	is	an	option	in	the	Edit	main	menu	that	allows	global	customization	of	the	appearance,	defaults	and	behavior	of	Gramps.
The	customizations	are	categorized	into	the	following	tabs:	 Data ,	 General ,	 Family	Tree ,	 Import ,	 Limits ,	 Colors ,
Genealogical	Symbols ,	 ID	Formats ,	 Text ,	 Warnings ,	 Researcher .
(A	 Theme 	tab	is	available	as	an	addon.)
(see	also	Configure...	option	in	the	View	main	menu	is	an	option.	Those	customization	are	limited	to	the	currently	active	view	and	its
Gramplets.	The	feature	may	also	be	accessed	by	the	 Configure... 	toolbar	icon.)
The	Gramps	5.1	and	older	preferences	are	categorized	into	the	following	tabs:	 General ,	 Family	Tree ,	 Display ,	 Text ,	 ID
Formats ,	 Dates ,	 Researcher ,	 Warnings ,	 Colors ,	 Genealogical	Symbols .

Prerequisites
Additional	software	required	to	make	certain	features	of	Gramps	work	and	or	some	addons.

Primary	object
Primary	objects	are	the	data	structures	at	the	top	level	of	a	hierarchical	collection	of	records	in	the	Gramps	data	model.	Beside	the	main
structure	of	data,	they	can	contain	a	hierarchy	of	secondary	objects,	and	can	be	referenced	by	other	primary	or	secondary	objects.	In	the
Gramps	database,	primary	objects	and	the	secondary	objects	that	they	contain	are	stored	as	separate	records.	Each	primary	object	type	is
stored	in	a	separate	table.	See	Using	database	API,	Primary	Objects	(see	also	secondary	object)
The	types	of	primary	objects	are:	

	Citation,	 	Event,	 	Family,	 	Media,	 	Note,	 	Person,	 	Place,	 	Repository,	 	Source,	 	Tag.
Primary	role

(event	role)	A	term	to	refer	to	the	role	of	the	focal	participant	of	an	Event.	Primary	is	the	default	role	when	adding	a	new	Event	in	the	Edit
Person	dialog.

Private	flag	or	tag
The	Private	option	identifies	sensitive	information	that	should	be	redacted	when	sharing	data	or	printing	reports.	(This	marker	should	not	be
confused	with	the	generic	user-definable	Tags	used	for	custom	filters	and	color	highlighting.)	Records	are	shown	with:	a	 locked	padlock
when	private;	and,	an	 unlocked	padlock	when	public.	Clicking	the	padlock	icon	toggles	between	Private	&	Public	flags.	This	manual
override	supplements	the	automated	Probably	Alive	and	custom	Filter	features	which	help	Gramps	to	respect	Personal	Privacy.
Gramps	is	a	single	user	database	and	omits	the	typical	security	features	of	a	multi-user	system.	So	even	"Private"	data	will	be	accessible	from
within	Gramps.	However,	generating	reports	and	exporting	data	default	to	redacting	information	flagged	as	Private.

Public	tag	or	flag
The	Public	option	identifies	information	that	should	be	included	when	sharing	data	or	printing	reports.	Records	are	shown	with:	a	
unlocked	padlock	when	public;	and,	an	 locked	padlock	when	private.	Clicking	the	padlock	icon	toggles	between	Public	&	Private	flags.
By	default,	all	records	are	created	as	Public.

Q

Quick	View
On-screen	reports	about	information	surrounding	the	active	object	that	do	not	print	or	save	to	file.	Generally	the	report	is	selected	from	a
context	menu	for	the	selected	category	of	record	and	will	have	no	configurable	options.	
The	Quick	View	gramplet	refreshes	a	builtin	builtin	or	addon	QuickView	reports	as	the	focus	of	the	active	record	is	changed.	The	specific
QuickView	report	is	selected	in	a	view	configuration	dialog	opened	with	the	View	->	Configure...	menu.

R

Reference
the	basic	a	system	of	linking	relationships	between	objects	in	Gramps.	When	when	an	object	is	added	in	the	Editor	for	record,	a	Reference
(link)	is	created	in	the	object	that	was	added.

References	tab
a	system	of	linking	between	objects	in	Gramps.	When	objects	of	Gramps	are	linked,	the	References	tab	lists	the	objects	to	link	toward	it.

Regular	Expressions
RegEx	is	a	system	to	specify	a	text	string	pattern	for	comparing	and	matching.	Optionally	used	to	extend	a	power	of	the	Filter	Gramplets	and
Custom	Filters	rules.
Filters	in	Gramps	use	the	RegEx	format	specified	by	the	installed	version	of	Python

Re-order

To	change	the	sequence	of	items	within	a	list	of	secondary	objects.	The	interface	for	(and	consequences	of)	re-ordering	that	sequence	varies
based	on	the	list	type.
The	natural	order	of	a	list	follows	when	the	data	was	created.	The	first	item	in	an	ordered	list	is	often	considered	the	primary	or	preferred	item
of	that	type.	The	primary/preferred	may	be	the	only	object	considered	in	some	charts	and	analyses.	So	when	data	entry	of	related	objects	was
out	of	sequence,	a	re-ordering	option	becomes	necessary.
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Re-ordering	affects	display	order	in	the	Tree,	charts,	and	most	reports.	Note	that	in	some	contexts,	dates	can	override	the	manual	order,
particularly	for	Places	and	Names.

Repository
( 	prim.	obj.)	-	Contains	the	information	related	to	a	physical	or	virtual	structure	where	genealogical	and	family	history	sources	are	stored.
Once	a	Repository	is	added	to	a	Gramps	Tree,	it	can	used	to	organize	Sources.

role
function	performed	or	part	played	by	a	person	(or	other	Gramps	object)	in	a	particular	situation.	When	objects	of	Gramps	are	linked,	a
Reference	is	created	where	the	implicit	Role	disambiguates	the	relative	nature	of	the	reference.	For	explicitly	defined	roles,	see	event	role	and
association	role

romanization
linguistic	representation	of	a	word	in	the	Roman	(Latin)	alphabet

Rule
a	pre-defined	abstraction	that	simplifies	the	interface	for	a	structured	query	about	a	particular	facet	of	your	family	tree.	Rules	allows	users	to
choose	search	criteria	without	needing	to	understand	the	intricate	details	of	the	actual	database	query	language.	Rules	are	layered	via	the
Custom	Filters	interface	to	filter	with	complex	criteria.

S

secondary	object
Secondary	objects	are	contained	within	other	objects	of	the	structured	Gramps	data	model,	and	cannot	be	referenced	directly.	They	can
contain	other	secondary	objects.	Examples	include:	Name,	Date	and	Address.	See	Using	database	API,	Secondary	Objects	(see	also	primary
object)

Selector	combo	box
(graphical	user	interface	terminology)	-	a	standard	text	entry	box	paired	with	pull-down	list	button	is	a	Gtk	toolbox	widget	(based	on	the
standard	combo	box).	The	combination	of	a	drop-down	list	and	a	single-line	editable	textbox	allows	the	user	to:	either	key	in	a	value	directly;
or,	select	a	value	from	the	list.	Moreover,	keying	in	a	value	that	is	not	already	in	the	list	will	add	that	custom	type	to	the	drop-down	list.

Shared	objects
Sharing	allows	an	Object	to	be	linked	at	multiple	places	in	the	tree.	Doing	so	establishes	a	relationship	or	maintains	single	set	of	attributes

(or	secondary	objects)	that	they	hold	in	common.	(Roles	for	shared	Events	define	the	person	or	family	participation	level.)
Object	Reference	Editors	allow	updates	to	a	shared	object	to	be	reflected	in	all	instances	mentioning	(referencing)	that	shared	object.
Redundantly	creating	object	with	the	same	information	should	be	avoided.	(So,	refining	a	Transcription	Note	shared	by	multiple	Citations
will	show	the	updated	transcription	in	all	the	Citations.)
Object	descriptions	are	grouped	in	two	distinct	sections:	
	•	The	Reference	Information	section	contains	information	unique	to	one	instance.	
	•	The	Shared	Information	of	an	object	will	be	seen	in	all	instances	that	are	linked	to	it.

selector
combo	interface	box	that	allows	you	to	select	an	object.	The	Select	Family	selector	is	one	example.

Source
( 	prim.	obj.)	-	Sources	can	be	a	person	(family,	friend,	another	researcher),	thing	(book,	magazine	newspaper,	census),	or	place
(courthouse,	church,	library,	genealogical/historical	society...	although	places	might	be	better	handled	as	Repositories)	from	which
information	comes,	arises,	or	is	obtained.	After	adding	a	Source	with	the	new	source	dialog	to	the	Sources	category	of	a	Gramps	Tree,	the
Source	can	be	referenced	when	adding	a	Citations	and	organized	within	Repositories.	The	same	Source	may	exist	in	multiple	Repositories	and
may	have	different	Media	Types	(such	as	book,	microfilm,	or	electronic)	and	Call	numbers	in	each	Repository.
[more]

SQLite
(database	backend	engine)	The	SQLite	project's	in-process	library	(also	known	simply	as	SQLite)	is	the	default	database	engine	used	since
the	5.1	version	of	Gramps.	The	support	was	extended	from	BSDDB	in	the	5.0	version	via	the	DB-API	Database	Backend.

Swatch
(graphical	user	interface	terminology)	-	a	color	swatch	is	a	sample	square	of	a	color	or	color	pattern.	Swatches	may	be	dragged	from	the	Pick
a	Color	selector	to	apply	that	specific	color	to	preferences.
The	word	originally	referred	to	sample	pieces	of	cloth	or	fabric	used	for	choosing	or	testing	colors,	patterns,	or	textures	for	interior	or	exterior
design.	It	now	means	any	small	sample	or	representation	of	a	larger	whole	and	is	commonly	usage	in	the	context	of	color	representation	and
selection	in	software	applications.

T

Tag
( 	prim.	obj.)	-	A	custom	titled	and	color-coded	label	that	can	be	created	with	the	Organize	Tags	dialog	and	attached	to	selected	 	Citation,	

	Event,	 	Family,	 	Media,	 	Note,	 	Person,	 	Place,	 	Repository	or	 	Source	objects	for	the	purpose	of	easy	identification	and
filtering.
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A	keyword	or	phrase	used	to	group	the	collection	to	produce	a	report.	Multiple	tags	may	be	used	to	label	and	categorize	objects	into	multiple
groups	when	filtering	by	other	attributes	is	not	viable.

Toolbar
(graphical	user	interface	terminology)	-	The	Toolbar	is	a	ribbon	(located	below	the	application	menubar)	with	button	shortcuts	for	the	most
widely	needed	functions	associated	with	the	current	view.	The	selection	of	buttons	changes	in	response	to	the	context	of	the	current	view.
(e.g.,	toolbar	buttons	for	switching	mapping	view	modes	will	only	appear	for	the	Geography	view.)

Typographical	conventions
The	customary	formatting	having	special	(and	possibly	peculiar)	meaning	when	used	throughout	the	MediaWiki	driven	Gramps	manual	and
documentation.	The	different	typeface	accents,	highlighting	and	enclosures	indicate	specific	parts	of	the	Gramps	Graphical	User	Interface
(GUI)	or	prompt	a	User	activity.

U

Unknown
(event	role)	A	placeholder	for	when	the	 role	of	a	participant	in	an	Event	has	not	yet	been	defined.	Gramps	sets	an	appropriate	default	Role	as
each	new	Event	type	is	created.	But	when	a	new	participant	is	associated	with	an	existing	Event	via	Share	or	drag'n'drop,	the	Role	isn't	as
predictable.	In	such	a	case,	an	Unknown	placeholder	is	inserted.
Any	Unknown	Event	Role	type	causes	a	variety	of	reporting	problems.	(Rule_expansions)Persons	and	Families	with	Unknown	Roles	should
be	found	and	the	Roles	manually	replaced	as	soon	as	is	practical.

User	Directory
(core	concept)	An	alias	for	the	file	folder	(directory)	location	where	customizations	(e.g.:	preferences	files,	addons,	plugins)	are	stored	for	the
Gramps	family	of	genealogy	tools.	Since	this	folder	location	varies	by	which	Operating	System	and	which	Gramps	fork	has	been	installed,
the	User	Directory	is	an	'alias'	(a.k.a.	placeholder)	used	in	instructions	about	re-configuring	Gramps.	
This	alias	allows	instructions	for	locating	your	specific	User	Directory	file	location	to	be	consolidated	in	the	documentation.

V

View	category
(graphical	user	interface	terminology)	-	a	View	category	(often	simply	called	a	"View")	is	a	Gramps-specific	name	for	the	collection	of
View	modes	(display	layouts)	presenting	information	in	a	structured	and	predictable	manner.	Different	Views	are	selected	from	the	Navigator
(left	sidebar),	
Layouts	are	in	table,	outline	or	graphical	formats;	depending	on	the	preferred	way	to	represent	how	the	data	elements	relate	to	on	another.	
Gramps	divides	and	organizes	the	information	about	each	Primary	Object	into	a	series	of	Categories,	each	with	their	own	View.	Each	of	the
Category	Views	displays	a	smaller,	more	digestible	portion	of	the	total	information	that	comprises	a	Genealogical	Tree.	The	View	categories
are:	 	Dashboard,	 	People,	 	Relationships,	 	Families,	 	Charts,	 	Events,	 	Places,	 	Geography,	 	Sources,	 	Citations,	
	Repositories,	 	Media,	 	Notes

View	mode
(graphical	user	interface	terminology)	-	a	View	mode	is	a	Gramps-specific	name	for	the	display	layouts	presenting	View	category
information	in	a	structured	and	predictable	manner.	A	View	category	may	have	alternate	view	modes	(subcategories)	of	display	layout.	(e.g.,
Views	with	Table	layouts	might	have	flat	listed	or	hierarchically	grouped	modes.)	Navigating	between	View	modes	is	from	the	toolbar	and
Navigator.	
Each	mode	of	a	category	can	be	independently	 	configured.	Each	mode	may	maintain	a	separate	object	selection,	filtering,	and
organization	for	its	Gramplet	bars.
View	data	may	be	further	subdivided	with	tabbed	pages	of	layouts.

W

wiki
(Hawaiian	loanword)	meaning	'quick';	or	'wikiwiki'	meaning	'very	quick'.	For	Gramps	users,	the	Wiki	(a.k.a.	Wiki	Manual)	refers	to	the
collaborative	website	of	educational	material	which	is	organized	using	the	MediaWiki	content	management	system.	The	core	pages	of	that
website	being	the	structured	reference-style	Gramps	software	user's	operating	guide.	(Note	that	specific	tutorial	documents	are	also	part	of	the	wiki.)
For	most	internet	users,	the	word	is	most	often	an	inadvertent	allusion	to	the	1995	WikiWikiWeb,	the	first	website	that	builtin	tools
encouraging	users	to	quickly	&	easily	collaborate	to	expand	the	content	of	the	site.	See	the	term:	'wiki'	in	Wiktionary

Witness
(event	role)	The	term	that	applies	to	the	people	asked	to	be	present	at	an	event	so	as	to	be	able	to	testify	to	its	having	taken	place

X

XML
acronym:	Extensible	Markup	Language.	A	schema	used	to	define	the	expected	structure	of	data	in	a	text	format.	The	system	annotates	a
document	in	a	way	that	data	elements	are	syntactically	distinguishable	from	identifying	tags.	A	markup	language	defines	a	set	of	rules	for
encoding	documents	in	a	fault	tolerant	format	that	is	both	(marginally)	human-readable	and	machine-readable.	
Gramps	will	generate	XML	format	natively	in	compressed	and	uncompressed	forms	identified	with	a	.gramps	or	.gpkg	file	extension.	It	is
the	format	that	definitively	supports	every	piece	of	genealogical	data	stored	by	Gramps.	Used	as	the	working	format	until	Gramps	2.0	started
using	a	database	backend	to	improve	performance,	XML	is	now	the	standard	Tree	data	backup	format	and	recommended	data	exchange
format.
See	the	reference	documentation	for	the	versions	of	Gramps	RELAX	NG	(REgular	LAnguage	for	XML	Next	Generation)(.rng)	schema
XML	and	DTD

Y

Z
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http://www.gramps-project.org/wiki/index.php/Addon:Rule_expansions#People_with_events_with_a_selected_role
http://www.gramps-project.org/wiki/index.php/File:Gramps-config.png
https://wikipedia.org/wiki/Loanword
http://www.gramps-project.org/wiki/index.php/User_manual
http://www.gramps-project.org/wiki/index.php/User_manual
https://mediawiki.org/wiki/MediaWiki
https://wikipedia.org/wiki/Content_management_system
http://www.gramps-project.org/wiki/index.php/Category:Tutorials
http://wiki.c2.com/?WikiWikiWeb
https://wiktionary.org/wiki/wiki
https://wiktionary.org/wiki/Wiktionary
https://wikipedia.org/wiki/XML
http://www.gramps-project.org/wiki/index.php/Generate_XML
http://www.gramps-project.org/wiki/index.php/Database_Backends
https://www.gramps-project.org/xml/
http://www.gramps-project.org/wiki/index.php/Gramps_XML#RELAX_NG_generation
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